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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help
You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help
If you’re setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions
that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally.
See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files
You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation
Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

• Application Fundamentals

• Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.
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In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions
PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions
The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign 
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

. . . (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
 Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
 an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

⇒ This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes
PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.
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ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY_CD_TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY_TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers
Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

• Asia Pacific

• Europe

• Latin America

• North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

• USF (U.S. Federal)

• E&G (Education and Government)

Translations and Embedded Help
PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We
are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.
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Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

• Using the PeopleSoft Online Help

• Managing Hosted online help

• Managing locally installed PeopleSoft Online Help

PeopleSoft CS Related Links

Hosted Online Help Home

PeopleSoft Information Portal

My Oracle Support

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Field or Control Description

YouTube

Twitter@PeopleSoft_Info.

PeopleSoft Blogs

LinkedIn
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Chapter 1

Getting Started with Recruiting and
Admissions

Recruiting and Admissions Overview

Recruiting and Admissions helps you plan, manage, and track admissions and recruitment activities.

With this application, you can:

• Capture student recruiting information and analyze recruiting activities.

• Tailor your admissions system according to your requirements and practices.

• Set enrollment targets, track progress toward recruiting efforts, and analyze admissions decisions and
patterns.

Recruiting and Admissions Business Processes

The following process flows illustrates the Recruiting and Admissions business processes.
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This diagram illustrates the receive transcripts and test scores business process.
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This diagram illustrates the add or receive applications business process.

Recruiting and Admission Integrations

Recruiting and Admissions integrates with these PeopleSoft applications:
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This diagram illustrates that PeopleSoft Recruiting and Admissions integrates with PeopleSoft Campus
Community, PeopleSoft Student Records, PeopleSoft Student Financials and PeopleSoft Financial Aid.

We discuss integration considerations in the implementation topics in this documentation.

Supplemental information about third-party application integrations is located in My Oracle Support.

PeopleSoft Campus Community

Campus Community shares people data, such as names and addresses, and external organization data, for
prospect, application and transcript processing, with Recruiting and Admissions.

PeopleSoft Student Financials

Recruiting and Admissions uses Student Financials functionality to process application fees and
application deposits.

PeopleSoft Student Records

Recruiting and Admissions transfers application data with Student Records after applicants have been
matriculated. Student Records can then build student program and plan records without having to re-enter
large amounts of information.

Recruiting and Admissions Implementation

PeopleSoft Setup Manager enables you to generate a list of setup tasks for your organization based on
the features that you are implementing. The setup tasks include the components that you must set up,
listed in the order in which you must enter data into the component tables, and links to the corresponding
documentation.
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Recruiting and Admissions also provides component interfaces to help you load data from your existing
system into Recruiting and Admissions tables. Use the Excel to Component Interface utility with the
component interfaces to populate the tables.

This table lists all of the components that have setup component interfaces:

Component Component Interface References

CRS_MAJOR_CODE SAD_CRS_MAJOR_CODE See Defining and Reviewing External
Data Setup Tables.

Other Sources of Information

In the planning phase of your implementation, take advantage of all PeopleSoft sources of information,
including the installation documentation, data models, business process maps, and troubleshooting
guidelines.

See product documentation for PeopleTools: Component Interfaces

See product documentation for PeopleTools: Setup Manager

Additional Information for Getting Started with Recruiting and
Admissions

Additional, essential information describing the setup and design of your system appears in two
companion volumes of documentation: Campus Solutions Application Fundamentals documentation and
Campus Community Fundamentals documentation.

See  Campus Solutions Application Fundamentals

See  Campus Community Fundamentals

For information about deferred processing, see "Additional Information for Getting Started with Campus
Solutions" (Campus Solutions Application Fundamentals)
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Chapter 2

Building Your Recruiting Structure

Setting Up Your Recruiting Structure

To set up your recruiting structure, use the Region component (REGION_TABLE), Region Postal
component (RGN_POSTAL_TABLE), Region SetID Effective Date Update component (RUN_AD505),
Recruiting Category component (RECRUIT_CAT_TABLE), Recruiting Center component
(ADM_RECRCTR_TBL), and Application Center component (ADM_APPLCTR_TBL).

An admissions recruiter can be anyone in your campus community (for example, staff, faculty, student,
and alumni) who helps with the recruiting and admissions process. Recruiters can recruit at different
levels. For example, they can recruit by region, career, program, or plan and sub-plan. You can assign
recruiters to prospects and applicants. You can assign recruiters, prospects, and applicants to geographic
regions and various recruiting categories to match recruiters to prospects.

This section provides an overview of building your recruiting structure and discusses how to:

• Set up region codes.

• Set up region trees.

• Activate region trees.

• Set up recruiting categories.

• Set up recruiting centers.

• Set up AAWS application fee waiver basis codes.

• Set up application processing centers.

• Map academic shifts to admit terms.

Pages Used to Set Up Your Recruiting Structure

Page Name Definition Name Navigation Usage

Region Table REGION_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Prospect/
Applicant Recruiting >
Region Table

Define the geographic regions
that your academic institution
uses for recruiting and
admissions.
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Page Name Definition Name Navigation Usage

Region Postal Table REG_POSTAL_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Prospect/
Applicant Recruiting >
Region Postal Table

Define postal codes for use
in your region tree. You
can define any number of
postal codes for your regional
recruiting purposes. Postal
codes are used as the detail
values, or leaves, of your
region tree.

It is vital to keep the region
postal codes that you define
on this page synchronized
with the detail values on your
region tree. Plan out your
postal code values and enter
them here before entering
them into the region tree.

Region SetID Effdt Update 
(region setID effective date
update)

RUNCTL_AD505 Student Recruiting >
Student Recruiters >
Region SetID Effdt Update

Run the Region SetID Effdt
Update process, which
activates region trees.

Recruiting Category Table RECRUIT_CAT_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Prospect/
Applicant Recruiting >
Recruiting Category Table

Set up your recruiting
categories.

Recruiting Center Table ADM_RECRCTR_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Prospects >
Recruiting Center Table

Create the admission
recruiting centers for your
institution.

Application Fee Waiver Basis SAD_FEE_WVR_BAS Set Up SACR > Product
Related > Recruiting and
Admissions > Applicants >
Application Fee Waiver
Basis

Set up basis codes for AAWS
application fee waiver.

Application Center Table ADM_APPLCTR_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Applicants >
Application Center Table

Set up your application
centers.

Academic Shift Mapping SAD_SHIFT_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > Applicants >
Academic Shift Mapping

Map academic shifts to admit
terms.
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Setting Up Region Codes
Access the Region Table page (Set Up SACR > Product Related > Recruiting and Admissions >
Prospect/Applicant Recruiting > Region Table).

A region can be a continent, a country, a state, a portion of a state, a mix of states, or any regional
grouping that is for recruiting. You can link applicants, prospects, schools, and recruiters to geographic
regions. Use this linkage for informational purposes and for assigning recruiters to prospects and
applicants according to where the person attends school or resides. Regions are required if you plan to
use PeopleSoft Tree Manager to assign recruiters to prospects and applicants. Plan your regions and your
region tree before defining codes.

Setting Up Region Trees
Before assigning recruiters to regions, set up a region tree for your academic institution using PeopleSoft
Tree Manager. This section covers setting up region trees for your recruiting structure.

A region tree is a detailed and hierarchical representation of all the geographic regions that you use for
recruiting purposes. Each region is represented on the region tree as a node that appears hierarchically. A
city can reside within a county, a county within a state, and a state within a country. However, the lowest
level on the tree must be postal code ranges.

Your system uses region trees when you assign recruiters to prospects and applicants. The region tree
hierarchical structure enables you to include and exclude recruiters from a variety of regions within your
recruiting structure. For example, you can have a West Coast recruiter who does not go to the state of
California, except for the city of San Jose, but only for the postal code range of 95000-95199 within
that city. In other words, you assigned the recruiter to the West Coast region but excluded her from the
California region. Then you assigned her to the San Jose region but excluded her from every postal code
range except 95000-95199.

You assign a region to applicants in the Application Entry component, to prospects in the Prospect Data
component, and to recruiters in the Recruiters component. When you assign recruiters to individual
prospects and applicants (also in the Application Entry and Prospect Data components) the system uses
the region tree to match recruiters to prospects and applicants, based on where they reside on the tree. For
example, suppose that you assign an applicant to the region San Jose. Suppose further that you don't have
any recruiters assigned at that level, but that you do have recruiters assigned to the region Santa Clara
County. San Jose is a lower node of Santa Clara County. Thus, recruiters assigned to Santa Clara County
are responsible for San Jose, and any other lower-level node on the region tree.

Using region trees, you can also assign recruiters to prospects and applicants in batch, using the Recruiter
Assignment process. This process matches recruiters to prospects and applicants based on the postal code
of the prospect's or applicant's home or last school attended.

Entering Regions in the Region Table Page

Although you can define new regions directly in PeopleSoft Tree Manager as you build your region tree,
plan and define your regions in advance on the Region Table page. That way, all regions are available
as you build your tree. You can always add additional regions through Tree Manager. When you define
regions, print your region codes so that they are available while building your tree. You can also draw a
map of your tree and include the actual region codes. Having a printed code list is valuable because you
cannot prompt for defined region codes in PeopleSoft Tree Manager. Also, you are less likely to create
duplicate or similar codes if you have a printed list.
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Setting Up Postal Codes on the Region Postal Code Table Page

Before you can define postal code values (detail values) on your tree, you must set up all of your postal
codes on the Region Postal Table page. To verify that a detail exists on the Region Postal Table page,
right-click that detail in the region tree. If you receive a message that the value is not found, then you
must go to the Region Postal Table page and set it up. It is extremely important to keep the region postal
codes on the Region Postal Table page synchronized with the detail values of your region tree. Postal
codes cannot overlap regions. If you enter the zip + 4 postal code for prospect or applicant addresses,
include the four digit extension when defining your postal code ranges for the regions. Example:
The begin postal code should be defined as 914360000 and the end postal code should be defined as
914669999.

For manual and batch recruiter assignment, the number of numeric digits in the postal code ranges of a
region tree should be the same. For instance, if you have set up a region tree with five digit postal code
ranges, such as USA94000 - USA95599, ensure that you do not define a nine digit postal code range for
the same region tree.

If you have set up a region tree with five digit postal code ranges, the system uses the first five digits of
the applicant's or prospect's home or school postal code.

If you have set up a region tree with nine digit postal code ranges, the system uses the nine digits of the
applicant's or prospect's home or school postal code. If the applicant's or prospect's postal code consists of
five digits, the system adds four zeros to the applicant's or prospect's postal code to make it nine digits for
the assignment process.

If the applicant's or prospect's home or school postal code consists of a dash, the system removes the dash
before comparing the postal code with the region tree's postal code ranges.

Defining a Region Tree for Recruiting and Admissions

You base your region tree on a special tree structure, shipped with Recruiting and Admissions, called
REGION. This structure uses the country and postal code of either the applicant's school or the applicant's
home address as detail nodes of the tree and the structure looks to the regions stored in the region table for
all other tree nodes.

To set up your region tree, select Tree Manager > Tree Manager.  Search for a Tree Name of REGION.
Select a delivered REGION tree. Then select the Save As link on the page.

The Tree Definition dialog box opens. The following values should appear:

• The tree name is REGION.

• The status is Active.

• The structure ID is REGION.

Note: Your region tree must be based on the REGION structure that is provided with your system.
Your system relies on this structure when matching recruiters to prospects and applicants.

• The All Detail Values in This Tree check box is cleared.

• The Allow Duplicate Detail Values check box is cleared.

• The Strictly Enforced option is selected.
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• Enter your institution's setID and an effective date. When you click Save As, you return to the
PeopleSoft Tree Manager page, with the name of your region tree. The name of your region tree is the
setID plus the effective date.

Delivered Region Tree Examples

Recruiting and Admissions comes with three sample region trees that you can view to get an idea of a
finished region tree. Each one is named REGION; they are listed, in order, under the following setIDs:

• PSCCS

• GLAKE

• PSUNV

This is an example of part of the delivered GLAKE region tree.

See product documentation for PeopleTools: Tree Manager

Related Links
Setting Up Region Codes
Understanding Adding Prospects

Activating Region Trees
After you create a region tree or update an existing tree with a new effective date, you must activate it by
running the Region SetID Effdt Update process.

Note: Region trees do not work unless you run this process.

Access the Region SetID Effdt Update page (Student Recruiting > Student Recruiters > Region
SetID Effdt Update).
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Field or Control Description

As Of Date Enter a date equal to the effective date of the region tree.

Institution Enter the institution for which the region tree will be used.

SetID for Region Enter the setID that was used when creating the region tree.

Click the Run button and select AD505 to run the process. The process activates the most recent region
tree with an effective date that is less than or equal to the date entered in the As Of Date field.

Setting Up Recruiting Categories
Access the Recruiting Category Table page (Set Up SACR >Product Related >Recruiting and
Admissions >Prospect/Applicant Recruiting >Recruiting Category Table).

Warning! You must create a recruiting category of REGN (region) so that you can use the flexibility of
regional recruiting assignments. To automatically assign recruiters to prospects and applicants by region,
define a REGN code in this table. The description can be anything, but the code must be REGN.

Recruiting categories enable you to track prospect and applicant interests. By assigning prospects and
applicants to recruiting categories, you can give them the proper attention during the recruiting and
admissions processes. You link recruiters to recruiting categories when setting up recruiters.

Field or Control Description

Recruitment Group Assign the recruiting category to a recruitment group. Values
are Academic, Alumni,  Athletics, Music, Region,and Special.
Recruitment groups are delivered with your system as translate
values. You can modify these translate values.

Important! Do not change or delete the translate value
Region. It is required for automated region and recruiter
assignment.

Move to Application Select to copy this recruiting information to the application
record when the prospect who is assigned to this category
becomes an applicant.

Academic Career Indicator Select to limit the recruiting category to one career. For
example, you can create a recruiting category called EXTV
for those prospects who are currently business executives and
define it so that it is only available to your BUSN (graduate
business) academic career. Enter the career to which you want
the category limited in the Academic Career field.
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Field or Control Description

Academic Career If you want this category to be available for only one academic
career, select the Academic Career Indicator check box and
enter the career here. If you want this recruiting category to be
available to all careers, clear the Academic Career Indicator
check box and leave this field blank. This field determines the
recruiting categories that appear in the Recruiting Category
field on the Application Recruiters and Prospect Recruiters
pages. Define academic careers on the Academic Career Table
page.

Note: When assigning a prospect or applicant to a recruitment group and category, you can indicate a
further level of a person's interests by using a recruitment subcategory.

Setting Up Recruiting Centers
Access the Recruiting Center Table page (Set Up SACR >Product Related >Recruiting and
Admissions >Prospects >Recruiting Center Table).

The recruiting center helps to identify the prospects and recruiters who belong to a particular recruiting
office. If you process applications in the same office as you process prospects, your application and
recruiting centers are probably identical. If you have a decentralized recruiting structure, you can create
a recruiting center for each office so that you can identify which office has responsibility for a specific
prospect or applicant.

Field or Control Description

Academic Career Select an academic career if you want this recruiting center
associated with only one academic career. If you want the
recruiting center available to all academic careers, leave this
field blank.

Related Links
Defining Recruiters
"Understanding Recruiting and Admissions Security" (Campus Solutions Application Fundamentals)

Setting Up AAWS Application Fee Waiver Basis Codes
Access the Application Fee Waiver Basis page (Set Up SACR > Product Related > Recruiting and
Admissions > Applicants > Application Fee Waiver Basis).

Use this page to set up waiver basis codes for AAWS application fee waivers.

The values that you set up here are available for selection in the Waiver Basis Code field in the AAWS
Application Fee and Waiver Processing group box on the Application Center Table page.

See Reviewing and Editing Staged Admission Application Transactions
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Setting Up Application Processing Centers
Access the Application Center Table page (Set Up SACR >Product Related >Recruiting and
Admissions >Applicants >Application Center Table).

This example illustrates the fields and controls on the Application Center Table page. You can find
definitions for the fields and controls later on this page.

Note: You assign applications and link recruiters to application centers. This helps you to identify the
applications and recruiters who belong to a particular admissions office.
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Application centers are where admissions applications are processed. By defining application centers,
you can track which office is handling a specific application. This is especially useful if you have
decentralized processing for academic careers.

Field or Control Description

Academic Career Select an academic career if this application center is for
only one academic career. If you want this application center
available to all careers, leave this field blank. Define academic
careers on the Academic Career Table page.

Application Fee Code Select the appropriate application fee code for this application
center. Define application fee codes on the Application Fees
page in PeopleSoft Student Financials. If you do not charge an
application fee, you can leave this field blank.

Deposit Fee Code Select the appropriate deposit fee code used for this
application center. Define deposit fee codes on the Deposit
Fees page in Student Financials. If you do not charge deposits,
 you can leave this field blank.

Calculate Deposit Fee in Batch Select if you want to allow users to save applications without
calculating a deposit fee. When you enter a status of Admitted
on the Application Program Data page, the system does not
prompt you to calculate the deposit. Rather, you use the
Deposit Fees Calc (deposit fees calculation) batch process 
(SFPBADEP) to calculate the deposit fee. This enables you to
automate the deposit fee calculation process.

If you clear this check box, the system does prompt you to
calculate a deposit fee when you enter a status of Admitted on
the Application Program Data page.

AAWS Application Fee and Waiver Processing

AAWS application fee processing uses staging data in the Application Transactions component.

Use this group box to set up the options for AAWS application fee and waiver processing.
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Field or Control Description

SF Merchant ID and SF eCheck Merchant ID Select a SF Merchant ID (for credit card) or a SF eCheck
Merchant ID or both for AAWS fee processing. Based on this
setup, during the AAWS fee calculation and payment process,
 a List of Values web service determines which payment
methods are available to an applicant on the external User
Interface site.

A merchant ID is a user-defined element that defines the rules
for interfacing with a third party payment processor. Define
Student Financials merchant IDs on the SF Merchants page 
(Set Up SACR, Common Definitions, Self Service, Student
Financials, SF Merchants).

See "Setting Up SF Merchants" (Student Financials).

When is Fee Payment Required If you select Pay Later, the payment processing must be
handled outside of AAWS processing. The online application
can be submitted and be posted to the core production
Application Maintenance component but your institution must
follow up with the applicant and process the payment outside
of AAWS processing.

Allow Application Fee Waiver If you select Yes, the Valid Waiver Basis Codes group box
and Application Fee Waiver Process fields become available.

Valid Waiver Basis Codes You can select from waiver basis codes that have been set up
on the Application Fee Waiver Basis page (Set Up SACR,
 Product Related, Recruiting and Admissions, Applicants,
Application Fee Waiver Basis).
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Field or Control Description

Application Fee Waiver Process • If you select Require Manual Reconciliation, an
administrator must approve or deny the waiver in the
Application Transactions staging component before the
application can be posted to core production.

• If you select Allow to Post, the application can be
posted to core production and the administrator assesses
the waiver request in the Application Maintenance
component.

If your school allows waivers but automatically grants the
waiver without review or assessment, you can select App
Fee Status Waived as the Allow to Post option. When
the application is posted, the Fee Status field value in
Application Maintenance is set to Waived.

If your school requires waiver requests to be assessed,
 select App Fee Status Waiver Request as the Allow
to Post option. When the application is posted, the Fee
Status field value in Application Maintenance is set to
Waiver.

Related Links
Reviewing and Editing Staged Admission Application Transactions
Payment Integration Web Service Operations
"Setting Up Application Fees" (Student Financials)
"Generating Direct to GL Entries" (Student Financials)
"Using the SSF_EPAYMENT_TRANS Web Service" (Student Financials)
Defining Recruiters
Entering Application Program Data
"Understanding Recruiting and Admissions Security" (Campus Solutions Application Fundamentals)

Mapping Academic Shifts to Admit Terms
Access the Academic Shift Mapping page (Set Up SACR > Product Related > Recruiting and
Admissions > Applicants > Academic Shift Mapping).
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This example illustrates the fields and controls on the Academic Shift Mapping page. You can find
definitions for the fields and controls later on this page.

Use this page to map academic shifts to admit terms.

If the Use Shift by Admit Term check box is selected on the Academic Institution 3 page, only the values
defined here for the particular admit term are available in the Academic Shift field on various pages in
Admissions and Student Records.

The Total Seats field is informational only.

Related Links
"Setting Additional Institution Defaults and Options" (Campus Solutions Application Fundamentals)
"Defining Academic Shifts" (Campus Solutions Application Fundamentals)

Defining Recruiters

After you have set up recruiters and related items such as regions, region trees, and recruiting categories,
you can identify and manage recruiters.

This section lists prerequisites and discusses how to:

• Designate recruiters.

• Assign recruiters to recruiting categories.

• Link recruiters to geographic regions.

• Associate recruiters with recruiting and application centers.

• Link recruiters with academic programs and academic plans.

Prerequisites
Before you can identify a person as a recruiter, he or she must first exist in your system.
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To see if the recruiter is already in your system, select Student Recruiting, Student Recruiters, Search
Match.

If you discover that the recruiter does not yet exist in your system, you can quickly add a record by
choosing Student Recruiting, Student Recruiters, Add/Update a Person.

Related Links
"Using Search/Match" (Campus Community Fundamentals)
"Adding an Individual to Your Database" (Campus Community Fundamentals)

Pages Used to Identify Recruiters

Page Name Definition Name Navigation Usage

Recruiters RECRUITERS Student Recruiting >
Student Recruiters >
Create/Update Recruiters >
Recruiters

Designate a person as a
recruiter or to update a
recruiter's information.

Recruiter Categories RECRUITER_RCR_CAT Student Recruiting >
Student Recruiters >
Create/Update Recruiters >
Recruiter Categories

Assign recruiting categories
to recruiters. This aids in
recruiter assignment. You also
assign recruiting categories
to prospects and applicants,
 enabling you to match
appropriate recruiters to
prospective students.

Recruiter Regions RECRUITER_REGIONS Student Recruiting >
Student Recruiters >
Create/Update Recruiters >
Recruiter Regions

Link recruiters at the career
level to specific geographic
regional assignments. You can
also use this page to exclude
recruiters from certain regions
or external organizations.

For example, you can assign
a recruiter to the Texas
region, but exclude him or
her from Abilene and Waco.
 You also link prospects and
applicants to geographic
regions, enabling you to
match appropriate recruiters
to prospective students.

Recruiter Centers RECRUITER_CENTERS Student Recruiting >
Student Recruiters >
Create/Update Recruiters >
Recruiter Centers

Link a recruiter to the
appropriate recruiting and
application centers, which is
beneficial for grouping and
reporting purposes. You can
link prospects to recruiting
centers and applicants to
application centers.
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Page Name Definition Name Navigation Usage

Recruiter Programs RECRUITER_PROGRAMS Student Recruiting >
Student Recruiters >
Create/Update Recruiters >
Recruiter Programs

Link recruiters to academic
programs and academic plans.

Designating Recruiters
Access the Recruiters page (Student Recruiting >Student Recruiters >Create/Update
Recruiters >Recruiters).

This example illustrates the fields and controls on the Recruiters page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Recruiter Type Select a recruiter type for this person. Values are Alumni,
 Faculty, Staff, and  Student. Recruiter types are delivered with
your system as translate values. You can modify these translate
values.

Recruiter Role Select one or more recruiter roles for this person. In our
example, John Chavez is both an evaluator and an interviewer.
 Add as many recruiter roles as are relevant to this person.
 A recruiter can recruit for more than one career. Add the
recruiter again, only select the relevant academic career when
prompted.

Recruiter roles are delivered with your system as translate
values. You can modify these translate values.

Assigning Recruiters to Recruiting Categories
Access the Recruiter Categories page (Student Recruiting >Student Recruiters >Create/Update
Recruiters >Recruiter Categories).
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This example illustrates the fields and controls on the Recruiter Categories page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Category Enter the appropriate recruiting categories for this recruiter.
 Define categories on the Recruiting Category Table page. In
the preceding page example, this recruiter is assigned to the
High Test Scores and Region recruiting categories.

Group The group to which this category belongs.

Assignment Stage For each category, select the appropriate stage of recruiting
in which this recruiter is involved. Values are Applicant,
  Prospect/Applicant, and Prospect. For track and field,
 basketball, and region, our example recruiter looks at
prospects and applicants. Values for this field are delivered
with your system as translate values. You can modify these
translate values.

Important! For your regional recruiters, assign a category of REGN. This is important for automatic
assignment of recruiters by region.

Linking Recruiters to Geographic Regions
Access the Recruiter Regions page (Student Recruiting >Student Recruiters >Create/Update
Recruiters >Recruiter Regions).
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This example illustrates the fields and controls on the Recruiter Regions page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Stage Select the stage of recruitment in which this recruiter is
involved for this region. Values are Applicant, Prosp/Appl 
(prospect/applicant), and Prospect. Stage values are delivered
with your system as translate values. Any modifications to
these values require a substantial programming effort.

Region Select a region for this recruiter. This can be a region where
this person recruits, or a region where this person does not
recruit. Define regions on the Region Table page.

Include/Exclude Choose whether to Include the recruiter in or Exclude the
recruiter from this region. If you select Include, the recruiter
can be assigned to prospects or applicants in any school in that
region. If you select Exclude, the recruiter can not be assigned
to prospects or applicants in any school in that region.

Note: First add the regions where this person recruits. Then,
 if you must exclude the person from certain areas, add those
rows last.
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Field or Control Description

External Org ID (external organization ID) If you want a recruiter to recruit at a school in a region from
which he or she is excluded (for example, include a school
in an excluded region), or if you do not want a recruiter to
recruit at a school in a region in which he or she is included 
(for example, exclude a school from an included region), enter
the external organization ID of the school you are including
or excluding. All schools within the postal code range of the
selected region are available.

Note: Be aware that you can only exclude or include a school 
(in the External Org ID field) from a region if the Region 
value entered is at the lowest level region node on your region
tree. If the region value is at any other level, you cannot access
the External Org ID  field.

Include/Exclude The display-only Include/Exclude  field (next to the External
Org ID  field) automatically contains the opposite value of
that entered in the Include/Exclude  field (below the Region 
field).

An Example of Including and Excluding Regions and Schools

You can be specific with your regional assignments. In the preceding page example, the recruiter is
assigned to the region California. But perhaps this person does not recruit for the Central Coast. To set
up this assignment, add a region row that excludes the California Central Coast region. This means the
recruiter is now assigned to California, except  for the Central Coast region. To further differentiate
matters, this recruiter makes an exception regarding the California Central Coast: she recruits at one
school within that region. As shown on the preceding page, recruiter John Chavez does not recruit in the
California Central Coast. However, he does make an exception for Seaside High School.

Note: The recruiting region assignment structure simplifies your reporting needs. You can assign
recruiters to very specific regions and still roll up your reporting to look at broad areas.

Associating Recruiters with Recruiting and Application Centers
Access the Recruiter Centers page (Student Recruiting >Student Recruiters >Create/Update
Recruiters >Recruiter Centers).

Field or Control Description

Recruiting Center Enter the recruiting centers to which this recruiter belongs
for each applicable academic career. This assignment enables
your admissions office to quickly identify its own recruiters. A
recruiter can belong to multiple recruiting centers.
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Field or Control Description

Application Center Enter the application centers to which this recruiter belongs
for each applicable academic career. This assignment enables
your admissions office to quickly identify its own recruiters. A
recruiter can belong to multiple application centers.

Note: For recruiters to have access to prospects and applicants within the recruiting and application
centers that you enter, you must grant the recruiters security access to these recruiting and application
centers via the Recruiting Center Security and Application Center Security pages.

Related Links
"Understanding Recruiting and Admissions Security" (Campus Solutions Application Fundamentals)

Linking Recruiters with Academic Programs and Academic Plans
Access the Recruiter Programs page (Student Recruiting >Student Recruiters >Create/Update
Recruiters >Recruiter Programs).

Associating recruiters with academic programs and plans helps to track academic associations for all
recruiters but is especially useful for graduate careers that typically offer many academic programs.

Note: Prospect records use the Last Prospect Date to determine if the program, plan, or subplan
should appear in the prompts. If the Last Prospect Date is populated on the Academic Program Table
(ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the date is less than or equal to the current date, the system does not display
the value in the prompt.

Field or Control Description

Academic Program Enter the academic programs in which this recruiter is
involved.

Academic Plan Enter the academic plans, within the chosen academic
programs, that apply to this recruiter.
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Setting Up Prospects

Setting Up Admission Installation Defaults

To set up admission installation defaults, use the Installation Defaults - AD component
(INSTALLATION_AD).

This section discusses how to set up admission installation defaults.

Page Used to Set Up Admission Installation Defaults

Page Name Definition Name Navigation Usage

Installation Defaults - AD INSTALLATION_AD Set Up SACR > Install >
Admissions Installation

Set up defaults, such as for
copying information between
application and prospect
records. For example, when
you add an application record,
 and a prospect record exists
for that applicant, you might
want to copy some of the
information from the prospect
record to the application
record.

Setting Up Admission Installation Defaults
Access the Installation Defaults - AD page (Set Up SACR >Install >Admissions Installation).
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This example illustrates the fields and controls on the Installation Defaults - AD page. You can find
definitions for the fields and controls later on this page.

Note: You must exit and reenter the application for installation defaults to take effect.

From Prospect to Application

Field or Control Description

Copy Data Select this check box if you want prospect information copied
to the application record. Clear this check box if you don't
want prospect information copied to a new application.

Matching Criteria

If you selected the Copy Data check box, choose the criteria that the system uses to update an application
with prospect information. Choose which data elements in your user defaults must match those of
the prospect record. When you add a new application, the system compares your user defaults to the
criteria that you select here. For example, if you select Career, Institution, and Admit Type, the system
compares the prospect's career, institution, and admit type to your user defaults. If it finds a match, the
system copies the prospect data into the new application. You must have defined user defaults for this
functionality to work.

See "Entering User Defaults" (Campus Solutions Application Fundamentals)

Data to Copy

If you selected the Copy Data check box, specify those data categories that you want carried to the
application from the prospect record. You can choose one or more of the following three categories:

• Recruiting categories.

• Last school attended and graduation date.
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• Financial aid, housing, admit type, and academic level and load.

The system updates the application with the selected data at the matching criteria level.

Only those matching recruiting categories with the Move to Application check box selected on the
Prospect/School Recruiting page are copied to the application record.

See Adding Prospects Through the Create/Update Prospects Component.

The preceding information is copied to the application initially, but if you later edit the application, the
prospect record does not change. Conversely, if you later edit the prospect record, the application does not
change.

Note: If you do not select the Copy Data  check box, the choices under the Matching Criteria and Data
to Copy group boxes do not affect anything in the system.

From Application to Prospect

If a prospect submits an application, you can update the prospect record with the relevant application
number for the career and program. If the application is for a program that is not included on the prospect
record, the system adds the new program information to the existing prospect record, including the career
and program to which the application pertains.

Field or Control Description

Update Data When you receive an application from an applicant with an
existing prospect record, select this check box to copy the
application number into the prospect record. The application
number appears on the Prospect Program Data page in the
Create/Update Prospects component. On the Prospect Career
Data page in the Create/Update Prospects component, the
Applied field is selected. Also, on the Prospect School/
Recruiting page, the Last School Attended,  Graduation Date,
 and Region fields are populated if they had no data in them on
the prospect record.

Note: If the prospect record does not include the program being applied to, the system adds that program
to the prospect record and updates it with the application information.

Create Prospect if no Match

You can receive applications from people for whom you have no existing prospect records. For historical
purposes, you might want to have a prospect record for all applications stored in your system. The
Campus Solutions enables you to create prospect records retroactively for all such applications.
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Field or Control Description

Create Prospect Select this check box to create a retroactive prospect record
for an applicant. You must have selected the Update Data
check box. When you save the new application, the system
automatically creates a prospect record. The new record
contains the following data from the application: admit
term, admit type, campus, academic level, academic load,
 academic program, academic plan and sub-plan, recruiting
status, application number, status date, last school attended,
graduation date and region. Recruiting center comes from your
user defaults. Additionally, the application number appears
on the Prospect Program Data page in the Create/Update
Prospects component, and the Applied field is selected on
the Prospect Career Data page in the Create/Update Prospects
component. The system only creates a prospect if a recruiting
center is defined in your user defaults.

Recruiting Status and Referral Source If you selected the Create Prospect check box, enter a
recruiting status and a referral source on the new prospect
record. Recruiting status values are delivered with your system
as translate values. You can modify these translate values.
 Define referral sources on the Referral Source Table page.

Appl on File Warning Criteria

Avoid entering duplicates when adding new applications. You can specify at what level the system warns
you that a potential duplicate application exists. For example, when saving an application, you might
want the system to notify you that an application with the same institution, career, program, and admit
term already exists for the person. Alternatively, you might want the system to warn you at a higher level,
when only the institution and career match. When the system warning appears, you can either save the
application or return to the application page without saving. Select your preference for being warned that
a potential duplicate application exists for a person.

Field or Control Description

Institution, Career If an application for this person exists with the same institution
and career as the application that you are saving, a warning
message appears.

Institution, Career, Program If an application for this person exists with the same
institution, career, and programs as the application that you are
saving, a warning message appears.
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Field or Control Description

Institution, Career, Program, Admit Term If an application for this person exists with the same
institution, career, program, and admit term as the application
that you are saving, a warning message appears.

If the system detects a potential duplicate when you save an
application, you get a warning such as the following:

"An application with Career (UGRD), Program (LAU), Admit
Term (0450) and Institution (PSUNV) already exists.

If you would like to create a new application with the same
Career, Program, Admit Term and Institution click the OK
button, otherwise click the Cancel button."

Student Response

Field or Control Description

Free Form Institution Select this check box to allow your users to enter a free-form
institution name on the Student Response page and to allow
students to enter a free form name on the self-service Accept
Admissions page. If you want users to select from a list of
external organizations that your institution has, clear this check
box.

You can use the Student Response page to capture reasons why
a prospect or applicant chose or rejected your institution. This
is important information that your institution might want to
track and report on. Your institution has the option of allowing
end users to enter the free-form name of a school when they
capture data on the Student Response page. You might want
to enable this option (on the Installation Defaults - AD page)
because a student can choose to attend an institution that is not
loaded as an external organization in your system.

See Updating Applications.
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Academic Interest

Field or Control Description

Use Priority Select this check box to enable the Academic Interest Priority
feature. To disable the Academic Interest Priority feature for
your institution, clear this check box.

The Academic Interest Priority feature enables you to capture
and view a prospect's or applicant's academic interest priority
ranking level. For example, pre-law could be their first level
academic interest priority and technology could be their
second level academic interest priority. This feature can
help in your enrollment management, recruiting efforts, and
reporting program evaluation. If you enable this feature, the
Priority field becomes active on the Academic Interests page.

See Prerequisites for Tracking Supporting Prospect and
Applicant Information

Last School Attended

Field or Control Description

Warn for Last School Attended Select this check box to have the following warning message
appear: "The Last School Attended will not be automatically
added to the academic history record."

This message appears if you enter a value in the Last School
Attended field on the Prospect School/Recruiting page or the
Application School/Recruiting page at the time of updating
a prospect or applicant record. You should use the External
Education page to update an applicant's or prospect's academic
history.

The warning message does not appear if you enter a value
in the Last School Attended field on the Prospect School/
Recruiting page or the Application School/Recruiting page at
the time of prospect or applicant creation.
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External Course Entry

Field or Control Description

Duplicate Course Warning Select this check box to warn the user that a duplicate external
course has been entered in the Education component. The
following message appears: "Warning - Duplicate row for
Subject (Subject) and Course Nbr (Course Number) in
Organization (Ext Org ID) (14200, 456)".

A duplicate course is defined as the same school subject and
course number for an external organization.

New Features

Field or Control Description

Fluid Self Service Select to indicate that Fluid features for Admissions self
service have been adopted. By default, this check box is
deselected.

This check box is for informational purposes only.

See:

• "Managing Applications Using PeopleSoft Fluid User Interface" (Campus Self Service )

• "Understanding PeopleSoft Fluid User Interface Homepages" (Campus Solutions Application
Fundamentals)

Setting Up Admit Types

To set up admit types, use the Admit Type component (ADMIT_TYPE_TABLE).

This section discusses how to set up admit types.

Page Used to Set Up Admit Types

Page Name Definition Name Navigation Usage

Admit Type Table ADMIT_TYPE_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Prospect/
Applicant Recruiting >
Admit Type Table

Define your institution's admit
type values. You can assign
an admit type to prospects
and applications to clarify the
type of prospect or applicant,
 such as first year, readmit, or
transfer.
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Setting Up Admit Types
Access the Admit Type Table page (Set Up SACR >Product Related >Recruiting and
Admissions >Prospect/Applicant Recruiting >Admit Type Table).

Field or Control Description

Academic Career Select the academic career to which this admit type is related if
you want this type available for only  that career. Do not select
an academic career if you want this admit type available for all
careers.

Readmit Processing Required Select this check box if the admit type requires you to admit a
person into an existing student record (for example, a person
applies to reenter a program they were previously studying
at your institution). When this admit type is entered on an
application record, the system populates an existing program
record rather than create a new record when the person
matriculates.

Setting Up Referral Sources

To set up referral sources, use the Referral Source component (REFERL_SRCE_TABLE).

This section discusses how to set up referral sources.

Page Used to Set Up Referral Sources

Page Name Definition Name Navigation Usage

Referral Source Table REFERL_SRCE_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Prospects >
Referral Source Table

Define your referral sources
and track how prospects or
applicants learned of your
institution. A referral source
indicates why this person
was originally added to your
database.

Setting Up Referral Sources
Access the Referral Source Table page (Set Up SACR >Product Related >Recruiting and
Admissions >Prospects >Referral Source Table).

Entering a referral source for a prospect records the initial contact made with this person. You can record
subsequent contacts with a person using the Communications Management pages.

Some individuals enter your database for the first time as an applicant. In such cases, you might want to
create a prospect record retroactively to record, among other information, a referral source.
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Related Links
Setting Up Admission Installation Defaults

Setting Up School Types

To set up school types, use the School Type component (LS_SCHL_TYPE_TABLE).

This section discusses how to set up school types.

Page Used to Set Up School Types

Page Name Definition Name Navigation Usage

School Type Table SCHOOL_TYPE_TABLE Set Up SACR > Common
Definitions > External
Education > School Type
Table

Set up school types
and categorize external
organization material.

Setting Up School Types
Access the School Type Table page (Set Up SACR >Common Definitions >External
Education >School Type Table).

School types are another way that the system categorizes external organization material. School
organizations are those that you probably use the most in Recruiting and Admissions. Assign school types
to an organization on the School Data page in the Organization Table component.

Field or Control Description

Advisement School Type If this is an advisement school, select an advisement school
type. Values for this field are delivered with your system as
translate values. You can modify these translate values.

Use Within Student Response When you are defining a school type code, you must also
specify whether this school type can be used with the Student
Response feature. Select this check box to enable student
response reasons when defining a school type on the School
Type Table page.

Canadian School Govt Class (Canadian school government
class)

This field only appears if your system installation country
equals CAN. In order to report the correct value for the school
type, select a Canadian classification value.

Use the values to define the schools type. Values are
Elementary, Post Sec, Secondary, University, and Unknown.
 These values are delivered as translate values. You can change
them.
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Field or Control Description

(AUS) DEEWR Credit Basis Enter the value to be reported for DIISRTE Element 561
Credit-Basis, if the school type is assigned to manual course
credits processed for the student. (DIISRTE - Department of
Industry, Innovation, Science, Research and Tertiary Education
- was previously DEEWR, and before that, was DEST.)

This field appears only if the DEST, HECS, Centrelink,
 TAC (Department of Education, Science and Training ,
 Higher Education Contribution Scheme, Centrelink,
Tertiary Admissions Centre) check box is selected on the SA
Features page.

(AUS) DEEWR Provider Type VET Enter the value to be reported for DIISRTE Element 564
Provider Type, if the school type is assigned to manual course
credits processed for the student.

This field is optional. If the school type is not used for VET
related study, you do not have to enter a value.

This field appears only if the DEST, HECS, Centrelink, TAC
check box is selected on the SA Features page.

Related Links
Setting Up Admission Installation Defaults
"Defining Organization Groups and Contacts" (Campus Community Fundamentals)
"Creating or Loading External Organization Codes" (Campus Community Fundamentals)
"Setting Up Organization Types" (Campus Community Fundamentals)

Setting Up Extracurricular Activities

To set up extracurricular activities, use the Extracurricular Activities component
(EXTRA_ACTIVITY_TBL).

This section discusses how to set up extracurricular activities.

Page Used to Set Up Extracurricular Activities

Page Name Definition Name Navigation Usage

Extracurricular Activity Table EXTRA_ACTIVITY_TBL Set Up SACR > Product
Related > Campus
Community > Define
Campus Community >
Setup > Extracurricular
Activity Table

Define extracurricular
activities for tracking,
 reporting, and recruiting and
admission purposes.
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Setting Up Extracurricular Activities
Access the Extracurricular Activity Table page (Set Up SACR >Product Related >Campus
Community >Define Campus Community >Setup >Extracurricular Activity Table).

This example illustrates the fields and controls on the Extracurricular Activity Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Activity Type Select an activity type. Activity type values are delivered with
your system as translate values. You can modify these translate
values.

Activity Offering

Select an option in the Activity Offering group box to indicate whether the activity is offered by your
institution (internal), by an external organization (external), or both.

Field or Control Description

Internal and External The activity is offered by your institution and by an external
organization. These activities are available in Recruiting and
Admissions and PeopleSoft Student Records.

Internal The activity is offered by your institution only. These activities
are available only in Student Records.

External The activity is offered by an external organization only. These
activities are available only in Recruiting and Admissions.
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Additional Elements

Field or Control Description

Extra Activity Primacy Enter the extra activity primacy number for this extracurricular
activity. Student Records typically uses this field for internal
extracurricular activities. The Consolidate Academic Statistics
process uses these primacy values to determine a student's
primary extracurricular activity when a student is active in
more than one academic career during an academic statistics
period. The system uses this number as a key to determine
the student's primary extracurricular activity. The consolidate
academic statistics process reports the student's extracurricular
activity that has the lowest primacy number.

Setting Up Honors and Awards

To set up honors and awards, use the Honors and Awards component (SA_HONORS_AWARDS).

This section discusses how to set up honors and awards.

Page Used to Set Up Honors and Awards

Page Name Definition Name Navigation Usage

Honors/Awards Table SA_HON_AWRD_TABLE Set Up SACR > Product
Related > Campus
Community > Define
Campus Community >
Setup > Honors and
Awards Table

Define internal and external
honors and awards.

Setting Up Honors and Awards
Access the Honors/Awards Table page (Set Up SACR >Product Related >Campus
Community >Define Campus Community >Setup >Honors and Awards Table).

You can store honors and awards, both internal and external to your institution, for prospects, applicants,
and students. You can define codes for honors and awards such as Dean's List, National Merit Finalist,
and Valedictorian. Note that these honors are non-degree related. Honors related to a degree are set up in
the Degree Honors Table page.

Field or Control Description

Internal/External Select a value to indicate whether this award or honor is
internal or external to your institution.
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Field or Control Description

Grantor Enter a grantor if one is associated with this award.

Transcript Level Select the transcript level for which you want the honor or
award to appear. Values are: Degr Prog (degree program), Not
Print, Official, Stdnt Life (student life), and Unofficial. This
field is only available if the Internal/External field is set to
Internal.

The transcript level is hierarchical, based on the two position
numeric codes in the value column of the translate table.
 Depending on the transcript level that you select, the system
prints the honor or award on that transcript type and all other
transcript types occurring below it on the translate table.

For example, if you select Official for your transcript level 
(which has a level value of 20 on the translate table), the
system prints the honor or award on all transcript types.

If you select Stdnt Life for your transcript level (which has a
level value of 60 on the translate table), the system prints the
honor or award only on student life transcripts (level 60) and
PeopleSoft Academic Advisement degree progress transcripts 
(level 80). The following table shows the hierarchy of these
transcript level values.

Value Translate Table Values Long Name for TRANSCRIPT
_LEVEL Field

00 Never Print

20 Print on Official

40 Print on Unofficial

60 Print on Student Life

80 Print on Degree Programs

Field or Control Description

Formal Description Enter a formal description of this honor or award. The formal
description is printed on the transcript if you have specified
that this award should be printed.
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Setting Up Student Groups

To set up student groups, use the Student Group component (STDNT_GROUP_TABLE).

This section discusses how to set up student groups.

Page Used to Set Up Student Groups

Page Name Definition Name Navigation Usage

Student Group Table STDNT_GROUP_TABLE Set Up SACR > Product
Related > Student
Records > Student
Standing and Awards >
Student Group Table

Define student groups and
track particular groups to
which a prospect or applicant
belongs. This data supports
application information.
 You can define any groups
that you want to record for a
prospect, applicant, or student.
 Student groups are also
used in PeopleSoft Student
Records.

Setting Up External Summary Types

To set up external summary types, use the Region component External Summary Type component
(EXT_SUMM_TYPE_TBL).

This section discusses how to set up external summary types.

Page Used to Set Up External Summary Types

Page Name Definition Name Navigation Usage

External Summary Type Table EXT_SUMM_TYPE_TBL Set Up SACR > Common
Definitions > External
Education > External
Summary Type Table

Define the types of summary
education information that
you want to capture from a
prospect or applicant. For
example, you might define
external summary types that
mirror academic levels on
a transcript, such as High
School Grade 9, High School
Overall, Undergraduate Third
Year, and Post-Baccalaureate
Overall.
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Setting Up External GPA Tables

To set up external GPA tables, use the External GPA Type component (GPA_TYPE_TABLE) and the
External GPA Rules component (GPA_RULES_TBL).

This section discusses how to:

• Define external GPA type codes.

• Set up external GPA conversion rules for GPA types.

Pages Used to Set Up External GPA Tables

Page Name Definition Name Navigation Usage

External GPA Type Table GPA_TYPE_TABLE Set Up SACR > Common
Definitions > External
Education > External GPA
Type Table

Set up grade point
average types for external
organizations.

External GPA Rules Table GPA_RULES_TABLE Set Up SACR > Common
Definitions > External
Education > External GPA
Rules Table

Define your GPA conversion
rules.

Defining External GPA Type Codes
Access the External GPA Type Table page (Set Up SACR >Common Definitions >External
Education >External GPA Type Table).

This example illustrates the fields and controls on the External GPA Type Table page. You can find
definitions for the fields and controls later on this page.
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Defining the External GPAs

If the outside GPA type has a name that is not descriptive or self-evident, you can use the GPA values
portion of this page to more clearly define the external GPAs that belong to this GPA type. You do not
need to fill in External GPA and Description fields if it is clear from the GPA type name exactly what it
means.

Field or Control Description

External GPA Enter the external GPA value for each GPA value.

Short Description Enter a short description–up to 15 characters–for each GPA
value.

Setting Up GPA Conversion Rules for GPA Types
Access the External GPA Rules Table page (Set Up SACR >Common Definitions >External
Education >External GPA Rules Table).

This example illustrates the fields and controls on the External GPA Rules Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Effective Date Enter an effective date for this GPA rule. If the effective date
is equal to or greater than the effective date for this GPA type,
 then this GPA rule is active.

Converted GPA Enter the converted GPA that applies to the range entered in
the From GPA and To GPA fields.
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Field or Control Description

From GPA  and To GPA You can enter any numeric value in these fields. If you defined
GPA values (on the GPA Type Table page) for this GPA type,
 you can prompt for those values, but you can also enter values
that are not defined. You can add as many converted GPAs as
required for a GPA type.

Reviewing Material Types and Defining Material Groups

To set up material groups, use the Material Type component (MATERIAL_TYPES) and the Material
Group component (MATL_GRP_TYP_TBL).

Your system is delivered with predefined material types. Material types are pieces of information that you
require for an application, such as letters of recommendation and transcripts. Group these types according
to the needs of your office.

This section discusses how to:

• View material types.

• Use the Material Type Field Usage page.

• Set up material groups.

Pages Used to Review Material Types and Define Material Group

Page Name Definition Name Navigation Usage

Material Type Table MATL_TYPE_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Material Type
Table

View material types and their
material data.

Material Type Field Usage MATL_TYPE_SP Click the  Material Data link
on the Material Type Table
page to view the Material
Type Field Usage page.

Review additional material
data content.

Material Group Table MATL_GRP_TYP_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Material
Group Table

Define material types into
groups. For example, you can
have one group of materials
for undergraduate auditions,
 one for graduate test scores,
 and one for medical external
courses.
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Viewing Material Types
Access the Material Type Table page (Set Up SACR >Product Related >Recruiting and
Admissions >Application Evaluation >Material Type Table).

This example illustrates the fields and controls on the Material Type Table page. You can find definitions
for the fields and controls later on this page.

The information on this page includes auditions, transcripts, external course work, letters of
recommendation and more. Recruiting and Admissions refers to all of this supporting application
information as material types.

Field or Control Description

General Material Material types that are designated as general materials—
the check box is selected—appear as a material type on the
General Materials page. When you enter general materials for
a prospect or applicant, you can choose only those designated
material types.

Material types that are not indicated as general materials—
the check box is cleared—appear on the Application Materials
page.

Material Data Click this link to display the Material Type Field Usage
page. This page is for informational purposes only. All items
marked with a Y or a 1 on the Material Type Field Usage page
are available to add to an application record on the General
Materials page. For example, the Recommendation material
type contains a Y for city, but nothing for essay topic. Thus,
 on the General Materials page you can enter a city for the
prospect but not an essay topic.
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Using the Material Type Field Usage Page
Access the Material Type Field Usage page (Click the Material Data link on the Material Type Table
page).

This example illustrates the fields and controls on the Material Type Field Usage page. You can find
definitions for the fields and controls later on this page.

If the General Material check box is cleared on the Material Type Table page, then that material type is
stored elsewhere for each person and then linked to actual applications on the Application Materials page.
For example, test scores (not a general material type) are linked to a person's ID on the Test Results page.
Specific test scores for that person can then be linked to an application. The material type values provided
with Recruiting and Admissions are the following:

Material Type Values General Material?

AUD - Audition Y

CRS - External Courses N

ESS - Essay Y

INT - Interview Y

POR - Portfolio Y

REC - Recommendation Y

SBJ - External Subjects N
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Material Type Values General Material?

SUM - Academic Summary N

TRN - Transcripts N

TST - Test Scores N

Setting Up Material Groups
Access the Material Group Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Application Evaluation > Material Group Table).

This example illustrates the fields and controls on the Material Group Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Material Type Enter the material types that you want in this group.
 A material group can consist of one or more material
types. For example, you can define a group called
Undergraduate Recommendations and assign the material
type Recommendation. You can define another group called
Undergraduate Portfolios and include the material types
Interview and Portfolio. A material type can be assigned to as
many material groups as needed.

Note: You can define as many material groups as necessary and you can choose from all material types.
You can include general and specific material types in the same group. We suggest that your institution
plan and name material groups to logically fit your application material requirements. For example, if
you create a material group called Graduate Tests,  link only relevant material types to this group. It is
unlikely that you would include the material type Recommendation within that material group.
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Setting Up Self-Service Request Information
and Using Self-Service Student Recruiting

Understanding Self-Service Request Information

PeopleSoft Campus Solutions and PeopleSoft Campus Self Service offer self-service applications that
are licensed separately. If you have licensed Campus Self Service, you can use the self-service pages
described here.

See "Campus Self Service Overview" (Campus Self Service )

This section lists prerequisites and discusses self-service request information.

Prerequisites
Before you can set up your parameters for the Request Information transaction, you must set up a
communications infrastructure in PeopleSoft Campus Community. The required steps for setting up
communications for the Request Information transaction include defining communication keys and
event IDs. All communications for the Request Information transaction must be defined using the
administrative function PSSV. You define communication keys on the Communication Speed Key Table
page.

Note: To access the Communication Speed Key Table page, you must enter an administrative function.
Enter PSSV (prospect self-service).

After you define communication speed keys, you must define event IDs. You define event IDs on the
Event Definition page. Event IDs contain the communication keys that you set up previously. You select
event IDs on the Web Prospect Setup 2 page. Event IDs contain the specific communications that the
prospect can choose from or automatically receive depending on your setup.

Note: To access the Event Definition page, you must enter an administrative function. Enter PSSV.

The Web Prospect Setup 2 page also enables you to control whether visitors can choose from a
selection of communications, depending upon the career of interest, or whether they are sent a default
communication. If you decide to let prospects select from a list of communications, you can define the
available choices.

Related Links
"Defining Communication Speed Keys" (Campus Community Fundamentals)
"Defining 3C Engine Events" (Campus Community Fundamentals)
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Requesting Self-Service Information
The PeopleSoft Learner Services self-service application enables you to capture prospect data over the
web. When visitors to your website request admissions information, they can enter information about
themselves that the system converts to prospect data. For example, they can enter academic interests,
test scores, academic program information, and more. The system takes this information and creates a
prospect record. To request admissions information, a visitor must have a user ID and password. This
is accomplished through the New User Registration process. After a visitor obtains a user ID, he or she
becomes a person in your database (the system assigns the person an ID and creates a biographic and
demographic data record for the person).

Note: New User Registration functionality is currently not delivered for requesting self-service
information. Check with your customer representative for the availability date.

After a person obtains a user ID and password, he or she has access to the Request Information feature.
However, before submitting the request for information, the system prompts the visitor for information
based on your setup options. The visitor enters the academic career in which he or she is interested, plus
the academic institution (if your institution is a part of a multi-institution system). You can decide what
other prospect data you want to collect. You can collect academic information, such as admit term, admit
type, campus, academic level, academic load, housing interest, and financial aid interest; and school
information, such as last school attended and graduation date. The information that the prospect enters
depends on your setup. Some pages and fields appear and hide depending on the information that you
want from prospects. For example, the Academic Interests and Test Results self-service pages are only
available if you select those segments on the Web Prospect Setup page.

After the visitor enters the information and submits the request, the system creates a prospect record. You
can view the new prospect record in the Prospect Data component. If you choose to collect academic
interest information, and the visitor chooses to enter this information, you can view the data in the
Academic Interests component. If you choose to collect test score data, and the visitor chooses to enter
this information, you can view the data in the Test Scores component. The system also updates the
Communication Management component for the person according to your setup and the prospect's
response. If a prospect record for that person already exists, the system updates the admit term, admit
type, last school attended, graduation date, academic program, and academic plan (assuming that you
chose to collect this data and that the visitor entered it).

You can edit the text messages on the Request Information self-service pages. These messages are in
the message catalog under the message set number 14230. Changing these messages is considered a
modification to your software.

Note: Campus Solutions offer self-service applications that are licensed separately. If you have licensed
the Campus Self-Service application you can use the self-service pages described here.

See "Campus Self Service Overview" (Campus Self Service )

Setting Up Self-Service Request Information

To set up self-service request information, use the Web Prospect Create component
(ADM_WEB_PRS_SETUP).
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Use the Web Prospect Create Table component to determine which information segments you want to
enable in the Request Information self-service transaction and to set up academic institution and career
parameters (such as which careers you want available to the visitor, and which recruiting center you want
assigned to that career).

This section discusses how to:

• Enable segments and prospect career fields.

• Set up institution and career parameters.

Pages Used to Set Up Self-Service Request Information

Page Name Definition Name Navigation Usage

Web Prospect Setup ADM_WEB_PRS_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > Prospects >
Web Prospect Create Table

Enable or disable Request
Information self-service
transaction segments and
prospect career fields.

Web Prospect Setup 2 ADM_WEB_PRS2_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > Prospects >
Web Prospect Create
Table > Web Prospect
Setup 2

Define institution and career
setup parameters for the
Request Information self-
service transaction. The
academic institutions and
careers that you select on this
page appear as choices on the
Request Information detail
page.

Enabling Segments and Prospect Career Fields
Access the Web Prospect Setup page (Set Up SACR > Product Related > Recruiting and
Admissions > Prospects > Web Prospect Create Table).
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This example illustrates the fields and controls on the Web Prospect Setup page. You can find definitions
for the fields and controls later on this page.

By selecting the check boxes on this page, you enable a segment or field to appear on the self-service
Request Information transaction. This enables you to choose what kind of information you collect
from prospects who request admissions information. The selections that you make here apply to every
academic institution in your system. Therefore, in a multi-institution system, each institution should agree
on how to complete this page.

Enable Segments

If you select the Academic Interests or the Test Results check boxes, the respective pages appear in the
Request Information self-service transaction. Visitors requesting admissions information have the option
of entering academic interest and test result information, which the system then stores in the Academic
Interest and Test Scores components.

If you select the Academic Program,  Academic Plan, and Academic Sub-Plan check boxes,
corresponding fields appear on the Request Information detail page. Visitors can use these fields to enter
the program, plan, and subplan that interests them. The system stores this information on the Create/
Update Prospects - Prospect Program Data page.

Enable Prospect Career Fields

Each check box in this group box corresponds to a field on the Request Information detail page. Select
the check boxes of the information that you want to collect from visitors who are requesting admissions
information. Each item in this group box corresponds to an item in the Create/Update Prospects
component. Thus, by selecting these check boxes, you can populate additional fields in the Create/Update
Prospects component (assuming that the visitor enters the information).
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Note: Clearing a check box in this group box hides its corresponding field on the Request Information
detail page. For example, if you clear the Academic Level check box, visitors to your website do not see
the Academic Level  field on the Request Information detail page.

Setting Up Institution and Career Parameters
Access the Web Prospect Setup 2 page (Set Up SACR > Product Related > Recruiting and
Admissions > Prospects > Web Prospect Create Table > Web Prospect Setup 2).

This example illustrates the fields and controls on the Web Prospect Setup 2 page. You can find
definitions for the fields and controls later on this page.

Acad Int/Test Results Defaults

Field or Control Description

Data Source Web is the default. You can change this value. The data source
posts to the Academic Interests and Test Results pages.
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Institution Setup Parameters

Field or Control Description

Academic Institution Enter the academic institution that you want to be available
to the visitor. If you enter more than one academic institution,
 visitors can select the academic institution that they are
interested in on the Request Information detail page. The
system uses the academic institution that the visitor selects
to create the prospect record. If you enter only one academic
institution, the system hides the Academic Institution field
on the Request Information page. In this case, the system uses
the one academic institution that you entered here to create
the prospect record. You must enter at least one academic
institution.

Recruiting Status Select the recruiting status that you want the system to assign
to the new prospect record. You can enter a different recruiting
status for each academic institution. The system assigns the
recruiting status to new prospect records, based on information
collected through the Request Information self-service
transaction.

Referral Source Enter the referral source for information collected through the
Request Information self-service transaction. You can enter
a different referral source for each academic institution. The
referral source that you enter here posts to the Prospect Career
Data page.

Career Setup Parameters

Field or Control Description

Academic Career Enter the academic careers that you want to be available for
the visitor to select. On the Request Information detail page,
 visitors can select the academic careers that interest them. The
system uses the selected academic career to create the prospect
record. You must enter at least one academic career.

Recruiting Center Enter the recruiting center that you want the system to assign
to the new prospect record. You can enter a different recruiting
center for each academic career. The system assigns the
selected recruiting center to new prospect records, based on
information collected through the Request Information self-
service transaction.
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Field or Control Description

Allow Prospect to Select Comm  (allow prospect to select
communication)

Select this check box to enable visitors to select from a list
of available communications. If you select this check box, a
group box that lists the communication items contained in the
event ID that you select appears on the Request Information
detail page. Visitors can select which items to receive. For
example, the UGRD Web Prospect event ID at PSUNV
includes communications containing information on financial
aid, campus housing, and undergraduate applications. Visitors
can choose one or more communications from this list.
 However, only those events that have the User Selection
check box selected on the Event Definition Setup page appear
as choices in the Event ID field, next to the Allow Prospect to
Select Comm field.

Send Default Communication Select this check box to send a default communication to all
visitors who request admissions information for this particular
academic institution and career.

Event ID Enter the event IDs that contain the communications that you
want mailed to visitors (for each academic career). Enter an
event ID in at least one of the Event ID fields. If both fields
are blank, then a visitor could submit a Request Information
request and receive a confirmation that the request went
through, without receiving any communication. The event ID
tells the system which communications to send to the visitor.
 Define event IDs on the Event page.

See "Creating an Event" (Campus Community Fundamentals).

Using Self-Service Student Recruiting for Recruiting and
Admissions

Campus Solutions offer self-service applications that are licensed separately. If you have licensed the
Campus Self-Service application, you can use the self-service pages that are described here.

Recruiting officers use Student Recruiting to view prospect and applicant information through self-service
pages. They can view the prospects and applicants that are assigned to them by category and region. They
can also view prospects and applicants for a specific organization.

Prerequisites
Before recruiting officers can view prospects and applicants through self-service pages, they must have
prospects and applicants that are assigned to them. Assign a recruiter to a prospect on the Prospect
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School/Recruiting page or through the Process Recruiters pages. Assign a recruiter to an applicant on the
Application School/Recruiting page.

Pages Used to Manage Student Recruiting for Recruiting and Admissions

Page Name Definition Name Navigation Usage

Prospects by Category - Select
Search Criteria

SS_ADM_PRS_REQ_CAT Self Service > Student
Recruiting > View
Prospects by Category

Recruiting officers use this
page to search for prospects
by category.

Prospects by Category -
Search Results

SS_ADM_PRS_SUM_CAT Click the Search button on
the Prospects by Category -
Select Search Criteria page.

Recruiting officers use this
page to view prospect search
results.

Prospect Programs ADM_PRSPCT_P_SEC Click the Program Detail
link on any one of the
prospect search results pages.

Recruiting officers use this
page to view program details
for a prospect.

Prospects by Organization -
Select Search Criteria

SS_ADM_PRS_REQ_ORG Self Service > Student
Recruiting > View
Prospects by Organization

Recruiting officers use this
page to search for prospects
by organization.

Prospects by Organization -
Search Results

SS_ADM_PRS_SUM_ORG Click the Search button on
the Prospects by Organization
- Select Search Criteria page.

Recruiting officers use the
page to view prospect search
results.

Organization Primary
Location

EXT_ORG_LOC Click the Org Primary
Location link on the
Prospects by Organization -
Search Results page.

Recruiting officers use
this page to view the
organization's primary
address.

Prospects by Region - Select
Search Criteria

SS_ADM_PRS_REQ_REG • Outreach > Recruiting
Officer > Home >
Recruiting > By Region

• Self Service > Student
Recruiting > View
Prospects By Region

Recruiting officers use this
page to search for prospects
by region.

Prospects by Region - Search
Results

SS_ADM_PRS_SUM_REG Click the Search button on
the Prospects by Region -
Select Search Criteria page.

Recruiting officers use this
page to view prospect search
results.

Applicants by Category -
Select Search Criteria

SS_ADM_APP_REQ_CAT • Outreach > Recruiting
Officer > Home >
Recruiting > By
Category

• Self Service > Student
Recruiting > View
Applicants By Category

Recruiting officers use this
page to search for applicants
by category.
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Page Name Definition Name Navigation Usage

Applicants by Category -
Search Results

SS_ADM_APP_SUM_CAT Click the Search button on
the Applicants by Category -
Select Search Criteria page.

Recruiting officers use this
page to view applicant search
results.

Applicants by Category -
Program Detail

SS_ADM_APPL_PROG_C Click the Program Detail
link on any one of the
applicant search results pages.

Recruiting officers use this
page to view program details
for an applicant.

Applicants by Category -
Application Status

SS_ADM_APP_ST_CAT Click the Application Status
link on the Applicants by
Category – Program Detail
page.

Recruiting officers use this
page to view a person's
application status.

Applicants by Organization -
Select Search Criteria

SS_ADM_APP_REQ_ORG Self Service > Student
Recruiting > View
Prospects by Category >
View Applicants By Org

Recruiting officers use this
page to search for applicants
by organization.

Applicants by Organization -
Search Results

SS_ADM_APP_SUM_ORG Click the Search button
on the Applicants by
Organization - Select Search
Criteria page.

Recruiting officers use this
page to view applicant search
results.

Applicants by Region - Select
Search Criteria

SS_ADM_APP_REQ_REG Self Service > Student
Recruiting > View
Applicants By Region

Recruiting officers use this
page to search for applicants
by region.

Applicants by Region - Search
Results

SS_ADM_APP_SUM_REG Click the Search button on
the Applicants by Region –
Select Search Criteria page.

Recruiting officers use this
page to view applicant search
results.
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Chapter 5

Setting Up and Working with Approvals

Understanding Approvals

Many daily tasks are part of a larger process that involves several steps and people working together,
such as the approval of a promotion. To facilitate this type of multiuser process, PeopleSoft provides
approvals functionality, which enables you to automatically trigger workflow notifications to inform the
next approver in the process of pending transactions.

While many PeopleSoft applications are delivered with predefined approval processes, PeopleSoft
Recruiting and Admissions delivers proofs-of-concept transactions. Because each admissions office
business practice may differ in terms of how an admissions approval request is handled (for example),
the proofs of concepts are examples of basic transactions that utilize one level and path. You can use
the delivered transactions if they meet your business needs, or modify them to meet your business
requirements. You can also create new transactions and reuse the approval objects to support an
admissions transaction.

Before implementing, you should read all relevant sources of information to gain a complete
understanding of how the pieces fit together.

• The topics in this section provide PeopleSoft Recruiting and Admissions product specifics of the
Approval Framework functionality as well as Fluid Approvals. The documentation lists the navigation
and additional topics specific to setting up approvals for admissions.

• Application-specific Campus Solutions documentation such as PeopleSoft Self Service and
PeopleSoft Recruiting and Admissions explain related setup topics for self service admissions using
PeopleSoft Fluid User Interface.

• PeopleSoft Approval Framework describes the common Approval Framework functionality that
applies to all product families.

Approval Framework

The Approval Framework is the engine that provides the framework and capabilities for creating, running,
and managing approval processes. The engine uses a series of database objects combined with application
component configuration settings to determine how to process approvals using workflow.

Approval workflows are triggered when requesters submit a transaction, such as a promotion. The
application hands the transaction over to the Approval Framework, which finds the appropriate approval
process definition and launches the approval workflow. A set of approvers then carry out tasks related to
the transaction.

The Approval Framework enables three levels of users to develop, configure, and use transaction
approvals that meet their organizational requirements. For example, the process of submitting a deferral
request, and getting it approved requires defining who will approve the promotion, the order in which
they will approve it, and how it will be routed to approvers.
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In contrast to the standard PeopleSoft workflow, which requires advanced technical skills in PeopleSoft
PeopleTools to create and maintain, approval workflow provides an alternative workflow that is much
easier to create, configure, and maintain. For example, all of the steps in approval workflow are defined
using PeopleSoft pages rather than underlying PeopleSoft PeopleCode, so functional users can design and
maintain workflow using these online PeopleSoft pages instead of requiring technical developers to create
workflow rules.

For more information about the Approval Framework features and process flow, see “Understanding the
Approval Framework” in PeopleSoft Approval Framework.

Approvals Terminology

The following terms are important in understanding the approvals functionality and are used throughout
this section.

Field or Control Definition

Approval Process A generic term referencing the business process of how a particular transaction is
routed for approval within an organization.

Approval Framework Engine that provides capabilities for the creation, execution, and management of
approval processes.

Approval Process Definition The definition of an approval process within the Approval Framework. The definition
may contain stages, paths, steps, varying hierarchies, and criteria, among other
configurable parameters.

Approval Process Definition ID 
(Process ID)

The ID associated with a particular approval process definition in the Approval
Framework. Each transaction registered with the Approval Framework must have at
least one process ID defined.

Request A transaction that uses the Approval Framework for approval processing. For example,
 a promotion, transfer time off request, job requisition, and so on.

Approval Step or Step A step has one or more approvers, whose actions are tracked. A step can be configured
to require a set number of approvers to act, and has criteria which govern whether or
not the step is to be active for the request under consideration. Steps are sequential.

Approval Path or Path A path is a sequence of steps. For example, step two routes to its approvers only after
step one is approved. A given approval could actually go through multiple approval
paths based on some decisions. Paths can be mutually exclusive or parallel. They all
converge at the final approval.
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Field or Control Definition

Approval Stage or Stage A stage is a collection of approval paths. Approval stages come in a single sequence 
(stage 1, stage 2, and so on). An approval stage runs when it's immediately preceding
stage finishes. When an approval stage runs, all the approval paths within it run
simultaneously. The approval stage is considered complete when all approval paths
within it have finished.

Approver The person who has been determined to have the authority to approve (deny, pushback,
 and so on) a request.

Requester and Originator The requester is the person for whom you want the Approval Framework to treat as the
initiator of a request. In most cases the requester and originator are the same person.
 However, when using the Delegation feature the requester and originator of a request
can vary. For example, if a manger delegates a transaction to a direct report and that
direct report submits the transaction, the direct report is the originator and the manager
is the requester.

Subject The person for whom a transaction is being processed.

Supervisor or Manager The person who has management responsibilities for the requester or for an approver,
 as defined in your direct report settings during implementation.

Approvals Administrator or Approval
Framework Administrator

The system administrator who is responsible for configuring, managing,
 troubleshooting, and maintaining approvals.

Event or Approval Event The Approval Framework engine is event driven. Events are typically actions that can
be taken by a user in the system, actions such as submit, approve, deny, push back, and
so on.

Status or Approval Status Statuses typically represent the overall state a transaction is in, such as pending, on
hold, approved, denied, terminated, and so on.

Approval Criteria Rules used to decide whether or not approval is required. Approval criteria fields
and dimensions are data elements and attributes that are used to define the approval
criteria.

Approval Hierarchy The organizational hierarchy that models the actual approvals required by a transaction
type (for example, approval hierarchy by supervisor or department).

User List Collection of users (PeopleSoft Operator IDs) expressed as the result of an SQL
statement, PeopleSoft role, or PeopleSoft Application Class.
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Field or Control Definition

Alternate Approver or Alternate User
ID

A user can have another user in the system as his or her alternate approver for
a specified period of time. This is set on the Workflow page of the User Profile
component within PeopleTools security.

Delegation Delegation is when a person authorizes another to serve as a his or her representative
for a particular task of responsibility. With the Delegation feature, users can authorize
other users to perform managerial tasks on their behalf by delegating authority to
initiate or approve managerial transactions.

Implementing Campus Solutions Transactions for Approval
Framework

Campus Solutions delivers approval transactions for common admissions requests that have basic
configuration to work with Approval Framework. You should review the delivered transaction data within
the application pages to ensure that the data fits your business processes.

To deploy an approval transaction and review delivered transactions for use with Approval Framework,
do the following:

Register the approval transaction in the Approval Framework

Use the Register Transactions page (Enterprise Components >Approvals >Approvals >Transaction
Registry) to link the components, event handler, records, and classes that you created into the approval
process for an application transaction, such as a deferral request. Application developers register the
main records and components that make up the transaction, then functional business analysts select the
approval transaction on which to base the approval process definition.

Campus Solutions delivers the following Registered Transactions Process IDs:
SAD_DEFR_APPROVAL, SAD_CHPP_APPROVAL, SAD_WITH_APPROVAL.

These IDs correspond to the types of requests an applicant can make through Fluid Self Service
(Applicant Homepage). You can use these process IDs as is if they meet the business needs, or use them
as examples to create a new process ID. You can also reuse the objects in the delivered transactions
(components, event handler, records, classes) in another applicant Self Service-related process ID.

For more information on the Register Transactions page, see PeopleSoft Approval Framework, Defining
the Approval Transaction Registry, Setting Up the Transaction Registry.

Set up the configuration options for the approval transaction

Use the Configure Transactions page (Enterprise Components >Approvals >Approvals >Transaction
Configuration) to select and define elements that determine what triggers a notification, who receives
the notification, and the content of the notification. Notifications are mapped to work with the approval
transaction registry and include menus and components and SQL definitions.
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Campus Solutions provides an accompanying Transaction Configuration for each Process ID that is
delivered in the Transaction Registry. If you create new Process IDs to use in Applicant Self Service
Approvals, you must create a corresponding Transaction Configuration for each Process ID. You can
reuse the delivered objects in new Transaction Configurations.

Note: Campus Solutions delivers notifications at the Approval Process Definitions level to allow for more
granular control of the notification messaging. You can set up notifications at this level.

For more information on the Configure Transactions page, see PeopleSoft Approval Framework, Defining
the Approval Transaction Registry, Configuring Approval Transactions.

Set up the approval process definition

Use the Setup Process Definition page (Enterprise Components >Approvals >Approvals >Approval
Process Setup) to define an approval definition process. The process is made up of stages and their paths
and steps. The approval steps that you place on the approval path represent the approval levels that are
required for a transaction. Multiple definition IDs may be created under one Process ID.

Campus Solutions delivers a Process Definition ID as a proof of concept for each Process ID that is
delivered. It is expected that customers will want to create their own definition IDs because it is at this
level where approvers, notifications, process flow, and security access are defined.

You would associate the Definition ID under one of the delivered Process IDs
(SAD_DEFR_APPROVAL, SAD_CHPP_APPROVAL, SAD_WITH_APPROVAL). In the Admissions
Self Service Fluid setup, a user would associate the process ID and the definition ID to a setup sequence
number under the high level keys of Institution, Career and Term. By linking the Definition ID to a
sequence, the user can tailor which definition to invoke for the user list, workflow processing, and
notifications.

For more information on the Setup Process Definition page, see PeopleSoft Approval Framework, Setting
Up Approval Framework Process Definitions, Defining the Setup Process Definitions Component.

Create email templates for the approval transaction

Use the Generic Template Definition page (Enterprise
Components >Approvals >Approvals >Approval Process Setup) to create a notification template.
The notification template allows notifications to be deployed within an approval flow.

Campus Solutions delivers a generic template for each approval transaction: SAD_DEFR_ROUTING,
SAD_CHPP_ROUTING, SAD_APPWTHDRW_ROUTING.

You can use the delivered generic templates as is, or use them as examples when you create a new
notification message. Each template uses the SQL identifier SAD_AWE_GEN_EMAIL_BIND. The SQL
identifier extracts data to get content for the email. The SQL must accept bind inputs equal to the number
of keys at the notification level. For example, header or line keys. You can use the SQL identifier for any
new template.

For more information on the Generic Template Definition page, see PeopleSoft Approval Framework,
Defining Notification Templates and Users for Approval Framework, Defining Notification Templates for
Approval Framework.
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Maintain user list definitions for the approval transaction

Use the User List Definition page (Enterprise Components >Approvals >Approvals >User List
Setup) to define users for the approval framework.

A user list is a collection of users (PeopleSoft Operator IDs) expressed as the result of an SQL statement,
PeopleSoft role, or PeopleSoft Application Class. User lists are used to represent the business process of
your approval hierarchy on a transaction-by-transaction basis. As an example, Campus Solutions delivers
one user list: SAD_SAMPLE_APPRV. This list is based on the role of CS – Administrator. It is expected
that you will want to create distinct user lists which make sense for the approval transaction definition.

For more information on:

• the User List Definition page, see PeopleSoft Approval Framework, Defining Notification Templates
and Users for Approval Framework, Defining Users for Approval Framework.

• administering and monitoring approvals, see PeopleSoft Approval Framework, Using the Approval
Monitor.

Set up the appropriate permission lists, roles, and web libraries

Use the PeopleTools security components to set up the applicable permissions lists, roles, and web
libraries.

Campus Solutions delivers the AWE Administrator role so that administrative users can use the Approval
Framework. The HCCPSCAW1010 permission list is assigned to this role, but the role is not attached
to any user (as delivered). If you do not have an application-specific administrator role, then you can
use this role by associating with any of your administrator users. If you do have an application-specific
administrator role within your organization, then Campus Solutions recommends that you associate the
HCCPSCAW1010 permission list to that role.

For approvers who should take action on an approval request, their user profile must:

• Be associated with a role to view the approval request, and access must be granted in the user list and
definition setup.

• Have access to the component to view the approval request. This can take two forms:

• For PeopleSoft Fluid User Interface, the role of Approvals Fluid must be granted.

• For classic user interface, a role or permission list must be granted to access the menu
SAD_REQ_APPROVAL, and components SAD_REQ_DEFR, SAD_REQ_CHPP,
SAD_REQ_WITH.

For information on PeopleTools security components, see PeopleTools: Security Administration.

Related Links
Approving Admissions Transactions Using PeopleSoft Fluid User Interface
"Managing Applications Using PeopleSoft Fluid User Interface" (Campus Self Service )
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Approving Admissions Transactions Using PeopleSoft Fluid User
Interface

The PeopleSoft Approvals feature provides a way for approvers to take Application Workflow Engine
(AWE) actions on PeopleSoft transactions pending their approval, but can do so using any device.

To use the Fluid Approvals feature, applications must utilize the Enterprise Components – Approval
Framework technology, also known as Approval Workflow Engine (AWE). This technology comprises
Enterprise Objects Approval Workflow (EOAW), Application Workflow Engine (AWE), and Enterprise
Objects Page Composer (EOPC). All transactions must be created in the database and adhere to the
Approval Framework logic and configuration within each application.

Because Fluid Approvals uses EOPC, transaction entries must be created in the Mobile Approvals
Options component, Transactions page (Enterprise Components >Approvals >Approvals >Mobile
Approval Options). Campus Solutions delivers Page Composer compositions for each approval
transaction as well as the underlying setup in the Page Composer Administrator. These compositions can
be used as delivered. Page Composer does allow for user changes to the layout, style, or formatting so you
can modify the compositions as necessary.

To use the Approvals feature, you must use PeopleTools 8.54.27 and higher or PeopleTools 8.55.10 and
higher.

This section describes how to access the approval pages and which pages to use to approve admissions
transactions.

Related Links
"Understanding PeopleSoft Fluid User Interface Homepages" (Campus Solutions Application
Fundamentals)

Pages Used to Approve Admissions Transactions Using PeopleSoft Fluid
User Interface

Page Name Definition Name Usage

Approvals Tile (Fluid Approvals) HMAP_APPR_TILE_FL Access the approvals pages and review
pending and historical approval requests.

This tile is delivered as part of Enterprise
Components and Approvals Framework.
To deploy and access this tile, users must
have the Approvals Fluid role. Like any
tile, as long as security is granted, the
tile can be included on any home page.
Campus Solutions does not associate this
tile with a specific home page.

Pending Approvals EOAWMA_MAIN_FL Lists pending approval requests requiring
the attention of the logged-in manager.
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Page Name Definition Name Usage

Pending Approvals - <Transaction
Details>

EOAWMA_TXNHDTL_FL Review the approval request details,
 enter a comment, and approve, deny, or
push back the request.

Approvals History EOAWMA_MAIN_FL Lists approvals you have worked on in
the past.

Approvals History - <Transaction
Details>

EOAWMA_TXNHDTL_FL View details about an approval request
you have already worked on.

Approving Admissions Transactions Using Classic User Interface

This section discusses which pages approvers use to approve or deny requests for deferral, changes to
program or plan, or withdrawal using the classic interface.

Pages Used to Approve Admissions Transactions Using Classic User
Interface

Page Name Definition Name Navigation Usage

Approval for Deferral Request SAD_REQ_DEFR Student
Admissions >Applicant
Request >Approval

View the status and details
of approval transactions
requests, approve or deny the
request.

Approval for Change Prog/
Plan

SAD_REQ_CHPP Student
Admissions >Applicant
Request >Approval

View the status and details
of approval transactions
requests, approve or deny the
request.

Approval for Withdraw
Request

SAD_REQ_WITH Student
Admissions >Applicant
Request >Approval

View the status and details
of approval transactions
requests, approve or deny the
request.
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Using Admission Applications Web
Services

Understanding AAWS

Admission Applications Web Services (AAWS) can be used by end user devices (such as a browser or a
PDA), enterprise applications or any other third party software that can interface through standards based
means.

AAWS can be used by:

• Oracle presentation technologies, such as Portal, Application Development Framework (ADF), and
PeopleSoft components and pages.

• Oracle middleware (such as Enterprise Service Bus and BPEL).

• Oracle Applications (such as Enterprise, EnterpriseOne, and E-Business Suite).

• Third party presentation technologies

• Third party middleware and applications.

Different academic institutions have different needs for capturing admission application data. Also,
application data can vary within the same academic institution between various campuses, departments,
careers, and types of applicants. For example, application data for international and domestic applicants
can vary within the same institution. This creates the need for institutions to develop their own online
application user interface that can interact with the Campus Solutions system. With AAWS, institutions
can connect their online application with the Campus Solutions system.

AAWS provides the SAD_ADMISSIONS service that enables access to the Campus Solutions Recruiting
and Admissions functionality. The SAD_ADMISSIONS service provides the following service
operations:

Service Operation Description

SAD_CREATEAPP Create admission application

SAD_SAVEAPPL Save admission application

SAD_SUBMITAPPL Submit admission application

SAD_GETAPPLS Get admission applications
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Service Operation Description

SAD_GETAPPL Get admission application

SAD_GETATTACH Get admission attachments.

With these service operations, AAWS offers functionality in the following areas:

• Admission Applications: Users, such as applicants, can use an online application user interface to:

• Create admission applications in the Campus Solutions system.

• Save, update, or submit the applications.

• Retrieve an application to make further updates.

• Application Attachments: Online application users can associate attachments of various formats
with an admission application. Administrators can track these attachments using the Application
Transactions and Maintain Application components.

Note that when an online application invokes SAD_SAVEAPPL or SAD_SUBMITAPPL service
operation, the system generates an admission transaction. This admission transaction contains the
admission application data that the user has saved or submitted. An admission transaction is defined
and configured using the CTM pages and Application Configuration component. You can use the
delivered Application Transactions and CTM Constituent Staging components to review, edit, and post
the application and applicant data in an admission transaction. Additionally, you can choose to post the
transactions in batch.

Constituent Transaction Management (CTM), which is a Campus Community feature, provides the
following two service operations related to New User Registration (NUR):

Service Operation Description

SCC_USERREG_CREATEACCT Create user account

SCC_USERREG_AUTHENTICATE Authenticate user

You can use these NUR service operations to:

• Provide usernames and passwords for access to your online application.

• Authenticate users who want to retrieve a saved application for further edits and submission.

The List of Values framework is also a Campus Community feature. The framework provides the
SCC_GET_LOV service operation. An online application can use this service operation to retrieve the list
of values from the Campus Solutions system for data entry fields on the online application. This is useful
only if the online application user interface is built outside of your Campus Solutions system.
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Service Operation Description

SCC_GET_LOV Get List of values

AAWS uses the following Student Financials payment integration service operations to enable application
fees calculation and payment:

Service Operation Description

SSF_INITIATE_EPAYMENT Initiate an ePayment.

SSF_COMPLETE_EPAYMENT Complete an ePayment.

All of these service operations use PeopleTools Integration Broker for interacting with the online
application. Any online application user interface that is web-service enabled and SOAP compliant can
access these service operations. AAWS adheres to open web service standards supported in PeopleTools.

Before developing your online application user interface, we recommend that you use a SOAP service
tester to become familiar with how the web services processes the admission application data and user
information. One way to use a service tester could be by first passing the input parameters to a service
operation and then viewing the service operation output.

Assessing Staff Skills
Developers working on the implementation of AAWS should have strong skills in:

• A tool or technology to build and deploy an online application user interface.

• PeopleSoft Integration Broker.

• PeopleCode.

• Web services concepts mainly XML, SOAP, and WSDL.

• Campus Community Entity Registry functionality.

• Recruiting and Admissions functionality.

• Campus Community Constituent Transaction Management functionality.

Setups for AAWS
The key setup areas that apply to AAWS are:

• PeopleTools Integration Broker.

• Campus Community Constituent Transaction Management (CTM).

• Campus Community Entity Registry.
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• Application Configuration (Configuring admission transactions).

• Campus Community List of Values.

• Attachments URL.

• Hosted Payment.

See Also
The following documentation should be reviewed as part of your AAWS implementation

• What is SOLA

• AAWS Documentation - Proactive Information and Known Issues in My Oracle Support (ID
1427475.1)

• Understanding Admission Transactions

• "Using the SSF_EPAYMENT_TRANS Web Service" (Student Financials)

• "Understanding CTM" (Campus Community Fundamentals)

• "Understanding New User Registration" (Campus Community Fundamentals)

• "Understanding Entity Registry" (Campus Community Fundamentals)

• How to Test AAWS and Hosted Payment SSF_INITIATE_EPAYMENT Service Operation Tester in
My Oracle Support (ID 1349409.1)

• "Understanding the Generic Service Tester" (Campus Community Fundamentals)

• "Understanding Get List of Values Web Service Operation" (Campus Community Fundamentals)

• Product documentation for PeopleTools: Integration Broker

AAWS and List of Values Framework

An online application user interface that you construct outside of the PeopleSoft Campus Solutions
database may contain data fields that have predefined or prompt values. The user interface can use such
fields to control and streamline data entry for the user. You set up these values in the PeopleSoft Campus
Solutions database. To display these values on the user interface, whether it is for a prompt field or a
field that contains translate values, you can use the List of Values service (SCC_GET_LOV). The service
recognizes and provides the values that are used to populate drop-down list boxes and for validating
selections on a user interface.

CTM Self-Service and Administrator Modes

In the Self-Service mode, an applicant creates and submits an admission application through AAWS.
In the Administrator mode for AAWS, the administrative user creates and submits an application on
behalf of an applicant. The administrator may create the application for an existing EMPLID (if the
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administrator knows the applicant’s ID when creating the application), or for an unknown or new
applicant.

In the Administrator mode, the system associates the application with the administrator’s user ID. You
can view this association on the Application Transactions component when reviewing the submitted
applications. In other words, you can use the Application Transactions component to see which
administrator has created an application for an applicant.

In the Self-Service mode, the system associates the application with the applicant’s user ID.

In the Administrator mode, the user must provide an institution and application center to create an
application. The system enforces application center and academic structure security for the administrative
user.

If an administrator saves an application, another administrator cannot submit it through AAWS. However,
the other administrator can use the Application Transactions staging component to update the application
status to submitted and post the application.

In the Administrator mode, the Get Applications service operation call returns only in-progress
applications, that is, applications which have not been posted or cancelled. It is optional for an
administrator to provide an EMPLID for a Get Applications call. If the administrator does not provide an
applicant’s EMPLID, the system returns all the in-progress applications.

The Administrator mode is activated by the presence of optional tag <SCC_ADMIN_MODE> in an
incoming message.

This image shows the SCC_ADMIN_MODE parameters.

For example, the following is a request message for the service operation SAD_CREATEAPPL that
contains the SCC_ADMIN_MODE tag:

<?xml version="1.0"?>
<SAD_CREATEAPPL_REQ xmlns="http://xmlns.oracle.com/Enterprise/HCM/services">
  <SCC_ADMIN_MODE>
    <INSTITUTION>PSUNV</INSTITUTION>
    <ADM_APPL_CTR>BUSN</ADM_APPL_CTR>
  </SCC_ADMIN_MODE>
  <COUNTRY></COUNTRY>
  <CITIZENSHIP_STATUS></CITIZENSHIP_STATUS>
  <PREFERENCES>
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    <PREFERENCE>
      <INSTITUTION>PSUNV</INSTITUTION>
      <ACAD_CAREER>BUSN</ACAD_CAREER>
      <ACAD_PROG>GRFIN</ACAD_PROG>
      <ACAD_PLAN>FINANC-MBA</ACAD_PLAN>
      <ACAD_SUB_PLAN></ACAD_SUB_PLAN>
      <ADMIT_TYPE>FYR</ADMIT_TYPE>
      <ADMIT_TERM>0630</ADMIT_TERM>
    </PREFERENCE>
  </PREFERENCES>
</SAD_CREATEAPPL_REQ>

Integration with Other Campus Solutions Components

AAWS interacts with the following Campus Solutions components:

• User Account Manager

• Constituent Transaction Manager

• Admissions API

• Student Financials Hosted Payment

This section discusses the application packages and classes for these components. If you want to
customize AAWS, you may need to modify some of these classes and packages. For instance, if you want
to integrate a non PeopleSoft user management system with AAWS, a new application class should be
created that implements SCC_IDENTITY_MGR:INTFC:IIdentityManager. The application class must
then be added to the table SCC_IDM_INST.
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This diagram illustrates that AAWS architecture is composed of SOA UI, web services for user
registration, authentication and admission applications, and the User Account Manager, Constituent
Transaction Manager and Admissions API interfaces.

User Account Manager
The user registration and authentication web service operations interact with User Account Manager
to register and authenticate the end user. PeopleTools User Profile, by default, stores the user account
information.

The User Account Manager component contains a number of sub-modules including the Campus Identity
Manager and the User Manager. The following graphics show the core application packages and classes
which support the User Account Manager:
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This image illustrates the Campus Identity Manager.

Class Description

CampusIdentityManager Manages all aspects of Self Service Transactions interactions
with any configured Identity management system or New User
Registration module. Call getInstance() on this class to get
access to a concrete IDM implementation.

HANDLERS:UserRegistration Implements the User Registration Web Service, the register &
authenticate operation.

INTFC:IIdentityManager Represents the functionality available through any typical
generic Identity Manager product. All access to IDM functions
will occur through this interface whether from code level API
calls or webservices.

SAMPLE:PeopleSoftIDMImpl The peoplesoft default implementation of IIdentityManager.
 Performs all Identity Management tasks against the peoplesoft
db.

UTIL:IdentityException All exceptions generated from within the IdentityManager
interface should extend this class.

UTIL:ResultSet Represents a tabular data object that is the basis for many of
the Identity Manager operations.
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This image illustrates the User Profile Manager.

Class Description

UserManager Main API for user manager.

UserProfile A data object to store user profile information.

TRANSACTION:UserRegTransaction This handles the posting activities for User Registration
sourced data as directed by the Constituent Staging
framework. Note: This is not the implementation currently
used.

UTIL:MessageHandler Handles any messages, warnings, errors generated during User
Management.

UTIL:UserManagementException All exceptions generated from within the UserManager
interface should extend this class.

Constituent Transaction Manager
Constituent Transaction Manager handles the admission application and applicant data that AAWS
receives and sends to the user interface. When the user interface submits the application and applicant
data, AAWS transmits this data to the Constituent Transaction Manager. The Constituent Transaction
Manager stores this data in Campus Solutions staging tables.

Constituent Transaction Manager is composed of a number of application classes and PeopleTools
components which support the staging and loading of constituent (applicant) and related transaction
(application) data into staging tables.

The following graphics show the application packages and classes in the Constituent Transaction
Manager component:
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This image illustrates the Constituent Transaction Manager (1 of 4).
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This image illustrates the Constituent Transaction Manager (2 of 4).
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This image illustrates the Constituent Transaction Manager (3 of 4).
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This image illustrates the Constituent Transaction Manager (4 of 4).

Admissions API
The Admissions Applications Programming Interface (API) moves the application data from the staging
tables to the core Recruiting and Admissions tables.

The API supports the creation, modification, and submission of online admission applications. The API is
an Object Oriented (OO) based application class hierarchy that represents the admission applications. The
class hierarchy contains an Application Manager API that performs key functions with application data.
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The API also supports the calculation of Application Fees via integration to the Application Fee hosted
payment processing.

The following graphics show the application packages and classes in the Admission Applications
Manager component:

This image illustrates the Admission Applications Manager (1 of 3).
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This image illustrates the Admission Applications Manager (2 of 3).

This image illustrates the Admission Applications Manager (3 of 3).

The Entity Registry feature enables academic institutions to create their own application data extensions
(that is, you can add entirely new application child entities).

AAWS and Entity Registry

AAWS uses the Entity Registry feature to exchange data between the Campus Solutions system and the
online application.

This section discusses the delivered Application and Constituent entities.

Copyright © 1988, 2021, Oracle and/or its affiliates. 107



Using Admission Applications Web Services Chapter 6

Application
The message SCC_ENTITY_APPLICATION contains the complete view of an admission application.
The message uses the schema generated by the Application entity. The system derives the Application
entity from the complete set of data available within the Campus Solutions Recruiting and Admissions
core data model. Use the PeopleTools Schema page to access the SCC_ENTITY_APPLICATION
message schema (PeopleTools >Integration Broker >Integration Setup >Messages >Schema).

Constituent
The message SCC_ENTITY_CONSTITUENT represents the core constituent information associated with
the person processed through AAWS. The system derives the Constituent entity from the complete set of
person related data available in both the Campus Solutions and Human Resources person data models.

Use the PeopleTools Schema page to access the SCC_ENTITY_CONSTITUENT message schema
(PeopleTools >Integration Broker >Integration Setup >Messages >Schema).

AAWS Service Operations

This section discusses the AAWS service operations that are delivered under the service called
SAD_ADMISSIONS.

Note: The schema diagrams in this section are subject to change as needed.

Note: This section includes information about posting data within Campus Solutions. If you implement
HCM, person data may also be posted to the HCM system.
Read the relevant documentation about CS-HCM Integration to understand the setup, functional, and
technical implementation considerations. See:
"Integrating Person Data" (Campus Solutions Application Fundamentals)
"Integrating Setup Data" (Campus Solutions Application Fundamentals)
"Monitoring Integrations Using the Integrity Utility" (Campus Solutions Application Fundamentals)
See Campus Solutions to Human Capital Management Integration in My Oracle Support (ID 1553319.1).

SAD_CREATEAPPL
This service operation enables the online application user to create an admission application in the
Campus Solutions system. Using this service may result in one or more applications being created. It can
also result in multiple applicant preferences being created within the same application, for example, entry
of another program or plan for an existing application is a preference.
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Create Application Service Operation Description
and Features

Details

Description The Create Application service operation call results in one or
more admission applications being initialized. The application
center settings on the Application Configuration component
control whether multiple applications (or preferences) can be
created. For example, if you do not have an application center
set up for an applicant who selects an Undergraduate career,
 Liberal Arts program, and History plan, the service operation
throws an error.

The service operation populates the admission application
fields based on the settings on the User Defaults and
Installation - AD components. At application creation time the
operation does not physically save the data to the admissions
staging tables. The save process does not occur until a later
point in time when the user selects a save or submit option
on the online application. Therefore, this operation is more
concerned with the initialization of an application, driven by
configuration, rather than creating a physical application in the
database.

Users • An applicant using an online application.

• An administrator using an online application for creating
an application on behalf of an applicant who has or does
not have an EMPLID.

Processing The service operation performs the following steps:

1. Validate that the user is authenticated (and is not a Guest)

2. If Administrator mode then:

• Validate the required input administrator parameters.

• Validate that the administrator is authorized to access
the application center, institution, career, program
and plan.

3. Validate the required input parameters for application
creation.

4. Determine the transaction that must be used to process
the Institution/Academic Career combination. Define
transactions on the Transaction Setup page.

5. Begin a new transaction for the request. Assign a new
TEMP_ID to the constituent.

6. Using the supplied input parameters, look up the
Application configuration component settings to
determine how many application preferences should be
created for this request.

7. Return response though the output parameters.
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Create Application Service Operation Description
and Features

Details

Output After processing, the operation creates an admission
application with default data and preferences. The user can
subsequently update and submit this application through the
Save and Submit service operations.

Error Conditions The following conditions result in a service error:

• User is not authenticated (for example, if an anonymous
Guest tries to sign into the online application, the service
throws an error message).

• Administrative user is not authorized to access the
application center, institution, career, program or plan.

• Required input parameters have not been supplied by the
user (see the graphic titled SAD_CREATEAPPL_REQ
Message Parameters and the "AAWS and Entity Registry"
section).
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Input Message: SAD_CREATEAPPL_REQ

This image shows the input parameters that the SAD_CREATEAPPL service operation receives:

Required data that the online application must supply to the service operation in Non-administrator
(Applicant) mode:

• Institution

• Academic Career

• Admit Term
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• Academic Program

• Academic Plan

Required data that the online application must supply to the service operation in Administrator mode:

• Institution

• Admission Application Center

• Academic Career

• Admit Term

• Academic Program

• Academic Plan

• Country and Citizenship Status (if your application mapping requires them).

The following is an example of the SAD_CREATEAPPL_REQ message that the SAD_CREATEAPPL
service operation receives from an online application:

<?xml version="1.0"?>
<SAD_CREATEAPPL_REQ>
  <COUNTRY>AUS</COUNTRY>
  <PREFERENCE>
    <INSTITUTION>PSUNV</INSTITUTION>
    <ACAD_CAREER>UGRD</ACAD_CAREER>
    <ACAD_PROG>AA</ACAD_PROG>
    <ACAD_PLAN>ARTHIST</ACAD_PLAN>
    <ADMIT_TYPE>FYR</ADMIT_TYPE>
    <ADMIT_TERM>0747</ADMIT_TERM>
  </PREFERENCE>
</SAD_CREATEAPPL_REQ>

Output Message: SAD_CREATEAPPL_RESP

When the Integration Broker receives the SAD_CREATEAPPL_REQ message, it responds with the
SAD_CREATEAPPL_RESP message.

This image shows the output parameters that the SAD_CREATEAPPL service operation passes to the
online application.

Note that the SAD_CREATEAPPL_RESP schema includes the Application entity (ADM_APPL_DATA)
and Constituent entity XSD schemas.

The following is an example of the SAD_CREATEAPPL_RESP message that the SAD_CREATEAPPL
service operation transmits to the online application:

<?xml version="1.0"?>
<SAD_CREATEAPPL_RESP>
  <PREFERENCE>
    <ADM_APPL_DATA>
     <!-- Application data shape -->

112  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 6 Using Admission Applications Web Services

    </ADM_APPL_DATA>
    <CONSTITUENT>
     <!-- Constituent data shape -->
    </CONSTITUENT>
  </PREFERENCE>
</SAD_CREATEAPPL_RESP>

Fault Message: SAD_FAULT_RESP

If the service operation encounters an error condition, it responds with the SAD_FAULT_RESP message.

This image shows the SAD_FAULT_RESP message parameters.

The following is an example of the SAD_FAULT_RESP message that the SAD_CREATEAPPL service
operation transmits to the online application:

<?xml version="1.0" encoding="UTF-8"?>
<SOAP-ENV:Envelope xmlns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/" xmlns⇒

:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
  <SOAP-ENV:Body>
    <SOAP-ENV:Fault>
      <faultcode>300</faultcode>
      <faultstring>A Error occurred processing this request</faultstring>
      <detail>
        <MSGS>
          <MSG>
            <ID>14200-556</ID>
            <DESCR> Validation error in preference PSUNV/UGRD/AA/MUSIC/VOIC/FYR/069⇒

0</DESCR><PROPS/>
          </MSG>
          <MSG>
            <ID>14200-556</ID>

            <DESCR> Tag ACAD_SUB_PLAN has an invalid value VOIC. Check and try agai⇒

n.</DESCR><PROPS><PROP><SCC_ENTITY_INST_ID>PREFERENCE ROW 1</SCC_ENTITY_INST_ID><PR⇒

OPNAME>ACAD_SUB_PLAN</PROPNAME></PROP></PROPS>
          </MSG>
        </MSGS>
      </detail>
    </SOAP-ENV:Fault>
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

SAD_SAVEAPPL
This service operation enables the user to save an admissions application to the Campus Solutions system
(for later submission). The service operation initially posts the application to the admissions staging
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tables. Applications in the staging tables may at some point of time become eligible to be posted to the
admissions production tables.

Save Application Service Operation Description and
Features

Details

Description The Save Application service operation call results in the
given admissions application being saved to the Campus
Solutions system. The application may be partially complete
when the online application user decides to use a Save
option that triggers a call to this service operation. The
service operation saves the application using an Update Via
Replacement approach; in other words, the SAD_SAVEAPPL
operation deletes any pre-existing application (based on a
unique key) for the applicant and then saves the new (or
current) version of the application.

When saving an application, the operation assigns an
application number (ADM_APPL_NBR) to the application for
tracking.

The application must pass through validation checks before it
gets saved.

The service operation validates all aspects of the application
data including data entered and translate values selected by the
user on the online application, and custom business validation
rules that the institution has incorporated into the online
application.

The service operation saves the valid applications to the
admissions staging tables. If the constituent (person) who
initiated the application save process is known (for example,
 the constituent has an EMPLID), then the constituent portion
of the application is immediately eligible to be posted to
the person production tables. Otherwise, the constituent
data remains in the staging tables until addressed by an
administrator. In any case, the application data itself is saved
to the staging tables and is not posted to admissions production
tables until a later submit occurs.

Applications may include attachments. The online application
must encode the attachment in Base64 format before passing
the attachment to Campus Solutions.

Users • An applicant using an online application.

• An administrator using an online application for creating
an application on behalf of an applicant or a student.
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Save Application Service Operation Description and
Features

Details

Processing The service operation performs the following steps:

1. Validate that the user is authenticated (and is not a Guest)

2. If administrator mode, then:

a. Validate the required input administrator parameters.

b. Validate that the administrator is authorized to access
the application center, institution, career, program
and plan.

c. Use the EMPLID supplied by the administrator for
the transaction.

3. Validate that the applicant is authorized to save the
application (for example, verify whether the applicant is
the same person who created the application in the call to
the SAD_CREATEAPPL service operation).

4. If administrator mode, then use the input parameter
Application Center value for the application.

5. If applicant mode, then use the input parameters and the
settings on the Application Configuration component to
assign an application center to the application.

6. To enter the Application Citizenship details, use the
applicant details in the input parameters, if necessary.

7. To enter the Constituent Institution (needed for Data
Update Rules), use the Admissions Application Institution
input parameter value.

8. Validate the constituent and application data using the
Constituent and Application entity schemas.

9. Associate the TEMP_ID (assigned during the SAD_
CREATEAPPL processing) with the application.

10. Save the validated constituent and application data to the
staging tables.

11. Add the assigned ADM_APPL_NBR to the response
message.

12. If the constituent is not known to the Campus Solutions
system (for example, the applicant does not have an
EMPLID):

a. Run the Search Match process according to the
Search Match settings on the Transaction Setup
component.

b. Add or update a person record according to Search
Match configuration and apply the necessary data
update rules during this processing.
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Save Application Service Operation Description and
Features

Details

13. Create or update a prospect record in the production tables
according to the settings on the Application Configuration
component.

Output After completing the processing steps, the service operation:

1. Posts the valid application data to the Campus Solutions
admissions staging tables.

2. Posts the valid constituent data to the Transaction
Manager constituent staging tables.

3. Optionally, creates or updates a person record for a valid
application.

4. Optionally, creates a prospect record for a known
applicant.

Error Conditions The following conditions result in a service error:

• User is not authenticated (for example, if an anonymous
Guest tries to sign into the online application, the service
throws an error message).

• User is not authorized to access the application (for
example, if the applicant is trying to access an application
created by another applicant).

• Application is invalid (that is, the application fails
validation processing).

• Required input parameters have not been supplied by
the user (see the graphic titled SAD_SAVEAPPL_REQ
Message Parameters and the "AAWS and Entity Registry"
section).

Input Message: SAD_SAVEAPPL_REQ

This image shows the input parameters that the SAD_SAVEAPPL service operation receives from an
online application.
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Note that the SAD_SAVEAPPL_REQ schema includes the Application entity (ADM_APPL_DATA) and
Constituent entity XSD schemas.

Required data that the online application must supply to the service operation in Non-administrator
(Applicant) mode:

• ADM_APPL_DATA

• CONSTITUENT

Required data that the online application must supply to the service operation in Administrator mode:

• Institution

• Admission Application Center

• ADM_APPL_DATA

• CONSTITUENT

The following is an example of the SAD_SAVEAPPL_REQ message that the SAD_SAVEAPPL service
operation receives from an online application:

<?xml version="1.0"?>
<SAD_SAVEAPPL_REQ>
  <ADM_APPL_DATA>
   <!-- Application data shape -->
  </ADM_APPL_DATA>
  <CONSTITUENT>
   <!-- Constituent data shape -->
  </CONSTITUENT>
</SAD_SAVEAPPL_REQ>

Output Message: SAD_SAVEAPPL_RESP

When the Integration Broker receives the SAD_SAVEAPPL_REQ message, it responds with the
SAD_SAVEAPPL_RESP message.

This image shows the output parameters that the SAD_SAVEAPPL service operation passes to the online
application.

The following is an example of the SAD_SAVEAPPL_RESP message that the SAD_CREATEAPPL
service operation transmits to the online application:

<?xml version="1.0"?>
<SAD_SAVEAPPL_RESP>
  <ADM_APPL_NBR>00023456</ADM_APPL_NBR>
</SAD_SAVEAPPL_RESP>

Fault Message: SAD_FAULT_RESP

Refer to the SAD_FAULT_RESP message example in the SAD_CREATEAPPL section.
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SAD_SUBMITAPPL
This service operation enables the user to submit a completed admissions application to the Campus
Solutions system. The service operation initially saves the applications to the admissions staging tables
and subsequently posts the staged application data to the admissions production tables.

Submit Application Service Operation Description
and Features

Details

Description The Submit Application service call results in the given
admissions application being submitted to the Campus
Solutions system. The application must be complete 
(according to the institution's data capture requirements). The
online application user interface and the underlying Campus
Solutions data model ensure that the submitted admission
application is complete.

The application submit process involves first validating the
data, then saving the data to the admissions staging tables,
 and finally transferring the staged data into the admissions
production tables.

When initially saving the application to the staging tables,
 if the application does not have an application number, the
service operation assigns an application number (ADM_APPL
_NBR) to the application for tracking purpose. The operation
does not assign an application number if another operation 
(for example, the SAD_SAVEAPPL operation) has already
assigned an application number.

The admission application must pass through validation
checks before it gets submitted. The service operation
validates all aspects of application data including data
entered and translate values selected by the user on the online
application and custom business validation rules that the
institution has incorporated into the online application.

If the constituent who initiated the application submit process
is known to the Campus Solutions system (for example,
 the constituent has an EMPLID), then the constituent and
application data is eligible to be posted to the admissions and
person production tables. Otherwise, the application remains in
the staging tables until addressed by an administrator.

When configured to do so, the constituent can pay an
application fee and/or request an application fee waiver.

Applications may include attachments. The online application
must encode the attachment in Base64 format before passing
the attachment to Campus Solutions.

Users • An applicant using an online application.

• An administrator using an online application for creating
an application on behalf of an applicant or a student.
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Submit Application Service Operation Description
and Features

Details

Processing This service operation performs the following steps:

1. Validate that the user is authenticated (and is not a Guest).

2. If administrator mode then:

a. Validate the required input administrator parameters.

b. Validate that the administrator is authorized to access
the application center, institution, career, program
and plan.

c. Use the EMPLID supplied by the administrator for
the transaction.

3. Validate that the applicant is authorized to submit the
application (for example, verify whether the applicant is
the same person who created the application in a call to
the SAD_CREATEAPPL service operation.)

4. If administrator mode, then use the input parameter
Application Center value for the application.

5. If applicant mode, then use the input parameters and the
settings on the Application Configuration component to
assign an application center to the application.

6. To enter the Application Citizenship details use the
applicant details in the input parameters, if necessary.

7. To enter the Constituent Institution (needed for data
update rules) use the Admissions Application Institution
input parameter value.

8. Validate the constituent and application data using the
Constituent and Applicant entity schemas.

9. Associate the TEMP_ID (assigned during the SAD_
CREATEAPPL processing) with the application.

10. Save the validated constituent and application data to the
staging tables.

11. If the constituent is not known to the Campus Solutions
system (for example, the applicant does not have an
EMPLID):

a. Run the Search Match process according to the
Search Match settings on the Transaction Setup
component.

b. Add or update a Person record according to Search
Match configuration and apply the necessary data
update rules during this processing.

12. If Fee payment is required but has not yet been paid:
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Submit Application Service Operation Description
and Features

Details

a. Call the Student Financials Fee Calculation API to
calculate the fee amount.

b. If Fee Waivers are allowed then allow the application
to progress to submitted status.

c. If Fee Waivers are Not allowed then:

1. Set the application data to Saved Status.

2. Add the Fee details to the response message.

The caller must handle this response by initiating
the payment services. Note it is possible for Fee
calculation to result in a zero (0) amount in which
case the caller should not initiate the payment
service.

13. Create or update a prospect record in the production tables
according to settings on the Application Configuration
component.

If the constituent is known (for example, the applicant
has an EMPLID), post the application data into the
admissions production tables and apply the necessary data
update rules during this processing.

Output After completing the processing steps, the service operation:

1. Posts the valid application data to the Campus Solutions
admissions staging tables.

2. Posts the valid constituent data to the Transaction
Manager constituent staging tables.

3. Transfers the application and constituent data from the
staging tables to the person and admissions production
tables.

4. Optionally, creates or updates a person record for a valid
application.

5. Optionally, creates a prospect record for a known
applicant.
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Submit Application Service Operation Description
and Features

Details

Error Conditions The following conditions result in a service error:

• User is not authenticated (for example, if an anonymous
Guest user tries to sign into the online application, the
service operation throws an error message.)

• User is not authorized to access the application (for
example, the applicant is trying to access an application
created by another applicant).

• Application is invalid (that is, the application fails
validation processing).

• Required input parameters have not been supplied by the
user (see the graphic titled SAD_SUBMITAPPL_REQ
Message Parameters and the "AAWS and Entity Registry"
section).

Input Message: SAD_SUBMITAPPL_REQ

This image shows the input parameters that the SAD_SUBMITAPPL service operation receives from an
online application.

Note that the SAD_SUBMITAPPL_REQ schema includes the Application entity (ADM_APPL_DATA)
and Constituent entity XSD schemas.

Required data that the online application must supply to the service operation in Non-administrator
(Applicant) mode:

• ADM_APPL_DATA

• CONSTITUENT

Required data that the online application must supply to the service operation in Administrator mode:

• Institution
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• Admission Application Center

• ADM_APPL_DATA

• CONSTITUENT

The following is an example of the SAD_SUBMITAPPL_REQ message that the SAD_SUBMITAPPL
service operation receives from an online application:

<?xml version="1.0"?>
<SAD_SUBMITAPPL_REQ>
  <ADM_APPL_DATA>
   <!-- Application data shape -->
  </ADM_APPL_DATA>
  <CONSTITUENT>
   <!-- Constituent data shape -->
  </CONSTITUENT>
</SAD_SUBMITAPPL_REQ>

Output Message: SAD_SUBMITAPPL_RESP

When the Integration Broker receives the SAD_SUBMITAPPL_REQ message, it responds with the
SAD_SUBMITAPPL_RESP message.

This image shows the output parameters that the SAD_SUBMITAPPL service operation passes to the
online application.

The following is an example of the SAD_SUBMITAPPL_RESP message that the SAD_SUBMITAPPL
service operation transmits to the online application:

<?xml version="1.0"?>
<SAD_SUBMITAPPL_RESP>
  <ADM_APPL_NBR>00023456</ADM_APPL_NBR>
  <FEE>
    <PAYMENT_APPLICATION>SADAAWS</PAYMENT_APPLICATION>
    <PAYMENT_KEY>00023456</PAYMENT_KEY>
    <APPL_FEE_AMT>20</APPL_FEE_AMT>
    <CURRENCY_CD>USD</CURRENCY_CD>
  </FEE>
</SAD_SUBMITAPPL_RESP>

Fault Message: SAD_FAULT_RESP

Refer to the SAD_FAULT_RESP message example in the SAD_CREATEAPPL section.
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SAD_GETAPPLS
This service operation enables the user to retrieve a summary of all active admission applications from
the Campus Solutions system for the current authenticated user. The applications summary includes
applications found in both the admissions staging and production database tables.

Get Applications Service Operation Description and
Features

Details

Description Use this service operation to retrieve a summary of all the
applications that reside in the Campus Solutions staging and
production tables. The service operation retrieves only those
applications that the authenticated user is authorized to access.

SAD_GETAPPLS can operate under applicant or
administrative modes. When using administrator mode, the
application data returned from the Admissions production
tables is subject to application center row level security.
 When using applicant mode, the application data returned
is restricted to those applications entered previously by the
authenticated online application user.

Users • An applicant using an online application.

• An administrator using an online application to retrieve
data that he or she previously saved or submitted. The
administrator can retrieve an application for an applicant
who has or does not have an EMPLID.
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Get Applications Service Operation Description and
Features

Details

Processing This service operation performs the following steps:

1. Validate that the user is authenticated (and is not a Guest).

2. If administrator mode then:

a. Validate the required input administrator parameters.

b. Validate that the administrator is authorized to access
the application center.

c. Use the EMPLID supplied by the administrator for
the transaction.

3. Determine the list of configured application transactions
from the Transaction Setup component.

4. Retrieve all the application transactions for all the
configured application transactions.

5. Retrieve all admission applications from the Admissions
staging tables that the authenticated user is authorized to
access.

6. If applicant mode, then retrieve all the applications
associated with the authenticated EMPLID from the
production tables.

7. To retrieve the application based on the ADM_APPL_
NBR key:

a. First, check whether the application exists in the
admissions staging tables using the SCC_TEMP_ID
key.

b. If the application does not exist in the staging tables,
 check the admissions production tables using the
EMPLID key.

8. Return the Application Summary, which indicates ID 
(EMPLID or SCC_TEMP_ID), Application Number,
 Institution, Academic Career and Application Status 
(SAVED, SUBMITTED, ERROR, or POSTED).

Output After processing the steps, a summary of all active
applications is returned.
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Get Applications Service Operation Description and
Features

Details

Error Conditions The following conditions result in a service error:

• User is not authenticated (for example, if an anonymous
Guest user tries to sign into the online application, the
service operation throws an error message).

• Required input parameters have not been supplied by
the user (see the graphic titled SAD_GETAPPLS_REQ
Message Parameters).

Input Message: SAD_GETAPPLS_REQ

This image shows the input parameters that the SAD_GETAPPLS service operation receives from an
online application.

Required data that the online application must supply to the service operation in Non-administrator
(Applicant) mode: No required parameters.

Required data that the online application must supply to the service operation in Administrator mode:

• Institution

• Admission Application Center

• Academic Program

The following is an example of the SAD_GETAPPLS_REQ message that the SAD_GETAPPLS service
operation receives from an online application:

<?xml version="1.0"?>
<SAD_GETAPPLS_REQ>
</SAD_GETAPPLS_REQ>

Output Message: SAD_GETAPPLS_RESP

When the Integration Broker receives the SAD_GETAPPLS_REQ message, it responds with the
SAD_GETAPPLS_RESP message.
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This image shows the output parameters that the SAD_GETAPPLS service operation passes to the online
application.

The following is an example of the SAD_GETAPPLS_RESP message that the SAD_GETAPPLS service
operation transmits to the online application:

<?xml version="1.0"?>
<SAD_GETAPPLS_RESP>
  <APPLICATION>
    <ADM_APPL_NBR>00024656</ADM_APPL_NBR>
    <INSTITUTION>PSUNV</INSTITUTION>
    <ACAD_CAREER>UGRD</ACAD_CAREER>
    <APPL_STATUS>DRAFT</APPL_STATUS>
   </APPLICATION>
  <APPLICATION>
    <ADM_APPL_NBR>00024657</ADM_APPL_NBR>
    <INSTITUTION>PSUNV</INSTITUTION>
    <ACAD_CAREER>UGRD</ACAD_CAREER>
    <APPL_STATUS>SUBMITTED</APPL_STATUS>
   </APPLICATION>
</SAD_GETAPPLS_RESP>

Fault Message: SAD_FAULT_RESP

Refer to the SAD_FAULT_RESP message example in the SAD_CREATEAPPL section.

SAD_GETAPPL
This service operation enables the user to retrieve a specific admissions application from the Campus
Solutions system. The application may exist in the admissions staging tables or in the admissions
production tables. Saved applications reside in the staging tables and submitted applications reside in the
production tables.
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Get Application Service Operation Description and
Features

Details

Description Use this service operation to retrieve a saved or submitted
application using the ADM_APPL_NBR key.

An online application can obtain the ADM_APPL_NBR
application key by calling the SAD_GETAPPLS service,
 which retrieves a summary of all the applications associated
with the current authenticated user.

The SAD_GETAPPL operation can operate under applicant
or administrative modes. When using applicant mode, the
application data returned is restricted to those applications
entered previously by the authenticated online application user.
 When using administrator mode, the application data returned
from the admissions production tables is subject to application
center row level security.

Users • An applicant using an online application.

• An administrator using an online application to retrieve
data that they previously saved or submitted. The
administrator can retrieve an application for an applicant
who has or does not have an EMPLID.
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Get Application Service Operation Description and
Features

Details

Processing This service operation performs the following steps:

1. Validate that the user is authenticated (and is not a Guest).

2. If administrator mode, then:

a. Validate the required input administrator parameters.

b. Validate that the administrator is authorized to access
the application center.

c. Use the EMPLID supplied by the administrator for
the transaction.

3. Validate that the applicant is authorized to retrieve the
application (for example, verify whether the applicant is
the same person who created the application).

4. If administrator mode, then use the EMPLID input
parameter to retrieve the application.

5. If applicant mode, then use the EMPLID input parameter
associated with the authenticated user profile to retrieve
the application.

6. To retrieve the application based on the ADM_APPL_
NBR key:

a. First, check whether the application exists in the
admissions staging tables using the SCC_TEMP_ID
key.

b. If the application does not exist in the staging tables,
 check the admissions production tables using the
EMPLID key.

7. Return the application data, if found.

Output After completing the processing steps, the service operation
returns a single application if it exists in the staging or
production tables. All the application details along with
constituent details are returned, if the application exists.
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Get Application Service Operation Description and
Features

Details

Error Conditions The following conditions result in a service error:

• User is not authenticated (for example, if an anonymous
Guest user tries to sign into the online application, the
service operation throws an error message).

• User is not authorized to access the application (for
example, the applicant is trying to access an application
created by another user).

• Required input parameters have not been supplied by
the user (see the graphic titled SAD_GETAPPL_REQ
Message Parameters).

• Administrative user is not authorized to access the
application due to the application center security
configuration.

Input Message: SAD_GETAPPL_REQ

This image shows the input parameters that the SAD_GETAPPL service operation receives from an
online application.

Required data that the online application must supply to the service operation in Non-administrator
(Applicant) mode:

• Academic Career

• Application Number
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Required data that the online application must supply to the service operation in Administrator mode:

• Institution

• Admission Application Center

The following is an example of the SAD_GETAPPL_REQ message that the SAD_GETAPPL service
operation receives from an online application:

<?xml version="1.0"?>
<SAD_GETAPPL_REQ>
  <ADM_APPL_NBR>00024656</ADM_APPL_NBR>
  <ACAD_CAREER>UGRD</ACAD_CAREER>
</SAD_GETAPPL_REQ>

Output Message: SAD_GETAPPL_RESP

When the Integration Broker receives the SAD_GETAPPL_REQ message, it responds with the
SAD_GETAPPL_RESP message.

This image shows the output parameters that the SAD_GETAPPL service operation passes to the online
application.

Note that the SAD_GETAPPL_RESP schema includes the Application entity (ADM_APPL_DATA) and
Constituent entity XSD schemas.

The following is an example of the SAD_GETAPPL_RESP message that the SAD_GETAPPL service
operation transmits to the online application:

<?xml version="1.0"?>
<SAD_GETAPPL_RESP>
  <ADM_APPL_DATA>
   <!-- Application data shape -->
  </ADM_APPL_DATA>
  <CONSTITUENT>
   <!-- Constituent data shape -->
  </CONSTITUENT>
</SAD_GETAPPL_RESP>

Fault Message: SAD_FAULT_RESP

Refer to the SAD_FAULT_RESP message example in the SAD_CREATEAPPL section.

SAD_GETATTACH
This service operation enables the user to retrieve the byte content of an admissions application
attachment from the Campus Solutions system.
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Get Attachment Service Operation Description and
Features

Details

Description Use this service operation to retrieve an attachment associated
with the admission application.

The online application must encode the attachment byte
content in Base64 format when a user saves or submits the
application data through AAWS. Subsequently, the online
application can use SAD_GETATTACH to retrieve the
attachment. After retrieval, the online application must decode
the attachment. The applicant or administrator can then use the
appropriate file type viewer to view the attachment.

The attachment is stored within the Campus Solutions
attachment framework in a database table.

You can use the Application Transactions or Maintain
Applications components to access the application
attachments.

Users • An applicant using an online application.

• An administrator using an online application to retrieve
data that he or she previously saved or submitted.
 The administrator can retrieve an application (and the
associated attachments) for an applicant who has or does
not have an EMPLID.
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Get Attachment Service Operation Description and
Features

Details

Processing This service operation performs the following steps:

1. Validate that the user is authenticated (and is not a Guest).

2. If administrator mode, then:

a. Validate the required input administrator parameters.

b. Validate that the administrator is authorized to access
the application center.

c. Use the EMPLID supplied by the administrator for
the transaction.

3. Verify whether the applicant is authorized to retrieve the
attachment (for example, verify whether the applicant is
the same person who originally created the attachment
through AAWS).

4. If administrator mode, then use the EMPLID input
parameter to retrieve the attachment.

5. If applicant mode, then use the EMPLID input parameter
associated with the authenticated User Profile to retrieve
the attachment.

6. To retrieve the attachment:

a. First, check whether the attachment exists in the
staging tables using the SCC_TEMP_ID key.

b. If the attachment does not exist in the staging tables,
 check the production tables using the EMPLID key.

7. Return the attachment, if found.

Output After completing the processing steps, if the attachment exists,
 the service operation returns the attachment data to the online
application.
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Get Attachment Service Operation Description and
Features

Details

Error Conditions The following conditions result in a service error:

• User is not authenticated (for example, if an anonymous
Guest user tries to sign into the online application, the
service operation throws an error message).

• User is not authorized to retrieve the attachment (for
example, the applicant is trying to access an attachment
created by another user).

• Required input parameters have not been supplied by
the user (see the graphic titled SAD_GETATTACH_
REQ Message Parameters).Administrative user is not
authorized to access the attachment due to application
center configuration.

Note: The Online Application may issue multiple calls to the SAD_GETATTACH service operation in
order to retrieve multiple Application attachments.

Input Message: SAD_GETATTACH_REQ

This image shows the input parameters that the SAD_GETATTACH service operation receives from an
online application.

Required data that the online application must supply to the service operation in Non-administrator
(Applicant) mode:
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• Attachment Sequence Number

• Academic Career

• Application Number

Required data that the online application must supply to the service operation in Administrator mode:

• Institution

• Admission Application Center

The following is an example of the SAD_GETATTACH_REQ message that the SAD_GETATTACH
service operation receives from an online application:

<?xml version="1.0"?>
<SAD_GETATTACH_REQ>
  <ACAD_CAREER>UGRD</ACAD_CAREER>
  <ADM_APPL_NBR>00024501</ADM_APPL_NBR>
  <ATTACH_SEQ_NBR>1</ATTACH_SEQ_NBR>
</SAD_GETATTACH_REQ>

Output Message: SAD_GETATTACH_RESP

When the Integration Broker receives the SAD_GETATTACH_REQ message, it responds with the
SAD_GETATTACH_RESP message.

This image shows the output parameter that the SAD_GETATTACH service operation passes to the
online application.

The following is an example of the SAD_GETATTACH_RESP message that the SAD_GETATTACH
service operation transmits to the online application:

<?xml version="1.0"?>
<SAD_GETATTACH_RESP>
  <ADM_APPL_ATCH class="R">
    <EMPLID>2</EMPLID>
    <ACAD_CAREER>UGRD</ACAD_CAREER>
    <STDNT_CAR_NBR>0</STDNT_CAR_NBR>
    <ADM_APPL_NBR>00024501</ADM_APPL_NBR>
    <ATTACH_SEQ_NBR>1</ATTACH_SEQ_NBR>
    <DESCR254>test file</DESCR254>
    <SCC_ROW_ADD_OPRID/>
    <SCC_ROW_ADD_DTTM/>
    <SCC_ROW_UPD_OPRID/>
    <SCC_ROW_UPD_DTTM/>
    <ATTACHSYSFILENAME>ADM_APPL_ATCH_20090331161239_Who Columns.doc</ATTACHSYSFILEN⇒
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AME>
    <ATTACHUSERFILE>Who Columns.doc</ATTACHUSERFILE>
    <AV_ATCH_TYPE/>
<BASE64FILE>0M8R4KGxGuEAAAAAAAAAAAAAAAAAAAAAPgADAP7/CQAGAAAAAAAAA  </BASE64FILE>
  </ADM_APPL_ATCH>
  <CONSTITUENT>
   <!-- Constituent data shape -->
  </CONSTITUENT>
</SAD_GETATTACH_RESP>

Fault Message: SAD_FAULT_RESP

Refer to the SAD_FAULT_RESP message example in the SAD_CREATEAPPL section.

Payment Integration Web Service Operations

This section discusses the SSF_INITIATE_EPAYMENT and SSF_COMPLETE_EPAYMENT service
operations for the SSF_EPAYMENT_TRANSACTION service.

Note: The payment integration service operations are delivered for only supporting online applications.
These service operations are not intended to be used for any other purpose.

Note: The schema diagrams in this section are subject to change as needed.

SSF_INITIATE_EPAYMENT
This service operation enables the user to record a newly initiated electronic payment in Student
Financials and provides access to Campus Solutions’ hosted payment framework. The hosted
payment framework provides information necessary to transition the user to a designated third
party payment provider’s hosted site to make a payment. The insert into the GL_TXN table,
for the general ledger process, will not be done until the Complete ePayment service operation
(SSF_COMPLETE_EPAYMENT) is invoked successfully.

This web service operation is adapter-based. AAWS has been delivered with its own custom Payment
Application adapter and will perform its own validation according to the admissions application
functional requirements.

Note that the Initiate ePayment service operation operates only within the Self Service mode (and cannot
be used within the Administrator mode).

Details:

Copyright © 1988, 2021, Oracle and/or its affiliates. 135



Using Admission Applications Web Services Chapter 6

Description: The Initiate ePayment service operation call will create a
new SF Payment in Student Financials in Initiated status,
 assigning a new SF Payment Reference Number (SF_PMT
_REF_NBR) for tracking. This service uses the payment
application’s own tracking number as the merchant reference
number passed to the third party payment processor. For
AAWS, that tracking number is the application number (ADM
_APPL_NBR). The application number will be stored in the
SF Payment as ADM_APPL_NBR and SSF_EXT_TRANS_
REF and the SF Payment Reference number will be stored in
the Admissions Tender Staging table. In addition, the Temp
ID will be stored in the SF Payment and Log. The service,
 through the AAWS adapter, will create new Admissions
Tender Staging records (if they do not exist) for all tenders
associated with the application center used in the creation of
the application.

The Initiate ePayment service will perform initial validation.
 For instance, the payment method must be either credit card
or electronic check (CC or EC), the amount has to be greater
than zero, and the Payment Application must be defined in the
system table SSF_ELEC_PMTS.

When the AAWS adapter is invoked, it will perform further
validation on the transaction.

• The payment amount and currency must match the
previously calculated application fee stored in the
Admissions Application Staging record (SAD_APL_
DAT_STG). This amount should have been previously
calculated in and returned from the submit web service
operation.

• The transaction must have been originated by the owner
of the application.

• The application must be in Saved (SV) status.

• If the payment is for a credit card tender type, the SF
Merchant must be defined in the application center
associated with the application. For electronic check
transactions, the Electronic Check Merchant ID must be
defined in the Application Center. These SF Merchants
must be associated with Payment Merchants that are
defined as hosted.

• The tender used must be defined as a valid tender on the
Application Fee code associated with the application
center.

Users: An applicant using an online application.
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Processing: This service operation performs the following steps:

1. Validate the parameters passed in to the web service.

2. Create a SF Payment to record the transaction. The
SF Payment will be in Initiated status. For AAWS, SF
Payment Detail records, which will later be used to record
the transaction in the General Ledger, will be based on the
Application Fee Item Type setup.

3. Call the AAWS adapter to:

• Validate the application.

• Validate the payment parameters.

• Create Application Tender Staging records.

• Save the application.

4. Call the hosted payment framework. The hosted payment
framework will:

• Based on the hosted payment adapter associated
with the Payment Merchant, perform an initial web
service callout to the third party to pass demographic
information about the applicant, such as name,
 address, email and phone. Note that this information
may or may not be used, depending on the third party
payment processor. In addition, a shared secret may
be passed to the third party to authenticate electronic
check transactions. For AAWS, this shared secret is
the Constituent birth date. The third party will return
a temporary token that identifies the transaction to
both the third party and Campus Solutions.

• Using the HTML object definition on the Payment
Merchant, create a string that will be used to either
http post or redirect to the third party.

Output: After completing the processing steps, the service operation:

1. Records the transaction in the SF Payment table and
Detail records.

2. Creates new Admissions Application Tender Staging
records.

3. Optionally, performs a web service callout to the third
party payment processor to pass demographic information
and receive a token identifying the transaction.
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Error Conditions: The following conditions result in a service error:

• The payment method is invalid.

• The payment amount is zero.

• The Payment Application is invalid.

• Required input parameters have not been supplied by the
user.

• The transaction does not pass the AAWS adapter
validation.

Input Message: SSF_INITIATE_EPAYMENT_REQ

This image shows the input parameters that the SSF_INITIATE_EPAYMENT service operation receives
from an online application.

Required data that the online application must supply to the service operation:

• Payment Application

• Payment Application Key (Application Number)

• Payment Amount

• Currency Code

• Payment Method (Credit card or electronic check)

The following is an example of the SSF_INITIATE_EPAYMENT_REQ message that the
SSF_INITIATE_EPAYMENT service operation receives from an online application:

<?xml version="1.0"?>
<SSF_INITIATE_EPAYMENT_REQ xmlns="http://xmlns.oracle.com/Enterprise/HCM/services">
  <SCC_PMT_APPL>SADAAWS</SCC_PMT_APPL>
  <SCC_PMT_APPL_KEY>00024828</SCC_PMT_APPL_KEY>
  <SCC_EPAY_TOTAL_AMT>20</SCC_EPAY_TOTAL_AMT>
  <CURRENCY_CD>USD</CURRENCY_CD>
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  <SCC_EPAY_PAYMETHOD>CC</SCC_EPAY_PAYMETHOD>
</SSF_INITIATE_EPAYMENT_REQ>

Output Message: SSF_INITIATE_EPAYMENT_RESP

When the Integration Broker receives the SSF_INITIATE_EPAYMENT_REQ message, it responds with
the SSF_INITIATE_EPAYMENT_RESP message.

This image shows the output parameters that the SSF_INITIATE_EPAYMENT service operation passes
to the online application.

The following is an example of the SSF_INITIATE_EPAYMENT_RESP message that the
SSF_INITIATE_EPAYMENT service operation transmits to the online application:

<?xml version="1.0"?>
<SSF_INITIATE_EPAYMENT_RESP xmlns="http://xmlns.oracle.com/Enterprise/HCM/services"⇒

>
  <SCC_REDIRECT>N</SCC_REDIRECT>
  <SCC_HTML_STRING>
    <![CDATA*<SCRIPT LANGUAGE='JavaScript'>
writeConsole('https://someserver/C30002test_upay/web/index.jsp', '<input type="HIDD⇒

EN" name="TICKET_NAME" value="SADAAWS"><input type="HIDDEN" name="UPAY_SITE_ID" val⇒

ue="12"><input type="HIDDEN" name="TICKET" value="ce224625-e55c-4346-b87c-96f784f5a⇒

e90">');
function writeConsole(bind1, bind2)
{
var stuff = '<form name="payform" action="'+bind1+
'" method="POST">'+bind2+'<SCRIPT LANGUAGE="JavaScript" onload="submitForm()">'+
'function submitForm(){document.payform.submit()}'+
'</'+'SCRIPT>'+'</'+'form'+'>';
document.body.innerHTML = stuff;
document.payform.submit();
}
</SCRIPT>*]>
  </SCC_HTML_STRING>
  <SCC_HPAY_INTG_ID>QA_CS_AAWS_MODEL1A</SCC_HPAY_INTG_ID>
</SSF_INITIATE_EPAYMENT_RESP>

Fault Message: SSF_TRANS_FAULT_RESP

If the service operation encounters an error condition, it responds with the SSF_TRANS_FAULT_RESP
message.
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The following is an example of the SSF_TRANS_FAULT_RESP message that the
SSF_INITIATE_EPAYMENT service operation transmits to the online application:

<?xml version="1.0"?>
<SOAP-ENV:Envelope xmlns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/" xmlns⇒

:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
  <SOAP-ENV:Body>
    <SOAP-ENV:Fault>
      <faultcode>Client</faultcode>
      <faultstring>An Error occurred processing this request (14098,286)</faultstri⇒

ng>
      <detail>
        <MSGS>
          <MSG>
            <ID>14871-11</ID>
            <DESCR>The Payment Amount must be greater than zero. (14871,11)</DESCR>
          </MSG>
        </MSGS>
      </detail>
    </SOAP-ENV:Fault>
  </SOAP-ENV:Body>
</SOAP-ENV:Envelope>

SSF_COMPLETE_EPAYMENT
This web service operation completes a previously initiated (SSF_INITIATE_EPAYMENT) SF Payment,
by authorizing the transaction and submitting the application. If authorization is successful, the SF
Payment Transaction Manager will create the Direct GL Transaction.

After having successfully invoked the SSF_INITIATE_EPAYMENT service operation, the
Online Application should transition the applicant to the third party payment provider using the
SCC_HTML_STRING returned from the SSF_INITIATE_EPAYMENT response. This next web service
should be invoked after the transaction is submitted by the applicant from the third party payment
processor user interface.

Details:
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Description: The Complete ePayment web service operation interprets the
response from the third party payment processor by invoking
the hosted payment framework. The data received from the
third party is transformed into Campus Solutions data elements
to allow the update of both Student Financials tables and the
calling Payment Application (AAWS).

If the user submitted the transaction successfully from the
third party processor, this web service operation will complete
any processing required in Student Financials to record the
payment. The session ID, which is a unique token generated
and returned by the third party to identify the payment, as well
as the last 4 digits of the credit card or account number, will be
stored in the SF Payment table from within the hosted payment
framework.

The ePayment API will be invoked to authorize the
transaction. If successful, the payment will be processed
in Student Financials by setting the SF Payment status to
Complete (SF_PAYMENT_STATUS = B), creating the
SF Payment Log with the results of the authorization, and
eventually deleting the SF Payment.

The transaction will be recorded directly in the General Ledger
using the Direct to GL API (as opposed to posting to a Student
Financials account).

Finally, the adapter for AAWS will be invoked to submit the
application. The application fee status will be set to Received,
 the Application Fee Paid amount and GL Sent Amount will
be set to the Payment Amount. The Admissions Application
Tender Staging record’s tender amount will also be set to the
Payment Amount.

If the user cancelled the transaction from the third party
payment processor’s hosted site, the SF Payment status will be
set to Cancelled. No update will occur on the AAWS adapter
and the applicant can submit another payment against the
application.

Users: An applicant using an online application.
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Processing: This service operation performs the following steps:

1. Validate the parameters passed in to the web service.

2. Call the Hosted Payment framework using the Hosted
Payment adapter passed into the web service. The
hosted payment framework will interpret the name/value
pairs and transform them into Campus Solutions data
elements using the hosted payment adapter settings. It will
extract the Payment Application ID and Key (application
number) to correctly identify the transaction. It will
update the session id and last 4 digits of the account or
credit card number in the SF Payment.

3. Complete the SF Payment associated with the application.
 For successfully submitted transactions, the transaction
will be authorized and sent to the General Ledger.

4. Call the AAWS adapter to update the proper fields in the
application and submit it.

Output: After completing the processing steps, the service operation:

1. Sets the SF Payment status to Complete or Cancelled
according to the user action on the third party processor.
 It will set the status to Declined if authorization fails. The
SF Payment will be deleted and the SF Payment Log will
be created to record the transaction results.

2. Creates the General Ledger Transaction records for later
processing to the General Ledger.

3. Submits the application if the payment was successfully
authorized.

Error Conditions: The following conditions result in a service error:

• The Hosted Payment Adapter ID is invalid.

• The Return URL type is invalid (Valid values are S, C or
E)

• The Payment Application is invalid.

• Required input parameters have not been supplied by
user.

• The transaction does not pass the AAWS adapter
validation.
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Input Message: SSF_COMPLETE_EPAYMENT_REQ

This image shows the input parameters that the SSF_COMPLETE_EPAYMENT service operation
receives from an online application.

Required data that the online application must supply to the service operation:

• Hosted Payment Adapter ID.

• Return URL Type (Success, Cancelled, Error).

• Hosted Payment Response Values (Name/Value pairs returned from third party). These values are
expected to correspond to the values under the Third Party Parameter Name of Inbound Parameters
grid of Hosted Payment Adapter Setting. For example:

This example illustrates a Hosted Payment Adapter setting.
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The following is an example of the SSF_COMPLETE_EPAYMENT_REQ message that the
SSF_COMPLETE_EPAYMENT service operation receives from an online application:

<?xml version="1.0"?>
<SSF_COMPLETE_EPAYMENT_REQ xmlns="http://xmlns.oracle.com/Enterprise/HCM/services">
  <SCC_HPAY_INTG_ID>QA_CS_AAWS_MODEL1A</SCC_HPAY_INTG_ID>
  <SCC_EPAY_URL_TYPE>S</SCC_EPAY_URL_TYPE>
  <SCC_HP_RESPONSE_VALUES>
    <SCC_TP_PARM>
      <name>session_identifier</name>
      <value>5c012fb4-43a4-4ffd-be63-a1415ce2b7e4</value>
    </SCC_TP_PARM>
    <SCC_TP_PARM>
      <name>UPAY_SITE_ID</name>
      <value>12</value>
    </SCC_TP_PARM>
    <SCC_TP_PARM>
      <name>EXT_TRANS_ID</name>
      <value>SADAAWS_00024863</value>
    </SCC_TP_PARM>
    <SCC_TP_PARM>
      <name>acct_number</name>
      <value>XXXXXXXXX2222</value>
    </SCC_TP_PARM>
    <SCC_TP_PARM>
      <name>acct_number</name>
      <value>XXXXXXXXX2222</value>
    </SCC_TP_PARM>
  </SCC_HP_RESPONSE_VALUES>
</SSF_COMPLETE_EPAYMENT_REQ>

Output Message: SSF_COMPLETE_EPAYMENT_RESP

When the Integration Broker receives the SSF_COMPLETE_EPAYMENT_REQ message, it responds
with the SSF_COMPLETE_EPAYMENT_RESP message.
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This image shows the output parameters that the SSF_COMPLETE_EPAYMENT service operation
passes to the online application.

The following is an example of the SSF_COMPLETE_EPAYMENT_RESP message that the
SSF_COMPLETE_EPAYMENT service operation transmits to the online application:

<?xml version="1.0"?>
<SSF_COMPLETE_EPAYMENT_RESP xmlns="http://xmlns.oracle.com/Enterprise/HCM/services"⇒

>
  <SF_PMT_REF_NBR>000000000043</SF_PMT_REF_NBR>
  <SCC_EPAY_MERCH_REF>00024828</SCC_EPAY_MERCH_REF>
  <CR_CARD_DIGITS>1111</CR_CARD_DIGITS>
  <SF_POST_STATUS>S</SF_POST_STATUS>
  <SF_PAYMENT_STATUS>B</SF_PAYMENT_STATUS>
  <SSF_PMT_SOURCE_STATUS>S</SSF_PMT_SOURCE_STATUS>
  <SSF_PMT_MSG>Your payment was successfully processed.</SSF_PMT_MSG>
  <SSF_APPL_MSG>Your application 00024828 was successfully submitted.</SSF_APPL_MSG⇒

>
</SSF_COMPLETE_EPAYMENT_RESP>

Fault Message: SSF_TRANS_FAULT_RESP

Refer to the SSF_TRANS_FAULT_RESP message example in the SSF_INITIATE_EPAYMENT section.

Setting Up the Attachments URL

Use the URL Maintenance page to define the location that AAWS uses to store application attachments.
To navigate to the URL Maintenance page, select PeopleTools >Utilities >Administration >URLs.
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In this example, attachments are stored in a FTP Server:

This example illustrates a URL Maintenance page.

Setting Up Hosted Payment

Application Fees are optionally required during application submission as configured in the Application
Center Setup page. If fees are required to be paid then a prerequisite is to set up the hosted payment
adapter and merchant which will facilitate the online payment.

Firstly, create a new HTML object in Application Designer. The HTML object is used to store user
interface specific HTML and JavaScript which will direct the self-service user interface during the
payment integration flow. Refer to the User Interface Considerations section for detailed technical
information on what this HTML object may need to contain.

See User Interface Considerations

Next, set up a new hosted payment adapter for AAWS pointing to the same application class as the one
used for PIA Self Service. This step is required because the HTML definition (created in the first step) is
attached to the adapter itself.

Access the Adapter Table page (Set Up SACR >System Administration >Utilities >Adapter
Registry).
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This example illustrates the fields and controls on the Hosted Payment Adapter Setup page.

Next, attach the new HTML definition to the Hosted Payment Adapter settings. Access the Hosted
Payment Adapter page (Set Up SACR >Common Definitions >Electronic Payments >Hosted
Payment Adapter Setting).

This example illustrates the fields and controls on the Hosted Payment Adapter page.

The parameters page should be set up according to your third-party payment provider’s requirements.
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This example illustrates the fields and controls on the Parameters page.

Next, the hosted payment adapter is attached to a Payment Merchant. If you are already using the hosted
payment framework for Student Financials’ Self Service or Cashiering, you will still need to set up new
Payment Merchants with a different set of Third Party Merchant IDs. Your third party will require return
URLs in order to navigate the user back to the online application. These return URLs are typically tied to
the Third Party Merchant ID defined in the Payment Merchant.

Note that the hosted payment adapters use the Get Token (91) and Authorize Only (92) transactions
defined in the Electronic Payment Setup section of the Payment Merchant setup. If you plan to use these
adapters as delivered, you will need to set up this section in the same manner as defined in the Electronic
Payment Integration Developer’s Reference Guide in My Oracle Support (ID 1982664.1). In addition,
you will need to set up the corresponding Integration Broker Related objects for these transactions. Please
refer to the Electronic Payment Integration Developer’s Reference Guide in My Oracle Support (ID
1982664.1) for more details.

You are required to configure one for each payment method you accept (credit card or electronic check).

Access the Payment Merchant page (Set Up SACR >Common Definitions >Electronic
Payments >Payment Merchant).
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This example illustrates the fields and controls on the Payment Merchant page.

Finally, payment merchants are attached to SF merchants which are associated with the Admissions
Application Center.

Credit transactions (Credit Only – 93 as defined above) can only be generated for transactions posted to
the student account. Since payments received through the online admissions application are posted to the
General Ledger directly, credit transactions are not supported for these application fee payments.

Access the SF Merchants page (Set Up SACR >Common Definitions >Self Service >Student
Financials >SF Merchants).
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This example illustrates the fields and controls on the SF Merchants page.

Note: Convenience fees are not currently supported for online application fee payment.

Post Installation Troubleshooting Tips

This section discusses how to:

• Verify web service security settings.

• Publish the web services.

• Refresh the HCM Registry Cache.

• Verify Campus Solutions SOA framework setup entries.

• Avoid caching issues.

• Resolve Microsoft Internet Explorer 7 trusted sites issue.

• Resolve Adobe Flex domain security issue.
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Verifying Web Service Security Settings
The service operations for the SAD_ADMISSIONS, SCC_USERREG, SCC_LOV,
SSF_EPAYMENT_TRANSACTION, and SCC_SM_SERVICE services are delivered with FULL
ACCESS to the HCSPSERVICE permission list.

Note: SCC_SM_SERVICE supports all aspects of the External Search Match feature and was delivered as
part of Constituent Web Services (CWS).

To verify whether HCSPSERVICE permission list is assigned to a service operation with FULL
ACCESS:

1. Access the General page (PeopleTools >Integration Broker >Integration Setup >Service
Operations >General).

2. Click the Service Operation Security link to access the Web Service Access page.

3. On the Web Service Access page, verify whether the permission list has full access.

Publishing the Web Services
Use the Provide Web Service page to publish the following web services (PeopleTools, Integration
Broker, Web services, Provide Web Service):

• SAD_ADMISSIONS

• SSF_EPAYMENT_TRANSACTION

Refreshing the HCM Registry Cache
A new version (1.1) of the Campus Solutions AddPersonCS service has been delivered. This may require
the HCM service registry to be refreshed.

To refresh the HCM service registry:

1. Access the HCM Interface Registry page (Set Up Common Objects >System
Administration >HCM Registry >Service Registry).

This example illustrates the fields and controls on the HCM Interface Registry page.
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2. 2. Click the Refresh Cache button.

Verifying Campus Solutions SOA Framework Setup Entries
During installation, the system automatically inserts configuration data into the Campus Solutions SOA
Framework setup tables.

To verify whether the setup entries exist:

1. Access the Request Handlers component (Set Up SACR >System
Administration >Integrations >Request Handlers).

2. For all the SAD_ADMISSIONS web service operations, ensure that the fields on the Request
Handlers page contain the following values:

Field Value

Package Name SCC_OLA

Path Handlers

Application Class ID Admissions

3. For all the SSF_EPAYMENT_TRANSACTION web service operations, ensure that the fields on the
Request Handlers page contain the following values:

Field Value

Package Name SSF_EPAYMENT_TRANS

Path HANDLERS

Application Class ID Admissions

Avoiding Caching Issues
Your web server or browser may cache old content. One way to overcome this issue is to enclose the
online application page content in a HTML wrapper as shown in the following code:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 3.2//EN">
<html>
<head>
<!-- BEGIN INSERT --><META HTTP-EQUIV="Expires" CONTENT="Mon, 04 Dec 1999 21:29:02 ⇒

GMT"><!-- END INSERT -->
<!-- BEGIN INSERT --><HEAD><META HTTP-EQUIV="PRAGMA" CONTENT="NO-CACHE"></HEAD><!--⇒

 END INSERT -->
<title>OLA Demo</title>
</head>
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<body bgcolor=white lang=EN-US link="#3366cc" vlink="#9999cc" style='tab-interval:
.5in' leftmargin=10 RIGHTMARGIN=10 alink="#0000cc">
<object width="800" height="500">
<param name="movie" value="OLA.swf">
<embed src="OLA.swf" width="800" height="500">
</embed>
</object>
</body>
</html>

Resolving Microsoft Internet Explorer 7 Trusted Sites Issue
When using Microsoft Internet Explorer 7, you may need to add your web server URL hostname to
Microsoft Internet Explorer 7's trusted sites. If you do not add the URL to the trusted sites, you will
receive a security error that starts like: Error in line 1 char 2. This is a rather cryptic error, but adding your
web server host to the trusted sites setup in your browser will correct this issue.

Resolving Adobe Flex Domain Security Issue
This issue is applicable if you are using Adobe Flex to develop an online application.

If the user loads this online application from a particular domain, the online application cannot retrieve
data from another domain. To avoid this issue, you can create a crossdomain.xml file that allows your
online application to load content from other domains. Refer to the Adobe Flash or Adobe Flex website
for more information on the crossdomain.xml file.

Setting Up Logging
This is an optional setup.

Use the Logging page to enable and configure the logging feature (Set Up SACR >System
Administration >Integrations >Logging).

This example illustrates the fields and controls on the Logging page.

Note: You should not enable logging in a production environment. SOA framework logging is only
appropriate for a testing, demo or development environment or when performing critical troubleshooting
activities.
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User Interface Considerations

It is beyond the scope of this AAWS documentation to cover the best practices for user interface
design and an effective online application user experience. However, this section discusses some key
considerations for designing and creating a user interface that interacts with AAWS.

Note that in addition to user interfaces interacting with AAWS, a third party admission application can
also interact with AAWS by transmitting the completed application data to AAWS for further processing.

Start: Unregistered User
Essentially all applicant users start in this state.

New User Registration
The user interface could use the SCC_USERREG_CREATEACCT service operation. NUR is a delivered
CTM transaction.

Logon (Authentication)
The user interface could use the delivered SCC_USERREG_AUTHENTICATE service operation.

Get Application Summary
Once the user has been authenticated, it is likely that the user would then expect to see some form of
online application launch page. It is also likely that returning users would expect to view or update any
applications they have saved or submitted previously. To implement this kind of scenario, the online
application user interface can request from AAWS the application summary information for the logged in
user and then display this information on the launch page.

For first time users, the online application does not display saved or submitted application information.
For these users, the online application can display options for creating a new application or for logging
out.

A typical self-service, online-application user interface might perform the following actions:

• Formulate a request message.

• Submit the request message to the SAD_GETAPPLS service operation.

• Receive the application summary response message from AAWS.

• Based on the application status, present each application to the user in a grid style format for
subsequent actions.

• Typically, applications which are in a Submitted status are not eligible for update and a user interface
would need to enforce this rule depending on the institution's requirements.

154  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 6 Using Admission Applications Web Services

Create Application
From the online application launch page, a user may choose to start the application process by creating a
new application.

A typical self-service, online-application user interface might perform the following actions:

• Present an Apply hyperlink that the user can click to initiate the application process.

• Present an initial Academic Learning Area page where the user can choose a field of study. For
example, on this page the user supplies the required values to the SAD_CREATEAPPL service
operation. The required values that the user enters might include academic program, plan, and sub
plan.

• Formulate a request message.

• Submit the request message to the SAD_CREATEAPPL service operation.

• Receive one or more admission application templates with default values from AAWS.

• Present the one or more applications with the default values to the user through one or more user
interface pages.

• Allow the user to enter in all required application details.

GetFee Configuration
Collecting application fees, while optional, is likely a common scenario that needs to be supported
by the user interface. At some point after application creation (where the application center assigned
to the application will be known to the user interface) but prior to application submission (when fees
may be payable) the user interface needs to obtain the application fee configuration options. The fee
options dictate what fee payment preferences should be presented to the self service applicant by the user
interface. Options related to fee payment include whether:

• An application fee is required.

• The applicant is given the option to Pay Later.

• The applicant can be given the option to request a Waiver for the fee.

Based on which fee options are configured, the user interface needs to react appropriately and present the
applicant with only the valid options. This will in some cases alter the user interface page flow presented
to the applicant.

A typical self-service, online-application user interface might perform the following actions:

• Collect the Academic Learning Area preferences that the applicant enters during the Create
Application step. For example, the applicants are required to enter the academic career and program
for which they wish to create an application.

• Use the preferences to create a request message for the SCC_LOV service, the request must include a
look up of:

• The SAD_LISTVAL_VW record to retrieve the application fee options.
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• The SSF_ADM_TND_VW record to retrieve the tendering options.

• Submit the request message to the SCC_LOV service.

• Receive the application fee configuration options.

• Act on the application fee configuration options in the following way:

• If the Pay Later option is activated, then present the applicant with the choice to pay later (the
applicant's choice is then used in the subsequent Submit Application step).

• Store all the application fee and tendering configuration options in user interface storage for use in
the subsequent Present Fee Options step.

Update Application
The online application's launch page may show applications that the user has previously saved or
submitted. The user may wish to submit a previously saved application.

A typical self-service, online-application user interface might perform the following actions:

• Present an Update hyperlink that the user can click to initiate the application update process.

• Formulate a request message.

• Submit the request message to the SAD_GETAPPL service operation.

• Receive an in-process or draft application from AAWS.

• Present the application to the user through one or more user interface pages.

• Allow the user to modify or enter the application details.

Edit Application
This activity represents the user completing details on one or more pages in the online application. This
activity mostly involves the user interface presenting the page flow and collecting data from the user.
If your institution has implemented attachments, then the returning user may wish to view any existing
attachments associated with an application.

When the user edits the application data, the online application user interface may present dynamically
generated prompts and dropdown list boxes. The online application may need to populate the values for
these prompts and list boxes through calls to the SCC_GET_LOV service operation. Dynamic prompting
occurs in situations where the system uses the user input to display the user interface dynamically. An
example of dynamic prompting is when the user selects an undergraduate career; the Program field on the
online application displays only undergraduate programs for the user to select.

A typical self-service, online-application user interface might perform the following actions:

• Present a series of pages for the user to interact with.

• Optionally, formulate a dynamic List-Of-Values request message.
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• Submit the request message to the SCC_GET_LOV service operation.

• Present the List-Of-Value results in the online application page fields.

• Optionally, formulate an attachment request message.

• Submit the request message to the SAD_GET_ATTACH service operation.

• Decode the response from AAWS and present the binary content of the attachment in a suitable
viewer.

Save Application
When the user is creating or updating an application, he or she may want to pause and save the
application for later modification or submission. The saved application is an in-process or draft
application and AAWS places this draft application in a staging area. Subsequently, the user may submit
this application or the system administrator may delete this application.

A typical self-service, online-application user interface might perform the following actions:

• Present a Save For Later hyperlink on any page in the page sequence. Generally, any page after
the user starts creating the application may display this link. The user clicks this link to save the
application.

• Prompt the user that the application is saved and the academic institution might use the applicant
information for marketing purposes (if prospect creation is configured to occur on save).

• Formulate a request message.

• Submit the request message to the SAD_SAVEAPPL service operation.

• Receive and process the response from AAWS:

• On a Success response there are various options:

Present the user with a confirmation page. The confirmation page confirms that the application
has been saved.

Take the user back to the Get Application Summary page.

Log out the user from the online application.

• On an Error response:

Based on the error codes that AAWS returns, position the user at an appropriate page of the user
interface to allow data correction.

Present validation error messages to the user.

Present system error messages to the user.

Copyright © 1988, 2021, Oracle and/or its affiliates. 157



Using Admission Applications Web Services Chapter 6

Submit Application
After a user completes the application, the user interface should present a Submit Application option.
Also, at submission time, the interface can present any number of disclaimer pages to the user. Generally,
after a user submits the application, the user cannot update the application and the user interface would
need to enforce this rule using the application status value. The user interface can retrieve this value using
the SAD_GETAPPLS service operation.

A typical self-service, online-application user interface might perform the following actions:

• Present a Submit button on the final online application page.

• Prompt the user with any required disclaimers.

• Formulate a request message. Note that if a fee is due and the applicant has opted to Pay Later during
the Get Fee Configuration step, then this intent must be indicated in the request message.

• Submit the request message to the SAD_SUBMITAPPL service operation.

• Receive and process a response from AAWS. There are three alternative responses that the user
interface needs to cater for:

• A Success response and fee payment is not required:

Present the user with a confirmation page. The confirmation page confirms that the application
has been submitted.

Take the user back to the Get Application Summary page.

Log out the user from the online application.

• A Success response and fee payment is required:

Extract the fee amount and currency code from the response.

Proceed to the Present Fee Options page.

• An Error response:

Based on the error codes that AAWS returns, position the user at an appropriate page of the user
interface to allow data correction.

Present validation error messages to the user.

Present system error messages to the user.

Present Fee Options
If the Get Fee Configuration step determines that there is a fee payable at submission time, then this page
flow must be presented to the applicant. Fees are calculated by Student Financials according to the Fee
Code attached to the application center. This page flow needs to present the applicant with his or her
payment options based on the values returned in the earlier Get Fee Configuration step. The options here
will include the ability to specify the tender category (for example, CC and check) and optionally the
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ability to request a waiver if that is allowed. Partial payments are not allowed. Therefore, the self service
online application must not allow the applicant to change amount presented for payment.

A typical self-service, online-application user interface might perform the following actions:

• Present a page showing the:

1. Amount payable.

2. Currency code of the fee amount.

3. Optionally, the ability to request a waiver.

4. Optionally, the ability to specify a Waiver Basis code to be associated with the waiver request.

5. Optionally, the ability for the applicant to attach one or more attachments to be used as supporting
documentation for the waiver request.

• Formulate a request message based on the choice of the applicant:

1. If the applicant requests a waiver then:

- Add waiver details to the request.

- Submit the request to the SAD_SUBMITAPPL service operation.

- Process the response as in the Submit Application flow.

2. If the applicant chooses to proceed with payment:

-Submit the request message to the SSF_INITIATE_EPAYMENT web service operation.

-Receive and process the response from the payment service operation.

-The response may be either a HTTP redirect or a HTML string (this is determined by the hosted
payment configuration).

-In the case of a redirect, the user interface needs to respect the HTTP redirect and it will also
need to store state of the current logged on userid/password in persistent client storage (for
example, a database table).

-In the case of a HTML string response, the user interface can handle this in a number of ways.
Some examples are:

— Spawn a new child window to display the HTML string response.

— Incorporate the HTML response into a parent window frame.

3. The response style is configurable and customizable by use of dynamic HTML. There is sufficient
flexibility for the user interface to initiate the Payment Processing flow in either a new or an
existing browser window. The decision will hinge entirely on the desired user experience and the
technical capabilities of the user interface technology being employed.
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• The end result of this activity is that the user will be presented with a browser page provided by the
third party hosted payment processor from where the applicant can proceed with payment as given in
the Payment Processing flow.

Payment Processing
At this point the applicant has indicated that they wish to proceed with payment of a fee and they will
have been presented with a browser window which contains a HTML page provided by the third party
hosted payment provider (for example, the applicant will have been redirected to the third party site).

The applicant would then proceed to enter payment options and submit or cancel the payment. The third
party provider would then redirect the applicant’s browser to one of the three configured URLs:

• CANCEL – the URL destination for when the applicant cancels the payment.

• SUCCESS – the URL destination for when the payment is completed successfully.

• FAIL - the URL destination for when the payment is not completed successfully.

In the event of a successful payment, then one final step needs to occur in order to complete the payment
cycle. The Complete ePayment web service needs to be invoked to finalize the payment and submit the
application. The self service online application user interface should display the appropriate message to
the applicant based on the Complete ePayment (SSF_COMPLETE_EPAYMENT) response message.

A typical self-service, online-application user interface might perform the following actions:

• Formulate a request message.

• Submit the request to the SSF_COMPLETE_EPAYMENT web service.

• Present a page to notify the applicant of successful payment.

• Optionally transfer the applicant back to the Online Application home page and initiate the Get
Application Summary flow to show the latest status.

Error Handling
When the system validates the data during save and submit, if validation errors occur, the error handling
feature returns a list of textual descriptions of those errors along with error IDs and the field names related
to the errors. As much information as possible is returned to the user interface to present the errors to the
user and allow correction of the errors.

The user interface must perform the following steps to use the error handling feature:

• The user interface must populate a unique ID into the tag called SCC_ENTITY_INST_ID in the
request xml for each entity. In the event of error during data validation, error handling returns to the
user interface the unique ID (that is obtained from the request message) and the field name related to
the error along with the error message text.

• The user interface can use this unique error ID, the field name, and the error message to know what
fields on what pages are in error. This allows the user interface to highlight the fields with errors and
allows the user to correct the data.
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The unique ID is optional in the request schema. Therefore, institutions should populate the unique ID
only if they want to uptake the error handling feature.

Institutions are free to populate the SCC_ENTITY_INST_ID in any format they please, but it is
recommended that they use the official Universally Unique Identifier (UUID) format, 36 character ISO
standard.

Logoff
An option to leave the online application could potentially be provided from any page in the online
application. Clicking the Logout hyperlink is a signal from the users that they intend to leave the system
and that any sensitive information managed by the user interface should now be cleared.

A typical self-service, online application user interface might perform the following actions:

• Present a Logout hyperlink that the user can click to log out of the online application.

• Clear the username and password combination from the local user interface temporary storage area.

• Present the user with a logged off confirmation page.

Building the Hosted Payment HTML Object
For more information about the hosted payment feature, refer to the Electronic Payment Integration
Developers Reference Guide in My Oracle Support (ID 1982664.1).

The HTML object is provided as a flexible means to allow a diverse range of user interface technologies
to interact with the hosted payment feature. The concept is that the HTML object can be constructed using
dynamic HTML. The HTML object can then be presented in a browser window to allow seamless flow
between the admissions online application and the third party payment provider. In theory there should be
no page flow or user experience which cannot be achieved using a JavaScript based HTML object. Note
that the HTML object is not limited to JavaScript and can contain any proprietary client side scripting
language as is dictated by the user interface technology in use by the institution.

As a simple example the following HTML object could be used to auto-redirect the applicant’s browser to
a third party payment provider:

<BODY onload="submitForm()">
 <form name=”myform” action="https://someserver/upay/web/index.jsp" method="post">
<input type="hidden" name="UPAY_SITE_ID" value="3">
<input type="hidden" name="TICKET" value="12345">
<input type="hidden" name="TICKET_NAME" value="12345">
</form>
<SCRIPT LANGUAGE="JavaScript">function submitForm()
{document.myform.submit();}
</SCRIPT>
</BODY>

AAWS Web Services Description Language

During setup, the system generates the Web Services Description Language (WSDL) for
SAD_ADMISSIONS.
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The following diagram lists the SAD_ADMISSIONS web service operations and their messages.
The diagram also shows an example of a location from where an online application can access the
SAD_ADMISSIONS web service.

Note: SAD_ADMISSIONS is a SOAP-based service. If a SOAP service request XSD contains the
languageCd parameter, then the service is enabled for National Language Support (NLS). The request
message must pass an ISO Locale value as the languageCd variable. Valid values can be found in the
PeopleTools – Manage Installed Languages page (PeopleTools, Utilities, International, Languages).

Here is an example of an excerpt of a request message that includes this variable:

<?xml version="1.0"?>
<SAD_CREATEAPPL_REQ languageCd="fr" xmlns=
"http://xmlns.oracle.com/Enterprise/HCM/services">

  <COUNTRY></COUNTRY>
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Sample Code for an Online Application

The following example shows how an online application uses ADF to call the SAD_SAVEAPPL service
operation:

1. Create the web service proxy using the WSDL URL. It will generate the proxy code (methods) to
invoke the service operations.

Sample code of generated proxy:

@WebServiceClient(wsdlLocation="http://<hostname>/PSIGW/
PeopleSoftServiceListeningConnector/SAD_ADMISSIONS.1.wsdl",
targetNamespace="http://xmlns.oracle.com/Enterprise/HCM/services/SAD_ADMISSIONS.1",
  name="SAD_ADMISSIONS")
public class SAD_ADMISSIONS
  extends Service
{  private static URL wsdlLocationURL;
  private static Logger logger;
  static
  {  try    {      logger = Logger.getLogger("sadAdmissions.SAD_ADMISSIONS");
           URL baseUrl = SAD_ADMISSIONS.class.getResource(".");
           if (baseUrl == null)  {
        wsdlLocationURL = SAD_ADMISSIONS.class.getResource("http://<hostname>/PSIGW⇒

/PeopleSoftServiceListeningConnector/SAD_ADMISSIONS.1.wsdl");
        if (wsdlLocationURL == null)   {
          baseUrl = new File(".").toURL();
          wsdlLocationURL =
              new URL(baseUrl, "http://<hostname>/PSIGW/PeopleSoftServiceListeningC⇒

onnector/SAD_ADMISSIONS.1.wsdl");
        }
      }     else      {
                if (!baseUrl.getPath().endsWith("/")) {
         baseUrl = new URL(baseUrl, baseUrl.getPath() + "/");
}                wsdlLocationURL =
            new URL(baseUrl, "http://<hostname>/PSIGW/PeopleSoftServiceListeningCon⇒

nector/SAD_ADMISSIONS.1.wsdl");
      }
    }    catch (MalformedURLException e)
    {  logger.log(Level.ALL,
       "Failed to create wsdlLocationURL using         http://<hostname>/PSIGW/Peop⇒

leSoftServiceListeningConnector/SAD_ADMISSIONS.1.wsdl",
          e);
    }
  }
//...
//...
//...
  @WebEndpoint(name="SAD_ADMISSIONS_Port")
  public SAD_ADMISSIONS_PortType getSAD_ADMISSIONS_Port()
  {    return (SAD_ADMISSIONS_PortType) super.getPort(new QName("http://xmlns.oracl⇒

e.com/Enterprise/HCM/services/SAD_ADMISSIONS.1", "SAD_ADMISSIONS_Port"),
SAD_ADMISSIONS_PortType.class);
  }
//...
}

  @WebMethod(operationName="SAD_SAVEAPPL", action="SAD_SAVEAPPL.v1")
  @SOAPBinding(parameterStyle=ParameterStyle.BARE)
  @Action(input="SAD_SAVEAPPL.v1", fault =
      { @FaultAction(value="http://xmlns.oracle.com/Enterprise/HCM/services/SAD_ADM⇒
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ISSIONS.1/SAD_ADMISSIONS_PortType/SAD_SAVEAPPL/Fault/SAD_FAULT_RESP.V1",
          className=sadAdmissions.SAD_FAULT_RESPV1.class) }, output="http://xmlns.o⇒

racle.com/Enterprise/HCM/services/SAD_ADMISSIONS.1/SAD_ADMISSIONS_PortType/SAD_SAVE⇒

APPL_RESP.V1")
  @WebResult(targetNamespace="http://xmlns.oracle.com/Enterprise/HCM/services",
    partName="parameter", name="SAD_SAVEAPPL_RESP")
  public SADSAVEAPPLRESP sadSAVEAPPL(@WebParam(targetNamespace="http://xmlns.oracle⇒

.com/Enterprise/HCM/services",
      partName="parameter", name="SAD_SAVEAPPL_REQ")
    SADSAVEAPPLREQ parameter)
    throws sadAdmissions.SAD_FAULT_RESPV1;

2. Use the proxy methods to invoke the service operation:

//Create the Application request
        SADSAVEAPPLREQ reqSaveAppl = new SADSAVEAPPLREQ();
 //Construct the Application request by setter methods created by web service proxy

 //Create the Application response
        SADSAVEAPPLRESP respSaveAppl = new SADSAVEAPPLRESP();

        try {
            SecurityPolicyFeature[] securityFeatures =
            new SecurityPolicyFeature[]            { new SecurityPolicyFeature("ora⇒

cle/wss_username_token_client_policy") };
            sAD_ADMISSIONS = new SAD_ADMISSIONS();
            SAD_ADMISSIONS_PortType sAD_ADMISSIONS_PortType =             sAD_ADMIS⇒

SIONS.getSAD_ADMISSIONS_Port(securityFeatures);

            Map<String, Object> requestContext =             ((BindingProvider) sAD⇒

_ADMISSIONS_PortType).getRequestContext();
            SAD_ADMISSIONS_PortClient.setPortCredentialProviderList(requestContext)⇒

;
            // Add WS-Security header username & password if we currently
            authenticate (logged on)
            requestContext.put(BindingProvider.USERNAME_PROPERTY, username);
            requestContext.put(BindingProvider.PASSWORD_PROPERTY, password);

            // invoke the sadSAVEAPPL method created by we service proxy
            respSaveAppl = sAD_ADMISSIONS_PortType.sadSAVEAPPL(reqSaveAppl);

            // pass the response (respSaveAppl) to the response handler

        }
        catch (SOAPFaultException sfe) {
            //handle SOAP Fault
        }
        catch (Exception e) {
            //handle any other exception
        }
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Using the AAWS Sample Online Application

What is SOLA

The primary purpose of the Admission Application Web Services (AAWS) suite (introduced in July,
2010) is to provide academic institutions, across the globe, with the ability to capture and move data
from separately designed and constructed admissions applications into staging and production tables.
Implementing and using this important technology and functionality requires in depth knowledge of
Service-Oriented Architecture (SOA), Web Services Description Language (WSDL), and user interface
design. The sample online application (SOLA) is an additional offering in Oracle's continuing efforts
to provide documentation, references, and tools that will guide and assist academic institutions in their
implementation of AAWS. SOLA provides the following important features:

• A sample user interface in a familiar PeopleTools package that can be easily understood and
referenced.

• A pre-constructed user interface that utilizes and demonstrates how delivered AAWS is designed,
organized, and managed. The sample interface includes embedded technical annotations within the
delivered code.

• A delivered example of how the Constituent Transaction Manager (CTM) and AAWS work within a
user interface.

• A working sample that can be used to test transaction setup and data update rules.

• A working sample that can be used to create data in CTM and application staging tables.

By providing a standalone online application sample, Oracle hopes to reduce the time required for
successful AAWS implementations and improve uptake of future SOA based development.

To navigate to the SOLA component, select Set Up SACR >System
Administration >Utilities >Sample User Interfaces >Sample Online Application.

What SOLA is Not

SOLA as delivered, is not intended to be used as an online application representing your institution. It is
a teaching tool and a reference for guidance on your implementation of AAWS. While there is nothing
preventing institutions from using SOLA as a foundation to develop an online admissions application
according to their requirements, Campus Solutions does not recommend the delivered user interface to be
deployed for applicants. As you will see later on in this SOLA documentation, we have delivered a very
basic design of an admission application and we fully expect that the sample user interface will not reflect
the items you wish for your applicants to submit. Because SOLA is an example, we do not anticipate
updating any of the data elements or the design of the delivered sample user interface.
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Audience

This SOLA documentation is directed specifically at the advanced developer who is interested in
understanding the relationship between AAWS and a working sample online application, developed using
the PeopleTools Internet Architecture (PIA). We expect that the SOA concepts and technical capabilities
illustrated with this example will be applicable when implementing AAWS with other user interface tools.

In order to gain a comprehensive understanding of how SOLA works, your developer needs to be aware
of three distinct types of documentation associated with this sample feature:

• The first is this SOLA documentation. This documentation contains a technical overview of how
SOLA works from a functional perspective, its design, as well as some references to additional
supporting documentation.

• The second is a complete object inventory. This is a HTML version of a Technical Design Document
(TDD). In this document you will find every object (that is, Fields, Record Definitions, Pages,
Components, PeopleCode, and so on.) that make up SOLA. You can find this document in My Oracle
Support (ID 1492390.1).

• Finally, there is the application package PeopleCode for this sample (SAD_OLA_DEMO). In each of
the application classes are comments documenting the inner workings of SOLA.

The developer is strongly encouraged to become knowledgeable with the content in all three types of
documentation to gain a comfortable understanding of AAWS and how it interacts within SOLA. When
combined and internalized, this troika of information is intended to educate the developer on the use and
deployment of AAWS within your institution.

Supporting Audience

In the Required Setups section of this SOLA documentation you will notice that AAWS has a dependency
with other functional areas; specifically Student Financials and Campus Community. It is very likely that
you will need to establish a close relationship (both technically and functionally) between AAWS and
these areas.

Required Setups

Before you can begin examining and evaluating SOLA, you need to perform the following setups:

Setup Areas See

Enable the CTM, AAWS and SF web services that SOLA uses
to Active.

Product documentation for PeopleTools: Integration Broker

Set up the URL definition SAD_APPL_ATCH. SOLA uses
SAD_APPL_ATCH for attachments.

Setting Up the Attachments URL
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Setup Areas See

Set up the Application Fee Waiver Basis Codes on the
Application Fee Waiver Basis page and AAWS Application
Fee and Waiver Processing parameters on the Application
Center Table page.

Setting Up Your Recruiting Structure

Set up the Data Update Rule Entry component to be used for
the transaction.

"Understanding CTM" (Campus Community Fundamentals)

Set up a transaction or use the delivered admissions
application transaction for testing.

"Understanding CTM" (Campus Community Fundamentals)

Set up the Application Configuration component. Configuring Admission Transactions

Set up SOLA and verify whether SOLA is set up properly SOLA Setup and Verification

New User Registration Setup:

To configure a New User Registration context that will
provision access to your Online Application Home page and
transfer the applicant directly to this page after successfully
authenticating to your system.

"Understanding New User Registration" (Campus Community
Fundamentals)

Setting Up Online Payment for Application Fee Setting Up Hosted Payment

Web Services Used by SOLA

This table lists the web services that SOLA uses and where you can find documentation about these
services:
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Web Service Web Service Operations See

SAD_ADMISSIONS • SAD_CREATEAPPL (Create
admission application)

• SAD_GETAPPL (Get admission
application)

• SAD_GETAPPL_RESP (Get
admission application response)

• SAD_GETAPPLS (Get admission
applications)

• SAD_GETAPPLS_RESP (Get
admission applications response)

• SAD_SAVEAPPL (Save admission
application)

• SAD_SUBMITAPPL (Submit
admission application)

• SAD_GETATTACH (Get admission
attachments)

Understanding AAWS

SSF_EPAYMENT_TRANSACTION • SSF_INITIATE_EPAYMENT 
(Initiate an ePayment)

• SSF_COMPLETE_EPAYMENT 
(Complete an ePayment)

How to Test AAWS and Hosted Payment
SSF_INITIATE_EPAYMENT Service
Operation Tester in My Oracle Support 
(ID 1349409.1)

Understanding AAWS

New User Registration Framework and SOLA

The New User Registration framework, integrated with SOLA, enables an applicant to sign up for a user
ID. The framework provides a sample New User Registration login page that you can customize and
deploy to suit your institution’s requirements. An applicant can use this page to sign into the system or to
register for a user ID. The applicant accesses the New User Registration login page from a link or button
you would have added to your portal (for example: “To apply online, click here”). Once transferred to
the New User Registration login page, the applicant can create a new user ID or use an existing one if the
applicant already has one (for example the applicant has taken courses previously in his or her life). Once
authenticated to your system, New User Registration can provision the applicant with security access to
your Online Application component and then automatically transfer the applicant directly to that page. To
do so, a New User Registration Context specific to Online Application needs to be created.

"Understanding New User Registration" (Campus Community Fundamentals)

168  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 7 Using the AAWS Sample Online Application

Entity Registry and SOLA

This table lists the records and their corresponding entities that are populated through Constituent Staging
and Application Transactions staging tables from SOLA:

Entity ID Entity Name Staging Record

SCC_ENTITY_20090521054417 Constituent SCC_STG_CONSTIT

SCC_ENTITY_20090520155540 Person Data Effdt SCC_STG_PDE

SCC_ENTITY_20090521053330 Names SCC_STG_NAMES

SCC_ENTITY_20090520155755 Address SCC_STG_ADDR

SCC_ENTITY_20090520155634 Phone SCC_STG_PHONE

SCC_ENTITY_20090521044252 Email Address SCC_STG_EMAIL

SCC_ENTITY_20090520155342 National ID SCC_STG_NID

SCC_ENTITY_20090519160928 Citizenship SCC_STG_CITZN

SCC_ENTITY_20090520035051 Person Data (USA) SCC_STG_PRSDATU

SCC_ENTITY_20090723101739 Emergency Contact SCC_STG_EMG_CNT

SCC_ENTITY_20090723101507 Emergency Phone SCC_STG_EMG_PHN

SCC_ENTITY_20090521094345 Application SAD_APL_DAT_STG

SCC_ENTITY_20090521094125 Career Sequence SAD_APP_CSQ_STG

SCC_ENTITY_20090521093827 Academic Program SAD_APL_PRG_STG

SCC_ENTITY_20090521093651 Academic Plan SAD_APL_PLN_STG

SCC_ENTITY_20090520153020 Student Career (Constituent) SCC_STG_STD_CAR

SCC_ENTITY_20090521090104 Application Attachment SAD_APLATCH_STG

SCC_ENTITY_20090521084930 File Attachment SCC_FATTACH_WRK
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Entity ID Entity Name Staging Record

SCC_ENTITY_20090521043203 Academic History SCC_STG_ACADHST

SCC_ENTITY_20090520160401 External Academic Data SCC_STG_EXACDDT

SCC_ENTITY_20090521042406 External Degree SCC_STG_EXTDEGR

SCC_ENTITY_20090625090929 Q&A Application Extension SCC_EXTN_STG

N/A N/A SCC_SL_TRNMAP (Records a mapping
between the Transaction Manager
constituent and any transaction the
constituent has participated.)

Related Links
"Understanding Entity Registry" (Campus Community Fundamentals)

Functional Flow for SOLA

This section discusses the functional flow of how an applicant registers for a user ID and uses SOLA.

New User Registration
Steps:

1. The applicant registers and authenticates to access your system.

The applicant should be allowed to access your system by using an existing user ID or by creating
a new one. Delivered with your system is a New User Registration login sample page (Set Up
SACR >System Administration >Utilities >Sample User Interfaces >New User Registration).
The page is a sample user interface that shows how security can be handled to access your system,
provision a new or an existing user ID with the security to access your Online Application page and
be automatically transferred to that page.

While the New User Registration login sample page requires a kiosk to be deployed (where
the anonymous user gets logged in as a true user), also delivered with your system is a
New User Registration Tester page (SCC_NUR_TESTER) (Set Up SACR >System
Administration >Utilities >Sample User Interfaces >New User Registration Tester). This page
allows you to evaluate the benefits of integrating a self-service transaction such as Online Application
to New User Registration framework.

Note: Do not deploy the New User Registration Tester page in a production environment.
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This example illustrates the fields and controls on the New User Registration Tester page.

2. The applicant can use an existing user ID and password, or can create a new one by selecting the
Need a User ID? Yes/No check box. When doing so the Confirm Password and any other constituent
fields you may want to add to the page are displayed. When the applicant clicks the Create User
button, the system invokes the SCC_USERREG_CREATEACCT web service operation. This
operation provisions an applicant with an ID and password as well as some generic roles. If set up
with a New User Registration Context, the New User Registration framework provisions the new or
existing user ID with some specific security roles to access the Online Application page and transfers
the applicant directly to that page.

Creating a New Application 
Steps:

1. The applicant signs in to access the institution's Admissions Application home page. The system
invokes the web service operations SCC_USERREG_AUTHENTICATE when the applicant signs
into the system and SAD_GETAPPLS when the applicant reaches the Admissions Application home
page.

Because this is the first time the applicant is visiting the institution’s Application Home page, the web
service operation SAD_GETAPPLS will not return any application data.

SOLA includes a sample Application Home page (SAD_OLA_HOME) (Set Up SACR >System
Administration >Utilities >Sample User Interfaces >Sample Online Application).
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This example illustrates the fields and controls on the Application Home page.

2. The applicant selects the institution, academic career, admit term, academic program, academic plan,
and admit type he or she wishes to apply for.

3. The applicant clicks the Create Application button. This invokes the SAD_CREATEAPPL web
service operation.

4. Because this is the first interaction with the institution (from an admissions perspective), the
web service operation SAD_CREATEAPPL minimally creates row(s) in both the constituent
record (SCC_STG_NAMES) and the academic program stack (SAD_APL_DAT_STG,
SAD_APL_PLN_STG, SAD_APL_PRG_STG, and SAD_APP_CSQ_STG).

5. When the applicant clicks the Create Application button, the system displays the first of six
pages that the applicant uses to fill out the application. At this point, the applicant can fill out the
application and submit the application. When the Submit button is clicked, the system invokes the
SAD_SUBMITAPPL service operation.
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This is an example of one of the six pages for application data entry.

6. Instead of entering data in all the six pages at one time, the applicant can fill out the application over
several sessions. To do this, the applicant can click the Save button and the application data is saved
to the staging tables. When the Save button is clicked, the system invokes the SAD_SAVEAPPL
service operation.

7. If the applicant elects to cancel the application process, a warning message appears to confirm the
cancellation. The applicant can either continue to cancel the application and nothing will be saved and
the applicant returns returned to the Application Home page. Else, the applicant can go back to the
page where he or she clicked the Cancel button and continue with the application.

8. When SAD_SAVEAPPL or SAD_SUBMITAPPL is invoked by the applicant's actions, the system
captures all the data that has been entered and saves it to the appropriate staging tables.

Editing Existing Application
Steps:
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1. Again through the New User Registration login page (or a custom version of it), the applicant signs
in using an existing user ID. The applicant is automatically transferred to the Online Application page
and the system invokes the SAD_GETAPPLS service operation. This service operation returns all the
applications that pertain to the applicant. To keep this scenario simple, let us assume that there is only
one application that the applicant is working on and therefore the home page displays that application.

This is an example of the Application Home page displaying one saved application.

2. When the applicant clicks the Edit button, the system invokes the SAD_GETAPPL service operation.

Note: The service operation SAD_GETATTCH also gets fired. SAD_GETATTCH will retrieve any
attachments that the applicant submitted in an earlier session.

3. When the applicant clicks the Edit button, the system displays the first of six pages that the applicant
uses to fill out or correct any previously entered data for the application. At this point, the applicant
can fill out the application.

4. The applicant can repeat the above steps as many times as he or she would like until the application is
finally submitted.

Editing Existing Multiple Applications and Reviewing Multiple Application
Statuses

Steps:

1. The applicant signs into the institution's Admissions Application home page. The system invokes the
SAD_GETAPPLS service operation. This service operation returns all the applications that pertain to
the applicant. This time, let us assume that there are several applications in various states and statuses.

2. The Current Applications grid displays all the applications of the applicant. Let us assume that from
this list of applications, one application has been Submitted. Depending on how you have defined how
the application is to be treated upon submission, the application can either be in Submitted or Posted
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status. If the application is in Submitted or Posted status, the only action available to the applicant is
to view that specific application (the applicant cannot edit the application).

This is an example of the Application Home page with multiple applications.

3. If the applicant clicks the View button for the submitted or posted application, the Application View
page (SAD_OLA_VIEW) appears. This page presents in a display-only, linear format, all of the
information the applicant submitted. If the applicant wants to update this application, the Application
View page requests the applicant to contact the Admissions office to initiate any updates. When the
applicant clicks the View button, the system invokes the SAD_GETAPPL service operation.
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This example illustrates the fields and controls on the Application View page (1 of 3).
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This example illustrates the fields and controls on the Application View page (2 of 3).
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This example illustrates the fields and controls on the Application View page (3 of 3).

Note: Notice that External Org ID and Name are blank in the Other Schools Attended section. This is
because the applicant indicated that he or she was unable to locate the school from the External Org
ID list and the School Setup page does not have a default External Org ID.

4. For the remaining application(s) that have yet to be submitted, the applicant can update them as
outlined in the previous Editing Existing Application subsection.
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SOLA Pages for Entering Application Data
This subsection discusses the six SOLA pages that the applicant can use to enter application data.

Basic Information page (SAD_OLA_BASIC)

This example illustrates the fields and controls on the Basic Information page.

• This SOLA page captures basic biographical data (that is, name, gender, and birth information). The
system saves the legal name entered here with the name type of Primary. If the applicant enters a
name in the Preferred First Name field, an additional row is written to the SCC_STG_NAMES with a
name type of Preferred.

• When the applicant accesses this page for the first time, the page hides the National ID field.
When the applicant enters a value for Country, the system executes the determineNIDType method.
This method determines whether to display the National ID field based on the setup within
NID_TYPE_TBL.
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Note: If the National ID field appears, then the page applies the validation associated with that
country's national ID number during the save process.

Contact Information page (SAD_OLA_CONTACT)

This is how the system presents the Contact Information page when the applicant accesses it for the first
time. Note that the page hides the permanent and mailing address fields:

This example illustrates the fields and controls on the Contact Information page.

• The page hides the address fields to support address formats based on a specific country. SOLA
supports address formats for the following countries:

• (ARG) Argentina

• (AUS) Australia

• (BRA) Brazil

• (CAN) Canada

• (CHN) China

• (FRA) France

• (IND) India

• (SNG) Singapore

• (USA) United States
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• When the applicant selects anyone of these countries, SOLA will display the address format specific
to that country:

This example illustrates the fields and controls on the Contact Information page for a particular
country.

• If the applicant selects a country other than those mentioned previously, the page renders a default
address format.

• To copy the permanent address values to the mailing address fields, the applicant can select the
Mailing Address Same as Permanent check box. When the applicant selects this check box, the
system executes the copyPermAddressToMailAddress  method to copy the values supplied in the
Permanent Address fields to the Mailing Address fields. After copying, the page hides this check box.
However, on any subsequent return to this page, the check box will again appear.
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Note: If the applicant changes the country value for any of the address types, this SOLA page will blank
out any previously saved address information for that address type. The handling of name, address and
other personal information in SOLA represents design examples of how delivered web services can
support a user interface.

Emergency Contact page (SAD_OLA_CONTACT)

This example illustrates the fields and controls on the Emergency Contact page.

The address functionality on this page is similar to the Contact Information page.
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Academics page (SAD_OLA_ACAD)

This example illustrates the fields and controls on the Academics page.

• This is an example of how the Academics page is displayed when an applicant accesses it for the
first time. This is done to preserve a predefined sequence numbering schema associated with the
admissions application history.

• If the applicant indicates that he or she was home schooled, the system writes a row to
SCC_STG_ACADHST with a sequence number of one. Information pertaining to the Last School
Attended will be assigned a sequence number of 2. The system will increment the sequence number
for each Other Schools Attended record that the applicant adds.

• If the applicant does not indicate that he or she was home schooled, then the information pertaining to
the Last School Attended will get a sequence number of one.

• If the applicant is unable to find his or her institution in the External Org ID drop down list, then
they have the option of indicating such by selecting the I can't find my school check box. When
the applicant selects this check box, the page displays additional fields that the applicant can use to
specify the school details.
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This is an example of the Academics page with the I cannot find my school check box selected.

• When the applicant selects the check box, the system disables the External Org ID field and marks
the School Name field as a required field. All other fields are optional.

Note: Suppose you have indicated that the application requires manual reconciliation for both home
school and unlisted school on the School Setup page of the Application Configuration component. In
such a case, if the applicant indicates that he or she was either home schooled or is unable to locate his
or her institution or indicates both, then the application will get a status of Error when submitted.

Suppose you have specified a default External Org ID for both home school and unlisted school on
the School Setup. In such a case, if the applicant indicates that he or she was either home schooled or
is unable to locate his or her institution or indicates both, then the system automatically populates the
default External Org ID when application is submitted.
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Note: If the applicant provides more than one school identified as I can’t find my school, only the
first will receive the default Org ID and the subsequent schools Org IDs will be set to blank and a
reconciliation error will be generated.

• If the applicant has entered the level of study and the dates attended, the system writes a row to
SCC_STG_EXACDDT.

Note: The applicant must supply all three values: level of study (external career), and both to and
from dates in order to write to SCC_STG_EXACDDT.

• If the applicant has entered a degree and the date in which the degree was obtained, the system writes
a row to SCC_STG_EXTDEGR.

Note: The applicant must supply both the degree and degree date values to write to
SCC_STG_EXTDEGR.

• When the applicant enters an External Org ID or a school name, then the fields in the Other Schools
Attended group box become available. Same rules mentioned previously apply to the fields in the
Other Schools Attended group box

• The applicant can enter as many additional Other Schools Attended records by clicking the plus sign
button. Conversely, clicking the minus sign button will delete an Other Schools Attended record.

Note: The system performs duplicate checking on Org IDs when the applicant supplies both a Last
School Attended and at least one Other Schools Attended. In addition, SOLA checks for duplicate Org
IDs in the Other Schools Attended when more than one is supplied by the applicant.
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Other page (SAD_OLA_OTHER)

This example illustrates the fields and controls on the Other page.

• The questions that appear in the Attachments and Additional Questions group boxes are derived from
the PeopleTools message catalog.

• The Additional Questions group box uses the sample Q&A Application Extension entity.
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Submit page (SAD_OLA_SUBMIT)

This example illustrates the fields and controls on the Submit page.

• When the applicant electronically signs the application (that is, selects the I certify check box on the
Submit page), the Submit button becomes available.

• Clicking the Submit button submits that application. Depending on how you have defined the
application to be processed during submission, the application can take many routes. Refer to the
discussion on “Setting Up Application Processing Centers” in the “Setting Up Your Recruiting
Structure” section to fully understand the submit process.

To understand application fee processing on submission, see Setting Up Application Processing
Centers

Note: The handling of attachments, additional questions, and messaging regarding the completion of an
application illustrated by SOLA represents design examples of how delivered web services can support a
user interface and these design examples are not intended to be deployed for your applicants.

 Paying Application Fees or Requesting Fee Waiver After Submitting
Application

Steps:

1. Once the applicant completes the application and is ready to submit the application, the applicant
clicks the Submit button.

2. If a fee is required with the option to pay later as defined on the Application Center Table setup page,
the applicant is presented with a message to pay the fee/request a waiver now or defer payment until
later. If the student selects the Yes button, they are taken to the Fee/Waiver Page. If they select the No
button, they are taken to the Submit Page.
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This is an example of the message for payment options.

3. If a fee is required as defined on the Application Center Table setup page, the applicant is presented
with the Fee/Waiver page (SAD_OLA_FEECALC), where he or she may request a waiver or pay the
fee. Actions allowed on this page are governed by the options defined on the Application Center Table
setup page.

This example illustrates the fields and controls on the Fee/Waiver page (Paying Application Fees).

4. When the applicant clicks the Pay Fees Now button, the system invokes the
SSF_INITIATE_EPAYMENT service operation. The system uses the information from the response
of this service operation to redirect the applicant to the third party payment provider, where additional
payment information is collected to pay the fees. This is accomplished by setting the value of the
HTML_AREA on page SAD_OLA_3RDPARTY to the value of the element SCC_HTML_STRING
from the SSF_INITIATE_EPAYMENT response. A transfer to page SAD_OLA_3RDPARTY will
launch the applicant to the third party payment provider.

For an example of the SCC_HTML_STRING, see Payment Integration Web Service Operations

Note: The third party payment provider will require return URLs in order to navigate the applicant
back to Campus Solutions after processing the transaction. These return URLs should correspond to
the Weblib functions defined in the Hosted Payment Adapter Settings. The system delivers iScripts
for SOLA to handle the post back from the third party payment provider.
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This example illustrates the fields and controls on the Hosted Payment Adapter page.

In the above example graphic, the success URL can be defined in the third party
payment provider site as  https://schoolserver/psc/ps/EMPLOYEE/HRMS/s/
WEBLIB_SAD_OLA.SAD_OLA_AWS.FieldFormula.IScript_Successful_Payment_TP.

Important! If the school is already using the Hosted Payment feature in Self Service Make a Payment
or Cashiering, a new Hosted Payment Adapter needs to be created in order to use the delivered
iScripts for SOLA. The new Hosted Payment Adapter may point to the same Application Class ID the
school is already using.
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This example illustrates the fields and controls on the Adapter Table page.

For more details, refer to the Campus Solutions 9.0 Electronic Payment Integration Developer’s
Reference Guide in My Oracle Support (ID 1982664.1) on how to set up the Hosted Payment
Adapter Setting. In addition to creating a new adapter, the new iScripts will need to be defined in the
permission list security for the applicant.

The new SOLA iScripts will invoke the SSF_COMPLETE_EPAYMENT service operation. This
service operation will authorize the payment and complete the application.

5. If a fee waiver option has been selected within the Application Center Table component, then the
applicant can request a waiver and click the Request Waiver button.
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This example illustrates the fields and controls on the Fee/Waiver page (Requesting Waiver).

Note: The display of captured data and the use of application fee payment illustrated by SOLA represent
design examples of how delivered web services can support a user interface.

Data Flow

This section discusses how the SOLA pages and the SQL tables exchange application data.

Campus Solutions SOLA Pages to SQL Tables
Flow:

1. The applicant enters data into the SOLA page.

2. The fields in each SOLA page reflect one or more SQL views. Each view represents the specific type
of data that SOLA is collecting (that is, address, emergency contact, academic data and so on.). The
views themselves are not traditional database views, but hollow views that exist merely to collect and
display the data on the SOLA page.

3. When the applicant clicks the Save or Submit button, SOLA copies the data within each view to the
view's corresponding entity in the Entity Registry. This is how SOLA processes the data into the
entity:

• The method associated with each entity performs any necessary data validation.

• The toXMLNode method then converts the entity content into an XML representation that the
SOAP-based web services require.

• Once all the data is entered in the SOLA pages and their respective views have been processed,
SOLA sends the XML request and invokes the SAD_SAVEAPPL web service operation.
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• The SAD_SAVEAPPL service operation then takes the XML request string and deconstructs it
node by node back into an entity.

• As each node is filled up with data, SAD_SAVEAPPL invokes the corresponding Entity Registry
ID.

Note: SOLA may look like any standard component in Campus Solutions, but the key concept to
understand is that the data entered on the SOLA pages never directly interact with the SQL table(s) as it
does in other Campus Solutions pages.

SQL Tables to Campus Solutions SOLA Pages
Flow:

1. The applicant signs into institution's Admissions Application home page and accesses the SOLA
component.

2. Assuming that this is not the first time the applicant is visiting the Admissions Application page,
SOLA invokes the SAD_GETAPPLS web service operation. The SAD_GETAPPLS_RESP XML
message contains all the key values for the applicant's applications.

3. This key information is presented in a grid format for the applicant to choose from, the applicant also
has the option to create an entirely new application.

4. The applicant clicks the View button or the Edit button for an existing application and SOLA passes
the key values for that specific application to the SAD_GET_APPL web service operation.

5. The SAD_GETAPPL_RESP XML response message contains all the data (both constituent and
academic) associated with that specific application.

6. SOLA deconstructs the XML response message node by node and moves this deconstructed message
to the corresponding SQL Views within the application page(s) in SOLA.

7. Once the XML response has been deconstructed, SOLA displays the page(s) to the applicant.

SOLA Setup and Verification

This section discusses the required setup and the verification to ensure that SOLA is configured properly.

Step 1: Update Admissions URL
Procedure:

1. Access the URL Maintenance component (PeopleTools >Utilities >Administration >URLs).

2. Enter SAD_APPL_ATCH in the Search by field:
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This is an example of searching for SAD_APPL_ATCH in the URL Maintenance component.

3. Click the Search button.

4. Verify whether a URL value (either a File Server or Database) has been supplied.

Step 2: Create New Roles
Procedure:

1. Access the Roles component (PeopleTools >Security >Permissions & Roles >Roles).

2. For New User Registration, see Campus Community’s New User Registration Framework
documentation for setup instructions on how to add role name CS - NUR GateKeeper.

3. For SOLA, complete the following steps:

a. Add role name as Online Application Demo:
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This is an example of adding a role for SOLA in the Roles component.

b. Click the Add button.

c. Add the description as Online Application Demo:

This is an example of adding a description for the SOLA role on the General page.

d. Add the permission list HCCPCSSA1190:
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This is an example of adding a permission list for the SOLA role on the Permission Lists page.

Step 3: Create New User Accounts
Procedure:

1. Access the User Profiles component (PeopleTools >Security >User Profiles).

2. Add SCC_GUEST.

This is example of adding the guest account in the User Profiles component.

3. On the General page, enter values as shown in the following graphic:

Note: For password, choose a password of your choice.
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This example illustrates the values entered on the General page.

4. On the ID page, enter values as shown in this graphic:

This example illustrates the values entered on the ID page.

5. On the Roles page, enter values as shown in this graphic:
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This example illustrates the values entered on the Roles page.

6. Save your changes.

Step 4: Set Up Integration Broker (IB)
Verify that minimal IB setup and service configuration is performed.

Verifying IB Gateway

Procedure:

1. Access the Gateways component (PeopleTools >Integration Broker >Configuration >Gateways).

2. Select that Integration Gateway ID for which the Local Gateway is set to Y.

3. Verify that the URL is pointing to the correct gateway.

4. Ensure that the gateway can be pinged by clicking the Ping Gateway button.

You should see this page if the gateway is pinged successfully.

Verifying IB Nodes

Procedure:

1. Access the Nodes component (PeopleTools >Integration Broker >Integration Setup >Nodes).
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2. Click the Search button and scroll through the search results list looking for the Node Name where
the Default Local Node is Y. There should be only one default local node.

3. On the Connectors page, click the Ping Node button.

4. Verify that the Gateway ID is pointing to the local gateway that you previously just pinged. If it is not,
change the Gateway ID so that it is.

5. When you click the Ping Node button, you should see Success in the message text.

Verifying that the Domain Status is Active

Procedure:

1. Access the Domain Status page (PeopleTools >Integration Broker >Service Operations
Monitor >Administration >Domain Status).

2. Verify that the domain status is Active.

Verifying Service Configuration

Procedure:

1. Access the Service Configuration page (PeopleTools >Integration
Broker >Configuration >Service Configuration).

2. Verify that a service configuration exists.

Note

Do not continue if any of the verification steps mentioned in this section “Step 4: Set Up Integration
Broker (IB)” fail. Resolve the failed steps before continuing.

Step 5: Configure Routings
Procedure:

1. Access the Services page (PeopleTools >Integration Broker >Integration Setup >Services).

2. Generate Any to Local and Local to Local routings for the following six web service operations of the
SAD_ADMISSIONS web service:

• SAD_CREATEAPPL.v1

• SAD_GETAPPL.v1

• SAD_GETAPPLS.v1

• SAD_GETATTACH.v1

• SAD_SAVEAPPL.v1

• SAD_SUBMITAPPL.v1
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This example illustrates the six service operations of SAD_ADMISSIONS service.

To generate these routings and verify that the operation status is Active:

1. For each operation, on the General page select both the Generate Any to Local check box and the
Generate Local to Local check box.

2. Make sure that the service operation is Active. If the status is not active, select the Active check box.

3. Save your changes. When you save, the system updates the routing status to Exists for both routing
actions:
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This example illustrates the fields and controls on the General page after save (1 of 2).

This example illustrates the fields and controls on the General page after save (2 of 2).

4. Click the Return to Service link.

5. Repeat the steps 1 through 4 for the remaining operations.

For new user registration also you must perform the same steps:

1. Access the Services page (PeopleTools >Integration Broker >Integration Setup >Services).
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2. Generate Any to Local and Local to Local routings for the following two web service operations of
the SCC_USERREG web service:

• SCC_USERREG_AUTHENTICATE.v1

• SCC_USERREG_CREATEACCT.v1

This example illustrates the two service operations of SCC_USERREG service.

3. Repeat the preceding steps for generating routings and ensuring that the status is Active.

Step 6: Set Up Integration Broker – ANONYMOUS Node
Procedure:

1. Access the Nodes component (PeopleTools >Integration Broker >Integration Setup >Nodes).

2. Search for the ANONYMOUS node name.

3. On the Node Definitions page, change the Default User ID to SCC_GUEST.
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This example illustrates the fields and controls on the Node Definitions page.

4. On the WS Security page, change the Authentication Token Type to Username Token.
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This example illustrates the fields and controls on the WS Security page.

5. Save your changes.

Step 7: Publish Web Services
Procedure:

1. Access the Provide Web Service Wizard (PeopleTools >Integration Broker >Web
services >Provide Web Service).

2. Ensure all the operations for the SAD_ADMISSIONS and SCC_USERREG web services are
published.

Search for SAD_ADMISSIONS service name:
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This example illustrates the fields and controls on the Select Services page.

3. Click the Select All button and click the Next button.

4. On the Select Service Operations page, click the Select All button and click the Next button.

This example illustrates the fields and controls on the Select Service Operations page.

5. On the View WSDL page, click the Next button.
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This example illustrates the fields and controls on the View WSDL page.

6. On the Specify Publishing Options page, click the Finish button.

This example illustrates the fields and controls on the Specify Publishing Options page.

7. Repeat the steps for the SCC_USERREG web service.

Step 8: Refresh HCM Registry Cache
Procedure:

1. Access the HCM Interface Registry page (Set Up Common Objects >System
Administration >HCM Registry >Service Registry).
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This example illustrates the fields and controls on the HCM Interface Registry page.

2. Click the Refresh Cache button.

Note: The message Processing displays and remains on the page. There is no other message
displayed.

Step 9: Set Up New User Registration Tester
Procedure:

1. Access the New User Registration Context component (Set Up SACR >System
Administration >Utilities >New User Registration >New User Registration Context).

2. Click the Add a New Value tab.

3. Add the DEFAULT_CONTEXT New User Registration Context as shown in this graphic:
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This is an example of the New User Registration Context for SOLA.

4. Select the Default check box.

5. In the Node Name field, you must select a node marked as Default Local Node = Y.

6. Save your changes.

Step 10: Verifying Your SOLA Setup
Procedure:

1. Sign into Campus Solutions using your institution's master user ID and password.
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This is an example of signing into CS.

2. Access the New User Registration Tester page (Set Up SACR >System
Administration >Utilities >Sample User Interfaces >New User Registration Tester).

This is an example of the New User Registration Tester page with sign-in fields.

3. Select the Need a User ID? Yes/No check box.

4. Fill out the New User Registration Tester page as shown in this figure:
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This is an example of the New User Registration Tester page with the filled out user registration
fields.

Note: For the password field, choose a password of our own.

5. Click the Create User button. On clicking this button, the system transfers you to Sample Online
Application home page:

This example illustrates the fields and controls on the blank Application Home page.

6. Fill out the Create A New Application section. Select values for:
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• Institution.

• Academic Career.  

• Admit Term.

• Academic Program.

• Academic Plan.

• Admit Type.

This is an example of the Home page with the values for creating a new application.

7. Click the Create Application button.

8. Change the value for the Gender field to Female.

9. Save your changes. When you save, a message should be displayed indicating that the application was
successfully saved:
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This is an example of the message indicating that application has been saved.

10. Click OK and sign out.

11. Sign back in using the newly created ID (that is, JSmith):

This is an example of signing into CS using the ID created through New User Registration tester page.

12. Access the Sample Online Application component (Set Up SACR >System
Administration >Utilities >Sample User Interfaces >Sample Online Application).

Copyright © 1988, 2021, Oracle and/or its affiliates. 211



Using the AAWS Sample Online Application Chapter 7

This is an example of the Home page with the saved application.

13. Click the Edit button.

14. You should be able to see the application you started and the previously saved Gender change.
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This is an example of the Basic Information page with the saved value.

15. If you have made it this far, then the database is configured correctly for AAWS, SOLA, and New
User Registration. If not, then verify that the preceding setup steps have been performed correctly.
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Managing PeopleSoft Admission
Transactions

Understanding Admission Transactions

Admission transactions use the delivered Admission Applications Web Services (AAWS) and the
File Parser bulk loading of admission applications features. The features are fully integrated with the
Constituent Transaction Management (CTM) framework (admission transactions are consumers of
the CTM framework). Each admission transaction you set up is considered a CTM transaction. CTM
generates an admission transaction when:

• An applicant or administrator uses an online admission application to create, save or submit an
application through AAWS (online transaction).

• You use the File Parser utility to load applications from an external file (offline transaction).

An admissions online or offline transaction includes both the constituent and application data.

Constituent data may include person data or data that is considered as not associated with the application.
Examples of constituent data include Name, Gender, Address, and Email. Examples of application data
include Academic Program, Admit Term, and Academic History.

When a transaction is generated, the system uses Search/Match to look for constituent data in your
production environment (based on the Search/Match parameters) that matches the constituent data
in the transaction. Each defined transaction can have its own Search/Match setup. You can therefore
determine the rules for creating a new ID, updating an existing ID, suspending or ignoring a record. The
system stores the constituent and application data in staging tables. If there are errors or if Search/Match
determines that the incoming constituent record should be suspended or ignored, use the Constituent
Staging and Application Transactions components to correct the admissions transaction data. You can post
transactions individually or by batch to the Campus Solutions database.
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This diagram shows the admission transactions flow:

See Also

Understanding AAWS

Setup for Loading Applications Using File Parser

"Understanding the File Parser Process" (Campus Community Fundamentals)

"Understanding Entity Registry" (Campus Community Fundamentals)
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"Understanding Get List of Values Web Service Operation" (Campus Community Fundamentals)

"Understanding CTM" (Campus Community Fundamentals)

PeoleTools Integration Broker documentation

CRM for Higher Ed EIPs and Admission Transactions
Enterprise Integration Points (EIPs) enable your institution to exchange data between CS and CRM. EIPs
publish data either whenever data updating happens for the given entities of the EIPs or when the user
requests data. This data can be created, updated, or deleted through various channels like components,
component interfaces, and batch processes.

The system publishes the following EIPs when an application that is submitted through AAWS or File
Parser process is posted:

• SAD_ADM_PRSPCT_DATA_SYNC

• SAD_ADM_APPL_DATA_SYNC

• SAD_TEST_SCORES_SYNC

• SAD_ADM_INTEREST_SYNC

• SSR_EXTRACUR_ACTVTY_SYNC

• SAD_EXT_ACAD_DATA_SYNC

• SCC_PERSON_SYNC

The system can publish SAD_ADM_PRSPCT_DATA_SYNC when the system creates a prospect record
for a saved or posted application. You use the Prospect Setup page to indicate when (upon save or post)
the system should create a prospect record.

For information about the Prospect Setup page, see Setting Up Prospect Creation Rules and Defaults for
Offline and Online Application Transactions

See Also

"Understanding CRM for Higher Ed" (Campus Solutions Application Fundamentals)

CRM for Higher Education Developer’s Guide in My Oracle Support (Doc ID 1982671.1)

Understanding Admission Transactions Setups

You define admission transactions using CTM pages. Then, you use the Application Configuration
component to configure the admission transactions.
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Setting Up CTM (Defining Transactions and Data Update Rules) and
Configuring the Admission Transactions (Application Configuration
component)

Before you deploy AAWS or start loading the applications, you must define the admission transactions
through the CTM setup pages. For AAWS, define a transaction for the online application that a user saves
or submits through the Save Application or Submit Application service operations. If you want to load
admission applications using the PeopleSoft File Parser utility, define an offline transaction for the batch
load.

The default transaction definition for AAWS that is delivered with the system is:
ADMISSIONS_APPLICATION (online application transaction).

Additionally, if you have defined an online transaction for the online application, consider using the New
User Registration framework to allow a guest or a returning user to access your system. The framework
delivers a sample login page that contains all the security objects delivered as part of the framework. The
New User Registration framework is also a consumer of the CTM framework and delivered with your
system is the CTM transaction code called NEW_USER_REGISTRATION. The New User Registration
framework, using the New User Registration Context, can also transfer the newly authenticated user to the
self-service page you created for your online application.

See "New User Registration and CTM" (Campus Community Fundamentals)

See "Understanding New User Registration" (Campus Community Fundamentals)

Warning! The ADMISSIONS_APPLICATION transaction is delivered only as a reference. It is not
required that you use this transaction.

The following table lists the delivered transaction handler values for ADMISSIONS_APPLICATION.
Do not change these values. Also use these values when defining a transaction handler for any new
application transaction you may define.

Root Package ID Path Application Class ID

SCC_OLA TRANSACTION AdmissionTransaction

The staging record delivered with ADMISSIONS_APPLICATION is SAD_APL_DAT_STG. This record
stores the transaction status and transaction status date value for ADMISSIONS_APPLICATION. Do not
change this value. You should always use this value when defining any new application transaction you
may define.

The following table lists the delivered Transaction Data Launch View settings for
ADMISSIONS_APPLICATION transaction. You should always use these values when defining the
transaction data launch view settings for any new application transaction you may create.

Menu Name Menu Bar Name Menu Item Name Menu Page Name

Process Applications Use SAD_APPL_STG SAD_APPL_STG
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Academic institutions require different rules for updating constituent and application data based on
a transaction and the affiliation the institution has with the constituent. For example, you may have
a graduate online application rule where you want to update the constituent’s home email address in
your database with the value from a submitted graduate application. On the other hand, you may have
a graduate application load rule where you do not want to update an existing home email address value
when you use File Parser to load graduate applications into Campus Solutions. Additionally, you may
want to override this graduate application load rule if the constituent is a prospect. The Data Update Rule
Entry component allows this flexibility. The system uses these rules when it posts a transaction.

While you can use the same AAWS online user interface for all your academic careers and institutions,
you can configure the admission transactions to behave differently. For AAWS and bulk load using File
Parser, different admission transactions may have different Search/Match settings and data update rules.
For instance, an academic institution might allow undergraduate applicants to update their passport details
when submitting an online application. Conversely, the institution might not want to allow graduate
applicants to update their passport details if that data is already on the system. You can associate the two
different data update rules to these two separate transactions. Both these transactions may or may not have
different Search/Match settings.

When establishing transactions, a single transaction for each institution and career combination could be
defined in CTM. In this way, you can accommodate online applications for different careers (Examples:
Undergraduate, Graduate, Graduation Business) which may have different Search/Match requirements,
data update rules, or intended methods of processing. After defining the admission CTM transactions, use
the Application Configuration component to set up different combinations of institutions and careers and
map each institution-career combination to a defined admission transaction (CTM Transaction Code).

It is typical for administrators to enter the admissions application data for an applicant. It is possible for
an administrator to use the same online application to do so, as long as the application user interface is
constructed to distinguish between an administrator log in and a self service applicant log in.

Administrators can use a different institution-developed user interface designed for quick data entry.
The same transaction value applied to the self service application is utilized for the institution/career
combination for which the application is being created.

Use the Transaction Setup component to define a transaction, associate a data update rule with the
transaction, and define the Search/Match setting for the transaction.

CTM Data Updates Rules Specific to Admission Transactions
To be consistent with existing processes that update this data, the application data update rules are as
follows for the following entities:
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Entity Rules

Academic Interests If data exists on ADM_INTRST_HDR for an existing
EMPLID and ACAD_CAREER and the max ADM_INTRST
_HDR.EFFDT is not equal to %Date, a new row is inserted
with EFFDT = %Date. Rows are inserted into ADM_
INTERESTS for each academic interest populated on SCC
_STG_ADMINT. PRIORITY is populated based on ADM_
INTRST_HDR.USE_PRIORITY.

If data exists on ADM_INTRST_HDR for an existing
EMPLID and ACAD_CAREER and the max ADM_INTRST
_HDR.EFFDT is equal to %Date, a row is not inserted
into ADM_INTRST_HDR. Rows are inserted into ADM
_INTERESTS only where SCC_STG_ADMINT.EXT_
SUBJECT_AREA does not exist on ADM_INTERESTS for
the current effective date. If ADM_INTRST_HDR.USE_
PRIORITY is ‘Y’, the max ADM_INTEREST.PRIORITY is
determined and incremented to the next number when new
rows are inserted.

External Academic Data A new Data Number (EXT_DATA_NBR) is inserted to EXT
_ACAD_DATA if the EXT_ORG_ID on the staging record
SCC_STG_ACADHST exists on the core record ACAD_
HISTORY. The max EXT_DATA_NBR existing on EXT_
ACAD_DATA is determined and incremented to the next
number on insert.

All child records are populated with the same EXT_DATA_
NBR that is inserted on EXT_ACAD_DATA if the field exists
on the child record.

Exception: For the record EXT_DEGREE, if data exists on
EXT_DEGREE where DESCR, DEGREE_DT, DEGREE
_STATUS and LS_DATA_SOURCE = data from staging
record (SCC_STG_EXTDEGR), a new row is not inserted.

General Materials A new record is always inserted.

The max GENL_MATL_NBR is determined and new
incremented to the next number when new rows are inserted.

Residency Official and Residency Appeal If the keys (INSTITUTION, ACAD_CAREER and
EFFECTIVE_TERM) do not exist on RESIDENCY_OFF or
RESIDENCY_APEAL, a new row is inserted.

If the keys exist, a new row is not inserted and the data is not
updated.

Residency Self (Self Reported Residency) If Date Reported (SCC_STG_RES_SLF.SELF_REPORT_DT)
does not exists on RESIDENCY_SELF, a new row is inserted.

If Date Reported (SCC_STG_RES_SLF.SELF_REPORT_DT)
exists, a new row is not inserted and the data is not updated.
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Entity Rules

Test Score If SCC_STG_TEST.TEST_ID does not exist on STDNT_
TEST for the EMPLID, a new row is inserted along with any
child rows (STDNT_TEST_COMP).

If the following elements on STDNT_TEST_COMP match the
elements on the staging record SCC_STG_TESTCMP, update
Score, Percentile and Date Loaded regardless of the previous
score reported: EMPLID, TEST_ID, TEST_COMP, TEST_DT
and DATA_SOURCE.

If there is not an existing row on STDNT_TEST_COMP that
matches on EMPLID, TEST_ID, TEST_COMP, TEST_DT,
 DATA_SOURCE, a new row is inserted.

How the System Attaches an Application to a Defined Transaction
Applications typically vary among institutions and academic careers. Use the Appl Config page in the
Application Configuration component to map an institution and career to a transaction. The system uses
this mapping to identify which transaction definition to use when it receives an application through
AAWS. For example, suppose you have defined two transactions: UG Transaction for undergraduate
applications and Grad Transaction for graduate applications. When an applicant submits an undergraduate
application, the system looks at the Appl Config page settings to determine that it needs to use the UG
Transaction.

For offline transactions, you must enter the transaction code as a default value for the file mapping
definition (Campus Community File Parser setup). The system uses this mapping to identify which
transaction definition to use when it receives an application through the File Parser.

Understanding Staged Admission Transactions Processing

Use the Constituent Staging and Application Transactions components to review or edit the admissions
transaction data stored in the staging tables. In addition, you can use these components to post the staged
transactions into the production records of the Campus Solutions database.

A constituent in an admission transaction is the person record (applicant). Use the Constituent Staging
component to handle the constituent data. The Constituent Staging component is a Campus Community
CTM component. Use the Application Transactions component to handle the admissions application
transaction data. To help you review the staged data using both the components for a particular Temporary
ID, the components display a link that helps you navigate from one component to the other.

Correcting Admission Transaction Errors
An admission transaction might have an error status for the constituent (person) or the application record.
For error indicators, use both the components to find the corresponding field and enter a valid value.

Use the Constituent Staging component to review and correct the constituent errors.

Use the Application Transactions component to review and correct the application errors.
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Note: For File Parser, only after the CTM Transaction Management process runs, any errors appear in the
components. In the case of AAWS, errors can appear either when the user saves or submits an admission
application.

An example of an error message that the Application Transactions staging component displays: Suppose
you selected the Manual Reconciliation option for Home Schools on the School Setup page. If the
applicant has indicated that a school of attendance is a home school and submitted the application, the
Application Transactions component displays an error message.

This example illustrates an error message in the Application Transactions component.

To resolve such an error, you can click the Education History tab, then select the valid external
organization ID for the home-schooled applicant and finally click the Save button.

Posting Admission Transactions
After you have reviewed a transaction and corrected the errors, you can run the search/match/post process
from the components itself by clicking the Run Search/Match/Post button. On clicking this button, you
can run both processes at once: to search for matching people in your database and to post the transaction
according to the Search/Match parameters you set up on the Transaction Setup component. The latter
happens if Search/Match identifies an ID that needs to be created or updated or if the applicant was a
returning user and used a User ID already tied to an ID. In either way, the system uses the identified
ID (EMPLID) to post the data. Alternatively, you can use the Constituent Staging and Application
Transactions components to correct multiple transactions and then run the Transaction Management
process to post the multiple transactions to the Campus Solutions database.

To process transactions in batch, use the Transaction Management process. If you had defined your
admission transaction as either offline or online with the Process Search/Match option set to Batch, use
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the Transaction Management batch process to process these transactions. However, if the system knows
the EMPLID for the applicant, then the transaction is effectively treated as realtime. The Transaction
Management Process component offers different options on how you can process one, all or only a certain
set of transactions. For processing a certain set of transactions, Population Selection can be used.

Regardless of how the application is posted (manually or in batch), the system looks at the Prospect Setup
page of the Application Configuration component to determine if a prospect should be created and if
3Cs should be inserted into the 3C Trigger Results table for the ID created or updated. In addition, the
system determines if additional actions should be taken on the prospect record based on the Update Data
check box in the From Application to Prospect section of the Installation Defaults - AD page. For more
information on updating an existing prospect record:

See Setting Up Admission Installation Defaults

Entity Registry and Admission Transactions

You can add new entities or extend existing entities. For example, an academic institution has a
requirement to add one or more new entities into the application process. The new entity could represent
entirely new data or it could represent an extension to one of the existing delivered entity data types. This
may involve either or both application and constituent data. You can use the Entity Registry feature for all
these situations.

The web service operations that are part of the AAWS feature are constructed based on entities.

The entities for all core data records within the constituent and application areas needed for admission
transactions are delivered with the system within the Entity Registry component. You can extend any
of these entities or create new ones. Register new institution-specific extension entities as children to
any entity in the registry. If you need to create new entities, because AAWS and File Parser admission
transactions are CTM transactions and therefore use stage and production records, the entity you create
must be set with an entity type that allows for stage records and production records. For instance, use
entity type called Staged Entity. The stage and production records need to exist prior to creating the new
entity.

All Recruiting and Admissions entities are represented by the IEntity interface
SAD_ADM_APPL:Accessors:IEntity. The IEntity interface defines the core behavior that any
participating entity needs to support in order to be managed by Recruiting and Admissions. For each new
distinct entity that you want to create for Recruiting and Admissions, an application class implementing
the IEntity interface needs to be created and registered. For instructions on creating and extending
entities:

See "Creating a New Entity" (Campus Community Fundamentals)

Example of a scenario of when you can use the Entity Registry feature for Recruiting and Admissions:
Suppose an online application has a list of questions. The Campus Solutions data structure does not
support capturing the answers to these questions. In such a case, you can create a Questions and Answers
entity.

The Questions and Answers application extension entity is registered as a child entity to the Application
entity on the Entity Registry page:
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This example illustrates the fields and controls on the Entity Registry page.

Delivered Entities Related to Admissions Data
The following entities are delivered for the application staging records and matching production records:

Entity Name Staging Record Names Production Record Names

Application SAD_APL_DAT_STG ADM_APPL_DATA

Career Sequence SAD_APP_CSQ_STG ADM_APP_CAR_SEQ
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Entity Name Staging Record Names Production Record Names

Academic Program SAD_APL_PRG_STG ADM_APPL_PROG

Academic Plan SAD_APL_PLN_STG ADM_APPL_PLAN

Academic Sub-Plan SAD_APL_SBP_STG ADM_APPL_SBPLAN

Academic Program (AUS) SAD_APPRGAU_STG SAD_APL_PRG_AUS

Academic Program (NLD) SAD_STDAPNL_STG SAD_STD_APP_NLD

Academic Program (NZL) SAD_PRGNZL_STG SAD_APL_PRG_NZL

Student Education (NLD) SAD_EDU_NLD_STG SAD_STD_EDU_NLD

Recruitment Category SAD_APL_RCC_STG ADM_APPL_RCR_CA

Recruiter SAD_APL_REC_STG ADM_APPL_RCTER

Student Response SAD_STG_STDRESP STDNT_RESPONSE

Application Fee Tender SAD_APL_TND_STG ADM_APPL_TENDER

Application Attachment SAD_APLATCH_STG SAD_APPL_ATCH

Application (NLD) SAD_APP_NLD_STG SAD_APP_DAT_NLD

Q&A Application Extension (Example
Only)

SCC_EXTN_STG SCC_EXTN

Other Schools Applied SAD_STG_OTH_SCH SAD_OTHER_SCH

Source Of Interest SAD_STG_SOI SAD_SOI

Research Candidate SSR_RS_CAND_STG SSR_RS_CANDIDAT

Research Candidate Header SSR_RS_CNDH_STG SSR_RS_CAND_HDR

Research Consumption SSR_RS_CNSP_STG SSR_RS_CONSMPTN

Research Topic Header SSR_RS_TPCH_STG SSR_RS_TOPC_HDR
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Entity Name Staging Record Names Production Record Names

Research Topic Detail SSR_RS_TOPC_STG SSR_RS_TOPIC

Research Topic Attachment SSR_RS_TPAT_STG SSR_RS_TOPC_ATT

Research Supervisor Header SSR_RS_SUPH_STG SSR_RS_SUPR_HDR

Research Supervisor SSR_RS_SUPR_STG SSR_RS_SUPRVSRS

Research Supervisor Attachment SSR_RS_SPAT_STG SSR_RS_SUPR_ATT

Research Assignment Header SSR_RS_OTRQ_STG SSR_RS_OTHR_REQ

Research Assignment Detail SSR_RS_OTRD_STG SSR_RS_OTHRQDTL

Research Assignment Attachment SSR_RS_OTAT_STG SSR_RS_OTHR_ATT

Research Candidate Messages SSR_RS_MSGS_STG SSR_RS_MSGS

Research Candidate Attachment SSR_RS_CDAT_STG SSR_RS_CAND_ATT

Configuring Admission Transactions

To configure the admission transactions, use the Application Configuration component
(SAD_ADM_APL_CONFIG).

This section discusses how to:

• Map online application transactions to academic careers.

• Set up application defaults for offline and online application transactions.

• Set up prospect creation rules and defaults for offline and online application transactions

• Set up home or unlisted schools for online application transactions.
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Pages Used to Configure Admission Transactions

Page Name Definition Name Navigation Usage

Appl Config SAD_TRANSAC_MAP Set Up SACR >Product
Related >Recruiting and
Admissions >Application
Configuration >Application
Configuration >Appl
Config

Map online application
transactions to academic
careers.

Application Setup SAD_APL_CNT Set Up SACR >Product
Related >Recruiting and
Admissions >Application
Configuration >Application
Configuration >Application
Setup

Define how the system should
assign an application center
and optionally assign 3Cs to
an application by defining
which Event ID should be
used in the processing. The
system uses this setup when
you use File Parser to load
applications in batch via a
calculated field or when the
user saves or submits an
application through AAWS.

Prospect Setup SAD_PRS_SETUP Set Up SACR >Product
Related >Recruiting and
Admissions >Application
Configuration >Application
Configuration >Prospect
Setup

Define how the system should
create a prospect record,
 and if a prospect record is
created, how to assign default
values to the prospect record.
 The system uses this setup
when you use File Parser to
process applications in batch
via a calculated field or when
the user saves or submits an
application through AAWS.

School Setup SAD_AWS_SCH_DFL Set Up SACR >Product
Related >Recruiting and
Admissions >Application
Configuration >Application
Configuration >School
Setup

Define how the system should
process unlisted or home
schools. The system uses
this setup only when the
user saves or submits an
application through AAWS.

Mapping Online Application Transactions to Academic Careers
Access the Appl Config page (Set Up SACR >Product Related >Recruiting and
Admissions >Application Configuration >Application Configuration >Appl Config).
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This example illustrates the fields and controls on the Appl Config page. You can find definitions for the
fields and controls later on this page.

You can enter only online transactions (except for the new user registration transaction
NEW_USER_REGISTRATION) in the Transaction field. To check whether a transaction has been
marked as online or offline, use the Transaction Setup page (Set Up SACR, System Administration,
Utilities, Constituent Transaction Mgmt, Transaction Setup).

Ensure that all academic careers for AAWS applications are mapped to a valid transaction on the Appl
Config page.

When a user saves or submits an application through AAWS, the Campus Solutions system uses the Appl
Config page to associate the application with a CTM online transaction. The system uses this association
to run search/match and process the application data according to the settings on the Transaction Setup
page.

Setting Up Application Defaults for Offline and Online Application
Transactions

Access the Application Setup page (Set Up SACR >Product Related >Recruiting and
Admissions >Application Configuration >Application Configuration >Application Setup).
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This example illustrates the fields and controls on the Application Setup page: Criteria tab (1 of 2). You
can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Application Setup page: Criteria tab (2 of 2). You
can find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Application Setup page: Assigned Values tab (1 of
2). You can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Application Setup page: Assigned Values tab (2 of
2). You can find definitions for the fields and controls later on this page.

Ensure that all the academic career, program, and plan combinations for AAWS and File Parser
applications are mapped to a valid application center on the Application Setup page.

Use the Criteria tab to define the selecting criteria — such as academic career, academic program, and
academic plan — that constitutes a particular group of applications. Use the Assigned Values tab to
define the application center and event ID that the system assigns to the particular application group.
When the system receives an online application, it uses this mapping to determine which application
center and event ID should be assigned to an application. For batch applications loaded through File
Parser, a calculated field can be built on the File Mapping Definition to look at this setup to determine the
application center to populate.

In the exhibit example — Application Setup page: Criteria tab (2 of 2) — you can see that for row
13, career is UGRD, program is AA and plan is Music. For the same row, in the exhibit example —
Application Setup page: Assigned Values tab (2 of 2) — the application center is APP2. Assume that the
system receives an application for a career of UGRD, program of AA, and plan of Music through AAWS
or batch load. In such a case, the system assigns APP2 to this application.
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The system requires an application center to create an admission application. Therefore, you must map
each career with an application center on the Application Setup page. The system generates an error
message if it receives an application through AAWS or batch load and it does not find the corresponding
application center from this mapping. You can view this error message on the Application Transactions
staging component. Note that the system assigns an application center from this mapping when an
application is saved or submitted. The system assigns the 3C Event ID when an application is posted.

Note: You should complete this mapping for only Self-Service (applicant) mode. In the Administrator
mode, the user provides the application center when creating an admission application. Therefore, this
setup is not relevant for Administrator mode.

Criteria

Field or Control Description

Career Enter the Career for which you want to assign an Application
Center (and optionally, an Event ID).

Program Optionally, enter the Program for which you want to assign an
Application Center (and optionally, an Event ID).

If you leave this field blank, the system assigns the
Application Center to all the Programs within the Career.
For example, suppose you have two Application Centers:
APP01 and APP02. Map the Career GRAD and Program
MBA combination to the APP01 Application Center and
map the GRAD Career to the APP02 Application Center. In
such a case, the system assigns APP01 Application Center
to an MBA application and assigns APP02 to other non MBA
applications such as a MS or MA application.

Plan Optionally, if you have entered a program, enter the Plan
for which you want to assign an Application Center (and
optionally, an Event ID).

If you leave this field blank, the system assigns the
Application Center to all the Plans within the program.
 For example, suppose you have two Application Centers:
APP03 and APP04. Map the Career GRAD, Program MS,
 and Plan Finance combination to the APP03 Application
Center and map the GRAD Career and MS Program to
APP04 Application Center. In such a case, the system assigns
APP03 Application Center to an MS Finance application and
assigns APP04 to other Master of Science applications such as
MS in Biochemistry or MS in Physics.
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Field or Control Description

Country and Citizenship Status Enter the Country and Citizenship Status if you want to
assign an Application Center (and optionally, an Event ID)
based on the applicant’s citizenship. For example, you could
have the Career UGRD, Country USA, and Citizenship
Status Alien Temporary mapped to an Undergrad International
Office Application Center and GRAD, USA, and Alien
Temporary mapped to a Graduate International Office
Application Center.

Note: If you enter a value in one of the two fields, you
cannot leave the other field blank. For example, if you enter a
Country, you must specify the Citizenship Status.

Note: When determining the Application Center assignment, the system uses the following order:
Citizenship Status, Plan, Program, and Career.

Assigned Values

Enter the Plan, and optionally the Event ID, for the row entered on the Criteria tab.

Only the Event IDs that have the administrative functions ADMA (admissions application) and ADMP
(admissions program) are available. ADMP is available only if you select an academic Program on the
Criteria tab. Define Event IDs on the Event Definition page.

"Defining 3C Engine Events" (Campus Community Fundamentals)

Setting Up Prospect Creation Rules and Defaults for Offline and Online
Application Transactions

Access the Prospect Setup page (Set Up SACR >Product Related >Recruiting and
Admissions >Application Configuration >Application Configuration >Prospect Setup).
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This example illustrates the fields and controls on the Prospect Setup page: Criteria tab. You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Prospect Setup page: Assigned Values tab. You can
find definitions for the fields and controls later on this page.

Use the Criteria tab to specify whether you want the system to create a prospect when the user saves an
application through AAWS or when you post an application to the Campus Solutions database. Also, on
this tab define the criteria for creating the prospect. Use the Assigned Values tab to specify the default
values that the system assigns to the prospect. You must specify the Recruiting Center, Recruiting
Status, and Referral Source values.

In the exhibit example — Prospect Setup page: Criteria tab — you can see that for row 3, career is
MEDS, program is MED, plan is Pharmacology and Create Prospect value is SAVE. For the same row,
in the exhibit example — Prospect Setup page: Assigned Values tab — values such as the recruiting
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center MPHA is assigned. Assume that a user saves a pharmacology application through AAWS. In such
a case, the system creates a prospect record for the applicant and also assigns the default values such as
the recruiting center MPHA to this newly created prospect record.

This is an optional setup. If you do not want to create a prospect record, when the application is saved or
posted, leave the Prospect Setup page blank.

Note: To create prospect on save, the online application must ensure that the required constituent data is
collected before the user saves the application. Also, ensure that the related transaction is set to run real
time on save. If the related transaction is set to run on submit, then the Prospect Setup page displays a
warning message if you choose the Save option for Create Prospect. For example, suppose you have a
transaction UGRD_online_app and you have mapped this transaction to the UGRD career and GLAKE
institution on Appl Config page. You have not selected the Run on Save check box on the Transaction
Setup page for this transaction. In such a case, the Prospect Setup page displays a warning message if you
select the Save option for the UGRD and GLAKE criteria. If the prospect setup is set to create a prospect
on Save, but the transaction is not set to run real time on Save, you can still create the prospect record by
running the Transaction Management process for Saved transactions.

Criteria

Field or Control Description

Career Enter the career for which you want to create prospect records
and assign default values.

Program Optionally, if you have entered a program, enter the plan for
which you want to create prospect records and assign default
values.

If you leave this field blank, the prospect records are created
for all the plans within the program or career.

Create Prospect Identify how you want to create prospect records for the
career (and program and/or plan, if applicable):

• Save – Select if you want the system to create a prospect
record when it receives a Save Application service
operation request or when the applications are loaded into
the staging tables using File Parser and have a transaction
status of Saved.

• Post – Select if you want the system to create a prospect
record when the online or offline transactions are posted
to the Campus Solutions database.

If the prospect record already exists for the institution and career of the transaction, the system updates
the prospect record to insert program and plan data that does not exist, and also inserts Housing Interest,
Financial Aid Interest, Last School Attended and Graduation Date if not previously populated. If you
have selected the Update Data check box in the From Application to Prospect section of the Installation
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Defaults - AD page, the system populates the Application Number and updates the Applied indicator for
the existing prospect record. For more information on this check box:

Setting Up Admission Installation Defaults

Note: If you want to create prospects for all applications received for the criteria entered, enter a row for
Save and a row for Post. This ensures that the system creates a prospect record when an application is not
saved prior to submission.

Assigned Values

Enter the recruiting center, recruiting status, referral source and optionally the event ID, for the row
entered on the Criteria tab.

Only the event IDs that have the administrative functions PROS (prospect) and PROP (prospect program)
are available. PROP is available only if you select an academic program on the Criteria tab. Define event
IDs on the Event Definition page.

Setting Up Home or Unlisted Schools for Online Application Transactions
Access the School Setup page (Set Up SACR >Product Related >Recruiting and
Admissions >Application Configuration >Application Configuration >School Setup).

This example illustrates the fields and controls on the School Setup page. You can find definitions for the
fields and controls later on this page.

An online application may need to capture the applicant’s academic history. The online application
may present a field with a list of schools, colleges, and universities that exist in the system’s External
Organization table and the user may select a value from this list. However, two applicant categories exist,
those who have attended an academic institution that is not listed in the list of values (unlisted schools)
and those who are home schooled. The online application may present a text field or some other method
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to capture the home or unlisted school details. Use the School Setup page if you want to define how the
system should process these unlisted or home schools.

Unlisted Schools

Field or Control Description

Post Application Using Default Select if you want to specify a default organization ID for
unlisted schools or if the applicant has not provided the school
name.

Field or Control Description

Default Organization This field appears if you select the Post Application Using
Default option. Specify the default organization ID to post
with the application record.

Note: If the application contains multiple rows of Unlisted
School data, the default applies to the first processed row.
 Because External Organization ID is a key field, it is not
possible to use the default more than once. In the event
of multiple Unlisted Schools, the web service creates a
reconciliation error in the staging component and requires
manual reconciliation of the additional Unlisted School rows.

Require Manual Reconciliation Select if you want to manually correct an application that has
an unlisted school or no school.

If you select this option and the application transaction has an
unlisted school or no school, the system retains the transaction
in the staging table with a constituent status of Error. You have
to resolve the error message, and then post the application.
 You can use the Application Transactions component to select
an appropriate External Org ID and run the post process.
 Refer to the “Reviewing and Editing Staged Admission
Application Transactions” section for more information about
this component.

See Reviewing and Editing Staged Admission Application
Transactions
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Home School

Field or Control Description

Post Application Using Default Select if you want to specify a default organization ID for
home schools.

Default Organization This field appears if you select the Post Application Using
Default option. Specify the default organization ID to post
with the application record.

Note: If the application contains multiple rows of Home
School data, the default applies to the first processed
row. Because External Organization ID is a key field, it
is not possible to use the default more than once. In the
event of multiple Home Schools, the web service creates
a reconciliation error in the staging component, requiring
manual reconciliation of the additional Home School rows.

Require Manual Reconciliation Select if you want to manually correct an application that has a
home school.

If you select this option and if the applicant has mentioned
home school, the system retains the transaction in the staging
table with a constituent status of Error. You have to resolve
the error message and then post the application. You can
use the Application Transactions component to select an
appropriate External Org ID and run the post process.
 Refer to the “Reviewing and Editing Staged Admission
Application Transactions” section for more information on
about component.

Reviewing and Editing Staged Admission Application
Transactions

Reviewing and Editing Staged Admission Application
Transactions

To review and edit the admission application transactions, use the Application Transactions component
(SAD_APPL_STG).

This section discusses:

• Impact of application center security on navigation.

• Header on the Application Transactions pages.

• Reviewing application data and error messages.
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• Reviewing additional information.

• Reviewing applicant’s education history.

• Reviewing additional academic information.

• Reviewing general materials and attachments.

• Reviewing application regional information.

Pages Used to Review and Edit Staged Admission Application Transactions

Page Name Definition Name Navigation Usage

Application Data SAD_APPL_STG • Student
Admissions >Application
Transaction
Mgmt >Application
Transactions >Application
Data

• Click the <Transaction
Name> link on the
Summary Information
page of the Constituent
Staging component.

Review the error messages
pertaining to the application in
the staging record.

In addition, review and edit
the application program data
and academic plan data. You
can also review and edit
the additional information
regarding the application,
 such as application center,
 application fees, source of
interest, other institutions,
 and recruiter assigned to the
application.

Additional Information SAD_APPL_CAF_STG • Student
Admissions >Application
Transaction
Mgmt >Application
Transactions >Additional
Information

• Click the <Transaction
Name> link on the
Summary Information
page and then click the
Additional Information
tab.

Review common attributes
for program, plan and subplan
pertaining to the application in
the staging record.

Education History SCC_EXT_ACAD_DATA • Student
Admissions >Application
Transaction
Mgmt >Application
Transactions >Education
History

• Click the <Transaction
Name> link on the
Summary Information
page and then click the
Education History tab.

Review and edit the education
history pertaining to the
application in the staging
record. Education history
includes information such
as schools attended and
degrees that are in progress or
completed.
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Page Name Definition Name Navigation Usage

Additional Academic Info SAD_STG_TEST • Student
Admissions >Application
Transaction
Mgmt >Application
Transactions >Additional
Academic Info

• Click the <Transaction
Name> link on the
Summary Information
page and then click the
Additional Academic
Info tab.

Review and edit the additional
academic information
pertaining to the application in
the staging record. Additional
academic information
includes test results and
academic interests.

Supplemental Information SAD_GENM_ATTACH • Student
Admissions >Application
Transaction
Mgmt >Application
Transactions >Supplemental
Information

• Click the <Transaction
Name> link on the
Summary Information
page and then click
the Supplemental
Information tab.

Review and edit the
supplemental information
pertaining to the application
in the staging record.
 Supplemental information
includes general materials,
 general material attachments,
 and application file
attachments.

Candidature Details SSR_RS_CNDDTRE_STG • Student
Admissions >Application
Transaction
Mgmt >Application
Transactions >Candidature
Details

• Click the <Transaction
Name> link on the
Summary Information
page and then click the
Candidature Details tab.

Review and edit the Candidate
Management data pertaining
to the application in the
staging record.

Application Regional SAD_APL_REG_STG • Student
Admissions >Application
Transaction
Mgmt >Application
Transactions >Application
Regional

• Click the<Transaction
Name> link on the
Summary Information
page and then click the
Application Regional tab.

Review and edit the country-
specific data pertaining to
the application in the staging
record.
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Impact of Application Center Security on Navigation
One of the methods to navigate to the Application Transactions component is by clicking the <transaction
name> link on the Constituent Staging component. There are two ways to access the Constituent Staging
component:

• Campus Community menu path navigation (Campus Community >Constituent Transaction
Mgmt >Constituent Staging)

• Student Admissions menu path navigation (Student Admissions >Application Transaction
Mgmt >Constituent Staging)

If you use the Campus Community menu path navigation and if your user ID is not associated with a
particular application center, you cannot access the application data associated with that application
center.

However, you can see how many applications exist for an applicant. In the following example, a user
can see there is one application for the constituent. However, the user cannot view the application data
because the <Transaction Name> link is disabled. The system has disabled the link because the user does
not have access to the application center.

This example illustrates a disabled Application Data link on the Summary Information page of
Constituent Staging component for a user who does not have application center access.

If you use the Student Admissions menu path navigation and if your user ID is not associated with a
particular application center, you cannot see how many applications associated with the application center
exist. Also, you cannot view the application data associated with the application center. Therefore, the
system strictly enforces the application center security for Student Admissions menu as compared to
Campus Community menu where the security is not enforced. In the following example, a user cannot see
whether there is an application transaction for the constituent because the user does not have access to the
application center.
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This example illustrates hidden search results on Constituent Staging component for a user who does not
have the application center access.

See "Setting Security for Application Centers" (Campus Solutions Application Fundamentals)

Header on the Application Transactions Pages
The header region on all the pages of the Application Transactions component is similar to the header
region on the Constituent Staging component pages. This region includes options to modify the
constituent status, run Search/Match/Post process or post a transaction.

This example illustrates a header region on an Application Transactions component page.
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Field or Control Description

Constituent Staging Click this link to access the Constituent Staging component
that contains all the pertinent person information.

Reviewing Application Data and Error Messages
Access the Application Data page (Student Admissions >Application Transaction
Mgmt >Application Transactions >Application Data).

This example illustrates the fields and controls on the Application Data page (1 of 3). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Application Data page (2 of 3). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Application Data page (3 of 3). You can find
definitions for the fields and controls later on this page.

For documentation about many of the fields on this page:

See Adding New Applications Manually
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Field or Control Description

Set Status to Submitted This button only appears if the application status is Posted.

If you have inadvertently posted the transaction data to
a wrong ID, click the Set Status to Submitted button. On
clicking the button, the system sets the application status back
to Submitted. For example, you may notice that an application
was posted to a new ID but you should have created the
application for an existing ID. To repost the application to the
existing ID, perform the following steps:

1. Run the Application Delete process to delete the
application that you have posted to the wrong ID so that
you do not maintain duplicate applications in the system.

2. Click the Set Status to Submitted button and save the
record.

3. Click the Set to Update ID button and select the existing
ID.

4. Click the Run Search/Match/Post button to post the
application.

Application Status Indicates the status of the application transaction.

Note: The Transaction Setup component refers to this
as Transaction Status. Transaction Status is the same as
the Status field shown in the Related Transactions grid
displayed on the Summary Information page of the Constituent
Staging component. We have modified only the label
as Application Status to show the relationship with the
application transactions. For a list of Application Status
values, refer to following table.

Application Status Description

Saved This status indicates that system has saved the admission
application to the staging records and the application is not
ready to be processed.

The system automatically assigns this status when the online
application calls the Save Application service operation.

You can also manually set this status if you want to indicate
that the application is not ready for processing.

When setting up the File Mapping Definition, you can
define the default value that File Parser should assign as the
Application Status.
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Application Status Description

Submitted This status indicates that system has submitted the admission
application to the staging records and the application is ready
to be processed.

The system automatically assigns this status to an application
when the online application calls the Submit Application
service operation.

You can manually set this status if you want to indicate that
the application is ready for processing. You cannot post Saved
transactions; only transactions with Submitted status can be
posted.

When setting up the File Mapping Definition, you can
define the default value that File Parser should assign as the
Application Status.

Saved Error This status indicates that the system encountered problems
when saving an admission application. You must resolve these
errors before the admission application can be posted.

You cannot manually change this status. When you resolve the
error and save the staging record, the system automatically sets
the status back to Saved.

Submit Error This status indicates that the system encountered problems
when submitting an admission application. You must resolve
these errors before the admission application can be posted.

You cannot manually change this status. When you resolve the
error and save the staging record, the system automatically sets
the status back to Submitted.

Pending This status indicates that manual reconciliation is required
for some data element which is not necessarily an error.
 For example, when manual reconciliation is required for
application fee waiver requests, the status is set to Pending and
the application fee status is set to Waiver. You can manually
change this status.

Posted This status indicates that the system has posted the data. The
system runs the posting process when you click the Post
Transaction Data button or the Run Search/Match/Post button,
 or when you run the Transaction Management process.

Application Fees

Use the Application Data and Application Fees regions of the page to view or update application fee
details. AAWS uses the payment integration services to enable application fees calculation and payment.

The setup of the AAWS Application Fee and Waiver Processing group box on the Application Center
Table page controls how an online application fee payment or waiver is processed.
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See Setting Up Application Processing Centers

See "Using the SSF_EPAYMENT_TRANS Web Service" (Student Financials)

When payment is authorized, the Amount Sent to GL field is updated in the Application Transactions
staging component (the field is not visible on the page) and is carried through to the core production
Application Maintenance component (Application Items page). The Generate Direct to GL process uses
the Amount Sent to GL value.

See "Generating Direct to GL Entries" (Student Financials)

The following scenarios discuss how the system updates the Application Data staging page fields when
an online application fee or waiver is processed in Self-Service mode — based on the setup of the AAWS
Application Fee and Waiver Processing group box on the Application Center Table page.

The staging field SAD_APL_DAT_STG.APP_FEE_STATUS is not visible on the Application Data
staging page.

Processing Application Fees When Waiver Request is Not Allowed

SCENARIO 1

The Application Center Table setup is:

• An application fee is required.

• Payment is required when the application is submitted.

• Waiver request is not allowed.

When an applicant has completed all the required data for the online application and is ready to submit
the application, the applicant clicks a payment button which triggers the AAWS Submit web service
operation (SAD_SUBMITAPPL). The web service operation calls the Application Fee Calculation API
which calculates the fee and returns the amount and currency to the external user interface which displays
the fee to the applicant.

The staging field SAD_APL_DAT_STG.APP_FEE_STATUS is set to Calculated.

When the applicant successfully makes a payment, the application is submitted. The
SAD_APL_DAT_STG.APPL_FEE_STATUS field is set to Received.

The field values are carried through to the core production Application Maintenance
component: ADM_APPL_DATA.APP_FEE_STATUS is set to Calculated and
ADM_APPL_DATA.APPL_FEE_STATUS is set to Received.

If the applicant does not successfully complete the payment process, the application remains in a saved
status.

SCENARIO 2

The Application Center Table setup is:

• An application fee is required.
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• Pay later is allowed.

• Waiver request is not allowed.

If the applicant selects to pay now, the process is the same as SCENARIO 1.

If the applicant selects to pay later, SAD_APL_DAT_STG.APP_FEE_STATUS is set to Calculated and
SAD_APL_DAT_STG.APPL_FEE_STATUS is set to Defer.

These values are carried through to core production: ADM_APPL_DATA.APP_FEE_STATUS is set to
Calculated and ADM_APPL_DATA.APPL_FEE_STATUS is set to Deferred. The Admissions office must
follow up on fee payment. No other processing occurs in AAWS.

Processing Application Fee Waivers in Staging

SCENARIO 3

The Application Center Table setup is:

• An application fee is required.

• Payment is required when the application is submitted OR pay later is allowed.

• Waiver request is allowed.

• Manual reconciliation is required.

If the applicant completes the payment, the process is the same as SCENARIO 1.

If the applicant requests a waiver, the applicant indicates the waiver basis (if required based on setup on
Application Center Table page) and provides supporting documentation (optional - may be submitted by
uploading an attachment or at a later time) and submits the application.

Because Require Manual Reconciliation is selected as the Application Fee Waiver Process option on the
Application Center Table page, then when the applicant submits the application, the staging fields are set
as follows:

• SAD_APL_DAT_STG. SAD_APPL_STS is set to Pending.

• SAD_APL_DAT_STG.APPL_FEE_STATUS is set to Waiver.

• SAD_APL_DAT_STG.WAIVED_AMT is set to blank.

• SAD_APL_DAT_STG.APP_FEE_STATUS is set to Pending.

The administrator reviews supporting documentation (Supplemental Information page) and grants or
denies the waiver.

If the waiver is granted, the staging fields are updated as follows:

• The administrator changes the staging Application Fee Status value to Waived.

• Programmatically, SAD_APL_DAT_STG.SAD_APPL_STS is set to Submitted.

• SAD_APL_DAT_STG.WAIVED_AMT shows the waiver amount.
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• SAD_APL_DAT_STG.APP_FEE_STATUS is set to Calculated.

These values are carried through to core production Admissions tables:

• On the Application Data - Application Fees page, the Fee Status value is Waived, the Waive Amount
value appears, and the Waiver Basis Code value appears based on the value in the related staging
field.

• On the Application Data page, the value in the Status field in the Application Fee Information group
box is Calculated.

If the waiver is denied, the administrator sets the Application Fee Status to Pending and the Application
Status is automatically set to Saved. The administrator must notify the applicant that the waiver request is
denied.

Processing Application Fee Waivers in Core Admissions

SCENARIO 4

The Application Center Table setup is:

• An application fee is required.

• Payment is required when the application is submitted OR pay later is allowed.

• Waiver request is allowed.

• Application can be posted to core production before waiver request is determined.

If the applicant completes the payment, the process is the same as scenario 1.

If the applicant selects to pay later, the process is the same as scenario 2. The Admissions office must
follow up on fee payment or waiver. No other processing occurs in AAWS.

If the applicant requests a waiver, the applicant indicates the waiver basis (if required based on setup on
Application Center Table page) and provides supporting documentation (optional - may be submitted by
uploading an attachment or at a later time) and submits the application.

If Allow to Post is selected as the Application Fee Waiver Process option and the App Fee Status Waived
option is selected on the Application Center Table page, then when the applicant submits the application,
the staging fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS is set to Waived.

• SAD_APL_DAT_STG.WAIVED_AMT is set to blank.

• SAD_APL_DAT_STG.APP_FEE_STATUS is set to Calculated.

These values are carried through to core production Admissions tables:

• On the Application Data - Application Fees page, the Fee Status value is Waived, the Waive Amount
value is blank and the Waiver Basis Code value appears based on the value in the related staging field.

• On the Application Data page, the value in the Status field in the Application Fee Information group
box is Calculated.
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The App Fee Status Waived option could be used by schools who allow waivers but automatically grant
the waiver without review or assessment.

If Allow to Post is selected as the Application Fee Waiver Process option and the App Fee Status Waiver
Request option is selected on the Application Center Table page, then when the applicant submits the
application, the staging fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS is set to Waiver.

• SAD_APL_DAT_STG.WAIVED_AMT is set to blank.

• SAD_APL_DAT_STG.APP_FEE_STATUS is set to Pending.

These values are carried through to core production Admissions tables:

• On the Application Data - Application Fees page, the Fee Status value is Waiver, the Waive Amount
value is blank and the Waiver Basis Code value appears based on the value in the related staging field.

• On the Application Data page, the value in the Status field in the Application Fee Information group
box is Pending.

Waiver requests must be assessed using the core production Application Maintenance component.

Query the record ADM_APPL_DATA and the field APPL_FEE_STATUS to find the applicants with
waiver requests.

The following scenarios discuss how the system updates the Application Data staging page fields when an
online application fee or waiver is processed in Administrator mode — based on the setup of the AAWS
Application Fee and Waiver Processing group box on the Application Center Table page.

Because, in Administrator mode, an administrative user is entering application data on behalf of the
applicant, an institution may design the user interface for Administrator mode differently than the
user interface for Self-Service mode. In the user interface for Self-Service mode, the institution may
implement greater control to dictate what options are presented to an applicant based upon the application
center parameters for application fees and waiver processing for AAWS. For Administrator mode,
although there may be less control in dictating these options, the application center parameters must still
be enforced. Therefore, while the following scenarios are similar to the scenarios listed above for Self-
Service mode, some of the logic and behavior for Administrator mode may vary.

Scenario 1

The Application Center Table setup is:

An application fee is not required.

User completes all the required sections of the application form and submits the application. Fields are set
as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Pending.

• APPL_FEE_TYPE = UI determined.

• APPL_FEE_DT = Submit date.

250  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 8 Managing PeopleSoft Admission Transactions

Scenario 2

The Application Center Table setup is:

• An application fee is not required.

• Payment is required when the application is submitted.

• Waiver request is not allowed.

In this scenario, in order to submit the application, the user must populate the APPL_FEE_STATUS =
Received (REC) and may give the fee amount. If the APPL_FEE_STATUS is not set to Received (REC),
the application will remain in Saved status in the staging component.

• Application fee calculation returns value to the application fee amount field.

• User must indicate APPL_FEE_STATUS = Received (REC).

• User may indicate the APPL_FEE_PAID value.

• User may populate the tender category and tender amount fields and the system stores these values in
staging and production tables.

• Status fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Received (REC).

• SAD_APL_DAT_STG.APPL_FEE_PAID = User-provided value. May be blank

• SAD_APL_DAT_STG.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2) (returned from the fee calculation
API).

• SAD_APL_TND_STG.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• SAD_APL_TND_STG.TENDER_AMT = User-populated value.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS = Received (REC).

• ADM_APPL_DATA.APPL_FEE_PAID = User-provided value. May be blank.

• ADM_APPL_DATA.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_TENDER.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• ADM_APPL_TENDER.TENDER_AMT = User-populated value.
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• Because the application center setup dictates that the fee is required and must be paid at application
submission, failure to indicate an APPL_FEE_STATUS of Received (REC) results in the application
remaining in Saved status in the staging component, with these fields set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Pending.

• SAD_APL_DAT_STG.APP_FEE_STATUS = Pending.

• SAD_APL_DAT_STG. SCC_TRANS_STS = SAVED.

Scenario 3

The Application Center Table setup is:

• An application fee is required.

• Payment is not required at submission (payment can be made later).

• Waiver request is not allowed.

In this scenario, at application submission, the user has the option to either:

• Provide fee payment details or

• Submit an application without payment details.

The APPL_FEE_STATUS values in use for this scenario are REC and DEF.

If the user provides the fee payment details:

• User must indicate APPL_FEE_STATUS = Received (REC).

• User may indicate the APPL_FEE_PAID value.

• User may populate the tender category and tender amount fields and the system stores these values in
staging and production tables.

• Status fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Received (REC).

• SAD_APL_DAT_STG.APPL_FEE_PAID = User-provided value. May be blank

• SAD_APL_DAT_STG.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2) (returned from the fee calculation
API).

• SAD_APL_TND_STG.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• SAD_APL_TND_STG.TENDER_AMT = User-populated value.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS = Received (REC).
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• ADM_APPL_DATA.APPL_FEE_PAID = User-provided value. May be blank.

• ADM_APPL_DATA.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_TENDER.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• ADM_APPL_TENDER.TENDER_AMT = User-populated value.

However, the user may opt to submit without populating the application fee status field. Because the
system cannot rely on a user supplying the correct value of Defer, the system enforces application fee
status to DEF if the application fee status value does not = Received (REC). If the application is submitted
without any payment details:

• Fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Defer (DEF).

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2).

• SAD_APL_DAT_STG.APPL_FEE_PAID = Blank.

• SAD_APL_DAT_STG.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS = Defer (DEF).

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_DATA.APPL_FEE_PAID = Blank.

• ADM_APPL_DATA.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

Scenario 4

The Application Center Table setup is:

• An application fee is required.

• Payment is required at submission.

• Waiver request is allowed.

In this scenario, the user must:

• Provide fee payment details or

• Provide fee waiver details.

If neither payment nor waiver details are provided at application submission, the application must remain
in Saved status.
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Valid APPL_FEE_STATUS values in use for this scenario are REC, WRQ, WVD, and PENDING.

User provides the fee payment details:

• User must indicate APPL_FEE_STATUS = Received (REC).

• User may indicate the APPL_FEE_PAID value.

• User may populate the tender category and tender amount fields and the system stores these values in
staging and production tables.

• Status fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Received (REC).

• SAD_APL_DAT_STG.APPL_FEE_PAID = User-provided value. May be blank

• SAD_APL_DAT_STG.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2) (returned from the fee calculation
API).

• SAD_APL_TND_STG.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• SAD_APL_TND_STG.TENDER_AMT = User-populated value.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS = Received (REC).

• ADM_APPL_DATA.APPL_FEE_PAID = User-provided value. May be blank.

• ADM_APPL_DATA.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_TENDER.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• ADM_APPL_TENDER.TENDER_AMT = User-populated value.

User provides waiver details:

• If application center setting for waiver processing is Require Manual Reconciliation then:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Waiver request (WVQ) (the system enforces
WVQ even if user provides WVD).

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2).

• SAD_APL_DAT_STG.WAIVE_AMT = User-provided value. May be blank.

• SAD_APL_DAT_STG.SAD_WAIVER_BASIS = User-provided value from valid waiver basis
values in the application center setup.
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With this setting in place, in staging SAD_APL_DAT_STG. SCC_TRANS_STS is set to Pending.

• The same values are carried through to production as (these values may change as the user will do
manual reconciliation and update some values.):

• ADM_APPL_DATA.APPL_FEE_STATUS =User-provided value that the system stores in the
staging table during reconciliation.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_DATA.WAIVE_AMT = User-provided value. May be blank.

• ADM_APPL_DATA. SAD_WAIVER_BASIS = User-provided value from valid values in the
application center setup.

• Else, if application center setting for waiver processing is Allow to Post then:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Setting specified on the application center
parameters for waiver processing is either Waived (WVD) or Waiver request (WVQ). The system
enforces WVD or WVQ from application center setting regardless of what user indicates.

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2).

• SAD_APL_DAT_STG.WAIVE_AMT = User-provided value. May be blank.

• SAD_APL_DAT_STG.SAD_WAIVER_BASIS = User-provided value from valid waiver basis
values in the application center setup.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS = Determined value of WVD or WVQ based upon
application center setting.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_DATA.WAIVE_AMT = User-provided value. May be blank.

• ADM_APPL_DATA. SAD_WAIVER_BASIS = User-provided value from valid values in the
application center setup.

• If the APPL_FEE_STATUS is not REC, WVD, (or WRQ) then:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Pending (PEN).

• SAD_APL_DAT_STG.APP_FEE_STATUS = Pending (1).

• SAD_APL_DAT_STG. SCC_TRANS_STS = SAVED.

Scenario 5

The Application Center Table setup is:
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• An application fee is required.

• Payment is not required at submission (payment can be made later).

• Waiver request is allowed.

In this scenario, the user can:

• Provide fee payment details or

• Provide fee waiver details.

• Not provide either payment or waiver details.

Valid APPL_FEE_STATUS values in use for this scenario are REC, DEF, WRQ, WVD, and PENDING.

If the user provides the fee payment details:

• User must indicate APPL_FEE_STATUS = Received (REC).

• User may indicate the APPL_FEE_PAID value.

• User may populate the tender category and tender amount fields and the system stores these values in
staging and production tables.

• Status fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Received (REC).

• SAD_APL_DAT_STG.APPL_FEE_PAID = User-provided value. May be blank

• SAD_APL_DAT_STG.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2) (returned from the fee calculation
API).

• SAD_APL_TND_STG.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• SAD_APL_TND_STG.TENDER_AMT = User-populated value.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS = Received (REC).

• ADM_APPL_DATA.APPL_FEE_PAID = User-provided value. May be blank.

• ADM_APPL_DATA.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_TENDER.TENDER_CATEGORY = User-selected value from valid values in
application fee setup.

• ADM_APPL_TENDER.TENDER_AMT = User-populated value.

User provides waiver details:

256  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 8 Managing PeopleSoft Admission Transactions

• If application center setting for waiver processing is Require Manual Reconciliation then:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Waiver request (WVQ) (the system enforces
WVQ even if user provides WVD).

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2).

• SAD_APL_DAT_STG.WAIVE_AMT = User-provided value. May be blank.

• SAD_APL_DAT_STG.SAD_WAIVER_BASIS = User-provided value from valid waiver basis
values in the application center setup.

With this setting in place, in staging SAD_APL_DAT_STG. SCC_TRANS_STS is set to Pending.

• The same values are carried through to production as (these values may change as the user will do
manual reconciliation and update some values.):

• ADM_APPL_DATA.APPL_FEE_STATUS =User-provided value that the system stores in the
staging table during reconciliation.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_DATA.WAIVE_AMT = User-provided value. May be blank.

• ADM_APPL_DATA. SAD_WAIVER_BASIS = User-provided value from valid values in the
application center setup.

• Else, if application center setting for waiver processing is Allow to Post then:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Setting specified on the application center
parameters for waiver processing is either Waived (WVD) or Waiver request (WVQ). The system
enforces WVD or WVQ from application center setting regardless of what user indicates.

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2).

• SAD_APL_DAT_STG.WAIVE_AMT = User-provided value. May be blank.

• SAD_APL_DAT_STG.SAD_WAIVER_BASIS = User-provided value from valid waiver basis
values in the application center setup.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS = Determined value of WVD or WVQ based upon
application center setting.

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_DATA.WAIVE_AMT = User-provided value. May be blank.

• ADM_APPL_DATA. SAD_WAIVER_BASIS = User-provided value from valid values in the
application center setup.

User submits without payment details or waiver details:
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Because the system cannot rely on a user supplying the correct value of Defer (DEF), the system enforces
application fee status to DEF if the application fee status value does not = REC, WVD, or WVQ.

• Fields are set as follows:

• SAD_APL_DAT_STG.APPL_FEE_STATUS = Defer (DEF).

• SAD_APL_DAT_STG.APP_FEE_STATUS = Calculated (2).

• SAD_APL_DAT_STG.APPL_FEE_PAID = Blank.

• SAD_APL_DAT_STG.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

• The same values are carried through to production as:

• ADM_APPL_DATA.APPL_FEE_STATUS= Defer (DEF).

• ADM_APPL_DATA.APP_FEE_STATUS = Calculated (2).

• ADM_APPL_DATA.APPL_FEE_PAID = Blank.

• ADM_APPL_DATA.APPL_FEE_AMOUNT = Value returned by the fee calculation API.

Reviewing Additional Information
Access the Additional Information page (Student Admissions >Application Transaction
Mgmt >Application Transactions >Additional Information).
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This example illustrates the fields and controls on the Additional Information page.

See Entering or Updating Additional Information

See "Understanding Common Attribute Framework" (Campus Community Fundamentals)

Reviewing Applicant's Education History
Access the Education History page (Student Admissions >Application Transaction
Mgmt >Application Transactions >Education History).
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This example illustrates the fields and controls on the Education History page (1 of 3).

This example illustrates the fields and controls on the Education History page (2 of 3).
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This example illustrates the fields and controls on the Education History page (3 of 3).

Reviewing Additional Academic Information
Access the Additional Academic Info page (Student Admissions >Application Transaction
Mgmt >Application Transactions >Additional Academic Info).

This example illustrates the fields and controls on the Additional Academic Info page.
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Reviewing General Materials and Attachments
Access the Supplemental Information page (Student Admissions >Application Transaction
Mgmt >Application Transactions >Supplemental Information).

This example illustrates the fields and controls on the Supplemental Information page (1 of 2).

This example illustrates the fields and controls on the Supplemental Information page (2 of 2).

Reviewing Candidature Details Information
Access the Candidature Details page (Student Admissions >Application Transaction
Mgmt >Application Transactions >Candidature Details).
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This example illustrates the fields and controls on the Candidature Details page (1 of 3).

This example illustrates the fields and controls on the Candidature Details page (2 of 3).
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This example illustrates the fields and controls on the Candidature Details page (3 of 3).

Reviewing Application Regional Information
Access the Application Regional page (Student Admissions >Application Transaction
Mgmt >Application Transactions >Application Regional).
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This example illustrates the fields and controls on the Application Regional page.

The system displays this page only if the country-specific options are selected on the SA Features and
Academic Institution 6 pages.

Related Links
"Selecting Country-Specific Features and Enabling CRM for Higher Education Feature" (Campus
Solutions Application Fundamentals)
"(AUS, CAN, GBR, NZL, NLD) Activating Other Student Administration Features" (Campus Solutions
Application Fundamentals)
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Using File Parser for Loading Applications

Related Documentation for Using File Parser for Loading
Applications

Ensure that you review the following:

• Understanding Admission Transactions

• "Understanding CTM" (Campus Community Fundamentals)

• "Understanding the File Parser Process" (Campus Community Fundamentals)

• "Understanding Entity Registry" (Campus Community Fundamentals)

• AAWS Data Mapping and Entity Catalog document which was posted to My Oracle Support (ID
1323959.1)

Before You Begin

You can use the Campus Community File Parser utility to load admission applications from a text file into
Campus Solutions. Before you begin setting up File Parser to load your external applications, there are
a few things that might be helpful to do. You may want to consider doing this with a spreadsheet or data
modeling tool:

• Review the external application data to determine which staging records and fields will be populated.
Utilize the Entity Registry feature to get a clear understanding of the staging table hierarchy.

• Document each record to be populated, the fields within each record that will come from the external
data, and which fields need to be populated with default values. Utilize the AAWS Data Mapping and
Entity Catalog document to view each of the staging records and their associated fields.

• Determine which incoming fields will need to be converted to internal values.

• Document the non-required incoming data elements so you know which records need to have Skip if
Blank selected for the mapped data element.

• Determine which fields require developing a calculated field. Examples include: Application Center,
External Organization ID, and Degree Description.

Setup for Loading Applications Using File Parser

The key setup areas that apply to bulk loading of applications are:

Copyright © 1988, 2021, Oracle and/or its affiliates. 267



Using File Parser for Loading Applications Chapter 9

• Campus Community File Parser.

• Campus Community Constituent Transaction Management (CTM).

• Campus Community Entity Registry.

• Application Configuration (Configuring admission transactions).

Setting Up Admission Transactions

Define and configure an admission transaction that represents data in the external file.

This example illustrates the CTM Transaction Setup page for a bulk load admission transaction (1 of 2).
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This example illustrates the CTM Transaction Setup page for a bulk load admission transaction (2 of 2).

Ensure that the following parameters are set up:

• Set the Transaction Status as Active.

• Deselect the Online Transaction check box. This indicates that the transaction is offline (that is, File
Parser will add the data to the stage records offline). This will automatically set Process Search/Match
to Batch.

Setting Up File Parser

File Parser consists of several key components:

• Field Conversion Definitions – Identifies external file field values to convert before storing the data
in the target staging table.

• Context Definitions – Identifies the parent-to-child relationship of the staging tables that will be used
to hold the data.

• File Mapping Definitions – Associates fields on the external file with the records in the context
definition.

Make sure you enter a row for the required constituent (CTM) and transaction staging records on the
Context Definition page and the Mapping page of File Mapping Definition component:

• SCC_STG_CONSTIT. It is required to set the following fields, even though they are not necessarily
required in the record:

• SUBMITTED - Default to N

• SCC_TRANSAC_CD – Set according to Transaction Setup
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• SCC_STG_STATUS – Default to LD (Loaded)

• SCC_STG_STATUS_DT – Default to %Date

• SCC_SL_TRNMAP (Select Force Insert)

• SCC_STG_NAMES

• SCC_STG_PERSSA (Select Force Insert if no incoming fields are mapped)

• SCC_STG_STD_CAR

• SAD_APP_CSQ_STG

• SAD_APL_DAT_STG It is required to set the following fields, even though they are not necessarily
required in the record:

• SCC_TRANSAC_CD – Set according to Transaction Setup

• SCC_TRANS_STS – Default to SB (Submitted ) or SV (Saved) depending on your business
process

• SCC_TRANS_STS_DT – Default to %Date

• SAD_APL_PRG_STG

• SAD_APL_PLN_STG

Warning! When using a file to upload data into the stage records, do not populate the EMPLID field with
a value that is not already created inside your production database. Doing so will cause the post process to
production tables to fail (the EMPLID value passed will not be used to create a new EMPLID). The same
is also true for the User ID (USERID field). The process will not create a User ID using the value entered
in the file.

Use the Field Conversion Definition page to define field values in the external file that must be converted
to internal values. Add any additional fields and complete the definition for the fields delivered.
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This example illustrates the Field Conversion Definition page.

Use the Context Definition page to add the delivered staging tables as well as any additional extension
staging tables that need to be updated when loading data from the external file. You may have created the
extension tables by performing steps listed in this section of the Developer Reference for Creating a New
CTM Consumer documentation:

"Developer Reference for Creating a New CTM Consumer" (Campus Community Fundamentals)

Ensure that you enter the correct Parent Record field value. For bulk load of admission applications,
SCC_STG_CONSTIT must be the first record entered as it is the parent to all records.

This example illustrates the Context Definition page (1 of 2).
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This example illustrates the Context Definition page (2 of 2).

For bulk load of admission applications, the counters that you must include in the context definition are:

• SCC_TEMP_ID: SCC_STG_CTRS.SCC_TEMP_ID

• ADM_APPL_NBR: INSTALLATION_SA.ADM_APPL_NBR_LAST

Note: The unique counter for ADM_APPL_NBR must be set up in the context definition and the Visible
for Mapping should be deselected for the ADM_APPL_NBR field.

Use the File Definition page to provide information about the external file.

This example illustrates the File Definition page.

Use the File Layout page to define fields from the external file that will be loaded into the staging tables.
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This example illustrates the File Layout page.

Use the Mapping page to associate fields defined on the File Layout page with staging table fields defined
in the context definition.

This example illustrates the Mapping page.

There could be required description fields that may require a calculated field to populate. File Parser
does not populate the description based on the code populated. You must build a calculated field to load a
description. Examples of required description fields:

• Academic Interests - SCC_STG_ADMINT. DESCR

• Extracurricular Activities - SCC_STG_EXTRACU.DESCR
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• External Degrees - SCC_STG_EXTDEGR.DESCR

SAD_APL_PRG_STG.APPL_PROG_NBR: To have the system automatically set the Application
Program Number to zero (which is the default when adding a new application), set the Mapping Action
for this field to a Default Value of 0. If you are inserting multiple program rows for one application
number, set the second occurrence of this field to a Default Value of 1.

Use the Preview Data page to test your external file with the File Parser Definitions.

Note: The preview feature shows only the first row of each row type; therefore, you should use a small
test file when using this component. Using a large test file is simply a waste of resources that could
potentially degrade the application server.

This example illustrates the Preview Data page.

Running the File Parser Process

Run the File Parser process to load the application data from a text file into the staging tables. Each
application is loaded as an admission transaction based on the default transaction code entered on the
Mapping page.

Use the Run File Parser page to run the File Parser process.
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This example illustrates the Run File Parser page.

Processing Staged Data

After loading the application data into the staging tables, review the staged constituent and applicant data.
Then, run the CTM Transaction Management Process to search/match and post the staged data into the
production tables of the Campus Solutions database. This process will also determine if any errors exist
in the data being posted. If there are errors, the Constituent Staging Status is set to Error and the errors
are displayed on the Constituent Staging (CTM) and Application Transactions components. Return to
Constituent Staging and search for the transactions you are processing which have errors.
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This example illustrates an example of using Constituent Staging component to search for transactions
with an error.

Correct the errors indicated on each transaction. Then, run the Transaction Management Process again to
post these records.

Commonly Used Calculated Mapping Application Class Objects

This section provides an example for how to derive: Application Center Default.

It is assumed that the person who will be responsible for creating and managing the Application Classes
is a seasoned engineer who is comfortable with working with PeopleTools Application Designer, is well
versed in writing PeopleCode, and has detailed knowledge of the referential integrity associated with the
tables referenced by the File Parser Context definition.

Warning! This is only an example, and have not been exposed to any rigorous testing scenarios. Should
you decide to use this example in any form, it is strongly recommended that a complete and thorough set
of test cycle(s) be exercised before moving to production.
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Application Center Default
Code example:

import SCC_FILE_PARSER:UTIL:FieldCalculationAbstract;
import SCC_FILE_PARSER:MODEL:Results:ResultsField;
import SCC_FILE_PARSER:MODEL:Results:ResultsRecord;
import SCC_FILE_PARSER:MODEL:Results:ResultsCollection;
import SCC_FILE_PARSER:UTIL:Exception:FileParserException;
import SAD_ADM_APPL:Setup:ApplicationDefaults;

/**
  *  class ApplicationCenterDefault
  *
  *  @version
  *  @author
  *
  *  Module:
  *  Description:
  */

class ApplicationCenterDefault extends
SCC_FILE_PARSER:UTIL:FieldCalculationAbstract
   /* public methods */
   method ApplicationCenterDefault();
   method calculateValue(&ResultsFieldIn As
SCC_FILE_PARSER:MODEL:Results:ResultsField, &ResultsCollectionIn
As SCC_FILE_PARSER:MODEL:Results:ResultsCollection) Returns any;

private
   method GetFileData();
   method GetFieldReferences();

   instance string &Institution;
   instance string &Career;
   instance string &Program;
   instance string &Plan;
   instance string &Country;
   instance string &Citizenshipstatus;

   instance SAD_ADM_APPL:Setup:ApplicationDefaults &ApplicationDefaults;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &ResultsField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsCollection
&ResultsCollection;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &InstitutionField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &CareerField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &ProgramField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &PlanField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &CountryField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField
&CitizenshipstatusField;

end-class;

method ApplicationCenterDefault

   %Super = create SCC_FILE_PARSER:UTIL:FieldCalculationAbstract();
   &ApplicationDefaults = create SAD_ADM_APPL:Setup:ApplicationDefaults();

end-method;

method calculateValue
   /+ &ResultsFieldIn as SCC_FILE_PARSER:MODEL:Results:ResultsField, +/
   /+ &ResultsCollectionIn as SCC_FILE_PARSER:MODEL:Results:
ResultsCollection +/
   /+ Returns Any +/
   /+ Extends/implements
SCC_FILE_PARSER:UTIL:FieldCalculationAbstract.CalculateValue +/
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   Local string &ApplicationCenter;

   &ResultsCollection = &ResultsCollectionIn;
   &ResultsField = &ResultsFieldIn;

   %This.GetFileData();

   try

      &ApplicationCenter = &ApplicationDefaults.getApplicationCenter(
&Institution, &Career, &Program, &Plan, &Country, &Citizenshipstatus);
   catch Exception &exception
      Local string &strParm = &Country | "," | &Citizenshipstatus;
      throw create SCC_FILE_PARSER:UTIL:
Exception:FileParserException(14015, 648,
"Message Not found - problem with App Center API",
&Institution, &Career, &Program, &Plan, &strParm);
   end-try;

   Return &ApplicationCenter;

end-method;

method GetFileData

   If &InstitutionField = Null Then
      %This.GetFieldReferences();
   End-If;

   &Institution = "";
   If &InstitutionField <> Null Then
      &Institution = &InstitutionField.FieldValue;
   End-If;

   &Career = "";
   If &CareerField <> Null Then
      &Career = &CareerField.FieldValue;
   End-If;

   &Program = "";
   If &ProgramField <> Null Then
      &Program = &ProgramField.FieldValue;
   End-If;

   &Plan = "";
   If &PlanField <> Null Then
      &Plan = &PlanField.FieldValue;
   End-If;

   &Country = "";
   If &CountryField <> Null Then
      &Country = &CountryField.FieldValue;
  End-If;

   &Citizenshipstatus = "";
   If &CitizenshipstatusField <> Null Then
      &Citizenshipstatus = &CitizenshipstatusField.FieldValue;
   End-If;

end-method;

method GetFieldReferences

   Local integer &SegmentNbr;
   Local integer &RowNbr = 1;

   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SCC_STG_CITZN;
   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SCC_STG_STD_CAR;
   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SAD_APL_DAT_STG;
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   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SAD_APL_PRG_STG;
   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SAD_APL_PLN_STG;
   &SegmentNbr = &ResultsField.ResultsRecord.SegmentNbr;

   &obj_SCC_STG_CITZN = &ResultsCollection.
GetResultsRecord(&SegmentNbr, "SCC_STG_CITZN", &RowNbr);
   &obj_SCC_STG_STD_CAR = &ResultsCollection.
GetResultsRecord(&SegmentNbr, "SCC_STG_STD_CAR", &RowNbr);
   &obj_SAD_APL_DAT_STG = &ResultsCollection.
GetResultsRecord(&SegmentNbr, "SAD_APL_DAT_STG", &RowNbr);
   &obj_SAD_APL_PRG_STG = &ResultsCollection.
GetResultsRecord(&SegmentNbr, "SAD_APL_PRG_STG", &RowNbr);
   &obj_SAD_APL_PLN_STG = &ResultsCollection.
GetResultsRecord(&SegmentNbr, "SAD_APL_PLN_STG", &RowNbr);

   If &obj_SCC_STG_CITZN <> Null Then
      &CountryField = &obj_SCC_STG_CITZN.GetResultsField("COUNTRY");
      &CitizenshipstatusField = &obj_SCC_STG_CITZN.
GetResultsField("CITIZENSHIP_STATUS");
   End-If;

   If &obj_SCC_STG_STD_CAR <> Null Then
      &CareerField = &obj_SCC_STG_STD_CAR.GetResultsField("ACAD_CAREER");
   End-If;

   If &obj_SAD_APL_DAT_STG <> Null Then
      &InstitutionField = &obj_SAD_APL_DAT_STG.
GetResultsField("INSTITUTION");
   End-If;

   If &obj_SAD_APL_PRG_STG <> Null Then
      &ProgramField = &obj_SAD_APL_PRG_STG.GetResultsField("ACAD_PROG");
   End-If;

   If &obj_SAD_APL_PLN_STG <> Null Then
      &PlanField = &obj_SAD_APL_PLN_STG.GetResultsField("ACAD_PLAN");
   End-If;

end-method;
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Managing PeopleSoft Prospect/Admissions
Data Load Transactions

Related Documentation for Prospect/Admissions Data Load
Transactions

For documentation related to Prospect/Admissions Data Load Transactions, see:

• The product documentation for PeopleTools: Integration Broker.

• The documentation for these Campus Community features:

• "Understanding Entity Registry" (Campus Community Fundamentals)

• "Understanding CTM" (Campus Community Fundamentals)

• "Understanding the File Parser Process" (Campus Community Fundamentals)

• "Understanding Common Attribute Framework" (Campus Community Fundamentals)

Understanding Prospect/Admission Data Load Transactions

Prospect/Admissions Data Load (PDL) is an innovative tool that utilizes existing architecture and
functionality including Constituent Transaction Management (CTM), the File Parser, Entity Registry, 3C
Events and Triggers and the Common Attribute Framework. It is designed to provide new structures that
will allow academic institutions to define and map almost any external file containing data that requires
staging, search/match processing, and posting to production records. This could include but is not limited
to admissions test scores, prospects, placement exams, internal academic knowledge test results, and so
on.

The Prospect/Admissions Data Load represents a common approach for capturing externally provided test
data and other data that:

• Utilizes the CTM data structures and staging components to capture bio/demo data.

• Utilizes the existing CTM Transaction Setup component and Transaction Management process to
enable staging and posting of data.

• Utilizes the existing CTM Data Update Rules feature to enable the user to determine how existing
constituent data should be updated.

• Provides ability to create prospects via appropriate mapping definitions.
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• Provides new application packages to post test scores, prospect data and other data to Campus
Solutions as part of the existing Transaction Management process.

• Utilizes the existing Enterprise Integration Points (EIPs) to exchange data between Campus
Solutions and PeopleSoft CRM for test scores, prospect data, academic interests, education data and
extracurricular activities.

• Utilizes the Common Attribute Framework to extend the existing prospect and test score records
enabling academic institutions to store additional test and prospect data not supported in the current
structures.

• Provides a security structure for the staging components to restrict access to only those transactions a
user can process.

PDL represents an important step towards ending your reliance on Campus Solutions continuous support
for various existing test score load processes. Working closely with the HEUG Admissions Product
Advisory Group, we intend to begin the evolutionary migration from currently supported test scores
to this new form of processing. It is our intention that this new paradigm will be used for loading all
currently supported admissions related test score and data loads. PDL will introduce initial file mapping
definition templates for currently supported test score loads which will serve as the basis for load
procedures. It is important to recognize that, as each new template for a test load is delivered; academic
institutions will acquire the ability for responding to layout changes as announced by various test
agencies.

Important! Campus Solutions will no longer update the individual test load after its related PDL template
has been delivered.
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This diagram illustrates the prospect/admissions data flow.

The steps for setting up, loading and posting prospect or admissions data from an external file are as
follows:
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Steps More Information

1. Define a data update rule based on the incoming data to be
used on the Transaction Setup component.

2. Define a transaction code on the Transaction Setup
component to be used on the file mapping definition.

3. Update transaction security to add the transaction code
for the appropriate users so that these users can view the
data in the Prospect/Admissions Staging and Constituent
Staging components under the Student Recruiting, Prospect/
Admissions Data Mgmt menu.

4. Update the appropriate Common Attribute Framework
record context via the Record Context component to add or
remove common attributes for additional data you want to
store for your prospects or test takers.

See Configuring PDL Setup

See "Setting Up CTM Transaction Security" (Campus
Community Fundamentals)

5. Optional: Assign a 3C Event ID to your transaction code
on the 3C Event ID Setup page to assign 3Cs to each person
record processed. Also, review and modify the Prospect Setup
page if you are using a calculated field to assign a recruiting
center to an incoming prospect record.

See Setting Up Prospect Configuration

6. Define a File Parser field conversion profile for your
external file, if needed, to convert external field values to
internal field values.

7. Define a File Parser context definition for your external file
to indicate the staging records you will populate in the proper
parent-child relationship.

8. Define a File Parser file mapping definition to map the
fields on the external file to the records defined on the context
definition.

9. Run the File Parser process to load the external file to the
staging records based on the file mapping definition.

See Setting Up File Parser for PDL

10. Run the Transaction Management process for your
transaction code to perform search/match and post staged data.

See the discussion on Transaction Management process in the
Campus Community – Constituent Transaction Management
documentation.

11. Use the Constituent Staging and Prospect/Admissions
Staging components to review records that were not posted
based on search/match rules or validation logic. Determine
if new record should be created or existing record updated.
 Resolve any validation errors.

See Reviewing and Editing Staged PDL Transactions

See the discussion on Constituent Staging component in the
Campus Community – Constituent Transaction Management
documentation.
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Steps More Information

12. Manually post individual records or run the Transaction
Management process again to post remaining records that were
reviewed on the Constituent Staging and Prospect/Admissions
Staging components.

For manually posting individual records:

See the discussion on Constituent Staging component in the
Campus Community – Constituent Transaction Management
documentation.

For posting in batch:

See Posting PDL Transactions

CRM for Higher Ed EIPs and Prospect/Admissions Data Transactions
Enterprise Integration Points (EIPs) enable your institution to exchange data between CS and CRM. EIPs
publish data either whenever data updating happens for the given entities of the EIPs or when the user
requests data. This data can be created, updated, or deleted through various channels like components,
component interfaces, and batch processes.

The system can publish the following EIPs when a PDL transaction is posted via the Transaction
Management process:

• SAD_ADM_PRSPCT_DATA_SYNC

• SAD_TEST_SCORES_SYNC

• SAD_ADM_INTEREST_SYNC

• SSR_EXTRACUR_ACTVTY_SYNC

• SAD_EXT_ACAD_DATA_SYNC

• SCC_PERSON_SYNC

Note: If EIPs are active, they are automatically published when you run the Transaction Management
process.

See also:

• "Understanding CRM for Higher Ed" (Campus Solutions Application Fundamentals)

• CRM for Higher Education Developer’s Guide in My Oracle Support (ID 1982671.1)

Entity Registry and PDL Transactions

The entities for all core data records within the constituent and prospect/admissions data areas needed for
PDL transactions are delivered with the system within the Entity Registry component.
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Delivered Entities Related to Prospect/Admissions Data

The following entities are delivered for the prospect/admissions staging records and matching production
records:

Entity Name Staging Record Names Production Record Names

Prospect/Admissions Data Load SAD_PDL_HDR_STG **SAD_PDL_HDR_WRK

Prospect Career SAD_PRS_CAR_STG ADM_PRSPCT_CAR

Prospect Program SAD_PRS_PRG_STG ADM_PRSPCT_PROG

Prospect Plan SAD_PRS_PLN_STG ADM_PRSPCT_PLAN

Prospect Sub-Plan SAD_PRS_SBP_STG ADM_PRSPCT_SBPL

Prospect Recruiting Category SAD_PRS_RCR_STG PRSPCT_RCR_CAT

Prospect Recruiter SAD_PRS_REC_STG PRSPCT_RECRTER

Prospect CAF SAD_STG_PRS_CAF SAD_PRSPCT_CAF

*Test Score SCC_STG_TEST STDNT_TEST

*Test Score Component SCC_STG_TESTCMP STDNT_TEST_COMP

*Test Date SCC_STG_TESTDT SAD_TESTDT

*Test CAF SAD_STG_TST_CAF SAD_TESTDT_CAF

*Academic History SCC_STG_ACADHST ACAD_HISTORY

*External Academic Data SCC_STG_EXACDDT EXT_ACAD_DATA

*External Education Comment SCC_STG_EXEDCOM SAD_EXT_ED_COM

*External Academic Summary SCC_STG_EXACDSM EXT_ACAD_SUM

*External Academic Subject SCC_STG_EXACDSB EXT_ACAD_SUBJ
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Entity Name Staging Record Names Production Record Names

*External Academic Data (CAN) SCC_STG_CANEXAC CAN_EXT_ACAD_DA

*External Course SCC_STG_EXTCRS EXT_COURSE

*External Course Communication SCC_STG_CRSCOM SAD_EXT_CRS_COM

*External Course Grade SCC_STG_CRSGRD SAD_EXT_CRS_GRD

*External Degree SCC_STG_EXTDEGR EXT_DEGREE

*Academic Interests Header SCC_STG_ADMIHD ADM_INTRST_HDR

*Academic Interests SCC_STG_ADMINT ADM_INTERESTS

*General Materials SAD_STG_GEN_MAT GENL_MATERIALS

*General Materials Attachment SAD_STG_GNMTATT GENL_MAT_ATTACH

*Considered Constituent Data but appears on Prospect/Admissions Staging

**Work record has no significance other than to act as a production record placeholder within the Entity
Registry

A query group, named PROS ADM DATA LOAD, has been added for PDL. This new query group is
added to QUERY_TREE_ADM. Use the Query Access Manager page to view this query group.

See Also

the product documentation for PeopleTools: Query

Configuring PDL Setup

Before you deploy PDL and start loading data from external sources, you must set up the following:

• Data Update Rules Entry

• CTM Transaction Setup

• Transaction Security

• Common Attribute Framework

• Prospect Configuration
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• File Parser

This section discusses:

• Setting Up Data Update Rules Entry

• Setting Up Transaction

• Setting Up CTM Transaction Security

• Understanding the Entity Registry Impacts

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

See also:

• Setting Up Prospect Configuration

• Setting Up File Parser for PDL

Setting Up Data Update Rules Entry
Access the Data Update Rule Entry page (Set Up SACR >System
Administration >Utilities >Constituent Transaction Mgmt >Data Update Rule Entry).

Create a data update rule based on the incoming constituent data from your file layout. Determine if/how
the constituent data should be updated if it already exists for the person in the core campus records.

Academic institutions require different rules for updating constituent data based on a transaction and the
affiliation the institution has with the constituent. For example, you may define one rule based on the
incoming data from TOEFL and a different rule based on the incoming data from PTE as the data you
receive from each testing agency differs. Additionally, you may want to override the TOEFL rule if the
constituent is already an applicant. The Data Update Rule Entry component allows this flexibility. The
system uses these rules when it posts a transaction.

To be consistent with existing CTM processes that update this data, the following table describes the data
update rules for these entities:

Entity Rules

Academic Interests If data exists on ADM_INTRST_HDR for an existing EMPLID and ACAD_
CAREER and the max ADM_INTRST_HDR.EFFDT is not equal to %Date, a new
row is inserted with EFFDT = %Date. Rows are inserted into ADM_INTERESTS for
each academic interest populated on SCC_STG_ADMINT. PRIORITY is populated
based on ADM_INTRST_HDR.USE_PRIORITY.

If data exists on ADM_INTRST_HDR for an existing EMPLID and ACAD_
CAREER and the max ADM_INTRST_HDR.EFFDT is equal to %Date, a row is not
inserted into ADM_INTRST_HDR. Rows will be inserted into ADM_INTERESTS
only where SCC_STG_ADMINT.EXT_SUBJECT_AREA does not exist on ADM_
INTERESTS for the current effective date. If ADM_INTRST_HDR.USE_PRIORITY
is Y, the max ADM_INTEREST.PRIORITY is determined and incremented to the
next number when new rows are inserted.
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Entity Rules

External Academic Data A new data number (EXT_DATA_NBR) is inserted to EXT_ACAD_DATA if the
EXT_ORG_ID on the staging record SCC_STG_ACADHST exists on the core record
ACAD_HISTORY. The max EXT_DATA_NBR existing on EXT_ACAD_DATA is
determined and incremented to the next number on insert.

All child records are populated with the same EXT_DATA_NBR that is inserted on
EXT_ACAD_DATA if the field exists on the child record.

Exception: For the record EXT_DEGREE, if data exists on EXT_DEGREE where
DESCR, DEGREE_DT, DEGREE_STATUS and LS_DATA_SOURCE = data from
staging record (SCC_STG_EXTDEGR), a new row is not inserted.

General Materials A new record is always inserted.

The max GENL_MATL_NBR is determined and new incremented to the next number
when new rows are inserted.

Test Score If SCC_STG_TEST.TEST_ID does not exist on STDNT_TEST for the EMPLID, a
new row is inserted along with any child rows (STDNT_TEST_COMP).

If the following elements on STDNT_TEST_COMP match the elements on the
staging record SCC_STG_TESTCMP, update Score, Percentile and Date Loaded
regardless of the previous score reported: EMPLID, TEST_ID, TEST_COMP, TEST_
DT and DATA_SOURCE.

If there is not an existing row on STDNT_TEST_COMP that matches on EMPLID,
 TEST_ID, TEST_COMP, TEST_DT, DATA_SOURCE, a new row is inserted.

From September 2020, when processing ACT CSV files make sure these entities are listed and activated
in Default Update Rule (DEFAULT_UPDATE_RULE):

• Test ID ACT Assessment (SCC_STG_TESTDT)

• Test Score (SCC_STG_TEST)

• Test Score Component (SCC_STG_TESTCMP)

If these entities aren’t included in Default Update Rule, then:

1. Go to Set Up SACR > System Administration > Entity > Entity Registry .

2. Search for each entity.

• Test ID ACT Assessment (SCC_STG_TESTDT)

• Test Score (SCC_STG_TEST)

• Test Score Component (SCC_STG_TESTCMP)

3. For each entity, click it to access its Entity Registry page.

4. Select Apply Data Update Rule.

5. From Actions, select Sync Entity.
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6. Click Save, then repeat steps 2 to 6 for the other entities.

7. Go to Set Up SACR >System Administration >Utilities >Constituent Transaction Mgmt >Data
Update Rule Entry, then click Search.

8. From the results, select Default Update Rule.

9. Click Refresh. You should see a message that the entities have been added.

10. While you’re on the Data Update Rule Entry page, locate Personal Details, Test ID ACT Assessment,
Test Score and Test Score Component.

11. For each entity, in Update Action, select Update/Insert.

12. Save your changes.

Setting Up Transaction
You must define a transaction for each PDL transaction you will be loading. For each prospect or test
score template Oracle delivers, transaction codes are also delivered.

This is an example of a delivered transaction code (1 of 2).
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This is an example of a delivered transaction code (2 of 2).

All PDL transactions should be set up with the Online Transaction check box cleared which sets the
Process Search/Match option to Batch automatically.

The following table lists the delivered transaction handler values for Prospect/Admissions Data Load
transactions. Use these values when defining a transaction handler for any new PDL transaction you may
define.

Root Package ID Path Application Class ID

SAD_PDL_PROCESS TRANSACTION DataLoadTransaction

The staging record name for PDL Transaction Status and Date should be set to SAD_PDL_HDR_STG.
This record stores the transaction status and transaction status date value for PDL transactions. You
should always use this value when defining any new PDL transaction.

The following table lists the delivered transaction handler values for processing the constituent data that is
loaded with your PDL transaction. Use these values when defining a constituent handler for any new PDL
transaction you define.
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Root Package ID Path Application Class ID

SCC_SL_TRANSACTION INTFC DefaultConstituent

All PDL transactions should be set to Partition by Transaction which creates one transaction record for
each constituent record.

The following table lists the delivered transaction data launch view settings for PDL transactions. You
should always use these values when defining the transaction data launch view settings for any new PDL
transaction you may create.

Menu Name Menu Bar Name Menu Item Name Menu Page Name

SAD_PDL_DATA_STAGE USE SAD_PDL_DATA_STG SAD_PDL_ACAD_INFO

On the Search/Match Setup tab, define the search parameter, search result code and action to take for each
search level that you want to use when processing your PDL transaction.

Setting Up CTM Transaction Security
Access the CTM Transaction Security page (Set Up SACR >Security >Secure Student
Administration >User ID >CTM Transaction Security).

This example illustrates the fields and controls on the CTM Transaction Security page.

The CTM Transaction Security page controls access to the Prospect/Admissions Staging and Constituent
Staging components under the Student Recruiting, Prospect/Admissions Data Mgmt menu.

For more information about the CTM Transaction Security page:

See "Setting Up CTM Transaction Security" (Campus Community Fundamentals)
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Understanding the Entity Registry Impacts
The system automatically creates an entity for a new test ID that you add through the Test Tables
component.

This is an example of the entity registry record that the system creates for the PTE test:

This image illustrates an Entity Registry example for PTE.

The system will assign a unique entity ID to each test ID that you set up. The Test Tables page will also
display this entity ID. The name assigned for each Test ID Entity will use the following name convention
<Test ID> <Description from Test Table>. The Description for each Test ID Entity will use the following
naming convention <Value entered for Test ID>: <Description from Test Table>.

See Defining External Tests
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Setting Up Common Attribute Framework
PDL is leveraging the Common Attribute Framework to enable you to store additional data loaded from
external data sources for test scores and prospects. Examples have been delivered but you may choose to
add additional attributes for the data you are loading.

For extending prospect career data, a record context has been delivered for ADM_PRSPCT_CAR and its
corresponding staging record SAD_PRS_CAR_STG.

This example illustrates the record context for prospect career.

For additional data you want to store for your prospect, define a common attribute and add it to the
ADM_PRSPCT_CAR record context.

To add common attributes to the ADM_PRSPCT_CAR record context:

1. Access the Record Context search page (Set Up SACR >Common Definitions >Common
Attributes Setup >Record Context).

2. Enter Record (Table) Name = ADM_PRSPCT_CAR.

3. Click Search.

4. In the Attributes section, add a row and populate the Common Attribute field for each common
attribute. Add a new row for each common attribute.
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5. Click Save.

Note: The “Delivered PDL Templates” section lists the common attributes delivered for each template.
The CFA attributes have already been added to ADM_PRSPCT_CAR. Add the remaining attributes to
ADM_PRSPCT_CAR for the templates you are planning to use.

See Delivered PDL Templates

To allow you to store additional test score data by test date, a record context has been delivered for
SAD_TESTDT and its corresponding staging record SCC_STG_TESTDT.

This example illustrates the record context for test date.

For additional data you want to store for your specific test, define a common attribute and add it to the
SAD_TESTDT record context. To add common attributes to the SAD_TESTDT record context:

1. Access the Record Context search page (Set Up SACR >Common Definitions >Common
Attributes Setup >Record Context).

2. Enter Record (Table) Name = SAD_TESTDT.

3. Click Search.
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4. In the Attributes section, add a row and populate the Common Attribute field for each common
attribute. Add a new row for each common attribute.

5. Click Save.

Note: The “Delivered PDL Templates” section lists the common attributes delivered for each template.
The IELTS and PTE attributes have already been added to SAD_TESTDT. Add the remaining attributes
to SAD_TESTDT for the templates you are planning to use.

See Delivered PDL Templates

Setting Up Filtering for Common Attributes
For each of the attributes you have added to the record context for SAD_TESTDT, you need to add the
Test ID that corresponds to the attribute. Doing so will then filter those attributes in the field search results
for that Test ID in the:

• Test Results group box of the Prospect/Admissions Staging - Academic Information page.

• Test Results pages.

This is an example of the Test Results group box when the user clicks the lookup button for Field in
Additional Test Values:
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This image illustrates an example of filtering based on Test ID in the Academic Information page.

This is an example of the Test Results page when the user clicks the lookup button for Field in Additional
Test Values:
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This image illustrates an example of filtering based on Test ID in the Test Results page.

For more information on Academic Information page:

See Reviewing and Editing Staged PDL Transactions

For more information on Test Results page:

See Tracking Supporting Information for Prospects and Applicants

You must perform the following steps in order to achieve this behavior of filtering based on Test ID:

1. Navigate to the Record Context search page (Set Up SACR >Common Definitions >Common
Attributes Setup >Record Context).

2. Enter SAD_TESTDT in the Record (Table) Name search field.

3. Click Search.

4. The Record Context page should look like this:
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This example illustrates the record context for SAD_TESTDT.

5. Expand the Entity Associations group box. The group box should look like this:

This example illustrates the Entity Associations group box.

6. For each of the Attributes defined to the record SAD_TESTDT, add the Entity Name that corresponds
to the value in the Common Attribute field. Entering Test ID in the Entity Name field and clicking the
lookup icon displays the results as shown in the following graphic:

Copyright © 1988, 2021, Oracle and/or its affiliates. 299



Managing PeopleSoft Prospect/Admissions Data Load Transactions Chapter 10

This example illustrates the Lookup results for the Entity Name field.

7. For all those attributes prefaced with IELTS, add the Entity Name Test ID International English:
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This example illustrates the Entity Name for IELTS.

8. Repeat the above step for the remaining attributes.

Note: Remember to use the correct Entity Name that corresponds to those common attributes.

9. Save your changes. When you save the changes, the system displays this message:

Please run Entity Property Sync process to update corresponding Entity Registry definitions. (14097,
56)

The record context data has changed. To keep corresponding Entity Registry definitions in sync please
run the Entity Property Sync process (Home > Setup SACR > System Administration > Entity > Entity
Property Sync)

10. In order for these changes to take full effect, you must complete the next steps and run both the Entity
Registry Sync and Cache Wipe processes.

11. Navigate to the Entity Property Sync component (Set Up SACR >System
Administration >Entity >Entity Property Sync).

This example illustrates the Entity Property Sync component (1 of 2).
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This example illustrates the Entity Property Sync component (2 of 2).

12. Click the Sync All Entity Properties button.

13. Clicking this button will initiate an Application Engine process that should take 5 - 10 minutes to
complete. Clicking the Refresh button will update the status of the Application Engine process (that
is, Queued, Processing, Success).

14. Once the process has completed successfully, click the Wipe Entity Cache button. This should take
between 3 - 5 minutes to complete. Upon completion, you should see the following message:

This example illustrates the confirmation message for Wipe Entity Cache process.

15. When the Wipe Entity Cache process has completed, you have successfully completed updating the
common attributes for test scores.

Note: If common attributes are changed, added or deleted, run the Entity Property Sync process (Set Up
SACR >System Administration >Entity >Entity Property Sync) to keep the corresponding Entity
Registry definitions in sync.

Setting Up Prospect Configuration

To configure the PDL Transactions, use the Prospect Configuration component (SAD_PDL_CONFIG).
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This section discusses how to:

• Map online PDL transactions to academic careers.

• Set up prospect defaults for PDL transactions.

• Set up 3C Event IDs to assign for each PDL transaction.

Pages Used to Set Up Prospect Configuration

Page Name Definition Name Navigation Usage

Prospect Config SAD_PDL_TRN_MAP Set Up SACR >Product
Related >Recruiting and
Admissions >Prospects >Prospect
Configuration >Prospect
Config

Map online PDL transactions
to academic careers.

Note: To be used for future
functionality. Do not set up at
this time.

Prospect Setup SAD_PDL_SETUP Set Up SACR >Product
Related >Recruiting and
Admissions >Prospects >Prospect
Configuration >Prospect
Setup

Define how the system should
assign a recruiting center to
a prospect. The system uses
this setup when you use File
Parser to load prospects in
batch via a calculated field.

3C Event ID Setup SAD_PDL_3C_SETUP Set Up SACR >Product
Related >Recruiting and
Admissions >Prospects >Prospect
Configuration >3C Event
ID Setup

Optional – Define a 3C
Event ID to assign for each
transaction code when the
transaction is processed.

Mapping Online Prospect/Admissions Data Load Transactions to Academic
Careers

Access the Prospect Config page (Set Up SACR >Product Related >Recruiting and
Admissions >Prospects >Prospect Configuration >Prospect Config).

This example illustrates the fields and controls on the Prospect Config page.

You can enter only online transactions in the Transaction field. PDL does not support online transactions
so you should not populate this page.
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Setting Up Prospect Defaults for Prospect/Admissions Data Load
Transactions

Access the Prospect Setup page (Set Up SACR >Product Related >Recruiting and
Admissions >Prospects >Prospect Configuration >Prospect Setup).

This example illustrates the fields and controls on the Prospect Setup page: Criteria tab. You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Prospect Setup page: Assigned Values tab. You can
find definitions for the fields and controls later on this page.

Ensure that all the academic career, program, and plan combinations for File Parser PDL transactions are
mapped to a valid recruiting center on the Prospect Setup page.

Use the Criteria tab to define the selecting criteria — such as academic career, academic program, and
academic plan — that will constitute a particular group of prospects. Use the Assigned Values tab to
define the recruiting center that the system can assign to the particular prospect group. For batch prospects
loaded through File Parser, a calculated field can be built on the file mapping definition to look at this
setup to determine the recruiting center to populate.

The system requires a recruiting center to create a prospect. Therefore, you must map each career with a
recruiting center on the Prospect Setup page to be used with a calculated field through File Parser unless
you define a default recruiting center on the File Parser mapping definition.

Criteria

Field or Control Description

Career Enter the career for which you want to assign a recruiting
center.

Program Optionally, enter the program for which you want to assign a
recruiting center.

Plan Optionally, if you have entered a program, enter the plan for
which you want to assign a recruiting center.
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Note: When determining the recruiting center assignment, the delivered calculated field example uses the
following order: academic plan, academic program, and academic career.

Assigned Values

Enter the recruiting center, recruiting status and referral source for the row entered on the Criteria tab.

Setting Up 3C Event IDs for Prospect/Admissions Data Load Transactions
Access the 3C Event ID Setup page (Set Up SACR >Product Related >Recruiting and
Admissions >Prospects >Prospect Configuration >3C Event ID Setup).

This example illustrates the fields and controls on the 3C Event ID Setup page. You can find definitions
for the fields and controls later on this page.

This is an optional setup. If you want to assign a 3C event ID for a specific transaction, set up this page.
The 3C event ID will be inserted into the 3C Trigger Results table upon posting the PDL transaction.

Only the event IDs that have the administrative functions GEN (General), PROS (prospect) and PROP
(prospect program) are available. Select an event ID for PROP only if you are certain you will be
populating prospect program. Define event IDs on the Event Definition page.

See "Defining 3C Engine Events" (Campus Community Fundamentals)

Setting Up File Parser for PDL

Use the Campus Community File Parser utility to load prospect/admissions data from a text file into
Campus Solutions.

Before You Begin
Before you begin setting up File Parser to load your external prospect or admissions data, there are a
few things that might be helpful to do. You may want to consider doing this with a spreadsheet or data
modeling tool:

• Review the external data to determine which staging records and fields will be populated. Utilize the
Entity Registry feature to get a clear understanding of the staging table hierarchy.

• Document each record to be populated, the fields within each record that will come from the external
data, and which fields need to be populated with default values. Utilize the AAWS Data Mapping and
Entity Catalog document or the Entity Registry component’s Entity Properties page to view each of
the staging records and their associated fields.
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• Determine which incoming fields will need to be converted to internal values.

• Document the non-required incoming data elements so you know which records need to have the Skip
if Blank check box selected for the mapped data element.

• Determine which fields require developing a calculated field. Examples include: Recruiting Center,
External Organization ID and Degree Description.

File Parser Setup
File Parser consists of several key components:

• Field Conversion Definitions – Identifies external file field values to convert before storing the data in
the target staging table.

• Context Definitions – Identifies the parent-to-child relationship of the staging tables that will be used
to hold the data.

• File Mapping Definitions – Associates fields on the external file with the records in the context
definition.

Important! Do not modify any of the delivered file mapping definition or file conversion definition
templates. Use the copy functionality to create a new version before you make modifications.

Make sure you enter a row for the required constituent (CTM) and Prospect/Admissions staging records
on the Context Definition page and the Mapping page of the File Mapping Definition component:

Required for all PDL transactions:

• SCC_STG_CONSTIT. Should be the first record. It is required to set the following fields, even
though they are not necessarily required in the record:

• SUBMITTED - Default to N.

• SCC_TRANSAC_CD - Default according to transaction setup.

• SCC_STG_STATUS - Default to LD (Loaded).

• SCC_STG_STATUS_DT - Default to %Date.

• SCC_SL_TRNMAP (Select the Force Insert check box.)

• SCC_STG_NAMES

• SCC_STG_PDE (Select the Force Insert check box if no incoming fields are mapped.)

• SCC_STG_PERSSA (Select the Force Insert check box if no incoming fields are mapped.)

• SAD_PDL_HDR_STG. It is required to set the following fields, even though they are not necessarily
required in the record:

• SCC_TRANSAC_CD – Default according to transaction setup.

• SAD_CRM_POST – Default to 1.
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• SCC_TRANS_STS – Default to SB (Submitted ) or SV (Saved) depending on your business
process.

• SCC_TRANS_STS_DT – Default to %Date.

Required if loading prospects:

• SCC_STG_STD_CAR

• SAD_PRS_CAR_STG

Required if loading test scores:

• SCC_STG_TEST

• SCC_STG_TESTCMP – Enter a row on the File Mapping Definition component for each test
component.

Warning! When using a file to upload data into the stage records, do not populate the EMPLID field with
a value that is not already created inside your production database. Doing so will cause the post process to
production tables to fail (the EMPLID value passed will not be used to create a new EMPLID). The same
is also true for the User ID (USERID field). The process will not create a User ID using the value entered
in the file.

Use the Field Conversion Definition page to define field values in the external file that must be converted
to internal values. Add any additional fields and complete the definition for the fields delivered.

This image shows an example of a field conversion definition.

See "Setting Up Field Conversion Definitions" (Campus Community Fundamentals).
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Use the Context Definition page to add the staging tables that need to be updated when loading data
from the external file. Ensure that you enter the correct value for the Parent Record field. For Prospect/
Admissions Data Load transactions, SCC_STG_CONSTIT must be the first record entered as it is the
parent to all records.

This image shows an example of a context definition.

See "Setting Up Context Definitions" (Campus Community Fundamentals).

For Prospect/Admissions Data transactions, you must include the following unique counter on the record
SCC_STG_CONSTIT: SCC_TEMP_ID: SCC_STG_CTRS.SCC_TEMP_ID.

Use the File Definition page to provide information about the external file.

This image shows an example of a file definition.
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Important! Changing the value in the Context Definition field will delete any existing setup on both the
File Layout and Mapping tabs. Do not change this value unless you want to start over with any setup you
have completed.

Use the File Layout page to define fields from the external file that will be loaded into the staging tables.
The fields should be entered in the exact order of the file layout you are loading. In addition, the Field
Type setting needs to be set to the same field type as that of the field you will be mapping it to. Set field
formats as needed for date fields and character fields.

This image shows an example of a file layout.

Use the Mapping page to associate fields defined on the File Layout page with staging table fields defined
in the context definition.
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This image shows an example of a file mapping.

For Prospect/Admissions data loads, the first record should always be SCC_STG_CONSTIT and the
second record should be SCC_SL_TRNMAP. Enter rows for other staging records you want to populate
in the proper parent-child relationship order.

There could be required description fields that may require a calculated field to populate. File Parser
does not populate the description based on the code populated. You must build a calculated field to load a
description. Examples of required description fields:

• Academic Interests - SCC_STG_ADMINT.DESCR

• Extracurricular Activities - SCC_STG_EXTRACU.DESCR

• External Degrees - SCC_STG_EXTDEGR.DESCR

You should also build calculated fields for LAST_NAME_SRCH and FIRST_NAME_SRCH on
SCC_STG_NAMES to remove all characters and spaces. Sample code is available in the Campus
Community – File Parser documentation.

See "Commonly Used Calculated Mapping Application Class Objects" (Campus Community
Fundamentals).

Use the Preview Data page to test your external file with the file parser definitions.

Note: The preview feature shows only the first row of each row type; therefore, you should use a small
test file when using this component. Using a large test file is simply a waste of resources that could
potentially degrade the application server.
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This image shows an example of previewing data.

Related Links
"Setting Up File Mapping Definitions" (Campus Community Fundamentals)

Running the File Parser Process
Access the Run File Parser page (Set Up SACR > System Administration > Utilities > File Parser >
Run File Parser).

Run the File Parser process to load the prospect/admissions data from a text file into the staging
tables. Each record is loaded as a PDL transaction based on the default transaction code defaulted on
SCC_STG_CONSTIT and SAD_PDL_HDR_STG on the Mapping page.
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This image shows an example of a Run File Parser page.

From September 2020, before you run the process for ACT CSV files, it’s recommended that you remove
the header row in the CSV file, save, then upload the file.

Otherwise, you can do this:

1. Go to Set Up SACR >System Administration >Utilities >File Parser >File Mapping Definition.

2. Select Multiple Row Types.

3. Provide values for these fields:

• Name: Header

• Section ID Value: Enter your school code.

• Field Number: 4

Related Links
"Running the File Parser Process" (Campus Community Fundamentals)

Reviewing and Editing Staged PDL Transactions

After loading the PDL data into the staging tables, review the staged constituent and prospect/admissions
data. To review and edit the PDL transactions, use the Prospect/Admissions Staging component
(SAD_PDL_DATA_STG).

This section discusses:

• Impact of CTM transaction security on navigation.

• Header on the Prospect/Admissions staging pages.

• Reviewing academic data and error messages.

• Reviewing education history.

• Reviewing prospect data.

Copyright © 1988, 2021, Oracle and/or its affiliates. 313



Managing PeopleSoft Prospect/Admissions Data Load Transactions Chapter 10

• Reviewing general materials and attachments.

Pages Used to Review and Edit Staged PDL Transactions

Page Name Definition Name Navigation Usage

Academic Information SAD_PDL_ACAD_INFO Student
Recruiting >Prospect/
Admissions Data
Mgmt >Prospect/
Admissions
Staging >Academic
Information

Review the error messages
pertaining to the PDL
transaction in the staging
record.

Review and edit the additional
academic information
pertaining to the PDL
transaction in the staging
record. Additional academic
information includes test
results, additional test data
using the Common Attribute
Framework and academic
interests.

Education History SAD_PDL_EDUC_HIST Student
Recruiting >Prospect/
Admissions Data
Mgmt >Prospect/
Admissions
Staging >Education History

Review and edit the education
history pertaining to the PDL
transaction in the staging
record. Education history
includes information such
as schools attended and
degrees that are in progress or
completed.

Prospect Data SAD_PDL_PROS_DATA Student
Recruiting >Prospect/
Admissions Data
Mgmt >Prospect/
Admissions
Staging >Prospect Data

Review and edit the prospect
data pertaining to the PDL
transaction in the staging
record.

Prospect data includes
prospect career, program, plan
and subplan data in addition
to additional prospect data
using the Common Attribute
Framework. Recruiting
categories and recruiters are
also included.

Supplementation Information SAD_PDL_GEN_MATL Student
Recruiting >Prospect/
Admissions Data
Mgmt >Prospect/
Admissions
Staging >Supplementation
Information

Review and edit the
supplemental information
pertaining to the PDL
transaction in the staging
record. Supplemental
information includes general
materials and general
materials attachments.
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Impact of CTM Transaction Security on Navigation
One of the methods to navigate to the Prospect/Admissions Staging component is by clicking the
<transaction name> link on the Constituent Staging component. There are two ways to access the
Constituent Staging component:

• Campus Community menu path navigation (Campus Community >Constituent Transaction
Mgmt >Constituent Staging).

• Student Recruiting menu path navigation (Student Recruiting >Prospect/Admissions Data
Mgmt > Constituent Staging).

If you use the Campus Community menu path navigation and if your user ID is not associated with a
particular transaction code, you cannot access the PDL data associated with that transaction code.

However, you can see the transaction that exists for the constituent. In the following example, a user can
see there is a PDL transaction for the constituent. However, the user cannot view the PDL data because
the <Transaction Name> link is disabled. The system has disabled the link because the user does not have
access to the transaction code.

This image shows an example of the transaction link disabled for a user who does not have transaction
code access.

If you use the Student Recruiting menu path navigation and if your user ID is not associated with a
particular transaction, you cannot see how many transactions associated with the transaction code exist.
Also, you cannot view the PDL data associated with the transaction code. Therefore, the system strictly
enforces the transaction security for the Student Recruiting menu as compared to Campus Community
menu where the security is not enforced. In the following example, a user cannot see whether there is a
PDL transaction for the constituent because the user does not have access to the transaction code.
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This image shows hidden search results for a user who does not have the transaction code access.

Header on the Prospect/Admissions Staging Pages
The header region on all the pages of the Prospect/Admissions Staging component is similar to the
header region on the Constituent Staging component pages. This region includes options to modify the
constituent status, run Search/Match/Post process or post a transaction.

Here is an example of the header region on a Prospect/Admissions Staging component page:
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Field or Control Description

Constituent Staging Click this link to access the Constituent Staging component
that contains all the pertinent person information.

Reviewing Academic Information Data and Error Messages
Access the Academic Information Page (Student Recruiting >Prospect/Admissions Data
Mgmt >Prospect/Admissions Staging >Academic Information ).

This example illustrates the fields and controls on the Academic Information page (1 of 2). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Academic Information page (2 of 2). You can find
definitions for the fields and controls later on this page.

Field or Control Description

Application Errors Errors related to the transaction data will appear here only
after the Transaction Management process has been run or if
the data on the component has been manually changed and
saved.

Set Status to Submitted This button only appears if the transaction status is Posted.

If you have inadvertently posted the transaction data to a
wrong ID, click the Set Status to Submitted button. On
clicking the button, the system sets the transaction status
back to Submitted. For example, you may notice that test
scores were posted to a new ID but you should have posted
for an existing ID. To repost the test scores to the existing ID,
 perform the following steps:

1. Click the Set Status to Submitted button and save the
record.

2. Click the Set to Update ID button and select the existing
ID.

3. Click the Run Search/Match/Post button to post the
transaction.

The following table describes the transaction statuses:
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Transaction Status Description

Saved This status indicates that system has saved the PDL transaction
to the staging records and the transaction is not ready to be
processed.

You can manually set this status if you want to indicate that the
PDL transaction is not ready for processing.

When setting up the file mapping definition, you must
define the default value that File Parser should assign as the
transaction status on SAD_PDL_HDR_STG.

Submitted This status indicates that system has submitted the PDL
transaction to the staging records and the transaction is ready
to be processed.

You can manually set this status if you want to indicate that
the PDL transaction is ready for processing. You cannot post
Saved transactions; only transactions with Submitted status can
be posted.

When setting up the file mapping definition, you must
define the default value that File Parser should assign as the
transaction status on SAD_PDL_HDR_STG.

Saved Error This status indicates that the system encountered problems
when saving a PDL transaction. You must resolve these errors
before the transaction can be posted.

You cannot manually change this status. When you resolve the
error and save the staging record, the system automatically sets
the status back to Saved.

Submit Error This status indicates that the system encountered problems
when submitting a PDL transaction. You must resolve these
errors before the transaction can be posted.

You cannot manually change this status. When you resolve the
error and save the staging record, the system automatically sets
the status back to Submitted.

Posted This status indicates that the system has posted the data. The
system runs the posting process when you click the Post
Transaction Data button or the Run Search/Match/Post
button, or when you run the Transaction Management process.
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Field or Control Description

Additional Test Data Enables you to store additional test score data that does not
have a home in the core Campus Solutions records. Populate
this section by test date with Common Attribute values defined
within the Common Attribute Framework. The prompts in the
Field column will display attributes associated on the record
context for SAD_TESTDT.

Academic Interests Academic interests can only be populated if the Prospect Data
page is populated.

Reviewing Education History
Access the Education History page (Student Recruiting >Prospect/Admissions Data
Mgmt >Prospect/Admissions Staging >Education History).

This example illustrates the fields and controls on the Education History page.
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Reviewing Prospect Data
Access the Prospect Data page (Student Recruiting >Prospect/Admissions Data Mgmt >Prospect/
Admissions Staging >Prospect Data).

This example illustrates the fields and controls on the Prospect Data page (1 of 2) . You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Prospect Data page (2 of 2) . You can find
definitions for the fields and controls later on this page.

Field or Control Description

Additional Prospect Data Enables you to store additional prospect data that does not
have a home in the core prospect records. Populate this section
with values for common attributes defined within the Common
Attribute Framework. The prompts in the Field column will
display attributes associated on the record context for ADM_
PRSPCT_CAR.
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Reviewing General Materials
Access the Supplemental Information page (Student Recruiting >Prospect/Admissions Data
Mgmt >Prospect/Admissions Staging >Supplemental Information).

This example illustrates the fields and controls on the Supplemental Information page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

File Attachments File attachments can only be attached manually to this page.
 File Parser does not support loading file attachments.
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Posting PDL Transactions

After loading the PDL data into the staging tables, review the staged constituent and prospect/admissions
data. Then, run the CTM Transaction Management process to search/match and post the staged data into
the production tables of the Campus Solutions database. This process will also determine if any errors
exist in the data being posted. If there are errors, the Constituent Staging Status is set to Error and the
errors are displayed on the Constituent Staging (CTM) and Prospect/Admissions Staging components.
Return to the Constituent Staging component and search for the transactions you are processing which
have errors.

This example illustrates the fields and controls on an example of searching for transactions on the
Constituent Staging page.

Correct the errors indicated on each transaction. Then, run the Transaction Management process again to
post these records.

Depending on the transaction and your business processes, the manner in which you post the staged data
may vary. A couple examples of how you might go about this are listed below.

Processing Steps for Posting all Staged Data for a Specific Transaction
1. Run the File Parser process to populate staging records based on incoming data file.
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Set SAD_PDL_HDR_STG.SCC_TRANS_STS = SB (Submitted).

2. Run the Transaction Management process to perform search/match and post staging data for the
transaction loaded.

Set the ID Selection field to All Person Temporary IDs. Select the Process Submitted Transactions,
Run Search Match, Post Constituent, and Post Transaction Data check boxes. On clicking the Run
button, the Process Scheduler Request page appears. Select the Prospect Data Load – SMP process on
this page.

This example illustrates the fields and controls on the Selection Parameters page when posting all data
for a transaction.

This example illustrates the fields and controls on the Process Scheduler Request page when running
the Prospect Data Load – SMP process.

3. Review staging records not posted based on search/match rules or validation errors.

Determine if new record should be created or existing record updated. Correct errors and save.
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4. Manually post individual records or run the Transaction Management process again to post remaining
records that were reviewed.

Processing Steps for Posting a Subset of Staged Data for a Specific
Transaction

Let’s say you only want to post test scores for those persons who received a minimum scores on a test you
have loaded.

1. Run the File Parser process to populate staging records based on incoming data file.

Set SAD_PDL_HDR_STG.SCC_TRANS_STS = SB (Submitted).

2. Build a query in Query Manager to select your population based on your criteria defined.

The Pop Select Bind Record of SCC_SL_SMP_RQ must be the first record in your query and
SCC_TEMP_ID must be the first field returned in the query results. Add other staging records as
needed to select your population. Test your query to make sure the correct population is returned.

This example illustrates the fields and controls on the Query page for chosen records.
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This example illustrates the fields and controls on the Criteria page of Query Manager.

3. Run the Transaction Management process to perform search/match and post staging data for the
transaction loaded.

Set the ID Selection field to Population Selection. Select the Process Submitted Transactions, Run
Search Match, Post Constituent, and Post Transaction Data check boxes. In the Population Selection
section, enter PS Query in the Selection Tool field and select the query name defined in Step 2. Test
your results once again before running the process. On clicking the Run button, the Process Scheduler
Request page appears. Select the Prospect Data Load – SMP process on this page.

This example illustrates the fields and controls on the Selection Parameters page when posting a
subset of test takers for a transaction.

4. Review staging records not posted based on search/match rules or validation errors.
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Determine if new record should be created or existing record updated. Correct errors and save.

5. Manually post individual records or run the Transaction Management process again to post remaining
records that were reviewed.

Processing Steps for Posting All Test Scores But Create Prospects for Only
a Subset of the Test Takers for a Specific Transaction

Let’s say you want to post test scores for all test takers who sent you scores but you only want to create
prospects for a subset of those test takers.

1. Run the File Parser process to populate staging records based on incoming data file.

Set the SAD_PDL_HDR_STG.SCC_TRANS_STS = SV (Saved). Set up your File Parser mapping
definition to populate the appropriate prospect staging records as well as the test results staging
records.

2. Build a query in Query Manager to select your prospect population based on your criteria defined.

The Pop Select Bind Record of SCC_SL_SMP_RQ must be the first record in your query and
SCC_TEMP_ID must be the first field returned in the query results. Add other staging records as
needed to select your population. Test your query to make sure the correct population is returned.

3. Run the Transaction Management process to perform search/match and post staging data for the
transaction loaded.

Set the ID Selection field to All Person Temporary IDs. Select the Process Saved Transactions, Run
Search Match, and Post Constituent check boxes. On clicking the Run button, the Process Scheduler
Request page appears. Select the Prospect Data Load – SMP process on this page. Running this
process with these settings will run search/match and post the constituent data ONLY for these saved
records. Test results are considered part of constituent data therefore test scores will be posted for
everyone. The status of the transaction will remain at Saved. Staged prospect data will not post at this
point.

This example illustrates the fields and controls on the Selection Parameters page when posting all test
data for a transaction.
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4. Review staging records not posted based on search/match rules or validation errors.

Determine if new record should be created or existing record updated. Correct errors and save.

5. Manually post individual records or run the Transaction Management process again to post remaining
records that were reviewed using the same criteria as above.

6. Once you have posted all test data, run the Transaction Management process again to post the
prospect data for your selected population.

Set the ID Selection field to Population Selection. Select the Process Saved Transaction, Run Search
Match, Update Status to Submitted, Post Constituent, and Post Transaction Data check boxes. On
clicking the Run button, the Process Scheduler Request page appears. Select the Prospect Data Load
– SMP process on this page. Running this process with these settings will post the prospect data for
only those records selected in the query. The status of the transaction for those selected will be set to
Posted.

This example illustrates the fields and controls on the Selection Parameters page when creating
prospects for a subset of test takers for a transaction.

Note: If the prospect record already exists for the institution and career of the transaction, the system
updates the prospect record to insert program and plan data that does not exist, and also inserts values
for the Admit Term, Admit Type, Campus, Academic Load, Academic Level, Referral Source, Source
Date, Region, Region From, Housing Interest, Financial Aid Interest, Last School Attended and
Graduation Date fields if not previously populated.

Commonly Used PDL Calculated Mapping Application Class
Objects

This section discusses how to derive:
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• Recruiting center.

• Academic interests – description.

For additional commonly used calculated mapping application class objects, see "Commonly Used
Calculated Mapping Application Class Objects" (Campus Community Fundamentals)

Recruiting Center
import SCC_FILE_PARSER:MODEL:Results:ResultsField;
import SCC_FILE_PARSER:MODEL:Results:ResultsRecord;
import SCC_FILE_PARSER:UTIL:FieldCalculationAbstract;
import SCC_FILE_PARSER:MODEL:Results:ResultsCollection;
import SCC_FILE_PARSER:UTIL:Exception:FileParserException;

/**
  *  class Recruiting_Center
  *
  *  @version 1.0
  *  @author Campus Solutions
  *
  *  Module: Campus Community / Common
  *  Description:
  */

class Recruiting_Center extends SCC_FILE_PARSER:UTIL:FieldCalculationAbstract
   /* public methods */

   method Recruiting_Center();
   method  calculateValue(&ResultsFieldIn As SCC_FILE_PARSER:MODEL:Results:ResultsF⇒

ield, &ResultsCollectionIn As SCC_FILE_PARSER:MODEL:Results:ResultsCollection) Retu⇒

rns any;

private
   method GetFileData();
   method GetFieldReferences();

   instance string &adm_recr_ctrOut;
   instance string &RecruitingCenter;

   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &ResultsField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsCollection &ResultsCollection;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &InstitutionField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &CareerField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &ProgramField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &PlanField;

end-class;

/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method obtains the Recruiting Center based on incoming data.
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     */

method Recruiting_Center

   %Super = create SCC_FILE_PARSER:UTIL:FieldCalculationAbstract();

end-method;
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/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method is the driver for deriving the Recruiting Center
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     */

method calculateValue
   /+ &ResultsFieldIn as SCC_FILE_PARSER:MODEL:Results:ResultsField, +/
   /+ &ResultsCollectionIn as SCC_FILE_PARSER:MODEL:Results:ResultsCollection +/
   /+ Returns Any +/
   /+ Extends/implements SCC_FILE_PARSER:UTIL:FieldCalculationAbstract.CalculateVal⇒

ue +/

   &ResultsCollection = &ResultsCollectionIn;
   &ResultsField = &ResultsFieldIn;

   %This.GetFileData();

   &RecruitingCenter = &adm_recr_ctrOut;

   Return &RecruitingCenter;

end-method;

/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method gets the Institution, Career, Program, and Plan from
     * the incoming data. Based on what data was supplied, there is an
     * iterative approach to obtaining the Recruiting Center
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     */

method GetFileData
   Local string &Institution, &Career, &Program, &Plan, &adm_recr_ctr;

   %This.GetFieldReferences();

   &Institution = "";
   If &InstitutionField <> Null Then
      &Institution = &InstitutionField.FieldValue;
   End-If;

   &Career = "";
   If &CareerField <> Null Then
      &Career = &CareerField.FieldValue;
   End-If;

   &Program = "";
   If &ProgramField <> Null Then
      &Program = &ProgramField.FieldValue;
   End-If;

   &Plan = "";
   If &PlanField <> Null Then
      &Plan = &PlanField.FieldValue;
   End-If;

   &adm_recr_ctr = "";
   If All(&Institution, &Career, &Program, &Plan) Then
      SQLExec("SELECT ADM_RECR_CTR FROM PS_SAD_PDL_SETUP WHERE INSTITUTION = :1 AND⇒

 ACAD_CAREER = :2 AND ACAD_PROG = :3 AND ACAD_PLAN = :4", &Institution, &Career, &P⇒

rogram, &Plan, &adm_recr_ctr);
   End-If;
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   If &adm_recr_ctr = "" Then
      If All(&Institution, &Career, &Program) Then
         &Plan = " ";

         SQLExec("SELECT ADM_RECR_CTR FROM PS_SAD_PDL_SETUP WHERE INSTITUTION = :1 ⇒

AND ACAD_CAREER = :2 AND ACAD_PROG = :3 AND ACAD_PLAN = :4", &Institution, &Career,⇒

 &Program, &Plan, &adm_recr_ctr);
      End-If;
   End-If;

   If &adm_recr_ctr = "" Then
      If All(&Institution, &Career) Then
         &Program = " ";
         &Plan = " ";

         SQLExec("SELECT ADM_RECR_CTR FROM PS_SAD_PDL_SETUP WHERE INSTITUTION = :1 ⇒

AND ACAD_CAREER = :2 AND ACAD_PROG = :3 AND ACAD_PLAN = :4", &Institution, &Career,⇒

 &Program, &Plan, &adm_recr_ctr);
      End-If;
   End-If;

   &adm_recr_ctrOut = &adm_recr_ctr;

end-method;

/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method obtains the Institution, Academic Career, Program and
     * Plan - if available.
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     */

method GetFieldReferences

   Local integer &SegmentNbr;
   Local integer &RowNbr = 1;

   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SAD_PRS_CAR_STG;
   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SAD_PRS_PRG_STG;
   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SAD_PRS_PLN_STG;

   &SegmentNbr = &ResultsField.ResultsRecord.SegmentNbr;

   &obj_SAD_PRS_CAR_STG = &ResultsCollection.GetResultsRecord(&SegmentNbr, "SAD_PRS⇒

_CAR_STG", &RowNbr);
   &obj_SAD_PRS_PRG_STG = &ResultsCollection.GetResultsRecord(&SegmentNbr, "SAD_PRS⇒

_PRG_STG", &RowNbr);
   &obj_SAD_PRS_PLN_STG = &ResultsCollection.GetResultsRecord(&SegmentNbr, "SAD_PRS⇒

_PLN_STG", &RowNbr);

   If &obj_SAD_PRS_CAR_STG <> Null Then
      &InstitutionField = &obj_SAD_PRS_CAR_STG.GetResultsField("INSTITUTION");

      &CareerField = &obj_SAD_PRS_CAR_STG.GetResultsField("ACAD_CAREER");
   End-If;

   If &obj_SAD_PRS_PRG_STG <> Null Then
      &ProgramField = &obj_SAD_PRS_PRG_STG.GetResultsField("ACAD_PROG");
   End-If;
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   If &obj_SAD_PRS_PLN_STG <> Null Then
      &PlanField = &obj_SAD_PRS_PLN_STG.GetResultsField("ACAD_PLAN");
   End-If;

end-method;

Academic Interests – Description
import SCC_FILE_PARSER:UTIL:FieldCalculationAbstract;
import SCC_FILE_PARSER:MODEL:Results:ResultsField;
import SCC_FILE_PARSER:MODEL:Results:ResultsRecord;
import SCC_FILE_PARSER:MODEL:Results:ResultsCollection;
import SCC_FILE_PARSER:UTIL:Exception:FileParserException;

/**
  *  class FetchSubjectDescr
  *
  *  @version 1.0
  *  @author Campus Solutions
  *
  *  Module: Recruiting and Admissions / Common App.
  *  Description:
  */

class FetchSubjectDescr extends SCC_FILE_PARSER:UTIL:FieldCalculationAbstract
   /* public methods */

   method FetchSubjectDescr();
   method calculateValue(&ResultsFieldIn As SCC_FILE_PARSER:MODEL:Results:ResultsFi⇒

eld, &ResultsCollectionIn As SCC_FILE_PARSER:MODEL:Results:ResultsCollection) Retur⇒

ns any;

private
   method GetFileData();
   method GetFieldReferences();

   instance string &SubjectArea;
   instance string &SubjectAreaDescrOut;

   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &ResultsField;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsCollection &ResultsCollection;
   instance SCC_FILE_PARSER:MODEL:Results:ResultsField &SubjectAreaField;

end-class;

/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method obtains the Subject Description based on incoming data.
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     */

method FetchSubjectDescr

   %Super = create SCC_FILE_PARSER:UTIL:FieldCalculationAbstract();

end-method;

/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method is the driver for deriving the Subject Description.
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
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     */

method calculateValue
   /+ &ResultsFieldIn as SCC_FILE_PARSER:MODEL:Results:ResultsField, +/
   /+ &ResultsCollectionIn as SCC_FILE_PARSER:MODEL:Results:ResultsCollection +/
   /+ Returns Any +/
   /+ Extends/implements SCC_FILE_PARSER:UTIL:FieldCalculationAbstract.CalculateVal⇒

ue +/

   &ResultsCollection = &ResultsCollectionIn;
   &ResultsField = &ResultsFieldIn;

   %This.GetFileData();

   Return &SubjectAreaDescrOut;

end-method;

/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method obtains the Subject Description based on incoming
     * Subject Area.
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     */

method GetFileData

   Local string &SubjectAreaDescr;

   If &SubjectAreaField = Null Then
      %This.GetFieldReferences();
   End-If;

   &SubjectArea = "";

   If &SubjectAreaField <> Null Then
      &SubjectArea = &SubjectAreaField.FieldValue;

      SQLExec("SELECT A.DESCR FROM PS_EXT_SUBJECT_TBL A WHERE A.EXT_SUBJECT_AREA =:⇒

1 AND A.EFF_STATUS = 'A' AND A.EFFDT = (SELECT MAX(A1.EFFDT) FROM PS_EXT_SUBJECT_TB⇒

L A1 WHERE A1.EXT_SUBJECT_AREA = A.EXT_SUBJECT_AREA AND A1.EFFDT <= %DateIn(:2))", ⇒

&SubjectArea, %Date, &SubjectAreaDescr);

      If &SubjectAreaDescr = "" Then
         &SubjectAreaDescrOut = "NOT FOUND";
      Else
         &SubjectAreaDescrOut = &SubjectAreaDescr;
      End-If;
   End-If;

end-method;

/**
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     *
     * This method obtains the Subject Area from the incoming data.
     *
     * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
     */

method GetFieldReferences

   Local integer &SegmentNbr;
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   Local integer &RecordRow;

   Local SCC_FILE_PARSER:MODEL:Results:ResultsRecord &obj_SCC_STG_ADMINT;

   &SegmentNbr = &ResultsField.ResultsRecord.SegmentNbr;
   &RecordRow = &ResultsField.ResultsRecord.RecordRow;

   &obj_SCC_STG_ADMINT = &ResultsCollection.GetResultsRecord(&SegmentNbr, "SCC_STG_⇒

ADMINT", &RecordRow);

   If &obj_SCC_STG_ADMINT <> Null Then
      &SubjectAreaField = &obj_SCC_STG_ADMINT.GetResultsField("EXT_SUBJECT_AREA");
   End-If;

end-method;

Delivered PDL Templates

This section provides additional information about each of the templates Oracle delivers for you to use
with Prospect/Admissions data loads.

This section discusses the templates for:

• College Fair Automation (CFA)

• International English Language Testing System (IELTS)

• Pearson Test of English (PTE)

• Test Of English as a Foreign Language (TOEFL)

• Graduate Management Admission Test (GMAT)

• Graduate Record Examinations (GRE)

• Educational Opportunity Service (EOS)

• American College Testing (ACT)

• Advanced Placement (AP)

• Law School Admission Test (LSAT)

• Student Search Service (SSS)

• Scholastic Aptitude Test (SAT)

College Fair Automation (CFA)

Delivered Transaction Code: SAD_CFA

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.
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• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_CFA

Conversion examples have been delivered for the following fields:

• Academic Plan based on incoming AcademicInterestCD1 values.

• Academic Program based on incoming AcademicInterestCD1 values.

• Citizenship Status based on incoming Citizenship values.

• Ethnicity based on incoming Ethnicity values.

• Admit Type based on incoming FreshmanTransfer values.

• Admit Term based on incoming StartingTerm values.

Each of these conversions will need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.

Context Definition Template: SAD_CFA

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_CFA_PROSPECTS

This file mapping definition can be used to create prospects and populate supporting data such as
academic interests and extracurricular activities. You will need to make changes to this delivered template
to reflect institution defined default values. Before doing so, make a copy of the delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_CFA. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Depending upon which college fair (NACAC, Regional, and so on) you are loading
data for, the file layout may differ from the layout defined. Review this tab to ensure the fields appear in
the exact order as that of the CFA layout you are using. Modify default values on the Date Day and Date
Month columns for the field HSGradYear.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:
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• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE – Two rows

• SCC_STG_EXTRACU.INSTITUTION – Twelve rows

• SCC_STG_STD_CAR.ACAD_CAREER

• SAD_PRS_CAR_STG.ACAD_CAREER

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_STG_PRS_CAF.ACAD_CAREER – Seven rows

• SAD_STG_PRS_CAF.INSTITUTION – Seven rows

• SCC_STG_ADMIHD.ACAD_CAREER

• SCC_STG_ADMINT.ACAD_CAREER – Three rows

Calculated Fields: The following calculated fields have been delivered for CFA:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

• SAD_PRS_CAR_STG. LAST_SCH_ATTEND - Uses the incoming value from CEEBCode to
determine the EXT_ORG_ID to populate based on the EXT_ORG_TBL_ADM.ATP_CODE.

• SAD_PRS_PRG_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

• SCC_STG_ACADHST.EXT_ORG_ID - Uses the incoming value from CEEBCode to determine the
EXT_ORG_ID to populate based on the EXT_ORG_TBL_ADM.ATP_CODE.

Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated:

• CFA_CLASSRANK for ClassRank
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• CFA_PARENTSCOLLEGE for ParentSiblingCollege

• CFA_PARENTSGRAD for ParentsGrad

• CFA_SCHLINOUTSTPREF for SchoolInOutOfState

• CFA_SCHLSETTINGPREF for SchoolSetting

• CFA_SCHLSIZEPREF for SchoolSize

• CFA_TEXTOK for TextOK

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. In addition to creating the common attribute and adding them to the record context
for ADM_PRSPCT_CAR, you will need to add rows for each common attribute on the File Mapping
Definition component. Additional fields that were not mapped include:

• Religion

• TransferFrom

• LastCompletedSemester

• SocialMediaLink

• CanMessage

• DrivingTime

• RateSchoolSetting

• RateSchoolInOutOfState

• RateSchoolSize

• RateSDrivingTime

International English Language Testing System (IELTS)

Delivered Transaction Code: SAD_IELTS

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template:

Not needed
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Context Definition Template: SAD_IELTS

Review the delivered template and determine if any records need to be added. Modify this delivered
definition. It will be used on the File Mapping Definition component. Create a copy before doing so to
keep an original version. If you choose to use a copy of a delivered context definition and reference the
copied version in your file mapping definition, the system forces you to redefine the file layout and file
mapping setup.

File Mapping Definition Template: SAD_IELTS_TESTRESULTS

This file mapping definition can be used to post IELTS test scores. You will need to make changes to
this delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_IELTS. If you change this, all the file layout and
mapping setup will disappear.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the IELTS layout
you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_COMPONENT – Five rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Five rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Six rows

Calculated Fields: The following calculated fields have been delivered for IELTS:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_TESTCMP.SCORE - Looks at the incoming score value for ListeningTestScore,
ReadingTestScore, WritingTestScore, SpeakingTestScore or OverallScore (depending on the
application class ID populated). If the incoming value is 0 or -1, population of the row is skipped.
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Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated:

• IELTS_DOWNLOADID for DownloadID

• IELTS_PARTNO for PartNo

• IELTS_CENTRENUMBER for CentreNumber

• IELTS_CANDIDATENUMBR for CandidateNumber

• IELTS_CANDIDATEID for CandidateID

• IELTS_TRFNUMBER for TRFNumber

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT record context. In addition to
creating the common attribute and adding them to the record context, you will need to add rows for each
common attribute on the File Mapping Definition component. Additional fields that were not mapped
include:

• StartDate

• EndDate

To complete the setup for the delivered common attributes, see Setting Up Filtering for Common
Attributes.

Pearson Test of English (PTE)

Delivered Transaction Code: SAD_PTE

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_PTE

Conversion examples have been delivered for the following fields:

• Academic Career based on incoming Program Receiving Scores values.

• Academic Plan based on incoming Program Receiving Scores values.

• Academic Program based on incoming Program Receiving Scores values.

• STATE/PROVINCE/COUNTY based on incoming Country Of Residence and State/Province/County
values. Used with a delivered calculated field.

Each of these conversions will need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.
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Context Definition Template: SAD_PTE

Review the delivered template and determine if any records need to be added. Modify this delivered
definition. It will be used on the File Mapping Definition component. Create a copy before doing so to
keep an original version. If you choose to use a copy of a delivered context definition and reference the
copied version in your file mapping definition, the system forces you to redefine the file layout and file
mapping setup.

File Mapping Definition Template: SAD_PTE_TESTRESULTS

This file mapping definition can be used to post PTE test scores only. You will need to make changes to
this delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_PTE. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the PTE layout
you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE – Two rows

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_COMPONENT – Eleven rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Eleven rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Five rows

Calculated Fields: The following calculated fields have been delivered for PTE:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.
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• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.STATE - Concatenates the incoming values for Country of Residence and State/
Province/County and compares them to the Field Conversion Definition for STATE/PROVINCE/
COUNTY to determine the value to populate.

File Mapping Definition Template: SAD_PTE_TESTPROSPECT

This file mapping definition can be used to post PTE test scores and create a prospect record. You will
need to make changes to this delivered template to reflect institution defined default values. Before doing
so, make a copy of the delivered template.

File Definition Tab: Modify context definition and conversion definition to those you have created.
Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the PTE layout
you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices.

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE – Two rows

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_COMPONENT – Eleven rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE– Eleven rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Five rows

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PLN_STG.INSTITUTION

Calculated Fields: The following calculated fields have been delivered for PTE:
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• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.STATE - Concatenates the incoming values for the Country of Residence and
State/Province/County fields and compares them to the field conversion definition for STATE/
PROVINCE/COUNTY to determine the value to populate.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated:

• PTE_DTSCORESAVAIL for Date Scores Available To Program

• PTE_FIRSTTIMETESTTKR for First-Time Test Taker

• PTE_PROGRECSCORES for Program Receiving Scores

• PTE_REGISTRATIONID for Registration Id

• PTE_SCORESVALIDUNTIL for Scores Valid Until

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT record context. In addition to
creating the common attribute and adding them to the record context, you will need to add rows for each
common attribute on the File Mapping Definition component. Additional fields that were not mapped
include: Irregularity Code

To complete the setup for the delivered common attributes, see Setting Up Filtering for Common
Attributes.

Test Of English as a Foreign Language (TOEFL)

Delivered Transaction Code: SAD_TOEFL

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_TOEFL

Conversion examples have been delivered for the following fields:

• Gender based on incoming Gender values.
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• Language Code based on incoming Native Language Code values.

• Academic Career based on incoming Department Code values.

Each of these conversions may need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.

Note: Not all Native Language Code values have been mapped. The following incoming language codes
are not mapped: AKA (Akan), ALB (Albanian), ASM (Assamese), AZE (Azerbaijani), BAM (Bambara),
BAK (Bashkir), BAQ (Basque), BEL (Belarusian), BEN (Bemba), BER (Berber), BIK (Bikol), BOS
(Bosnian), CAT (Catalan), CEB (Cebuano), NYA (Chichewa (Nyanja)), CHV (Chuvash), DYU (Dyula),
EFI (Efik), EST (Estonian), EWE (Ewe), FIJ (Fijian), FIN (Finnish), FUL (Fulah), GAA (Ga), GLA
(Galician), LUG (Ganda), GEO(Georgian), GRN (Guarani), GUJ (Gujarati), GWI (Gwichin), HAU
(Hausa), HIL (Hiligaynon), IBO (Igbo), ILO (Iloko), IPK (Inupiaq), JAV (Javanese), KAU (Kanuri),
KAS (Kashmiri), KAZ (Kazakh), KHM (Khmer), KIK (Kikuyu), KIN (Kinyarwanda), KOS (Kosraean),
KUR (Kurdish), KUS (Kusaiean), LIN (Lingala), LUA (Luba-Lulua), LUO (Luo), LTZ (Luzembourgish),
MAC (Macedonian), MAD (Madurese), MLG (Malagasy), MAL (Malayalam), MLT (Maltese),
MAN (Mandingo), MAR (Marathi), MAH (Marshallese), MEN (Mende), MIN (Minangkabau), MON
(Mongolian), MOS (Mossi), NAU (Nauru), NEP (Nepali), ORI (Orlya), ORM (Oromo), PAU (Palauan),
PON (Pohnpeian), PAN (Punjabi), PUS (Pushto), SMO (Samoan), SAT (Santali), SNA (Shona), SND
(Sindhi), SIN (Sinhalese), SLO (Slovak), SLV (Slovenian), SOL (Somali), SUN (Sundanese), TGK
(Tajik), TAT (Talar), TIB (Tibetan), TIR (Tigrinya), TON (Tonga), TUK (Turkmen), UIG (Uighar), UZB
(Uzbek), WOL (Wolof), XHO (Xhosa), YAP (Yapese), YID (Yiddish), YOR (Yoruba), YPK (Yupik),
ZHA (Zhuang), ZUL (Zulu).

Context Definition Template: SAD_TOEFL

Review the delivered template and determine if any records need to be added. Modify this delivered
definition. It will be used on the File Mapping Definition component. Create a copy before doing so to
keep an original version. If you choose to use a copy of a delivered context definition and reference the
copied version in your file mapping definition, the system forces you to redefine the file layout and file
mapping setup.

File Mapping Definition Template: SAD_TOEFL_TESTRESULTS

This file mapping definition can be used to post TOEFL test scores only. You will need to make changes
to this delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_TOEFL. If you change this, all the file layout and
mapping setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the TOEFL layout
you are using.

Mapping Tab:
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The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_COMPONENT – Ten rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Ten rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Ten rows

Calculated Fields: The following calculated fields have been delivered for TOEFL:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.LAST_NAME, SCC_STG_NAMES.FIRST_NAME and
SCC_STG_NAMES.MIDDLE_NAME - Parses the incoming value in Last (Family) Name in
position 43 into LAST_NAME, FIRST_NAME and MIDDLE_NAME when the Test Type = P (PBT)
in field position 556. If the Test Type is I (IBT), the name parts will appear in the three separate
fields Last (Family) Name, First (Given) Name and Middle Name and will populate LAST_NAME,
FIRST_NAME and MIDDLE_NAME from the three fields.

• SCC_STG_TESTCMP.SCORE - Looks at the incoming score value for IBT Listening, IBT Speaking,
IBT Total Score, P/B Section I Score and Total Score (depending on the application class ID
populated). If the incoming value is ** or ***, population of the row is skipped.

• SCC_STG_ADDR.STATE - Validates the incoming country against the values in the country table. If
the country exists, it then validates the incoming state-country combination against the state table. If
the state-province is found, the state value is populated. If not, the field is left blank.

File Mapping Definition Template: SAD_TOEFL_TESTPROSPECT

This file mapping definition can be used to post TOEFL test scores and create a prospect record. You will
need to make changes to this delivered template to reflect institution defined default values. Before doing
so, make a copy of the delivered template.

File Definition Tab: Modify context definition and conversion definition to those you have created.
Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the TOEFL layout
you are using.
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Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices.

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_COMPONENT – Ten rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Ten rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Ten rows

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

Calculated Fields: The following calculated fields have been delivered for TOEFL:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.LAST_NAME, SCC_STG_NAMES.FIRST_NAME and
SCC_STG_NAMES.MIDDLE_NAME - Parses the incoming value in Last (Family) Name in
position 43 into LAST_NAME, FIRST_NAME and MIDDLE_NAME when the Test Type = P (PBT)
in field position 556. If the Test Type is I (IBT), the name parts will appear in the three separate
fields Last (Family) Name, First (Given) Name and Middle Name and will populate LAST_NAME,
FIRST_NAME and MIDDLE_NAME from the three fields.

• SCC_STG_TESTCMP.SCORE - Looks at the incoming score value for IBT Listening, IBT Speaking,
IBT Total Score, P/B Section I Score and Total Score (depending on the application class ID
populated). If the incoming value is ** or ***, population of the row is skipped.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

• SCC_STG_ADDR.STATE - Validates the incoming country against the values in the country table. If
the country exists, it then validates the incoming state-country combination against the state table. If
the state-province is found, the state value is populated. If not, the field is left blank.
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Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the SAD_TESTDT record context:

• TOEFL_REG_NBR for Registration or Appointment Number

• TOEFL_TESTCTR_CD for Test Center Code

• TOEFL_LIST_IND for Listening Indicator

• TOEFL_SPK_IND for Speaking Indicator

• TOEFL_REASON_TKN for Reason for taking TOEFL

• TOEFL_DEGREE for Degree

• TOEFL_INTINFO_YEAR for Interpretive Info Year

• TOEFL_NBR_TAKEN for Number of times taken

• TOEFL_IBT_TESTCTR for IBT Test Center Code

• TOEFL_TSTCTR_CNTRY for Test Center Country

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT record context. In addition to
creating the common attribute and adding them to the record context, you will need to add rows for each
common attribute on the File Mapping Definition component. Additional fields that were not mapped
include:

• Institution Code

• Department Code

• Address Country Name

• Native Country Name

• Test Type

• No Resp/Off Topic

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

Graduate Management Admission Test (GMAT)

Delivered Transaction Code: SAD_GMAT

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

Copyright © 1988, 2021, Oracle and/or its affiliates. 347



Managing PeopleSoft Prospect/Admissions Data Load Transactions Chapter 10

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_GMAT

Conversion examples have been delivered for the following fields:

• Admit Term based on incoming Graduation Date values.

• Gender based on incoming Gender values.

• STATE/PROVINCE based on incoming Country Of Residence and State/Province values. Used with
a delivered calculated field.

Each of these conversions may need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.

Note: Not all State/Province Codes have been mapped. See the rows populated for the following
provinces in Pakistan: PAKICT (Islamabad Capital Territory), PAKNWF (North West Frontier), PAKPUN
(Punjab) and PAKSIN (Sindh) and enter an internal values for these states.

Context Definition Template: SAD_GMAT

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_GMAT_TESTPROSPECT

This file mapping definition can be used to create prospects in addition to populating test scores. You will
need to make changes to this delivered template to reflect institution defined default values. Before doing
so, make a copy of the delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_GMAT. If you change this, all the file layout and
mapping setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the GMAT layout
you are using. Modify default values on the Date Day column for the fields:

• Administration Date

• Administration Date2

• Administration Date3
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• Graduation Date

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Fifteen rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Fifteen rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Fifteen rows

• SCC_STG_TESTDT.TEST_ID – Three rows

• SAD_STG_TST_CAF.TEST_ID – Eight rows

• SCC_STG_STD_CAR.ACAD_CAREER

• SAD_PRS_CAR_STG.ACAD_CAREER

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_PRG_STG.ACAD_CAREER

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.ACAD_PROG

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PLN_STG.ACAD_CAREER

• SAD_PRS_PLN_STG.INSTITUTION

• SAD_PRS_PLN_STG.ACAD_PROG

• SAD_PRS_PLN_STG.ACAD_PLAN

• SAD_STG_PRS_CAF.ACAD_CAREER – Three rows.

• SAD_STG_PRS_CAF.INSTITUTION – Three rows.
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Calculated Fields: The following calculated fields have been delivered for GMAT:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.STATE - Concatenates the incoming values for the Country of Residence and
State/Province/County fields and compares them to the field conversion definition for STATE/
PROVINCE to determine the value to populate.

• SCC_STG_TESTCMP.SCORE - Looks at the incoming score value for the Verbal Converted Score,
Quantitative Converted Score, Total Converted Score, Analytical Writing Converted Score and
Integrated Reasoning Converted Score (depending on the application class ID populated). If the
incoming value is ++ or +++ or ~~~, population of the row is skipped.

• SCC_STG_TESTCMP.PERCENTILE - Looks at the incoming percentile value for the Verbal
Percentage Below, Quantitative Percentage Below, Total Score Percentage Below, Analytical Writing
Percentage Below or Integrated Reasoning Percentage (depending on the application class ID
populated). If the incoming value is ++ or ~~, population of the field is skipped.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

• SAD_PRS_CAR_STG.LAST_SCH_ATTEND - Uses the incoming value from Attending Institution
Code to determine the EXT_ORG_ID to populate based on the EXT_ORG_TBL_ADM.ATP_CODE.

File Mapping Definition Template: SAD_GMAT_TESTRESULTS

This file mapping definition can be used to post GMAT test scores. You will need to make changes to
this delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_GMAT. If you change this, all the file layout and
mapping setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the GMAT layout
you are using. Modify default values on the Date Day column for the fields:

• Administration Date

• Administration Date2

• Administration Date3

• Graduation Date
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Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Fifteen rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Fifteen rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Fifteen rows

• SCC_STG_TESTDT.TEST_ID – Three rows

• SAD_STG_TST_CAF.TEST_ID – Eleven rows

Calculated Fields: The following calculated fields have been delivered for GMAT:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.STATE - Concatenates the incoming values for the Country of Residence and
State/Province/County fields and compares them to the field conversion definition for STATE/
PROVINCE to determine the value to populate.

• SCC_STG_TESTCMP.SCORE - Looks at the incoming score value for the Verbal Converted Score,
Quantitative Converted Score, Total Converted Score, Analytical Writing Converted Score and
Integrated Reasoning Converted Score (depending on the application class ID populated). If the
incoming value is ++ or +++ or ~~~, population of the row is skipped.

• SCC_STG_TESTCMP.PERCENTILE - Looks at the incoming percentile value for the Verbal
Percentage Below, Quantitative Percentage Below, Total Score Percentage Below, Analytical Writing
Percentage Below or Integrated Reasoning Percentage (depending on the application class ID
populated). If the incoming value is ++ or ~~, population of the field is skipped.

Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the SAD_TESTDT record context:

• GMAT_DT_SCORE - Date Scores Published to Program.

• GMAT_EDU_LVL - Education Level.
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• GMAT_ID_NBR - GMAT ID Number.

• GMAT_IN_GRD_STUDY - Intended Graduate Study.

• GMAT_IRR_CD - Irregularity Code.

• GMAT_PROG_CD - GMAT Program Code.

• GMAT_REG_NBR - Registration/Appt Number.

• GMAT_UGRD_MJCD - Undergraduate Major Code.

• GMAT_UGRD_PTAVG - Undergraduate Grade Point Average.

These attributes should be associate with the ADM_PRSPCT_CAR Record Context:

• GMAT_EDU_LVL - Education Level.

• GMAT_UGRD_MJCD - Undergraduate Major Code.

• GMAT_UGRD_PTAVG - Undergraduate Grade Point Average.

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

Graduate Record Examinations (GRE)

Delivered Transaction Code: SAD_GRE

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_GRE

Conversion examples have been delivered for the following fields:

• ACAD CAREER based on incoming Department Code value.

• ACAD_PROG based on incoming Department Code value.

• ACAD PLAN based on incoming Intended Graduate Major Field value.

• GENDER based on incoming Gender value.

Each of these conversions may need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.
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Context Definition Template: SAD_GRE

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_GRE_TESTPROSPECT

This file mapping definition can be used to create prospects, populate test scores and supporting data
such as academic interests. You will need to make changes to this delivered template to reflect institution
defined default values. Before doing so, make a copy of the delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_GRE. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the GRE layout
you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Twenty-one rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Twenty-one rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Twenty-one rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Seven rows

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

Copyright © 1988, 2021, Oracle and/or its affiliates. 353



Managing PeopleSoft Prospect/Admissions Data Load Transactions Chapter 10

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PLN_STG.INSTITUTION

• SCC_STG_ADMINT.LS_DATA_SOURCE

Calculated Fields: The following calculated fields have been delivered for GRE:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_TESTCMP.SCORE - Twenty one rows. Formats the incoming score.

• Verbal Reasoning Score: If Test Code is 02 and Score Type is V, then Scaled Score should be
populated.

• Quantitative Reasoning Score: If Test Code is 02 and Score Type is Q, then Scaled Score should
be populated.

• New Verbal Reasoning Score: If Test Code is 03 and Score Type is V, then Scaled Score should
be populated. OR If Test Code is 02 and Score Type is V, then Estimated Current Score should be
populated.

• New Quantitative Reasoning Score: If Test Code is 03 and Score Type is Q, then Scaled Score
should be populated. OR If Test Code is 02 and Score Type is Q, then Estimated Current Score
should be populated.

• Analytical Writing Score: If Test Code is 02 or 03 and Score Type is W, then Scaled Score should
be populated.

• Biochemistry, Cell, Molecular Biology Score: If Test Code is 22 and Score Type is S, then Scaled
Score should be populated.

• Biochemistry Subscore: If Test Code is 22 and Score Type is 1, then Scaled Score should be
populated.

• Cell Biology Subscore: If Test Code is 22 and Score Type is 2, then Scaled Score should be
populated.

• Molecular Bio & Genetics Subscore: If Test Code is 22 and Score Type is 3, then Scaled Score
should be populated.

• Biology Score: If Test Code is 24 and Score Type is S, then Scaled Score should be populated.

• Cellular & Molecular Bio Subscore: If Test Code is 24 and Score Type is 1, then Scaled Score
should be populated.

• Organismal Biology Subscore: If Test Code is 24 and Score Type is 2, then Scaled Score should
be populated.
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• Ecology & Evolution Subscore: If Test Code is 24 and Score Type is 3, then Scaled Score should
be populated.

• Chemistry Score: If Test Code is 27 and Score Type is S, then Scaled Score should be populated.

• Computer Science Score: If Test Code is 29 and Score Type is S, then Scaled Score should be
populated.

• Literature in English Score: If Test Code is 64 and Score Type is S, then Scaled Score should be
populated.

• Mathematics Score: If Test Code is 68 and Score Type is S, then Scaled Score should be
populated.

• Physics Score: If Test Code is 77 and Score Type is S, then Scaled Score should be populated .

• Psychology Score: If Test Code is 81 and Score Type is S, then Scaled Score should be populated.

• Experimental Psychology Subscore: If Test Code is 81 and Score Type is 1, then Scaled Score
should be populated.

• Social Psychology Subscore: If Test Code is 81 and Score Type is 2, then Scaled Score should be
populated.

• SCC_STG_TESTCMP.PERCENTILE - Twenty One rows. Formats the incoming percentile.

• Verbal Reasoning Percentage: If Test Code is 02 and Score Type is V, then Percentage Rank
should be populated.

• Quantitative Reasoning Percentage: If Test Code is 02 and Score Type is Q, then Percentage Rank
should be populated.

• New Verbal Reasoning Percentage: If Test Code is 03 and Score Type is V, then Percentage Rank
should be populated.

• New Quantitative Reasoning Percentage: If Test Code is 03 and Score Type is Q, then Percentage
Rank should be populated.

• Analytical Writing Percentage: If Test Code is 02 or 03 and Score Type is W, then Percentage
Rank should be populated.

• Biochemistry, Cell, Molecular Biology Percentage: If Test Code is 22 and Score Type is S, then
Percentage Rank should be populated.

• Biochemistry Percentage: If Test Code is 22 and Score Type is 1, then Percentage Rank should be
populated.

• Cell Biology Percentage: If Test Code is 22 and Score Type is 2, then Percentage Rank should be
populated.

• Molecular Bio & Genetics Percentage: If Test Code is 22 and Score Type is 3, then Percentage
Rank should be populated.

• Biology Percentage: If Test Code is 24 and Score Type is S, then Percentage Rank should be
populated.

Copyright © 1988, 2021, Oracle and/or its affiliates. 355



Managing PeopleSoft Prospect/Admissions Data Load Transactions Chapter 10

• Cellular & Molecular Bio Percentage: If Test Code is 24 and Score Type is 1, then Percentage
Rank should be populated.

• Organismal Biology Percentage: If Test Code is 24 and Score Type is 2, then Percentage Rank
should be populated.

• Ecology & Evolution Percentage: If Test Code is 24 and Score Type is 3, then Percentage Rank
should be populated.

• Chemistry Percentage: If Test Code is 27 and Score Type is S, then Percentage Rank should be
populated.

• Computer Science Percentage: If Test Code is 29 and Score Type is S, then Percentage Rank
should be populated.

• Literature in English Percentage: If Test Code is 64 and Score Type is S, then Percentage Rank
should be populated.

• Mathematics Percentage: If Test Code is 68 and Score Type is S, then Percentage Rank should be
populated.

• Physics Percentage: If Test Code is 77 and Score Type is S, then Percentage Rank should be
populated.

• Psychology Percentage: If Test Code is 81 and Score Type is S, then Percentage Rank should be
populated.

• Experimental Psychology Percentage: If Test Code is 81 and Score Type is 1, then Percentage
Rank should be populated.

• Social Psychology Percentage: If Test Code is 81 and Score Type is 2, then Percentage Rank
should be populated.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Derives the Recruiting Center based on the incoming
Institution, Career, Program, and Plan.

File Mapping Definition Template: SAD_GRE_TESTRESULTS

This file mapping definition can be used to post GRE test scores. You will need to make changes to
this delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_GRE. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the GRE layout
you are using.
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Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Twenty-one rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Twenty-one rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Twenty-one rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Seven rows

Calculated Fields: The following calculated fields have been delivered for GRE:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_TESTCMP.SCORE - Twenty one rows. Formats the incoming score.

• Verbal Reasoning Score: If Test Code is 02 and Score Type is V, then Scaled Score should be
populated.

• Quantitative Reasoning Score: If Test Code is 02 and Score Type is Q, then Scaled Score should
be populated.

• New Verbal Reasoning Score: If Test Code is 03 and Score Type is V, then Scaled Score should
be populated. OR If Test Code is 02 and Score Type is V, then Estimated Current Score should be
populated.

• New Quantitative Reasoning Score: If Test Code is 03 and Score Type is V, then Scaled Score
should be populated. OR If Test Code is 02 and Score Type is Q, then Estimated Current Score
should be populated.

• Analytical Writing Score: If Test Code is 02 or 03 and Score Type is W, then Scaled Score should
be populated.

• Biochemistry, Cell, Molecular Biology Score: If Test Code is 22 and Score Type is S, then Scaled
Score should be populated.
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• Biochemistry Subscore: If Test Code is 22 and Score Type is 1, then Scaled Score should be
populated.

• Cell Biology Subscore: If Test Code is 22 and Score Type is 2, then Scaled Score should be
populated.

• Molecular Bio & Genetics Subscore: If Test Code is 22 and Score Type is 3, then Scaled Score
should be populated.

• Biology Score: If Test Code is 24 and Score Type is S, then Scaled Score should be populated.

• Cellular & Molecular Bio Subscore: If Test Code is 24 and Score Type is 1, then Scaled Score
should be populated.

• Organismal Biology Subscore: If Test Code is 24 and Score Type is 2, then Scaled Score should
be populated.

• Ecology & Evolution Subscore: If Test Code is 24 and Score Type is 3, then Scaled Score should
be populated.

• Chemistry Score: If Test Code is 27 and Score Type is S, then Scaled Score should be populated.

• Computer Science Score: If Test Code is 29 and Score Type is S, then Scaled Score should be
populated.

• Literature in English Score: If Test Code is 64 and Score Type is S, then Scaled Score should be
populated.

• Mathematics Score: If Test Code is 68 and Score Type is S, then Scaled Score should be
populated.

• Physics Score: If Test Code is 77 and Score Type is S, then Scaled Score should be populated.

• Psychology Score: If Test Code is 81 and Score Type is S, then Scaled Score should be populated.

• Experimental Psychology Subscore: If Test Code is 81 and Score Type is 1, then Scaled Score
should be populated.

• Social Psychology Subscore: If Test Code is 81 and Score Type is 2, then Scaled Score should be
populated.

• SCC_STG_TESTCMP.PERCENTILE - Twenty one rows. Formats the incoming percentile.

• Verbal Reasoning Percentage: If Test Code is 02 and Score Type is V, then Percentage Rank
should be populated.

• Quantitative Reasoning Percentage: If Test Code is 02 and Score Type is Q, then Percentage Rank
should be populated.

• New Verbal Reasoning Percentage: If Test Code is 03 and Score Type is V, then Percentage Rank
should be populated.

• New Quantitative Reasoning Percentage: If Test Code is 03 and Score Type is Q, then Percentage
Rank should be populated.
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• Analytical Writing Percentage: If Test Code is 02 or 03 and Score Type is W, then Percentage
Rank should be populated.

• Biochemistry, Cell, Molecular Biology Percentage: If Test Code is 22 and Score Type is S, then
Percentage Rank should be populated.

• Biochemistry Percentage: If Test Code is 22 and Score Type is 1, then Percentage Rank should be
populated.

• Cell Biology Percentage: If Test Code is 22 and Score Type is 2, then Percentage Rank should be
populated.

• Molecular Bio & Genetics Percentage: If Test Code is 22 and Score Type is 3, then Percentage
Rank should be populated.

• Biology Percentage: If Test Code is 24 and Score Type is S, then Percentage Rank should be
populated.

• Cellular & Molecular Bio Percentage: If Test Code is 24 and Score Type is 1, then Percentage
Rank should be populated.

• Organismal Biology Percentage: If Test Code is 24 and Score Type is 2, then Percentage Rank
should be populated.

• Ecology & Evolution Percentage: If Test Code is 24 and Score Type is 3, then Percentage Rank
should be populated.

• Chemistry Percentage: If Test Code is 27 and Score Type is S, then Percentage Rank should be
populated.

• Computer Science Percentage: If Test Code is 29 and Score Type is S, then Percentage Rank
should be populated.

• Literature in English Percentage: If Test Code is 64 and Score Type is S, then Percentage Rank
should be populated.

• Mathematics Percentage: If Test Code is 68 and Score Type is S, then Percentage Rank should be
populated.

• Physics Percentage: If Test Code is 77 and Score Type is S, then Percentage Rank should be
populated.

• Psychology Percentage: If Test Code is 81 and Score Type is S, then Percentage Rank should be
populated.

• Experimental Psychology Percentage: If Test Code is 81 and Score Type is 1, then Percentage
Rank should be populated.

• Social Psychology Percentage: If Test Code is 81 and Score Type is 2, then Percentage Rank
should be populated.
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Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the SAD_TESTDT record context:

• GRE_LAST4_SSN - Social Security Number – Last 4 Digits

• GRE_REG_NBR - Registration Number

• GRE_TEST_NAME - Test Name

• GRE_EXAM_SEQ_NO - Examinee Sequence No.

• GRE_REC_SRL_NBR - Record Serial Number

• GRE_CYCLE_NO - Cycle Number

• GRE_PROC_DT - Process Date

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT record context. In addition to
creating the common attribute and adding them to the record context, you will need to add rows for each
common attribute on the File Mapping Definition component. Additional fields that were not mapped
include:

• Institution Name

• Department Name

• Country

• Test Code

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

Educational Opportunity Service (EOS)

Delivered Transaction Code: SAD_EOS

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_EOS

Conversion examples have been delivered for the following fields:

• Gender based on incoming Gender value.
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• Racial/Ethnicity based on incoming Racial/Ethnicity value.

• Admit Term based on incoming Year of H.S. Graduation value.

• Academic Program based on incoming Intended College Major value.

• Academic Plan based on incoming Intended College Major value.

• Academic Interest based on incoming Intended College Major value.

Each of these conversions may need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.

Context Definition Template: SAD_EOS

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_EOS_PROSPECTS

This file mapping definition can be used to create prospects, populate test scores and supporting data
such as academic interests. You will need to make changes to this delivered template to reflect institution
defined default values. Before doing so, make a copy of the delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_EOS. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the EOS layout
you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_CONSTIT.SCC_TRANSAC_CD

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SAD_PDL_HDR_STG.SCC_TRANSAC_CD

• SCC_STG_STD_CAR.ACAD_CAREER
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• SAD_PRS_CAR_STG.ACAD_CAREER

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_PRG_STG.ACAD_CAREER

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PLN_STG.ACAD_CAREER

• SAD_PRS_PLN_STG_PRG.INSTITUTION

• SAD_STG_PRS_CAF.ACAD_CAREER

• SAD_STG_PRS_CAF.INSTITUTION

• SCC_STG_ADMIHD.ACAD_CAREER

• SCC_STG_ADMINT.ACAD_CAREER

Calculated Fields: The following calculated fields have been delivered for EOS:

• SCC_STG_CONSTIT.BIRTHDATE - Removes zeros from birthdate which are delivered if the
Birthdate in position 160 is blank or invalid.

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.COUNTRY - Uses the incoming value from Country Code in position 127 to
determine the three character Country value to populate from COUNTRY_TBL.

• SCC_STG_ADDR.STATE - Populates incoming State field value starting at position 116 when the
country is USA. Populates incoming Canadian Province field value starting at position 130 when the
country is CAN. For other countries, the STATE field is not populated.

• SCC_STG_ADDR.POSTAL - Populates incoming ZIP Code + 4 field starting at position 118 when
the country is USA. Populates incoming Non U.S. Postal Code field starting at position 132 when the
country is CAN or other countries.

• SAD_PRS_CAR_STG.ADM_RCR_CTR - Looks at the prospect setup you have defined to determine
recruiting center. If you don’t set up the Prospect Setup page, you will need to change this to a default
recruiting center.

• SAD_PRS_CAR_STG.LAST_SCH_ATTEND - Uses the incoming value from High School
Code Number in position 175 to determine the EXT_ORG_ID to populate based on the
EXT_ORG_TBL_ADM.ACT_CODE.
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• SCC_STG_ADMINT.DESCR - Derive the academic interest description based on the External
Subject Area populated.

Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the ADM_PRSPCT_CAR record context:

• EOS_MOBILITY_INDEX - Mobility Index

• EOS_PERRANK_MOBINDEX - Percentile Rank Mobility Index

• EOS_INST_TYPE_INDEX - Institution Type Index

• EOS_PERRANK_INSTINDEX - Percentile Rank Inst Type Index

• EOS_SEL_INDEX - Selectivity Index

• EOS_PERRANK_SELINDEX - Percentile Rank Selectivity Index

• EOS_INST_SIZE_INDEX - Institution Size Index

• EOS_PERRANK_INSTSZINDEX - Percentile Rank Inst Size Index

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT record context. In addition to
creating the common attribute and adding them to the record context, you will need to add rows for each
common attribute on the File Mapping Definition component. Additional fields that were not mapped
include:

• Purchase ID

• Occupational Choice

• State Code

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

American College Testing (ACT)

Delivered Transaction Code: SAD_ACT

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.
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File Parser Field Conversion Definition Template: SAD_ACT

Note: From September 2020, when processing ACT test results, copy your existing SAD_ACT field
conversion definition template, then name the copy as SAD_ACT_2020. This template is used in the file
mapping definition template SAD_ACT_TESTRESULTS_2020. You have to update SAD_ACT_2020 to
map incoming data from the ACT Test File. It’s a Campus Solutions-based setup table. To determine all
the new fields in the test file, you must review 2020-2021 ACT College Score Reporting Service Layout.

Conversion examples have been delivered for the following fields:

• Citizenship based on incoming Citizenship value.

• Gender based on incoming Gender Alpha value.

• Phone Type based on incoming Type of Telephone value.

• NID Country based on incoming Country Code value.

• Ethnicity based on incoming Race Background values in position 609-615.

• Hispanic/Latino based on incoming Hispanic or Latino Background value.

• Academic Interest based on incoming Major Plan value.

• Academic Program based on incoming Major Plan value.

• Academic Plan based on incoming Major Plan value.

• Academic Level based on incoming Academic Level value.

• Academic Load based on incoming Academic Load value.

• Admit Term based on incoming Year of H.S. Graduation value.

• Planned Housing based on incoming Planned Housing value.

• Financial Aid based on incoming Financial Aid value.

• Campus or community service (Extracurricular Activity Description) based on incoming Campus or
community service value.

• Debate (Extracurricular Activity Description) based on incoming Debate value.

• Dramatics, theater (Extracurricular Activity Description) based on incoming Dramatics, theater value.

• Fraternity or sorority (Extracurricular Activity Description) based on incoming Fraternity or sorority
value.

• Instrumental music (Extracurricular Activity Description) based on incoming Instrumental music
value.

• Political organizations (Extracurricular Activity Description) based on incoming Political
organizations value.

• Publications (Extracurricular Activity Description) based on incoming Publications value.
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• Racial or ethnic organizations (Extracurricular Activity Description)based on incoming Racial or
ethnic organizations value.

• Radio-TV (Extracurricular Activity Description) based on incoming Radio-TV value.

• Religious organizations (Extracurricular Activity Description) based on incoming Religious
organizations value.

• Student government (Extracurricular Activity Description) based on incoming Student government
value.

• Varsity athletics (Extracurricular Activity Description) based on incoming Varsity athletics value.

• Vocal music (Extracurricular Activity Description) based on incoming Vocal music value.

• Test Location (Used to derive test day for Test Date) based on incoming Test Location value.

Each of these conversions may need to be modified based on your internal values. Modify the delivered
version as it will be used on the File Mapping Definition component. Before modifying, make sure you
create a copy so that you have the original version.

Context Definition Template: SAD_ACT

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_ACT_TESTPROSPECT

This file mapping definition can be used to create prospects, populate test scores and populate supporting
data such as academic interests and extracurricular activities. You will need to make changes to this
delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab: Change the delimiter if needed based on your file characteristics.

Important! Leave the context and conversion definitions as SAD_ACT. If you change this, all the file
layout and mapping setup will disappear.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the ACT layout
you are using. Also modify the default Date Day and Date Month values for Year of H.S. Graduation.

Mapping Tab: The default values for the following fields will need to be reviewed and probably modified
depending upon your institution’s business practices.

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

Copyright © 1988, 2021, Oracle and/or its affiliates. 365



Managing PeopleSoft Prospect/Admissions Data Load Transactions Chapter 10

• SCC_STG_STD_CAR.ACAD_CAREER

• SAD_PRS_CAR_STG.ACAD_CAREER

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_CAR_STG.ACADEMIC_LEVEL

• SAD_PRS_CAR_STG.CAMPUS

• SAD_PRS_PRG_STG.ACAD_CAREER

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PRG_STG.CAMPUS

• SAD_PRS_PLN_STG.ACAD_CAREER

• SAD_PRS_PLN_STG.INSTITUTION

• SAD_STG_PRS_CAF.ACAD_CAREER – Nine rows

• SAD_STG_PRS_CAF.INSTITUTION – Nine rows

• SCC_STG_ADMIHD.ACAD_CAREER

• SCC_STG_ADMINT.ACAD_CAREER

• SCC_STG_EXTRACU.INSTITUTION – Thirteen rows

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Seven Rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Seven rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Seven rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Eight rows

Calculated Fields: The following calculated fields have been delivered for ACT:

• SCC_STG_CONSTIT.BIRTHDATE - Removes zeros from birthdate which are delivered if the
Birthdate in position 155 is blank or invalid.

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.
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• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.COUNTRY - Uses the incoming value from Country Code in position 85 to
determine the three character Country value to populate from COUNTRY_TBL.

• SCC_STG_ADDR.POSTAL - Populates incoming ZIP Code + 4 field starting at position 146 when
the country is USA. Populates incoming Non U.S. Postal Code field starting at position 253 when the
country is CAN or other countries.

• SCC_STG_ADDR.STATE - Populates incoming State field value starting at position 142 when the
country is USA. Populates incoming Canadian Province field value starting at position 250 when
the country is CAN. For other countries, the STATE field is not populated nor is the STATE field
populated if the value is FN or CN when country is USA.

• SCC_STG_NID.NATIONAL_ID - Populates National ID only when the incoming Social Security
Number or ACT ID starting at position 91 doesn’t start with the value - and length is equal to 9.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

• SAD_PRS_CAR_STG.LAST_SCH_ATTEND - Uses the incoming value from High School
Code Number in position 205 to determine the EXT_ORG_ID to populate based on the
EXT_ORG_TBL_ADM.ACT_CODE.

• SCC_STG_ADMINT.DESCR - Derive the academic interest description based on the External
Subject Area populated.

• SCC_STG_TESTCMP.TEST_DT, SCC_STG_TESTDT.TEST_DT and
SAD_STG_TST_CAF.TEST_DT - Determine the Test Date based on the incoming MMYYYY value
for Expanded Test Date in position 227 plus the converted value for Test Location on the SAD_ACT
Field Conversion Definition in position 249. The converted Test Location Value will produce the
day. The converted value for Test Location (DD) should be combined with the Expanded Test Date
(MMYYYY) to provide the full TEST_DT value (MMDDYYYY).

For this calculated field, it is important that the SAD_ACT field conversion definition is used. Modify
the delivered version.

• SCC_STG_TESTCMP.PERCENTILE - Per the ACT Layout, the value -- will be populated for the
National Norm if the score is not reported. If the percentile is populated with the value -- the field is
not populated for the following fields:

• Natl Norms – English in position 773

• Natl Norms – Math in position 775

• Natl Norms – Reading in position 777

• Natl Norms – Science Reasoning in position 779

• Natl Norms – Composite in position 781
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• SCC_STG_TESTCMP.SCORE - Per the ACT Layout, the value -- will be populated for the score if it
is not administered. If the score is populated with the value --, the row is not created for the following
scores:

• English Scaled Score in position 261

• Math Scaled Score in position 263

• Reading Scaled Score in position 265

• Science Scaled Score in position 267

• Composite Scaled Score in position 269

• Combined English Writing Score in position 163

• Writing Sub-score in position 165

File Mapping Definition Template: SAD_ACT_TESTRESULTS

This file mapping definition can be used to post ACT test scores. You will need to make changes to
this delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context and conversion definitions as SAD_ACT. If you change this, all the file
layout and mapping setup will disappear.

Change the delimiter if needed based on your file characteristics.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the ACT layout
you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Seven Rows

• SAD_STG_TST_CAF.TEST_ID – Eight rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Seven rows
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• SCC_STG_TESTCMP.LS_DATA_SOURCE – Seven rows

• SCC_STG_TESTDT.TEST_ID

Calculated Fields: The following calculated fields have been delivered for ACT:

• SCC_STG_CONSTIT.BIRTHDATE - Removes zeros from birthdate which are delivered if the
Birthdate in position 155 is blank or invalid.

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.COUNTRY - Uses the incoming value from Country Code in position 85 to
determine the three character Country value to populate from COUNTRY_TBL.

• SCC_STG_ADDR.POSTAL - Populates incoming ZIP Code + 4 field starting at position 146 when
the country is USA. Populates incoming Non U.S. Postal Code field starting at position 253 when the
country is CAN or other countries.

• SCC_STG_ADDR.STATE - Populates incoming State field value starting at position 142 when the
country is USA. Populates incoming Canadian Province field value starting at position 250 when
the country is CAN. For other countries, the STATE field is not populated nor is the STATE field
populated if the value is FN or CN when country is USA.

• SCC_STG_NID.NATIONAL_ID - Populates National ID only when the incoming Social Security
Number or ACT ID starting at position 91 doesn’t start with the value - and length is equal to 9.

• SCC_STG_TESTCMP.TEST_DT, SCC_STG_TESTDT.TEST_DT and
SAD_STG_TST_CAF.TEST_DT - Determine the Test Date based on the incoming MMYYYY value
for Expanded Test Date in position 227 plus the converted value for Test Location on the SAD_ACT
Field Conversion Definition in position 249. The converted Test Location Value will produce the
day. The converted value for Test Location (DD) should be combined with the Expanded Test Date
(MMYYYY) to provide the full TEST_DT value (MMDDYYYY).

For this calculated field, it is important that the SAD_ACT field conversion definition is used. Modify
the delivered version.

• SCC_STG_TESTCMP.PERCENTILE - Per the ACT Layout, the value -- will be populated for the
National Norm if the score is not reported. If the percentile is populated with the value -- the field is
not populated for the following fields:

• Natl Norms – English in position 773

• Natl Norms – Math in position 775

• Natl Norms – Reading in position 777

• Natl Norms – Science Reasoning in position 779

• Natl Norms – Composite in position 781
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• SCC_STG_TESTCMP.SCORE - Per the ACT Layout, the value -- will be populated for the score if it
is not administered. If the score is populated with the value --, the row is not created for the following
scores:

• English Scaled Score in position 261

• Math Scaled Score in position 263

• Reading Scaled Score in position 265

• Science Scaled Score in position 267

• Composite Scaled Score in position 269

• Combined English Writing Score in position 163

• Writing Sub-score in position 165

Common Attribute Framework for SAD_ACT_TESTRESULTS

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the SAD_TESTDT record context:

• ACT_TEST_LOCATION for Test Location

• ACT_ESSAYCOMMENT1 for Essay Comment 1

• ACT_ESSAYCOMMENT2 for Essay Comment 2

• ACT_ESSAYCOMMENT3 for Essay Comment 3

• ACT_ESSAYCOMMENT4 for Essay Comment 4

• ACT_SCALESCORES_SUM for Sum of Scale Scores

• ACT_STATE_STUDENTID for State-Assigned Student ID

• ACT_CORRECTED_IND for Corrected Report Indicator

These attributes should be associated with the ADM_PRSPCT_CAR record context

• ACT_CLG_CHOICE_NBR for College Choice Number

• ACT_HS_CLASSRANK for High School Class Rank

• ACT_HS_GPA for High School GPA

• ACT_HS_CLASS_SIZE for High School Class Size

• ACT_CLG_TYPE_PREF for College Type Preference

• ACT_CLG_TYPE_RANK for Ranking College Type

• ACT_INSTTYPE_PREDINDEX for Pred Modeling Institution Type Index

• ACT_MOMGRD1_EDLEVEL for Mother/Guardian 1 Ed Level
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• ACT_DADGRD2_EDLEVEL for Father/Guardian 2 Ed Level

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT or ADM_PRSPCT_CAR record
context depending on your business process. In addition to creating the common attribute and adding
them to the record context, you will need to add rows for each common attribute on the File Mapping
Definition component. Additional fields that were not mapped upon initial delivery of the ACT File
Mapping Definitions include:

• Reporting Year Identifier

• English Score before Oct 1989

• Math Score before Oct 1989

• Social Science Score before Oct 1989

• Natural Sciences Score before Oct 1989

• Composite Score before Oct 1989

• English GPA

• Math GPA

• Social Studies GPA

• Natural Sciences GPA

• H.S. Average

• Science Int Inv

• Arts Int Inv

• Social Service Int Inv

• Business Contact Int Inv

• Business Operations Int Inv

• Technical Int Inv

• Map Region 1

• Map Region 2

• Map Region 3

• College Code

• Usage/Mech Subscore

• Elem Algebra Subscore

• Soc Stud/Sci Subscore

• Rhetorical Skills Subscore
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• Alg/Coord Geom Subscore

• Arts/Lit Subscore

• Plane Geom/Trig Subscore

• Usage/Mech National Norms

• Elem Algebra National Norms

• Soc Stud/Sci National Norms

• Rhetorical Skills National Norms

• Alg/Coord Geom National Norms

• Arts/Lit National Norms

• Plane Geom/Trig National Norms

• Usage/Mech Local Norms

• Elem Algebra Local Norms

• Soc Stud/Sci Local Norms

• Rhetorical Skills Local Norms

• Alg/Coord Geom Local Norms

• Arts/Lit Local Norms

• Plane Geom/Trig Local Norms

• Science Int Inv

• Arts Int Inv

• Social Service Int Inv

• Business Contact Int Inv

• Business Operations Int Inv

• Technical Int Inv

• Local ID Number

• Mobility Index

• Selectivity Index

• Institution Size Index

• Interest-Major Fit Score

• Legal Resident of State

• Disability
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• Vocation Choice

• Confidence in College Major

• Confidence in Vocation

• Expected Highest Educ Level

• ROTC

• Decide Educ/Occup Plans

• Express Ideas in Writing

• Improve Reading Speed & Comp

• Improve Student Skills

• Independent Study

• Freshman honors courses

• Study in a foreign country

• Improve Math Skills

• Expect to Work

• Hours Expect to Work

• Total Combined Income

• Distance From College

• English Spoken at Home

• Ethnicity

• Pref College Gender Type

• PrefCollege State(1)

• PrefCollege State(2)

• Pref Max Annual Tuition

• Pref Student Body Size

• Ranking Gender Type

• Ranking Location

• Ranking Tuition

• Ranking Student Body Size

• Ranking Field of Study

• Ranking Other Factor
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• High School Descr

• High School Prog Type

• Yrs Study: English

• Yrs Study: Mathematics

• Yrs Study: Social studies

• Yrs Study: Natural sciences

• Yrs Study: Spanish

• Yrs Study: German

• Yrs Study: French

• Yrs Study: Other Language

• Honors Courses English

• Honors Courses Math

• Honors Courses Social Studies

• Honors Courses Natural Sci

• Honors Courses Foreign Lang

• Organized school event

• Elected to student offices

• Leadership award

• Musical group

• Superior rating state music

• 1st/2nd/3rd debate

• Substantial roles in plays

• Appeared on radio or TV

• Exhibited art state/reg show

• High school art award

• City/country/state art award

• Published poems, stories

• Literary award or prize

• Published creative writing
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• NSF summer program

• 1st/2nd/3rd reg/state science

• 1st/2nd/3rd school science

• Varsity sports letter

• Athletic honors

• Community service award

• Started business or service

• EOS Release

• Prefer not to respond

• Multiracial (converted records only)

• English 9 Taken or Planned

• English 10 Taken or Planned

• English 11 Taken or Planned

• English 12 Taken or Planned

• English Other Taken or Planned

• Algebra 1 Taken or Planned

• Algebra 2 Taken or Planned

• Geometry Taken or Planned

• Trigonometry Taken or Planned

• Calculus Taken or Planned

• Other Math Taken or Planned

• Computer Taken or Planned

• General Science Taken or Planned

• Biology Taken or Planned

• Chemistry Taken or Planned

• Physics Taken or Planned

• U.S. History Taken or Planned

• World History Taken or Planned

• Other History Taken or Planned

• Government Taken or Planned
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• Economics Taken or Planned

• Geography Taken or Planned

• Psychology Taken or Planned

• Spanish Taken or Planned

• French Taken or Planned

• German Taken or Planned

• Other Language Taken or Planned

• Art Taken or Planned

• Music Taken or Planned

• Drama Taken or Planned

• English 9 Grade Earned

• English 10 Grade Earned

• English 11 Grade Earned

• English 12 Grade Earned

• English Other Grade Earned

• Algebra 1 Grade Earned

• Algebra 2 Grade Earned

• Geometry Grade Earned

• Trigonometry Grade Earned

• Calculus Grade Earned

• Other Math Grade Earned

• Computer Grade Earned

• General Science Grade Earned

• Biology Grade Earned

• Chemistry Grade Earned

• Physics Grade Earned

• U.S. History Grade Earned

• World History Grade Earned

• Other History Grade Earned

• Government Grade Earned
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• Economics Grade Earned

• Geography Grade Earned

• Psychology Grade Earned

• Spanish Grade Earned

• French Grade Earned

• German Grade Earned

• Other Language Grade Earned

• Art Grade Earned

• Music Grade Earned

• Drama Grade Earned

• Pred Pct English

• Pred Pct Math

• Pred Pct Reading

• Pred Pct Science Reason

• Pred Pct Composite

• Pred Pct Ranking Overall 1

• Pred Pct Ranking Overall 2

• Pred Pct Ranking Overall 3

• Pred Pct Ranking Overall 4

• Pred Pct Ranking Overall 5

• Pred Pct Ranking Specific Courses 1

• Pred Pct Ranking Specific Courses 2

• Pred Pct Ranking Specific Courses 3

• Pred Pct Ranking Specific Courses 4

• Pred Pct Ranking Specific Courses 5

• Prob C or Higher Overall 1

• Prob C or Higher Overall 2

• Prob C or Higher Overall 3

• Prob C or Higher Overall 4

• Prob C or Higher Overall 5
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• Prob C or Higher Courses 1

• Prob C or Higher Courses 2

• Prob C or Higher Courses 3

• Prob C or Higher Courses4

• Prob C or Higher Courses 5

• Pred GPA Overall 1

• Pred GPA Overall 2

• Pred GPA Overall 3

• Pred GPA Overall 4

• Pred GPA Overall 5

• Pred GPA Courses 1

• Pred GPA Courses 2

• Pred GPA Courses 3

• Pred GPA Courses4

• Pred GPA Courses 5

• Norms Type

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

Context Definition Template: SAD_ACT_2020

SAD_ACT_2020 is used in the file mapping definition template SAD_ACT_TESTRESULTS_2020, and
is a copy of the context definition template SAD_ACT.

File Mapping Definition Template: SAD_ACT_TESTRESULTS_2020

Important! You should not make any changes to this definition; any change renders the process unusable.

From September 2020, you must use this file mapping definition to post ACT test scores because the file
layout has changed.

File Definition Tab: This definition uses a CSV file, with the comma as a delimiter and double quotation
marks as text qualifiers. This uses the context and conversion definitions SAD_ACT_2020.

File Layout Tab: The layout is based on the 2020-2021 ACT College Score Reporting Service Layout.

Mapping Tab: The structure of the mapping here is the same as SAD_ACT_TESTRESULTS with a few
changes.
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• These are additional mapping records in this template:

• SCC_STG_TESTCMP row 4 for Test Component SCI (previously SCIRE)

• SCC_STG_TESTCMP row 6 for Test Component STEM

• SCC_STG_TESTCMP row 8 for Test Component ELA

• SCC_STG_TESTCMP row 9 for Test Component SSCOM

• SCC_STG_TESTCMP row 10 for Test Component SSELA

• SCC_STG_TESTCMP row 11 for Test Component SSENG

• SCC_STG_TESTCMP row 12 for Test Component SSMAT

• SCC_STG_TESTCMP row 13 for Test Component SSREA

• SCC_STG_TESTCMP row 14 for Test Component SSSCI

• SCC_STG_TESTCMP row 15 for Test Component SSTEM

• SCC_STG_TESTCMP row 16 for Test Component SSWRI

• SAD_STG_TST_CAF row 9 for Test Component ACT_SUPER_OTHER_ENG

• SAD_STG_TST_CAF row 10 for Test Component ACT_SUPER_OTHER_MAT

• SAD_STG_TST_CAF row 11 for Test Component ACT_SUPER_OTHER_SCI

• SAD_STG_TST_CAF row 12 for Test Component ACT_SUPER_OTHER_REA

• This mapping record has been removed: SCC_STG_NID.

• PeopleCode for TestDate, SuperEnglishDate, SuperMathDate, SuperReadingDate, SuperScienceDate
and SuperWritingDate: By default, the day of the date is set to “01”.

• PeopleCode for SuperEnglishScore, SuperMathScore, SuperReadingScore, SuperScienceScore
and SuperWritingScore: If a row is not Super, the process throws a blank value; “Skip if Blank” is
triggered.

• Because there's no Test Date for Super fields SSCOM, SSELA, SSTEM,
ACT_SUPER_OTHER_ENG, ACT_SUPER_OTHER_MAT, ACT_SUPER_OTHER_SCI and
ACT_SUPER_OTHER_REA, the Application Class ID TestDate is used.

• Make sure to populate the Value Conversion of Gender, Academic Level and Ethnicity based on the
field conversion that you created.

See also:

• "Mapping the File and Converting the Data" (Campus Community Fundamentals)

• Running the File Parser Process
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Common Attribute Framework for SAD_ACT_TESTRESULTS_2020

These common attributes have been added to the record context SAD_TESTDT. The sequence for these
attributes is 81, 82, 83, and 84.

• ACT Super Other English Score

• ACT Super Other Math Score

• ACT Super Other Reading Score

• ACT Super Other Science Score

These test components need to be added to the Test Table with the Test ID ACT.

• SCI

• SSCOM

• SSELA

• SSENG

• SSMAT

• SSREA

• SSSCI

• SSTEM

• SSWRI

Advanced Placement (AP)

Delivered Transaction Code: SAD_AP

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_AP

Conversion examples have been delivered for the following fields:

• Academic Level based on incoming Educational Level value; used to populate the academic level for
each test component.

• Admit Term based on incoming Expected College Entrance value.

• Canadian (CAN) Provinces based on incoming Country Code value.
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• Country based on incoming Country Code value.

• Ethnicity based on incoming Ethnic Group value.

• Exam Code based on incoming Exam Code; used to populate test component.

• Gender based on incoming Sex value.

Each of these conversions may need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.

Note: Not all Country Codes have been mapped. Add rows as needed for the following incoming country
values: 348 - Macedonia, The Former Yugoslav Republic of; 377 - Midway Islands; 550 - Tahiti; 625 -
Montenegro or Serbia; 660 - Bonaire, Sint Eustatius and Saba; 665 - Curacao; 681 - Timor-Leste and 685
- South Sudan.

Note: The following incoming Ethnicity values were not mapped: 0 - Not Stated and 8 - Other.

Context Definition Template: SAD_AP

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_AP_TESTPROSPECT

This file mapping definition can be used to create prospects and populate test scores. You will need to
make changes to this delivered template to reflect institution defined default values. Before doing so,
make a copy of the delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_AP. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the AP layout you
are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_STD_CAR.ACAD_CAREER

• SAD_PRS_CAR_STG.ACAD_CAREER
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• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_CAR_STG.CAMPUS

• SAD_PRS_PRG_STG.ACAD_CAREER

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.ACAD_PROG

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PRG_STG.CAMPUS

• SAD_PRS_PLN_STG.ACAD_CAREER

• SAD_PRS_PLN_STG.INSTITUTION

• SAD_PRS_PLN_STG.ACAD_PROG

• SAD_PRS_PLN_STG.ACAD_PLAN

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Thirty Rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Thirty rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Eight rows

Calculated Fields: The following calculated fields have been delivered for AP:

• SCC_STG_CONSTIT.BIRTHDATE - Removes zeros from birthdate which are delivered if the Date
of Birth in position 142 is blank or invalid.

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.STATE - Populates incoming State field value starting at position 127 when
the country is USA. When country is CAN, the field is populated based on the Field Conversion
definition CAN Provinces. For other countries, the STATE field is not populated.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.
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• SAD_PRS_CAR_STG.LAST_SCH_ATTEND - Uses the incoming value from High
School Code in position 213 to determine the EXT_ORG_ID to populate based on the
EXT_ORG_TBL_ADM.ACT_CODE.

File Mapping Definition Template: SAD_AP_TESTRESULTS

This file mapping definition can be used to post AP test scores. You will need to make changes to this
delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_AP. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the AP layout you
are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Thirty Rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Thirty rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Eight rows

Calculated Fields: The following calculated fields have been delivered for AP:

• SCC_STG_CONSTIT.BIRTHDATE - Removes zeros from birthdate which are delivered if the
Birthdate in position 142 is blank or invalid.

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.STATE - Populates incoming State field value starting at position 127 when
the country is USA. When country is CAN, the field is populated based on the Field Conversion
definition CAN Provinces. For other countries, the STATE field is not populated.
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Common Attribute Framework

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the SAD_TESTDT record context:

• AP_BEST_LANG for Best Language

• AP_DT_GRD_RTC for Date Grades Released to College

• AP_DT_LAST_STUP for Date of Last Student Update

• AP_DT_REPORT for Date of this report

• AP_NBR for AP Number

• AP_ORDER_IKEY for Ordering Institution Key

• AP_SERVICE_CODE for Service Code

• AP_SERVICE_TYPE for Service Type

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT or ADM_PRSPCT_CAR record
context depending on your business process. In addition to creating the common attribute and adding
them to the record context, you will need to add rows for each common attribute on the File Mapping
Definition component. Additional fields that were not mapped upon initial delivery of the AP File
Mapping Definitions include:

• Student Search

• Applying for Sophomore Standing

• Previous AI Year1

• Previous AI Code1

• Previous AI Year2

• Previous AI Code2

• Award Type1

• Award Year1

• Award Type2

• Award Year2

• Award Type3

• Award Year3

• Award Type4

• Award Year4

• Award Type5
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• Award Year5

• Award Type6

• Award Year6

• High School Contact Name

• High School Name

• High School Address #1

• High School Address #2

• High School Address #3

• High School State

• High School ZIP Code

• College Code

• College Contact Name

• College Name

• College Address #1

• College Address #2

• College Address #3

• College State

• College ZIP Code

• The following fields are not mapped for each of the thirty exam sets:

• Irregularity Code #1

• Irregularity Code #2

• Exam Suppression Flag

• Class Section Code

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes
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Law School Admission Test (LSAT)

Delivered Transaction Code: SAD_LSAT

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_LSAT

Conversion examples have been delivered for the following fields:

• Admit Term based on incoming Term Code value.

• Ethnicity based on incoming Ethnic Super Categories values.

• Gender based on incoming Gender value.

Each of these conversions may need to be modified based upon your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.

Note: The following incoming Ethnic Super Categories values were not mapped: CD - Canadian
Aboriginal, AT - Aboriginal or Torres Strait Islander Australian and NI - Not Indicated.

Context Definition Template: SAD_LSAT

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_LSAT_TESTPROSPECT

This file mapping definition can be used to create prospects and populate test scores. You will need to
make changes to this delivered template to reflect institution defined default values. Before doing so,
make a copy of the delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_LSAT. If you change this, all the file layout and
mapping setup will disappear.

Modify the conversion definition to the one you have created.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the LSAT layout
you are using.

Mapping Tab:
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The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE – 2 rows

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_STD_CAR.ACAD_CAREER

• SAD_PRS_CAR_STG.ACAD_CAREER

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_PRG_STG.ACAD_CAREER

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.ACAD_PROG

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PLN_STG.ACAD_CAREER

• SAD_PRS_PLN_STG.INSTITUTION

• SAD_PRS_PLN_STG.ACAD_PROG

• SAD_PRS_PLN_STG.ACAD_PLAN

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Twelve Rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Twelve rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Nine rows

Calculated Fields: The following calculated fields have been delivered for LSAT:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case. There are two calculated fields: one for Primary Name and one for Previous Last Name.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.
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• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

File Mapping Definition Template: SAD_LSAT_TESTRESULTS

This file mapping definition can be used to post LSAT test scores. You will need to make changes to
this delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_LSAT. If you change this, all the file layout and
mapping setup will disappear.

Modify the conversion definition to the one you have created.

File Layout Tab: Review this tab to ensure the fields appear in the exact order as that of the LSAT layout
you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_NID.NATIONAL_ID_TYPE

• SCC_STG_TEST.TEST_ID

• SCC_STG_TEST.CHKLST_ITM_UPDT

• SCC_STG_TESTCMP.TEST_ID – Twelve Rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Twelve rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Nine rows

Calculated Fields: The following calculated fields have been delivered for LSAT:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case. There are two calculated fields: one for Primary Name and one for Previous Last Name.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.
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Common Attribute Framework:

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the SAD_TESTDT record context:

• LSAT_APPL_STATUS for Applicant Status

• LSAT_AVG3D_SCORE for Average 3-digit LSAT Score

• LSAT_LSAC_ACCTNBR for LSAC Account Number

• LSAT_MISCONDUCT for Misconduct Flag

• LSAT_PRIOR_SCHLNM_1 for Name of Law School 1

• LSAT_PRIOR_SCHL_1 for Prior Law School Matriculation 1

• LSAT_SCORE_UPDATE for Score Update

• LSAT_SCRBAND_LOWER for Score band - Lower

• LSAT_SCRBAND_UPPER for Score band - Upper

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT or ADM_PRSPCT_CAR record
context depending on your business process. In addition to creating the common attribute and adding
them to the record context, you will need to add rows for each common attribute on the File Mapping
Definition component. Additional fields that were not mapped upon initial delivery of the LSAT File
Mapping Definitions include:

• Law School Code #

• Date of Transmission

• Time Stamp

• Law School Social Sec/Ins Number

• Law School Last Name

• Law School First Name

• Law School Middle Initial

• Law School Tracking Number

• Age

• Foreign Address (City, Country, Zip)

• State of Permanent Residence

• Date of Future Test

• The following fields are not mapped for each of the twelve scores:

• Score band - Upper

Copyright © 1988, 2021, Oracle and/or its affiliates. 389



Managing PeopleSoft Prospect/Admissions Data Load Transactions Chapter 10

• Score band - Lower

• Irregularity Code

• Number of Valid 3-digit LSAT Scores

• Number of Valid 2-digit LSAT Scores

• Average 2-digit LSAT Score

• Date File Completed

• Misconduct Update

• Prior Matriculation Update

• Prior Matriculation School Code 1

• Prior Law School Matriculation 2

• Prior Matriculation School Code 2

• Name of Law School 2

• Prior Law School Matriculation 3

• Prior Matriculation School Code 3

• Name of Law School 3

• Term Year

• Ethnic Sub Categories

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

Student Search Service (SSS)

Delivered Transaction Code: SAD_SSS

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes, and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_SSS

Conversion examples have been delivered for the following fields:
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• Academic Interest based on incoming Major Choice values.

• Academic Plan based on incoming Major Choice values.

• Academic Program based on incoming Major Choice values.

• Admit Term based on incoming Grad Year value.

• Ethnicity based on incoming Ethnicity value.

Each of these conversions may need to be modified based on your internal values. Either create a new
field conversion definition or copy the delivered definition and modify as needed.

Context Definition Template: SAD_SSS

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used in the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_SSS_PROSPECTS

This file mapping definition can be used to create prospects and supporting data such as academic
interests. You will need to make changes to this delivered template to reflect institution defined default
values. Before doing so, make a copy of the delivered template.

File Definition Tab:

Important! Leave the context definition as SAD_SSS. If you change this, all the file layout and mapping
setup will disappear.

Modify the conversion definition to the one you have created.

Change the delimiter if needed based on your file characteristics.

File Layout Tab:

Review this tab to ensure the fields appear in the exact order as that of the SSS layout you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending on
your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_STD_CAR.ACAD_CAREER

• SAD_PRS_CAR_STG.ACAD_CAREER

• SAD_PRS_CAR_STG.INSTITUTION
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• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_STG_PRS_CAF.ACAD_CAREER – Eight Rows

• SAD_STG_PRS_CAF.INSTITUTION – Eight Rows

• SAD_PRS_PRG_STG.ACAD_CAREER

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PLN_STG.ACAD_CAREER

• SAD_PRS_PLN_STG_PRG.INSTITUTION

• SCC_STG_ADMIHD.ACAD_CAREER

• SCC_STG_ADMINT.ACAD_CAREER – Five rows

Calculated Fields. The following calculated fields have been delivered for SSS:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.COUNTRY – Uses the incoming value from Country Name in position 334 - 362
to determine the three character Country value to populate from COUNTRY_TBL.

• SAD_PRS_CAR_STG.ADM_RCR_CTR – Looks at the prospect setup you have defined to
determine recruiting center. If you did not set up the Prospect Setup page, you will need to change this
to a default recruiting center.

• SAD_PRS_CAR_STG.LAST_SCH_ATTEND - Uses the incoming value from AI Code in position
434 to determine the EXT_ORG_ID to populate based on the EXT_ORG_TBL_ADM.ATP_CODE.

• SCC_STG_ADMINT.DESCR - Derive the academic interest description based on the External
Subject Area populated.

Note: If you have purchased names based on AP Test Takers, it is suggested that you delete the row for
SCC_STG_ADMIHD and 5 rows for SCC_STG_ADMINT as the Major Choice data is not provided in
the data file.

Field Conversion Definitions. If you changed the Conversion Definition on the File Definition tab, you
will need to repopulate the conversion fields on the Value Conversion tab of the Field Mapping Detail for
the following fields:

• SCC_STG_DIV_ETH.ETHNIC_GRP_CD – Ethnicity Conversion Field

• SCC_STG_ETH_DTL.ETHNIC_GRP_CD – Ethnicity Conversion Field

• SAD_PRS_CAR_STG.ADMIT_TERM – Admit Term Conversion Field
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• SAD_PRS_PRG_STG.ACAD_PROG – Academic Program Conversion Field

• SAD_PRS_PLN_STG.ACAD_PROG – Academic Program Conversion Field

• SAD_PRS_PLN_STG.ACAD_PLAN – Academic Plan Conversion Field

• SCC_STG_ADMINT.EXT_SUBJECT_AREA (Five Rows) – Academic Interest Conversion Field

Common Attribute Framework

The following sample common attributes have been delivered for the incoming field indicated. These
attributes should be associated with the ADM_PRSPCT_CAR record context:

• SSS_POSTAL_DEL_PT for Postal Delivery Point

• SSS_POSTAL_COR_CHAR for Postal Correction Character

• SSS_GEOMKT_CODE for Geomarket Code

• SSS_MR_CB_EXAM for Most Recent CB Exam

• SSS_HOMESCH_IND for Homeschooled Indicator

• SSS_COUNTRY_NAME for Country Name

• SSS_SEGA_HS_CLUSTER for Segment Analysis HS Cluster

• SSS_SEGA_EN_CLUSTER for Segment Analysis EN Cluster

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the ADM_PRSPCT_CAR record context. In addition to
creating the common attribute and adding them to the record context, you will need to add rows for each
common attribute on the File Mapping Definition component. Additional fields that were not mapped
include:

• Order Number

• Run Code

• Student ID

• County Code

• AP Exam Code 1

• AP Exam Code 2

• AP Exam Code 3

• AP Exam Code 4

• AP Exam Code 5

• AP Exam Code 6

• AP Exam Code 7

• AP Exam Code 8
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• AP Exam Code 9

• AP Exam Code 10

• SAT Subject Test Code 1

• SAT Subject Test Code 2

• SAT Subject Test Code 3

• SAT Subject Test Code 4

• SAT Subject Test Code 5

• SAT Subject Test Code 6

• SAT Subject Test Code 7

• SAT Subject Test Code 8

• SAT Subject Test Code 9

• SAT Subject Test Code 10

• Last Update Date

• Low SES

To complete the setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes

Scholastic Aptitude Test (SAT)

Note: Refer Doc ID 1997021.1 on My Oracle Support for detailed information on updated PDL templates
based on the redesigned SAT layout effective from October 2015. The 2015 SAT Mapping Workbook
contains all of the following information, updated for the revised SAT layout.

Delivered Transaction Code: SAD_SAT

Modify the delivered transaction as follows:

• Update the data update rule with one defined by your institution based on your constituent data update
policies.

• Search/Match Setup: Update the search parameter, search result codes and update rules based on your
institution’s needs.

File Parser Field Conversion Definition Template: SAD_SAT

Conversion examples are delivered for the following fields:
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• Academic Interest based on incoming First Choice Major, Other Major 1, Other Major 2, Other Major
3 and Other Major 4 values.

• Academic Level based on incoming Academic Level value.

• Academic Plan based on incoming First Choice Major value.

• Academic Program based on incoming First Choice Major value.

• Admit Term based on incoming Year of H.S. Graduation Date value.

• Art (College Activity Description) based on incoming Art value.

• Athletics: Intramural/Club (College Activity Description) based on incoming Athletics: Intramural or
Club Sports value.

• Athletics: Varsity Sports (College Activity Description) based on incoming Athletics: Varsity Sports
value.

• Citizenship based on incoming Citizenship value.

• Community/Service Organization (College Activity Description) based on incoming Community or
Service Organization value.

• Cooperative Work/Internship (College Activity Description) based on incoming Cooperative Work or
Internship Program value.

• Country based on incoming Country value.

• Dance (College Activity Description) based on incoming Dance value.

• Debating or Public Speaking (College Activity Description) based on incoming Debating or Public
Speaking value.

• Departmental Organization (College Activity Description) based on incoming Departmental
Organization value.

• Drama or Theater (College Activity Description) based on incoming Drama or Theater value.

• Environmental/Ecology Activity (College Activity Description) based on incoming Environmental or
Ecology Activity value.

• Ethnic Activity or Clubs (College Activity Description) based on incoming Ethnic Activity or Clubs

• Ethnicity based on incoming Ethnic value in position 994.

• Financial Aid based on incoming Financial Aid value.

• Foreign Study or Study Abroad (College Activity Description) based on incoming Foreign Study or
Study Abroad Program value.

• Fraternity Sorority/Social Club (College Activity Description) based on incoming Fraternity, Sorority,
or Social Club value.

• Gender based on incoming Sex value.
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• Honors Prog/Independent Study (College Activity Description) based on incoming Honors Program
or Independent Study value.

• Instrumental Music (College Activity Description) based on incoming Instrumental Music
Performance value.

• Journalism/Literary Activity (College Activity Description) based on incoming Journalism/Literary
Activity value.

• Planned Housing based on incoming Planned Housing value.

• ROTC (College Activity Description) based on incoming ROTC value.

• Religious Activity (College Activity Description) based on incoming Religious Activity value.

• Religious Preference based on incoming Religion value.

• Student Government (College Activity Description) based on incoming Student Government value.

• Test Component based on incoming Subject Test Code.

• Vocal Music (College Activity Description) based on incoming Vocal Music Performance value

Each of these conversions may need to be modified based on your internal values. Modify the delivered
version as it will be used on the File Mapping Definition component. Before modifying, make sure you
create a copy so that you have the original version.

Context Definition Template: SAD_SAT

Review the delivered template and determine if any records need to be added. Modify this delivered
version. It will be used on the File Mapping Definition component. Create a copy before doing so to keep
an original version. If you choose to use a copy of a delivered context definition and reference the copied
version in your file mapping definition, the system forces you to redefine the file layout and file mapping
setup.

File Mapping Definition Template: SAD_SAT_TESTPROSPECT

This file mapping definition can be used to create prospects, populate test scores and populate supporting
data such as academic interests and extracurricular activities. You will need to make changes to this
delivered template to reflect institution defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context and conversion definitions as SAD_SAT. If you change this, all the file
layout and mapping setup will disappear.

If needed, change the delimiter based on your file characteristics.

File Layout Tab:

Review this tab to ensure that fields appear in the exact order as that of the SAT layout you are using.
Also modify the default Date Day and Date Month values for Year of H.S. Graduation.

Mapping Tab:
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The default values for the following fields need to be reviewed and probably modified depending upon
your institution’s business practices:

• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

• SCC_STG_STD_CAR.ACAD_CAREER

• SAD_PRS_CAR_STG.ACAD_CAREER

• SAD_PRS_CAR_STG.INSTITUTION

• SAD_PRS_CAR_STG.RECRUITING_STATUS

• SAD_PRS_CAR_STG.ADM_REFRL_SRCE

• SAD_PRS_CAR_STG.ACADEMIC_LEVEL

• SAD_PRS_CAR_STG.CAMPUS

• SAD_STG_PRS_CAF.ACAD_CAREER – Six rows

• SAD_STG_PRS_CAF.INSTITUTION – Six rows

• SAD_PRS_PRG_STG.ACAD_CAREER

• SAD_PRS_PRG_STG.INSTITUTION

• SAD_PRS_PRG_STG.RECRUITING_STATUS

• SAD_PRS_PRG_STG.CAMPUS

• SAD_PRS_PLN_STG.ACAD_CAREER

• SAD_PRS_PLN_STG.INSTITUTION

• SCC_STG_ADMIHD.ACAD_CAREER

• SCC_STG_ADMINT.ACAD_CAREER – Five rows

• SCC_STG_ADMINT.LS_DATA_SOURCE – Five rows

• SCC_STG_TEST.TEST_ID – Two rows

• SCC_STG_TESTCMP.TEST_ID – Forty Eight Rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Thirty rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Forty Eight rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Seven rows
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Calculated Fields: The following calculated fields have been delivered for SAT:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.COUNTRY – Interrogates Foreign Address Indicator in position 135. If ‘Y’ then
populates COUNTRY from field conversion COUNTRY, otherwise uses USA.

• SCC_STG_ADDR.STATE – Populates STATE position 92-93 if Country = CAN or USA. For all
other countries, STATE is not populated.

• SCC_STG_ADDR.POSTAL – Populates POSTAL position 95 – 103 only if Country = USA.

• SAD_PRS_CAR_STG.ADM_RECR_CTR - Looks at the prospect setup you have defined to
determine recruiting center. If you don’t set up the Prospect Setup page, you will need to change this
to a default recruiting center.

• SAD_PRS_CAR_STG.LAST_SCH_ATTEND - Uses the incoming value from High School
Code Number in position 1016 to determine the EXT_ORG_ID to populate based on the
EXT_ORG_TBL_ADM.ACT_CODE.

• SCC_STG_ADMINT.DESCR – Derives the academic interest description DESCR based on the
incoming First Choice Major starting at position 933, Other Major 1 starting at position 937, Other
Major 2 starting at position 940, Other Major 3 starting at position 943, Other Major 4 starting at
position 946, from table EXT_SUBJECT_TBL.

• SCC_STG_TEST.CHKLST_ITM_UPDT for second row where Test ID = SATII – Interrogates
incoming Subject Test Codes to determine if this row of SCC_STG_TEST should be created. If codes
are not present, the row is not created.

File Mapping Definition Template: SAD_SAT_TESTRESULTS

This file mapping definition can be used to post SAT test scores. You will need to make changes to this
delivered template to reflect institution-defined default values. Before doing so, make a copy of the
delivered template.

File Definition Tab:

Important! Leave the context and conversion definitions as SAD_SAT. If you change this, all the file
layout and mapping setup will disappear.

If needed, change the delimiter based on your file characteristics.

File Layout Tab:

Review this tab to ensure the fields appear in the exact order as that of the SAT layout you are using.

Mapping Tab:

The default values for the following fields will need to be reviewed and probably modified depending
upon your institution’s business practices:
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• SCC_STG_NAMES.NAME_TYPE

• SCC_STG_ADDR.ADDRESS_TYPE

• SCC_STG_EMAIL.E_ADDR_TYPE

• SCC_STG_PHONE.PHONE TYPE

• SCC_STG_ETH_DTL.HISP_LATINO

• SCC_STG_TEST.TEST_ID – Two rows

• SCC_STG_TESTCMP.TEST_ID – Forty Eight Rows

• SCC_STG_TESTCMP.TEST_COMPONENT – Thirty rows

• SCC_STG_TESTCMP.LS_DATA_SOURCE – Forty Eight rows

• SCC_STG_TESTDT.TEST_ID

• SAD_STG_TST_CAF.TEST_ID – Seven rows

Calculated Fields: The following calculated fields have been delivered for SAT:

• SCC_STG_NAMES.LAST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_NAMES.FIRST_NAME_SRCH - Removes all special characters and puts the field into
upper case.

• SCC_STG_ADDR.COUNTRY – Interrogates Foreign Address Indicator in position 135. If ‘Y’ then
populates COUNTRY from field conversion COUNTRY, otherwise uses USA.

• SCC_STG_ADDR.STATE – Populates STATE position 92-93 if Country = CAN or USA. For all
other countries, STATE is not populated.

• SCC_STG_ADDR.POSTAL – Populates POSTAL position 95 – 103 only if Country = USA.

• SCC_STG_TEST.CHKLST_ITM_UPDT for second row where Test ID = SATII. – Interrogates
incoming Subject Test Codes to determine if this row of SCC_STG_TEST should be created. If no
codes are present, the row is not created.

Common Attribute Framework

The following sample common attributes have been delivered for the incoming field indicated.

These attributes should be associated with the SAD_TESTDT record context:

• SAT_REV_SC_IND1 for SAT Revised Score Indicator 1

• SAT_LAT_ESS_ID for Latest SAT Essay ID

• SAT_ESS_ID_AD2 for SAT Essay ID Admin 2

• SAT_ESS_ID_AD3 for SAT Essay ID Admin 3

• SAT_READ_ST_PCT for Reading State Percentile
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• SAT_MATH_ST_PCT for Mathematics State Percentile

• SAT_WR_ST_PCT for Writing State Percentile

These attributes should be associated with the ADM_PRSPCT_CAR record context:

• SAT_GRD_PT_AVG for Grade Point Average

• SAT_HS_CLASSRANK for High School Class Rank

• SAT_DEGR_GOAL for Degree Goal

• SAT_PART_TM_JOB for Part-Time Job

• SAT_FIRST_LANG for First Language

• SAT_BEST_LANG for Best Language

Set up additional common attributes for other fields that have not been mapped on the File Mapping
Definition component. Add each new attribute to the SAD_TESTDT or ADM_PRSPCT_CAR record
context depending on your business process. In addition to creating the common attribute and adding
them to the record context, you will need to add rows for each common attribute on the File Mapping
Definition component.

Additional fields that were not mapped upon initial delivery of the SAT File Mapping Definitions include:

• College Code

• Residence Code

• EPS Market

• Foreign Address Indicator

• SAT Revised Score Indicator 2

• SAT Revised Score Indicator 3

• SAT Revised Score Indicator 4

• SAT Revised Score Indicator 5

• SAT Revised Score Indicator 6

• Revised Score Indicator 1

• Subject Test 1-1 Subscore 1

• Subject Test 1-1 Subscore 2

• Subject Test 1-1 Subscore 3

• Subject Test 1-2 Subscore 1

• Subject Test 1-2 Subscore 2

• Subject Test 1-2 Subscore 3
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• Subject Test 1-3 Subscore 1

• Subject Test 1-3 Subscore 2

• Subject Test 1-3 Subscore 3

• Subject Test 2-1 Subscore 1

• Subject Test 2-1 Subscore 2

• Subject Test 2-1 Subscore 3

• Subject Test 2-2 Subscore 1

• Subject Test 2-2 Subscore 2

• Subject Test 2-2 Subscore 3

• Subject Test 2-3 Subscore 1

• Subject Test 2-3 Subscore 2

• Subject Test 2-3 Subscore 3

• Subject Test 3-1 Subscore 1

• Subject Test 3-1 Subscore 2

• Subject Test 3-1 Subscore 3

• Subject Test 3-2 Subscore 1

• Subject Test 3-2 Subscore 2

• Subject Test 3-2 Subscore 3

• Subject Test 3-3 Subscore 1

• Subject Test 3-3 Subscore 2

• Subject Test 3-3 Subscore 3

• Subject Test 4-1 Subscore 1

• Subject Test 4-1 Subscore 2

• Subject Test 4-1 Subscore 3

• Subject Test 4-2 Subscore 1

• Subject Test 4-2 Subscore 2

• Subject Test 4-2 Subscore 3

• Subject Test 4-3 Subscore 1

• Subject Test 4-3 Subscore 2

• Subject Test 4-3 Subscore 3
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• Subject Test 5-1 Subscore 1

• Subject Test 5-1 Subscore 2

• Subject Test 5-1 Subscore 3

• Subject Test 5-2 Subscore 1

• Subject Test 5-2 Subscore 2

• Subject Test 5-2 Subscore 3

• Subject Test 5-3 Subscore 1

• Subject Test 5-3 Subscore 2

• Subject Test 5-3 Subscore 3

• Subject Test 6-1 Subscore 1

• Subject Test 6-1 Subscore 2

• Subject Test 6-1 Subscore 3

• Subject Test 6-2 Subscore 1

• Subject Test 6-2 Subscore 2

• Subject Test 6-2 Subscore 3

• Subject Test 6-3 Subscore 1

• Subject Test 6-3 Subscore 2

• Subject Test 6-3 Subscore 3

• Reading State Percentile

• Mathematics State Percentile

• Writing State Percentile

• Subject Test 1 Subscore 1 %ile

• Subject Test 1 Subscore 2 %ile

• Subject Test 1 Subscore 3 %ile

• Subject Test 2 Subscore 1 %ile

• Subject Test 2 Subscore 2 %ile

• Subject Test 2 Subscore 3 %ile

• Subject Test 3 Subscore 1 %ile

• Subject Test 3 Subscore 2 %ile

• Subject Test 3 Subscore 3 %ile
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• Arts and Music Years

• English Years

• Foreign and Classical Languages Years

• Mathematics Years

• Natural Sciences Years

• Social Sciences and History Years

• Chinese Years

• French Years

• German Years

• Greek Years

• Hebrew Years

• Italian Years

• Japanese Years

• Korean Years

• Latin Years

• Russian Years

• Spanish Years

• Other Language Course Years

• Algebra Years

• Geometry Years

• Trigonometry Years

• Precalculus Years

• Calculus Years

• Computer Math (no longer reported) Years

• Other Math Course Years

• Biology Years

• Chemistry Years

• Environmental, Earth, or Space Science Years

• Physics Years

• Other Science Course Years
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• U.S. History Years

• U.S. Gov’t/Civics Years

• European History Years

• World History Years

• Ancient History Years

• Anthropology (no longer reported) Years

• Economics Years

• Geography Years

• Psychology Years

• Sociology Years

• Other Social Science or History Course Years

• Arts and Music GPA

• English GPA

• Foreign and Classical Languages GPA

• Mathematics GPA

• Natural Sciences GPA

• Social Sciences and History GPA

• American Literature

• British Literature

• Composition

• English Language Arts

• Literature (other than US or British)

• Communications

• Public Speaking

• English as a Second Language

• Art/Music no experience

• Acting/Production of a Play

• Art Hist. or Appreciation

• Dance

• Drama or Theater for Appreciation
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• Music History, Theory, or Appreciation

• Music, Instrumental or Vocal Performance

• Photography or Filmmaking

• Studio Art and Design

• Computer No Experience

• Computer Basic Concepts

• Computer Word Processing

• Computer Programming

• Computer Use Spreadsheets/Databases

• Computer Graphics

• Computer Internet Activities

• High School/Community/Activities

• H.S. Activity Designator 1

• 9th Grade Activity 1

• 10th Grade Activity 1

• 11th Grade Activity 1

• 12th Grade Activity 1

• Office/Award Activity 1

• H.S. Activity Designator 2

• 9th Grade Activity 2

• 10th Grade Activity 2

• 11th Grade Activity 2

• 12th Grade Activity 2

• Office/Award Activity 2

• H.S. Activity Designator 3

• 9th Grade Activity 3

• 10th Grade Activity 3

• 11th Grade Activity 3

• 12th Grade Activity 3

• Office/Award Activity 3
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• H.S. Activity Designator 4

• 9th Grade Activity 4

• 10th Grade Activity 4

• 11th Grade Activity 4

• 12th Grade Activity 4

• Office/Award Activity 4

• H.S. Activity Designator 5

• 9th Grade Activity 5

• 10th Grade Activity 5

• 11th Grade Activity 5

• 12th Grade Activity 5

• Office/Award Activity 5

• H.S. Activity Designator 6

• 9th Grade Activity 6

• 10th Grade Activity 6

• 11th Grade Activity 6

• 12th Grade Activity 6

• Office/Award Activity 6

• H.S. Activity Designator 7

• 9th Grade Activity 7

• 10th Grade Activity 7

• 11th Grade Activity 7

• 12th Grade Activity 7

• Office/Award Activity 7

• H.S. Activity Designator 8

• 9th Grade Activity 8

• 10th Grade Activity 8

• 11th Grade Activity 8

• 12th Grade Activity 8

• Office/Award Activity 8
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• H.S. Activity Designator 9

• 9th Grade Activity 9

• 10th Grade Activity 9

• 11th Grade Activity 9

• 12th Grade Activity 9

• Office/Award Activity 9

• H.S. Activity Designator 10

• 9th Grade Activity 10

• 10th Grade Activity 10

• 11th Grade Activity 10

• 12th Grade Activity 10

• Office/Award Activity 10

• Sports

• Sport Designator 1

• Sport Designator 2

• Sport Designator 3

• Sport Designator 4

• Sport Designator 5

• Sport Designator 6

• 4-Year College or University

• 2-Year Community or Junior College

• Vocational/Technical School

• 2 or 4 Year Undecided

• Public University or College

• Private University or College (not religiously affiliated)

• Private, Religiously Affiliated University or College

• Private, Public Undecided

• Fewer than 2,000 Students

• 2,000–5,000 Students

• 5,000–10,000 Students
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• 10,000–20,000 Students

• More than 20,000 Students

• Size Undecided

• Large City or Metropolitan Area

• Medium-Size City

• Small City or Town

• Suburban Community

• Rural

• Setting Undecided

• Close to Home

• In My Home State

• In States Bordering Mine

• Beyond States Bordering Mine

• Outside of the U.S

• Location Undecided

• All Women or All Men

• Coeducational

• Type Undecided

• Art AP or Exempt

• Biology AP or Exempt

• Chemistry AP or Exempt

• Computer Science AP or Exempt

• English AP or Exempt

• Foreign Language AP or Exempt

• Humanities AP or Exempt

• Mathematics AP or Exempt

• Music AP or Exempt

• Physics AP or Exempt

• Social Studies AP or Exempt

• No Plans to Apply AP or Exempt
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• Educational Plans Requested Services

• Career Plans Requested Services

• Study Skills Requested Services

• Math Skills Requested Services

• Reading Skills Requested Services

• Writing Skills Requested Services

• No Plans for Help Requested Services

• High School Name

• High School Address 1

• High School Address 2

• High School Address 3

• High School Telephone Number

• High School Type

• Senior Class Size

• Percent of Seniors Going to College

• Location of High School

• Number of Advanced Placement Program® Courses Offered

• Honors Courses Offered

• Units to Graduate

• Date of Report

To complete setup for the delivered common attributes, see:

• Setting Up Common Attribute Framework

• Setting Up Filtering for Common Attributes
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Setting Up External Test Score Loads

Understanding External Test Score Loads Setup

Important! Test score load and other processes and components discussed in the Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

You must complete all the items in the following list before you can post external test scores to
PeopleSoft Campus Solutions or PeopleSoft CRM. When you post the test scores to CRM, the system
automatically creates prospect records in CRM from the posted test scores. However, when you post the
test scores to Campus Solutions, you can choose whether or not to create prospect records in Campus
Solutions.

• Define external test components.

• Define external tests.

• Define and review external data setup tables.

• Map external test IDs.

• Map external test codes to internal codes.

In addition to the above, if you want to post to PeopleSoft CRM you must enable the posting to CRM
option.

Enabling the Posting to CRM Option

Important! Test score load and other processes and components discussed in the Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

If you want to post test scores to PeopleSoft CRM, select the CRM for Higher Education check box on
the SA Features page (Set Up SACR >Install >Student Admin Installation >SA Features).
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This example illustrates the fields and controls on the SA Features page.

The Post To Enterprise CRM option is available on the Search/Match/Post Test Scores page only when
you select the CRM for Higher Education check box on the SA Features page.

Defining External Test Components

Important! Test score load and other processes and components discussed in the Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

To set up the external test components, use the Test Component Table component
(SA_TEST_COMP_TABLE).
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Page Used to Define External Test Components

Page Name Definition Name Navigation Usage

Test Component Table SA_TEST_COMP_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Test Component
Table

Define the test components 
(such as verbal, math, and
analytical) of external
academic tests (such as the
ACT, GMAT, and GRE).
 Also, create components of
placement and other tests
administered internally
by your institution. If a
component is used in more
than one test, define it only
once. Note that totals are
not computed by the system,
 so if you want to enter and
track totals, be sure to define
Total as one of your test
components.

Defining External Tests

Important! Test score load and other processes and components discussed in the Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

To define external tests, use the Test Tables component (SA_TEST_TABLE).

Page Used to Define External Tests

Page Name Definition Name Navigation Usage

Test Tables SA_TEST_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Test Tables

Define tests (such as the
ACT, GMAT, and GRE) and
associate test components
with the appropriate tests. You
can also associate tests on this
page with a particular testing
agency, such as American
College Testing, College
Board, Educational Testing
Services, and Law School
Admission Services.
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Defining External Tests
Access the Test Tables page (Set Up SACR > Product Related > Recruiting and Admissions >
External Test Scores > Test Tables).

This example illustrates the fields and controls on the Test Tables page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Testing Agency Select the testing agency that administers this test (if
applicable). This field is for informational purposes only.
 Values for this field are delivered with your system as
translate values. You can modify these translate values. The
delivered values are American College Testing, College Board,
 Educational Testing Services, and Law School Admission
Services.

Entity ID The system populates this field with the entity ID created in
the Entity Registry component.

See "Understanding Entity Registry" (Campus Community
Fundamentals)

See Understanding the Entity Registry Impacts

Component Enter the test components that you want to link to this
academic test. The system populates the descriptions based on
the code that you select. Define test components on the Test
Component Table page.
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Field or Control Description

Min Score/Max Score (minimum score/maximum score) Enter a test score range for each component.

Subtest Enter the code used for TS130 or TS189 processing of test
scores.

Defining and Reviewing External Data Setup Tables

Important! Test score load and other processes and components discussed in the Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

To define external data setup tables, use the AP Subject Test Codes component (AP_SUBJECT_CODES),
AP Country Codes (SAD_AP_CNTRY_TBL), ADA Country Codes component
(ADA_COUNTRY_TBL), AMCAS Credit Hour Codes component (AMCAS_CR_HR_CODE),
AMCAS GPA Codes component (AMCAS_GPA_CODE), AMCAS Ethnicity Mapping component
(SAD_AMC_ETHNIC_MAP), AMCAS Country Mapping component (SAD_AMC_CNT_MAP),
SAT Country Codes component (SAD_SAT_CNTRY_TBL), SAT Math Recentered Values component
(SAT_MATH_RECENTER), SAT Verbal Recentered Values component (SAT_VERBAL_RECENTR),
SAT II Test Codes component (SATII_TEST_CODES), SAT II Test Recentered Values component
(SATII_TST_RECENTER), Ethnicity Mapping component (SAD_ETHNIC_MAP), and the GMAT
State/Province Codes component (SAD_GMT_STATE_TBL). Use the CRS_MAJOR_CODE component
interface to load the data into the tables from these component interfaces.

Recruiting and Admissions delivers AP and SAT test codes, CRS major codes, MCAT credit hours, GPA
codes, and SAT recentered values. These codes and values are used in external data processing.

You can edit the delivered descriptions, but we recommend that the descriptions retain their original
meaning to avoid confusion when viewing the loaded test data.

This section discusses how to:

• Map AMCAS ethnic groups.

• Map AMCAS country codes.

• Map SAT country codes.

• Map ethnicity codes.

• Map GMAT state/province codes.
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Pages Used to Review External Data Setup Tables

Page Name Definition Name Navigation Usage

AP Subject Test Codes AP_SUBJECT_CODE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > AP Subject Test
Codes

Define or review the delivered
AP subject test codes or to
add or edit a code. This table
stores the test codes used on
the AP test.

You can link your own codes
and descriptions to these
codes so that the system
displays your codes after the
scores are posted. Use the
AP Subjects section on the
External Test Score Load
page to link your subject test
components to the delivered
codes.

AP Country Codes SAD_AP_CNTRY_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > AP Country Codes

Translates the AP country
values to internal PeopleSoft
country values during the
AP-specific load routine.
 The AP Country Codes table
is delivered with known
values set as of the date of
this publication. You might
need to add or delete rows to
accurately maintain the table
in the future.

ADA Country Table ADA_COUNTRY_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > ADA Country
Codes

Define or review the AADAS
country code. Before
processing the ADA external
test score load, use the
Country field to map AADAS
country codes used on the
ADA to PeopleSoft country
codes.

Note: This setup is relevant
only for posting to Campus
Solutions. The system does
not support posting ADA test
scores to CRM therefore this
setup is not needed for posting
test scores to CRM.

CRS Major Codes CRS_MJR_CD_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > CRS Major Codes

Review the delivered CRS
major codes or add or edit a
code.
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Page Name Definition Name Navigation Usage

AMCAS Credit Hours Codes AMCAS_CR_HR_CODE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > AMCAS Setup >
AMCAS Credit Hour Codes

Define or review the delivered
AMCAS credit hours codes
or add or edit a code. An
AMCAS file includes only
the actual number of credit
hours, so this table includes
the codes and descriptions that
are mapped to the AMCAS
credit hour types.

Note: This setup is relevant
only for posting to Campus
Solutions. The system does
not support posting AMCAS
test scores to CRM therefore
this setup is not needed for
posting test scores to CRM.

AMCAS GPA Codes AMCAS_GPA_CODE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > AMCAS Setup >
AMCAS GPA Codes

Define and review the
delivered AMCAS GPA codes
or add or edit a code. An
AMCAS file only includes
the actual GPA, so this
table includes the codes and
descriptions that are mapped
to the GPA.

Note: This setup is relevant
only for posting to Campus
Solutions. The system does
not support posting AMCAS
test scores to CRM therefore
this setup is not needed for
posting test scores to CRM.

AMCAS Ethnicity Map SAD_AMC_ETHNIC_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > AMCAS Setup >
AMCAS Ethnicity Mapping

For AMCAS and MCAT
only, map the race codes
provided by testing agency to
the corresponding PeopleSoft
codes in order to capture
ethnicity information on
the Add/Update a Person
component.

Note: This setup is relevant
only for posting to Campus
Solutions. The system does
not support posting AMCAS
test scores to CRM therefore
this setup is not needed for
posting test scores to CRM.
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Page Name Definition Name Navigation Usage

AMCAS Country Mapping SAD_AMC_CNT_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > AMCAS Setup >
AMCAS Country Mapping

Map the AMCAS country
code values to the
corresponding PeopleSoft
country code values.

Note: This setup is relevant
only for posting to Campus
Solutions. The system does
not support posting AMCAS
test scores to CRM therefore
this setup is not needed for
posting test scores to CRM.

SAT Country Codes SAD_SAT_CNTRY_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > SAT Setup > SAT
Country Codes

Translates the SAT country
values to internal PeopleSoft
country values during the SAT
specific load routine.

SAT Math Recentered Values SAT_MATH_RECENTER Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > SAT Setup > SAT
Math Recentered Values

Review or edit the recentered
SAT math score values. When
you process SAT math scores,
 the system recenters some of
the scores (as indicated by the
SAT load) according to the
values in this table. When the
system recenters scores, only
the recentered scores post to
the person's record.

The system displays the score
it receives from the testing
agency in the Math Score
field. The translated score
appears in the Recentered
Math Score field. This is
the score that the reported
score is translated to when it
is processed.
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Page Name Definition Name Navigation Usage

SAT Verbal Recentered
Values

SAT_VERBAL_RECENTR Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > SAT Setup > SAT
Verbal Recentered Values

Review or edit the recentered
SAT verbal score values.
When you process SAT verbal
scores, the system recenters
some of the scores according
to the values in this table.
 When the system recenters
scores, only the recentered
scores post to the person's
record.

The system displays the
score that it receives from the
testing agency in the Verbal
Score field. The score that
appears in the Recentered
Verbal Score field is what the
reported score is translated to
when it is processed.

SAT II Test Codes SATII_CODE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > SAT Setup > SAT
II Test Codes

Review the delivered SAT
II test codes or add or edit a
code. You can link your own
codes and descriptions to the
codes that you received in
an SAT II tape or file so that
your codes appear on your
Admissions pages.

SAT II Test Recentered Values SATII_TST_RECENTER Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > SAT Setup > SAT
II Test Recentered Values

Review or edit the recentered
test score values for each
SAT II test code. When you
process SAT II scores, the
system recenters the scores
according to the values in this
table. Only the recentered
scores post to the person's
record.

The left column lists the SAT
II test scores received from
the testing agency.

The right column lists the
recentered test scores, which
are what the reported score
is translated to when it is
processed.

Ethnicity Map SAD_ETHNICITY_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Ethnicity Mapping

Map the ethnicity codes
provided by testing agencies
to the corresponding
PeopleSoft codes in order to
capture ethnicity information
on the Bio/Demo Data
component.
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Page Name Definition Name Navigation Usage

GMAT State/Province Codes SAD_GMT_STATE_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > External
Test Scores > GMAT State/
Province Codes

Define or review the mapping
of GMAT State/Province
codes to PeopleSoft State/
Province codes.

Mapping AMCAS Ethnic Groups
Access the AMCAS Ethnicity Map page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > AMCAS Setup > AMCAS Ethnicity Mapping).

This example illustrates the fields and controls on the AMCAS Ethnicity Map page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Ethnic Group Enter the internal ethnic group value that corresponds to the
race code.

AMCAS Race Code Enter the external AMCAS race code.

Copy Ethnicity Map to New Application Year Click to copy ethnicity mapping data from one application
year to another. The system prompts you for the new year
value.

Mapping AMCAS Country Codes
Access the AMCAS Country Mapping page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > AMCAS Setup > AMCAS Country Mapping).
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This example illustrates the fields and controls on the AMCAS Country Mapping page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Copy Country Map to New Application Year The country code mappings are keyed by application year.
 Click this button to copy values from one application year to a
new application year. You might need to add or delete rows to
accurately maintain the table in the future.

Some AMCAS country codes do not have equivalent PeopleSoft country codes. Hence, these are not
delivered. Your institution must determine the mappings for these values.
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Mapping SAT Country Codes
Access the SAT Country Codes page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > SAT Setup > SAT Country Codes).

This example illustrates the fields and controls on the SAT Country Codes page (top of page). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the SAT Country Codes page (bottom of page). You can
find definitions for the fields and controls later on this page.

The SAT Country Codes table is delivered with known field values set as of the date of this publication.
You might need to add, edit, or delete rows to accurately maintain the table in the future.

Field or Control Description

SAT Country Code and SAT Country Description SAT country codes, descriptions and their corresponding
PeopleSoft country codes are delivered in the table.

State/Province If a state or province is associated with the specific SAT code,
 that state or province is also delivered in the table.

Mapping Ethnicity Codes
Access the Ethnicity Map page (Set Up SACR > Product Related > Recruiting and Admissions >
External Test Scores > Ethnicity Mapping).

Copyright © 1988, 2021, Oracle and/or its affiliates. 423



Setting Up External Test Score Loads Chapter 11

This example illustrates the fields and controls on the Ethnicity Map page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Ethnic Group Enter the ethnic group code that corresponds to the testing
agency code. Ethnicity group codes are defined on the
Ethnicity Group Table page.

Ethnicity Enter the ethnicity code provided by the testing agency. You
must contact the testing agency for these codes or refer to the
test score layout provided by the testing agency.

For AMCAS and MCAT ethnicity data, use the AMCAS Ethnicity Map component.

See Mapping AMCAS Ethnic Groups.

Mapping GMAT State/Province Codes
Access the GMAT State/Province Codes page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > GMAT State/Province Codes).
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This example illustrates the fields and controls on the GMAT State/Province Codes page. You can find
definitions for the fields and controls later on this page.

Use this page to define or review the mapping of GMAT State/Province codes to PeopleSoft State/
Province codes for the following countries: Australia, Brazil, Canada, China, India, Japan, Mexico and
the United States.

For the country of Pakistan, State/Province values do not exist in the PeopleSoft State/Province Table.
You must therefore map the GMAT State/Province codes for Pakistan to the State/Province codes that you
have set up for Pakistan in Campus Solutions.

The GMAT State/Province Codes table is delivered with known field values set as of the date of this
publication. You might need to add, edit, or delete rows to accurately maintain the table in the future.
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Mapping External Tests IDs

Important! Test score load and other processes and components discussed in the Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

To map external test IDs, use the External Test Score Mapping component (SAD_TEST_SETUP).

This section provides an overview of external test ID mapping and discusses how to map external test
score IDs to PeopleSoft test codes.

Understanding External Test ID Mapping
The PeopleSoft system uses the External Test Score Mapping page to perform a variety of external test-
related functions.

The PeopleSoft system needs to know which test IDs from your institution correspond to the PeopleSoft
test codes in order to know which fields to display on the external test score components. For example,
when you enter the External Test Score Load page and select a test ID, the page dynamically appears
based on the test ID that you enter.

In addition, when you create a query in PeopleSoft Query Manager to create prospects from test loads, the
query must contain the primary candidate data record for the test. To determine which is the primary data
record, go to the External Test Score Mapping page, where the primary candidate data record is indicated.
Also, the records listed under Suspense Records are used in the External Test Score Purge process.

Page Used to Map External Tests IDs to PeopleSoft Test Codes

Page Name Definition Name Navigation Usage

External Test Score Mapping SAD_TEST_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > External
Test Scores > External Test
Score Mapping

Map your test ID defined
on the Test Tables page to
the PeopleSoft test code.
 The system needs this
setup to perform a variety of
external test-related functions.
 Also determine the primary
candidate data record for a
test, which you will need if
you want to create prospect
records from test score loads
using a PeopleSoft Query
Manager.

Mapping External Tests IDs to PeopleSoft Test Codes
Access the External Test Score Mapping page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > External Test Score Mapping).

426  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 11 Setting Up External Test Score Loads

This example illustrates the fields and controls on the  External Test Score Mapping page . You can find
definitions for the fields and controls later on this page.

Field or Control Description

Test ID Enter a test ID for each PeopleSoft test code. If you have more
than one test ID affiliated to the PeopleSoft test code, add a
row and enter the additional test ID.

Available for CRM Post Indicates whether the scores for the test ID can be posted to
PeopleSoft CRM. For example, you can post ACT, AP, CRS,
 DAT, EOS, GMS, GMT, GRE, LSAT, SAT, SSS and TOEFL
scores to CRM, therefore, the system selects the Available
for CRM Post check box for these test IDs. Conversely, you
cannot post ADA, AMCAS, LSDAS, NCEA, OUAC, QTAC,
 SATAC, Studielink, UAC, and VTAC test scores to CRM,
 therefore, the system does not select the Available for CRM
Post check box for these test IDs.

Note: On this page, you need to enter only a test ID that corresponds to a PeopleSoft test code. PeopleSoft
delivers the rest of the page complete. All test IDs that you have defined and that you intend to load
through the external test score load must be mapped to a PeopleSoft test code or you will not be able to
load test score data.
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Warning! Do not delete the suspense or candidate data records delivered or change the primary records
flag because these changes will affect the External Test Score Load and Create Prospects from Test Scores
processes.

Mapping External Test Codes to Internal Codes

Important! Test score load and other processes and components discussed in the Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

To map external test codes to internal codes, use the Academic Interests Map component
(SAD_ACAD_MAP), Extracurricular Activity Map component (SAD_EXTRA_MAP), and the Religious
Preference Map component (SAD_REL_MAP).

This section provides an overview of external test data mapping and discusses how to:

• Map academic interest codes.

• Map extracurricular activity codes.

• Map religious preference codes.

• Map admit terms.

• Map programs, plans and subplans.

Related Links
Creating Prospects When Posting External Test Scores

Understanding External Test Data Mapping
In order to populate academic interest, extracurricular activity, and religious preference information from
external test score loads, you must map the testing agency codes to the corresponding PeopleSoft codes.
Use the Academic Interest Map, Extracurricular Activity Map, and Religious Preference Map pages
to map external codes to internal codes. Set up these pages only if you want to populate that data for
prospects.

Map the following codes:

• Academic interest.

You set up internal academic interest codes on the External Subject Table page. If you set up the
Academic Interests Map page, when you create prospects from the external test loads listed in the
following table, the system populates the Academic Interests page for each new prospect that the
system creates based on the data populated in the Test Score Candidate Data component. This data is
provided by students when they take the specific tests.
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The following table shows the external tests that provide academic interest information and where in
the candidate data record that the system finds this information for each test:

Test ID Location in Test Score Candidate Data Component

ACT Academics page, Academic Information group box, Major
Plan field.

EOS Test Score Candidate Data page, Student Profile
Information group box, Intended Major field.

GMASS Test Score Candidate Data page, Additional Information
group box, Area of Concentration field.

SAT Student Data page, Majors group box, First Choice and
Other (1) through Other (4) fields.

SSS Student Data page, SSS SAT I Search Information group
box, SAT Search Listed Major field or SSS PSAT Search
Information group box, PSAT/NMSQT Search Listed
Major field.

GRE Test Score Candidate Data page, Grad Major Code field

• Extracurricular activity.

You set up internal extracurricular codes on the Extracurricular Activity Table page. If you set up the
Extracurricular Activity Map page, the system populates the Extracurricular Activities page when you
create prospects from ACT or SAT external test score loads based on the data populated in the Test
Score Candidate Data component. This data is provided by the students when they take the specific
tests.

The following table shows the external tests that provide extracurricular activity information and
where in the candidate data record that the system finds this information for each test:

Test ID Location in Test Score Candidate Data Component

ACT Activities page where the Participation field is selected for
college activities or where the Participated field is selected
for high school activities.

SAT Student Data page, High School/Community Activities
group box, and School Data page, College Activities group
box.

• Religious preference

Set up religious preference codes on the Religious Preference Table page. When you create prospects
from external test loads, the system populates the Religious Preference page for each new prospect
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that the system creates from the external test score load based on the data populated in the Test Score
Candidate Data component. This data is provided by the students when they take the specific tests.

The following table shows the external tests that provide religious preference information and where
in the candidate record that the system finds this information for each test:

Test ID Location in Test Score Candidate Data Component

ACT Personal Information page, Profile Information group box,
 Religion field.

SAT Student Data page, SDQ Information group box, Religion
field.

Pages Used to Map External Test Codes to Internal Codes

Page Name Definition Name Navigation Usage

Academic Interests Map SAD_ACAD_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Create Prospects
Setup > Academic Interests
Map

Map the academic interest
codes provided by some
external testing agencies to
the corresponding PeopleSoft
codes to capture academic
interest information when
creating prospects from
certain test loads. Set up
this page only if you want
to capture academic interest
information when creating
prospects from test score
loads.

The following test layouts
provide a major interest: ACT,
 EOS, GMASS, SAT, GRE,
 and SSS.

Extracurricular Activity Map SAD_EXTRA_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Create Prospects
Setup > Extracurricular
Activity Map

Map the extracurricular
activity codes provided by
the ACT and ETS testing
agencies to the corresponding
PeopleSoft codes to capture
academic interest information
when creating prospects
from ACT or SAT test score
loads. Set up this page
only if you want to capture
extracurricular activity
information when creating
prospects from test score
loads.
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Page Name Definition Name Navigation Usage

Religious Preference Map SAD_REL_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External
Test Scores > Create
Prospects Setup > Religious
Preference Map

Map the religious preference
codes provided by the ACT
and ETS testing agencies to
the corresponding PeopleSoft
codes to capture religious
preference information when
creating prospects from ACT
or SAT test score loads. Set up
this page only if you want to
capture religious preference
information when creating
prospects from test score
loads.

Admit Term Map SAD_TERM_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Create Prospects
Setup > Admit Term Map

Map the graduation dates
provided by a test layout to
the corresponding PeopleSoft
admit terms. Set up this page
only if the test layout provides
a graduation date and you
want the system to use that
date to determine the admit
term when creating a prospect
from a test score load.

The following test layouts
provide a graduation date:
ACT, CRS, EOS, GMAT, and
SAT.

Program Plan SubPlan Map SAD_INTPROG_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Create Prospects
Setup > Program Plan
SubPlan Map

Map each interest code
provided by the testing agency
to a program, plan or subplan.
 Set up this page only if the
test layout provides an interest
code and you want the system
to use the code to determine
the program, plan or subplan
when creating a prospect from
the test load.

The following test layouts
provide a major interest: ACT,
 EOS, GMASS, SAT, GRE,
 and SSS.

Mapping Academic Interest Codes
Access the Academic Interests Map page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > Create Prospects Setup > Academic Interests Map).
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This example illustrates the fields and controls on the Academic Interests Map page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Academic Interest Enter the internal academic interest code that corresponds to
the testing agency code. Academic interest codes are defined
on the External Subject Table page.

Interest Code Enter the interest code provided by the testing agency. You
must contact the testing agency for these codes or refer to the
test score layout provided by the testing agency.

Mapping Extracurricular Activity Codes
Access the Extracurricular Activity Map page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > Create Prospects Setup > Extracurricular Activity Map).
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This example illustrates the fields and controls on the Extracurricular Activity Map page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Extracurricular Activity Enter the internal extracurricular activity code that corresponds
to the testing agency code. Extracurricular activity codes are
defined on Extracurricular Activity Table page.

Activity Code Enter the activity code provided by the testing agency. You
must contact the testing agency for these codes or refer to the
test score layout provided by the testing agency.

College Activity The SAT and ACT testing agencies record two types of
activity information: high school/community activities that the
student has participated in and the activities that the student
wants to participate in when in college. Select this check box if
you want to populate extracurricular activities with the activity
that the student wants to participate in when in college.
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Field or Control Description

High School/Community Activity Select this check box if you want to populate extracurricular
activities with the activity from the student's high school/
community activity data.

Mapping Religious Preference Codes
Access the Religious Preference Map page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > Create Prospects Setup > Religious Preference Map).

This example illustrates the fields and controls on the Religious Preference Map page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Religious Preference Enter the religious preference code that corresponds to the
testing agency code. Religious preference codes are defined on
the Religious Preference Table page.

Religion Code Enter the religion code provided by the testing agency. You
must contact the testing agency for these codes or refer to the
test score layout provided by the testing agency.

Mapping Admit Terms
Access the Admit Term Map page (Set Up SACR > Product Related > Recruiting and Admissions >
External Test Scores > Create Prospects Setup > Admit Term Map).
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This example illustrates the fields and controls on the Admit Term Map page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Graduation Date From and Graduation Date To Enter graduation date ranges for the test layouts that provide a
graduation date.

Term Enter the admit term that corresponds to the graduation date
range.

When you run the Test Score Load process, the system uses this mapping to determine the relevant
admit term for the prospect. For example, let us suppose that for SAT I you have mapped 2009 Fall to
the Graduate to and from dates of January 24, 2009 and August 15, 2009. When you import a SAT I
test score, and if the test score of a prospect contains a graduation date of January 25 2009, the system
determines 2009 Fall as the admit term for the prospect.

Note that you cannot map overlapping dates to different admit terms. For example, if you have mapped a
graduation date range of January 24, 2009 and August 15, 2009 to 2009 Fall for SAT I, then you cannot
map a graduation date range of May 1, 2009 and August 15, 2009 to a different admit term for SAT I.

Mapping Programs, Plans and Subplans
Access the Program Plan SubPlan Map page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > Create Prospects Setup > Program Plan SubPlan Map).
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This example illustrates the fields and controls on the Program Plan SubPlan Map page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Interest Code Enter the interest code provided by the testing agency. You
must contact the testing agency for these codes or refer to the
test score layout provided by the testing agency.

Academic Program, Academic Plan, Academic Sub-Plan Enter the academic program, plan or subplan that corresponds
to the interest code

When you run the Test Score Load process, the system uses this mapping to determine the relevant
academic program, plan or subplan for the prospect. For example, let us suppose that for SAT I you have
mapped interest code 450 to the Fine Arts Undergraduate program and Music plan. When you import an
SAT I test score and the test score of a prospect contains the interest code 450, the system determines the
program as Fine Arts Undergraduate and the plan as Music for the prospect.
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(CAN) Setting Up to Receive OUAC
Transactions

Setting Up EDI Manager for OUAC Transactions

Electronic Data Interchange (EDI) is a means of transmitting data electronically from one entity to
another. Through the EDI Manager, you can receive data files from external sources and load important
recruiting and admissions data into staging tables, where you can review and edit the data. You can then
post the data to tables in your database.

Before you begin processing external OUAC transactions, you must set up conversion parameters in the
EDI Manager. This setup enables the EDI Manager to recognize OUAC elements (such as OUAC element
number 400 - expected enrollment date) and to map data from OUAC elements to PeopleSoft objects
(such as the field ADMIT_TERM in the table ADM_APPL_PROG).

To map OUAC elements to PeopleSoft objects, you must first define a conversion type definition, such as
ADMIT_TERM, for the destination objects in your database. Use the Conversion Type Definition page
to define conversion type definitions. Then, you must define conversion data profiles that relate internal
values to external values. Use the Conversion Data Profile page to define conversion data profiles. Last,
define an inbound map definition that links the OUAC element to the PeopleSoft object. Use the Business
Document Layout page to map OUAC elements to PeopleSoft objects. EDI Manager pages are discussed
in more detail in your PeopleSoft PeopleTools documentation.

This table lists the OUAC elements that are school specific:

OUAC ELEMENT EC Map ID Business Doc Record Name

010 - Institution OUAC_LAW_A

OUAC_LAW_U

OUAC_PT

OUAC_TEA_A

OUAC_TEA_U

OUAC_UAS_A

OUAC_UAS_U

OUAC_CTL_WD

OUAC_CTL_WD

OUAC_CTL_WD

OUAC_CTL_WD

OUAC_CTL_WD

OUAC_CTL_WD

OUAC_CTL_WD

INSTITUTION

INSTITUTION

INSTITUTION

INSTITUTION

INSTITUTION

INSTITUTION

INSTITUTION
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OUAC ELEMENT EC Map ID Business Doc Record Name

395 - University/Program
Desired

OUAC_UAS_A

OUAC_UAS_U

OUAC_UAS_U

OUAC_PT

OUAC_A5_U5_WD

OUAC_A5_U5_WD

OUAC_D1_WD

OUAC_A5_U5_WD

ACAD_PROG

ACAD_PROG

ACAD_PROG

ACAD_PROG

400 - Expected Enrollment
Date

OUAC_UAS_A

OUAC_UAS_U

OUAC_UAS_U

OUAC_PT

OUAC_A5_U5_WD

OUAC_A5_U5_WD

OUAC_D1_WD

OUAC_A5_U5_WD

ADMIT_TERM

ADMIT_TERM

ADMIT_TERM

ADMIT_TERM

410 - Full or Part-time OUAC_UAS_A

OUAC_UAS_U

OUAC_PT

OUAC_A5_U5_WD

OUAC_A5_U5_WD

OUAC_A5_U5_WD

ACAD_LOAD_APPR

ACAD_LOAD_APPR

ACAD_LOAD_APPR

411 - Year Desired OUAC_UAS_A

OUAC_UAS_U

OUAC_PT

OUAC_A5_U5_WD

OUAC_A5_U5_WD

OUAC_A5_U5_WD

ACADEMIC_LEVEL

ACADEMIC_LEVEL

ACADEMIC_LEVEL

440 - Residence Information
Requested

OUAC_UAS_A

OUAC_UAS_U

OUAC_PT

OUAC_A5_U5_WD

OUAC_A5_U5_WD

OUAC_A5_U5_WD

HOUSING_INTEREST

HOUSING_INTEREST

HOUSING_INTEREST

600 - Final or Interim OUAC_UAS_A

OUAC_UAS_U

OUAC_M2_WD

OUAC_M2_WD

TRNSCRPT_STATUS

TRNSCRPT_STATUS

755 - Last Session of Study at
CEGEP

OUAC_UAS_A

OUAC_UAS_U

OUAC_C1_WD

OUAC_C1_WD

EXT_TERM

EXT_TERM

765 - Session CEGEP Course
Taken

OUAC_UAS_A

OUAC_UAS_U

OUAC_C2_WD

OUAC_C2_WD

EXT_TERM

EXT_TERM
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OUAC ELEMENT EC Map ID Business Doc Record Name

531 - Year Level OUAC_PT

OUAC_TEA_A

OUAC_TEA_U

OUAC_UAS_A

OUAC_UAS_U

OUAC_PI_WD

OUAC_PI_WD

OUAC_PI_WD

OUAC_PI_WD

OUAC_PI_WD

EXT_ACAD_LEVEL

EXT_ACAD_LEVEL

EXT_ACAD_LEVEL

EXT_ACAD_LEVEL

EXT_ACAD_LEVEL

533 - Diploma Received OUAC_LAW_A

OUAC_LAW_U

OUAC_PT

OUAC_TEA_A

OUAC_TEA_U

OUAC_UAS_A

OUAC_UAS_U

OUAC_G2_H2_WD

OUAC_G2_H2_WD

OUAC_PI_WD

OUAC_PI_WD

OUAC_PI_WD

OUAC_PI_WD

OUAC_PI_WD

OUAC_DIPLOMA_CODE

OUAC_DIPLOMA_CODE

OUAC_DIPLOMA_CODE

OUAC_DIPLOMA_CODE

OUAC_DIPLOMA_CODE

OUAC_DIPLOMA_CODE

OUAC_DIPLOMA_CODE

665 - University/Program
Desired

OUAC_UAS_A

OUAC_UAS_U

OUAC_AR_WD

OUAC_AR_WD

ACAD_PROG

ACAD_PROG

670 - Enrollment 1 Offered OUAC_UAS_A

OUAC_UAS_U

OUAC_AR_WD

OUAC_AR_WD

ADMIT_TERM

ADMIT_TERM

840 - University/Program
Code

OUAC_TEA_A

OUAC_TEA_U

OUAC_TEA_U

OUAC_A8_U8_WD

OUAC_A8_U8_WD

OUAC_D1_WD

ACAD_PROG

ACAD_PROG

ACAD_PROG

860 - Residence Information
Requested

OUAC_TEA_A

OUAC_TEA_U

OUAC_A8_U8_WD

OUAC_A8_U8_WD

HOUSING_INTEREST

HOUSING_INTEREST

685 - Year Level Offered OUAC_UAS_A

OUAC_UAS_U

OUAC_AR_WD

OUAC_AR_WD

ACADEMIC_LEVEL

ACADEMIC_LEVEL

1400 - Course Level OUAC_UAS_A

OUAC_UAS_U

OUAC_UAS_A

OUAC_UAS_U

OUAC_F2_WD

OUAC_F2_WD

OUAC_F3_WD

OUAC_F3_WD

COURSE_LEVEL

COURSE_LEVEL

COURSE_LEVEL

COURSE_LEVEL
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OUAC ELEMENT EC Map ID Business Doc Record Name

825 - Degree Code OUAC_TEA_A

OUAC_TEA_U

OUAC_A8_U8_WD

OUAC_A8_U8_WD

OUAC_DIPLOMA_CODE

OUAC_DIPLOMA_CODE

This table lists the translates that the PeopleSoft system maintains as transaction processing (TP)
converts:

OUAC ELEMENT Transactions TP Convert Name

170 - Country of Current Citizenship A4 OUAC_CNTRY

180 - Citizenship, Appendix 9.A.30 A4 OUAC_CNTRY

190 - Country of Residence, Appendix 9.
A.30

A4 OUAC_CNTRY

200 - Province of Residence A4 OUAC_PROV

220 - Immigration Status A4 CitznStat

230 - Gender A4 Sex

250 - Marital Status A4 MAR_STATUS

270 - First Language A4 Accmpl-Lng

542 - Country where attended English
School

A5 OUAC_CNTRY

573 - Response to OSAP Question A5 OUAC_Y/N

2174 - LSAT Misconduct Flag J1 OUAC_Y/N

1080 - Country of Birth A5 OUAC_CNTRY

280 - Language of Correspondence A4 Accmpl-Lng

450 - Language of Instruction A5 Language

581 - Language of Instruction M2 Language

865 - Language of Instruction A8 Language
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OUAC ELEMENT Transactions TP Convert Name

430 - Previous Yr Applied to this Inst A5 Prior_Appl

114 - Mailing Address Country B7 OUAC_FCTRY

154 - Home Address Country B8 OUAC_FCTRY

560 - Achievement of OSSD M1 Degr_Stat

2168 - Plan to Write LSAT Future J1 OUAC_Y/N

2106 - Emergency Contact Country B9 OUAC_FCTRY

This table lists the translates that the PeopleSoft system maintains as translate tables:

OUAC ELEMENT Transactions Field Name

2201 - LSAT Details irreg code J2, J3, J4 OUAC_LSAT_IRREG1

OUAC_LSAT_IRREG2

OUAC_LSAT_IRREG3

OUAC_LSAT_IRREG4

477 - Attended Postsecondary A5 OUAC_ATTND_PSTSCND

475 - Authorization to Release Academic A5 OUAC_AUTH_RELEASE

397 - Cooperative Education A5, D1 COOP_REQ

507 - Authorization to Release Univ
Performance to Sec School

A9 OUAC_AUTH_RELEASE

930 - Previously Dealt w/ University B1 OUAC_PRV_WITH_UNIV

2020 - Ever Attended Law School B1 OUAC_ATTEND_LAW

2145 - Fee Waiver Received G8 OUAC_WAIVER_RCVD

(check box)
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OUAC ELEMENT Transactions Field Name

2151 - All OLSAS Applications G8 OLSAS_OSGOODE_STAT

OLSAS_OTTAWA_STAT

OLSAS_QUEENS_STAT

OLSAS_TORONTO_STAT

OLSAS_WESTERN_STAT

OLSAS_WINDSOR_STAT

2095 - Authorization G3 OUAC_EMR_CNTCT_AUT

295 - Mature Student Regulation A4 OUAC_MATURE_STDNT

935 - Second Degree B1 OUAC_SECOND_DEGREE

2173 - Ethnic Code J1 ETHNICITY_LSAC

2286 - Type R2 OUAC_DEGREE_TYPE

This table lists the translates that the PeopleSoft system maintains in tables:

OUAC ELEMENT Table Name

532 - Program of Study, Appendix 9.A.65 EXT_SUBJECT_TBL

332 - Subject of Major Interest, Appendix 9.A.80 EXT_SUBJECT_TBL

845 - Teaching Subject 1, Appendix 9.A.85

850 - Teaching Subject 2, Appendix 9.A.85

OUAC_T_SUBJECT_TBL

750 - Program Code Last Studied,

Appendix 9.A.25

CEGEP_PROG_TBL

525 - Advanced Standing Program,

Appendix 9.A.95

OUAC_PROG_TBL

2111 - Category, Appendix 9.A.50 OUAC_LAW_CAT_TB
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See Also

Product documentation for PeopleTools: Supported Integration Technologies

Setting Up OUAC Law Categories

This section lists the page used to set up OAUC law categories.

Page Used to Set Up OUAC Law Categories

Page Name Definition Name Navigation Usage

OAUC Law Categories OUAC_LAW_CAT_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > OUAC >
Law Categories

Define OUAC law categories.
 Law categories are used
on the OUAC Appl Law
Cat (OUAC application law
category) page.

Setting Up Teaching Subjects and CEGEP Programs

To set up teaching subjects, use the OUAC Teaching Subject (OUAC_T_SUBJECTS) and CEGEP
Programs (CEGEP_PROGRAMS) components.

This section lists the pages used to set up teaching subjects.

Pages Used to Set Up Teaching Subjects

Page Name Definition Name Navigation Usage

OUAC Teaching Subject
Table

OUAC_T_SUBJECT_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > OUAC >
Teaching Subjects

Define OUAC teaching
subjects. Teaching subjects
are used on the OUAC A8/U8
page.

CEGEP Program Table CEGEP_PROG_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > OUAC >
CEGEP Program Table

Define programs for CEGEP.

Setting Up OUAC Organizations

Before you can receive data from OUAC, you must define your OUAC organizations. Use the
Organization Table component to define OUAC organizations.
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This section discusses how to:

• Add OUAC organizations.

• Specify a primary contact and department for an OUAC organization.

• Enter OUAC organization data.

• Enter school data.

• Assign grade point average (GPA) types to OUAC organizations.

• Define school course classifications for OUAC.

• Define the SECSCH (secondary school) comment category.

Pages Used to Set Up OUAC Organizations

Page Name Definition Name Navigation Usage

Organization Table EXT_ORG_TABLE Campus Community >
Organization > Create/
Maintain Organizations >
Organization Table >
Organization Table

Enter or update data about an
organization. View and update
information about the primary
contact and department for the
organization.

Regional EXT_ORG_TBL_REG Campus
Community >Organization >Create/
Maintain
Organizations >Organization
Table >Regional

In the OUAC Organization
Data group box, enter
the Ministry of Education
code, the OUAC institution
code, and the current
enrollment levels for the new
organization.

School Data SCC_EXT_ORG_ADM Campus Community >
Organization > Create/
Maintain Organizations >
Organization School Data

Enter data that applies to
an organization that offers
courses.

Organization Affiliation EXT_ORG_AFFLTN Campus Community >
Organization > Create/
Maintain Organizations >
Organization Affiliation

Identify details that are
important to your institution
in affiliation with an
organization.

School Course Classification SCHOOL_COURSES Campus Community >
Organization > Create/
Maintain Organizations >
School Course Classification

Record the specific course
offerings for each subject
area.

444  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 12 (CAN) Setting Up to Receive OUAC Transactions

Page Name Definition Name Navigation Usage

Comment Category Table CMNT_CATG_TABLE • Campus Community >
Comments > Set Up
Comments > Comment
Category Table

• Set Up SACR >
Common Definitions >
Comments > Comment
Category Table

Set up comment categories
that enable you to group
comments for similar
purposes.

Adding OUAC Organizations
Access the Organization Table page (Campus Community > Organization > Create/Maintain
Organizations > Organization Table > Organization Table).

Use the Organization Table page to add OUAC organizations. You can enter definitions for the
organization, select an organization type, and select a location.

Related Links
"Understanding Organizations" (Campus Community Fundamentals)

Specifying a Primary Contact and Department for an OUAC Organization
Access the Organization Table page (Campus Community > Organization > Create/Maintain
Organizations > Organization Table > Organization Table).

Use the Organization Table page to specify an organization's primary contact person or the department to
contact in order to streamline your institution's communications with that organization.

Related Links
"Creating Organization Records" (Campus Community Fundamentals)

Entering OUAC Organization Data
Access the Regional page (Campus Community >Organization >Create/Maintain
Organizations >Organization Table >Regional).
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This example illustrates the fields and controls on the Regional page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Mident Code Enter the Ontario Ministry of Education six-digit school code.

OUAC Institution Code Enter the code that identifies OUAC institutions. When you
post OUAC data, the process looks for this code to populate
the EXT_ORG_ID field.

Grade 9 (through 12) Enrollment Enter the current enrollment levels for the respective grades.

OAC Enrollment Enter the total OUAC enrollment.

Entering School Data
Access the School Data page (Campus Community > Organization > Create/Maintain
Organizations > Organization School Data).

Use the School Data page to enter school characteristics, school codes, and system default values.
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Related Links
"Entering School-Related Data" (Campus Community Fundamentals)

Assigning GPA Types to OUAC Organizations
Access the Organization Affiliation page (Campus Community > Organization > Create/Maintain
Organizations > Organization Affiliation ).

GPA type must have a value entered to populate a grading scheme on the Courses and Degrees page
when OUAC transmissions are processed. This setup is important because grading scheme is a required
field and—if it is not populated—the user cannot make any changes to that page without getting an error
message. Use the Organization Affiliation page to define a GPA type for an organization.

Related Links
"Entering Affiliations with Organizations" (Campus Community Fundamentals)

Defining School Course Classifications for OUAC
Access the School Course Classification page (Campus Community > Organization > Create/
Maintain Organizations > School Course Classification).

Use the School Course Classification page to define school course classifications for OUAC
organizations. The values you enter on this page populate fields on the Courses and Degrees page when
you post OUAC transmissions.

Related Links
"Setting Up External Subject Categories and Term Sessions" (Campus Community Fundamentals)

Defining the SECSCH Comment Category
Secondary school comments on the A9 transaction appear on the Comments pages. To view them, you
must first set up the comment category SECSCH. You must also tie it to at least one 3C group. Use the
Comment Category Table page to define the SECSCH comment category. Use the Comment 3C Groups
page to tie the SECSCH comment category to a 3C group.

Related Links
"Setting Up Comment 3C Groups" (Campus Community Fundamentals)
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Setting Up for Evaluating Applicants

Prerequisites for Applicant Evaluations

Before you begin performing applicant evaluations, you must set up the following:

• Rating components.

• Rating schemes.

• Evaluation codes.

• Evaluation status codes.

• Evaluation committees.

Setting up Applicant Evaluation

This section discusses how to:

• Define rating schemes.

• Use the Material Extract Detail Page.

• Assign components to rating schemes.

• Define evaluation codes.

• Define evaluation committees for Admission applications.

• Define evaluation status codes.
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Pages Used to Set up Applicant Evaluation

Page Name Definition Name Navigation Usage

Rating Comp Def Table 
(rating component definition
table)

RATING_COMP_DEF Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Rating Comp
Definition Table

Define rating components.
 Rating components are
specific criteria that you
use to rate applicants.
 For example, you could
have components such as
extracurricular activities,
 academic preparation, and
highest SAT. You use rating
components to define rating
schemes.

Rating Scheme Table RATING_SCHEM_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Rating
Tables > Rating Scheme
Table

Define rating schemes.
 The admissions evaluation
process uses rating schemes
to evaluate applicants.
 For example, you could
have one rating scheme for
undergraduate applicants and
another for undergraduate
engineering applicants. Rating
schemes can be defined
for manual and automatic
evaluations.

Materials Extract Detail RATING_SCHEME_SP Click the Extracts button on
the Rating Scheme Table
page.

Enter the SQCs for your
material extracts.

Rating Components Table RATING_CMP_TABLE Set Up SACR > Product
Related > Recruiting
and Admissions >
Application Evaluation >
Rating Tables > Rating
Components Table

Select the rating components
that make up your rating
scheme. For example, an
undergraduate first year rating
scheme could consist of
components such as overall
rating, academic preparation,
 highest ACT score, highest
SAT score, and subjective
committee rating. Later, you
can assign scores to each
component, which can be
averaged for an overall score
for the rating scheme.
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Page Name Definition Name Navigation Usage

Evaluation Table EVALUATION_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Evaluation
Tables > Evaluation Table

Define evaluation codes and
the rating schemes linked
to them. You must assign
evaluation codes—either
manually or automatically
—to evaluations during
the evaluation process.
 Evaluation codes contain
default information that
populates fields (such as
rating scheme) in the General
Evaluation and Application
Evaluation components
on evaluation pages when
you assign an evaluation
code to an applicant. Thus,
 evaluation codes act as
templates, making data entry
much speedier when creating
evaluation records.

Evaluation Committee Table EVAL_COMMITTEE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Evaluation
Tables > Evaluation
Committee Table

Assign evaluation committees
to your evaluation codes (if
applicable).

Evaluation Status Table EVAL_STATUS_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Evaluation
Status Table

Define evaluation status
codes. For example, you can
set up statuses such as Final,
 On Hold, and In Progress.
 Later, when evaluating
applicants, you will enter
these statuses on evaluation
pages as well as on the
Application Program Data
page under the Application
Maintenance menu.

Defining Rating Schemes
Access the Rating Scheme Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Application Evaluation > Rating Tables > Rating Scheme Table).
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This example illustrates the fields and controls on the Rating Scheme Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Rating Type Select a rating type for this scheme. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are Application, Audition,
 Committee, Interview, Overall,and Portfolio.

Note: If you plan to evaluate applicants using automated
processes, you must define a rating scheme with an Overall
rating type.

Instructions Enter information about this rating scheme.

Extracts Click this button to enter the SQCs for your material extracts.
 The Material Extract Detail Page for this rating scheme
appears.

Using the Material Extract Detail Page
Access the Materials Extract Detail page (Click the Extracts button on the Rating Scheme Table page).

452  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 13 Setting Up for Evaluating Applicants

This example illustrates the fields and controls on the Material Extract Detail page. You can find
definitions for the fields and controls later on this page.

Test scores, academic summaries, course/subject information, and general materials are linked to a
person.  When you evaluate applicants, you might want to consider only certain materials for a particular
evaluation, rather than considering all materials for the person. Within Recruiting and Admissions
you can manually associate the appropriate application materials to an application (on the Application
Materials page), or you can associate application materials to applications using the Application Materials
Extract process. To associate materials to an application using the application materials extract process,
you use SQCs to define which information to extract and use in your evaluation process. Use the
Materials Extract Detail page to enter the name of the SQCs that extract appropriate material information
(at the person level) for evaluating applicants.

Enter the SQCs that you want to be executed by the SQR that your institution has defined to retrieve test
scores, summaries, courses, subjects and general materials. PeopleSoft delivers the example SQCs shown
on the previous page shot but you will need to create your own SQCs to meet your specific business
process needs.

For each SQC, except general materials, select the appropriate material group from which you will extract
data. Material groups are made up of material types. The information you extract can later be viewed on
the Application Materials Summary pages.

See Pages Used to View Summary Application Materials Information.

Note: You can use the application materials extract process to associate transcript information to an
application. To associate transcript information to an application, use the Materials Extract Detail page to
enter the SQC name for summary information, which contains the transcript information. Alternatively,
you can manually associate transcript information to an application on the Application Materials page.

Assigning Components to Rating Schemes
Access the Rating Components Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Application Evaluation > Rating Tables > Rating Components Table).
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This example illustrates the fields and controls on the Rating Components Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Rating Component Enter a rating component for this rating scheme. Rating
components are specific criteria that you use to rate applicants.
 When you are ready to evaluate applicants, you can assign
scores to each rating component (if you are evaluating the
applicant manually), which can be averaged for an overall
score for the rating scheme. Assign rating components on the
Rating Component Definition Table page.

Type Identify the type of rating component that you selected.
 This identifies the rating component as an individual
component (such as Essay), or one that is made up of other
components (such as Overall). Component types are useful for
informational and reporting purposes. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are Cumulative and Individual.

Processing Order Enter the order in which this component should be processed
within the group of components assigned to this rating scheme.
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Field or Control Description

Final Value Select this check box if this component is one on which you
base admissions decisions. The application status update
process that posts results of an evaluation to the application
looks to see if all components with this check box selected
have been fulfilled before posting a result. You can have only
one component selected as final value (such as overall rating),
 if that component is the only component that needs to be
fulfilled before evaluating the applicant. You can also have
more than one component selected as final value (such as
overall, highest GPA, and highest test score), if you require
all of these components to be fulfilled before evaluating the
applicant.

Required Select this check box if this component must be considered
for this rating scheme. For example, you might have a rating
scheme that requires the testing component, which looks for
a person's highest ACT or highest SAT score. Within this
rating scheme you also have separate components for SAT and
ACT, but they are not marked required. If a component is not
marked as required, your rating scheme process continues to
the next component if this component does not exist for this
applicant. If a component is marked required, the process will
not continue if the component is missing. So in our example,
 there would have to be an ACTor SAT score, but not both,
 since only the testing component is required.

Method Select the calculation method for this component. Component
rating values can be calculated automatically, in which
case the Assign Adm Applicant Rating (assign admissions
applicant rating) process calculates the rating value for you.
 Alternatively, you can calculate the value manually, which
means that you enter the score. For example, you would most
likely want to calculate an objective rating component (such
as overall rating) automatically. Thus, the process would look
at various data to come up with the overall rating score for
an applicant. Alternatively, you would probably want to enter
subjective scores (such as for the recommendations rating
component) manually.

Values for this field are delivered with your system as translate
values. You can modify these translate values. Values are
Automatic and Manual.

Formula ID If you selected Automatic in the Method field, select a formula
ID. Formula IDs are the names of the SQCs that provide the
programming logic for components. These are the programs
that retrieve the data for the evaluation calculation. PeopleSoft
delivers sample SQCs but you will need to create your own to
meet your business process needs.
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Field or Control Description

Rating Value Enter a numeric rating value if the component is calculated
manually. For example, if you want the essay component to be
used as part of a committee evaluation, you can assign rating
values (such as poor or average) to the essay component, as on
the previous page example. When evaluators enter evaluations
for these components (on the General Evaluator Detail page
or the Application Evaluator Detail page), they can prompt for
these rating values.

Note: The rating values you enter here are not retrieved
through the Application Evaluation process, as are objective
values such as test scores and GPA. Individual evaluators will
use the rating values you enter here when they rate subjective
materials (such as essays).

Defining Evaluation Codes
Access the Evaluation Table page (Set Up SACR > Product Related > Recruiting and Admissions >
Application Evaluation > Evaluation Tables > Evaluation Table).

This example illustrates the fields and controls on the Evaluation Table page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Evaluation Type Select an evaluation type for this evaluation code. You can
define evaluation codes that can be used for evaluating
applicants (Application), or you can define evaluation codes
that can be used for evaluating individuals (General). In the
latter case, the evaluation code will be assigned to a person,
 rather than an application. Values for this field are delivered
with your system as translate values. You can modify these
translate values. Values are Application and General.
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Field or Control Description

Committee Rating ID If committees perform this evaluation, enter the rating scheme
that the committee will use with this evaluation code. You
assign actual committees to this evaluation code on the next
page in this component. Define rating schemes on the Rating
Scheme Table page.

Overall Rating ID Assign an overall rating scheme if you use this rating code for
overall evaluations.

Defining Evaluation Committees for Admission Applications
Access the Evaluation Committee Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Application Evaluation > Evaluation Tables > Evaluation Committee Table).

This example illustrates the fields and controls on the Evaluation Committee Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Committee Enter a committee to be assigned to this evaluation code. You
can add more than one committee for an evaluation code.
Define committees and committee members on the Committee
page in PeopleSoft Campus Community.

Evaluator ID Enter the evaluators who sit on this committee. All members
of this committee automatically appear as evaluators, along
with their role on the committee. You can add evaluators who
are not already assigned to this committee.

Role Enter evaluator roles for the evaluators that you add. Roles
for committee members appear from the Committee Members
page.
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Related Links
"Prerequisites for Managing Committee Data" (Campus Community Fundamentals)
"Creating Committees" (Campus Community Fundamentals)
"Assigning Committee Members" (Campus Community Fundamentals)

Defining Evaluation Status Codes
Access the Evaluation Status Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Application Evaluation > Evaluation Status Table).

Field or Control Description

Evaluation in Progress Select this check box if the evaluation status that you're
defining is defined as in progress (such as In Progress, and
as opposed to Final). Applicant evaluation processes only
process applications whose current evaluation status is one that
has this check box selected.

Setting Up Student Response

To set up student response, use the Response Reason component (RESP_RSN_TABLE).

You can set up the reasons why an applicant chose or rejected your institution and a series of adapted
reason response codes that enable you to capture and track the specific information that you want. You
can use the Student Response page to capture why students did select your school, or why students chose
not to attend your school and where they are going instead. This information can also be captured on the
Accept Admission self-service feature. If a student has multiple applications on file, a response can be
captured for each individual application. Multiple reasons can also be captured for each application.

This section discusses how to enable student response for a school type.

Related Links
Updating Applications

Page Used to Set Up Student Response

Page Name Definition Name Navigation Usage

Student Response Reason
Table

RESP_RSN_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Applicants >
Response Reason Table

Define reason codes for
capturing the reason why
a student decided to attend
another institution or why the
student did select your school.
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Enabling Student Response for a School Type
Each external organization that you define in the system must have a school type code assigned to it.
When you define a school type code, you must specify whether this school type will be considered when
using the Student Response feature. Then, when you use the Student Response page, the External Org
ID (external organization ID) field prompt dialog box displays a list of external organizations whose
school type codes have the Student Response option enabled. Use the School Type Table page to enable
the Student Response feature for school types.

Related Links
Setting Up School Types
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Setting Up Admissions Program Actions
and Program Action Reasons

Setting Up Admissions Program Actions and Program Action
Reasons

This section discusses how to:

• Review admissions program action values.

• Define admissions program action reason values.

Pages Used to Set Up Admissions Program Actions and Program Action
Reasons

Page Name Definition Name Navigation Usage

Admissions Action Table ADM_ACTION_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Applicants >
Admissions Action Table

View admissions program
actions.
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Page Name Definition Name Navigation Usage

Program Action Table PROG_ACTION_TABLE Set Up SACR > Product
Related > Student
Records > Program
Action > Program Action
Table

Modify program action
descriptions. Program action
codes designate the status
of a student in a program
from the time he or she is
an applicant and throughout
his or her academic career.
 For example, a student must
have a program action of
Matriculate to become a
student, and a program action
of Activate in any term in
which she wants to enroll.

You can change the effective
date and status for the
program action codes that
PeopleSoft provides. By
changing the effective date
and status you can render a
program action code inactive
so that it is longer available to
your users.

Note: Program actions are
predefined and cannot be
changed on this page.

Program Action Reason Table PROG_RSN_TBL • Set Up SACR >
Product Related >
Recruiting and
Admissions >
Applicants > Program
Action Reason Table

• Set Up SACR >
Product Related >
Student Records >
Program Action >
Program Action Reason
Table

Define program action
reasons. You can define
multiple reasons for one
action. For example, for
the action Administrative
Withdrawal, you can define
a reason of Incomplete
Application as well as a
reason of No Response. These
reasons enable flexibility with
the program action codes
delivered with your system.

Reviewing Admissions Program Action Values
Access the Admissions Action Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Applicants > Admissions Action Table).

Program actions are shared with PeopleSoft Student Records. The only values that you will see on this
page are those that are specific to admissions. Similarly, when you prompt for a program action on
Recruiting and Admissions pages, you will see only a list of those values that are relevant to admissions.

Values for this table are delivered with your system as translate values. Do not modify these values in any
way. Any modifications to these values require a substantial programming effort. For your convenience,
you can view the admissions specific program actions in this table without accessing the translate table.
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Defining Admissions Program Action Reason Values
Access the Program Action Reason Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Applicants > Program Action Reason Table).

This example illustrates the fields and controls on the Program Action Reason Table page.

The reason values for the program actions in this table are shared with PeopleSoft Student Records.

Important! To automatically populate the Date of Death field for an applicant on the Decedent Data
page, an action reason code of DEAT (Deceased) must be defined for the program action entered on the
admissions application.
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Recruiting Prospective Students

Understanding Adding Prospects

You can add prospects to your system:

1. Individually, through the Prospect Data component.

2. Individually, through PeopleSoft Campus Self Service (prospects create themselves through self
service).

3. Individually or in a group when you create an application, depending on your setup.

See Setting Up Admission Installation Defaults.

4. In a group, for all individuals within a single posting of test scores.

5. In a group, by creating a user-defined query of individuals who have posted test scores from previous
test score loads.

6. In a group, by creating a user-defined query of individuals in your system.

Prerequisites for Adding Prospects

Before you enter prospects into the system, set up your recruiting structure. Your recruiting structure
consists of recruiting regions and recruiters. You must also define honors, awards, school types, admit
types, and extracurricular activities, for example, before you can assign them to prospects.

See Setting Up Your Recruiting Structure

See Defining Recruiters

Before you add prospects, search the database to see if biographical and demographic records exist
for the person. The person might already be in your database as an employee, instructor, or student in
another academic institution or career. To determine if the prospect exists in your system, select Student
Recruiting, Maintain Prospects, Search Match.

See "Understanding Search/Match" (Campus Community Fundamentals)

See "Setting Up Search/Match" (Campus Community Fundamentals)

If the person already exists in your database, you must determine if there is a prospect record for the
academic institution and career before you create a new prospect record. Only one prospect record can
exist for an institution and career combination.
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Adding Prospects Through the Create/Update Prospects
Component

The Prospect Data component is the first of three similar components:

• Create/Update Prospects component.

• Add Application component.

• Maintain Applications component.

Create/Update Prospects and Add Application have Biographical Details, Regional, and Personal pages.
All three components have other pages with similar names, such as Prospect Academic Program Data
page and Application Program Data page. Use these components to enter or maintain similar information
at different points in time during the admissions process.

The 3C buttons are common to multiple pages within this component: Add a New Communication, Add
a New Checklist, and Add a New Comment.

Note: The system automatically populates many of the values in this component according to your user
defaults. These fields are indicated in the documentation by the phrase (user defaults).

This section discusses how to enter and update the following information for prospects:

• Biographical details

• Regional data

• Personal information

• Academic career data

• Academic program data

• School and recruiting data

• Event attendance

• Event meeting information

• Communications, checklists and comments

Pages Used to Add Prospects

Page Name Definition Name Navigation Usage

Prospect Career Data ADM_PRSPCT_CAR Student Recruiting >
Maintain Prospects >
Create/Update Prospects >
Prospect Career Data

Enter prospect career data.
 Store additional prospect
information that you define by
using the Common Attribute
Framework.
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Page Name Definition Name Navigation Usage

Prospect Program Data ADM_PRSPCT_PROG Student Recruiting >
Maintain Prospects >
Create/Update Prospects >
Prospect Program Data

Enter information about
programs, plans, or subplans
in which a prospect has
expressed interest.

Prospect School/Recruiting ADM_PRSPCT_RECRUIT Student Recruiting >
Maintain Prospects >
Create/Update Prospects >
Prospect School/Recruiting

Enter recruiting information
for a prospect. This page
stores information such as
the last school that a prospect
attended and the recruiting
region to which this prospect
belongs.

Attendee Events EVENT_ATTENDEE_SEC Click the Events link on the
Prospect School/Recruiting
page.

Register a prospect for events
or to record events that the
prospect attended.

Attendee Meetings EVENT_MEETING_SEC Click the Meetings  button on
the Attendee Events page to
open the Attendee Meetings
page.

Record information regarding
meetings that are associated
with an event.

Entering and Updating Prospect Biographical Details
Use the Biographical Details and Addresses pages to enter or update any personal, demographic, or
address information for the prospect.

See "Understanding Biographical Information" (Campus Community Fundamentals).

Entering and Updating Prospect Regional Data
Use the Regional page to view, enter, and update prospect regional information.

See "Setting Up and Reviewing Regulatory Regions" (Campus Community Fundamentals).

Entering or Updating Personal Information for Prospects
Access the Personal page (Student Recruiting > Maintain Prospects > Create/Update Prospects >
Personal).

Use the Personal page to enter or update other biographic details such as gender or sexual orientation.
This information is stored separately from the rest of the applicant’s data. This page appears when you
select at least one field from the Biographic Details page.

For more information about:

• Setting up the Personal page, see "Reviewing or Defining Installation Settings For Biographic
Fields" (Campus Community Fundamentals).
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• The Personal page, see "Entering Personal Information" (Campus Community Fundamentals).

Entering and Updating Prospect Academic Career Data
Access the Prospect Career Data page (Student Recruiting > Maintain Prospects > Create/Update
Prospects > Prospect Career Data).

This example illustrates the fields and controls on the Prospect Career Data page . You can find
definitions for the fields and controls later on this page.

You can create multiple academic career records for a prospect by adding prospect records for each
academic career. The Prospect Biographical Details page and the Regional page are the same for each
academic career because the data on those pages is shared. The data on the remaining pages in the Create/
Update Prospects component is unique to each academic career. Prospects are tracked at the academic
career level.

Field or Control Description

Admit Term Enter the admit term for the prospect's career. Define admit
terms on the Term Table page. (user defaults)
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Field or Control Description

Admit Type Enter the prospect's admit type for this career. Define admit
types on the Admit Type Table page. (user defaults)

Campus Enter a campus to associate the prospect to a specific campus.
 Define campuses on the Campus Table page. (user defaults)

Academic Load Select the appropriate academic load for this career. Values for
this field are delivered with your system as translate values.
 You can modify these translate values.

Academic Level Select the academic level for this career. Values for this field
are delivered with your system as translate values. You can
modify these translate values. (user defaults)

Housing Select any housing interest that this person indicated. Values
for this field are delivered with your system as translate values.
 You can modify these translate values. Values are (none),
  Commuter, Off Campus, and On Campus. This field is for
informational purposes. (user defaults)

Financial Aid Interest Select to indicate that this prospect has an interest in financial
assistance. This field is for informational purposes only. (user
defaults)

Applied The system automatically updates this check box when the
prospect applies to your institution if, on the Installation
Defaults - AD page, you set up the system to update prospect
records when prospects become applicants.

Recruiting Status Select the person's recruiting status. The recruiting status
indicates the level of interest, at the academic career level, that
your institution has in the prospective student. For example,
 you might consider a person who attended an on-campus
event a suspect (someone who you suspect is interested in
your institution). Conversely, you might consider a person
who sends a prospect card a prospect (someone who you know
is interested in your institution). This field is also helpful for
targeting mass mailings. Values for this field are delivered
with your system as translate values. These translate values
can be modified. Values are Applicant, Inactive, Inquiry,
 Prospect, and Suspect.

Status Date Enter the date, if different than the default date, on which you
entered or updated the recruiting status. The default date is the
system date on the day the record was added.

Created On Enter the date, if different than the default date, on which this
prospect record was created. The default date is the system
date on the day the record was added.
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Field or Control Description

Referral Source Enter the appropriate referral source for this prospect. A
referral source indicates how this person became a prospect.
 The referral source is a high level indicator of how your
institution came into contact with the person. For example, a
referral source could be Drop-In, Campus Event, or College
Fair. Although this is a way to track your first contact with this
person, record subsequent contacts with the Communications
pages. Define referral sources on the Referral Source Table
page.

Source Date Enter the date, if different than the default date, on which you
entered this referral source. The default date is the system date
on the day the record was added.

Recruiting Center Enter the recruiting center that is responsible for this prospect's
career. Define recruiting centers on the Recruiting Center
Table page. The values depend on the academic career that you
select and are subject to user security established for recruiting
centers. (user defaults)

Go Click this button to go to another component for this prospect
record.

Note: To enter an additional career for a prospect, re-enter the component by selecting Add and enter the
new academic career when prompted by the system.

Additional Prospect Data

This section enables you to store additional prospect data that does not have a home in the core prospect
records. Populate this section with values for common attributes defined within the Common Attribute
Framework. Attributes can be manually added on this page or can also be populated from the Prospect/
Admissions Data Load process. The prompts in the Field column will display attributes associated on the
record context for ADM_PRSPCT_CAR.

See "Understanding Common Attribute Framework" (Campus Community Fundamentals)

See Understanding Prospect/Admission Data Load Transactions

Entering and Updating Prospect Academic Program Data
Access the Prospect Program Data page (Student Recruiting > Maintain Prospects > Create/Update
Prospects > Prospect Program Data).
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This example illustrates the fields and controls on the Prospect Program Data page. You can find
definitions for the fields and controls later on this page.

Although you are required to enter prospect career data, you are not required to enter prospect program
data because you might not have that information at this stage in the process. Your institution has several
options for tracking prospects (for example, by programs under a career, by academic plans under
programs, and by subplans under academic plans).

Note: Prospect records use the Last Prospect Date to determine if the program, plan, or subplan
should appear in the prompts. If the Last Prospect Date is populated on the Academic Program Table
(ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the date is less than or equal to the current date, the system does not display
the value in the prompt.

Field or Control Description

Recruiting Status Select the recruiting status for this program. Depending on
your settings on the Installation Defaults - AD page, the
system can update the recruiting status when the person
applies to your institution. Values for this field are delivered
with your system as translate values. You can modify these
translate values. Values are Applicant,  Inactive, Inquiry,
 Prospect, and Suspect.

By tracking recruiting information at the academic program
level, you can designate a recruiting status that is different than
the status that is designated at the academic career level.

Status Date The status date is the system date on the day that you last
modified the Recruiting Status field.

Application Number If the prospect applies to this academic program, the system
automatically updates the application number.
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Field or Control Description

Recruiting Center Enter the recruiting center that is responsible for this particular
program for the prospect. Define recruiting centers on the
Recruiting Center Table page. (user defaults)

Academic Plan and Sub-Plan Enter an academic plan and subplan, if known. You can
enter multiple academic plans for a program and multiple
subplans under an academic plan. Define academic plans in
the Academic Plan Table component and academic programs
in the Academic Program Table component (user defaults).

Note: You can enter multiple program data records or a prospect because a person might be interested
in multiple programs within one academic career. Additionally, a prospect can have multiple plans and
subplans. Add rows to accommodate additional programs, plans, and subplans.

Entering and Updating Prospect School and Recruiting Data
Access the Prospect School/Recruiting page (Student Recruiting > Maintain Prospects > Create/
Update Prospects > Prospect School/Recruiting).

This example illustrates the fields and controls on the Prospect School/Recruiting page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Events Click this link to record the events that this prospect attended
to which this prospect was invited. The Attendee Events Page
appears.

School Information

Field or Control Description

Last School Attended Enter the prospect's last school attended. Since a person might
attend several schools in his or her external academic career,
 it is helpful to know which school the person attended most
recently. You can use this information to target that school for
recruiting visits. Define schools on the Organization Table
page. (user defaults).

Graduation Date Enter the graduation date from the last school that the person
attended. (user defaults).

Recruiting Information

Field or Control Description

Region You can assign a recruiting region manually or automatically.
 To manually assign a region, click the prompt on the Region
field and enter as value. Define regions on the Region Table
page.

Home Postal Code Click this button to automatically assign the recruiting region,
 based on the home postal code of the prospect. Assigning
recruiting regions based on home address postal codes requires
that you define the region tree.

School Postal Code Click this button to automatically assign the recruiting region,
 based on the postal code of the primary location of the
prospect's last school attended. Assigning recruiting regions
based on school postal codes requires that you define the
region tree.

See Setting Up Your Recruiting Structure.
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Field or Control Description

From This display-only field shows you how this region was
defined:

Region Tree appears if you manually assigned a region.

Address appears if you assigned the region when you click the
Home Postal Code button.

School appears if you assigned the region when you click the
School Postal Code button.

See Defining Recruiters.

Recruiting Categories

Field or Control Description

Category Enter a recruiting category for the prospect within this career.
 In our example, the prospect's sibling attended the institution.
 Define recruiting categories on the Recruiting Category Table
page. Use categories to target and report on students.

You can enter multiple recruiting categories and prospect
supporting information for each career.

Note: If you plan to assign a regional recruiter to this prospect,
 you must enter a category of REGN (region).

Sub-Category Select a recruiting subcategory, if known. Subcategories can
indicate the priority of this recruiting category. Values for this
field are delivered with your system as translate values. You
can modify these translate values. Values are (none), High, 
Low, and Medium.

Group The system automatically populates this field from the
Recruiting Category Table page after you enter a recruiting
category in the Category  field.

Move to Application Select this check box to copy the information in the
Recruiting Categories group box to the application record
when the prospect applies to your institution. The system
selects this check box if you set up the system to copy prospect
data to the application by selecting the Copy Data and
Recruiting Categories  check boxes on the Installation
Defaults - AD page.
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Recruiters

Recruiter assignment is tied to recruiting categories. If you entered a recruiting category, the Recruiters
group box becomes available. Use this section to assign one or more recruiters to this prospect that are
relevant to this category. You can add multiple recruiters under all categories that you entered.

When selecting recruiters, you might want to see all of the recruiters in your system or only recruiters that
are linked to the current recruiting category. The system uses various methods to specify the selection of
recruiters when you click the prompt on the Recruiter ID field.

Field or Control Description

Recruiters Prompt Select this check box if you want all recruiters to be available
when you prompt on the Recruiter ID  field, regardless of the
recruiting category to which recruiters are assigned.

Clear this check box to view only those recruiters who are
assigned to the current recruiting category to be available
when you click the prompt on the Recruiter ID field. The
REGN (region) category works differently.

If you are adding recruiters for the recruiting category REGN,
 you select only from recruiters in the region that you selected
on the Prospect School/Recruiting page. You can enter a
region on the Prospect School/Recruiting page manually or
automatically. The list of regional recruiters vary, depending
on how you defined the region.

If you defined the region according to the last school that the
prospect attended, the Recruiters Prompt field displays the
recruiters for the school's region. If you click the prompt on
the Recruiter ID field, the system displays a list of recruiters
that are assigned to that school. If no recruiters are assigned to
that school, then you must select a recruiter who is assigned to
the region.

If you entered the region according to the prospect's home
address, the Recruiters Prompt field displays the recruiters
for the address region. If you click the prompt on the
Recruiter ID  field, the system displays a list of recruiters
who are assigned to the region.

If you manually assigned the region from the region tree,
 the system displays a list all recruiters who are assigned to a
recruiting category of REGN when you click the prompt on the
Recruiter ID field. Click the prompt on the Recruiters field
to view the recruiters for the category.

To override the system defaults, select the Recruiters Prompt
check box. All recruiters for the academic career are available
when you click the prompt on the Recruiter ID field.
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Field or Control Description

Recruiter ID Enter the ID of the person to assign to this prospect. You can
assign multiple recruiters for any recruiting category to a
prospect.

Recruiter Type The recruiter type appears automatically, based on the recruiter
ID.

Primary Select this check box if this is the primary recruiter for this
academic career. This ID appears on the Prospect School/
Recruiting page in the Primary Recruiter ID field. You can
also enter both primary and non-primary recruiters using this
option.

Go Click this button to go to another component for this prospect
record.

Tracking Prospects Event Attendance
Access the Attendee Events page (Click the Events link on the Prospect School/Recruiting page).

Field or Control Description

Event ID Enter the ID for the event that the prospect is attending (or
attended).

Description, Event Type, and Attendee The system displays the description, event type, and attendee
when you select the event ID.

Meeting Click this button to access the Attendee Meetings Page and
view a list of meetings or sessions that are associated with this
event.

Related Links
"Creating an Event" (Campus Community Fundamentals)

Recording Event Meeting Information
Access the Attendee Meetings page (Click the Meetings button on the Attendee Events page).
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Field or Control Description

Event Mtg (event meeting), Description, Meeting Date,
Meeting Start Time, and Meeting End Time

Enter the event meeting number. The system then displays
the event description, meeting date, meeting start time, and
meeting end time.

Status Select the attendee's status regarding this meeting. Values for
this field are delivered with your system as translate values.
 You can modify these translate values. Values are (none),
 Attended, Invited, Not Attend, and Will Attend.

Adding Communications, Checklists and Comments for Prospects
The Communication, Checklist and Comment buttons appear next to the Institution field on the Prospect
Career Data, Prospect Program Data and Prospect School/Recruiting.

By using the Communication, Checklist and Comment buttons from this component, A new window
is opened for the entry pages for communication, checklist, and comments and initiate recruiting and
admissions related items.

If the Communication, Checklist
or Comments Pages are Accessed
From the:

The Variable Data for the
Following Administrative Function
is Supplied:

Data that is Transferred

Prospect Program Data page PROP

Prospect Program

ID, academic career. academic program,
 recruiting center.

Prospect Career Data page PROS

Prospect

ID, academic career.

Prospect School/Recruiting page EVNT

Event

ID.

Related Links
"Understanding the 3C Engine" (Campus Community Fundamentals)

Creating Prospects When Posting External Test Scores

You can create prospect records when you post external test scores from the Search/Match/Post Test
Scores page. To create prospect records when you post external tests, you must:

1. Load the test scores into a suspense table.
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2. Review the suspense table to confirm that the data loaded correctly and make any necessary changes
prior to posting.

3. Configure search/match/post parameters and select the options that enable you to create prospect
records for all individuals in the test load and run the post process.

4. Run the post process, which creates candidate data records and prospect records for all employee IDs
in the test load if they do not already exist.

5. Purge the suspense file.

See Understanding Performing Search/Match and Posting Test Scores.

Prerequisites
Before you create prospects from test score loads or test queries, you must:

1. Set up tests and test components.

2. Set up test ID security for all appropriate users.

3. Configure the External Test Load Mapping page.

4. Configure the Ethnicity Mapping page.

5. Configure Test ID mapping options for academic interests, extracurricular activities, and religious
preference (optional).

6. Set up data entry defaults for all appropriate users (optional).

Related Links
Mapping External Tests IDs

Creating Prospects from Test Scores with Query

This section provides an overview and discusses how to:

• Create prospects by querying external test loads.

• Select a query.

Understanding Creating Prospects from Test Scores with Query
This option of creating prospects from test scores after they have been posted enables you to define
specific criteria using Query Manager to decide for whom you want to create prospects. You can define
as many queries as necessary to select the specific population that you want to recruit. To create prospects
from a query of previously posted test score records:

1. Create a query.

To access Query Manager, select Reporting Tools > Query.
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2. Access the Create Prospects from Tests page.

3. Select a test ID, and enter default prospect values.

4. Select the query.

5. Run the process.

To create a query for prospects, you must:

• Select the primary candidate data record for the test ID for which you are creating a query.

When you post external test score data, the system creates candidate data records. It is essential to
select the primary candidate data record in your query because the system must use this record to
create prospects. The student must have a candidate data record for the test ID on the Create Prospects
from Test page to be selected for prospect creation. To find the primary candidate data record for a
given test, navigate to the External Test Score Mapping page. You can use any additional records
from the system to further define the candidates for whom you want to create prospect records. For
example, you could add the Test Component record (STDNT_TEST_COMP) to your query to select
only students with an ACT Candidate Date record who have an ACT Composite score greater than 24.

• Employee ID must be the first field that is listed on the Fields page in PeopleSoft Query Manager.

You can select additional fields to enhance the results of your query as long as the Employee ID is the
first field that is listed.

Note: Check the results of your query in PeopleSoft Query Manager before you run the query on the
Create Prospects from Test page to ensure you are using the correct population.

To assist you in creating your queries, PeopleSoft delivers the following queries as examples in the
demo database: PS_AD_ACT_CPTEST02 , PS_AD_ACT_CPTEST03, PS_AD_ACT_CPTEST04,
PS_AD_AP_CPTEST01, PS_AD_AP_CPTEST02, PS_AD_GMAT_CPTEST01,
PS_AD_GRE_CPTEST01, PS_AD_LSAT_CPTEST01, PS_AD_SAT_CPTEST01,
PS_AD_SAT_CPTEST02, PS_AD_SAT_CPTEST03, PS_AD_SAT_CPTEST04

See Also

Product documentation for PeopleTools: Query

Prerequisites
Before you create prospects from test score post or test scores using queries, you must:

1. Set up tests and test components.

2. Set up test ID security for all appropriate users.

3. Configure the External Test Load Mapping page.

4. Configure Ethnicity Mapping.

5. Post test score data.
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6. (optional) Configure Test ID mapping options for academic interests, extracurricular activities, and
religious preference.

Pages Used to Add Prospects From Test Scores Using Query

Page Name Definition Name Navigation Usage

Create Prospects from Tests SAD_PRS_CREATE • Student
Admissions >External
Test Score
Processing >Create
Prospects From Tests

• Student
Recruiting >External
Test Score
Processing >Create
Prospects From Tests

Create prospects from
external test loads by querying
the primary candidate date
records that have been created
through external test loads.

Select Query SAD_QRY_SELECT Click the Select Query button
on the Create Prospects from
Tests page.

Select a query of external test
data to create prospects from
test loads.

Creating Prospects by Querying External Test Loads
Access the Create Prospects from Tests page (Student Admissions >External Test Score
Processing >Create Prospects From Tests).
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This example illustrates the fields and controls on the Create Prospects from Tests page. You can find
definitions for the fields and controls later on this page.

Note: Prospect records use the Last Prospect Date to determine if the program, plan, or subplan
should appear in the prompts. If the Last Prospect Date is populated on the Academic Program Table
(ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the date is less than or equal to the current date, the system does not display
the value in the prompt.
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Additional Elements

Field or Control Description

Test ID Enter the test ID for the query you want to run. When you
search for a query on the Select Query page, the system
searches for valid queries for the test ID that you enter. A valid
query is set up to search the primary candidate data record for
this test where the employee ID is the first field that you select.
 The system identifies the primary candidate data record from
the External Data Mapping page.

For example, when you enter ACT and then click the Select
Query button, the system accesses the External Data Mapping
page and locates the primary candidate data record for ACT,
 which is SAD_ACT_CD. When you click Search  from the
Select Query page, the system returns only those queries that
have SAD_ACT_CD selected. In other words, the system
returns the valid queries for the ACT test ID by accessing the
candidate data record on the External Data Mapping page.

Default Prospect Values

Select the default values to assign to the prospects that you create from the query. For example, if
you select UGRD in the Academic Career field, the system assigns every prospect it creates to the
undergraduate academic career. To create prospects, you must enter an academic institution, academic
career, recruiting status, and recruiting center. In certain circumstances, you might also want to assign
additional information, such as academic program and plan, and admit term, when your test load contains
a specific set of prospects.

Field or Control Description

Academic Program Because the Academic Program table is keyed by admit term,
 you must enter an admit term in order to enter an academic
program.

Assign 3C Select this check box to assign 3Cs to the prospects that you
create from the query. When you select this option, the Event
ID field becomes available.
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Field or Control Description

Event ID Assign an event ID to the prospects that you create from
the query. Only the event IDs that have the administrative
functions PROS  (prospect) and PROP (prospect program) are
available. Prospect program is available only if you select an
academic program on this page. Define event IDs on the Event
Definition page.

See "Defining 3C Engine Events" (Campus Community
Fundamentals).

Prospect Select Query

Field or Control Description

Select Query Click the link to access the Select Query page. You must select
a query before you click the Run  button.

Selecting a Query
Access the Select Query page (Click the Select Query button on the Create Prospects from Tests page).

When you click the Search button, the system searches for the test ID that you entered on the Create
Prospects from Tests page. A valid query searches the primary candidate data record for the specified
test where the employee ID is the first field you select. The system identifies the primary candidate data
record from the External Data Mapping page.

In addition, you can view only those queries to which you have access. Queries can be marked private or
public. You can view all public queries; however, you cannot view private queries if you are not listed as
the owner even though the private queries fit the criteria for the test.

Note: When you click Search, the system evaluates every query to which you have access for the primary
candidate data record. Because the system searches all queries to which you have access, leaving the
search string blank might increase your wait time.

Adding Prospects Through a System-wide Query

This section discusses how to:

• Add prospects through a system-wide query.

• Select a query.
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Understanding Queries and Prospect Creation
You can create prospect records for anyone in your system who does not already have a prospect record.
To create prospect records through a system-wide query:

1. Create one or more queries based on the demographic information for which you want to create
prospects.

2. Define default prospect data for the prospects that the system creates on the Create Prospects from
Query page.

3. Select and run the query that you created from the Create prospects from Query page.

You can create your query to search any record in your system that has an employee ID or ID field. When
you define your query, you can set certain criteria that identifies the demographic that you want to target.
For example, a medical school might create prospects for all currently enrolled senior biology majors
with GPAs equal to or greater than 3.8 for recruitment purposes. To do this, you must define a query that
searches the ACAD_PROG, ACAD_PLAN, and STDNT_CAR_TERM tables.

Warning! Use caution with whom grant access to the Create Prospects from Query page. Anyone with
access to this page can view public queries in the system. Users can also define their own queries to
search for any record in your database that has an employee ID or ID field.

See Also

Product documentation for PeopleTools: Query

Pages Used to Add Prospects Through a System-wide Query

Page Name Definition Name Navigation Usage

Create Prospects from Query SAD_PRS_CREATE Student
Recruiting >Maintain
Prospects >Create
Prospects from Query

Create prospects from any
record in your database
through a system-wide query.

Select Query SAD_QRY_SELECT Click the Select Query button
on the Create Prospects from
Query page.

Select the query that you
created to create prospects
from records that contain
employee ID or ID fields and
in which the employee ID is
the first field selected.

Adding Prospects Through a System-wide Query
Access the Create Prospects from Query page (Student Recruiting >Maintain Prospects >Create
Prospects from Query).
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This example illustrates the fields and controls on the Create Prospects from Query page.

Note: Prospect records use the Last Prospect Date to determine if the program, plan, or subplan
should appear in the prompts. If the Last Prospect Date is populated on the Academic Program Table
(ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the date is less than or equal to the current date, the system does not display
the value in the prompt.

Select the default values to assign to the prospects that you create from the query. For example, if
you select UGRD in the Academic Career field, the system assigns every prospect it creates to the
undergraduate academic career. To create prospects, you must enter an academic institution, academic
career, recruiting status, and recruiting center. In certain circumstances, you might also want to assign
additional information, such as academic program and plan, and admit term, when your test load contains
a specific set of prospects.

Selecting a Query
Access the Select Query page (Click the Select Query button on the Create Prospects from Query page).
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Related Links
Selecting a Query

Viewing Prospect Information

This section discusses how to view prospect information.

Pages Used to View Prospect Information

Page Name Definition Name Navigation Usage

Prospect Summary ADM_PRSPCT_SUMM Student Recruiting >
Prospect Summaries >
Prospect Summary

View a summary of
information about a prospect,
 such as academic career,
 recruiting status, and referral
source. You can also view
whether or not this prospect
has applied.

Prospect Programs ADM_PRSPCT_S_SEC Click the Program link on
the Prospect Summary page.
 This link appears if you have
entered academic program
data for this prospect.

View information about a
prospect's academic career.
You can click the Detail Panel
link to access the person's
Prospect Career Data page
at the row for this academic
career.

Prospect Recruiters PRSPCT_RCR_SUMMARY Student Recruiting >
Prospect Summaries >
Prospect Recruiters
Summary

View a list of a prospect's
recruiters for an academic
career.

Assigning Regions, Recruiting Categories, and Recruiters on a
Mass Basis

This section provides an overview and discusses how to:

• Use general criteria to select the prospect group.

• Use academic criteria to select the prospect group.

• Use program and plan criteria to select the prospect group.

• Use academic interests criteria to select the prospect group.

• Assign regions, recruiters, and recruiting categories to the prospect group.
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Understanding the Assignment of Regions, Recruiting Categories, and
Recruiters on a Mass Basis

Use the Assign Recruiters component to assign regions, recruiting categories, and recruiters to a group of
prospects at the same time. You can select the group of prospects based on selection criteria, including:

• Biographical and demographic data, such as gender, ethnicity, and citizenship.

• Address data, such as state and postal codes, or a range of postal codes.

• Geographic region, based on last school attended, prospect's home address, or the region tree.

• Academic institution, last school attended, academic career, program, plan, and campus.

• Recruiting status and recruiting center.

• Other items, such as referral source, academic interest, housing interest, and financial aid interest.

You can assign regions, recruiting categories, and recruiters to prospects based on one or more of the
fields on these pages. For example, you can define only one field, such as Country, and select all
prospects in the U.S. Conversely, you can use multiple selection criteria fields to capture a specific
prospect group. For example, you can select all Native American females whose home address is within
postal code 10990, with a certain academic career and academic program, and who have an academic
interest in law with a priority ranked between 1 and 5. Use additional selection criteria fields to narrow
the group of prospects for assignment to a region, recruiting category, and recruiter.

Related Links
Adding Prospects Through the Create/Update Prospects Component

Pages Used to Assign Regions, Recruiting Categories, and Recruiters on a
Mass Basis

Page Name Definition Name Navigation Usage

General Selection Crit 
(general selection criteria)

ADM_PERS_CAR_PARMS Student Recruiting >
Assign Recruiters >
Recruiter Assignment >
General Selection Crit

Use the General Selection
Crit (general selection
criteria) page to specify the
prospect group for which
you want to assign regions,
 recruiting categories, and
recruiters.

Academic Selection Crit 
(academic selection criteria)

ADM_CAR_PARMS Student Recruiting >
Assign Recruiters >
Recruiter Assignment >
Academic Selection Crit

Enter any academic selection
criteria for the prospect group.

Prog/Plan Selection Crit 
(program or plan selection
criteria)

ADM_PROGRAM_PARMS Student Recruiting >
Assign Recruiters >
Recruiter Assignment >
Prog/Plan Selection Crit

Enter any academic program
or academic plan selection
criteria for the prospect group.
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Page Name Definition Name Navigation Usage

Acad Interests Selection Crit 
(academic interests selection
criteria)

ADM_INTEREST_PARMS Student Recruiting >
Assign Recruiters >
Recruiter Assignment >
Acad Interests Selection Crit

Enter any subject area
selection criteria for this
prospect group. You can
select people for prospect
groups that have expressed an
academic interest in certain
subject areas if you want to
assign regions, recruiting
categories, and recruiters
based on this criteria.

Assignment Crit (assignment
criteria)

ADM_RECRREGN_PARMS Student Recruiting >
Assign Recruiters >
Recruiter Assignment >
Assignment Crit

Assign regions, recruiting
categories, and recruiters to
the prospect group.

Using General Criteria to Select the Prospect Group
Access the General Selection Crit (general selection criteria) page (Student Recruiting > Assign
Recruiters > Recruiter Assignment > General Selection Crit).
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This example illustrates the fields and controls on the General Selection Crit page. You can find
definitions for the fields and controls later on this page.

Note: To select a person for a prospect group, that person must meet all of the criteria that you define
on this page. For example, you can select a female from Cottonwood High School with an admit term of
spring 2001 and an academic load of Full Time. The system selects only persons to whom all of these
conditions apply. This is an example of AND logic. Contrast this with the discussion of OR logic in the
Program Data group box on the Prog/Plan Selection page.

Academic Selection

Field or Control Description

Institution and Academic Career Enter the academic institution and career and for this prospect
group.

If you do not enter an academic institution and an academic
career, no prompt values exist for fields such as admit term,
 admit type, and referral source on the Acad Interests Selection
Crit (academic interests selection criteria) page and the
Program/Plan Selection Crit (program or plan selection
criteria) page.
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Field or Control Description

Last School Attended Enter the last school attended to assign regions, recruiting
categories, and recruiters based on this criterion.

Bio/Demo Selection

Field or Control Description

Gender Select (none), Female,  Male, or Unknown to assign regions,
 recruiting categories, and recruiters based on this criterion.

Citizenship Country Enter a county of citizenship.

Citizenship Status Select a citizenship status to assign regions, recruiting
categories, and recruiters based on this criterion. You must
specify a country of citizenship for values to exist for this
field.

Marital Status Select a marital status to assign regions, recruiting categories,
 and recruiters based on this criterion.

Address Selection

Field or Control Description

Country and State Enter the country and state to assign regions, recruiting
categories, and recruiters based on these criteria.

Postal Code

Complete field in this group box to select a prospect group from a certain postal code or postal code
range. Select the appropriate option, depending on how you want to select by postal code. Only one of
these options can be selected.
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Field or Control Description

Begins With and From Select a prospect group by defining a beginning postal code.
 Enter the beginning postal code in the From field. For
example, use this option if one prospect has a five-digit postal
code (90068) and another prospect has a nine-digit version of
the postal code Using a postal code that begins with 90068
finds both prospects.

Equals Select this option to choose a prospect group by a specific
postal code. Enter the postal code in the From field.

Range, From, and To Select Range to select a prospect group by a postal code range.
 Enter the beginning postal code in the From field and the
ending postal code in the To field.

N/A Select N/A if you do not want to use a postal code in your
selection criteria for this prospect group. This is the default
setting.

Region Selection

Complete fields in this group box to define how you will select this prospect group if you want to assign
regions, recruiting categories, and recruiters based on this criterion.

Field or Control Description

N/A Select this option if you do not want to use region in your
selection criteria for this prospect group.

Blank Select this option to select people for a prospect group who do
not have a region assigned.

Non-Blank Select this option to select prospects who have been assigned a
geographical region.

Ethnic Group Selection

Complete fields in this group box if you want to assign regions, recruiting categories and recruiters to a
group of prospects based on specific ethnic groups.
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Field or Control Description

Regulatory Region Select the region for which the ethnic groups are defined. Once
this field is populated, the Ethnic Group field will appear.

Ethnic Group Select one or more ethnic groups to assign regions, recruiting
categories, and recruiters based on this criterion. The values
for this field will vary based on the regulatory region entered.

Using Academic Criteria to Select the Prospect Group
Access the Academic Selection Crit (academic selection criteria) page (Student Recruiting > Assign
Recruiters > Recruiter Assignment > Academic Selection Crit).

This example illustrates the fields and controls on the Academic Selection Crit page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Admit Term Enter the admit term for this career and prospect group to
assign regions, recruiting categories, and recruiters based on
this criterion. Values depend upon the academic career n the
General Selection Crit page.

Admit Type Enter the admit type for this career to assign regions, recruiting
categories, and recruiters based on this criterion. Values
depend upon the academic career on the General Selection Crit
page.

Campus Enter a campus to assign regions, recruiting categories, and
recruiters based on this criterion.
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Field or Control Description

Acad Load (academic load) Select the appropriate academic load for this career to assign
regions, recruiting categories, and recruiters based on this
criterion. Values depend upon the academic career entered on
the General Selection Crit page.

Acad Level (academic level) Select an academic level for this career to assign regions,
 recruiting categories, and recruiters based on this criterion.

Note: If you have not entered an academic institution and an
academic career on the General Selection Crit page, there are
no prompt values for these fields.

Recruiting Status Select the recruiting status to assign regions, recruiting
categories, and recruiters based on this criterion.

Created On Enter the date that prospect records were created to assign
regions, recruiting categories, and recruiters based on this
criterion.

Referral Source Enter the referral source to assign regions, recruiting
categories, and recruiters based on this criterion.

Recruiting Center Enter the recruiting center to which prospects in this career are
assigned to assign regions, recruiting categories, and recruiters
based on this criterion.

Housing Select a housing interest for this prospect group to assign
regions, recruiting categories, and recruiters based on this
criterion.

Interested in Fin Aid (interested in financial aid) Select this option to select a prospect group by those who
indicate an interest in financial aid.

Not Interested in Fin Aid (not interested in financial aid) Select this option to select a prospect group by those who have
specified that they are not interested in financial aid.

Not Applicable Select this option to selects a prospect group regardless of their
expressed interest in financial aid. This is the default setting.

Using Program and Plan Criteria to Select the Prospect Group
Access the Prog/Plan Selection Crit (program or plan selection criteria) page (Student Recruiting >
Assign Recruiters > Recruiter Assignment > Prog/Plan Selection Crit).
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Field or Control Description

Academic Program Enter an academic program for this prospect group. Values
depend upon the academic institution and career that you
select on the General Selection Crit page. You can enter
more than one academic program. If you enter more than
one academic program (for example, Liberal Arts and Fine
Arts) people who are in either the Liberal Arts or the Fine
Arts academic programs are selected for this prospect group.
 Whenever you see a field in which you can scroll (First-Next-
Previous-Last links) in this component, the OR logic applies;
that is, one or the other must be true for that person to be
selected. Contrast this to the AND logic discussed in the Using
General Criteria to Select the Prospect Group section.

Campus Enter a campus for this prospect group to assign regions,
 recruiting categories, and recruiters based on this criterion.
 Values depend upon the academic program selected.

Recruiting Status Select a recruiting status for this academic program if you
want to assign regions, recruiting categories, and recruiters
based on this criterion.

Recruiting Center Enter a recruiting center for this academic program to assign
regions, recruiting categories, and recruiters based on this
criterion. Values depend upon the academic career you select
and are subject to the user security established for recruiting
centers.

Academic Plan Enter an academic plan for the academic program in the
Academic Program field to assign regions, recruiting
categories, and recruiters based on this criterion. You can enter
more than one academic plan. If you enter one academic plan,
 a person must have that plan to be selected for this prospect
group. If you enter more than one academic plan, a person
must have only one of the plans that you enter to be included
in this prospect group.

Using Academic Interests Criteria to Select the Prospect Group
Access the Acad Interests Selection Crit (academic interests selection criteria) page (Student
Recruiting > Assign Recruiters > Recruiter Assignment > Acad Interests Selection Crit).
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This example illustrates the fields and controls on the Acad Interests Selection Crit page . You can find
definitions for the fields and controls later on this page.

Field or Control Description

Priority Select this option to select prospects who have expressed a
prioritized interest in certain subject areas.

Non-Priority Select this option to select prospects who have not expressed a
prioritized interest in certain subject areas.

Not-Applicable Select this option to select prospects regardless of their
expressed interest in any subject area. This is the default
option.

Subject Area Enter individuals for a prospect group who have expressed
an academic interest in a common subject area. This field
is optional and is based on the options that you selected
(Priority, Non-Priority, or Not-Applicable). You can enter
more than one subject area. For example, if you enter English
and Math as subject areas, the system selects those people who
have expressed an interest in either English or Math for this
prospect group. Therefore, the OR logic applies; one or the
other must be true for that person to be selected. Contrast this
to the AND logic discussed in the Bio/Demo Selection group
box on the first page in this component.

From and To Enter an academic interest priority range. For example, you
can select people for this prospect group who have expressed
an interest in pre-law as their first or second interest choice.
 These fields are relevant only if you selected the Priority
option.

Related Links
Pages Used to Track Supporting Information for Prospects and Applicants
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Assigning Regions, Recruiters, and Recruiting Categories to the Prospect
Group

Access the Assignment Crit (assignment criteria) page (Student Recruiting > Assign Recruiters >
Recruiter Assignment > Assignment Crit).

This example illustrates the fields and controls on the Assignment Crit page . You can find definitions for
the fields and controls later on this page.

Assignment Selection

Field or Control Description

Regions and Categories/Recruiters Select the criteria for processing this prospect group, such
as assign regions to the prospect group; assign recruiting
categories and recruiters to the prospect group. Alternately,
 you can select both the options assign regions, recruiting
categories, and recruiters to the prospect group. The system
selects both check boxes by default.

Region From

You can automatically or manually assign a region for the individuals in this prospect group. These fields
are only relevant if you select the Regions check box.
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Field or Control Description

School Select this option to automatically assign a region for this
prospect group, based on the primary location postal code of
the school that the prospect last attended.

Address Select this option to automatically assign a region for this
prospect group, based on the home address postal code of the
prospect.

Region Tree Manually assign a region for this prospect group when you
click the prompt on the Region field. Select a region from the
list.

Important! If you plan to assign a regional recruiter to this prospect, you must enter a category of REGN
(region) in the Category field.

Recruiting Categories

Complete the fields in this group box to assign recruiting categories to the prospect group. Use recruiting
categories to target a prospect group for special attention during the recruiting and admissions business
process.

Field or Control Description

Category Enter a recruiting category for this prospect group (for
example, HTST (high test scores). You can assign multiple
recruiting categories. Define recruiting categories on the
Recruiting Category Table page. Use these categories in the
recruiting and application processes to target and report on
students.

Sub-Cat (subcategory) Select a recruiting subcategory, if known. Values for this
field are delivered with your system as translate values. You
can modify these translate values. Values are (none),  High,
 Low, and Medium.  You can use a subcategory to indicate the
priority of this recruiting category.

Existing Recrs (existing recruiters) Select an option for handling existing recruiters for people in
this prospect group. You can merge them or replace them with
the recruiters that you are currently assigning.  Merge appears
by default.
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Field or Control Description

Move to Application Select this check box to carry forward the recruiting categories
to the application records when individuals in this prospect
group apply to your institution. However, you must set up your
installation defaults to allow the system to copy the recruiting
category. Select the Recruiting Categories check box on the
Installation Defaults - AD page.

Multiple Recruiters - Assign

This group box becomes active when you assign recruiters to prospects by the region category.

Field or Control Description

All Select this option to assign to this prospect group all of the
region's recruiters in the region that you define.

One Select this option to assign to this prospect group one of the
region's recruiters in the region that you define. The system
assigns the first recruiter who is assigned to this recruiting
category.

None Select this option to assign no recruiters if there are multiple
recruiters for this category.

Recruiters

Field or Control Description

Prompt Category Use this field to assign recruiters to the prospect group for all
recruiting categories other than REGN. Select Categories to
view the list of recruiters for the category in the Recruiting
Categories group box. Select Recruiters to display a list of all
recruiters, regardless of their category.

If you chose the REGN category, the Recruiting Categories
and Recruiters group boxes become unavailable.

Recruiter ID Enter a recruiter ID for the prospect group. The list of
recruiters that appears depends on what you entered in the
Prompt Category  field.
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Field or Control Description

Primary Select this check box if you want to designate the recruiter as
the primary recruiter.

Note: Save the page before you click the Run button.

Click Run to run this request at user-defined intervals.
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Tracking Supporting Prospect and
Applicant Information

Understanding Tracking Supporting Prospect and Applicant
Information

You can:

• Track supporting information for prospects and applicants.

• View event and meeting summary information.

• View schools by groups.

• View an account summary.

Note: Recruiting and Admissions shares functionality with PeopleSoft Campus Community. For
this reason, many of the pages covered by the topics listed above are documented in their entirety in
PeopleSoft Campus Community Fundamentals product documentation.

Prerequisites for Tracking Supporting Prospect and Applicant
Information

Before you begin entering supporting information for a prospect or applicant, you must enter prospects
and applicants into your database.

Related Links
Adding New Applications Manually
Adding New Prospects and Applications with Quick Admit
Creating Applications from External Test Score Data
Understanding Adding Prospects

Tracking Supporting Information for Prospects and Applicants

This section discusses how to track and view the following information for prospects and applicants:

• Academic interests.

• Electronic addresses.
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• Extracurricular activities.

• Honors and awards.

• Languages.

• Names.

• Publications.

• Relations with your institution.

• Relationships.

• Residency data.

• Student group involvement.

• Work experience.

• Test results.

• Test summary information.

Pages Used to Track Supporting Information for Prospects and Applicants

Page Name Definition Name Navigation Usage

Academic Interests ADM_INTERESTS • Student Recruiting >
Maintain Prospects >
Academic
Information >
Academic Interests

• Student Admissions >
Application
Entry > Academic
Information >
Academic Interests

Record a person's external
subject areas of interest,
whether your institution offers
them. You can also record the
person's level of academic
interest. For example, Pre-
Law could be a person's first
priority and Technology
could be the person's second
priority. You can use this
information for recruiting
purposes by determining what
areas you offer that are similar
to the person's preferences.
 This information is also
valuable for reporting and
academic program planning
purposes.
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Page Name Definition Name Navigation Usage

Test Results STDNT_TEST_SCORE • Student Recruiting >
Maintain Prospects >
Academic
Information > Test
Results

• Student Admissions >
Application
Entry > Academic
Information > Test
Results

• Student Recruiting >
External Test Score
Processing > Test
Results or Student
Admissions > External
Test Score Processing >
Test Results

• Records and
Enrollment > Transfer
Credit Evaluation >
Test Results

Enter test scores and related
test information for a person
manually. You can also load
various test information into
this page through an external
test score load. Test results
are stored under a person's
name and can be used when
evaluating any application
for the person. Link test
scores to an application on the
Application Materials page.

Store additional test score
information by Test Date
using the Common Attribute
Framework.

Test Summary STDNT_TEST_SUMMARY • Student Recruiting >
Prospect Summaries >
Academic Test
Summary

• Student Admissions >
Applicant
Summaries >
Academic Test
Summary

• Records and
Enrollment > Transfer
Credit Evaluation >
Academic Test
Summary

• Student Recruiting >
External Test Score
Processing > Academic
Test Summary or
Student Admissions >
External Test Score
Processing > Academic
Test Summary

View a summary of academic
test information for prospects
and applicants. This page
includes information such as
test score and data source.

Tracking Academic Interests for Prospects and Applicants
Access the Academic Interests page (Student Recruiting >Maintain Prospects >Academic
Information >Academic Interests).
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This example illustrates the fields and controls on the Academic Interests page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Effective Date Enter the effective date if it is different than the current date.
The current date is the default. The effective date defines when
the information you enter is valid.

Use Priority Select this check box to prioritize a person's academic
interests.

The default for this field is selected if you enabled the Use
Priority Academic Interest feature on the Installation Defaults
- AD page.

Subject Area Enter a subject area. Define external subject areas on the
External Subject Table page.

Description The description for this subject appears.

If the person expressed an interest for which no subject area
code is defined, leave the Subject Area  field blank and enter
a free-form.

Data Source Select a value to indicate how this information was provided
to your institution. For example, you might have received this
information directly from the applicant or through a data load.
Values for this field are delivered with your system as translate
values. You can modify these translate values.

Priority Enter a priority level (for example 1, 2, 3). 1 is the highest
priority.

The default for this field is selected if you have enabled the
Use Priority Academic Interest feature on the Installation
Defaults - AD page.

Go Click this button to go to another component.
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Tracking Electronic Addresses for Applicants
Use the Electronic Addresses page to enter or update electronic addresses for a person. To navigate to the
Electronic Addresses page, select Campus Community > Personal Information > Biographical >
Addresses/Phones > Electronic Addresses.

See "Campus Self Service Overview" (Campus Self Service )

Tracking Extracurricular Activities for Prospects and Applicants
Use the Extracurricular Activities page to record information regarding a person's external interests. To
navigate to the Extracurricular Activities page, select Campus Community > Personal Information >
Participation Data > Extracurricular Activities.

Tracking Honors and Awards for Prospects and Applicants
Use the Honors and Awards page to record a prospect's or applicant's honors and awards. For example,
an external honors could be National Merit Finalist or Valedictorian. Internal honors and awards could
be a scholarship for an incoming applicant or the Dean's List for a matriculated student. To navigate to
the Honors and Awards page, select Campus Community > Personal Information > Participation
Data > Accomplishments > Honors and Awards.

Related Links
"Tracking Honors and Awards" (Student Records)

Tracking Languages for Prospects and Applicants
Use the Languages page to enter, update, and view language proficiency information. To navigate to the
Languages page, select Campus Community > Personal Information > Biographical > Personal
Attributes > Languages.

Tracking Names for Prospects and Applicants
Use the Names page to enter, update, and review name information. You can store various names for a
person, such as their primary name, preferred name, former name, and maiden name. You can also search
on these names using the Search/Match feature. When generating letters, you can specify the specific
name that you want to use.

To navigate to the Names page, select Campus Community > Personal Information > Biographical >
Names.

See Entering and Updating Prospect Biographical Details.

Tracking Publications for Prospects and Applicants
Use the Publications page to enter, update, and review publication information. For example, a person
might have written a book, produced a video, or published a thesis. To navigate to the Publications page,
select Campus Community > Personal Information > Participation Data > Accomplishments >
Publications.

Copyright © 1988, 2021, Oracle and/or its affiliates. 505



Tracking Supporting Prospect and Applicant Information Chapter 16

See Also

"Entering Publications Data" (Campus Community Fundamentals)

Tracking Relations with Your Institution for Prospects and Applicants

Important! Mass Change is a deprecated product. Support will be maintained for this product, but
no new development will be produced for Mass Change. It is strongly recommended that you use
Application Engine instead. For more information on PeopleSoft Application Engine, see PeopleTools:
Application Engine.

Use the Relations With Institution page to enter, update, and review information regarding relationships
a person has with your institution. The status you designate here is reflected on the Search/Match Results
page. There is a mass change definition delivered with your system that can update and move multiple
peoples' status as a background process. To navigate to the Relations With Institution page, select
Campus Community > Personal Information > Biographical > Relationships > Relations with
Institution.

Related Links
"Managing Relationships Data" (Campus Community Fundamentals)

Tracking Relationships for Prospects and Applicants
Use the Relationships page to enter, update, and review information regarding relationships a prospect or
applicant has with any person in your database. For example, a prospect or applicant could have a friend
or a relative in the database. The Relationships page can store data for people who already exist in the
system (those who have an ID) or for people who do not exist in the system. If you enter information
on this page for people who do not exist in the system, the system creates a new ID. To navigate to
the Relationships page, select Campus Community > Personal Information > Biographical >
Relationships > Relationships.

Related Links
"Managing Relationships Data" (Campus Community Fundamentals)

Tracking Residency Data for Prospects and Applicants
Use the Residency Data component to enter, update, and review residency information for a person.

Related Links
"Entering Residency Data" (Campus Community Fundamentals)

Tracking Student Group Involvement for Prospects and Applicants
Use the Student Groups page to enter any student groups that your institution has defined to which this
person belongs. To navigate to the Student Groups page, select Records and Enrollment > Career and
Program Information > Student Groups.
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Related Links
"Tracking Student Groups" (Student Records)

Tracking Work Experience for Prospects and Applicants
Use the Work Experience page to enter, update, and review work experience information you might
have for a person. To navigate to the Work Experience page, select Campus Community > Personal
Information > Biographical > Work Experience.

See Also

"Tracking Work Experience" (Campus Community Fundamentals)

Tracking Test Results for Prospects and Applicants
Access the Test Results page (Student Recruiting >External Test Score Processing >Test Results  or
Student Admissions >External Test Score Processing >Test Results).

This example illustrates the fields and controls on the Test Results page. You can find definitions for the
fields and controls later on this page.
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Field or Control Description

Test ID Enter the test you are recording. Define tests on the Test Tables
page.

Checklist Item Update Select this check box to indicate that the checklist related
to this row of data is updated when you run the Checklist
Item Update Automated process. When you save the page,
 the system selects this check box automatically. To clear this
check box, save the page, clear the check box, then save the
page again.

Test Date Select the date on which this test was taken. The value you
enter here populates the corresponding field in the bottom
region of the page.

Data Source Select how this test information was reported. For example,
 the data could have been self-reported or received from
a testing agency. The value you select here populates the
corresponding field in the bottom region of the page. Values
for this field are delivered with your system as translate values.
 You can modify these translate values.

Acad Level (academic level) Select the applicant's academic level at the time this test was
taken. This level can be different from the applicant's current
level. The value you enter here defaults to the corresponding
field in the bottom region of the page. Values for this field are
delivered with your system as translate values. You can modify
these translate values.

Component Enter the first test component. Values for this field are
determined by the test ID that you enter. Define test
components on the Test Component Table page and link them
to tests on the Test Tables page.

Score %tile (score percentile) Enter the score, percentile, or both for this test component.

Test Date The system automatically populates this field from the value
you entered in the Defaults for Components group box. You
can edit the date if necessary.

Data Source The system automatically populates this field from the value
you entered in the Defaults for Components group box. You
can edit the value if necessary.

Acad Level The system automatically populates this field from the value
you entered in the Defaults for Components group box. You
can edit the value if necessary.

Letter Score Enter a letter score for this test component, if applicable.
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Field or Control Description

Date Loaded The default for the loaded date is your system date. Edit this
field if necessary. If this information is electronically loaded,
 this field is automatically populated with your system date the
day the data is loaded.

Index The LSAT 3-Year Test Index appears if this information has
been loaded.

Stnd Admin (standard administration) The system selects this check box by default, which indicates
that this test was administered in a standard way. Clear this
check box if the test was administered in a nonstandard or
non-timed way.

Go Click this button to go to another component for this record.

Additional Test Data

This section enables you to store additional test score data that does not have a home in the core Campus
Solutions records. Populate this section by test date with values for common attributes defined within the
Common Attribute Framework. Attributes can be manually added on this page or can also be populated
from the Prospect/Admissions Data Load process. The prompts in the Field column will display attributes
associated on the record context for SAD_TESTDT.

See "Understanding Common Attribute Framework" (Campus Community Fundamentals)

See Understanding Prospect/Admission Data Load Transactions

Viewing Academic Test Summary Information for Prospects and Applicants
Access the Academic Test Summary page (Student Recruiting >External Test Score
Processing >Academic Test Summary  or Student Admissions >External Test Score
Processing >Academic Test Summary).

This example illustrates the fields and controls on the Academic Test Summary page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Test ID and Test Component Enter the test ID and test component about which you want to
view summary information.

Date, Score, or Test Select the order in which you want the summary information
to appear (for example, by date, score or test).

Search Click to access information that matches your search criteria.

Viewing Event and Meeting Summary Information

Use the Person Event Summary page to look up summary information regarding events and meetings
for any prospect or applicant in your database. To navigate to the Person Event Summary page, select
Campus Community > Campus Event Planning > View Event Information > Person Event
Summary.

Related Links
"Reviewing Events, Meetings, and Attendees" (Campus Community Fundamentals)

Viewing Schools by Groups

Use the Organization Groups Summary page to view schools or any type of organization, in groups
you designate. You can display the list in the order you choose. To navigate to the Organization Groups
Summary page, select Campus Community > Organization > Review Organizations > Organization
Groups Summary.

Related Links
"Reviewing Organization Data" (Campus Community Fundamentals)

Viewing an Account Summary

You can view a summary of an applicant's account history through a PeopleSoft Student Financials
inquire page. Use the Customer Accounts page to view an applicant's account history.

See "Viewing Application History" (Financial Aid).
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Tracking External Education

Understanding External Education

Enter and update academic information from external sources in the Education
(ACAD_HISTORY_PERS) component. You can record external education data, such as schools attended,
academic summaries, subjects, degrees, courses, and dates of attendance.

Note: This information is linked to a person rather than an application. You can, therefore, consider the
information when you evaluate specific applications for the person.

This information can be reported on a transcript, self-reported, or reported from another source, and it can
be linked to specific applications on the Application Materials page.

View summaries of external education information for prospects and applicants in the Education
Summary (SAD_EDUC_SUMMARY) component.

Entering and Updating External Education Data

This section lists common elements and discusses how to:

• Enter external education data.

• Enter transcript comments.

• Enter external courses and degrees.

• Enter transfer credit detail.

• Enter external course comments.

• (CAN) Enter regional data.

• Copy self-reported courses.

Common Elements Used in This Section

Field or Control Description

Transfer To Course Credits appears by default. Enter a value and click Go
to transfer to another component.
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Field or Control Description

Customize Click to ensure more efficient and flexible data entry by
ordering or hiding tabs and fields.

See PeopleTools: Applications User's Guide

Pages Used to Enter and Update External Data

Page Name Definition Name Navigation Usage

External Education SAD_EXT_EDUCATION • Student Admissions >
Application/Transcript
Loads > Education >
External Education

• Student Recruiting >
Maintain Prospects >
Academic
Information >
Education > External
Education

• Student Admissions >
Application
Entry > Academic
Information >
Education > External
Education

• Records and
Enrollment > Transfer
Credit Evaluation >
External Education >
External Education

Enter information about
external careers, transcripts,
 and subjects. View school
details.

External Education Comment SAD_EXT_ED_COMM Click the Comments link on
the External Education page.

Enter transcript comments.
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Page Name Definition Name Navigation Usage

Courses and Degrees SAD_EXT_EDUCATION2 • Student Admissions >
Application/Transcript
Loads > Education >
Courses and Degrees

• Student Recruiting >
Maintain Prospects >
Academic
Information >
Education > Courses
and Degrees

• Student Admissions >
Application
Entry > Academic
Information >
Education > Courses
and Degrees

• Records and
Enrollment > Transfer
Credit Evaluation >
External Education >
Courses and Degrees

Enter external course defaults
and information about
external courses and degrees.

Grade Input History SAD_EXT_CRS_GRD Click the History link on the
Courses and Degrees page.

View a history of grade
changes.

Transfer Credit Detail SAD_EXT_CRS_TRCR Click the Referenced link
on the Courses and Degrees
page.

View transfer credit details
about external courses.

External Course Comments SAD_EXT_CRS_COMM Click the Course Comment
link on the Courses and
Degrees page.

Enter comments about
external courses.
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Page Name Definition Name Navigation Usage

Regional SAD_EXT_EDUC_REG • Student Admissions >
Application/Transcript
Loads > Education >
Regional

• Student Recruiting >
Maintain Prospects >
Academic
Information >
Education > Regional

• Student Admissions >
Application
Entry > Academic
Information >
Education > Regional

• Records and
Enrollment > Transfer
Credit Evaluation >
External Education >
Regional

(CAN) Define previous
education information for
ESIS (Extended Student
Information System)
reporting.

Self Reported Courses SAD_EXT_EDUC_TRCR • Student Admissions >
Application/Transcript
Loads > Education >
Self Reported Courses

• Student Recruiting >
Maintain Prospects >
Academic
Information >
Education > Self
Reported Courses

• Student Admissions >
Application
Entry > Academic
Information >
Education > Self
Reported Courses

• Records and
Enrollment > Transfer
Credit Evaluation >
External Education >
Self Reported Courses

Copy self-reported courses
entered by the student on
the Evaluate My Transfer
Credit page to the Courses
and Degrees page.

Entering External Education Data
Access the External Education page (Student Admissions >Application/Transcript
Loads >Education >External Education).
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This example illustrates the fields and controls on the External Education page (1 of 2). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the External Education page (2 of 2). You can find
definitions for the fields and controls later on this page.

Field or Control Description

External Org ID (external organization ID) The source of the external data. The system automatically
populates this field from the initial add of Last School
Attended on the Prospect School/Recruiting page or the
Application School/Recruiting page if a value is entered. You
can edit this field.
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Field or Control Description

Checklist Item Update Select this check box to indicate that the checklist that relates
to this row of external data (or transcript) is updated when
you run the Checklist Item Update Automated process. If you
enter a value of Received in the Action field in the Transcript
Status group box, this check box is automatically selected
when you save the page.

School Details

Click the arrow to the left of School Details to view information about the external organization.

This data is populated from the Organization Table page and the Organization School Data page.

Career Data

Field or Control Description

Data Number The system populates this field automatically. The first data
item (or row) you enter is 1. The system numbers subsequent
rows sequentially.

Career Select the external career for this external data. Values for this
field are delivered with your system as translate values.

Term Type Select the term type that is used by the external organization.
Values for this field are delivered with your system as translate
values. Examples of the available values include semester and
quinmester.

External Term Enter the external term to which this data relates. For example,
 if this is a Fall transcript, enter FALL in the External Term
field. The available values depend on what you enter in the
Term Type field. Define external terms on the External Term
Table page.

This field is optional; leave it blank until you are ready to enter
transfer credit information.

Term Year Enter the term year that is relevant to this external data entry.
This field is optional; leave it blank until you are ready to enter
transfer credit information.
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Field or Control Description

Academic Level Select the academic level of the person at the time the external
data was collected or issued. This value might be different
from the current academic level. Values for this field are
delivered with your system as translate values.

From Date and To Date Enter the dates of attendance for the career data that you
entered.

Dismissed From School Select this check box if the student was dismissed from the
institution.

Transcript Status

Field or Control Description

Action Desired appears by default. Select the appropriate action for
the transcript. Available values are Desired and Received.
 Leave the value as Desired if you are entering data for a
transcript that you requested. Select a value of Received if the
data is for a transcript that you have received.

When the Action field is set to Received, you can link the data
to an application on the Application Materials page.

Transcript Date Enter the date that the transcript was issued. The transcript
date must not be later than the received date.

Date Received Enter the date that your office received the transcript. The
received date cannot occur before the transcript date.

Transcript Type Select a transcript type. Values for this field are delivered with
your system as translate values. These values default from the
User Defaults 3 page if defaults are defined there.

Transcript Status Select a transcript status. Values for this field are delivered
with your system as translate values.

Data Source Select the data source for this transcript. Values for this field
are delivered with your system as translate values. These
values default from the User Defaults 3 page if defaults are
defined there.
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Field or Control Description

Data Medium Select the format in which you received the transcript. Values
for this field are delivered with your system as translate values.
 These values default from the User Defaults 3 page if defaults
are defined there.

Comments Click to access the External Education Comment page and
enter transcript comments.

Transcript Summary

You can enter GPA (grade point average), units, and rank details for this data, which can be reported on
a transcript, self-reported, or reported from another source. You can enter multiple transcripts (or similar
data) under an external organization.

The layout of the page enables you to define how you want to represent a person's academic transcripts.
You can associate one or more summaries for a single transcript. You can also enter the summary GPA,
units, and rank of a person's entire academic career, or insert rows to create individual summaries that
capture data for various segments of a person's academic career. Enter as many summary types as you
require. This structure enables you to capture the GPA, rank, and units for each year of school, in addition
to the overall summary, on one transcript.

Note: Many values on this page appear by default from the User Defaults 3 page, from pages in the
Create/Maintain Organizations component, and from the data that you entered in the Career Data group
box.

Term

Select the Term tab.

Field or Control Description

Summary Type Select the summary type for the external data. For example,
 you might select a summary of an entire high school transcript
or a summary of grade 12 only. Define summary types on the
External Summary Type Table page.

External Term and Ext Year (external year) Select the external term and year relevant to the summary.
 Define external terms on the External Term Table page

518  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 17 Tracking External Education

Field or Control Description

Acad Level (academic level) Select the student's academic level at the time that this
information was current, which may not be the student's
current academic level. For example, this value could be a
summary of a school year that the student has completed. As
with the academic level for career data, you can choose which
data to enter here and how to relate this academic level data to
the career data.

GPA/Units

Select the GPA/Units tab.

This example illustrates the fields and controls on the External Education page: GPA/Units tab. You can
find definitions for the fields and controls later on this page.

Field or Control Description

GPA Type (grade point average type) Enter the GPA type that is used by the external organization.
 Define GPA types on the GPA Type Table page.

Ext GPA (external grade point average) Enter the external GPA from the reported information. If you
have defined external GPA values for this GPA type on the
GPA Type Table page, you can prompt for those values here.
 Otherwise, you can enter the appropriate numeric GPA value.

Conv GPA (converted grade point average) If you have defined GPA conversion rules, the system
automatically converts the GPA based on the External GPA
that you enter. If you have not defined GPA conversion rules,
the value that you enter in the External GPA field is copied to
the Conv GPA field.

Completed The value in the  Completed field is automatically populated
from the value in the Attempted field. You can override this
value. Enter the number of units that the student completed
if it is different from the number of units that the student
attempted.
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Rank

Select the Rank tab.

This example illustrates the fields and controls on the External Education page: Rank tab. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Class Rank and Class Size Enter the student's rank in their class and the size of the class.

Percentile The system automatically calculates the percentile based on
the values entered in the Class Rank and Class Size fields.

External Subjects

External subject information can be reported on a transcript, self-reported, or reported from another
source. Storing this data is useful for grouping subjects. For example, if your office tracks subject area
requirements but does not want to enter or load all of the external courses that a student has taken, you
can record course level, number of courses, units, external GPA, and converted GPA details about external
subject areas. Define external subject areas on the External Subject Table page. You can add multiple
rows to enter external subject data.

GPA

Select the GPA tab.

Field or Control Description

Course Level Select the course level taken in this area. Values for this field
are delivered with your system as translate values.

GPA Type (grade point average type) Enter the GPA type for the school that the student attended.
 Define GPA types on the GPA Type Table page.

External GPA (external grade point average) Enter the external GPA that was earned by the student for this
subject. If you have defined external GPA values for this GPA
type on the GPA Type Table page, you can prompt for those
values here. Otherwise, enter the appropriate GPA value.
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Field or Control Description

Converted GPA (converted grade point average) If you have defined GPA conversion rules, the system
automatically converts the GPA. If you have not defined GPA
conversion rules, the GPA that you enter in the External GPA
field is copied into the Converted GPA field.

Subject Totals

Select the Subject Totals tab.

This example illustrates the fields and controls on the External Education page: Subject Totals tab. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Courses Completed Enter the number of courses that the student completed if it is
different from the number of courses the student attempted.

Units Completed Enter the number of units that the student completed if it is
different from the number of units that the student attempted.

Entering Transcript Comments
Access the External Education Comment page (Click the Comments link on the External Education
page).
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This example illustrates the fields and controls on the External Education Comment page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

ID, External Org ID (external organization ID), External
Career, and Data Number

You can enter multiple comments for each of these fields. Your
user ID, name, and the date that you entered the comment will
appear with each row.

Default Comment and Comment If you enter a default comment, the Comment field is
populated with the default text and you can enter more
information. You can also add a comment without entering
a default. Default comments are defined on the External
Education Comments table.

Entering External Courses and Degrees
Access the Courses and Degrees page (Student Admissions >Application/Transcript
Loads >Education >Courses and Degrees).
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This example illustrates the fields and controls on the Courses and Degrees page. You can find definitions
for the fields and controls later on this page.

Note: Many values on this page appear by default from the User Defaults 3 page, from pages in the
Create/Maintain Organizations component, and from the data that you entered on the External Education
page.

Important! If you have to enter more than one course, use the External Course Defaults group box to
enter information that is common to each course. This group box will save you data entry time.

External Course Defaults

Field or Control Description

Data Number If the courses that you enter are linked to a row of transcript
data on the External Education page, enter the data number
from that page. When you navigate out of this field, the system
automatically populates a number of the remaining fields with
the data that is linked to this data number. If the courses that
you enter are not linked to a data number, do not enter a value
in this field but complete the remaining fields.
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Field or Control Description

Term Type If you select a value of Other, the Begin Date and End Date
fields become available. If you select any other value, the
External Term and Term Year fields become available.

Grading Scheme Select the grading scheme to convert the grading scheme of
the external school to your standards. Define grading schemes
on the Grading Scheme Table page.

Apply Defaults Click to populate the default values to the first row of the
External Courses group box. These defaults will then be
applied to subsequent rows.

You only need to apply the defaults once. If you enter
another data number or change the default data, do not select
the Apply Defaults button again. The new defaults will
automatically apply to subsequent rows of course data that you
enter.

External Courses

When you click the Apply Defaults button, the system populates many values in the External Courses
group box.

Important! Always apply defaults before you add multiple rows or enter any external course data.

Course

Select the Course tab.

Field or Control Description

School Subject Enter the school subject area for the course that you are
entering. If you have set up a course catalog for this school,
 you can prompt for the valid values in this field. If a course
catalog does not exist for this school, enter the subject.

Course Nbr (course number) Enter the school course number for this course. If you have
set up a course catalog for this school, you can prompt for the
valid values in this field. If a course catalog does not exist for
this school, enter the course number.
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Field or Control Description

Course Name This field is populated when you enter a course number. You
can override this value. For example, if Physical Education
appears, you might add Basketball as extra text. You can also
enter a course name if one is not automatically populated.

Grades

Select the Grades tab.

This example illustrates the fields and controls on the Courses and Degrees page: Grades tab. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Units Taken Appears by default from the value in the Units Taken field in
the External Course Defaults group box. The default value
is overridden if a value for External Units is defined on the
School Course Classification page.

Grade In Enter grades and grade changes. When you save grade
changes, the History link appears.

History Click to access the Grade Input History page and view a
history of the grade changes. This link will only appear if a
change was made to the value in the Grade In field.

Transfer Credit/Comments

Select the Transfer Credit/Comments tab.
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This example illustrates the fields and controls on the Courses and Degrees page: Transfer Credit/
Comments tab. You can find definitions for the fields and controls later on this page.

Field or Control Description

Transfer Credit This check box is selected by default.

Transfer Credit Status The Referenced link is available if the course was used in
a Transfer Credit model articulation rule. Click to access
the Transfer Credit Detail page and view transfer credit
information about the course.

(CAN) Transfer Credit Type This field is available if the Government Reporting check
box for Canada is selected on the SA Features (student
administration features) page.

Course Comment Click to access the External Course Comments page and enter
comments about courses.

External Degrees

Enter information about external degrees that are in progress or completed.

Degree

Select the Degree tab.

Field or Control Description

Degree and Description If you enter a value in the Degree field, the Description
field is populated. If a degree value is not available, enter a
description.

Degree Date Enter the date that the degree was or will be granted.

Degree Status Complete appears by default.
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Field of Study

Select the Field of Study tab.

This example illustrates the fields and controls on the Courses and Degrees page: Field of Study tab. You
can find definitions for the fields and controls later on this page.

Field or Control Description

External Subject 1, Field of Study 1, External Subject 2,
and Field of Study 2

When you enter external subject information, field of study
information appears. If a subject area value is not available,
 enter the field of study information.

Transcript

Select the Transcript tab.

This example illustrates the fields and controls on the Courses and Degrees page: Transcript tab. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Data Number If this degree data is related to a specific transcript or source
of information, select the data number of the transcript or
other source. The system populates this field from the External
Education page.

Entering Transfer Credit Detail
Access the Transfer Credit Detail page (Click the Referenced link on the Courses and Degrees page).
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This example illustrates the fields and controls on the Transfer Credit Detail page. You can find
definitions for the fields and controls later on this page.

View transfer credit information about courses. These values default from the Transfer Course Details
page if the course tied to an articulation rule.

Note: Multiple transfer credit statuses may exist for each course because a course can be modeled more
than once.

Field or Control Description

Articulation Term The term for which the transfer credit was processed.

Transfer Status The status of the transfer credit model. The available values
are Submitted, Completed, and Posted.

Entering External Course Comments
Access the External Course Comments page (Click the Course Comment link on the Courses and
Degrees page).
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This example illustrates the fields and controls on the External Course Comments page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

ID, External Org ID (external organization ID), School
Subject, and Course Number

You can enter multiple comments for each of these fields.
 Your user ID, name, and the date that you enter the comment
appears for each row.

Default Comment and Comment If you enter a default comment, the Comment field is
populated with the default text and you can enter more
information. You can also add a comment without entering a
default. Define default comments on the External Education
Comments table.

(CAN) Entering Regional Data
Access the Regional page (Student Admissions >Application/Transcript
Loads >Education >Regional).
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This example illustrates the fields and controls on the Regional page. You can find definitions for the
fields and controls later on this page.

This page is available if the Government Reporting check box for Canada is selected on the SA Features
page.

Field or Control Description

Previous Educational Activity Select the student's most recent educational activity.

Previous PostSecond Credential (previous postsecondary
credential)

Select the type of credential that is associated with successful
completion of the student's most recent postsecondary
education.

Copying Self-Reported Courses
Access the Self Reported Courses page (Student Admissions >Application/Transcript
Loads >Education >Self Reported Courses).
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This example illustrates the fields and controls on the Self Reported Courses page . You can find
definitions for the fields and controls later on this page.

This page is available if a student has modeled transfer credit through self service. Instead of entering
external course information from an official transcript, you can copy some or all courses from self service
to the Courses and Degrees page.

Course Data

Select the Course Data tab.

Field or Control Description

Copy to Education Select the check box for each course that you want to copy.
 Use the Check All link to copy all the courses.
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Copy Selected Courses

Field or Control Description

Copy Selected Courses Click to copy the course data to the Courses and Degrees page.

A row is also added on the External Education page.
 Unofficial appears by default in the Transcript Type field,
 and Incomplete appears by default in the Transcript Status
field. To include copied courses in the automated application
evaluation process, change the type to Official and the status
to Final or Mid Year, or associate the course with an official
transcript row by changing the data number associated with the
course.

Additional Information

Select the Additional Information tab.

This example illustrates the fields and controls on the Self Reported Courses page: Additional
Information tab. You can find definitions for the fields and controls later on this page.

Field or Control Description

Copy to Education If a course is copied, the check box is unavailable and the
course cannot be copied again.

Course Copied If a course is copied, the check box is selected.

Note: After a course has been copied, any changes that a student makes in self service are not reflected
on the Courses and Degrees page. Also, only the student can remove the courses that are displayed on the
Self Reported Courses page through self service.
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Viewing Summary Education Data for Prospects and Applicants

This section lists common elements and discusses how to:

• View external academic summary information.

• View external subject summary information.

• View external degree summary information.

• View external course summary information.

Common Elements Used in This Section

Field or Control Description

Transcript Data Click to access the Transcript Data page and view details about
external transcripts.

Pages Used to View Summary Education Data for Prospects and Applicants

Page Name Definition Name Navigation Usage

External Academic Summary EXT_ACAD_SUMMARY • Student Admissions >
Applicant
Summaries >
Education Summary >
External Academic
Summary

• Student Recruiting >
Prospect Summaries >
Education Summary >
External Academic
Summary

View external academic
summary information.

Transcript Data TRANSCRIPT_SEC1 Click the Transcript Data
link on the External Academic
Summary page.

View information about
external transcripts.

Academic Data Detail EXT_ACAD_SEC Click the Academic Data
Detail link on the External
Academic Summary page.

View external academic data.
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Page Name Definition Name Navigation Usage

External Subject Summary EXT_SUBJ_SUMMARY • Student Admissions >
Applicant
Summaries >
Education Summary >
External Subject
Summary

• Student Recruiting >
Prospect Summaries >
Education Summary >
External Subject
Summary

View summaries of external
subjects.

Transcript Data TRANSCRIPT_SEC2 Click the Transcript Data
link on the External Subject
Summary page.

View information about
external transcripts.

Academic Subject Detail EXT_SUBJ_SUM_SEC Click the Academic Subject
Detaillink on the External
Subject Summary page.

View further details about an
external subject summary.

External Degree Summary EXT_DEGREE_SUMMARY • Student Admissions >
Applicant
Summaries >
Education Summary >
External Degree
Summary

• Student Recruiting >
Prospect Summaries >
Education Summary >
External Degree
Summary

View external degree
summary information.

Transcript Data TRANSCRIPT_SEC3 Click the Transcript Data
link on the External Degree
Summary page.

View information about
external transcripts.

External Course Summary EXT_COURSE_SUMMARY • Student Admissions >
Applicant
Summaries >
Education Summary >
External Course
Summary

• Student Recruiting >
Prospect Summaries >
Education Summary >
External Course
Summary

View external course
summary information.
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Page Name Definition Name Navigation Usage

Transcript Data TRANSCRIPT_SEC4 Click theTranscript Data
link on the External Course
Summary page.

View information about
external transcripts.

External Course Detail EXT_COURSE_DTL Click the Course Detail
link on the External Course
Summary page.

View further details about
external course summary
information.

Viewing External Academic Summary Information
Access the External Academic Summary page (Student Admissions >Applicant
Summaries >Education Summary >External Academic Summary).

This example illustrates the fields and controls on the External Academic Summary page. You can find
definitions for the fields and controls later on this page.

Search for all academic summary information, or search by particular criteria, such as academic level or
summary type. You can also sort the data in a particular order.

Field or Control Description

Academic Data Detail Click to access the Academic Data Detail page and view
information about external academic data.

Viewing External Subject Summary Information
Access the External Subject Summary page (Student Admissions >Applicant Summaries >Education
Summary >External Subject Summary).
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This example illustrates the fields and controls on the External Subject Summary page. You can find
definitions for the fields and controls later on this page.

Search for all subject summary information, or search by particular criteria, such as academic level or
subject. You can also sort the subjects in a particular order

Field or Control Description

Academic Subject Detail Click to access the Academic Subject Detail page and view
further information about external subjects.

Viewing External Degree Summary Information
Access the External Degree Summary page (Student Admissions >Applicant Summaries >Education
Summary >External Degree Summary).

This example illustrates the fields and controls on the External Degree Summary page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Sort Degree By Indicate the order in which you want to view degree
information.
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Viewing External Course Summary Information
Access the External Course Summary page (Student Admissions >Applicant Summaries >Education
Summary >External Course Summary).

This example illustrates the fields and controls on the External Course Summary page. You can find
definitions for the fields and controls later on this page.

Search for all course summary information, or search by particular criteria, such as academic or course
level. You can also sort the courses in a particular order.

Field or Control Description

Course Detail Click to access the External Course Detail page and view
further information about external courses.
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Tracking General and Application Materials
for Prospects and Applicants

Entering General Materials for Prospects and Applicants

This section discusses how to:

• Enter general materials.

• Add details about the recommender.

• View general materials summary information for prospects and applicants.

• Manually associate supporting materials to an application.

• Link general materials to applications.

Pages Used to Enter General Materials for Prospects and Applicants

Page Name Definition Name Navigation Usage

General Materials GENL_MATERIALS • Student Admissions >
Application
Evaluation >
Evaluate Application
Materials > General
Materials

• Student Recruiting >
Evaluate Prospects >
General Materials

Enter supporting information
for prospects and applications.
 The type of information you
record here is the information
that you defined as a general
material type. For example,
 PeopleSoft considers essays,
 portfolios, recommendations
and interviews as general
materials.

General material data is linked
to a person, so anything
that you enter on this page
can be used to evaluate any
applications for this person.
 After you have identified the
general materials, you can
link them to applications and
evaluations.

Recommender Information ORG_DATA_PANEL Click the Recommender
Information link on the
General Materials page.

Add details about the
recommender.
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Page Name Definition Name Navigation Usage

Address Information ADDR_INFO_PANEL Click the Address Information
link on the General Materials
page.

View, add, or edit a
recommender's mailing
or email address. If you
select an address location
on the Recommender
Information page, the system
automatically populates
the address on this page.
Conversely, you can manually
enter the mailing address
information you have for
this recommender. Note that
if this is an address of an
organization, any changes
you enter do not affect the
addresses that are stored
elsewhere in the system for
the school or organization
with which this recommender
is affiliated.

General Materials Summary GENL_MATL_SUMMARY • Student Admissions >
Applicant
Summaries > General
Materials Summary

• Student Recruiting >
Evaluate Prospects >
General Materials
Summary

View any general materials
stored for a person. You can
display the information by
material group or material
type.

Recommender RECOMMENDER_SEC1 Click the Recommender link
on the General Materials
Summary page.

View further details
about general materials
summary information.
 This Recommender Detail
page is available with a
Recommendation material
type entry.

Entering General Materials
Access the General Materials page (Student Admissions >Application Evaluation >Evaluate
Application Materials >General Materials  or Student Recruiting >Evaluate Prospects >General
Materials).
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This example illustrates the fields and controls on the General Materials page. You can find definitions for
the fields and controls later on this page.

Note: The fields on this page vary depending on the material group type you select. The material data that
is attached to this type dictates what fields are available. For example, the Recommender Information
and Address Information links enable you to enter information and addresses about recommenders.
However, these links appear on the page only when the material type is REC (recommendation).

Field or Control Description

Material Group Enter the material group to which you are associating this
applicant. Only material groups that include a material type
that is marked General Material are available to select. Define
material groups on the Material Group Table page.

Material Type Enter a material type. Only general material types from this
material group are available. Material types are associated with
groups on the Material Group Table page.

Material Nbr (material number) This display-only field shows which general material entry
you are viewing for this person. For example, the first general
material entry is number 1, and the second is number 2.

Checklist Item Update When you add a new material group row, the system
automatically selects this check box. The check box indicates
that the checklist related to this row of general material data is
updated when you run the Checklist Item Update Automated
process.
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Field or Control Description

Date Received The system uses the system date as the default date on which
materials were received. You can edit this field.

Date Recorded The system uses the system date as the default date on which
materials were recorded. You can edit this field.

Rcmd Type (recommender type) Which remaining fields are available to you depends on the
variable data that is associated with the material type that
you select. In the example, you enter the recommender type.
Values for this field are delivered with your system as translate
values. You can modify these translate values.

Comments Enter any notes or text for this general materials entry.

Recommender Information This link appears when you select the REC (recommendation)
material type. Click this link to add details about the
recommender. The Recommender Information page appears.

Address Information This link appears when you select the REC (recommendation)
material type. Click this link to view, add, or edit the
mailing or email address for this recommender. The Address
Information page appears.

Attachments

Field or Control Description

Add Attachment Click this button to add a file attachment to the page.

Adding Details About the Recommender
Access the Recommender Information page (Click the Recommender Information link on the General
Materials page).

Field or Control Description

ID If this recommender is in your database, enter the person's ID.

Name If you enter an ID, the recommender's name automatically
appears. If you do not enter an ID because this recommender is
not in your database, type in the recommender's name.

Title Enter the recommender's title.
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Field or Control Description

Org ID  (organization identification) If the recommender is affiliated with a school or organization
in your database, enter the organization ID. The name of
the organization automatically appears. Leave this field
blank if the recommender is not associated with a school or
organization in your database and type in the name of the
organization.

Location If you enter an organization ID, you can choose any defined
address for the organization or school that you want to use as a
mailing address for the recommender.

Org Name  (organization name) The system automatically populates the organization name if
you enter an organization ID. Type in the organization name if
the organization does not already exist in your database.

Viewing General Materials Summary Information for Prospects and
Applicants

Access the General Materials Summary page (Student Admissions >Applicant Summaries >General
Materials Summary or Student Recruiting >Evaluate Prospects >General Materials Summary).

This example illustrates the fields and controls on the General Materials Summary page. You can find
definitions for the fields and controls later on this page.

You must first enter general material information for this person in the General Materials page.

Select Materials By

Field or Control Description

Material Group Enter a material group to search for a summary of general
materials for this person based on material group.

Material Type Enter a material type to search for a summary of general
materials for this person based on material type.
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Sort Materials By

Field or Control Description

Material Group Enter a material group to sort the findings by material group.

Material Type Enter a material type to sort the findings by material type.

Search Click the Search button to locate information that matches
your search criteria.

Other Page Elements

Field or Control Description

Recommender Click to view additional details about general materials
summary information for a particular row.

Manually Associating Supporting Materials to an Application
Access the Application Materials page (Student Admissions >Application Entry >Application
Materials >Application Materials).

This example illustrates the fields and controls on the Application Materials page. You can find
definitions for the fields and controls later on this page.

An application for this person must already exist.
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Field or Control Description

Test Scores To link a test score group to this application, enter a material
group for the test scores material type. Only groups that
include a test scores material type are available. Define
material groups on the Material Group Table page.

After you enter a test score material group, click the Test
Scores link to view a list of test scores that are associated with
this applicant. The Select Test Scores page appears.

Academic Summary To link an academic summary group to this application, enter a
material group for the academic summary material type. Only
those groups that include an academic summary material type
are available.

After you enter an academic summary material group, click
the Academic Summary link to view a list of academic
summaries that are associated with this applicant. The Select
Academic Summary Data page appears.

External Courses To link an external course group to this application, enter a
material group for the external courses material type. Only
those groups that include an external courses material type are
available.

After you enter an external course material group, click the
External Courses link to view a list of external courses that
are associated with this applicant. The Select External Courses
page appears.

External Subjects To link an external subject group to this application, enter a
material group for the external subjects material type. Only
those groups that include an external subjects material type are
available.

After you enter an external subjects material group, click the
External Subjects link to view a list of external courses that
are associated with this applicant. The Select External Subjects
page appears.

Transcripts To link transcripts to this application, enter a material group
for the transcripts material type. Only those groups that
include a transcripts material type are available.

After you enter a transcripts material group, click the
Transcripts link to view a list of transcripts that are associated
with this applicant. The Select Transcripts page appears.

General Materials Click to link general materials to this application. The Select
General Materials page appears, where you can view a list of
general materials that are associated with this applicant.

Go Click this button to go to another component.
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Related Links
Assigning Evaluation Codes to Applications in Batch

Linking General Materials to Applications
Access the Select General Materials page (Click the General Materials link on the Application Materials
page).

Field or Control Description

Recommender Detail If an interviewer or recommended is linked to a general
material entry, click the Recommender Detail link to view
information about that person.

Linking Materials to an Application

This section discusses how to link materials to an application.

Pages Used to Link Materials to an Applications

Page Name Definition Name Navigation Usage

Application Materials ADM_APPL_MATL Student Admissions >
Application Entry >
Application Materials >
Application Materials

Manually associate
application materials to an
application. If the information
for this person is stored
elsewhere in the database, you
can link the relevant data to an
application on this page.

Select Test Scores APPL_SCORES_SP After choosing a test score
material group, click the Test
Scores link on the Application
Materials page.

View test scores that are
associated with this applicant.
 Select the test IDs that
you want to link to this
application. All tests for this
applicant that are not already
linked to this application
are available on this page.
 Select only those tests that
are relevant to this material
group and application. You
can enter tests for a applicant
on the Test Results page.
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Page Name Definition Name Navigation Usage

Select Academic Summary
Data

APPL_ACAD_SUMM_SP After choosing an academic
summary material group, click
the Academic Summary link
on the Application Materials
page.

Link an academic summary
group to this application. the
system stores all academic
summaries for this applicant
that are not already linked to
this application are available
on this page. Select only those
academic summaries that are
relevant to this material group
and application. You can enter
academic summaries for an
applicant on the External
Education page.

Select External Courses APPL_COURSE_SP After you choose an external
course material group, click
the External Courses link on
the Application Materials
page.

Link external courses to
this application. Select the
external courses that you want
to link to this application.
 All external courses for this
applicant that are not already
linked to this application
are available on this page.
 Select only those external
courses that are relevant
to this material group and
application. You can enter
external courses for an
applicant on the Courses and
Degrees page .

Select External Subject APPL_SUBJECTS_SP After you choose an external
subjects material group, click
the External Subjects link
on the Application Materials
page.

Link external subjects to
this application. Select
the external subjects that
you want to link to this
application. All external
subjects for this applicant
that are not already linked to
this application are available
on this page. Select only
those external subjects that
are relevant to this material
group and application. You
can enter external subjects for
an applicant on the External
Education page.

Copyright © 1988, 2021, Oracle and/or its affiliates. 547



Tracking General and Application Materials for Prospects and Applicants Chapter 18

Page Name Definition Name Navigation Usage

Select Transcripts APPL_TRANSCRIPT_SP After you choose a transcripts
material group, click the
Transcripts link on the
Application Materials page.

Link transcripts to this
application. Select the
transcripts that you want to
link to this application. All
transcripts for this applicant
that are not already linked to
this application are available
on this page. Select only those
transcripts that are relevant
to this material group and
application. You can enter
transcript information for
an applicant on the External
Education page.

Select General Materials APPL_MATL_SP Click the General Materials
link on the Application
Materials page.

Link general materials to
this application. Select only
those general materials that
you want to link to this
application. All general
materials for this applicant
that are not already linked to
this application are available
on this page. You can enter
general materials for an
applicant on the General
Materials page.

Recommender Detail INTERVIEWER_SEC2 Click the Recommender
Detail link on the Select
General Materials page.

View information about an
interviewer or a recommender.

Viewing Summary Application Materials Information

This section discusses how to:

• View materials summary information.

• View academic summary information.

• View academic subjects summary information.

• View course summary information.

Related Links
Prerequisites for Tracking Supporting Prospect and Applicant Information
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Pages Used to View Summary Application Materials Information

Page Name Definition Name Navigation Usage

Materials Summary APPL_MATL_SUMMARY Student Admissions >
Applicant Summaries >
Application Materials
Summary > Materials
Summary

View summary information
regarding materials assigned
to a person, and associated
with a particular application
and academic program.

Interviewer Detail INTERVIEWER_SEC Click the Interviewer
Detail link on the Materials
Summary page.

View additional interview
information.

Recommender Detail RECOMMENDER_SEC Click the Recommender
Detail button on the Materials
Summary page.

View additional recommender
information.

Test Score Summary APPL_TEST_SUMMARY Student Admissions >
Applicant Summaries >
Application Materials
Summary > Test Score
Summary

View summary test scores
information that is associated
with a particular application
and academic program.

Transcripts Summary APPL_TRNS_SUMMARY Student Admissions >
Applicant Summaries >
Application Materials
Summary > Transcripts
Summary

View summary transcript
information that is associated
with a particular application
and academic program.

Academic Summary APPL_SUMM_SUMMARY Student Admissions >
Applicant Summaries >
Application Materials
Summary > Academic
Summary

View academic summary
information that is associated
with a particular application
and academic program. You
can view the data in a variety
of formats, depending on your
selection criteria.

Application Summary Detail APPL_SUMM_SEC Click the App Summary
Detail link on the Academic
Summary page to view the
Application Summary Detail
page.

View application detail
information.

Academic Subjects Summary APPL_SUBJ_SUMMARY Student Admissions >
Applicant Summaries >
Application Materials
Summary > Academic
Subjects Summary

View summary information
about academic subjects
that are associated with a
particular application and
academic program.
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Page Name Definition Name Navigation Usage

Academic Subject Detail APPL_SUBJ_SUM_SEC Click the Acad Subject Detail
button on the Academic
Subjects Summary page to
view the Application Subject
Detail page.

View application subject
information.

Course Summary APPL_CRSE_SUMMARY Student Admissions >
Applicant Summaries >
Application Materials
Summary > Course
Summary

View summary course
information that is associated
with a particular application
and academic program.

Transcript Data APPL_CRSE_TRAN_SEC Click the Transcript Data link
to open the Transcript Data
page.

View transcript data.

Application Course Detail APPL_CRSE_SEC Click the App Course Detail
link to open the Application
Course Detail page.

View an applicant's course
detail information.

Viewing Materials Summary Information
Access the Materials Summary page (Student Admissions >Applicant Summaries >Application
Materials Summary >Materials Summary).

This example illustrates the fields and controls on the Materials Summary page. You can find definitions
for the fields and controls later on this page.

You must first attach materials to the application on the Application Materials page.

Field or Control Description

Interviewer Detail Click this link to view about interviewer information about this
material type. The Interviewer Detail page appears.

Recommender Detail Click this link to view recommender information about this
material type. The Recommender Detail page appears.
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Viewing Academic Summary Information
Access the Academic Summary page (Student Admissions >Applicant Summaries >Application
Materials Summary >Academic Summary).

This example illustrates the fields and controls on the Academic Summary page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Acad Level (academic level) Select the academic level for which you want to search for
academic summary information.

Org ID  (organization ID) Enter the organization ID for which you want to search for
academic summary information.

Data Source Select the data source for which you want to search for
academic summary information.

Institution Enter the academic institution for which you want to search for
academic summary information.

Sum Type (summary type) Enter the summary type for which you want to search for
academic summary information.

Term Year Enter the term year for which you want to search for academic
summary information.

Search Click this button to view information matching your search
criteria.

App Summary Detail (application summary detail) Click this link to view application summary details. The
Application Summary Detail page appears.
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Viewing Academic Subjects Summary Information
Access the Academic Subjects Summary page (Student Admissions >Applicant
Summaries >Application Materials Summary >Academic Subjects Summary).

This example illustrates the fields and controls on the Academic Subjects Summary page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Acad Level  (academic level) Select the academic level for which you want to search for
academic subjects summary information.

Org ID (organization ID) Enter the organization ID for which you want to search for
academic summary information.

Data Source Select the data source for which you want to search for
academic subjects summary information.

Course Level Select the course level for which you want to search for
academic subjects summary information.

Subject Enter the subject for which you want to search for academic
subjects summary information.

Term Year Enter the term year for which you want to search for academic
subjects summary information.

Search Click the Search button to view information matching your
search criteria.

Acad Subject Detail (academic subject detail) Click this link to view academic subject details. The
Application Subject Detail page appears.
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Viewing Course Summary Information
Access the Course Summary page (Student Admissions >Applicant Summaries >Application
Materials Summary >Course Summary).

This example illustrates the fields and controls on the Course Summary page. You can find definitions for
the fields and controls later on this page.

You must first attach course summaries to the application on the Application Materials page.

Field or Control Description

Acad Level (academic level) Select the academic level for which you want to search for
course summary information.

Org ID (organization ID) Enter the organization ID for which you want to search for
course summary information.

Data Source Select the data source for which you want to search for course
summary information.

Course Level Select the course level for which you want to search for course
summary information.

Subject Enter the subject for which you want to search for course
summary information.

Search Click the Search button to view information matching your
search criteria.

Transcript Data Click this link to view transcript data. The Transcript Data
page appears.

App Course Detail (application course detail) Click this link to view application course details. The
Application Course Detail page appears.
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Viewing Groups of Prospects or Applicants

Viewing Prospects and Applicants by Organization

This section discusses how to:

• View prospects by organization.

• View contact information.

• View applicants by organization.

Pages Used to View Prospects and Applicants by Organization

Page Name Definition Name Navigation Usage

Prospects by Organization ORG_PRSP_SUMMARY Student Recruiting >
External Org Summaries >
Org Admissions
Summary > Prospects by
Organization

View lists of prospects
that are associated with
a particular external
organization and display
the records in the order you
choose. You can narrow the
scope to view only certain
prospects that are associated
with an external organization.

Prospect Programs ADM_PRSPCT_P_SEC Click the Prospect Programs
link on the Prospects by
Organization page.

View a list of programs for a
prospect.

Organization Primary
Location

EXT_ORG_PRIM_LOC Click the Org Primary
Location link on the Prospects
by Organization page.

View the primary address of
the organization or school.

Organization School
Information

SCHOOL_INFO Click the School Information
link on the Organization
Primary Location page.

View additional information
regarding a school.

Contact Information EXT_ORG_CNTCT_SEC Click the Contact Information
link on the Prospects By
Organization page.

View any contacts that are
associated with this school.

Organization Contact Detail EXT_ORG_CNTCT_PHN Click the Details link on the
Contact Information page.

View a contact's address,
 email address, and phone
numbers.
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Page Name Definition Name Navigation Usage

Applicants by Organization ORG_APPL_SUMMARY Student Recruiting >
External Org Summaries >
Org Admissions
Summary > Applicants by
Organization

View lists of applicants
that are associated with a
particular organization or
school and display the records
in the order you choose. You
can narrow the scope to view
only certain applicants that are
associated with a school.

Applicant Programs ORG_APPL_P_SEC Click the Applicant Programs
link.

View a listing of academic
programs for an applicant.

Viewing Prospects by Organization
Access the Prospects by Organization page (Student Recruiting >External Org Summaries >Org
Admissions Summary >Prospects by Organization).

This example illustrates the fields and controls on the Prospects by Organization page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Institution Enter the academic institution for which you want to search for
prospect information.

Career Enter the academic career for which you want to search for
prospect information.

Acad Prog (academic program) Enter the academic program for which you want to search for
prospect information.
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Field or Control Description

Admit Term Enter the admit term for which you want to search for prospect
information.

Recruiting Status Select the recruiting status for which you want to search for
prospect information.

Applied Select to view records for prospects who applied to your
institution.

Sort Prospects By Select whether you want to view prospects by career, admit
term, or recruiting status.

Search Click this button find the prospects that match your search
criteria. the system displays matches in the bottom portion of
the page.

Carry ID Click this button to carry forward this person's ID to the next
page.

Prospect Programs Click this link to view a listing of the academic programs for a
prospect. The Prospect Programs page appears.

Org Primary Location (organization primary location) Click this link to view the primary address of the organization
or school. The Organization Primary Location page appears.

Contact Information Click this link to view any contacts that are associated with
this school. The Contact Information page appears.

Viewing Applicants by Organization
Access the Applicants by Organization page (Student Recruiting >External Org Summaries >Org
Admissions Summary >Applicants by Organization).
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This example illustrates the fields and controls on the Applicants by Organization page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Career and Institution These values are based on your user defaults. Edit the values if
necessary.

Admit Type Enter an admit type.

Admit Term Enter the admit term of the applicants you want to view.

Acad Program (academic program) Enter an academic program.

Status Select a status to view applicants with a particular program
status. For example, you might want to view only those
applicants with a Cancelled or Waitlisted status.

Acad Career (academic career), Admit Term,  Admit Type,
 and Status

Select an option to view prospects by academic career, admit
term, admit type, or status.

Search Click this button to view the applicants that match your search
criteria. The system displays matches in the bottom portion of
the page.

Carry ID Click this button to carry forward this person's ID to the next
page.

Applicant Programs Click this link to view the applicant program details. The
Applicant Programs page appears.
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Field or Control Description

Org Primary Location (organization primary location) Click this link to view the primary address of the organization
or school. The Organization Primary Location page appears.

Contact Information Click this link to view contacts that are associated with this
school. The Contact Information page appears.

Viewing Prospects and Applicants Assigned to a Specific
Recruiter

This section discusses how to:

• View prospects assigned to a specific recruiter by category.

• View applicants assigned to a specific recruiter by category.

• View prospects assigned to a specific recruiter by region.

• View applicants assigned to a specific recruiter by region.

Pages Used to View Prospects Assigned to a Specific Recruiter by
Category

Page Name Definition Name Navigation Usage

Prospects by Category RCR_PRSP_CAT_SUMM Student Recruiting >
Student Recruiters >
Summaries > Recruiter
Summary > Prospects By
Category

View lists of prospects
that are associated with a
particular recruiter for any
category to which the recruiter
is assigned and determine the
order in which the records
appear.

Prospect Programs ADM_PRSPCT_P_SEC Click the Prospect Program
link on the Prospects by
Category page.

View a listing of programs for
a prospect.

Applicants by Category RCR_APPL_CAT_SUMM Student Recruiting >
Student Recruiters >
Summaries > Recruiter
Summary > Applicants by
Category

View lists of applicants
that are associated with a
particular recruiter for any
category to which the recruiter
is assigned and determine the
order in which the records
appear.
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Page Name Definition Name Navigation Usage

Program Summary ADM_APPL_P_SEC Click the Program Detail link
on the Applicants by Category
page.

View a list of programs for an
applicant.

Prospects by Region RCR_PRSP_REG_SUMM Student Recruiting >
Student Recruiters >
Summaries > Recruiter
Summary > Prospects by
Region

View lists of prospects
that are associated with a
particular region and assigned
to a particular recruiter
and determine the order in
which the records appear. For
example, you can search by
the last school attended or by
region.

Prospect Programs ADM_PRSPCT_R_SEC Click the Prospect Programs
link on the Prospects by
Region page.

View any program
information that exists for a
prospect.

Applicants by Region RCR_APPL_REG_SUMM Student Recruiting >
Student Recruiters >
Summaries > Recruiter
Summary > Applicants By
Region

View lists of applicants
that are associated with a
particular region and assigned
to a particular recruiter
and determine the order in
which the records appear. For
example, you can search by
the last school attended or by
region.

Viewing Prospects Assigned to a Specific Recruiter by Category
Access the Prospects by Category page (Student Recruiting >Student
Recruiters >Summaries >Recruiter Summary >Prospects By Category).
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This example illustrates the fields and controls on the Prospects by Category page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Select Prospects By Enter the appropriate values that designate which prospects
you want to see. You must complete at least one field as search
criteria.

Admit Term Enter an admit term to view prospects for a specific term.

Category Enter a recruiting category to narrow which prospects you
want to see. Leave this field blank to view all prospects that
are assigned to this recruiter, regardless of category.

Note: You cannot search on REGN on this page. To search on
region, access the Prospects by Region page.

Group Select a recruitment group to search for a broader recruiting
group.

Responsible Select a value to view only prospects for whom this recruiter is
the primary recruiter. You can also view only those prospects
for whom this recruiter is not the primary recruiter. Do not
select a value if you want to select all prospects, regardless of
the recruiter's responsibility role.

Admit Term, Category,  and Group Select an option to view prospects by admit term, category or
group.

Search Click this button to view prospects that match your search
criteria.
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Field or Control Description

Carry ID Click this button to carry forward this person's ID to other
pages that you access.

Prospect Program Click this link to access the Prospect Programs page and view
a list of programs for a prospect.

Viewing Applicants Assigned to a Specific Recruiter by Category
Access the Applicants by Category page (Student Recruiting >Student
Recruiters >Summaries >Recruiter Summary >Applicants by Category).

This example illustrates the fields and controls on the Applicants by Category page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Select Applicants By Enter the appropriate values that designate which applicants
you want to see. You must complete at least one field as search
criteria.

Admit Term Enter an admit term to view applicants for a specific term.

Acad Program (academic program) Enter an academic program to specify a particular program.

Category Enter a recruiting category to narrow the list of applicants you
want to see. Leave this field blank if you want all applicants
that are assigned to this recruiter, regardless of category.

Note: You cannot search on REGN on this page. To search on
region, access the Applicants by Region.
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Field or Control Description

Group Select a recruitment group to search for a broader recruiting
group.

Status To view only applicants with a certain program status, select a
value in the status field.

Responsible Select a value to view only those applicants for whom this
recruiter is the primary recruiter. You can also view only those
applicants for whom this recruiter is not the primary recruiter.
 Do not select a value if you want to select all applicants,
 regardless of the recruiter's responsibility role.

Admit Term, Category, Group, and Status Select an option to view applicants by admit term, category,
 group, or status.

Search Click this button to view the applicants that match your search
criteria.

Carry ID Click this button to carry forward this person's ID to other
pages that you access.

Program Detail Click this link to access the Program Summary page and view
a list of programs for an applicant.

Viewing Prospects Assigned to a Specific Recruiter by Region
Access the Prospects by Region page (Student Recruiting >Student
Recruiters >Summaries >Recruiter Summary >Prospects by Region).
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This example illustrates the fields and controls on the Prospects by Region page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Select Prospects By Enter the appropriate values that designate which prospects
you want to see. You must complete at least one field as search
criteria.

Admit Term Enter an admit term to prospects for a specific term.

Region Enter a region to limit the list of prospects. Leave this field
blank to view all prospects that are assigned to this recruiter,
 regardless of region.

Last School Attended Enter a value to search for prospects by the last school that
they attended.

Responsible Select a value to view only those prospects for whom this
recruiter is the primary recruiter. You can also view only those
prospects for whom this recruiter is not the primary recruiter.
 Do not select a value if you want to select all prospects,
 regardless of the recruiter's responsibility role.

Admit Term,  Lst School (last school attended), and Region Select an option to view prospects by admit term, last school
attended, or region.

Search Click this button to view the prospects that match your search
criteria.

Carry ID Click this button to carry forward this person's ID to other
pages that you access.
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Field or Control Description

Prospect Program Click this link to access the Prospect Programs page and view
details about the program or programs that are related to a
prospect's academic career.

Viewing Applicants Assigned to a Specific Recruiter by Region
Access the Applicants by Region page (Student Recruiting >Student
Recruiters >Summaries >Recruiter Summary >Applicants By Region).

This example illustrates the fields and controls on the Applicants by Region page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Select Applicants By Enter the appropriate values that designate which applicants
you want to view. You must complete at least one field as
search criteria.

Admit Term Enter an admit term to view applicants for a specific term.

Region Enter a region to limit the list of applicants. Leave this field
blank to view all applicants that are assigned to this recruiter,
 regardless of region.

Acad Prog (academic program) Enter an academic program to specify a particular academic
program.

Status Status an application status to view applicants with a particular
status.
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Field or Control Description

Responsible Select a value to view only those applicants for whom this
recruiter is the primary recruiter. You can also view only those
applicants for whom this recruiter is not the primary recruiter.
 Do not select a value if you want to select all applicants,
 regardless of the recruiter's responsibility role.

Last School Attended Enter a value to search for applicants by the last school that
they attended.

Admit Term,  Lst School (last school attended), and  Region Select an option to view applicants by admit term, last school
attended, or region.

Search Click this button to view the applicants that match your search
criteria.

Carry ID Click this button to carry forward this person's ID to other
pages that you access.

Program Detail Click this link to access the Program Summary page and view
a list of the programs for an applicant.
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Adding and Updating Applications

Adding New Applications Manually

If the applicants you are adding do not already exist in your database, the system creates them and assigns
them identification numbers.

The Biographic Details, Regional, and Personal pages store information regarding the applicant as a
person. This data is shared between all applications for an applicant as well as with prospect personal
data. When you use this component to update biographical data, the whole database is updated. The
rest of the pages in the Add Application component are application-specific pages, meaning they
store information unique to this application. In other words, applications share biographical data but
application data is unique to each application.

Avoid entering duplicate applications. Use the Installation Defaults - AD page to specify at what level you
want the system to warn you that a potential duplicate application exists. For information, see Setting Up
Admission Installation Defaults.

The Student Admissions–Add Application component is the second of three very similar components:

• Student Recruiting , Create/Update Prospects component.

• Student Admissions, Add an Application component.

• Student Admissions, Maintain Applications component.

Create/Update Prospect and Add an Application have Biographical Data, Regional, and Personal
pages. All three components have other pages with similar names such as Prospect Program Data
and Application Program Data. Use these components to enter or maintain similar information at
different times during your business processes, such as entering prospects, entering application data, and
maintaining application data.

This section lists prerequisites and discusses how to:

• Enter or update applicant biographical data.

• Enter or update applicant regional data.

• Enter or update personal information

• Enter application program data.

• Enter or update additional information.

• Update or add application regional data.

• Use the Calculate Deposit Fees page.

• Enter application data.
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• Use the Application Fees page.

• Use the Application Items page.

• Enter recruiting information for an application.

• Enter or update applicant additional details.

• Add communications, checklists and comments for applicants.

Prerequisites
Before you begin entering application data, determine if the person is already in your Campus Solutions
database. Often an applicant already has a system ID because an administrator already entered the person
as a prospective student. For example, if people sent test scores to your institution, it is likely that they are
already in the system.

To see if the applicant is already in your system, go to Student Admissions > Application Entry >
Search Match.

Related Links
"Using Search/Match" (Campus Community Fundamentals)

Pages Used to Add New Applications Manually

Page Name Definition Name Navigation Usage

Biographical Details SCC_BIO_DEMO_PERS Student Admissions >
Application Entry > Add
Application > Biographical
Details

Enter an applicant's
biographical information.

Addresses SCC_BIO_DEMO_ADDR Student Admissions >
Application Entry > Add
Application > Addresses

Enter an applicant's address.

Regional SCC_BIO_DEMO_REG Student Admissions >
Application Entry > Add
Application > Regional

Enter region specific
information, if applicable,
 based on country code.

Personal SCC_PERSONAL_INFO Student Admissions >
Application Entry > Add
Application > Personal

Enter biographic details
separately from the rest of
the person’s data. This page
appears if you select a field on
the Biographic Fields page.
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Page Name Definition Name Navigation Usage

Application Program Data ADM_APPL_PROG_ENT Student Admissions >
Application Entry > Add
Application > Application
Program Data

Enter program data and
academic plan data pertaining
to this application. You can
also create an enrollment
deposit and matriculate an
applicant from this page. You
must track applications at
least at the plan level, but any
lower level tracking depends
on your office policies.

Additional Information SAD_APPL_CAF_TAB Student Admissions >
Application Entry > Add
Application > Additional
Information

Add or update common
attributes for program, plan
and subplan.

Application Regional SAD_APPL_REG_DATA • Student Admissions >
Application
Maintenance >
Maintain Applications

>Application Regional

• Student Admissions >
Application
Entry > Add
Application >Application
Regional

Add or update country-
specific data regarding the
application.

Evaluation ADM_APPL_EVAL1_SEC Click the Evaluation link on
the Application Program Data
page.

Add an evaluation status for
this program.

Deposit Fees ADM_APPL_DEP_FEE Click the Calculate Deposit
Fees link on the Application
Program Data page.

Calculate a deposit fee when
entering a new application.
 You can calculate the deposit
owed for enrollment and post
that charge to the person's
account directly from the
Application Program Data
page as part of adding a new
application. If the application
has a program status of
admitted, the Calculate
Deposits Fees link becomes
available if a value is defined
on the Application Center
Table.
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Page Name Definition Name Navigation Usage

Deposit Fees (entry) ADM_APPL_ENTRY2_S Click the Calculate Deposit
Fees button or the Deposit
Fees link on the Deposit Fees
page.

Enter deposit fees for the
applicant.

Note: When this deposit
posts in PeopleSoft Student
Financials, the system
updates the program action to
matriculation if you selected
the Create Student check box
on the Status Update page.

Application Data ADM_APPL_DATA Student Admissions >
Application Entry > Add
Application > Application
Data

Enter additional information
regarding the application and
to calculate an application fee.
 The system stores data on
this page at the application 
level, as opposed to storing it
under a person or academic
program. This data is relevant
to all academic programs
being applied to with this
application.

Application Fees APP_FEE_CALC_MSG Click the Calculate
Application Fees link on the
Application Data page.

Calculate the application fee
that the person owes.

If fees were calculated in the
AAWS on line application and
a payment was sent to the GL,
fees are not recalculated when
you click this link.

Tender Details ADM_APPL_TNDRCC_SP Click the Show Tender
Details link on the
Application Fees page.
 The Tender Details page is
accessible when you select the
Credit Card tender category
on the Application Fees page.

Enter credit card information.

See "Accepting Student
Payments" (Student
Financials).

Tender Details ADM_APPL_TENDER_SP Click the Show Tender
Details link on the
Application Fees page. The
Tender Details page displays
when you select the Check or
Cash tender category on the
Application Fees page.

Enter check or cash
information.

See "Accepting Student
Payments" (Student
Financials).

Currency Conversion APPL_FEE_CURR_SP Click the Currency Detail
link on the Application Fees
page.

Obtain details on the currency
conversion.
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Page Name Definition Name Navigation Usage

Application Items ADM_APPL_ENTRY3_S Click the Transaction
Summary link on the
Application Data page to
view information about
the application fee for this
application.

Review information about
the application fee for an
applicant.

Tender Details PAYMENT_TENDER_SP Click the Show Tender
Details link on the
Application Items page.

View tender details.

Application School/Recruiting ADM_APPL_RECRUIT Student Admissions >
Application Entry > Add
Application > Application
School/Recruiting

Enter recruiting information
about an applicant.

Additional Details SAD_PESC_OTHER_SCH Student Admissions >
Application Entry > Add
Application > Additional
Details

Enter and view information
about previous schools the
applicant has attended.

Entering or Updating Applicant Biographical Data
Access the Biographical Details page (Student Admissions > Application Entry > Add Application >
Biographical Details).

Use this page to enter and update the known biographical and demographic data for an applicant.

If, by performing search/match, you find that the person does not yet have an ID in your database, the
key dialog prompt says NEW in the ID field because you are adding a new person as well as a new
application. The application number will be all zeros.

Note: Leave the Application Number field as all zeros in order for the auto-numbering feature to work
properly.

If you find the person in your search/match and used the Carry ID option, your key dialog prompt lists
that person's ID. The application number is still all zeros.

If the person exists in your database, it is a good idea to see if an application has already been entered.
You do not want to enter a duplicate application. Go to the Maintain Applications component to determine
if the person has any current applications.

If you find a matching ID during your search process, the Biographical Data page displays existing data
about this person. If you do not find a matching ID during your search process, then you add a new person
as well as a new application. The page is blank except for those fields populated according to your user
defaults.

After running a search/match, select Student Admissions, Application Entry, Add Application to add a
new application.
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Entering or Updating Applicant Regional Data
Access the Regional page (Student Admissions > Application Entry > Add Application > Regional).

Use this page to enter biographical information specific to your installation country. If this person is
already in your database and has existing information, you can view it on this page.

Entering or Updating Personal Information
Access the Personal page (Student Admissions > Application Entry > Add Application > Personal).

Use the Personal page to enter or update other biographic details such as gender or sexual orientation.
This information is stored separately from the rest of the applicant’s data. This page appears when you
select at least one field from the Biographic Details page.

For more information about:

• Setting up the Personal page, see "Reviewing or Defining Installation Settings For Biographic
Fields" (Campus Community Fundamentals)

• The Personal page, see "Entering Personal Information" (Campus Community Fundamentals)

Entering Application Program Data
Access the Application Program Data page (Student Admissions > Application Entry > Add
Application > Application Program Data).
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This example illustrates the fields and controls on the Application Program Data page. You can find
definitions for the fields and controls later on this page.

Note: The system fills in most of the fields on the Application Program Data page according to your
user defaults. If the applicant had a prospect record and your setup dictates that data from the prospect
record is to be copied to the application, the system populates some fields according to those defaults. For
example, depending on your default setup, the system might populate academic career, institution, admit
term, academic load, and academic program data based on the values in the matching prospect record.

Note: Admissions application records use the Last Admit Term to determine if the program, plan, or
subplan should appear in the prompt. If the Last Admit Term is populated on the Academic Program
Table (ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID, the system does
not display the value in the prompt.
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Field or Control Description

Effective Date Enter an effective date for the application to this academic
program if different than the default date. If you are entering
the application after the start date of the admit term, you need
to back date the effective date to a date prior to the start date of
the admit term in order to term activate the student once they
are matriculated.

Admit Term Enter the admit term in which the applicant is expected to
enroll, if he or she is admitted for this application. Define
admit terms on the Term Table page. This is a user default
field.

Expected Graduation Term Enter the term in which the student expects to graduate.

Academic Program Enter or update the academic program to which the person
is applying. Define academic programs on the Academic
Program page. This is a user default field.

After you matriculate the applicant, the system copies the
application program data to the program/plan tables in
PeopleSoft Student Records.

Academic Load Select the academic load that the applicant will be taking on if
admitted for this application. Values for this field are delivered
with your system as translate values. You can modify these
translate values. Values are Full-Time and Part-Time.

Joint Program Select the Joint Program  check box if the applicant is
applying to a joint program.

Dual Program This field becomes available when you select the Joint
Program check box. Enter the joint academic program. Define
dual programs on the Academic Program page.

Campus Enter or update the campus to which the person is applying
within your academic institution. Define campuses on the
Campus Table page. This is a user default field.
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Field or Control Description

Academic Shift Indicates the attendance pattern under which an applicant
has applied and is being considered for admission. The field
appears if the Use Shift check box is selected on the Academic
Institution 3 page.

If only the Use Shift check box is selected, the Academic Shift
field is optional and the values available here are those defined
on the Academic Shift page.

If the Use Shift by Admit Term check box is also selected on
the Academic Institution 3 page, then the values available here
are those defined on the Academic Shift page and then mapped
to an admit term on the Academic Shift Mapping page. If a
match is found, you must select a value for the Academic Shift
field.

See "Setting Additional Institution Defaults and
Options" (Campus Solutions Application Fundamentals)

See "Defining Academic Shifts" (Campus Solutions
Application Fundamentals)

See Mapping Academic Shifts to Admit Terms

Status Because you are entering a new application, this field
automatically displays Applicant.

Program Action Because you are entering a new application, this field
automatically displays Application. This value can be changed.
 Program actions are predefined on the Admissions Action
Table page and should not be modified.

Action Date The default for the action date is your system date. This is
the date that the action was actually entered into the system 
(contrast this with the effective date).

Action Reason If there are action reasons associated with the program action
that you selected, you can select the appropriate reason value.
 Action reasons enable you to record a brief explanation of
why the program action took place. For example, for the
action WADM (Administrative Withdrawal), you could define
a reason of Incomplete Application.  Define action reasons on
the Program Action Reason Table page.

Last Updated On and By The date on which the page was last updated and the name of
the person who last updated the page.
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Field or Control Description

Career Number Available if the Program Action  field contains the value
Readmit Application. If you want to readmit this applicant
for this application into an existing career, you can select
the proper career number here. You must also have an admit
type where the Readmit Processing Required check box
has been selected on the Admit Type Table page. The system
readmits the person into the career that corresponds to the
career number that you select.

Academic Plan Enter the academic plan within the academic program being
applied to with this application. An academic plan can be
any area of study, such as English, math minor, physics, or
undeclared. Define academic plans on the Academic Plan
Table page. This is a user default field.

Sub-Plan If a subplan exists for the academic plan, enter the subplan
here. Define academic subplans on the Academic Sub-Plan
Table page. This is a user default field.

Calculate Deposit Fees Click this link to calculate an enrollment deposit. The
Calculate Deposit Fees Page appears.

If your application center has designated a deposit fee code
that requires a deposit, and you enter a program status of
Admit, the Calculate Deposit Fees link appears. You can not
exit the component until you calculate the enrollment deposit.
 Application centers are designated on the Application Data
page.

Evaluation Select this link to enter the status of the application. Values for
this field are defined on the Evaluation Status Table.
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Field or Control Description

Create Program To matriculate the applicant at the same time you are entering
the new application, select Matriculation in the Program
Action field. The Create Program button becomes available.

Click the Create Program button to save the component.
 Also, note that if you select  Matriculation in the Program
Action field, you are required  to click the Create Program
button (which, again, saves the component) before exiting the
component.

After you matriculate a person, the system creates a record
in Student Records. All fields on this page are unavailable
because to access the information you need access to pages in
Student Records. Therefore, if you must make a change to this
person's record after matriculation, you must do so through
Student Records.

The Recruiting and Admissions application enables you to
record multiple academic programs for one application under
an academic career. After you have saved the Application
Entry component, however, you must use the Program
Addition page to add an additional program. Note that the
Prog Number field shows the number of the program in
the order it was entered. For example, if you only have one
program, it displays 0. The next program displays 1.

Note: Since each application number tracks to one set of
application data, including an Application Center, Oracle does
not recommend the use of multiple admit terms and multiple
programs for a single application number.

Before matriculating the applicant, you might want to move
to the next page in the Application Entry component first to
record additional information about the applicant before you
perform the matriculation process.

Go Click this button to go to another component.

Program Enrollment

This group box appears only if the Enable Program Enrollment check box is selected on the Academic
Institution 9 page.

See "Enabling Program Enrollment and Activity Management Defaults" (Campus Solutions Application
Fundamentals)

For information about Program Enrollment, refer to the Student Records - Program Enrollment
documentation.

See "Understanding Program Enrollment" (Student Records)
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Entering or Updating Additional Information
Access the Additional Information page (Student Admissions > Application Entry > Add
Application > Additional Information).

This example illustrates the fields and controls on the Additional Information page (1 of 2).

This example illustrates the fields and controls on the Additional Information page (2 of 2).

The Common Attribute Framework allows you to associate attributes with a functional area by a Record
Context (Set UP SACR, Common Definitions, Common Attributes Setup, Record Context).
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Define attributes on the Common Attribute page (Set Up SACR, Common Definitions, Common
Attributes Setup, Common Attribute).

See "Understanding Common Attribute Framework" (Campus Community Fundamentals)

The following Record Contexts are delivered:

• ADM_APPL_PROG (Attribute Record: SAD_PROG_CAF)

• ADM_APPL_PLAN (Attribute Record: SAD_PLAN_CAF)

• ADM_APPL_SUBPLAN (Attribute Record: SAD_SUBPLAN_CAF)

The Additional Information page is available only if you associate at least one attribute with one of the
record contexts.

If no sub-plan data exists, the Sub-Plan Data section of the Additional Information page does not
appear. If the section does appear, an Attributes link opens a subpage where you can enter/view sub-plan
attributes.

Defining Attributes for the Admissions/Student Records Program Stack

The Record Context allows you to set certain properties for a particular attribute in that context, including
whether an attribute is repeatable or required.

Note: When an attribute is set to required, then from that point forward, a value must be entered to save
the component. If a user inserts a new effective dated row (or makes a change in correction mode) to
records which pre-date the implementation of the Common Attribute Framework attribute, the user
must enter a value on the current row as well as any historical or future dated rows in order to save
the component. For this reason, we strongly recommend that careful consideration be given when
determining whether an attribute should be required.

Additionally if the required attribute is to be used in a web service, a value must be present in the request
XML in order for the service to perform without error. For example, if an attribute field is defined
as required on the ADM_APPL_PROG Record Context, then in AAWS that field would need to be
required in the User Interface to collect a value allowing the SAD_SUBMITAPPL operation to complete
successfully.

See Understanding AAWS

For further information about how to set attributes to required or repeatable, refer to the Campus
Community – Common Attribute Framework documentation.

See "Understanding Common Attribute Framework" (Campus Community Fundamentals)

If the attributes set up for Admissions also exist on the Student Program/Plan stack, the values carry over
during the Matriculation process.

See "Maintaining Student Additional Information" (Student Records)

Updating or Adding Application Regional Data
Access the Application Regional page (Student Admissions > Application Entry > Add
Application >Application Regional).
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This example illustrates the fields and controls on the Application Regional page: Australia. You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Application Regional page: New Zealand. You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Application Regional page: Netherlands (1 of 2).
You can find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Application Regional page: Netherlands (2 of 2).
You can find definitions for the fields and controls later on this page.

You can add or update country-specific application data on this page. The page and the appropriate data
appear based on the country options that you select on the following pages:

• (AUS, NLD, NZL) Academic Institution Table, Academic Institution 6 page.

• (NLD) Student Admin Installation, SA Features page.

(AUS) Australia and (NZL) New Zealand Functionality

Field or Control Description

(AUS) Mode of Attendance The Mode of Attendance field is a required field that is
populated on each student's application. This data is required
for reporting admissions data to the TACs via the Enrollment
Feedback process as well as reporting element 329 Mode of
Attendance code in DEEWR Data Collections.

The Mode of Attendance field resides on Application Entry,
 Application Maintenance, and Program Addition pages. It is a
required field when you enter an application. After the student
is matriculated, the mode of attendance is carried forward to
the student program.
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Field or Control Description

(AUS) Cohort (Optional) Select a cohort for the student that the system
will use as the default value when you enroll the student.
 The system populates this value by default on the Australian
regional enrollment data and the field is available to tuition
calculation for HECS or tuition fees if the Australian
Regional Installation Settings are selected. After the student
is matriculated, the cohort is carried forward to the student
program.

(AUS) Funding Source (Optional) Select a funding source for the applicant to
represent the type of place being offered. The funding source
can be mapped to the code reportable as element 724 in the
DEEWR Applications & Offers Collection.

See "Generating the Applications and Offers Files" (Student
Records).

(NZL) Funding Source This field is populated at application data entry time and is
used in the Single Data Return process. The system uses the
funding source that you enter as a default on the enrollment
record for the student.

(NLD) Netherlands Functionality

Field or Control Description

Form of Study Enter the form of study for which the applicant is registering.

Academic Level The academic level can be registered separately from the
academic program record.

Funding Applies Select this option to indicate whether funding applies.

Prior Education Before a student can enroll in a program, the student has to
meet certain requirements concerning his or her curriculum.
 One is these requirements is the fact that the student has
obtained a diploma from their previous school. The diploma
received will reflect a specific level of education. Individual
exam results are relevant. On a student level all prior
education, including information about the school(s), courses
taken and subjects passed, have to be registered.
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For more information about fields in the Admission Verification, Payment Information, and Lot
Drawing group boxes, refer to the “Reviewing Admissions Information, Reviewing Other Application
Information” section in the following topic:

Understanding Studielink

Note: To make changes to this page after it has been saved, you must do so through the Maintain
Applications component. If you are only entering one program for the applicant, enter only one program
action on the Application Program Data page. You must enter additional program actions through the
Maintain Applications component. For example, suppose you enter the application initially with a
program action of APPL in the Add Application component. When you admit the applicant, you would
enter the program action of Admit  in the Maintain Applications component.

Using the Calculate Deposit Fees Page
Access the Calculate Deposit Fees page (Click the Calculate Deposit Fees link on the Application
Program Data page).

Field or Control Description

Calculate Deposit Fees Click this button to access the Deposit Fees page where you
can calculate an enrollment deposit fee.

Deposit Fees Click this link to access the Deposit Fees page where you can
view details about a person's enrollment deposit.

Deposit Calc Messages  (deposit calculation messages) Click this link to view messages that occur while attempting
to calculate deposit fees. This link becomes available when the
system generates a message.

Entering Application Data
Access the Application Data page (Student Admissions > Application Entry > Add Application >
Application Data).
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This example illustrates the fields and controls on the Application Data page. You can find definitions for
the fields and controls later on this page.

Note: The system populates most of the fields on this page according to your user defaults. If the
applicant had a prospect record and your setup dictates that data from the prospect record is to be copied
to the application, the system populates some fields according to those defaults.

Field or Control Description

Application Center Enter the application center that will process this application.
 This information helps you track which office is managing
specific applications. Define application centers on the
Application Center Table page. This is a user default field.

Admit Type Enter the admit type for this application (for example, First-
Year or Transfer,). Define admit types on the Admit Type
Table page. This is a user default field.

Application Date The default for the application date is the system date that the
application was received. You can override this default.
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Field or Control Description

Academic Level Select the academic level to which the applicant is applying
for admission. Values for this field are delivered with your
system as translate values. You can modify these translate
values. Values are Freshman, Graduate, Junior, Not Set, and
Post-Baccalaureate. This is a user default field.

Created On The default for the created date is the system date on which
you create this application record.

Notification Plan Specify whether this person should be on a regular or special
notification track. This field is useful for informational
reporting purposes. Values for this field are delivered with
your system as translate values. You can modify these translate
values. Values are Early Admit, Regular, and Rolling.

Prior Application Select this check box if this applicant previously applied
to this career. This selection is useful for informational and
reporting purposes.

Application Method Select a value to indicate how or in what form this application
was received. Values for this field are delivered with your
system as translate values. You can modify these translate
values. Values are (none), Application Service, Diskette, Hard
Copy, Web Application, EDI, and OUAC. This is a user default
field.

Previous Attendance Select this check box if the applicant previously attended the
institution.

From Date and To Date If the Previous Attendance check box is selected, enter the
dates from which and to which the applicant previously
attended the institution.

Graduated early? Select this check box if the applicant graduated early from the
institution.

Not Currently Attending School Select this check box if the applicant is not currently attending
school.

Electronic Signature Indicates that the applicant has submitted an electronic
signature.

Criminal Conviction Select this check box if the applicant has a criminal conviction.
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Field or Control Description

Additional Fields This link is available only if at least one attribute is associated
with the delivered record context ADM_APPL_DATA 
(Attribute Record: SAD_APPL_CAF).

Refer to the documentation about the Additional Information
page.

Housing Interest Enter any housing interest indicated by the applicant. Values
for this field are delivered with your system as translate values.
 You can modify these translate values. Values are (none),
Commuter, Off Campus, and On Campus. This is a user default
field.

Financial Aid Interest Select this check box if this applicant is interested in financial
aid for the programs to which he or she is applying. This
field is useful for informational and reporting purposes. For
example, the financial aid office can run reports listing those
applicants interested in financial aid. This is a user default
field.

Complete Select this check box if this application is not missing any
information and is considered complete by your office.

Date Enter the date that you marked this application as complete.

External Application Nbr (external application number) Enter the external application number if you received this
application from a service with its own application-numbering
scheme.

Fee Type Select the type of fee assigned to this application. Values for
this field are delivered with your system as translate values.
 You can modify these translate values. Values are (none),
 International, and Standard. These fee types enable you to
charge varying user-defined application fees.
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Field or Control Description

Calculate Application Fees You can use the Application Fees Calculation process to
calculate application fees based on the Application Fee Code
structure which is attached to the Application Center. The
fee is calculated based on core production data—application
program data. Application fees may or may not be posted
to the student account. An administrator can waive the fee.
 The waiver is associated with an item type defined on the
Application Fee Code setup. Both the application fee and
waiver are posted to the student account.

If you calculate application fees based on core production
data, then after selecting the fee type, click the Calculate
Application Fees link to calculate the application fee owed.
 The Application Fees Calculation process runs and the
Application Fees page appears. The system displays the
calculated fee amount.

When you return to the Application Data page, the Status
field in the Application Fee Information group box displays
Calculated.

If your application fee is set up to post to PeopleSoft Student
Financials, the Application Fees calculation process runs when
you click the Run button on the Application Fees page. A
COBOL posting program runs which creates an account for
this person in PeopleSoft Student Financials.

If you use the Admission Applications Web Services (AAWS),
fee calculation does not rely on Admissions production data. If
a fee is required, fee calculation occurs during the application
submit process via the web service, using the data stored in
the AAWS staging table. With the exception of the maximum
amounts on the Minimum/Maximum Fee Code (which rely
on the charges posted to the student account), the AAWS
fee calculation process produces the same amounts as the
production data Application Fee Calculation process.

Note: Application fees and payments are not posted to the
student account for AAWS. Regardless of any setup in the
Application Fees component, all AAWS transactions are
posted to the general ledger using the Direct to GL process.

For AAWS application fee processing, if Yes is selected for
the Application Fee Required field on the Application Center
Table page and the Amount Sent to GL  value is greater
than zero, then when you click the Calculate Application
Fees  link, the fee is not recalculated. The link takes you to
the Application Fees page where you can view the results of
AAWS application fee and waiver processing.

See Setting Up Application Processing Centers.

See Reviewing and Editing Staged Admission Application
Transactions

See Payment Integration Web Service Operations

See "Setting Up Application Fees" (Student Financials).
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Field or Control Description

See "Generating Direct to GL Entries" (Student Financials).

Status For AAWS fee and waiver processing, the value in this field
is updated based on staging table data for SAD_APL_DAT_
STG.APP_FEE_STATUS.

Transaction Summary Click this link to view information about the application fee
for this application. The Application Items Page appears.

Display Errors/Warnings If any errors occurred during the calculation, click this link to
view error details.

Go Click this button to go to another component.

Note: After this page has been saved, you make changes to this application in the Application
Maintenance component.

File Attachments

Use this group box to add, delete and view attachments for an admissions application.

Field or Control Description

Add Click to access standard PeopleTools functionality to browse
to a file and upload it

View Click the link to open the attachment in a new window.

The Audit tab displays all updates to attachments, including user name and date/time.

Using the Application Fees Page
Access the Application Fees page (Click the Calculate Application Fees link on the Application Data
page).
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This example illustrates the fields and controls on the Application Fees page. You can find definitions for
the fields and controls later on this page.

Note: You cannot authorize/capture credit card or electronic check payments through Admissions
Application Fee Payment.
To adhere to PCI compliance regulations, you should not store credit card numbers in your database.

Field or Control Description

Date The default for this date is your system date. Edit this field to
reflect the date the application fee was entered or waived.

Fee Status Values for this field are delivered with your system as translate
values. You can modify these translate values. Values are
Deferred, Pending, Received, Waived, and Waiver.

If you calculate fees from production data, using the
Application Fee Calculation process, select a status for this
application fee. If you are receiving the application fee, change
the status of the fee to Received. After you change the status
to Received, the fields in the lower section of the page become
available.

For information about how to use this page for AAWS
application fee and waiver processing:

See Reviewing and Editing Staged Admission Application
Transactions

Waive Amount Enter the amount of the application fee that will be waived, if
appropriate.

For AAWS, if manual reconciliation is required, you enter
the waive amount in the Application Data staging page and it
appears here after the data is posted.
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Field or Control Description

Waiver Basis Code The field is available for edit only if the value in the Fee
Status field is Waived or Waiver.

For information about how this field is populated by AAWS
fee processing:

See Reviewing and Editing Staged Admission Application
Transactions

Tender Category Use this field to designate how the fee payment was received.
Values for this field are delivered with your system as translate
values. You can modify these translate values. Values are
Credit Card, Electronic Check, Check, or Cash.

You have the flexibility to receive payments in multiple
tenders. For example, you can waive a portion of a fee and the
student's remaining payment can be split between a credit card
and a check.

If you enter Credit Card, Electronic Check, or Check,
 the Tender Details page appears so you can enter further
information.

If you do not use AAWS fee processing, you can enter
information about the echeck or credit card, although the
authorize/settle must be completed outside of Campus
Solutions.

Hosted payment authorize/settle functionality is available only
through AAWS fee processing.

For AAWS fee processing, if payment is required at the
time of the application, the value that appears here is carried
through on posting from the Application Transactions staging
component. You enter a value here only if the applicant is
allowed to pay later or if the waiver request was denied in
the Application Maintenance component and payment was
received later.

Note: For AAWS, partial payment is not allowed and
applicants cannot split payments between credit card and
check.

Tender Amount After entering a form of payment, enter the amount tendered.

For information about AAWS fee processing, refer to the
previous documentation about the Tender Category field.

Currency Enter the type of currency, such as USD (US Dollars).

For information about AAWS fee processing, refer to the
previous documentation about the Tender Category field.

Currency Conversion Details Click this link to obtain details on the currency conversion.
 The Currency Conversion Page appears.
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Field or Control Description

Show Tender Details Click this link to view details about the application fee. The
Tender Details page appears.

Using the Application Items Page
Access the Application Items page (Click the Transaction Summary link on the Application Data page).

This example illustrates the fields and controls on the Application Items page. You can find definitions for
the fields and controls later on this page.

Use the Application Items page to view the results of application fee processing. Application fees are
processed using production data or, for AAWS, via the web service, using staging data.

The Amount Sent to GL field applies to AAWS fee processing and is populated based on the value in the
related field in the Application Transactions staging component.

Set up waiver basis codes on the Application Fee Waiver Basis page (Set Up SACR, Product Related,
Recruiting and Admissions, Applicants, Application Fee Waiver Basis).

Note: To view a summary of a person's financial account, access the Customer Accounts page in
PeopleSoft Student Financial.

See Reviewing and Editing Staged Admission Application Transactions

See Setting Up Application Processing Centers.

See "Generating Direct to GL Entries" (Student Financials).

Entering Recruiting Information for an Application
Access the Application School/Recruiting page (Student Admissions > Application Entry > Add
Application > Application School/Recruiting).
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This example illustrates the fields and controls on the Application School/Recruiting page. You can find
definitions for the fields and controls later on this page.

Note: If the applicant had a prospect record, and you selected the Move to Application option on the
Prospect Recruiters page, and your setup dictates that data from the prospect record be copied to the
application, the system automatically populates some of the fields on this page. For example, the Last
School Attended and Graduation Date fields could be populated by the values in the matching prospect
record.
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School Information

Field or Control Description

Last School Attended Enter the last school attended for this applicant. Because
a person might have attended several schools in his or her
external academic career, it is helpful to know which school
was attended most recently. This is a user default field.

Upon the first save of the application, the value entered in this
field is added to the Education component automatically. After
you enter a school, you might receive a message informing
you that this school will not be added to the Academic
History record, depending on how your institution has set this
parameter on the Installation - AD page. Schools are stored for
academic history in the Education component. The school you
store here is for recruiting and informational purposes.

Graduation Date Enter the graduation date. A graduation date can be in the
future if the person is still attending this school.

Recruiting Information

Field or Control Description

Region Enter a region if you want to choose a region from the region
tree manually. Only regions from your region tree are available
for selection. Define regions on the Region Table page.

Home Postal Code Click this button if you want the system to assign a region
based on the postal code in the applicant's home address. The
system uses the tree manager to assign a region based on the
postal code.

School Postal Code Click this button if you want the system to assign a region
based on the applicant's last school attended postal code. The
system uses the tree manager to assign a region based on the
postal code.

From This display-only field shows you how this region was
defined:

Region Tree: If you manually assigned a region.

Address: Assigned if you click the Home Postal Code button.

School: Assigned if you click the School Postal Code button.
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Recruiting Categories

Use the fields in this group box to target the applicant for special recruiting efforts during the admissions
process regarding this application.

Field or Control Description

Category Enter a recruiting category for the applicant under this career
and application. For example, in the previous screen example,
 this applicant is being recruited according to the geographic
region of her school. Define recruiting categories on the
Recruiting Category Table page. These same categories are
used in both the recruiting and application processes to target
and report on students.

If you plan to assign a recruiter to this applicant based on your
region tree, you must enter a category of REGN (region). Only
the recruiters assigned to the region appearing in the Region
field will be available.

Group The group under which this category falls automatically
displays when you move out of the Category field.

Sub-Category Select a recruiting subcategory. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are (none), High, Low, and
Medium. A subcategory can be used to indicate the priority of
this recruiting category.

Description Enter any descriptive information regarding the recruiting
category.

Note: You can enter multiple recruiting categories and supporting information for an application.

Recruiters

This group box becomes available if you have entered a recruiting category. The recruiter assignment is
tied to the recruiting categories. Use this section of the page to assign one or more recruiters, relevant to
this category, for the applicant.
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Field or Control Description

Recruiters Prompt Select this check box if you want all recruiters in your
database to be available when you prompt on the Recruiter ID
field, regardless of the recruiting category to which recruiters
are assigned.

Clear this check box if you want only the recruiters assigned
to the current recruiting category to be available when you
prompt on the Recruiter ID field. (Note that the REGN
category works differently).

If you are adding recruiters for the recruiting category REGN,
 you select only from recruiters who were assigned the region
that appears in the Region field.

If you entered the region according to the last school attended
using the School Postal Code button; the Prompt Table  field
displays Recruiters for School's Region. Select the prompt to
bring up any recruiters assigned to that school. If no recruiters
are assigned to that school, then your choices are any recruiters
assigned to the region.

If you entered the region according to the applicant's home
address using the Home Postal Code button, the Prompt
Table  field displays Recruiters from Address Region.  Click
the prompt to bring up all recruiters assigned to the region.

If you manually chose the region from the region tree, all
recruiters assigned a recruiting category of REGN - Region are
available when you prompt for values on the Recruiter ID 
field. The Prompt Table  display field in this case displays
Recruitment Category.

Recruiter ID Enter the ID number of the recruiter that you want to assign
to this applicant. The region tree determines which recruiters
to make available for selection, based on the region that you
assigned to the applicant.

You can override the region tree selection by selecting the
Recruiters Prompt  check box. If selected, all recruiters for
the academic career are available.

You can assign an applicant multiple recruiters for any
recruiting category.
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Field or Control Description

Primary Select this check box if this is the primary recruiter for this
category.

The ID of the person who has been marked primary displays
in the Prmy Recruiter ID (primary recruiter ID) field. You
can use this field to report on primary versus non-primary
recruiters.

Events Click this link to sign an applicant up for attendee events. The
Attendee Events page appears.

Go Click this button to go to another component.

Note: After you save the information on these pages, all modifications must be made on the Application
Recruiters page in the Application Maintenance component.

Entering or Updating Applicant Additional Details
Access the Additional Details page (Student Admissions > Application Entry > Add Application >
Additional Details).

This example illustrates the fields and controls on the Additional Details page. You can find definitions
for the fields and controls later on this page.

Use this page to enter additional details about the applicant, including information about other schools to
which the applicant has applied for admission, and the applicant's referral source.
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Other Institutions

You can either select a school using the School lookup field, or you can manually enter the Description,
State, and Country fields.

Field or Control Description

School Select from the external organizations defined by the
institution.

Adding Communications, Checklists and Comments for Applicants
The Communication, Checklist and Comment buttons appear next to the Application Number field on
the Application Data, Application School/Recruiting, and Application Recruiters pages, and next to the
Expected Graduation Term field on the Application Program Data page.

Use the Communication, Checklist and Comment buttons from this component to open a new window for
the entry pages for communication, checklist, and comments and initiate recruiting and admissions related
items.

If the Communication, Checklist
or Comments Pages are Accessed
From the:

The Variable Data for the
Following Administrative Function
is Supplied:

Data that is Transferred

Application Program Data page ADMP

Admissions Program

ID, academic career. student career
number, application number, application
program number.

Application Data page ADMA

Admissions Application

ID, academic career, student career
number, application center.

Application School/Recruiting page EVNT

Event

ID

Related Links
"Understanding the 3C Engine" (Campus Community Fundamentals)

Adding New Prospects and Applications with Quick Admit

Recruiting and Admissions can take information concerning people enrolled from the Student Records
Quick Admit process and at your discretion, create a prospect record and an application, or an application
only for those people.

This section provides an overview of quick enroll and quick admit and discusses how to:
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• Enter biographical details.

• Enter regional data.

• Enter or view academic program data.

• Select your criteria for quick admit batch apps.

• Assign criteria for quick admit.

Understanding Quick Enroll and Quick Admit
The Quick Admit a Student component, Quick Enroll and Student component, and Quick Admit Batch
Apps component are a variation on the fuller processes of admitting students and enrolling them into
classes. Typically, you will use these components in conjunction with each other to accelerate admissions
and enrollment procedures where immediate formal processing is not required or is unavailable for
students. In addition, collecting admissions information on students who have been quick admitted might
be useful for various funnel reports.

The Quick Admit a Student component and Quick Enroll a Student component, when used together,
enable you to rapidly add or update a student's personal data in your system; activate the student in an
academic career, academic program, or term; and enroll the student in classes.

The Quick Admit a Student component works concurrently with the Quick Admit Batch Apps
component. Whenever you admit a student through the Quick Admit a Student component, the system
flags the student's record to indicate that the student has been admitted by this method. The system then
places these records into a temporary table awaiting your action. Using the Quick Admit Batch Apps
component, you can then run the Quick Admit Process (ADQCKADM) to create prospect records and
applications for these flagged records in the temporary table. The Quick Admit Batch Apps component
and Quick Admit a Student component are not a replacement for the regular Recruiting and Admissions
functionality. You must use the Application Data pages for regular admissions.

You can use the Quick Admit a Student component to add a new student's personal data record to your
system, to activate a student into an academic career and an academic program within that academic
career, and to activate a student into a specific term. By completing and saving the Quick Admit a Student
component, a student quickly becomes eligible for class enrollment. You can also use the Quick Admit a
Student component to update a new or continuing student's personal data record after the student already
has an existing personal data record stored in the system. If you are entering new students into the system
through the Quick Admit a Student component and you click the Save button after entering the student's
biographical data and program data, the system assigns the student a unique ID that remains associated
with the individual in your database until you change or delete it. Remember that each user has access to
specific edit modes based on her or his security profile.

Important! To avoid creating duplicate IDs in your system, you should use the search/match function
to determine if an individual with the same data already exists in your database before adding the new
individual.

For new students, you can use the Quick Admit a Student component to enter the biographic,
demographic, address, and program data about the student. When you save the component, the system:

• Assigns the new student an ID and creates a row for the student in the person tables.
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• Activates the new student in the academic program that you select within the specific academic
institution and academic career that you specify.

• Activates the new student in the term that you select, creating a row in the student term table
(STDNT_CAR_TERM) for the student.

For continuing students, you can use the Quick Admit a Student component to activate the student into a
subsequent term; or to activate the student into a new academic career. When you save the component, the
system:

• Updates the data for the student in the person tables.

• Verifies whether the student has already been activated for the term, and if not, activates the student in
the term, creating a new row in the student term table (STDNT_CAR_TERM) for the student.

• Activates the continuing student in the new academic program that you select within the specific
academic institution and career that you specify when you are adding the student to a new academic
career.

After you have saved the student's biographical data and activated the student into the term, the student
is eligible for class enrollment. You can then use the Quick Enroll a Student component to rapidly
enroll students into the term. The system carries forward the key information (ID, academic institution,
academic career, and term) and automatically opens the Quick Enroll a Student component for the given
student.

When you access the Quick Admit a Student component, a dialog box prompts you to enter the key values
of the admissions transaction. The key values are:

Term Definition

ID In add mode, the system defaults the student's ID to New. For
a student new to your system, you can use the default value
to have the system assign the ID, or you can enter a new ID
of your choice provided that it does not belong to another
individual already in the system , or you can enter a student's
existing ID.

In other modes, the system prompts you to search for an
existing ID.

If you enter a new ID of your choice, you run the risk of
disrupting the auto-numbering sequence that is included with
the system. If you disrupt the auto-numbering sequence, a
system administrator must correct the situation.

Academic Institution Enter the academic institution to which you want to quickly
admit the student.

Academic Career Enter the academic career to which you want to quickly admit
the student. Remember that academic careers are parents of
academic programs. Therefore, when you enter an academic
program on the Program/Plan page within this component,
 the system displays academic programs based only on the
academic career you enter here.
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Term Definition

Term Enter the term for which you want to activate the student.
 After you enter the required data for a student into the Quick
Admit a Student component and click the Save button, the
system activates the student into the term that you specify.
This functionality works for both new and continuing students.

To use the Quick Admit feature for a specific term, you must
already have defined your academic term calendar for the
academic programs within that term.

Note: Quick Admit uses the Max Program Effective Date
for Term field from the Term/Session Table when populating
the Effective Date on Student Program/Plan. If the current
date is less than or equal to the Max Program Effective Date
for the activation term, the Effective Date field on Student
Program/Plan will be set to current date. If the current date
is greater than the Max Program Effective Date for the
activation term, the Effective Date field on Student Program/
Plan will be set to the Max Program Effective Date defined
for activation term.

See "Defining Terms, Sessions, and Session Time
Periods" (Campus Solutions Application Fundamentals)

Add Click to open the component with the specified key values.

The Quick Admit Batch Apps process is a two-step, two-page process. Use the first page in the Quick
Admit Batch Apps component, the Selection Criteria page, to select a group of students who have been
admitted through the Quick Admit a Student component. Use the second page in the Quick Admit Batch
Apps component, the Assignment Criteria page, to specify whether to create historical prospect and
application records or new prospect and application records, or both.

Related Links
"Understanding Class Enrollment Processing" (Student Records)

Pages Used to Add New Prospects/Applications with Quick Admit

Page Name Definition Name Navigation Usage

Quick Admit - Biographical
Details

SCC_BIO_DEMO_PERS Records and Enrollment >
Enroll Students >
Quick Admit a
Student >Biographical
Details

Enter or update a student's
biographic and demographic
information.

Quick Admit - Regional SCC_BIO_DEMO_REG Records and Enrollment >
Enroll Students > Quick
Admit a Student > Regional

Enter or update a student's
information according to
regional data requirements.
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Page Name Definition Name Navigation Usage

Quick Admit - Program/Plan PROGRAM_PLAN Records and Enrollment >
Enroll Students > Quick
Admit a Student >
Program/Plan

For new students, select the
primary academic program
for which you want to activate
the student in a term and
enter other program stack
information. For continuing
students, view the student's
career number and primary
academic program or add the
student to a new academic
career. If you want make
any changes to a new or
continuing student's program
stack information after
you save the student to
your system, you must use
the Student Program/Plan
component.

Quick Admit - Selection
Criteria

QUICK_ADMIT_SELECT Records and Enrollment >
Enroll Students >
Quick Admit Batch
Apps >Selection Criteria

Enroll students into classes
without going through a
formal admissions process.

Quick Admit - Assignment
Criteria

QUICK_ADMIT_CREATE Records and Enrollment >
Enroll Students > Quick
Admit Batch Apps >
Assignment Criteria

Create applications for the
group of quick-admitted
students that you selected
in the first page of this
component.

Entering Biographical Details
Access the Quick Admit - Biographical Details page (Records and Enrollment > Enroll Students >
Quick Admit a Student >Biographical Details).

This page is part of the Quick Admit a Person feature, which enables you to rapidly admit students into
your institution. The system saves any biographic and demographic data that you add or change to the
person tables. You can maintain a student's biographical data through either the Quick Admit component
or the Add/Update a Person component found in PeopleSoft Campus Community.

See Entering or Updating Applicant Biographical Data.

Entering Regional Data
Access the Quick Admit - Regional page (Records and Enrollment > Enroll Students > Quick Admit
a Student > Regional).

This page is part of the Quick Admit a Student feature, which enables you to rapidly admit students into
your institution. The system saves the regional data that you add or change to the person tables. You can
maintain a student's biographical data through either the Quick Admit component or the Add/Update a
Person component found in PeopleSoft Campus Community.
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Related Links
"Understanding Biographical Information" (Campus Community Fundamentals)

Entering or Viewing Academic Program Data
Access the Quick Admit - Program/Plan page (Records and Enrollment > Enroll Students > Quick
Admit a Student > Program/Plan).

This example illustrates the fields and controls on the Quick Admit - Program/Plan page. You can find
definitions for the fields and controls later on this page.

Note: Admissions application records use the Last Admit Term to determine if the program, plan, or
subplan should appear in the prompt. If the Last Admit Term is populated on the Academic Program
Table (ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID, the system does
not display the value in the prompt.

Entering Program Stack Data for New Students

When you add a new student to your system, the following fields appear:

Field or Control Description

Academic Program Primary Enter the primary academic program into which you want to
matriculate and activate the student. The system prompts you
with academic career values specific to the academic career
that you selected as a key upon entering the component.
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Field or Control Description

Campus Enter the campus where the student is going to take the
primary academic program.

Academic Plan Enter the student's primary academic plan within the primary
academic program. If a student requests multiple academic
plans within the academic program, you must enter the
additional academic plans through the Student Program/Plan
component.

Admit Term The term in which you are matriculating the student into the
academic program. The admit term usually defaults from the
Recruiting and Admissions matriculation process. However,
 because you are performing a quick activation and are going
to matriculate the student through this Quick Admit a Student
component, you must enter the admit term for the primary
academic program that you have specified.

Requirement Term The requirement term indicates to the system which term's
degree progress requirements apply to the student for the
primary academic program that you have specified. The
system, by default, sets this value to the Admit Term value.

Expected Graduation Term Enter the term in which you expect the student to graduate.
 Define term values on the Term Table page.

(NZL) Funding Source This field is used by New Zealand institutions.

(AUS) Mode of Attendance The Mode of Attendance field is a required field that is
populated on each student's application. This data is required
for reporting admissions data to the TACs via the Enrollment
Feedback process as well as reporting element 329 Mode of
Attendance code in DEEWR Data Collections.

The Mode of Attendance field resides on Application Entry,
 Application Maintenance, and Program Addition pages. It is a
required field when you enter an application. After the student
is matriculated, the mode of attendance is carried forward to
the student program.
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Field or Control Description

(AUS) Cohort (Optional) Select a cohort for the student that the system
will use as the default value when you enroll the student.
 The system populates this value by default on the Australian
regional enrollment data and the field is available to tuition
calculation for HECS or tuition fees if the Australian
Regional Installation Settings are selected. After the student
is matriculated, the cohort is carried forward to the student
program.

(AUS) Funding Source (Optional) Select a funding source for the applicant to
represent the type of place being offered. The funding source
can be mapped to the code reportable as element 724 in the
DEEWR Applications & Offers Collection.

See "Generating the Applications and Offers Files" (Student
Records).

Residency Click to display the Residency Official page and record
residency information that has been verified by your
institution.

Quick Enrollment Click to access the Quick Enroll component, where you can
process enrollment transactions for the student.

Enrollment Appointments Click to access the Appointments component, where you can
add and update enrollment appointments for the student.

Student Program Plan Click to access the Student Program/Plan component and
make any changes to a new or continuing student's program
stack information after the student data has been saved to your
system.

Viewing Program Stack Data After Saving the Component

When you are updating a new or continuing student's records, only the following fields appear:
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Field or Control Description

Student Career Nbr (student career number) The system uses the student career number to differentiate
between academic programs within the same academic career.
For students with multiple academic programs within the same
academic career, you must enter the student career number for
which you want to activate the student into the term you have
specified. If the student has only one student career number in
a specific academic career, the field is unavailable for edit.

Prim Prog (primary program) The system displays the primary academic program associated
with the student career number. The primary academic
program that appears is the academic program into which
the system activates the student for the term that you have
specified.

Related Links
"Understanding Biographical Information" (Campus Community Fundamentals)
Understanding Quick Enroll and Quick Admit
"Entering Residency Data" (Campus Community Fundamentals)

Selecting Your Criteria for Quick Admit Batch Apps
Access the Quick Admit - Selection Criteria page (Records and Enrollment > Enroll Students >
Quick Admit Batch Apps >Selection Criteria).

Field or Control Description

Academic Institution Enter the academic institution from which you want to select
quick-admitted students. You can enter multiple academic
institutions. You must enter at least one academic institution.

Academic Career Enter the academic career from which you want to select
quick-admitted students. You can enter multiple academic
careers.

Academic Program Enter the academic program from which you want to select
quick-admitted students. You can enter multiple academic
programs.

Academic Plan Enter the academic plan from which you want to select quick-
admitted students. You can enter multiple academic plans.
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Assigning Criteria for Quick Admit
Access the Quick Admit - Assignment Criteria page (Records and Enrollment > Enroll Students >
Quick Admit Batch Apps > Assignment Criteria).

This example illustrates the fields and controls on the Quick Admit - Assignment Criteria page (1 of 2).
You can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Quick Admit - Assignment Criteria page (2 of 2).
You can find definitions for the fields and controls later on this page.
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Field or Control Description

Create Applicant/Prospect Select this option to create prospect and application records for
the selected group of students.

Delete From Holding Table Select this option to take the selected group of students and
delete them from the temporary table. Selecting this option
will disable the remaining fields on the page. If this is the
desired option, click the Run button to initiate this process. If
you use the Quick Admit a Student feature but do not create
applications for quick admitted students, you should run this
process to clean out the temporary table.

Create History Select this check box to create history records for the group of
students you have selected. The system adds the students to
the prospect and applicant tables even though they bypassed
the normal admissions process. The data created is based on
the data entered on the Quick Admit pages. Selecting this
check box ensures that admissions information is available for
these people for your admissions reporting purposes.

Create New Select this check box to create a new set of prospect and
application records for the selected group of students.
 Prospect and application records will be created based on the
parameters in the Assignment Values group box.

Create Application Select this check box to create applications for the selected
group of students. This field is available if you select the
Create New check box.

Create Prospect Select this check box to create prospect records for the
selected group of students specified on the Selection Criteria
page. If the Create Application check box is selected, the
availability of this field is determined by the settings on the
Installation Defaults - AD page.

The following fields appear, regardless of whether you choose Create History or Create New:

Field or Control Description

Acad Level (academic level) Select the academic level that you want to assign to the
selected group.

Admit Type Enter the admit type that you want to assign to selected group.

Appl Ctr (application center) Enter the application center that is populated for each
application. This information helps you track what office is
handling specific applications. Define application centers on
the Application Center Table page.
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Field or Control Description

Acad Load (academic load) Select the academic load that the applicants will carry. Values
for this field are delivered with your system as translate values.
 You can modify these translate values. Values are Full-Time
and Part-Time.

Appl Meth (application method) Select a value to indicate how or in what form the application
was received. Values for this field are delivered with your
system as translate values. You can modify these translate
values. Values are (none), Application Service, Diskette, Hard
Copy, Web Application,  EDI, and OUAC.

Rcrtg Stat (recruiting status) Select the recruiting status that will be populated on the
prospect record of this applicant. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are Applicant, Inactive, Inquiry,
Pre-Appl, Prospect,and Suspect.

This field appears only if the Create Prospects field on the
Installation – AD page is set to Yes.

Recr Ctr (recruiting center) Enter the recruiting center that is responsible for this particular
program on the prospect record. Define recruiting centers on
the Recruiting Center Table page.

This field appears only if the Create Prospects field on the
Installation – AD page is set to Yes.

Refrl Srce (referral source) Enter the appropriate referral source that will be populated
on the prospect record. A referral source indicates how this
person became a prospect. In other words, it is a high-level
indicator of how your institution came into contact with the
person. For example, a referral source could be Drop-In,
 Campus Event, or College Fair. Define referral sources on the
Referral Source Table page.

This field appears only if the Create Prospects field on the
Installation – AD page is set to Yes.

Copy History Values to New Click to transfer values entered for Create History to the
corresponding fields in the Create New section. This
minimizes data entry.

The following fields are associated solely with the Create New option:

Field or Control Description

Institution Enter the academic institution that you want to assign to the
selected group.
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Field or Control Description

Career Enter the academic career that you want to assign to the
selected group.

Academic Plan Enter the academic plan that you want to assign to the selected
group of students.

Acad Prog (academic program) Enter the academic program that you want to assign to the
selected group.

Prog Actn  (program action) Enter the program action that you want to assign to the
selected group.

Action Rsn (action reason) Enter the action reason that you want to assign to the selected
group.

Admit Term Enter the admit term that you want to assign to the selected
group.

Academic Plan Enter the academic plan that you want to assign to the selected
group of students.

Click the Run button to run this request at user-defined intervals.

Student records that were processed are automatically deleted from the temporary record, so it is not
necessary to run the Delete from Holding Table process.

Creating Applications from External Test Score Data

If application data is included in your LAW, AMCAS, or ADA external test score loads, you can load the
data as new applications. The data used to create new applications comes from the Additional Candidate
Information data posted to the following pages:

Test Page Where Data Comes From

LAW Personal Information

AMCAS Application

ADA Application

After the external application data is posted to your database, you are ready to run the Create Applicants
from Tests process.
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Note: Applications are created for all records posted to the Additional Candidate Application Information
pages listed in the previous table if the Post option contains the Select for Application Creation value.
After the Create Applicants from Tests process runs, the process updates the Post option to Created
Application if the process created an application for the person, or Duplicate Application if a potential
duplicate was found and the program did not create an application.

You must set up some initial parameters before activating the process.

To run the Create Applicants from Tests process:

1. Select the test score load data.

2. Set up the application program parameters.

3. Set up the application data parameters.

4. Set up the application recruiting data parameters and run the Create Applicants from Tests process.

Related Links
Understanding External Test Score Data Processing

Pages Used to Create Applications from External Test Score Data

Page Name Definition Name Navigation Usage

Create Applicants From Tests ADM_APPL_PROC_PARM Student Admissions >
External Test Score
Processing > Create
Applicants from Tests

Indicate which type of
application you want to load.

Application Program
Parms (application program
parameters)

ADM_PROG_PARMS Student Admissions >
External Test Score
Processing > Create
Applicants from Tests >
Application Program Parms

Set up default program
parameters for the new
applications. The values
you select for the fields on
this page are inserted on
the Application Program
Data page when the new
applications are loaded.

Application Data Parms 
(application data parameters)

ADM_APPL_PARMS Student Admissions >
External Test Score
Processing > Create
Applicants from Tests >
Application Data Parms

Set up default application
data parameters to be filed
in on new applications. The
values you select for the fields
on this page are inserted on
the Application Data page
when the new applications are
loaded.
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Page Name Definition Name Navigation Usage

Application Recruit
Parms (application recruit
parameters)

ADM_RECRUIT_PARMS Student Admissions >
External Test Score
Processing > Create
Applicants from Tests >
Application Recruit Parms

Set up default application
recruiting parameters to be
filled in on new applications.
 The values you select for the
fields on this page are inserted
on the Application School/
Recruiting page when you
load the new applications.

Selecting the Test Score Data Load
Access the Create Applicants From Tests page (Student Admissions > External Test Score
Processing > Create Applicants from Tests).

Select the type of external test data from which you want to create applications: LAW Test Score Data,
MCAT Test Score Data, or ADA Test Score Data.

Setting Up the Application Program Parameters
Access the Application Program Parms (application program parameters) page (Student Admissions >
External Test Score Processing > Create Applicants from Tests > Application Program Parms).

This example illustrates the fields and controls on the Application Program Parms page. You can find
definitions for the fields and controls later on this page.

Note: Some of the fields on this page might populate automatically according to your user defaults. You
can edit those fields as needed.
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Field or Control Description

Admit Term Enter the admit term for these applicants. Define admit terms
on the Term Values Table page.

Acad Load  (academic load) Select the academic load for these applicants. Values for this
field are delivered with your system as translate values. You
can modify these translate values.

Acad Program (academic program) Enter the academic program for these applicants. Only the
academic programs for the chosen career appear in the prompt
list. Define academic programs on the Academic Program
Table page.

Campus Enter the campus being applied to within your institution.
 Define campuses on the Campus Table page.

Status Select the person's program status. This value is entered on
the application. Values for this field are delivered with your
system as translate values. Field values are delivered with your
system as translate values. Do not modify these values in any
way. Any modifications to these values require a substantial
programming effort.

Prog Actn  (program action) Enter the program action that you want entered regarding
the program on these applications. Because the intent of this
process is to create applications, not all program actions are
available when you prompt on this field. Program actions are
stored on the Program Action Table page.

Action Reason If there are action reasons associated with the program action
that you selected, you can enter the appropriate reason value.
 Define action reasons on the Action Reason Table page.

Acad Plan (academic plan) Enter an academic plan for these applications. Define
academic plans on the Academic Plan Table page.

Sub-Plan Enter a subplan for these applications. Define academic
subplans on the Academic Sub-Plan Table page.

Setting Up the Application Data Parameters
Access the Application Data Parms (application data parameters) page (Student Admissions > External
Test Score Processing > Create Applicants from Tests > Application Data Parms).
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This example illustrates the fields and controls on the Application Data Parms page. You can find
definitions for the fields and controls later on this page.

Note: Some of the fields on this page appear automatically according to your user defaults. Edit these
fields as needed.

Field or Control Description

Application Center Enter the application center for these applications. The only
values available are those that fall under the academic career
entered on the Application Program Parameters page.

Housing Interest Select a housing interest, if applicable. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are Commuter, Off Campus, and
On Campus.

Financial Aid Interest Select this check box if you want the system to select the
corresponding check box on the newly created applications.
 This field is useful for informational and reporting purposes.
 For example, your financial aid office can run reports listing
those applicants interested in financial aid.

Fee Type Select the fee type you want entered for these applications. Fee
types enable you to charge varying user-defined application
fees. Values for this field are delivered with your system as
translate values. You can modify these translate values. Values
are Internatnl (international) and Standard.

Complete Select this check box to mark these applications complete.

Admit Type Enter the admit type that you want entered for these
applications. Define admit types on the Admit Type Table
page.
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Field or Control Description

Academic Level Select the academic level you want entered for these
applications. Values for this field are delivered with your
system as translate values. You can modify these translate
values.

Notification Plan Select the notification plan that you want entered for these
applications. A notification plan specifies whether this person
should be on a regular or special notification track. This field
is useful for informational reporting purposes. Values for this
field are delivered with your system as translate values. You
can modify these translate values. Values are Early Admt 
(early admit), Regular, and Rolling.

Application Method Select the application method that you want entered for these
applications. Application methods indicate how or in what
form you received these applications. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are (none), Application Service,
 Diskette, Hard Copy, Web Application, EDI, and OUAC.

Setting Up the Application Recruiting Parameters
Access the Application Recruit Parms (application recruit parameters) page (Student Admissions >
External Test Score Processing > Create Applicants from Tests > Application Recruit Parms).

This example illustrates the fields and controls on the Application Recruit Parms page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Region from Select how you would like the region to be assigned to these
applications. Values are School, Address, and Region.

School: Not a valid choice. You will get an error message if
you enter this value.

Address: Select this value if you want the system to
automatically assign a region to these applications according
to the applicant's home address.

If you select Address, the Region field is not available because
the system will assign the region based on the person's home
address or the address of the last school attended.

Region: Select this value if you prefer to choose a region here
to be entered on all applications.

Field values are delivered with your system as translate values.
 Do not modify these values in any way. Any modifications to
these values require a substantial programming effort.

Region Enter a region to be entered on these applications. This field
is available only when you enter Region in the Region from
field. It is automatically assigned when Address is entered.
 Define regions on the Region Tree page.

Recruiting Center If you have indicated in your installation setup that you want
prospect records to be created for applications that come in
without existing matching prospect records, you must enter a
recruiting center here to be added to the new prospect record.
 Define recruiting centers on the Recruiting Center Table page.

Category Enter a recruiting category If you want a recruiting category
entered on these applications. The recruiting categories
available are based on the academic career that you selected.

Sub-Category Select a recruiting subcategory for these applications 
(optional). Subcategories indicate your level of interest in the
applicant. Values for this field are delivered with your system
as translate values. You can modify these translate values.
 Values are High,Low, and Medium.

Recruiter ID If you have entered a recruiting category and you want a
recruiter assigned to these applications under the chosen
category, enter the recruiter identification number in this field.
 Only recruiters assigned to this academic career are available.

Primary Recruiter Select this check box if you want the recruiter that you
selected to be the primary recruiter for these applications.

Click the Run button to run the Create Applicants from Tests process at user-defined intervals.
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When this process runs, the system looks to the defaults you have set up on the Installation Defaults - AD
page and creates a prospect record based on the Create Prospect setting.

Note: To view the applications posted for a person, use the Maintain Applications component, or for a
summary of the applications, see the Application Summary page.

Related Links
Setting Up Admission Installation Defaults

Updating Applications

After you have entered and saved an application, you must use the Application Maintenance component
to update the application. Use the Application Maintenance component to program, recruiting data and
more. You can also use this component to calculate an application fee, calculate an enrollment deposit,
and matriculate an applicant.

Data in this component is stored at the application  level, as opposed to the applicant or program level.
This data is relevant to all academic programs being applied to with this application. You can enter and
edit information in this component.

This section lists prerequisites and discusses how to:

• Update or add application program data.

• Capture student response – why the student selected another institution.

• Add a program to an existing application.

Prerequisites
Before you can edit or add any additional information in the Application Maintenance component, an
application must first be entered into the system through the Application Entry component.

The Process Applications, Application Maintenance component is the third of three very similar
components:

• Student Recruiting, Add/Update a Prospect component.

• Student Admissions, Add Application component.

• Student Admissions, Maintain Applications component.

For example, Add/Update a Prospect and Add Application have a Bio/Demo (biographic/demographic),
Regional, and Personal pages. All three components have pages with similar names such as Prospect
Academic Program Data page and Application Program Data page. You use these components to enter
or maintain similar information at different times in your business process for prospects, for entering
application data, and for maintaining application data.

For information on the Biographical Details, Regional, and Personal pages, see any one of the following:

• Adding New Applications Manually
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• Adding Prospects Through the Create/Update Prospects Component

Pages Used to Update Applications

Page Name Definition Name Navigation Usage

Application Program Data ADM_APPL_PROG_MNT Student Admissions >
Application
Maintenance > Maintain
Applications >Application
Program Data

Edit or update program and
plan data for an application.
 You can also create an
enrollment deposit and
matriculate an applicant from
this page. All applications
must be tied to an academic
career and program. Any
lower level tracking depends
on your office's policies.

Application Data ADM_APPL_DATA Student Admissions >
Application Maintenance >
Maintain Applications >
Application Data

Update information for an
application.

Application School/Recruiting ADM_APPL_RECRUIT Student Admissions >
Application Maintenance >
Maintain Applications >
Application School/
Recruiting

Update or add recruiting
information data.

See Entering Recruiting
Information for an
Application.

Application Student Response ADM_APPL_STDNT_RSP Student Admissions >
Application Maintenance >
Maintain Applications >
Application Student
Response

Capture the reason why a
prospect or applicant chose to
attend another institution and
what institution he or she will
be attending.

Program Addition ADM_APPL_ADD_PROG Student Admissions >
Application Maintenance >
Program Addition

Add a program to an existing
application if you have
already created an application
number for that person within
the same career. This page is
only for adding an academic
program and program-related
information. You perform
all modifications to existing
academic programs using
the Application Program
Data page in the Maintain
Applications component.

Updating or Adding Application Program Data
Access the Application Program Data page (Student Admissions > Application Maintenance >
Maintain Applications >Application Program Data).
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Note: Admissions application records use the Last Admit Term to determine if the program, plan, or
subplan should appear in the prompt. If the Last Admit Term is populated on the Academic Program
Table (ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID, the system does
not display the value in the prompt.

Field or Control Description

UCAS Personal ID, UTT Personal ID, or Apply Candidate
ID

Any one of these links appears depending on the type
of application. Click the link to go to the corresponding
application page.

Sequence The default of the sequence is 1. The sequence appears in the
field to the right of the Effective Date field.

When you enter more than one row for the same effective date,
 the system automatically increments the sequence.

Field or Control Description

Program Action If you are adding a new row, the Program Action  field is
blank, because the system is assuming you want to update the
status of this application. Edit or add the appropriate program
action value. Program actions are stored on the Admissions
Action Table page and will display based on your Admissions
Action security.

Note: Since each application number tracks to one set of application data, including an Application
Center, Oracle does not recommend using multiple admit terms and multiple programs for a single
application number.

Related Links
Entering Application Program Data

Capturing Student Response – Why the Student Selected Another
Institution

Access the Application Student Response page (Student Admissions > Application Maintenance >
Maintain Applications > Application Student Response).

Student response information is important information your institution might want to track and report
on. You can choose from a series of adapted reason response codes that your institution can set up to
capture the exact information you want to track. However, you can use this page however you want to.
For example, you can capture why students chose not to attend your school and where they are going.
Alternatively, you can capture the reason why a student did  select your school. If a student has multiple
applications on file, each application can have its own corresponding student response. You can enter
multiple reasons per application.
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Field or Control Description

Reason Enter a Student Response Reason code, for example FAID 
(financial aid). Define reason codes on the Response Reason
Table page.

External Org ID (external organization ID) Enter the external organization ID of the institution that the
student has decided to attend. The system displays the external
organizations for which you selected the Student Response -
School Type check box.

You can enter a free-form institution name by tabbing out
of the External Org ID field without entering a value and
entering an institution in the field to the right. This way,
 the institution does not have to enter in all possible external
institution codes. To enter a free form institution, you must
select the Free Form Institution check box on the Installation
- AD page.

Date The date the response reason was entered. The default date is
your system date.

See Setting Up Student Response.

Adding a Program to an Existing Application
Access the Program Addition page (Student Admissions > Application Maintenance > Program
Addition).
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This example illustrates the fields and controls on the Program Addition page. You can find definitions
for the fields and controls later on this page.

This component allows you to enter another program for an existing application. You may choose this
option instead of creating a whole new application. The Program Number will increment by one based
on the previous Program Number used for the application. For example, the student has one application
on file with Program Number 0 for Liberal Arts and Program Number 1 for Fine Arts. Upon adding
a new program from this component, the Program Number will increment to 2. After you have added
the additional program, you maintain it through the Application Program Data page in the Maintain
Applications component. You are prompted to choose the appropriate program number on the search
page before accessing the Application Program Data page. To edit a different academic program for that
application, you would need to click the Return to the Search button and choose the correct program
number.

Note: Since each application number tracks to one set of application data, including an Application
Center, Oracle does not recommend the use of multiple admit terms and multiple programs for a single
application number.

Note: Admissions application records use the Last Admit Term to determine if the program, plan, or
subplan should appear in the prompt. If the Last Admit Term is populated on the Academic Program
Table (ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID, the system does
not display the value in the prompt.
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For documentation about the fields on the Program Addition page, see Entering Application Program
Data.

For documentation about the Additional Information page, see Entering or Updating Additional
Information.

Viewing Application Summary Information

This section discusses how to view application summary information.

Pages Used to View Application Summary Information

Page Name Definition Name Navigation Usage

Application Summary ADM_APPL_SUMM Student Admissions >
Applicant Summaries >
Application Summary

View summary information
about any application stored
for an applicant.

Application Detail ADM_APPL_SEC Click the Application Detail
link on the Application
Summary page.

View application detail
information.

Calculating Application Fees in Batch

This section discusses how to calculate application fees in batch.

Pages Used to Calculate Application Fees in Batch

Page Name Definition Name Navigation Usage

Batch Application Fees RUNCTL_SFPBAAPP Student Admissions >
Application Fees and
Deposits > Application Fees
Process

Calculate application fees
for a group of applicants.
 The Batch Application
Fees process updates each
applicant's application fee
status on the Application
Data page to Completed.
 The process also updates
each applicant's customer
account in PeopleSoft Student
Financials if appropriate.
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Page Name Definition Name Navigation Usage

Application Fees (Batch) APP_FEE_CALC Student Admissions >
Application Fees and
Deposits > Review Batch
Application Fees

View application fee
information generated by
the Batch Application Fees
process.

You must first run the Batch
Application Fees process via
the Batch Application Fees
page.

Application Fee Calc
Messages

APP_CALC_MESSAGES Student Admissions >
Application Fees and
Deposits > Application Fee
Calc Messages

View messages generated
by the batch application fees
process.

Calculating Application Fees in Batch
Access the Batch Application Fees page (Student Admissions > Application Fees and Deposits >
Application Fees Process).

Field or Control Description

Batch ID The Batch Application Fees process assigns a batch ID after
you initiate the process.

Academic Institution, Application Center, and Admit Term Enter an academic institution, application center, and
admit term. The Batch Application Fees process calculates
application fees for the applicants that the process selects using
this criteria.

Display Application Fees Click this link to view the application fees for each applicant
after you have run the Batch Application Fees process. The
Application Fees (Batch) page appears.

Click the Run button to run the Batch Application Fees process at user-defined intervals.

Note: If you use AAWS and Yes is the option selected for the Application Fee Required field in the
AAWS Application Fee and Waiver Processing group box on the Application Center Table page,
then when you click Run, an error message appears: Application fees for this Application Center can be
calculated through Admissions Web Services only.

See Setting Up Application Processing Centers.

See Reviewing and Editing Staged Admission Application Transactions
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Recording the Basis of Admission

Important! Letter Generation (Letter Gen) is a deprecated product. Support will be maintained for this
product, but no new development will be produced for Letter Gen. It is strongly recommended that you
use Communication Generation (Comm Gen) instead. For more information on Comm Gen, see "Using
the Communication Generation Process" (Campus Community Fundamentals)

To set up a basis of admission, use the Basis of Admission component (BASIS_ADMIT_TABLE).

This section discusses how to:

• Define the basis of admission code.

• Assign the basis of admission codes to applicants.

You can set up basis of admission codes that represent general admission criteria—such as ACT test
score, grade point average, or interview—then link the code or codes to applicants or students. You can
also print the basis of admission on admission offer letters and transcripts.

Available Fields for Letter Generation

The following fields are attached to the ADMA and ADMP administrative functions and are available as
merge fields for all letters. The system extracts and attaches up to three bases of admissions.

Winword Merge Field PeopleSoft RECORD.FIELD

BasisAdmit ADM_BASIS_ADMIT.BASIS_ADMIT_CODE

BasisAdmitDL ADM_BASIS_ADMIT.DESCR254

BasisAdmitDE BASIS_ADMIT_TBL.DESCR

BasisAdmitDS BASIS_ADMIT_TBL.DESCRSHORT

BasisAdmitAcadProg ADM_BASIS_ADMIT.ACAD_PROG

BasisAdmitTerm ADM_BASIS_ADMIT.ADMIT_TERM

BasisAdmitBeginDt ADM_BASIS_ADMIT.BEGIN_DT

BasisAdmitEndDt ADM_BASIS_ADMIT.END_DT

Related Links
"Understanding Communication Management" (Campus Community Fundamentals)
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Pages Used to Record the Basis of Admission

Page Name Definition Name Navigation Usage

Basis of Admission Setup BASIS_ADMIT_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Basis of
Admission Table

Define basis of admission
codes. You link these codes to
applicants and students on the
Basis of Admission page.

Basis of Admission ADM_APPL_BASIS_ADM Records and Enrollment >
Career and Program
Information > Basis of
Admission

Assign the basis of admission
to an applicant or student.

Defining the Basis of Admission Code
Access the Basis of Admission Setup page (Set Up SACR > Product Related > Recruiting and
Admissions > Application Evaluation > Basis of Admission Table).

Field or Control Description

Include In Offer Select this check box to include the code, description, short
description, and long description by default on the admission
offer letter for any applicant to whom you assign this basis of
admission code. When you select this check box, the system
automatically selects the Include in Offer check box on the
Basis of Admission page.

Include In Transcript Select this check box to include the code and long description
by default on the transcript for any student to whom you
assign this basis of admission code. When you select this
check box, the system automatically selects the Include in
Transcript check box on the Basis of Admission page.

Long Description Enter a default long description for this basis of admission
code. The long description appears by default on the Basis of
Admission page after you assign this code to the applicant or
student.

The long description should clearly state the basis for
admission. For example, you could say, "The applicant's
composite SAT score exceeded the minimum score required
for admission to the program." You can have another code that
represents grade point average, and another that represents
letters of referral, for example. Thus, if you admitted a person
based on their SAT score, grade point average, and letters of
referral, you could assign all three bases of admission codes to
the person.
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Assigning a Basis of Admission to Applicants
Access the Basis of Admission page (Records and Enrollment > Career and Program Information >
Basis of Admission).

This example illustrates the fields and controls on the Basis of Admission page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Basis of Admission Enter a basis of admission code from the list of valid values.
 Define basis of admission codes on the Basis of Admission
page.

Application Nbr (application number) Enter an application number to assign the basis of admission to
a specific application. (optional)

Application Program Nbr  (application program number) Enter an application program number to assign the basis of
admission to a specific program. (optional)

Admit Term Enter the individual's admit term. If an individual was
admitted to more than one academic program, he or she could
have multiple admit terms.

Academic Program Enter the individual's academic program to which you want to
apply the basis of admission. Individuals can be admitted to
multiple academic programs. (optional)
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Field or Control Description

Begin Date The default for the begin date is your system date.

End Date Enter the date that you want this basis admission to be no
longer valid. If you run the offer letter or transcript after this
date it will not appear even if you have selected the Include in
Offer check box.

Include in Offer Select this check box to include the code, description, short
description, and long description on the applicant's admission
offer letter. The system automatically selects this check box if
the Include in Offer field on the Basis of Admission setup page
is selected for the given basis of admission. You can change
the setting for this applicant here.

Include In Transcript Select this check box to include the code and long description
on the student's transcript. The system automatically selects
this check box if the Include in Transcript field on the Basis
of Admission setup page is selected for the given basis of
admission. You can change the setting for this person here.

Long Description The long description appears from the Basis of Admission
setup page. You can change the long description for this
person here.

The long description should clearly state the basis for
admission. For example, you could say, "The applicant's
composite SAT score exceeded the minimum required for
admission to the program." You can have another code that
represents grade point average, and another that represents
letters of referral, for example. Thus, if you admitted a person
based on his or her SAT score, grade point average, and letters
of referral, you could assign all three bases of admission codes
to the person.

Go Click this button to go to another component.

Recording Comments and Conditions for Admission

Important! Letter Generation (Letter Gen) is a deprecated product. Support will be maintained for this
product, but no new development will be produced for Letter Gen. It is strongly recommended that you
use Communication Generation (Comm Gen) instead. For more information on Comm Gen, see "Using
the Communication Generation Process" (Campus Community Fundamentals)

To set up admission comment codes, use the Admissions Comments component
(ADMISSION_COMMENTS).

This section discusses how to:
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• Define admissions comment codes.

• Assign admission comment codes to applicants.

Recruiting and Admissions functionality enables you to record generic comments and then link them to
an applicant. You can use this functionality however you like. One particular use is to record conditions of
admission. For example, you can define a comment such as "You must successfully complete all current
coursework." You can set up admission comment codes that represent general admission comments, then
link the code or codes to the applicant. You can print the comments on the admission offer letter, and later,
after the applicant becomes a student, you can print the comment on his or her transcript.

Available Fields for Letter Generation

The following fields are attached to the ADMA and ADMP administrative functions and are available as
merge fields for all letters. The system extracts and attaches up to three bases of admissions.

Winword Merge Field PeopleSoft RECORD.FIELD

AdmCommentCd ADM_COMMENTS.ADM_COMMENT_CD

AdmCommentDL ADM_COMMENTS.DESCRLONG

AdmCommentDE COMMENT_CDE_TBL.DESCR

AdmCommentDS COMMENT_CDE_TBL.DESCRSHORT

AdmCommentTerm ADM_COMMENTS.ADMIT_TERM

AdmCommentProg ADM_COMMENTS.ACAD_PROG

AdmCommentBegin ADM_COMMENTS.BEGIN_DT

AdmCommentEnd ADM_COMMENTS.END_DT

AdmCommentType ADM_COMMENTS.COMMENT_TYPE

Related Links
"Understanding Communication Management" (Campus Community Fundamentals)
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Pages Used to Record Comments and Conditions for Admission

Page Name Definition Name Navigation Usage

Admissions Comments Table ADM_COMMENTS_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Application
Evaluation > Admissions
Comments Table

Define admission comment
codes.

Admissions Comments STDNT_ADM_COMMENTS Student Admissions >
Application Evaluations >
Application Decisions >
Admission Comments

Assign admission comments
to applicants.

Defining Admission Comment Codes
Access the Admissions Comments Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Application Evaluation > Admissions Comments Table).

This example illustrates the fields and controls on the Admissions Comments Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Comment Type Indicates the type of comment that you are entering. Select
Conditional if the comment is a condition for admission,
 and Procedural if the comment is for procedure only. 
(informational only)
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Field or Control Description

Include In Offer Select this check box to include the code, description, short
description, and long description on the applicant's admission
offer letter. When you select this check box, the system
automatically selects the Include in Offer check box on the
Admission Comments page.

Include In Transcript Select this check box to include the code and long description
on the student's transcript. When you select this check box, the
system automatically selects the Include in Transcript check
box on the Admission Comments page.

Long Description Enter the full text of the comment for this admission comment
code. The long description appears by default on the
Admission Comment page after you assign this code to the
applicant.

Assigning Admission Comments to Applicants
Access the Admission Comments page (Student Admissions > Application Evaluations > Application
Decisions > Admission Comments).

This example illustrates the fields and controls on the Admission Comments page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Admission Comment Code Enter a code. Define comment codes on the Admission
Comment Table page.

Admit Term Enter an admit term. If an applicant was admitted to more
than one academic program, he or she can have multiple admit
terms.

Academic Program Enter an academic program. Applicants can be admitted to
multiple academic programs. (optional)

Comment Type Indicates the type of comment that you are entering. Select
Conditional if the comment is a condition for admission,
 and Procedural if the comment is for procedure only. 
(informational only)

Begin Date The default for the begin date is your system date.

End Date Enter the date from which you want this comment to be no
longer valid. If you run the offer letter after this date it will not
appear even if you have selected the Include in Offer check
box.

Include in Offer Select this check box to include the code, description, short
description, and long description on the applicant's admission
offer letter. The system automatically selects this check box if
the Include in Offer field on the Admission Comment Table
page is selected. You can change the setting for this applicant
here.

Include In Transcript Select this check box to include the code and long description
on the student's transcript. The system automatically selects
this check box if the Include in Transcript field on the
Admission Comment Table page is selected. You can change
the setting for this applicant here.

Long Description The long description appears from the Admission Comment
Table page. You can change the long description for this
applicant here.

Go Click this button to go to another component.

Viewing Summary Checklist, Comment, and Communication Data

You can use summary pages for a quick view of checklists, comments and communications stored
for prospects, applicants and recruiters. You can also view Operator 3C Groups pages for checklists,
comments and communications.
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• Use the Checklist Summary page (PERS_CHKLST_SUMM) to access a summary of checklists
associated with a recruiter, a prospect, or an applicant.

The Checklist Summary page enables you to designate which checklist information you want to see
for a person.

• Use the Comment Summary page (CMNT_SUMMARY) to access a summary of comments
associated with a recruiter, a prospect or an applicant.

The Comment Summary page enables you to designate which checklist information you want to see
for a person.

• Use the Communication Summary page (COMM_SUMMARY) to view a summary of
communications associated with a recruiter, a prospect, or an applicant.

This page enables you to designate which communication information you want to see for a person.

• Use the Operator 3C Groups Summary (Checklist) (OPR_GRP_3C_SUM) page to view the user 3C
groups to which you are assigned.

• Use the Operator 3C Groups Summary (Comment) (OPR_GRP_3C_SUM) page to view the user 3C
groups to which you are assigned.

• Use the Operator 3C Groups Summary (Communication) page (OPR_GRP_3C_SUM) to view the
user 3C groups to which you are assigned.

Related Links
"Understanding the 3C Engine" (Campus Community Fundamentals)
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Performing EDI TS130 Transcript
Transactions

Prerequisites for Performing EDI TS130 Transcript Transactions

The EDI Manager provides the tools you need to manage electronic commerce transactions with your
trading partners. To assist you in setting up the EDI Manager for recruiting and admissions application
and transcript transactions, we have created some sample definitions in the EDI Manager. However,
before processing EDI transactions, you might need to modify the setup to fit your particular needs.
Therefore, it is important that you become familiar with PeopleSoft EDI architecture and recruiting
and admissions processes to understand the implications of your EDI implementation decisions. The
following paragraphs explain how this information can be set up.

When a trading partner submits an EDI transaction, it needs to address it to a specific business unit. In
other words, the EDI agent needs to know in some way to which business unit to forward the transaction.
Therefore, you must define entity codes that tell the EDI Manager where to forward the transaction. This
PeopleSoft system includes sample entity codes for admissions transcript and application transactions, as
well as sample internal and external partner definitions.

• The sample entity code provided for the Admissions Transcript Transaction (TS130) is ADTR -
Admission Transcript Process.

• Two sample entity codes are provided for the Application for Admissions Transaction (TS189):
ADAP - Admissions Applicant Processing and ADST - Admissions Applicant Student.

• The sample internal partner definition provided (for both the EDI TS130 and TS189 transactions) is
Admissions - Admissions Office.

• The sample external partner definition provided (for both the EDI TS130 and TS189 transactions)
is ADM_EDI_STX - Admissions EDI Supply Tech. As mentioned earlier, you might use another
external partner as your EDI translator.

When you receive an EDI transaction from a trading partner, the first record of the transaction includes a
Transaction ID that identifies the transaction type. The EDI agent uses the transaction ID, in conjunction
with the trading partner ID, to determine which inbound map to use to process the transaction data.
Similarly, when you initiate an outbound transaction, the EDI agent puts the appropriate transaction ID
in the first transaction record so that the recipient knows what kind of transaction you have sent. The
PeopleSoft system includes sample transaction definitions, partner profile definitions and conversion data
profiles.

• The sample transaction definition provided for your ADM_TRNS_130 Admissions Transcript
Transaction is ADM_TRNS_TS130 Inbound - Admissions Transcript Transaction.

• The sample transaction definition provided for your ADM_TRNS_189 Admissions Applicant
Transaction is ADM_TRNS_TS189 Inbound - Admissions Applicant Transaction.
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• The sample partner profile definition provided (for both the EDI TS130 and TS189 transactions) is
ADM_EDI_P - Admissions EDI Transaction Profile.

• The sample conversion data profile provided is EDI_CONV - EDI TS130/TS189. Conversion Profile
lists the conversion values used in your EDI load processing (for both the EDI TS130 and TS189
transactions).

Electronic commerce maps specify how the EDI Agent transfers data between PeopleSoft business
documents and the staging tables in the PeopleSoft database. The EDI agent uses inbound maps to
transfer data from PeopleSoft business documents to the staging tables, in preparation for processing by
your Recruiting and Admissions application. PeopleSoft has created sample inbound map definitions.

• The sample inbound map definition provided for the Admissions Transcript Transaction
(ADM_TRNS_TS13O) is EC Map ID TS130_MAP.

• The sample inbound map definition provided for the Admissions Applicant Transaction
(ADM_TRNS_TS189) is EC Map ID TS189_MAP.

When you add a trading partner, you assign to it a map profile, which lists the electronic commerce maps
that the EDI agent can use to process transactions from the partner. The PeopleSoft system includes
sample data mapping profile definitions.

The example data mapping profile definition provided is ADM_EDIMP - Admissions EDI Map
Profiles. This definition lists the map assignments for the Admissions Transcript Transaction
(ADM_TRNS_TS13O) and the Admissions Applicant Transaction (ADM_TRANS_TS189).

See Also

The following topics in the product documentation for PeopleTools: Supported Integration Technologies

• “Using PeopleSoft EDI Manager”, "Setting Up Trading Partners"

• “Using PeopleSoft EDI Manager”, “Defining EDI Transactions”

• “Mapping EDI Transactions, "Defining Inbound Maps”

• “Mapping EDI Transactions, “Defining Outbound Maps”

• “Mapping EDI Transactions, “Creating Data Mapping Profiles”

Understanding EDI TS130 Transcript Transactions

Recruiting and Admissions enables you to load external academic transcripts through EDI (Electronic
Data Interchange).

To perform EDI TS130 transcript transactions:

1. Process the inbound EC agent.

Specify the location of the file that you want to load into the suspense file on the Schedule Inbound
EC Agent page.

2. Load the EDI data for transcript transactions.
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Run the TS130 Load process to load the data into staging files.

3. Review and edit the data that you loaded in suspense pages.

Correct all load errors before moving on to the next step. In the search dialog page of the suspense
component, enter Error in the Edit Processing Option field and click the Search button. Access each
suspense record and correct the errors until every suspense record has a value of Complete (rather
than Error) in the Edit field of the Process Options page.

4. After you have corrected all of the load errors in the suspense files, run the organization search
process.

This process looks for a match of the organization based on the ATP, ACT, FICE, or IPEDS code
loaded against the same codes stored on the Organization Table, School Data page. The system
compares the EDI School Subject and EDI Course Number on the EDI TS130 Courses page with the
school subject and school course number on the School Course Classification page.

5. Resolve and edit any course errors resulting from the organization search process.

In the search dialog page of the suspense component, enter Error in the Edit Processing Option field
and click the Search button. Access each suspense record and correct the course or organization errors
until every suspense record has a value of Complete (rather than Error) in the Edit field of the Process
Options page. If more than one match is found for an organization, the EDI Org Process Options
Search field will be set to Error and the Search/Match results will show the number of schools that
matched on the code used as shown. You will need to resolve that error and run the Organization
Search process again for the courses to be populated.

This process looks for data in your database (based on search parameters that you define on the
Search/match Parameters page, to include, for example, name, social security number, and birth date)
that matches the data that you are posting. For a set of parameters that suggest only a possible match
(such as name and gender, for example), the process does not post the record until you can manually
determine which records are actually duplicates.

6. After you have corrected all of the organization and course errors in the suspense files, run the search/
match/post process.

This process looks for data in your database (based on search parameters that you defined on the
Search/match Parameters page, to include, for example, name, social security number, and birth date)
that matches the data that you are posting. For a set of parameters that suggest only a possible match
(such as name and gender, for example), the process does not post the record until you can manually
determine which records are actually duplicates.

7. Check each suspense record that did not get posted to see if it is actually a duplicate.

In the search dialog page of the TS130 Staging component, enter Complete in the Edit Process
Option field and Perform in the Search/Match Process Option field, and then click the Search
button. The search process finds only those suspense records that went through the search/match/
post process but were not posted. The reason the search/match/post process did not post the records
is because it found a possible duplicate record in the database. After you access the component, find
the parameters for which the process identified a match, and then use search/match to look up the bio/
demo information that matches the suspense record and decide whether a person who matches the
incoming data already exists in the system. Then, specify whether you want the search/match/post
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process to add the bio/demo and test record to your database, update an existing record, or ignore the
suspense record.

8. Run the search/match/post process again.

The process posts the suspense records that you manually tagged to post. By this time, all of your
suspense records should be posted to your database. When a record posts to your database, the search/
match/post process assigns an ID to the person. To view a bio/demo record that the search/match/post
process created, select Develop Enrollment, Process External Data, Use, Bio/Demo Data. To view a
test score record that the search/match/post process created or updated, select Develop Enrollment >
Process External Data > Use > Test Scores.

Purge TS130 staging table records on the TS130 Purge Parameters page. You can also purge messages
in this process. If you want to perform an analysis on your TS130 processing, perhaps at the end of a
year, do not purge your messages with this process. Instead, purge them at a later date when you know
you no longer need to view them.

Related Links
Purging All EDI Messages
Tracking Test Results for Prospects and Applicants
Entering or Updating Applicant Biographical Data

Understanding the EDI Applications and Transcripts Business
Process

EDI is a means of transmitting data electronically from one entity to another. Through the EDI Manager
you can receive data files from external sources and load important recruiting and admissions data into
staging tables where you can review and edit the data. Then, you can post the data to tables in your
database.

Recruiting and Admissions supports EDI transactions for transcripts and applications. For example, an
applicant can fill out an application online using a third-party vendor, which then sends the application
electronically to your institution. Additionally, an external institution can electronically send you an
applicant's transcripts. In either case, you can load the data from a file into staging tables, review the data,
and post it to your database.

The EDI transaction supported for the transcript load is the Admissions Transcript Transaction
(ADM_TRNS_TS13O). The data transmitted through the EDI data load includes personal information,
academic status, dates of attendance, session and course information, grades earned, degrees awarded,
testing information, and more.

The inbound transaction supported for the application load is the Admissions Applicant Transaction
(ADM_TRNS_TS189). The data transmitted through the EDI data load includes personal information,
names, addresses, residence data, application entry and questions, session and course information, degrees
awarded, testing information, and more.

If you receive a transcript or application for a person who does not exist in your database, the system can
add the person to your system (depending on the parameters you set up). If the person already exists in
your database, the system can update the person's records (depending on the parameters you set up).
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The file that you load into EDI Manager is a business document that you receive from an EDI translator.
The example setup provided with your system was developed using a Supply Tech business document.
Your institution, however, might receive your business document from another EDI translator.

See Also

PeopleTools: Supported Integration Technologies, “Using PeopleSoft EDI Manager”

Setting Up Ethnicity in the System

You must ensure that your system is set up to correctly populate ethnicity information during the TS130
and TS189 posting processes. To do so:

• Change your internal mapping values for ETHNIC_GRP on the Conversion Data Profile page
(PeopleTools > EDI Manager > Convert EDI/PeopleSoft Code > Conversion Data Profile) for
the EDI Convert Profile ID of EDI_CONV.

• Verify that the new values reflect those you defined for ethnic groups on the Ethnic Groups page (Set
Up Common Objects > Product Related > Workforce Administration > Ethnic Groups).

This is an example of ethnic groups defined on the Conversion Data Profile page:
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This is an example of ethnic groups defined on the Conversion Data Profile page.

Processing the Schedule Inbound EC Agent

Use the Schedule Inbound EC Agent (inbound electronic commerce agent) page to specify the location
of the file that you want to load into the suspense file. The Schedule Inbound EC Agent (ECIN0001.sqr)
process converts the data in the file according to your setup in the EDI Manager. After the process
converts the data, it loads it into temporary files until you run the load process.

To process the inbound EC agent for recruiting and admissions transactions:

1. Select PeopleTools > EDI Manager > Monitor EDI Processing > Schedule Inbound EC Agent.

2. Select the Single File run option.

3. In the Single File Path field, enter the directory path of the file that you want to load.

4. In the Single File Name field, enter the name of the file that you want to load.
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5. Select Do Not Force in the Force Profile group box.

6. Clear the check boxes in the File Options group box.

See Also

PeopleTools: Supported Integration Technologies, “Using PeopleSoft EDI Manager”

Loading EDI Data for Transcript Transactions

This section discusses how to use the EDI TS130 Load Parameters page to load EDI TS130 transcripts
into staging tables. You can also elect to create a TS131 acknowledgement file with this process. You
send acknowledgement files to the institution that sent you the transcript. It acknowledges the receipt of
the transcript and confirms that the institution the transcript was sent to was the institution that received
it, and that the information sent is correct. Since you send the acknowledgement file to the institution
that sent the transcript, it also confirms for you that the transcript came from the proper office at the
institution indicated as the sender and that certain key elements of the transcript were received as they
were sent. Before you can create EDI TS131 acknowledgement files, you must define defaults for the
acknowledgement files on the TS130/TS131 Setup page.

Related Links
"Defining TS130 and TS131 Controls" (Student Records)
"Reviewing TS130 Outbound Transactions" (Student Records)

Page Used to Load EDI Data for Transcript Transactions

Page Name Definition Name Navigation Usage

EDI TS130 Load Parameters ADM_TS130_LOD_PARM Student Admissions >
Application/Transcript
Loads > TS130 > Load
Process

Use the EDI TS130 Load
Parameters page to load EDI
TS130 transcripts into staging
tables.

Loading TS130 Transcripts into Staging Tables
Access the EDI TS130 Load Parameters page (Student Admissions > Application/Transcript Loads >
TS130 > Load Process).
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This example illustrates the fields and controls on the TS130 Load Parameters page. You can find
definitions for the fields and controls later on this page.

Warning! You should complete the full loading, search/match, and posting processes before loading a
new set of data. If you have data waiting to be processed, do not load a new file until you have processed
any data in your staging files.

Field or Control Description

Regulatory Region The system uses the value entered here to populate ethnic
group fields during TS130 staging.

Important! Ensure that the ethnic groups defined on the
Conversion Data Profile page match those defined for the
regulatory region entered here.

Create Acknowledgement (TS131) Select to create a TS131 acknowledgement file. The system
creates the file according to the standards defined on the
TS130/131 Setup page. After the system creates the file, you
can send it to the original sending institution to acknowledge
receipt of the transcripts.

Institution Enter your institution code. The system uses the institution
code to determine which setup values to use from the
TS130/131 Setup page when creating the file.

File Name Enter the path to where you want the system to write the file,
 and enter the name of the created file.
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Field or Control Description

Male, Female, and  Unknown An EDI load does not include a person's prefix. It does,
 however, include gender. In these fields, select the prefix that
you want entered according to the gender provided in the EDI
load. Values for this field are delivered with your system as
translate values. You can modify these translate values.

After you load the data into staging files, you can view the
data in the EDI TS130 Staging pages.

EDI Name Type Select the path to where you want the system to write the file,
 and enter the name of the created file. Since a transaction can
have multiple names for a student, you must indicate which
name type to use for the Primary PeopleSoft name. This is the
name posted to the NAMES table. Indicate, in hierarchical
order, the EDI name types you want to use for this purpose.
 These are delivered translate values, based on the name types
defined in the TS130 Standards documentation. It is important
that you enter all EDI name types that you may receive. If a
name type is not entered and the student only has that name
type, then the student will be loaded with a blank name and the
record will display an error.

Click the Run button to run the EDI TS130 Transcript Load/Edit process at user-defined intervals.

Reviewing and Editing the EDI TS130 Staging Pages

You can use the EDI TS130 Staging component to review or edit the transcript data that you loaded
through the EDI transaction. If you have not run the posting process, any changes you make post to your
database when you run the posting process, which means the data posts to the person's record (unless
otherwise noted).

The EDI TS130 transcript staging pages are holding tables and are not linked to your database. Personal,
organization, and transcript data from these tables post to your database during the posting process,
but the data is not shared. In other words, if you change a value in one of these pages, your database is
not affected until you run the posting process. Data from these records can post to personal data, to the
Education component, and to the Test Results page. If, during the posting process, the data causes a new
record to be added, the person is added to your demographic data.

You can access the EDI TS130 Staging pages to review the information stored here at any time during
the Processing TS130 transcript business process. For example, you might prefer to look at the data
immediately after loading it, after running the organization search process, after posting it, or after each of
those steps, depending on your procedures.

Note: Be cautious when editing the data in your staging files prior to posting so that you do not
inadvertently create duplicate records.

If you find an error in these pages after the posting process, you need to go to the applicable page in your
application to make any changes.

This section discusses how to review EDI TS130:
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• Staging process options.

• Organization staging process options.

• Name data.

• Address data.

• Staging bio/demo data.

• Staging bio/demo (2) data.

• Requirements, attributes, and proficiencies.

• Previous college data.

• Staging organization demographic data.

• Staging academic status data.

• Staging activity data.

• Staging test score data.

• Staging session data.

• Staging academic summary data.

• Staging course data.

• Staging degree data.

• Staging additional information.

• Messages in the staging table.

See Also

The Postsecondary Electronic Standards Council Website
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Pages Used to Review and Edit the EDI TS130 Data

Page Name Definition Name Navigation Usage

EDI TS130 Process Options ADM_TS130_PROC_OPT Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Process Options

Review or edit the process
options in your EDI TS130
staging table. This page
provides the status of an
EDI TS130 transcript record
regarding the loading, search/
match and posting processes.
 You can determine if a record
is waiting to be processed,
 if a record instigated a new
person to be added to your
database, or if any errors
were encountered during
the search/match or loading
processes.

EDI TS130 Org Process
Options (organization process
options)

ADM_TS130_ORG_OPT Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130 Org
Process Options

Review or edit the process
options for external
organization records in your
EDI TS130 staging table.

EDI TS130 Names ADM_TS130_NAMES Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Names

Review or edit the names of
applicants loaded through the
EDI TS130 data load.

EDI TS130 Addresses ADM_TS130_ADDR Student Admissions >
Application Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Addresses

Review or edit the addresses
of applicants loaded through
the EDI TS130 data load.

EDI TS130 Bio/Demo 
(biographical/demographic)

ADM_TS130_BIODEMO1 Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130 Bio/
Demo

Review and edit the
biographical and demographic
data loaded through the EDI
TS130 data load.

EDI TS130 Bio/Demo 2 
(biographical/demographic 2)

ADM_TS130_BIODEMO2 Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130 Bio/
Demo (2)

Review and edit the
biographical and demographic
data loaded through the EDI
TS130 data load.
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Page Name Definition Name Navigation Usage

EDI TS130 RAP 
(requirements, attributes, and
proficiencies)

ADM_TS130_RAP Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130 RAP

Review or edit transcript
degree data loaded through
the EDI TS130 data load.
 Requirement, Attribute, and
Proficiency information fall
under a session.

EDI TS130 Previous Colleges ADM_TS130_PCL Student Admissions >
Application Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Previous Colleges

Review or edit previous
college data loaded through
the EDI TS130 data load.

EDI TS130 Org Data 
(organization data)

ADM_TS130_ORG_DEMO Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130 Org
Data

Review and edit the
organization demographic
data loaded through the
EDI TS130 data load. This
page contains data about the
external organization that this
transcript data is regarding.
 Organization data does not
post to your database.

EDI TS130 Acad Status 
(academic status)

ADM_TS130_SST Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130 Acad
Status

Review or edit high school
academic status data loaded
through the EDI TS130 data
load. If the organization you
are viewing is a high school,
this page contains high school
academic information about
the person in regard to this
organization.

EDI TS130 Activities ADM_TS130_ACTIVITY Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Activities

Review or edit transcript
degree data loaded through
the EDI TS130 data load.
 Activity information falls
under a session.

EDI TS130 Test Scores ADM_TS130_TESTS Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130 Test
Scores

Review or edit test score
data loaded through the EDI
TS130 data load.
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Page Name Definition Name Navigation Usage

EDI TS130 Sessions ADM_TS130_SES Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Sessions

Review or edit transcript
session data loaded through
the EDI TS130 data load.
 Multiple sessions can come
from one organization. For
example, one session could
make up the Fall of 9th grade,
whereas another session could
make up the Spring of 9th
grade.

EDI TS130 Academic
Summary

ADM_TS130_ACAD_SUM Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Academic Summary

Review or edit academic
summary data loaded through
the EDI TS130 data load.

EDI TS130 Courses ADM_TS130_CRS Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Courses

Review or edit transcript
course data loaded through the
EDI TS130 data load.

TS130 Course Detail ADM_TS130_CRS_SEC Click the Course Detail link
on the EDI TS130 Courses
page.

View additional course
information.

EDI TS130 Degrees ADM_TS130_DEG Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Degrees

Review or edit transcript
degree data loaded through
the EDI TS130 data load.
 Degree information falls
under a session.

EDI TS130 Additional Info ADM_TS130_ADDL Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Additional Info

Review or edit additional
information loaded through
the EDI TS130 data load.

EDI TS130 Messages ADM_TS130_MSGS Student Admissions >
Application/Transcript
Loads > TS130 > TS130
Staging > EDI TS130
Messages

View EDI TS130 processing
messages.

Reviewing EDI TS130 Staging Process Options
Access the EDI TS130 Process Options page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Process Options).
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This example illustrates the fields and controls on the EDI TS130 Process Options page. You can find
definitions for the fields and controls later on this page.

Processing Options

Field or Control Description

Edit The system displays the status of the load process for this
suspense record. The load process populates this value.

Complete: The load process loaded the transcript data without
a problem. This record is ready to be posted.

Error: The load process encountered problems when loading
the transcript data. The system indicates the values that you
need to correct in the Error Indicators group box. Correct
all errors and save the data before running the search/match/
post process on this record. After you correct the errors and
save the component, the system changes the field value to
Complete.

Perform: You set this value manually. It is for informational
purposes only.
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Field or Control Description

Search The system displays the status of the search/match process for
this suspense record. The search/match process populates this
value.

Complete: The search/match process posted the transcript
data without a problem. If the process created a new person in
your database, the process generates an ID for the person and
displays it in the ID field on the Bio/Demo page. If the process
updated an existing person's record, the process displays the
ID that was updated in the ID field on the Bio/Demo page.

Error: The search/match process encountered problems when
posting the transcript data.

Perform: The search/match process processes this record the
next time you run the process.

Post The system displays the status of the record regarding the
search/match/post process. These values can be entered
manually, however, some are entered by the system after you
run the processes as described in the following table.

Post Value Meaning How Set

Error The posting process encountered a
problem.

Set by the system during the search/
match/post process.

New ID Add The system was unable to find a match in
the database and will add a record with
a new ID to your database when you run
the search/match/post process.

When set manually it means that the
process identified a match and you
determined manually that no duplication
exists. When you run the search/match/
post process again, the process creates a
new record and generates an ID, which it
displays in the ID field on the Bio/Demo
page.

Set by the system during the search/
match process if no match was found
in your database (only when you run
search/match and post and different
times).

Set manually.

No Action Search/match/post and purge suspense
file processes will ignore the record if
this value is entered.

Set manually.
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Post Value Meaning How Set

Purge Indicates that this suspense record will
be removed from the system during the
purge suspense file process.

Set by the system during the search/
match/post process if the record was
successfully processed.

Update ID The search/match/post process found a
matching ID in the database. The process
will update the matching records with the
data from this suspense record.

When set manually it means that the
process identified a match and you
determined manually that a duplication
exists. The system makes available the
ID field on the Bio/Demo page. Select
the ID that you want the search/match/
post process to update. You must save
the page and run the search/match/post
process to update the record.

Set by the system during the search/
match process if a match was found
in the database and if your search
parameters define that an update should
occur in this situation (only when you
run search/match and post and different
times).

Set manually.

Wait Search This record is in the suspense file and is
waiting to be processed by the search/
match/post process.

Set by the system during the load
external data process.

Note: While you can manually edit the values in the Edit, Search and Post fields, keep in mind that if
a field contains Error and you manually change it without correcting an error, you might experience
problems when posting the data.

Error Indicators

Field or Control Description

Last Name, First Name, Test Component,  and Course
Error

When a load error occurs, the load external data process
selects the required values that were missing or incorrect
in the load. Go to the Bio/Demo page, the Tests page, or
another page is the Suspense component where the missing or
incorrect data resides to enter a valid value. When you correct
the error the system clears the check box. After you clear all
of the check boxes and save the component, the system enters
Complete in the Edit field.
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Search/Match Results

Field or Control Description

Order Nbr You know that the search/match/post process found a match
and did not post the suspense record when the Search field
contains Perform and displays the search order number that led
to the match in the Order Number field. Use this information
to decide whether or not a possible duplication exists.

Matches The system displays the number of matches the process found
at the given order number.

Note: Additional status information can be viewed on the EDI TS130 Messages page.

Reviewing EDI TS130 Organization Staging Process Options
Access the EDI TS130 Org Process Options page (Student Admissions > Application/Transcript
Loads > TS130 > TS130 Staging > EDI TS130 Org Process Options).

This example illustrates the fields and controls on the EDI TS130 Org Process Options page. You can find
definitions for the fields and controls later on this page.

This page provides the status of EDI TS130 transcript organization data regarding the loading, search/
match and posting processes. You can determine if an external organization record is waiting to be
processed, if the person linked to this organization record instigated a new ID to be added to your
database, or if any errors were encountered during the search/match or loading processes.

When organization data comes in with an EDI load, the system does not create new organizations in your
database. During the Organization Search process, the system searches through your database to find a
matching external organization for the organization data that comes in. Therefore, the organization must
already exist in your database for this transcript data to process. An error occurs if the process does not
find a matching organization.

Organization data is linked to a personal EDI TS130 record. The organization controls the transcript
information related to the person linked to this record. The system does not process the organization data
until you process the matching personal record.
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Processing Options

Field or Control Description

Edit The system displays the status of the load process for this
organization suspense record. The load process populates this
value.

Complete: The load process loaded the organization data
without a problem. This record is ready to be posted.

Error: The load process encountered problems when loading
the organization data. View details about the error on the EDI
TS130 Messages page. Correct all errors and save the data
before running the search/match/post process on this record.
 After you correct the errors and save the component, the
system changes the field value to Complete.

Perform: You set this value manually. This is for informational
purposes only.

Search The system displays the status of the search/match process for
this suspense record. The search/match process populates this
value.

Complete: The search/match process posted the organization
data without a problem.

Error: The search/match process encountered problems when
posting the organization data.

Perform: The search/match process processes this record the
next time you run the process.

Post The system displays the status of the record regarding the
search/match/post process. These values can be entered
manually, however, some are entered by the system after you
run the processes as described in the following table.

Post Value Meaning How Set

Error The posting process encountered a
problem.

Set by the system during the search/
match/post process.
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Post Value Meaning How Set

New ID Add The system was unable to find a match
for this organization in your database. To
post data for this person regarding this
organization, you must manually enter a
valid organization ID on the EDI TS130
Org Data page.

Set by the system during the search/
match process if no matching
organization was found in your database.

No Action Search/match/post and purge suspense
file processes will ignore the record if
this value is entered.

Set manually.

Purge Indicates that this suspense record will
be removed from the system during the
purge suspense file process.

Set by the system during the search/
match/post process if the record was
successfully processed.

Update ID The system found a matching
organization ID in the database.
 Consequently, data from this
organization for this person can be
updated.

Set by the system during the search/
match process if a matching organization
was found in the database.

Wait Search This record is in the suspense file and is
waiting to be processed by the search/
match/post process.

Set by the system during the load
external data process.

Note: While you can manually edit the values in the Edit, Search and Post fields, keep in mind that if
a field contains Error and you manually change it without correcting an error, you might experience
problems when posting the data.

Search/Match Results

Field or Control Description

Matches The system displays number of external organization matches
found in your database for this record.

Note: Additional status information can be viewed on the EDI TS130 Messages page.

Reviewing EDI TS130 Name Data
Access the EDI TS130 Names page (Student Admissions > Application/Transcript Loads > TS130 >
TS130 Staging > EDI TS130 Names).
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This example illustrates the fields and controls on the EDI TS130 Names page. You can find definitions
for the fields and controls later on this page.

View all the names parts loaded for the student by name type. The name appearing at the top of the page
is the name that will be posted to the NAMES record. This name was determined by the Name types you
entered on the TS130 Load Parameters page.

Reviewing EDI TS130 Address Data
Access the EDI TS130 Addresses page (Student Admissions > Application Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Addresses).

This example illustrates the fields and controls on the EDI TS130 Addresses page. You can find
definitions for the fields and controls later on this page.

View the address types loaded for the student. Click the Address button to access the TS130 Address,
where you can view the address loaded through the TS130 Load process. You can also click the Edit
Address link on the TS130 Address page to edit address data. If a new record is created when you post
EDI TS130 data, address information from this page is used to populate the new record. If a matching
record is found in your database and you have defined that matching records should be updated with EDI
TS130 data, this EDI TS130 personal data does not overwrite any data in the existing record.
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Reviewing EDI TS130 Staging Bio/Demo Data
Access the EDI TS130 Bio/Demo page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Bio/Demo).

This example illustrates the fields and controls on the EDI TS130 Bio/Demo page. You can find
definitions for the fields and controls later on this page.

The EDI TS130 Bio/Demo page contains biographical and demographic data for the person from the EDI
TS130 transcript load.

If the system creates a new record when you post EDI TS130 data, the system uses personal information
from this page to populate the new record. If the system finds a matching record in your database this
EDI TS130 personal data does not overwrite any bio/demo data in the existing record, even if you have
specified that matching records should be updated with EDI TS130 data. To protect verified information,
the system never updates bio/demo data through external data loads.

If you have not run the posting process and you edit the data on this page, then the edited data posts to the
person's record when you post the data.
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Field or Control Description

ID After the load process runs, this field is display-only and
is empty. After the search/match process runs this field is
accessible and contains the ID of the person in your database
if a match was found, or NEW if a new record will be added
during the posting process. After the posting process runs, this
field is display-only and displays the ID of the person in your
database to whom this EDI data posted.

This field is unavailable until you run the search/match/post
process. The search/match/post process generates an ID and
displays it here if the process created a new record.

If the process finds a match and updates an existing record, the
process enters the ID of the record that it updated.

If the process finds a match and dumps the record into the
suspense table, and you decide to update an existing ID (by
selecting Update ID in the Post field on the Process Options
page), a prompt becomes available. Click the prompt to select
the ID that you want to update.

Ref Nbr Qualifier  (reference number qualifier) The type of reference number indicated in the EDI TS130 load
for this person.

Number  (reference number) The actual reference number from the EDI TS130 load.

Reviewing EDI TS130 Staging Bio/Demo (2) Data
Access the EDI TS130 Bio/Demo (2) page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Bio/Demo (2)).

This example illustrates the fields and controls on the EDI TS130 Bio/Demo (2) page. You can find
definitions for the fields and controls later on this page.

654  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 21 Performing EDI TS130 Transcript Transactions

If a new record is created when you post EDI TS130 data, personal information from this page is used
to populate the new record. If a matching record is found in your database and you have defined that
matching records should be updated with EDI TS130 data, this EDI TS130 personal data does not
overwrite any data in the existing record. If you have not run the posting process and you edit the data on
this page, the edited data posts to the person's record when you post the data.

Field or Control Description

Disabled The system selects this check box if the record indicates that
the person is disabled.

Full-Time Student The system selects this check box if the record indicates that
the person is a full-time student.

Reviewing EDI TS130 Requirements, Attributes, and Proficiencies
Access the EDI TS130 RAP page (Student Admissions > Application/Transcript Loads > TS130 >
TS130 Staging > EDI TS130 RAP).

Field or Control Description

Test/Requirement Code Indicates a particular national, regional, state, or local
requirement for a course.

Description 1 Specifies the main category of the requirement, attribute, or
proficiency.

Description 2 Specifies the lesser category of the requirement, attribute, or
proficiency.

Usage Indicator Designates the achievement or characteristic being described
as a requirement, an attribute, or a proficiency. Possible values
are Attribute, Prfncy (proficiency), and Reqmn (requirement).

Condition or Response Code If selected, indicates that the student or course meets the
requirement, attribute, or proficiency.

Reviewing EDI TS130 Previous College Data
Access the EDI TS130 Previous College(s) page (Student Admissions > Application Transcript
Loads > TS130 > TS130 Staging > EDI TS130 Previous College(s)).
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This example illustrates the fields and controls on the EDI TS130 Previous College(s) page. You can find
definitions for the fields and controls later on this page.

View previous colleges supplied by the sending institution on this page. Information includes the
institution name, the begin and end dates, as well as degree data. This data is informational only and not
posted to the Education component.

Reviewing EDI TS130 Staging Organization Demographic Data
Access the EDI TS130 Org Data page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Org Data).

This example illustrates the fields and controls on the EDI TS130 Org Data page. You can find definitions
for the fields and controls later on this page.

656  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 21 Performing EDI TS130 Transcript Transactions

Note: An organization must exist in your database for transcript data from that organization to post
to your database. If the organization search process resulted in multiple or no matches, you need to
manually choose an organization ID on this page. If the organization does not exist in your database, you
need to add a new organization to your database and then return to this page and insert the new ID. The
organization search process must be run again to process the courses for the new external organization
once it is entered on this page.

Field or Control Description

Description The descriptive name of this external organization as provided
in the EDI load.

Organization Type The type of external organization (such as School). Values for
this field are delivered with your system as translate values.
 You can modify these translate values.

External Org ID  (external organization ID) If the organization search process found a match for this
organization in your database, its ID appears. If more than one
or no potential match is found during the organization search
process, Error appears in the Search field of the Org Process
Options page. In such a case, an organization does not appear
in this page. To investigate the reason for the error, go to the
EDI TS130 Staging - Messages page. If no match is found,
 you must manually choose the appropriate organization ID.
 If the organization does not exist, you need to add it to your
database and then return to this page to select the new ID.

See "Understanding Organizations" (Campus Community
Fundamentals)

Term Type The type of term used by this external organization.

External Career The external career for this organization. Values for this field
are delivered with your system as translate values. You can
modify these translate values. Values are Graduate, High
School, Law, Medical, and Undergraduate.

Inbound School Type The EDI school type for this external organization comes from
the EDI record. Its description appears next to the field.

ACT Code,  ATP Code, FICE Code, and IPEDS Code The ACT code, ATP code, FICE code, and IPEDS code
appear. The organization search process uses these codes to
search for a matching external organization in the database.

Organization Address Click this button to access address information for this external
organization.
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Reviewing EDI TS130 Staging Academic Status Data
Access the EDI TS130 Acad Status page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Acad Status).

This example illustrates the fields and controls on the EDI TS130 Acad Status page . You can find
definitions for the fields and controls later on this page.

View additional information about the student's attendance at the organization listed on the EDI TS130
Org Data page. After you post the EDI TS130 data, you can view transcript data for this person through
the Education component or through the Education Summary inquiry component.

Reviewing EDI TS130 Staging Activity Data
Access the EDI TS130 Activities page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Activities).

This example illustrates the fields and controls on the EDI TS130 Activities page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Qualifier Code Identifies a specific industry code list, such as Activ Cd
(activity code) or Award Cd (award code).

658  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 21 Performing EDI TS130 Transcript Transactions

Note: You can view activity code information on the Extracurricular Activities page and award code
information on the Honors/Awards page after the person becomes a prospect or applicant and the data is
posted to the database.

Reviewing EDI TS130 Staging Test Score Data
Access the EDI TS130 Test Scores page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Test Scores).

This example illustrates the fields and controls on the EDI TS130 Test Scores page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Test ID The ID of the test taken by this person. Define test IDs on the
Test Tables page.

Test Date The PeopleSoft standard date format as translated from the
EDI test date.

Test Date Error The system selects this check box if it detected an error on the
test date.

Test Level A free-form text description of the level of the test for cases
in which there are multiple levels to a test. For example, for
the International Baccalaureate Test, "H" represents the higher
level and "S" represents the subsidiary level.

Component The system translates the test component to your institution
component code by matching the subtest code delivered with
the EDI load and the subtest code on the Test Tables page.

Subtest (subtest code) The test component code from the EDI record. A
corresponding subtest code must be defined for the test
component on the Test Table for the test component to be
populated during the TS130 load process.
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Field or Control Description

Score The reported score from the EDI load.

Post The system selects this check box if the component will be
posted to your database.

Error The system selects this check box if it detected an error on the
test component.

Note: You can view the test results posted for a person through the Academic Test Summary page or the
Test Results page.

Reviewing EDI TS130 Staging Session Data
Access the EDI TS130 Sessions page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Sessions).

This example illustrates the fields and controls on the EDI TS130 Sessions page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Term Type The term type used by this external organization. Values for
this field are delivered with your system as translate values.
 You can modify these translate values.

Career The external career to which this transcript session pertains.
Values for this field are delivered with your system as translate
values. You can modify these translate values.
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Field or Control Description

Ext Term (external term) The actual external term that this data applies to (such as FALL
or SPRING). The values available to you in this field depend
on what you entered in the Term Type field. Define external
terms on the External Term Table page.

Acad Level (academic level) The academic level of the person at the time this data was
collected or issued. Values for this field are delivered with
your system as translate values. You can modify these translate
values. Examples of the values are 10th Grade, 11th Grade,
 Freshman, and Postdoctoral.

Term Year The term year relevant to this session.

From Date and To Date The first and last date that the applicant attended this school
for this session.

Certificate Received Date The date that you ran the EC Inbound Agent process.

Data Medium The data medium default for this session is EDI. Values for
this field are delivered with your system as translate values.
 You can modify these translate values.

Reviewing EDI TS130 Staging Academic Summary Data
Access the EDI TS130 Academic Summary page (Student Admissions > Application/Transcript
Loads > TS130 > TS130 Staging > EDI TS130 Academic Summary).

This example illustrates the fields and controls on the EDI TS130 Academic Summary page . You can
find definitions for the fields and controls later on this page.

View academic data specific to the session listed for the student. This data will include grade point
average (GPA), units attempted and completed, as well as class rank information. If an N appears in the
Cumulative field, the data shown is specific to the session listed. If a Y appears in the Cumulative field,
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the data is cumulative to show overall academic statistics as of the end of the session listed. The latest
cumulative information is posted to the academic summary section of the Education component during
the search/match/post process.

Reviewing EDI TS130 Staging Course Data
Access the EDI TS130 Courses page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Courses).

This example illustrates the fields and controls on the EDI TS130 Courses page. You can find definitions
for the fields and controls later on this page.

The Org Search Process finds course matches based on the EDI School Subject and EDI Course Number.
The EDI fields are compared against the School Subject and School Course Number defined for the
Organization on the School Course Classification page. If a match is found, the School Subject, Course
Number and Description from the School Course Classification Table are populated on EDI TS130
Courses and the Course Post flag is set to Y. If a match is not found based on the Subject and Number
during the Org Search Process, the Edit Process Option will be set to Error and the Course Error flag will
be set to Yes on the EDI TS130 Process Options page.

You can choose to post the course without having a match. The error flag will not be set on the course
and you are able to select Course Post which allows the course to be posted to External Course instead of
having to manually data enter the course. You can select the School Subject and Course Nbr prompts to
search for an appropriate course or leave the fields populated as they are. If you determine you want this
course to be posted even though a match was not found, select Course Post and Save. If you select Course
Post for all the courses that did not find a match and save, the Edit Process Option on EDI TS130 Process
Options will automatically change from Error to Complete. If you decide not to post one or more courses,
you will need to manually go change the Edit Process Option to Complete in order for the transcript to be
posted.
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Field or Control Description

External Course Number The sequential number of this row of course data. The first
data item (or row) loaded is 1. The next row is 2. Courses fall
under a session.

Crse Error (course error) The system selects the course error display-only check box if
there was an error during the posting process. For example,
 the system selects this check box if it fails to find a matching
course for the course loaded through the EDI load. See the
Messages page for more information on this error.

Course Post The system selects this check box if this course will be posted
to your database.

School Subject If the system finds an external subject area on the School
Course Classification page for this school that matches the
external subject area loaded through the EDI load, it populates
the subject area from the School Course Classification page
here. If it does not find a match, it populates the value from the
External Subject Area field here, and selects the Crse Error
check box. The system compares the subject areas when you
post the record.

Course Nbr (course number) If the system finds a course description and external subject
area on the School Course Classification page that matches
the description of the EDI course number and the external
subject area from the load, it populates the course number
here, and the description in the field to the right. If it does not
find a match, the system leaves this field blank and selects
the Crse Error check box. The system compares the course
descriptions when you post the record.

Career The external career comes from the EDI load. Values for this
field are delivered with your system as translate values. You
can modify these translate values.

EDI School Subject The external subject area loaded from the EDI load. When
you post this record the system compares this value to the
external subject areas and course descriptions set up for this
external organization on the School Course Classification
page. If it finds a match it populates the School Subject field
with the corresponding subject area from the School Course
Classification page. If it does not find a match the system
populates the School Subject field with the value in this field.
 The description appears next to the field.
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Field or Control Description

EDI Course Number The course number loaded from the EDI load. The description
from the EDI load appears next to this course field. When
you post this record the system compares the description of
the EDI course number and the external subject area to the
course descriptions and external subject areas set up for this
external organization on the School Course Classification
page. If it finds a match it populates the Course Nbr field
with the corresponding course number from the School Course
Classification page. If it does not find a match the system
leaves the Course Nbr field blank and selects the Crse Error
check box.

The Description field is display-only if a match is found from
your School Course Classification setup. If a match is not
found, you can edit the Description field.

EDI External Course Type The external course type defining this course, such as Course
and Event. External Course Type comes from the EDI load.
Values for this field are delivered with your system as translate
values. You can modify these translate values.

Course Level The course level comes from the EDI load. This course could
be described, for example, as an Honors, AP, or Regular
course. Values for this field are delivered with your system as
translate values. You can modify these translate values.

Units Taken The number of units taken for this course.

Grd In/Official (grade in/official) The grade information for this course.

Course Detail Click this button to view additional data regarding this course.

Note: View transcript data posted through the EDI load for a person through the Education component or
through the Education Summary inquiry component.

Reviewing EDI TS130 Staging Degree Data
Access the EDI TS130 Degrees page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Degrees).

664  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 21 Performing EDI TS130 Transcript Transactions

This example illustrates the fields and controls on the EDI TS130 Degrees page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Degree Nbr (degree number) Displays the sequential number of this row of degree data. The
first data item (or row) loaded is 1 and the next row is 2.

Degree Date The date the student received or will receive this degree.

Honors Category Honors the person received for this degree (if applicable).
Values for this field are delivered with your system as translate
values. You can modify these translate values. The delivered
values are Cum Laude, Magna Cum Laude, None, and Summa
Cum Laude.

Field of Study 1 and Field of Study 2 The particular subject areas or concentrations for this degree 
(if applicable).

Note: You can view the degree data posted for a person through the Education component or through the
Education Summary inquiry component.

Reviewing EDI TS130 Staging Additional Information
Access the EDI TS130 Additional Info page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Additional Info).
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This example illustrates the fields and controls on the EDI TS130 Additional Info page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

EDI Trans Type The purpose of the transaction. Values are Original, Replace,
 Duplicate, Response, Re-Submission, Confirmation, and 
Mutually Defined.

Transaction Type The type or transcript or student record being sent. Values are
District or Postsecondary.

Ref Nbr Qual (reference number qualifier) A code identifying the type of student identification being
sent in the Reference Number field. Refer to the Student
Educational Record Transaction Set 130 (TS130) for a
definition of the values.

Status Reason The reason the transcript or student record is being sent.
 Refer to the Student Educational Record Transaction Set 130 
(TS130) for a definition of the values.

Unit Type The external unit type from the last SUM loop transmitted
for the student indicating the type of credit used by the
sending institution. Refer to the Student Educational Record
Transaction Set 130 (TS130) for a definition of the values.

Reference Number The reference information as defined by the reference
identification qualifier field.

Cumulative An indicator of whether or not the data on this page is a
summary or all work included in the record. A Y in the field
indicates the data is cumulative.
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Field or Control Description

Course Level The level of work that is reflected in the GPA and hours on
this page. Refer to the Student Educational Record Transaction
Set 130 (TS130) for a definition of the values.

Attempted The total number of units the student attempted on this record
as transmitted in the last SUM loop of the record.

External GPA (external grade point average) The GPA for the student as transmitted in the last SUM loop of
the record.

Class Rank The class rank of the student as transmitted in the last SUM
loop of the record.

Completed The total number of units the student attempted and earned on
this record as transmitted in the last SUM loop of the record

Hours Earned The total number of hours included in the GPA for this
summary as transmitted in the last SUM loop of the record.

Class Size The total number of student in the class to help position the
student's rank as transmitted in the last SUM loop of the
record.

Name Component The code identifying the type of name component. Refer to the
Student Educational Record Transaction Set 130 (TS130) for a
definition of the values.

Date Time Period The date the class rank was determined.

Name The free-form text of the name component or the full name as
indicated in the name component field.

Reviewing EDI TS130 Messages in the Staging Table
Access the EDI TS130 Messages page (Student Admissions > Application/Transcript Loads >
TS130 > TS130 Staging > EDI TS130 Messages).
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This example illustrates the fields and controls on the EDI TS130 Messages page. You can find
definitions for the fields and controls later on this page.

Any informational and error messages that the EDI TS130 load, organization search, search/match, or
posting processes generates appear on this page. These messages can serve historical and analytical
purposes, giving you a picture of the kinds of errors encountered in your EDI processing. To do such an
analysis, you would need to wait to purge your EDI messages until you have completed your analysis.

You can also look to these messages to ascertain any changes you want to make to your staging data
before posting it to your database.

Field or Control Description

Run Date/Time The day and time the last process ran for this record.

Process Instance The process number of the last process run for this record.

User ID The user ID of the person who ran the last process for this
person.

Process Name The name of the last SQR run for this record. For example, in
the previous page example, the last SQR run was ADTRNPST.
SQR (the load process).

Message Set Number  and Message Number The message set number and message number, which come
from the message catalog.

Message Severity The message severity (such as Message or Error).

Message Text The actual message on this row of data.

Description Details about the message in the Message Text area.
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Field or Control Description

Comments Results or other additional information about the message.

Using the Organization Search Process

This section provides an overview of the organization search process and lists the page used to run the
Organization Search process.

After you have loaded the TS130 data and corrected any error resulting from the load process, run the
organization search process to match the organization and course data.

When you click the Run button, the Organization Search process does the following: Uses the FICE, ATP,
ACT, or IPEDS code found on the EDI TS130 Staging, EDI TS130 Org Data page to find a match to the
same codes stored on the Organization Table, School Data page. If a match is found, the system populates
the Ext Org ID, Term Type, and External Career fields on the EDI TS130 Org Data page.

The Term Type and External Career fields will only be populated if the system defaults for those fields
are populated on the Organization Table, School Data page.

The system updates the EDI TS130 Courses page (Student Admissions, Application/Transcript Loads,
TS130, TS130 Staging, EDI TS130 Courses) based on the search process. The system compares the EDI
School Subject and EDI Course Number fields on the EDI TS130 Courses page with the school subject
and school course number on the School Course Classification page (Campus Community, Organization,
Create/Maintain Organizations, School Course Classification).

If the system finds a match, it sets the course to Course Post. If the system does not find a match, it sets
the Crse Error (course error) flag for the course and also sets it on the EDI TS130 Staging, EDI TS130
Process Options page.

To post the course as it is, select the Course Post check box and save the page. If you post all of the
courses for which no match was found, the Edit Process Option field on the EDI TS130 Process Options
page automatically changes from Error to Complete. If you decide not to post one or more courses, you
must manually change the Edit Process Option field to Complete in order for the transcript to be posted.

To rectify a course error:

1. Clear the Course Nbr (course number) field

2. Press TAB.

3. Click the prompt to select the appropriate course.

The system clears the Crse Error check box, but you must select Course Post to post the course. The
appropriate courses do not appear if you do not press TAB before selecting the course number prompt.
You must return to TS130 staging and correct the errors before posting the data.

Copyright © 1988, 2021, Oracle and/or its affiliates. 669



Performing EDI TS130 Transcript Transactions Chapter 21

Page Used to Run the Organization Search Process

Page Name Definition Name Navigation Usage

EDI TS130 Org Search 
(organization search)

ADM_TS130_ORG_PARM Student Admissions >
Application/Transcript
Loads > TS130 >
Organization Search
Process

Run the process to match
organization and course data
from the transmitted student
record.

Setting Up TS130 Search/Match/Post Parameters, and Processing
and Posting the EDI Staging Files

After you have reviewed the staging tables, specify on the Search Parameters page which EDI data to
load into your database as new records, which data to append to existing records in your database, and
which data to ignore. After choosing your search/match parameters, you can also set up the parameters
for posting the EDI TS130 data, and then you can run both processes at once: to search for matching
people in your database and to post the external EDI TS130 data according to the parameters you set
up. The EDI TS130 Post process contains logic to prevent the posting of duplicate data in the following
areas: External data and external academic summary. The following fields are used to determine if a
new row should be added to external data and external academic summary during the process: EmplID,
External Organization ID, Career, Data Source, Transcript Type, Transcript Status, Academic
Level, From Date, and To Date. If the session data on the EDI TS130 staging matches the data on the
External Education page, a new row is not added. The exception to this logic is if the EDI Transaction
Type (BGN01) equals Replace (05), Re-Submission (15), or Reissue (18). In this case, the existing data is
updated with the new data. If the data does not match, a new row is added.

External degree: The following fields are used to determine if an external degree should be added during
the process: EmplID, External Org ID, External Career, Data Source, Degree Status, Degree Date,
and Degree. If the degree data on EDI TS130 staging matches the data on the Courses and Degrees
page, a new row is not added. The exception to this logic is if the EDI Transaction Type (BGN01) equals
Replace (05), Re-Submission (15), or Reissue (18). If the data matches and the transaction type is one
of these values, the existing data is updated with the new data. If the data does not match, a new row is
added.

External courses. The following fields are used to determine if an external course should be added
during the process: EmplID, External Org ID, Data Source, School Subject, Course Number, Begin
Date and End Date, and Grade In. If the course data on EDI TS130 Staging matches the data on the
Courses and Degrees page, a new row is not added. The exception to this logic is if the EDI Transaction
Type (BGN01) equals Replace (05), Re-Submission (15), or Reissue (18). If the data matches and the
transaction type is one of these values, the existing data is updated with the new data. Additionally, if the
Grade In field on the Courses and Degrees page is blank and the remaining data matches, the Grade In
field will be updated with the grade from EDI TS130 Staging. If the data does not match, a new row is
added.

This section discusses how to:

• Set up search/match parameters.
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• Post the EDI TS130 external data.

• Establish address types.

Note: The recommended option is to select the Search, Match, and Post option to search for matching
people in your database and post the EDI TS130 data to the database in one step.

Pages Used to Set Up TS130 Search/Match/Post Parameters, Process, and
Post the EDI Staging Files

Page Name Definition Name Navigation Usage

Search Parms SEARCH_PARMS Student Admissions >
Application/Transcript
Loads > TS130 > Search/
Match/Post Process >
Search Parms

Set up your search/match
parameters for processing the
EDI TS130 transcript staging
table.

Post Parameters ADM_TS130_PST_PARM Student Admissions >
Application/Transcript
Loads > TS130 > Search/
Match/Post Process > Post
Parameters > ADM TS130
Post Parm

Set up post parameters and
to post EDI TS130 transcript
data. You can post a single
record or all records in the
staging table.

Post Parameters ADM_TS130_PST_PRM2 Student Admissions >
Application/Transcript
Loads > TS130 > Search/
Match/Post Process > Post
Parameters > ADM TS130
Post Parm 2

Set up your address type for
the search/match process.

Setting Up Search/Match Parameters
Access the Search Parms page (Student Admissions > Application/Transcript Loads > TS130 >
Search/Match/Post Process > Search Parms).
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This example illustrates the fields and controls on the Search Parms page . You can find definitions for the
fields and controls later on this page.

Note: The words Parameters Refreshed appear if this is the first time you have entered this page with this
run control ID, or if any of the parameters on this page changed since the last time you accessed this page
with this run control ID.

No Matches Found

Field or Control Description

New Select one of the following options to specify what the search/
match/post process should do when it does not find a matching
record in your database.

Add: Add the unmatched record to your database, including
personal data.

Suspend: Keep the unmatched record in the suspense file to be
looked at manually.

Ignore: Ignore the unmatched record completely. The process
marks the record to be purged.

Match(es) Found

This group box contains one row for each search/match criteria order defined by your institution. Define
search/match orders on the Search/Match Criteria page.
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Field or Control Description

Order Nbr (order number) For each order number, select what you want to do with the
EDI record if the search/match/post process discovers one or
more matching records.

One Match and Multiple Matches Select whether you want to add, update, suspend, or ignore
matching records.

Add: Add a new record to your database using the suspense
record.

Update: Update the existing record with the data in the
suspense record. Remember, the process does not update bio/
demo data.

Suspend: Keep the suspense record back in the suspense table.
 You need to determine manually whether or not this record
matches a record in your database.

Ignore: Ignore the suspense record that matched a record in
your database. The process marks the record to be purged.

Posting the EDI TS130 External Data
Access the ADM TS130 Post Parm page (Student Admissions > Application/Transcript Loads >
TS130 > Search/Match/Post Process > Post Parameters > ADM TS130 Post Parm).

This example illustrates the fields and controls on the ADM TS130 Post Parm page. You can find
definitions for the fields and controls later on this page.
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Execution Option

Field or Control Description

Search, Match and Post Select this option if you want to perform the search/match
and the post process at the same time. This option is
recommended. The EDI TS130 Search/Match/Post process
looks for matching data in your database. You can define
search/match parameters that tell the process what to do in the
case that it finds a match. After the process has performed the
match, it posts the EDI TS130 external data to your database.

Post Only Select this option if you only want to post the external data to
your database.

Search and Match Only Select this option to only run the search and match process on
the suspense table. Note that the process only flags the data,
 according to the parameters you set up, which tells the posting
process to create a new person, update an existing person,
 or ignore the incoming data. However, the process does not
create a new person or update an existing person until you post
the data.

Post Processing Parameters

Field or Control Description

Process Single Record Select this option to process and post a single record. After
you select this, select the appropriate record you want to post.
 If you prefer to process the entire staging table, do not select
this option.

Data Source Select the data source that you want the process to assign to
any transcript information that posts to your database. The
default is School, but you can select a different value. Values
for this field are delivered with your system as translate values.
 You can modify these translate values.

Academic Institution Enter the academic institution to post with the academic
summary and course data.

Grading Scheme Enter the grading scheme to populate for each course on the
Courses and Degrees page.
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Summary Type from External Career

Field or Control Description

External Career and Summary Type Cross-reference fields that work in conjunction with external
academic summary data from incoming transcripts. These
two fields enable the posting of External GPAs to students'
external education records—external GPA is tied to summary
type, which is a child of external career. External career data
is loaded with the TS130 table. By defining desired summary
types for each external career that has been loaded, the EDI
TS130 Transcript Srch/Post process writes external career,
summary type, and external GPA data to the external education
record.

Click the Run button to run the EDI TS130 Transcript Srch/Post process at user-defined intervals.

Note: You can view the data in the EDI TS130 Staging pages at this time. To view the transcript data
posted for a person, use the Education component.

Establishing Address Types
Access the EDI TS130 Post Parm 2 page (Student Admissions > Application/Transcript Loads >
TS130 > Search/Match/Post Process > Post Parameters > ADM TS130 Post Parm 2).

This example illustrates the fields and controls on the ADM TS130 Post Parm 2 page. You can find
definitions for the fields and controls later on this page.

All of the addresses in EDI TS130 Staging post to the PeopleSoft tables. The Address Type chosen in the
Address Search Usage hierarchy is used solely for search/match purposes.

Field or Control Description

Address Usage Order Indicates the usage order for the address type in the search
process.
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Field or Control Description

Address Type Select the address type to be used in the search process.

Purging the EDI TS130 Staging Table and Messages

This section discusses how to purge the EDI TS130 staging table and messages.

Page Used to Purge the EDI TS130 Staging Table and Messages

Page Name Definition Name Navigation Usage

EDI TS130 Purge Parms (EDI
TS130 purge parameters)

ADM_TS130_PUR_PARM Student Admissions >
Application/Transcript
Loads > TS130 > Purge
Process

Purge records and messages,
 if applicable, from the EDI
TS130 staging table.

Purging Staging Tables
Access the EDI TS130 Purge Parms page (Student Admissions > Application/Transcript Loads >
TS130 > Purge Process).

Purge Processing Parameter

Field or Control Description

All Suspense Rows Select this option to purge all records in your staging table,
 regardless of the posting status shown in the Post field of the
Process Options and Org Process Options pages.

Marked Suspense Rows Select this option to purge only those records in your staging
table marked Purge in the Post field of the Process Options
and Org Process Options pages.

Purge Option for Marked Rows

This group box appears when you select the Marked Suspense Rows option.
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Field or Control Description

All Marked Suspense Rows Select this option to purge all the records in your staging table
that are marked Purge in the Post field of the Process Options
and Org Process Options pages.

Rows Loaded before or on Select this option and enter a date to purge only those staging
records that were loaded on or before the specified date and
that are marked Purge in the Post field of the Process Options
and Org Process Options pages.

Use the Dt Loaded (date loaded) field on the EDI TS130
Process Options page to see when you loaded a record.

Suppose you loaded transcripts on May 10, 2008.
Subsequently, you loaded another set of transcripts on May 15,
 2008. If you select the Rows Loaded before or on option and
specify the date as May 15, 2008, the purge process deletes the
transcript records marked Purge that were loaded on May 15,
 2008, and May 10, 2008.

Rows Posted before or on Select this option and enter a date to indicate that you want
to purge only those staging records that are marked Purge in
the Post field of the Process Options and Org Process Options
pages and that were posted on or before the specified date.

Use the Dt Posted (date posted) field on the EDI TS130
Process Options page to see when you posted a record.

Suppose you posted transcripts on May 10, 2008.
Subsequently, you posted another set of transcripts on May 15,
 2008. If you select the Rows Posted before or on option and
specify the date as May 15, 2008, the purge process deletes the
transcript records marked Purge that were posted on May 15,
 2008, and May 10, 2008.

Message Purge Parameters

Field or Control Description

Retain Associated Messages Select this option if you do not want to purge messages
associated with the files that you are purging.

Remove Associated Messages Select this option if you do want to purge messages associated
with the files that you are purging.

Click the Run button to run the EDI TS130 Transcript Purge process at user-defined intervals.
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Purging All EDI Messages

This section lists the page used to purge all EDI messages.

Page Used to Purge All EDI Messages

Page Name Definition Name Navigation Usage

EDI Message Purge EDI_TS_MSG_PURGE Student Admissions >
Application/Transcript
Loads > EDI All Message
Purge

Purge all EDI messages. You
can run a process to purge all
EDI messages in your staging
files.
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Performing EDI TS189 Application
Transactions

Understanding EDI TS189 Application Transactions

Recruiting and Admissions enables you to load applications through EDI (Electronic Data Interchange).
This section discusses the steps involved in performing EDI TS189 application transactions.

To perform EDI TS189 application transactions:

1. Process the inbound EC agent.

Specify the location of the file that you want to load into the suspense file on the Schedule Inbound
EC Agent page.

See Processing the Schedule Inbound EC Agent.

2. Load the EDI data for application transactions.

Run the TS189 Load Application Process to load the data into staging files.

3. Review and edit the data that you loaded in suspense pages.

Correct all load errors before moving on to the next step. In the search dialog page of the suspense
component, enter Error in the Edit Processing Option field and click the Search button. Access each
suspense record and correct the errors until every suspense record has a value of Complete (rather
than Error) in the Edit field on the Process Options page.

4. Search for matching organization data.

After you have loaded the application (TS189) data into the staging files, run the Organization Search
process. You must do the organization search as the TS189 load contains some organization data—
course information associated with a particular organization—that must be identified to some record
in the system.

5. After you have corrected all of the load errors in the suspense files, run the Search/Match/Post
process.

This process looks for data in your database (based on search parameters that you define on the
Search/match Parameters page, to include, for example, name, social security number, and birth date)
that matches the data that you are posting. For a set of parameters that suggest only a possible match
(such as name and gender, for example), the process does not post the record until you can manually
determine which records are actually duplicates.

6. Access each suspense record that was not posted and check to see if it is actually a duplicate.
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In the search dialog page of the TS189 Staging component, enter Complete in the Edit Process
Option field and Perform in the Search/Match Process Option field. Then, click the Search
button. The search process finds only those suspense records that went through the search/match/
post process but were not posted. The reason the search/match/post process did not post the records
is because it found a possible duplicate record in the database. After you access the component, find
the parameters for which the process identified a match, and then use the search/match process to
look up the biographic/demographic information that matches the suspense record and decide on your
own whether a person who matches the incoming data already exists in the system. Then, specify
whether you want the search/match/post process to add the biographic/demographic information and
test record to your database, update an existing record, or ignore the suspense record altogether.

7. Run the Search/Match/Post Process again.

The process posts the suspense records that you manually tagged to post. By this time, all of your
suspense records should be posted to your database. When a record posts to your database, the search/
match/post process assigns an ID to the person. To view a biographic/demographic record that the
search/match/post process created, select Student Admissions > Application Maintenance > Add/
Update a Person. To view a test score record that the search/match/post process created or updated,
select Student Admissions > Application Entry > Academic Information > Test Results. To
view the application created, select Student Admissions > Application Maintenance > Maintain
Application.

8. Purge files.

Purge TS189 staging table records on the EDI TS189 Purge Parameters page. You can also purge
messages in this process. If you want to perform an analysis on your EDI processing, perhaps at the
end of a year, do not purge your messages with this process. Instead, purge them at a later date when
you know you no longer have a need to view them.

Note: Ensure that your system is set up to correctly populate ethnicity information during the TS189
posting process.

See Setting Up Ethnicity for EDI TS189 Application Transactions.

Related Links
Purging All EDI Messages
Tracking Test Results for Prospects and Applicants
Entering or Updating Applicant Biographical Data

Setting Up Ethnicity for EDI TS189 Application Transactions

This section provides an overview of ethnicity setup for EDI TS189 transactions and discusses how to set
up ethnicity mapping.

Understanding Ethnicity Setup for EDI TS189 Transactions
You need to make sure that your system is set up to correctly populate ethnicity information during the
TS189 posting processes.
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In order to populate ethnicity and race information in the system to meet IPEDS requirements, you should
complete ethnicity mapping on the IPEDS Ethnicity Mapping table rather than on the Conversion Data
Profile. If collecting this data according to the IPEDS requirements is not necessary, then you may use the
Conversion Data Profile.

Note: When IPEDS data is available, the system ignores any Ethnic Group field on the Bio/Demo page.

Related Links
Setting Up Ethnicity in the System

Page Used to Set Up Ethnicity for EDI TS189 Application Transactions

Page Name Definition Name Navigation Usage

TS189 IPEDS Ethnicity
Mapping

SAD_T189_ETHNICITY Set Up SACR > Product
Related > Recruiting and
Admissions > Applicants >
TS189 IPEDS Ethnicity
Mapping

Define and track ethnicity
codes to comply with
U.S. Federal Integrated
Postsecondary Education
Data System (IPEDS)
requirements.

Setting Up Ethnicity Mapping
Access the TS189 IPEDS Ethnicity Mapping page (Set Up SACR > Product Related > Recruiting and
Admissions > Applicants > TS189 IPEDS Ethnicity Mapping).

This example illustrates the fields and controls on the TS189 IPEDS Ethnicity Mapping page. You can
find definitions for the fields and controls later on this page.

The fields on this page map inbound data to the Ethnicity page in PeopleSoft Campus Community.
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Field or Control Description

Regulatory Region The IPEDS standards apply only to the U.S. region.

IPEDS Race/Ethnicity Enter an ethnicity code. These codes are mandated by the
AACRAO SPEEDE committee's recommendation for
handling IPEDS requirements.

Ethnic Group Select an ethnic group. These codes are set up on the Ethnic
Groups page.

See "Defining Ethnic Groups" (Campus Community
Fundamentals).

Related Links
"Entering Ethnicity Information" (Campus Community Fundamentals)

Loading the EDI Data for Application Transactions

This section discusses how to use the EDI TS189 Load Parms (EDI TS189 load parameters) page to set
up application load parameters and to load application data into staging tables.

Page Used to Load the EDI Data for Application Transactions

Page Name Definition Name Navigation Usage

EDI TS189 Load Parms ADM_TS189_LOD_PARM Student Admissions >
Application/Transcript
Loads > TS189 > Load
Application Process > EDI
TS189 Load Parms

Set up application load
parameters and load
application data into staging
tables. After you process your
Inbound EC Agent, define
parameters on the EDI TS189
Load Parms page for the data
you are loading. Then, run the
process to load the data into
the staging tables.

Loading Applications
Access the EDI TS189 Load Parms page (Student Admissions > Application/Transcript Loads >
TS189 > Load Application Process > EDI TS189 Load Parms).

Warning! You should complete the full loading, search/match and posting process before loading a new
set of data. If you have data waiting to be processed, do not load a new file until you have processed any
data already in your staging files.
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Field or Control Description

Regulatory Region The system uses the value entered here to populate ethnic
group fields during TS189 staging.

Important! Ensure that the ethnic groups defined on the
Conversion Data Profile page match those defined for the
regulatory region entered here.

Male, Female, and Unknown An EDI load does not include a person's title. It does, however,
 include gender. In these fields, enter the title you want entered
according to the gender provided in the EDI load. Values for
this field are delivered with your system as translate values.
 You can modify these translate values.

Click the Run button to run the EDI TS189 Application Load/EDI process at user-defined intervals. The
process uses the Last Admit Term field on the Academic Program Table and Academic Plan Table pages
to validate academic programs and plans.

Note: You can view the data in the TS189 Staging pages at this time.

Reviewing and Editing the TS189 Staging Pages

You can use the TS189 Staging component to review or edit the application data loaded through the EDI
transaction. If you have not run the posting process, any changes you make posts to your database when
you run the posting process, which means that the data posts to the person's record (unless otherwise
noted).

The TS189 application staging pages are holding tables and are not linked to your database. Personal,
organization, and application data from these tables post to your database during the posting process,
but the data is not shared. Therefore, if you change a value in one of these pages, your database is not
affected until you run the posting process. Data from these records can post to personal data and to the
Application Maintenance, Extracurricular Activities, Honors and Awards, Education, Work Experience,
and Test Results components. If, during the posting process, the data causes a new record to be added, the
person is added to your demographic data.

At any time during the TS189 application load process, you can access the TS189 Staging pages to review
the information stored here. For example, you might want to look at the data immediately after loading it,
after processing it, after posting it, or after each of those steps, depending on your procedures.

If you have not run the posting process, then you can edit the data in these pages before it posts to your
database. That way the edited data posts to the person's record.

Note: Be careful when editing the data in your staging files before posting so that you do not
inadvertently create duplicate records.

If you find an error in these pages after the posting process, you need to go to the proper page in your
database to make any changes.
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Note: Many of the TS189 Staging pages are similar to those with the same name in the TS130 Staging
component. For these common pages, we provide an example of the TS189 page here, but refer you to the
corresponding TS130 page section for a description of the fields since they are the same.

This section discusses how to review TS189:

• Staging bio/demo data.

• Staging address data.

• Staging communication data.

• Staging languages.

• Staging recommender data.

• Staging residence data.

• Staging reference numbers data.

• Staging application degree data.

• TS189 staging application entry/questions.

• Staging cumulative GPA data.

• Staging employment data.

• Staging immunizations data.

• Staging religion data.

• Staging activities data.

Pages Used to Review and Edit TS189 Staging Pages

Page Name Definition Name Navigation Usage

Process Options ADM_TS189_PROC_OPT Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Process Options

Review or edit the process
options in your TS189 staging
table. This page provides the
status of an TS189 application
record regarding the loading,
 search/match and posting
processes. For example, you
can determine if a record
is waiting to be processed,
 if a record instigated a new
person to be added to your
database, or if any errors
were encountered during
the search/match or loading
processes.

684  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 22 Performing EDI TS189 Application Transactions

Page Name Definition Name Navigation Usage

Org Process Options 
(organization process options)

ADM_TS189_ORG_OPT Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Org Process
Options

Review or edit the process
options for external
organization records in your
TS189 staging table.

Bio/Demo (biographic/
demographic)

ADM_TS189_BIODEMO1 Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Bio/Demo

Review and edit the
biographical and demographic
data loaded through the
TS189 load application
process.

Bio/Demo 2 (biographic/
demographic 2)

ADM_TS189_BIODEMO2 Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Bio/Demo 2

Review and edit the
biographical and demographic
data loaded through the
TS189 load application
process.

Names ADM_TS189_NAM Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Names

View name component
information for the
application loaded through
the TS189 load application
process.

Address ADM_TS189_ADR Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Address

View additional address
information loaded through
the TS189 load application
process.

Organization Detail ADM_TS189_ADR_SEC Click the Organization
Detail link on the Address
page.

View actual address
information.

Communications ADM_TS189_COM Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Communications

View details about TS189
communication data loaded
through the TS189 load
application process.

Languages ADM_TS189_LANG Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Languages

View information about an
applicant's language use and
proficiency loaded through
the TS189 load application
process.

Recommenders ADM_TS189_REC Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Recommenders

View information
about individuals who
recommended the applicant.
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Page Name Definition Name Navigation Usage

Address ADM_TS189_REC_SEC Click the Address link on the
Recommenders page.

View address information for
a recommender.

Residences ADM_TS189_RES Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Residences

View residence data for the
applicant and other related
people.

Test Scores ADM_TS189_TESTS Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Test Scores

Review or edit test score data
loaded through the TS189
load application process.

Ref Nmbrs (reference
numbers)

ADM_TS189_REF Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Ref Nmbrs

View reference number
information loaded through
the TS189 load application
process.

App Degree (application
degree)

ADM_TS189_DEG Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > App Degree

Review or edit applicant
degree data loaded through
the TS189 load application
process. Degree information
falls under a session.

Application Data ADM_T189_DEG_EC Click the Application Data
link on the Application
Degree page.

View details about an
applicant's academic
background.

App Entry/Qstns (application
entry/questions)

ADM_TS189_SSE Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > App Entry/Qstns

View information about
additional application
questions and answers, if
provided.
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Page Name Definition Name Navigation Usage

Org Data (organization data) ADM_TS189_ORG_DEMO Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Org Data

Review and edit the
organization demographic
data loaded through the
TS189 load application
process. Organization
data does not post to your
database. The organization
data from the TS189
application load is matched
with an organization in your
database. Then, the matching
ID is inserted on this page and
carried over to the subsequent
pages in this component,
which contain application data
about this organization. The
system also uses the matching
organization to populate
organization information in
the Education component.

Sessions ADM_TS189_SES Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Sessions

Review or edit transcript
session data loaded through
the TS189 load application
process.

Acad Status (academic status) ACAD_TS189_SST Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Acad Status

Review or edit high school
academic status data loaded
through the TS189 load
application process.

Cum GPA (cumulative grade
point average)

ADM_TS189_SST2 Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Cum GPA

Review or edit applicant
cumulative GPA data loaded
through the TS189 load
application process. GPA
information is under a session.

Courses ADM_TS189_CRS Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Courses

Review or edit applicant
course data loaded through
the TS189 load application
process. Course information is
under a session.

Employment ADM_TS189_EMPLOY Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Employment

Review or edit applicant
employment data loaded
through the TS189 load
application process.
 Employment information is
under a session
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Page Name Definition Name Navigation Usage

Immunizations ADM_TS189_IMMUNIZ Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Immunizations

Review or edit applicant
immunizations data loaded
through the TS189 load
application process.

Religion ADM_TS189_RELIGION Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Religion

Review or edit applicant
religion data loaded through
the TS189 load application
process.

Activities ADM_TS189_ACTIVITY Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Activities

Review or edit applicant
activities data loaded through
the TS189 load application
process.

Messages ADM_TS189_MSGS Student Admissions >
Application/Transcript
Loads > TS189 > TS189
Staging > Messages

View EDI TS189 processing
messages.

Reviewing EDI TS189 Staging Bio/Demo Data
Access the Bio/Demo page (Student Admissions > Application/Transcript Loads > TS189 > TS189
Staging > Bio/Demo).
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This example illustrates the fields and controls on the Bio/Demo page. You can find definitions for the
fields and controls later on this page.

This page contains biographical and demographic data for the person from the EDI TS189 application
load.

IPEDS Ethnicity and Race Data

The data that appears in this group box is populated by the system from the IPEDS Ethnicity Mapping
table. The display-only values of R, Q, S, etc. represent the inbound data values; select the Campus
Solutions equivalent values in the Ethnic Group field.

The TS189 post process uses these CS-mapped values to populate the ethnicity pages and records on
various Campus Solutions transaction components

Reviewing TS189 Staging Address Data
Access the Address page (Student Admissions > Application/Transcript Loads > TS189 > TS189
Staging > Address).
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This example illustrates the fields and controls on the TS189 Staging - Address page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Dt 1 Qual (date 1 qualifier) and Dt 2 Qual (date 2 qualifier) Identifies what the dates in the Date 1 and Date 2 fields
represent. For example, the dates could represent the start date,
 the end date, or the expiration date.

Organization Detail Click this link to view or edit address information. The
Address Detail page appears.

Reviewing TS189 Staging Communication Data
Access the Communications page (Student Admissions > Application/Transcript Loads > TS189 >
TS189 Staging > Communications).

This example illustrates the fields and controls on the TS189 Staging - Communications page. You can
find definitions for the fields and controls later on this page.
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Field or Control Description

DT 1 Qual (date 1 qualifier) and  Dt 2 Qual (date 2 qualifier) Identifies what the dates in the Date 1 and Date 2 fields
represent. For example, the dates could represent the start date,
 the end date, or the expiration date.

Reviewing TS189 Staging Languages
Access the Languages page (Student Admissions > Application/Transcript Loads > TS189 > TS189
Staging > Languages).

This example illustrates the fields and controls on the TS189 Staging - Languages page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

ID Code Qual (ID code qualifier) Indicates which set of language codes is being sent. Values are
Lang Cd (language code) and Mutually.

ID Code A code that identifies the language (such as KO for Korean).

Reviewing TS189 Staging Recommender Data
Access the Recommenders page (Student Admissions > Application/Transcript Loads > TS189 >
TS189 Staging > Recommenders).
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This example illustrates the fields and controls on the TS189 Staging - Recommenders page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

SeqNum (sequence number) The sequential number of this row of data. The first data item 
(or row) loaded is 1. The next row is 2, and so on.

Rcmd Type (recommendation type) The recommendation type that the system posts to the General
Materials component.

Dt Record  (date record) The date of the recommendation.

Recommendation Type The free-form name or mutually defined indicator for the type
of recommendation being supplied when there is a need to
distinguish types of recommendations. Types might include
counselor evaluation, faculty evaluation, and supervisor
recommendation.

Length Known Quant Qualifier  (length known quantity
qualifier)

Codes that identify the format of the Length Known field.
 Values are DY (days), MN (months), and YY (years).

Length Known The amount of time the recommender has known the
applicant. The code in the Length Known Quant Qual field
defines the format of the number in this field. For example, if
Length Known contains the value 78 and the Length Known
Quant Qual field contains DY, then the recommender has
known the applicant for 78 days.

Comm Qual 1 and Comm Qual 2 (communication qualifier 1
and communication qualifier 2)

Codes identifying the type of communication number
that appears in the Communication Number 1 and
Communication Number 2 fields. Values are:
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Code Name

AP Alternate Telephone

AS Answering Service

BN Beeper Number

CP Cellular Phone

EM Electronic Mail

FX Facsimile

HP Home Phone Number

NP Night Telephone

PC Personal Cellular

TE Telephone

WC Work Cellular

WF Work Facsimile Number

WP Work Phone Number

Field or Control Description

Communication Number 1 and Communication Number 2 The complete communication number, including country or
area code (when applicable).

ID Code Identification of an organizational entity.

Address Click to access the Address Detail page and view address
information for this recommender.

Reviewing TS189 Staging Residence Data
Access the Residences page (Student Admissions > Application/Transcript Loads > TS189 > TS189
Staging > Residences).
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This example illustrates the fields and controls on the TS189 Staging - Residences page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Industry Code Indicates a particular criteria or test for determining residency.

Relation Code Indicates the relationship to the student of the individual to
which this residency test or criteria applies. Examples include
but are not limited to: 01 (spouse), 03 (parent), 26 (guardian),
 32 (mother), and 33 (father).

Location Qual (location qualifier) Code identifying the type of location.

Location ID Code identifying a specific location.

Dt 1 Qual  (date 1 qualifier) Identifies what the date in the Date 1 field represents. For
example, the date could represent the start date, the end date,
 or the expiration date.

Date 1 The date that the Dt 1 Qual field identifies.

Quantity Qual (quantity qualifier) Identifies what the value in the Quantity field represents.
Values for this field are delivered with your system as translate
values. You can modify these translate values. Values are:
Days, Weeks, Months, and Years.

Quantity The days, weeks, months, or years—as specified in the
Quantity Qual field—that this person lived with this relation.

694  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 22 Performing EDI TS189 Application Transactions

Reviewing TS189 Staging Reference Numbers Data
Access the Ref Nmbrs (reference numbers) page (Student Admissions > Application/Transcript
Loads > TS189 > TS189 Staging > Ref Nmbrs).

This example illustrates the fields and controls on the TS189 Staging - Ref Nmbrs page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Ref ID Qual (reference ID qualifier) A code identifying what the reference ID represents. Examples
of reference ID qualifiers include but are not limited to:
SSN (Social Security number), state ID, PIN (personal
identification number), and visa number.

Ref ID  (reference ID) The Ref ID Qual field defines this number. For example, if the
reference ID qualifier is SSN, then the reference ID number is
the person's Social Security number.

Location Qualifier A code identifying the type of location.

Location ID A code identifying a specific location.

Dt 1 Qual (date 1 qualifier) and Dt 2 Qual  (date 2 qualifier) Identifies what the dates in the Date 1 and Date 2 fields
represent. For example, the dates could represent the start date,
 the end date, or the expiration date.

Entity ID The type of entity to which this name and location applies (for
example, school, city, or county).

Reviewing TS189 Staging Application Degree Data
Access the App Degree (application degree) page (Student Admissions > Application/Transcript
Loads > TS189 > TS189 Staging > App Degree).
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This example illustrates the fields and controls on the TS189 Staging - App Degree page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

ID Code Qual  (ID code qualifier) Identifies what the field of study represents. Mutually means
that the value in the Field of Study 1 field is mutually defined.

Application Data Click this link to view additional application data. The
Application Data page appears.

Note: Admissions application records use the value of the
Last Admit Term to determine if the program, plan, or subplan
should appear in the prompt. If the Last Admit Term is
populated on the Academic Program Table (ACAD_PROG
_TBL), Academic Plan Table (ACAD_PLAN_TBL), or
Academic SubPlan Table (ACAD_SBPLN_TBL) and the term
is less than or equal to the term selected for the ID, the system
does not display the value in the prompt.

Note: You can view the transcript data posted for a person through the Education component or through
the Education Summary inquiry component.

Reviewing TS189 Staging Application Entry/Questions
Access the App Entry/Qstns (application entry/questions) page (Student Admissions > Application/
Transcript Loads > TS189 > TS189 Staging > App Entry/Qstns).
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This example illustrates the fields and controls on the TS189 Staging - App Entry/Qstns page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Priority A number that indicates the priority of choice for an intended
entry into a school, school program, or postsecondary
institution.

Application Error Indicates whether or not there was an error when loading this
application data. (display-only)

Entered Date The applicant's desired entry date.

Exit Date The applicant's desired exit date.

Status Reasn Cd (status reason code) A code identifying a reason for the applicant's status, such as
dropout or graduated.

Code Lst Qual (code list qualifier) A code identifying a specific industry code list. For example,
 App Q Qual (application question identifier) and Mutually
Defined.

Appl Q ID Code (application question identifier code) A code identifying the type of question that was asked.

Yes/No Indicates whether the applicant answered the question yes
or no. The possible values are N (no), U (unknown), W (not
applicable), and Y (yes).

Descr 1 (description 1) A free-form question or indicator for a mutually defined
question when the codified questions are not adequate.
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Field or Control Description

Descr 2  (description 2) The free-form or fill-in-the-blank response to a question
when a response is needed. Some questions require that an
explanatory note accompany an answer; for example, the
question "Have you ever been convicted of a crime?' may
require further explanation.

Reviewing TS189 Staging Cumulative GPA Data
Access the Cum GPA (cumulative grade point average) page (Student Admissions > Application/
Transcript Loads > TS189 > TS189 Staging > Cum GPA).

This example illustrates the fields and controls on the TS189 Staging - Cum GPA page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Acd Hrs Attmptd  (academic hours attempted) The number of academic hours the person attempted.

Quality Points The quality points used to compute the person's GPA.

Excessive GPA Flag Indicates that an A+ grade has a value higher than the highest
possible GPA.

Sum Data Source  (summary data source) A code used to indicate the source of the summary data.
 Values are A (self-reported) and D (college transcript).

Cum Summary (cumulative summary) Indicates whether the summary is cumulative.
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Reviewing TS189 Staging Employment Data
Access the Employment page (Student Admissions > Application/Transcript Loads > TS189 >
TS189 Staging > Employment).

This example illustrates the fields and controls on the TS189 Staging - Employment page. You can find
definitions for the fields and controls later on this page.

The Employer

Field or Control Description

Emp Code (employer code) The employer code. Values for this field are delivered with
your system as translate values. You can modify these translate
values. Values are Employer  and Mutually.

Emp Loc Qual (employer location qualifier) Defines the address type: for example, home address, current
address, local address.

Position

Field or Control Description

Date 1  and Date 2 The dates that the action in the Type field occurred. In the
example in the preceding page shot, the start date of the
position was January 1, 2000.

Format Defines the units in which the date is defined. For example,
 if the date is set at CCYYMM, then data represented as
01/01/2000 would be transmitted as 000101: century, year,
 month.
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Field or Control Description

Type Specifies whether the date represents the starting date or the
ending date.

Address Click to access the Address Detail page and view address
information for this employer.

Reviewing TS189 Staging Immunizations Data
Access the Immunizations page (Student Admissions > Application/Transcript Loads > TS189 >
TS189 Staging > Immunizations).

This example illustrates the fields and controls on the TS189 Staging - Immunizations page. You can find
definitions for the fields and controls later on this page.

Note: Immunization data does not post to the PeopleSoft Immunization table.

Field or Control Description

Immunization Date(s) The date or dates that the immunization occurred.

Immunization Code The type of immunization a person received. The following
table contains possible codes defined by the Postsecondary
Electronic Standards Council. Some possible codes are:

Immunization Code Description

V03.2 Vaccine for Tuberculosis
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Immunization Code Description

V03.6 Vaccine for Pertussis

V03.7 Tetanus Toxoid Inoculation

V04.01 Polio Oral

V04.02 Polio Immunization

V04.1 Vaccine for Smallpox

V04.2 Vaccine for Measles

V04.3 Vaccine for Rubella

V04.6 Vaccine for Mumps

V04.8 Vaccine for Influenza

V06.1 Vaccine for DTP

V06.12 TD

This list is not comprehensive. For a comprehensive list, see the Postsecondary Electronic Standards
Council website.

Field or Control Description

Immunization Status Code Indicates the status of an immunization conducted on a person.
 Possible codes are:

Code Name

1 First Inoculation

2 Second Inoculation

3 Third Inoculation

4 Fourth Inoculation
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Code Name

5 Fifth Inoculation

6 Sixth Inoculation

7 Seventh Inoculation

8 Eighth Inoculation

9 Ninth Inoculation

10 Medical Exemption

11 Personal Exemption

12 Religious Exemption

13 Had the Disease

14 Has Not Had the Disease

This list is not comprehensive. For a comprehensive list, see the Postsecondary Electronic Standards
Council website.

Field or Control Description

Immunization Type Code Indicates the title or contents of a document, report, or
supporting item. Some possible codes are:

Code Description

CQ County Record

HR Health Clinic Records

IR State School Immunization Records

MG Migrant Student Records Transfer System (MSRTS) Record

PY Physician's Report
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Code Description

ZZ Mutually Defined

This list is not comprehensive. For a comprehensive list, see the Postsecondary Electronic Standards
Council website.

Field or Control Description

Identification Code Qual  (identification code qualifier) Identifies a specific industry code list, such as AAW 
(Immunization Injection Code).

Date/Time Period Qualifier Defines the units in which the Immunization Date(s) field is
defined. For example, if the Date/Time Period Qualifier field
is set at MMDDCCYY, then data represented as 04/06/2000
would be transmitted as 04062000.

Reviewing TS189 Staging Religion Data
Access the Religion page (Student Admissions > Application/Transcript Loads > TS189 > TS189
Staging > Religion).

This example illustrates the fields and controls on the TS189 Staging - Religion page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Identification Code Qual Identifies a specific industry code list, such as REL Cd
(religion code).

Note: Religion data does not post to the PeopleSoft Religious Preferences table.
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Reviewing TS189 Staging Activities Data
Access the Activities page (Student Admissions > Application/Transcript Loads > TS189 > TS189
Staging > Activities).

This example illustrates the fields and controls on the TS189 Staging - Activities page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Qualifier Code Identifies a specific industry code list, such as Award Cd 
(award code).

Searching for Matching Organization Data

After you have loaded the application data into the staging files, you perform an organization search
step. You must do the organization search because the TS189 load contains organization data—course
information associated with a particular organization—that must be related to some record in your
database.

This section discusses how to use the EDI TS189 Organization Search page.

Page Used to Search for Matching Organization Data

Page Name Definition Name Navigation Usage

EDI TS189 Org Search (EDI
TS189 organization search)

ADM_TS189_ORG_PARM Student Admissions >
Application/Transcript
Loads > TS189 >
Organization Search
Process

Perform the organization
search.
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Using the EDI TS189 Organization Search Page
Access the EDI TS189 Org Search page (Student Admissions > Application/Transcript Loads >
TS189 > Organization Search Process).

Click the Run button to run the EDI TS189 App Org Search process at user-defined intervals.

Setting Up TS189 Search/Match/Post Parameters, and Processing
and Posting the EDI Staging Files

After you have reviewed the staging tables, specify on the Search/Match Parameters page which EDI data
to load into your database as new records, which data to append to existing records in your database, and
which data to ignore. After choosing your search/match parameters, you can also set up the parameters
for posting the TS189 data and then you can run both processes at once: to search for matching people in
your database and to post the external TS189 data according to the parameters you set up.

Note: The recommended option is to select the Search, Match, and Post option to search for matching
people in your database and post the TS189 data to the database in one step.

To set up TS189 search/match/post parameters, and to process and post the staging files:

• Set up the EDI TS189 search/match parameters.

• Set up post parameters for EDI TS189 external data.

• Set up additional post parameters for TS189 external data.

Pages Used to Set Up TS189 Search/Match/Post Parameters, and to
Process and Post EDI Staging Files

Page Name Definition Name Navigation Usage

Post Parameters ADM_TS189_PST_PARM Student Admissions >
Application/Transcript
Loads > TS189 > Search/
Match/Post Process > Post
Parameters

Post TS189 application data.
 You can post a single record
or all records in the staging
table.

Post Parameters 2 ADM_TS189_PST_PRM2 Student Admissions >
Application/Transcript
Loads > TS189 > Search/
Match/Post Process > Post
Parameters 2

Enter additional run control
defaults, such as contact type,
 external career, summary
type, and material group
information.

Setting Up the EDI TS189 Search/Match Parameters
Access the Search/Match Parameters page (Student Admissions > Application/Transcript Loads >
TS189 > Search/Match/Post Process > Search/Match Parameters).
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Set up your search/match parameters for processing the EDI TS189 application staging table.

Related Links
Setting Up Search/Match Parameters

Setting Up Post Parameters for EDI TS189 External Data
Access the Post Parameters page (Student Admissions > Application/Transcript Loads > TS189 >
Search/Match/Post Process > Post Parameters).

This example illustrates the fields and controls on the Post Parameters page. You can find definitions for
the fields and controls later on this page.

Search/Match/Post Exec Options

Field or Control Description

Search, Match, and Post Select this option if you want to perform the search/match and
the post process at the same time. This is the recommended
option. The EDI TS189 Search/Match/Post process looks for
matching data in your database. You can define search/match
parameters that tell the process what to do in the case that it
finds a match. After the process has performed the match, it
posts the EDI TS189 external data to your database.

Post Only Select this option if you only want to post the external data to
your database.
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Field or Control Description

Search and Match Only Select this option to only run the search and match process on
the suspense table. Note that the process only flags the data,
 according to the parameters you set up, which tells the posting
process to create a new person, update an existing person,
 or ignore the incoming data. However, the process does not
create a new person or update an existing person until you post
the data.

TS189 Post Processing Parms

Field or Control Description

Process Single Record Select this option to process and post a single record. After
you select this, select the appropriate record you want to post.
 If you prefer to process the entire staging table, do not select
this option.

Data Source Select the data source that you want the process to assign to
any transcript information that posts to your database. The
default is School. You can select a different value. Values for
this field are delivered with your system as translate values.
 You can modify these translate values.

Update IPEDS Ethnicity Flag

Field or Control Description

For New Person Records Added Select this option to instruct the TS189 Post program to check
the IPEDS flag for each row on the Ethnicity page in Campus
Community only for new person records added to the system.

For All Person Records Posted Select this option to instruct the TS189 Post program to check
the IPEDS flag for each row on the Ethnicity page in Campus
Community for both new and updated EMPLIDs.

Related Links
Posting the EDI TS130 External Data

Setting Up Additional Post Parameters for EDI TS189 External Data
Access the Post Parameters 2 page (Student Admissions > Application/Transcript Loads > TS189 >
Search/Match/Post Process > Post Parameters 2).
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This example illustrates the fields and controls on the Post Parameters 2 page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Contact Type Select the contact type to enable the posting of new
organization and organization contact information that is
loaded with the TS189 file.

External Career and Summary Type These are cross reference fields that work in conjunction with
external academic summary data from incoming applications.
The two fields enable the posting of external GPAs to students'
external education records (external GPA is tied to summary
type, which is a child of external career). External career data
is loaded with the TS189 file. By defining desired summary
types for each external career that has been loaded, the TS189
PeopleSearch/Post process writes external career, summary
type, and external GPA data to the external education record.

Institution,  Academic Career, Material Group,  and Matl
Type  (material type)

These fields enable the posting of recommendation material
group information. Select material groups that represent
recommendations and the recommendation material type.
 Recommendation material group information gets posted
to the general materials page. Define material groups on the
Material Group Table page.

Purging the TS189 Staging Table and Messages

This section discusses how to use the EDI TS189 Purge Parms (EDI TS189 purge parameters) page to
purge records and messages, if applicable, from the EDI TS189 staging table.
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Page Used to Purge the EDI TS189 Staging Table and Messages

Page Name Definition Name Navigation Usage

EDI TS189 Purge Parms (EDI
TS189 purge parameters)

ADM_TS189_PUR_PARM Student Admissions >
Application/Transcript
Loads > TS189 > Purge
Process

Purge records and messages,
 if applicable, from the TS189
staging table.

Purging the EDI TS189 Staging Table and Messages
Access the EDI TS189 Purge Parms page (Student Admissions > Application/Transcript Loads >
TS189 > Purge Process).

TS189 Purge Processing Parms

Field or Control Description

All Suspense Rows Select this option if you want to purge all records in your
staging table, regardless of what is in the Post field on the
Process Options and Org Process Options pages.

Marked Test Suspense Rows Select this option if you want to purge only those records
in your staging table marked Purge in the Post field on the
Process Options and Org Process Options pages.

TS189 Msg Purge Process Parms

Field or Control Description

Retain Associated Messages Select this option if you do not want to purge messages
associated with the files that you are purging.

Remove Associated Messages Select this option if you want to purge messages associated
with the files that you are purging.

Click the Run button to run the EDI TS189 Application Purge process at user-defined intervals.
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Processing External Test Scores

Understanding External Test Score Data Processing

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

The ability to receive external test score data and post it to your database is integral to recruiting and
evaluating applicants. Academic institutions receive hundreds, if not thousands, of test scores each year.
Using your Recruiting and Admissions application, you can receive external test score data, review the
data for errors, and post the data, confident that you are not creating duplicate IDs. You can also post test
score data to PeopleSoft CRM and have the post process create prospect records directly in CRM.

Recruiting and Admissions supports loading many test scores, such as the ACT, ADA, AMCAS, AP,
CRS, DAT, EOS, GMASS, GMAT, GRE, LSAT/LSDAS, SAT, SSS and TOEFL. The ultimate goal in
processing external test score data is to update test score data for individuals through electronic data
loads. Your institution receives tapes that contain scores, bio/demo, and sometimes transcript data for
individuals. For each test, you first load the data into suspense tables. Then, you ensure that you are not
going to create any duplicate bio/demo or test records. (It's very hard to identify and correct duplicate
records after they've been created.) Finally, you post the bio/demo and test score data to your database.
(The search/match/post process posts self-reported academic information to test score candidate data
tables.) You follow this process for each test.

Regardless of the test, the same components are used to load, view, and post test score data. The ID of
the test that you are processing must be entered on each component. The entry of the test ID determines
which fields appear on each page. The test IDs shown in the prompt are based on your test ID security.
You must have test ID security defined in order to process external test scores.

To process external test score data:

1. Load the test score data from a file in your directory into a suspense table using the External Test
Score Load Application Engine (SAD_TST_LOAD ) process.

2. Review and edit the data that you loaded in suspense pages.

Correct all load errors before moving on to the next step. In the search dialog page of the suspense
component, enter the test ID, Error in the Edit Processing Option field and click the Search
button. Access each suspense record and correct the errors until every suspense record has a value of
Complete (rather than Error) in the Edit field on the Test Score Suspense Data page.

3. After you have corrected all of the load errors, run the Search/Match/Post Test Scores Application
Engine (SAD_TEST_PST) process.
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This process looks for data in your database (based on search parameters that you define on the
search/match criteria pages, for example, name, social security number, and birth date) that matches
the data that you are posting. For a set of parameters that suggest only a possible match (such as name
and gender, for example), the process will not post the record until you can manually determine which
records are actually duplicates. You can also choose to create prospect records and assign 3Cs during
the post process.

You can post the test scores to either Campus Solutions or PeopleSoft CRM (if you have installed
PeopleSoft CRM) . The External Test Score Mapping page indicates which test scores can be posted
to CRM. You can post the following the test scores to CRM: ACT, AP, CRS, DAT, EOS, GMAT,
GMASS, GRE, LSAT, SAT, SSS and TOEFL. The following the test scores cannot be posted to CRM:
ADA, AMCAS, LSDAS, NCEA, OUAC, QTAC, SATAC, Studielink, UAC, and VTAC. If you post
the test scores to CRM, the Search/Match/Post Test Scores process automatically creates prospect
records in CRM.

4. View each suspense record that did not get posted and confirm that it is actually a duplicate.

In the search dialog page of the suspense component, enter the test ID, Complete in the Edit Process
Option field and Perform in the Search/Match Process Option field. Then click the Search button.
The search process finds only those suspense records that went through the search/match/post
process but did not get posted. The reason the search/match/post process did not post the records is
because it found a possible duplicate record in the database. After you access the component, find the
parameters for which the process identified a match, then use Search Match to look up the bio/demo
information that matches the suspense record and decide on your own whether a person who matches
the incoming data already exists in the system. Then, specify whether you want the search/match/post
process to add the bio/demo and test record to your database, update an existing record, or ignore the
suspense record altogether.

5. Run the Search/Match/Post Test Scores process again.

The process posts the suspense records that you manually tagged to post. By this time, all of your
suspense records should be posted to your database. When a record posts to your database, the search/
match/post process assigns an ID to the person. To view a bio/demo record that the search/match/
post process created, select Student Recruiting > External Test Score Processing > Add/Update
a Person or Student Admissions > External Test Score Processing > Add/Update a Person. 
To view a test score record that the search/match/post process created or updated, select Student
Recruiting > External Test Score Processing > Test Results or Student Admissions > External
Test Score Processing > Test Results.

6. Purge the suspense tables.

You should purge the suspense tables as soon as all of the suspense records have been posted to the
database. This helps to avoid confusion the next time that you load data into the suspense tables.

7. (Optional) Review test score candidate data.

When external test score loads contain additional information about the student, such as academic
interests, extracurricular activities, and prior schools attended, the search/match/post process stores
the data in the Test Score Candidate Data component.

The process does not store candidate data if you post the test scores to PeopleSoft CRM.

8. (Optional) Create prospects from tests.
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Create prospects from posted test scores using query manager to define a specific population.

See Understanding Creating Prospects from Test Scores with Query.

9. (Optional) Create applicants from tests. Create applications for posted ADA, AMCAS, or LSAT/
LSDAS tests.

See Pages Used to Create Applications from External Test Score Data.

Related Links
Reviewing Test Score Candidate Data
"Understanding CRM for Higher Ed" (Campus Solutions Application Fundamentals)

Loading External Test Score Files

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

To run an external test score load process, you must enter the directory path where the test data file is
located (such as \\network\test files\ACT_1.dat). The process loads the data from the file into suspense
tables.

This section lists prerequisites and discusses how to set up load parameters and load the file.

Prerequisites
Before you load external test scores, you must:

1. Set up tests and test components.

2. Set up test ID security for all appropriate users.

3. Configure the External Test Load Mapping page.

4. Configure the Ethnic Group Mapping page.

5. Configure Country Mapping if applicable to the test score being loaded.

See Pages Used to Create Applications from External Test Score Data.
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Page Used to Load External Test Score Files

Page Name Definition Name Navigation Usage

External Test Score Load SAD_TEST_LOAD • Student Recruiting >
External Test Score
Processing > External
Test Score Load

• or Student
Admissions > External
Test Score Processing >
External Test Score
Load

Designate the directory
location of the test scores that
you are loading and enter the
load parameters for that test.

Note: You should complete
the full loading, search/match
and posting process before
loading a new set of data. If
you have test scores waiting
to be processed, such as ACT
test scores, do not load a new
ACT test score file until you
have processed the data in
your ACT suspense files.

Setting Up Load Parameters and Loading the File
Access the External Test Score Load page (Student Recruiting > External Test Score Processing >
External Test Score Load or Student Admissions > External Test Score Processing > External Test
Score Load).
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This example illustrates the fields and controls on the External Test Score Load page (1 of 2). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the External Test Score Load page (2 of 2). You can
find definitions for the fields and controls later on this page.

Test ID

Field or Control Description

Test ID Select the test that you want to load. Define test ID values
on the Test Tables page. Once the Test ID is entered, the
additional fields specific to the test will appear. You must have
Test ID Security established in order to select a value. This
field is required.
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Test Score Input File Name

Field or Control Description

Test Score Input File Name Enter the path of the directory and file where the test data
resides. This field is required.

For the ADA test only:

In the AADSAS field, enter the name of the directory and
file where the AADSAS data resides. This file contains the
biographical, parent and family, secondary school, personal
statement, release statement, and test score information.

In the AADSAS (Courses Completed) field, enter the name
of the directory and file where the list of completed courses
resides.

In the AADSAS (Courses Planned) field, enter the name of
the directory and file where the planned or in-progress list of
courses resides.

In the AADSAS (College) field, enter the name of the
directory and file where the list of attended colleges resides.

In the AADSAS (GPA) field, enter the name of the directory
and file where the GPA data resides.

In the AADSAS (GPA per College) field, enter the name of
the directory and file where the GPA summary for each college
resides.

In the AADSAS (GPA per Session) field, enter the name of
the directory and file where the GPA summary for each session
resides.

Name Prefix

Field or Control Description

Male, Female, and Unknown Test score loads do not include name prefixes. They do,
 however, include gender. Select the prefix according to the
gender provided in the test data load. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are Dr, Miss, Mr,  Mrs, and Ms.

Test Parameters

The test components appear based on the test ID that you entered. For example, ACT has seven
components as part of its test, but LSAT reports only one component. After the Test ID field is populated,
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enter the test component corresponding to each test parameter listed. The prompt in test parameters
displays only the test components for the test ID. Test components are mapped to the test ID on the Test
Table page. You may leave these fields blank for EOS, GMASS, and SSS. The Test components must be
entered for all other tests.

See Understanding External Test Score Loads Setup

Field or Control Description

Score  and Percentile For EOS, GMASS, and SSS only: For each test component,
 enter the score and percentile that you want to appear for all
of the EOS, GMASS, and SSS records that you load. EOS,
 GMASS, and SSS are search tapes and do not deliver test
scores. If you used test scores or percentiles as part of your
criteria when purchasing the search tape, you have the option
of entering that information on the page. The scores and
percentiles will be posted for each person on the search tape.
 You may leave these fields blank.

Mapping Additional Test Codes

For AP, SAT, and SSS only: These tests require that you map additional test codes for the test. To
begin, click the button to retrieve the test codes for the test ID. The left column is the delivered test
code. This is the code that the testing organization defines. (To view the delivered codes, select Set Up
SACR > Product Related > Recruiting and Admissions > External Test Scores and then choose the
component that you want to review.) The right column is the corresponding component that you defined
on the Test Component page and mapped to the test ID on Test Table page. Select the test component that
corresponds to the delivered test code.

Other Parameters

Field or Control Description

Test Date, Test Day, Test Month, Degree Day, Graduation
Day. and Graduation Month

The PeopleSoft date format requires a day, month, and year.
 If the date format for a test omits one of these numbers, the
system asks you to enter the numeric value for the missing
number (such as day, month, or graduation day) that you
want the load process to use when it converts the date to
the PeopleSoft date format. This also allows the program to
populate the Degree Date and Graduation Date  information
to the prospect record if you select the Create Prospect field
on the Search/Match/Post Test Scores page. Values for Test
Day,  Degree Day, and Graduation Day  are 1 through 28.
Values for Test Month  and Graduation Month are 1 through
12.

LSAT/LSDAS Test Score For LSAT/LSDAS only: Select LSAT or LSDAS to indicate the
type of file that you are loading.
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Field or Control Description

Score/Test Type For ADA only: Select USA or CAN to indicate if the test
is administered for the United States or Canada. The test
components on the page change based on the option that you
select.

SAT I Search, PSAT/NMSQT Search, or AP Search For SSS only: Your institution can buy the names of students
who have either taken the SAT I, PSAT/NMSQT, or AP
exams. Select the search tape that you are loading. The format
of the file varies according to the test that you are loading.

School Tape Type For SAT only: Select the type of file that you're loading:
College or Secondary. The default is College. The format of
the file varies between the two school tape types.

Initial or Full For DAT only: Select one of these options to determine
whether to have the system load the student's middle name
initial or the full middle name. The default setting is to load
the middle initial.

Correcting and Editing Data in the Suspense Record

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

This section provides an overview of the correcting and editing of suspense data and discusses how to
review:

• Test score suspense data.

• Personal information.

• Test score data.

Understanding the Correcting and Editing of Suspense Data
You edit information in the suspense record. However, remember that the search/match/post process only
posts bio/demo data and test score data to your database. The system stores additional data that the test
loads contain in the Test Score Candidate Data component. This data does not affect other tables in your
database.
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Before entering the External Test Score Suspense component, you must enter the test ID and at least one
other search criteria. The pages in the component dynamically appear based on the test ID that you enter.
The pages in the component are similar in the way that they look and work. For example, every suspense
component has a Personal Information page and a Tests page. In addition, they all share the first page:
the Test Score Suspense Data page. Some testing agencies ask questions about college preferences, high
school activities, and transcript information. Independent of the testing agency, core, and supplemental
data are handled similarly within the system.

Much of the data that is loaded into the suspense record is data that the person entered when completing
the student profile section of the test. If the person left out information or did not complete the entire
section, there will be empty fields in the suspense component.

Many of the values and codes that appear in the suspense component are based on values and codes that
the testing agency defines. Contact the testing agency that manages the test for full descriptions of the
data that appears in these pages or refer to the test score layouts that you receive from the testing agency.

Correcting Load Errors

An error is indicated on the External Test Score Suspense component when certain values are missing or
invalid. You will see an error flag for First Name or Last Name if the value is not populated. In addition
an error flag will appear for the following data if it is invalid for the test ID entered: Birthdate, Graduation
Date, Test Date, Test Component, Country, Subject Test Code, and Degree Date. An invalid test score is
a score that is outside the valid test score range according to the ranges that you defined on the Test Table
page. The program validates the country for every test where a country code is received. The country
code is validated against the PS Country table, with the exception of ADA, AMCAS, AP and SAT which
have their own country mapping tables. Find the field that contains the missing value and enter a valid
value. You can find the First Name, Last Name, and Birthdate fields on the Personal Information page,
and the Test Date and Test Component fields on the Tests page. For other error indicators, look through
the suspense component to find the corresponding field and enter a valid value.

After you enter a valid value for the fields that were missing or incorrect, save the component. The Edit
field on the Process Options page should now display Complete.  Be sure to correct all errors before
posting the data.

Note: Data in suspense tables does not affect tables in your database until you post the data by running
the search/match/post process. In addition, if you find an error in the suspense component after you run
the search/match/post process, you must go to the proper page in your database to make any changes. For
example, if you found an error on the Personal Information page in the suspense component, you must go
to the Add/Update a Person component in the External Test Score Processing menu to correct the error.

Related Links
"Using Search/Match" (Campus Community Fundamentals)

720  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 23 Processing External Test Scores

Pages Used to Correct and Edit Data in the Suspense Record

Page Name Definition Name Navigation Usage

Test Score Suspense Data SAD_SUSP_PROC_OPTN • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Test Score Suspense
Data

• Student
Admissions >External
Test Score
Processing >External
Test Score
Suspense >Test Score
Suspense Data

View and correct load
process results and test score
messages. This page appears
for every test ID.

Personal Information SAD_ACT_SUS_BIO

SAD_ADA_SUS_BIO

SAD_AMC_SUS_BIO

SAD_AP_SUS_BIO

SAD_CRS_SUS_BIO

SAD_DAT_SUS_BIO

SAD_EOS_SUS_BIO

SAD_GMS_SUS_BIO

SAD_GMT_SUS_BIO

SAD_GRE_SUS_BIO

SAD_LAW_SUS_BIO

SAD_SAT_SUS_BIO

SAD_SSS_SUS_BIO

SAD_TFL_SUS_BIO

• Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Personal Information

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Personal Information

Review and edit the student's
personal information in the
suspense record. Refer to the
data layouts from the testing
agency to determine the fields
that will appear. Each test has
a Personal Information page.
 The data varies depending on
the test ID.
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Page Name Definition Name Navigation Usage

Tests SAD_ACT_SUS_TST

SAD_ADA_SUS_TST

SAD_AMC_SUS_TST

SAD_AP_SUS_TST

SAD_CRS_SUS_TST

SAD_DAT_SUS_TST

SAD_EOS_SUS_TST

SAD_GMS_SUS_TST

SAD_GMT_SUS_TST

SAD_GRE_SUS_TST

SAD_LAW_SUS_TST

SAD_SSS_SUS_TST

SAD_TFL_SUS_TST

• Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Tests

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Tests

Review or edit test data in
the suspense record. Some of
the information on this page
is required (such as test date
and test components). If this
information is missing in the
external test data load, you
must enter valid values here
before posting the record.
 Refer to the data layouts
from the testing agency to
determine the fields that will
appear. Each test has a Tests
page, with the exception
of SAT. The data varies
depending on the test ID.

Academics SAD_ACT_SUS_SPS • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Academics

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Academics

For ACT only: Review or
edit academic data in the
suspense record. Refer to the
data layouts from ACT to
determine the fields that will
appear.

Note that the same changes
have been made to the
corresponding candidate
data page (SAD_ACT_CD_
ACAD). ]

Activities SAD_ACT_SUS_COL • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Activities

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Activities

For ACT only: Review and
edit activity information in
the suspense record. Refer to
the data layouts from ACT to
determine the fields that will
appear.
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Page Name Definition Name Navigation Usage

Interests SAD_ACT_SUS_INT • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Interests

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Interests

For ACT only: Review
and edit interest data in the
suspense record. Refer to the
data layouts from ACT to
determine the fields that will
appear.

Education SAD_ADA_SUS_OTH • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Education

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Education

For ADA only: Review
and edit education data in
the suspense record. Refer
to the data layouts from
Associated American Dental
Schools Application Service 
(AADSAS) to determine the
fields that will appear.

Courses SAD_ADA_SUS_CRS • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Courses

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Courses

For ADA only: Review and
edit course detail information
in the suspense file. Refer
to the data layouts from
AADSAS to determine the
fields that will appear.

Applicant Data SAD_ADA_SUS_ADDL

SAD_AMC_SUS_OTH

• Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Applicant Data

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Applicant Data

For ADA only: Review and
edit applicant data in the
suspense record. Refer to the
data layouts from AADSAS to
determine the fields that will
appear.
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Page Name Definition Name Navigation Usage

Family Information SAD_ADA_SUS_FAMILY • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Family Information

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Family Information

For ADA only. Review and
edit the family information
data in the suspense record.
 Refer to the data layouts
from AADSAS (Associated
American Dental Schools
Application Service) to
determine the fields that will
display.

Essays SAD_ADA_SUS_ESSAY • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Essays

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Essays

For ADA only. Review and
edit the personal statement
data in the suspense record.
 Refer to the data layouts from
AADSAS to determine the
fields that will display.

Colleges SAD_AMC_SUS_COL • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Colleges

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Colleges

For AMCAS only: Review
and edit college data in
the suspense record. Refer
to the data layouts from
American Association of
Medical Colleges (AAMC) to
determine the fields that will
appear.

GPA/Hours SAD_AMC_SUS_GPA • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
GPA/Hours

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
GPA/Hours

For AMCAS only: Review
and edit undergraduate
education data in the suspense
record. Refer to the data
layouts from AAMC to
determine the fields that will
appear.
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Page Name Definition Name Navigation Usage

Schools SAD_AP_SUS_SCH • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Schools

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Schools

For AP only: Use the Schools
page to review and edit school
data in the suspense record.
 Refer to the data layouts from
Educational Testing Service 
(ETS) to determine the fields
that will appear.

Awards SAD_AP_SUS_PREV

SAD_SSS_SUSP_SDQ

• Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Awards

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Awards

For AP and SSS only:
Review and edit additional
question information in the
suspense record. Refer to
the data layouts from ETS to
determine the fields that will
appear.

Additional Information SAD_CRS_SUS_ACI • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Additional Information

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Additional Information

For CRS only: Review and
edit additional information
in the suspense record. Refer
to the data layouts from Law
School Admission Council 
(LSAC) to determine the
fields that will appear.

Profile Data SAD_GRE_SUS_PRFL • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Profile Data

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Profile Data

For GRE only: Review
and edit profile data in the
suspense record. Refer to
the data layouts from ETS to
determine the fields that will
appear.
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Page Name Definition Name Navigation Usage

Prior Schools SAD_LAW_SUS_MTR • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Prior Schools

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Prior Schools

For LSAT/LSDAS only:
Review and edit prior schools
attended in the suspense
record. Refer to the data
layouts from LSAC to
determine the fields that will
appear.

Candidate Data SAD_LAW_SUS_ACI • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Candidate Data

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Candidate Data

For LSAT/LSDAS only:
Review and edit candidate
data in the suspense record.
 Refer to the data layouts from
LSAC to determine the fields
that will appear.

Recommendations SAD_LAW_SUS_REC • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Recommendations

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Recommendations

For LSAT/LSDAS
only: Review and edit
recommendation data in the
suspense record. Refer to the
data layouts from LSAC to
determine the fields that will
appear.

Academics SAD_LAW_SUS_SCH • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Academics

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Academics

For LSAT/LSDAS only:
Review and edit academic
data in the suspense record.
 Refer to the data layouts from
LSAC to determine the fields
that will appear.
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Page Name Definition Name Navigation Usage

SAT I SAD_SAT_SUS_SATI • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
SAT I

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
SAT I

For SAT only: Review
and edit SAT I data in the
suspense record. Refer to
the data layouts from ETS to
determine the fields that will
appear.

SAT II SAD_SAT_SUS_SATII • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
SAT II

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
SAT II

For SAT only: Review
and edit SAT II data in the
suspense record. Refer to
the data layouts from ETS to
determine the fields that will
appear.

Student Data SAD_SAT_SUS_SDQ

SAD_SSS_SUS_SDQ

• Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
Student Data

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
Student Data

For SAT and SSS only:
Review and edit student data
in the suspense record. Refer
to the data layouts from ETS
to determine the fields that
will appear.

School Data SAD_SAT_SUS_SDQ2 • Student Recruiting >
External Test Score
Processing > External
Test Score Suspense >
School Data

• Student Admissions >
External Test Score
Processing > External
Test Score Suspense >
School Data

For SAT only: Review
and edit school data in the
suspense record. Refer to
the data layouts from ETS to
determine the fields that will
appear.

Reviewing Test Score Suspense Data
Access the Test Score Suspense Data page (Student Recruiting > External Test Score Processing >
External Test Score Suspense > Test Score Suspense Data or Student Admissions >External Test
Score Processing >External Test Score Suspense >Test Score Suspense Data).
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This example illustrates the fields and controls on the Test Score Suspense Data page. You can find
definitions for the fields and controls later on this page.

This page provides the status of a suspense record regarding the loading, search/match and posting
processes.

Any informational and error messages that external test data load and search/match/post processes
generate appear on this page. You can use this page to keep current on the status of an individual's test
score processing. These messages can serve historical and analytical purposes, giving you a picture of the
kinds of errors encountered in your test score processing. To do so, you would need to wait to purge your
test score messages until you have completed your analysis.

Processing Options

Field or Control Description

Edit Displays the status of the load process for this suspense record.
 The load process populates this value.

Complete: The load process loaded the test score data without
a problem. This record is ready to be posted.

Error: The load process encountered problems when loading
the test score data. The system indicates the values that you
must correct in the Error Indicators group box. Correct all
errors and save the data before running the search/match/
post process on this record. After you correct the errors and
save the component, the system changes the field value to
Complete.

Perform: You set this value manually. This is for informational
purposes only.
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Field or Control Description

Search Displays the status of the search/match process for this
suspense record. The search/match process populates this
value.

Complete: The search/match process completed successfully.

Error: The search/match process encountered problems. Refer
to the log file for information regarding the error.

Perform: The search/match process will process this record the
next time that you run the process.

Post Displays the status of the record regarding the search/match/
post process. You can enter these values manually; however,
 some are entered by the system after processes are run, as
described in the following table. If the process created a
new person in your database, the process generates an ID
for the person and displays it in the ID field on the page. If
the process updated an existing person's record, the process
displays the ID that was updated in the ID field on the Bio/
Demo page.

Post Value Meaning How Set

Error The posting process encountered a
problem.

Set by the system during the search/
match/post process.

New ID Add The system was unable to find a match in
the database and will add a record with
a new ID to your database when you run
the search/match/post process.

When set manually, this value means
that the process identified a match and
the user determined manually that no
duplication exists. When the user runs
the search/match/post process again,
 the process creates a new record and
generates an ID, which it displays in the
ID field on the Personal Information
page.

Set by the system during the search/
match process if no match was found
in your database (only when you run
search/match and post and different
times).

Set manually.

No Action Search/match/post and purge suspense
file processes will ignore the record if
this value is entered.

Set manually.
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Post Value Meaning How Set

Purge Indicates that this suspense record will
be removed from the system during the
purge suspense file process.

Set by the system during the search/
match/post process if the record was
successfully processed.

Update ID The search/match/post process found a
matching ID in the database. The process
will update the matching records with the
data from this suspense record.

When set manually, means that the
process identified a match, and the user
determined manually that duplication
exists. The system makes available the
ID field on the Personal Information
page. Select the ID that you want the
search/match/post process to update. You
must save the page and run the search/
match/post process to update the record.

Set by the system during the search/
match process if a match was found
in the database and if your search
parameters define that an update should
occur in this situation (only when you
run search/match and post and different
times).

Set manually.

Awaiting Search/Match This record is in the suspense file and is
waiting to be processed by the search/
match/post process.

Set by the system during the load
external data process.

Note: While you can manually edit the values in the Edit, Search, and Post fields, keep in mind that
if a field contains Error and you manually change it without correcting an error, you may experience
problems when posting the data.

Error Indicators

Field or Control Description

Last Name, Test Date,Birth Day, First Name, Graduation
Date, High School Graduation Date, and Test Component

When a load error occurs, the load external data process
displays the required values that were missing or incorrect in
the load. Go to the Personal Information page, the Tests page,
 or another page in the Suspense component where the missing
or incorrect data resides to enter a valid value. When you
correct the error, the system clears the check box and the fields
will no longer appear. After all of the check boxes are cleared
and the component is saved, the system displays Complete in
the Edit field.
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Search/Match Results

Field or Control Description

Order Number You know that the search/match/post process found a match
and did not post the suspense record when the Search field
contains Perform and displays the search order number that led
to the match in the Order Number field. Use this information
to decide whether a possible duplicate exists.

Matches Displays the number of matches that the process found at the
order number given.

Messages

Field or Control Description

Message Severity The message severity, such as Message or Error.

Message Text The message on this row of data.

Description The detailed message.

Comments Results or other additional information about the message.

Process Instance The process number of the process that you ran for this record.
 Process Scheduler generates this number.

Run Date/Time The day and time that the process ran for this record.

Process Name The name of the application engine that you ran for this
record (for example, in the previous page example, the
messages displayed from running SAD_TST_LOAD
application engine, which is the External Test Score Load
process).

User ID The user ID of the person who ran the process.

Reviewing Personal Information
Access the Personal Information page (Student Recruiting > External Test Score Processing >
External Test Score Suspense > Personal Information or  Student Admissions > External Test
Score Processing > External Test Score Suspense > Personal Information).
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This example illustrates the fields and controls on the Personal Information page (1 of 2). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Personal Information page (2 of 2). You can find
definitions for the fields and controls later on this page.

Use Personal Information page in the suspense component to review and edit biographical and
demographic data loaded through the external test data load. Use this page to edit the person's last name,
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first name, and birth date, if the external data load omitted these values. The data varies depending on the
test ID. Common fields are described in this section.

When the search/match/post process posts the data in the suspense record, the process posts much of this
data to the newly created personal information record.

Note: If the search/match/post process finds a match and updates the existing record with the data in the
suspense file, the process does not update the personal information. This prevents you from overriding
verified information.

Field or Control Description

Record Number Displays the test record number. This number is automatically
populated based on the Installation parameters.

Date Loaded Displays the date that you loaded this record.

Last Name, First Name, and Middle Initial Displays the person's last name, first name, and middle initial
or middle name, as they appear in the test record. If the Last
Name or First Name fields are empty, enter values.

ID This field is unavailable until you run the search/match/post
process. The search/match/post process generates an ID and
displays it here when the process creates a new record.

If the process finds a match and updates an existing record, the
process enters the ID of the record that it updated.

If the process finds a match and retains the record in the
suspense table, and you decide to update an existing ID (by
selecting Update ID in the Post field on the Process Options
page), a prompt becomes available. Click the prompt to select
the ID that you want to update.

Birthdate Displays the person's birth date after the load process converts
it to the PeopleSoft date standard from the birth date reported
on the test.

Name Prefix Displays a name prefix, according to the gender from the test
record and the prefix criteria that you set up on the External
Test Score Load page.

Gender The person's gender. The load process converts the person's
gender as reported in the test record to the corresponding
PeopleSoft gender code.

Ethnic Group Displays the person's ethnic group. The load process converts
the person's ethnicity code as reported on the test record to
the corresponding PeopleSoft ethnic group. This value is
populated based on the Ethnic Group Mapping page. This
setup must be done for the Test ID indicated or a value will not
appear.
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Field or Control Description

SSN (social security number) Displays the person's social security number after the load
process converts it to the PeopleSoft standard from the social
security number reported on the test.

Address 1, Address 2, City, State, Country, and Postal
Code

Displays the person's address. The load program validates the
country for every test where a country code is received. The
country code is validated against the PS Country table, with
the exception of ADA, AMCAS, AP and SAT which have
their own country mapping tables.

Telephone Displays the person's telephone number.

Citizenship Status Displays the person's citizenship status. This value is
populated based on the conversion of the data from the test
record to a PeopleSoft value. Values for this field are delivered
with your system as translate values.

Reviewing Test Score Data
Access the Tests page (Student Recruiting > External Test Score Processing > External Test Score
Suspense > Tests or Student Admissions > External Test Score Processing > External Test Score
Suspense > Tests ).
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This example illustrates the fields and controls on the Tests page. You can find definitions for the fields
and controls later on this page.

Field or Control Description

Test Date Displays the day that this person took the test. The load
process converts the test date delivered with the test to the
PeopleSoft format, which appears here. The search/match/post
process posts the test date to your database when you run the
process for this suspense record.

Test ID Displays the ID of the test taken by this person. Define test
IDs on the on the Test Tables page. The test ID is entered as a
parameter during the load process.

Post The load process selects this check box if the score and
component are valid. You can post the score for this
component.
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Field or Control Description

Error The load process selects this check box if it encounters an
error with either the component or the score during the load
process. You can view additional information about this error
on the Test Score Suspense Data page. The error must be
cleared in order for the component and score to post to Test
Results. Once the specific error is corrected, the Error check
box is cleared and the Post check box is selected.

Test Component Displays the test components that you selected on the External
Test Score Load page for the test ID.

Score and  Percentile Displays the reported score and percentile for each component 
(if applicable).

Performing the Search/Match Process and Posting External Data

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

This section provides an overview of performing search/match and posting test scores and discusses how
to:

• Process search/match/post test scores.

• Set up search/match parameters for test score data.

Understanding Performing Search/Match and Posting Test Scores
The search/match/post process consists of two separate processes that complement each other. The search/
match process uses data from the suspense record to determine if the person might already exist in your
database. The purpose of the search/match is to prevent duplicate records. Duplicate records are difficult
to find and delete after they have been created. The post process uses the data in the suspense record to
create persons if they do not already exist and to create or update test score data based on the search/
match results. The post process also creates or updates test score candidate data.

You can specify what you want the post process to do when search/match finds a match (or multiple
matches). Based on the results of the search/match process, the post process can update the record in your
database that matches the suspense record if you are sure that the person in your database is the same
person to whom the test data relates. For example, if the search/match process found a matching social
security number, you might be confident that this is the same person, so the post process could update
the record automatically. You can also define search/match parameters that tell the post process to wait
on posting the record. This enables you to review the record and decide manually if it matches a record
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already in your database. For example, you would want to check whether duplication exists if the only
parameters that matched were name and gender.

If the search/match process does not find a match, and you selected the Add option for the New parameter
on the Search Parameters page, the post process populates data from the suspense record to your database.
Data from the suspense records post to the Add/Update a Person component, the Test Results component,
and the Test Score Candidate Data component. After you post suspense data, you must use these
components to edit the information.

You can perform the search/match and post processes separately, or you can perform them together. You
should run the search/match and post processes in one step. This ensures that you process the records in
the correct order.

You might run the search/match/post process more than once for a suspense record. If the search/match/
post process finds possible matches in the suspense table, you must manually determine whether a match
exists and then run the process again.

You can also create prospect records for all students for whom you post external test data. Before you
create prospects as part of the search/match/post process, you can optionally configure test ID mapping
options for academic interests, extracurricular activities, religious preference, admit terms, and program,
plan and subplan. You can also define event IDs for 3Cs.

Pages Used to Perform the Search/Match Process and Posting External
Data

Page Name Definition Name Navigation Usage

Search/Match/Post Test
Scores

SAD_TEST_POSTS • Student Recruiting >
External Test Score
Processing > Search/
Match/Post/Test Scores

• Student Admissions >
External Test Score
Processing > Search/
Match/Post Test Scores

Post external test data from
suspense files. Before you
post the data, however, set up
the search/match parameters
on the Search Parameters
page. You can post a single
record or all of the records in
the suspense file. You can also
create prospect records from
this data.

Search Parameters SEARCH_PARMS • Student
Recruiting >External
Test Score
Processing >Search/
Match/Post/Test
Scores >Search
Parameters

• Student
Admissions >External
Test Score
Processing >Search/
Match/Post Test
Scores >Search
Parameters

Use this page to set up your
search/match parameters.
 These are the rules that
determine what the post
process should do with the
suspense record after the
search/match process is
complete. This page is the
same for each Test ID entered
on the Search/Match/Post Test
Scores page.
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Processing Search/Match/Post Test Scores
Access the Search/Match/Post Test Scores page (Student Recruiting > External Test Score
Processing > Search/Match/Post/Test Scores or Student Admissions > External Test Score
Processing > Search/Match/Post Test Scores).

This example illustrates the fields and controls on the Search/Match/Post Test Scores page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Test ID Enter the test ID that you want to process. Once you enter the
test ID, the additional fields specific to the test will appear.
You must have Test ID Security established in order to select a
value. The prompt will display only test IDs to which you have
security to access. This field is required.

LSAT/LSDAS Test Score

The system displays this group box if you have selected the CRM for Higher Education check box on the
SA Features page and if the test ID is LSAT.
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Field or Control Description

LSAD Test Score The system does not display the Post To group box if you
select this option. You cannot post LSAD test scores to CRM.

LSAT Test Score The system displays the Post To group box if you select this
option. You can post the LSAT test scores to CRM.

Execution Option

Field or Control Description

Search, Match and Post Select this option if you want the process to search your
database for records that match the suspense record and post
the suspense data to your database. This is the recommended
option.

Post Only Select this option if you want only to post the suspense data to
your database (if you select this option, you must have already
run search/match or manually changed the Search and Post
process options on the External Test Score Suspense page).

Search and Match Only Select this option if you want to only run the search and match
process on the suspense file. You will need to post the data at a
later time.

Post To

Field or Control Description

Campus Solutions Select this option if you want to post the suspense data to
Campus Solutions.
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Field or Control Description

Enterprise CRM Select this option if you want to post the suspense data to
PeopleSoft CRM.

The system displays this option if you have selected the CRM
for Higher Education check box on the SA Features page
of the Student Admin Installation component and if the test
ID is eligible for posting to CRM. If the test ID is eligible
for posting to CRM, the system displays the Available for
CRM Post check box as selected on the  External Test Score
Mapping page (Set Up SACR, Product Related, Recruiting
and Admissions, External Test Scores, External Test Score
Mapping).

Important: If you have opted to post to CRM and if there is no matching person record in Campus
Solutions, the process does not create a EMPLID or any record in Campus Solutions. The process will
only send the test score and prospect data as a message to Integration Broker. If you have opted to post to
CRM and if there is a matching person record in Campus Solutions, the process adds a new record in the
Test Results page for the EMPLID (Student Recruiting, External Test Score Processing, Test Results or
Student Admissions, External Test Score Processing, Test Results) in addition to sending the message to
Integration Broker.

Ethnicity Update Rules

For ACT, LSAT/LSDAS, AMCAS only:

Field or Control Description

Update All Records Select this option if you want the process to post the ethnicity
data to the ethnicity records (DIVERS_ETHNIC and
ETHNICITY_DTL) for all existing EMPLIDS. The posted
ethnicity data can be viewed on the Ethnicity page (Campus
Community, Personal Information, Biographical, Personal
Attributes, Ethnicity) or on the Regional page of the Add/
Update a Person component (Campus Community, Personal
Information or Personal Information (Student), Add/Update a
Person).

If you select this option and if data already exists for an
EMPLID on the ethnicity records, the process inserts a new
row into the records for the EMPLID. If the Ethnic Group of
NSPEC is currently populated on either ethnicity record, new
rows will not be inserted.

Update If Not Populated Select this option if you want the process to post the ethnicity
data only for those EMPLIDS who do not have existing
ethnicity data.
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Set Hispanic/Latino Indicator

For LSAT/LSDAS only:

Field or Control Description

Hispanic/Latino Populated Select this option if you want the process to check the Person
is Hispanic or Latino check box on the Ethnicity or Regional
page (HISP_LATINO = Y for a DIVERS_ETHNIC record).

If you select this option, the process checks the Person
is Hispanic or Latino check box if the person's test score
ethnicity data is mapped to an Ethnic Group with the EEO
Ethnic Category of Hispanic/Latino (Ethnicity or Regional
page displays EEO Ethnic Category as the Ethnic Category).

Do Not Update Select this option if you do not want the process to check the
Person is Hispanic or Latino check box on the Ethnicity page.

If you select this option, the process does not check the Person
is Hispanic or Latino check box even if the person's test score
ethnicity data is mapped to an Ethnic Group with the EEO
Ethnic Category of Hispanic/Latino.

Update IPEDS Ethnicity Flag 

For ACT, LSAT/LSDAS, and AMCAS only:

Field or Control Description

For New Person Records Added Select this option if you want the process to check the IPEDS
check box on each ethnic group row inserted to the Ethnicity
or Regional page (ETH_VALIDATED = Y for each DIVERS_
ETHNIC record) only for new EMPLIDS added to the system.

For All Person Records Posted Select this option if you want the process to check the IPEDS
check box on each ethnic group row inserted to the Ethnicity
or Regional page (ETH_VALIDATED = Y for each DIVERS_
ETHNIC record) for both new and updated EMPLIDS.

Do Not Update This check box is available only for ACT. Select this check
box if you do not want the process to check the IPEDS check
box regardless of whether the suspense record contains
ethnicity information.
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Hispanic/Latino Ethnic Group

For ACT only:

Field or Control Description

Ethnic Group Select the PeopleSoft ethnic group code that the search/match/
post process should post to the Ethnicity group box of the
Ethnicity or Regional page. The process posts this value only
if the person is Hispanic or Latino.

Post Processing Parameters

Field or Control Description

Process Single Record Select this check box if you want to run the search/match/
post process for a single suspense record. The field to the right
becomes available. Select the suspense record that you want to
process. Only records where the Edit processing option is set
to Complete on the External Test Score Suspense component
will appear.

Data Source Select the data source from which this information was
received. Data source is a required value on the Test Results
page. The search/match/post process will post the value that
you select here to the Test Results page. Values for this field
are delivered with your system as translate values. You can
modify these translate values.

Address Type If the search/match/post process adds a new record to your
database, the process loads the address information from the
test record into the Addresses page. Select the address type
that you want the process to assign to the new address. Define
address types on the Address Type Table.

Phone Type If the search/match/post process adds a new record to your
database, the process loads the phone number from the test
record to the Personal Information page. Select the phone type
that you want to process to assign to the new phone number.
 This field will appear only for test IDs where the phone
number is loaded.
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Field or Control Description

Commit Frequency The commit frequency enables you to decide how often the
data is saved during the Search/Match/Post process. The field
defaults to 1000. Edit this field to decrease or increase the
number of records that are processed before being saved.
 The commit frequency can help with the performance of the
program. A commit frequency that is too low, however, can
slow the program down.

Populate Email Address, Email Type Select this check box to post an email address to the Email
Addresses on the Add/Update a Person component. If you
choose to populate an email address, you must then select an
email type.

Note: These fields appear only for test IDs where an email
address is loaded.

Create Prospects Select to create prospect records for the IDs that are added or
for existing IDs where no prospect record exists from the test
score post. The Default Prospect Values group box becomes
available to enter default values for the prospect records
that the system creates. You can view prospect data in the
Create/Update Prospect component under the menu Student
Recruiting, Maintain Prospects.

If you have selected the Enterprise CRM option in the Post To
group box, the system selects the Create Prospects check box
and disables it

You must enter the required fields in the Default Prospect
Values group if the Create Prospects check box is selected.

Default Prospect Values

Select the default values that you want the system to assign to the prospects that you create from the
test score post. For example, if you select UGRD in the Academic Career field, the system will assign
every prospect it creates to the undergraduate academic career. To create prospects in Campus Solutions,
you must enter an academic institution, academic career, recruiting status, and recruiting center. To
create prospects in CRM, you must enter an academic institution, academic career, and recruiting status.
Recruiting Center becomes an optional field if you have selected the Post to Enterprise CRM option. In
certain circumstances, you might also want to assign additional information, such as academic program
and plan, and admit term, when your test load contains a specific set of prospects.
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Field or Control Description

Academic Program Because the Academic Program table is keyed by admit term,
 you must select an admit term to select an academic program.
 You do not have to assign an academic program.

Assign 3C If you are posting data to Campus Solutions, select this check
box to assign 3Cs to the prospects that you create from the test
score post. The Event ID field becomes available.

The system clears and disables this check box if you have
selected the Enterprise CRM option in the Post To group box.
 The 3Cs feature is not available in CRM.

Event ID Assign an event ID to the prospects that you create from the
test score post. Only the event IDs that have the administrative
functions PROS (prospect) and PROP (prospect program)
are available. PROP is available only if you select an
academic program on this page. Define event IDs on the Event
Definition page.

If the testing agency provides a graduation date, the process uses the mapping defined on the Admit
Term Map page to determine an admit term for a prospect. If the admit term mapping is not done or if
the testing agency does not provide a graduation date, the process uses the default admit term defined on
the Default Prospect Values group box. To navigate to the Admit Term Map page, select Set Up SACR,
Product Related, Recruiting and Admissions, External Test Scores, Create Prospects Setup, Admit Term
Map.

If the testing agency provides an interest code, the process uses the mapping defined on the Program Plan
SubPlan Map page to determine the program, plan and subplan for a prospect. If this mapping is not done
or if the testing agency does not provide an interest code, the process uses the default program, plan, and
subplan defined on the Default Prospect Values group box. To navigate to the Program Plan SubPlan Map
page, select Set Up SACR, Product Related, Recruiting and Admissions, External Test Scores, Create
Prospects Setup, Program Plan SubPlan Map.

See "Understanding the 3C Engine" (Campus Community Fundamentals).

Integration Broker Messages (Applicable Only If You Are Posting to CRM)

The system uses the PeopleSoft Integration Broker's Message Segmentation technology to transmit test
score data from Campus Solutions to PeopleSoft CRM. When you post a test score record to CRM, the
system creates a message for consumption by CRM. To view this message that contains the test score and
prospect data:

1. Select People Tools, Integration Broker, Service Operations, Monitor, Monitoring, Asynchronous
Services.

2. Click the number link below the New field for the SAD_CRM_DATA queue.
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3. Click the Details link for a transaction (You can view the number of segments created and the
transaction ID in the message log for the Search/Match/Post Test Score process).

4. Finally, click the Edit XML or the Download XML link on the Asynchronous Details page to view the
message data.

To enable segmented messages, you will need to select the Segment Aware option on the Node
Definitions page for the remote node defined on the local system.

The message has the following parts:

• Header Record (SAD_HEADER_CRM): The process creates one record for a test ID for each Search/
Match/Post process run. This record includes the following fields: TEST_ID, RUN_CNTL_ID,
INSTITUTION, ACAD_CAREER, DATE_LOADED, and ADM_RECR_CTR.

• Combined bio demo and prospect record (SAD_BIO_PRS_SUS): This record contains the following
fields: TEST_ID, TEST_REC_NBR, EMPLID, BIRTHDATE, LAST_NAME, FIRST_NAME,
MIDDLE_NAME, NAME_SUFFIX, NAME_PREFIX, ADDRESS_TYPE, ADDRESS1,
ADDRESS2, ADDRESS3, CITY, STATE, COUNTRY, POSTAL, NATIONAL_ID_TYPE,
NATIONAL_ID, CAMPUS, INSTITUTION, ACAD_CAREER, SEX, MAR_STATUS, PHONE,
PHONE_TYPE, EMAIL_ADDR, E_ADDR_TYPE, ETHNIC_GRP_CD, REG_REGION, SETID,
CITIZENSHIP_STATUS, RECRUITING_STATUS, ADM_REFRL_SRCE, ADMIT_TYPE,
ADMIT_TERM, ACADEMIC_LEVEL, LAST_SCH_ATTEND, GRADUATION_DT,
FIN_AID_INTEREST, HOUSING_INTEREST, and RELIGIOUS_PREF.

• SAD_PRS_PRG_SUS: This record includes a prospect's academic offering suspense table data (such
as academic program and plan).

• SAD_PRS_INT_SUS: This record includes a prospect's academic interest suspense table data.

• SAD_PRS_EXT_SUS: This record includes a prospect's extra curricular activities suspense table
data.

• Test Score Record (SAD_TST_COM_SUS): This record contains the following fields: TEST_ID,
TEST_REC_NBR, TEST_COMPONENT, TEST_DT, LS_DATA_SOURCE, SCORE,
SCORE_LETTER, EXT_ACAD_LEVEL, DATE_LOADED, PERCENTILE, TEST_ADMIN,
TEST_INDEX0, REV_SCORE_IND, and TEST_ID_OVRD.

The process sets the TEST_ID_OVRD value for only SAT II test components and derives the field
value from SAD_SAT_SUS_II.SAD_SAT_II_TEST_ID.

REV_SCORE_IND can contain the following values:

• U: Always update the test score.

• C: Compare and update if required. This value indicates CRM to update the score if the messaged
score is greater than CRM score of the same test ID, component and test date.

• N: No Updates. This value indicates CRM to not update the existing CRM score. The process
derives this value when SAD_SAT_SUS_I.REV_SCORE_IND_SAT is not equal to Z.

• Name/value pair record (SCC_NAME_VALUE). CRM does not use this record.

Once the messages are created, the Search/Match/Post Test Scores process sets the Search field to
Complete and Post field to Purge on the Test Score Suspense Data page.
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The CRM user then uses the PeopleSoft CRM's Manage Import Batches page to import the message data
into the CRM production tables.

See the PeopleSoft CRM for Higher Education documentation for information about the Manage Import
Batches page.

Data Enrichment to CS and CRM

Regardless of whether you are posting to CRM or Campus Solutions, if the person already exists in
Campus Solutions, the process enters the following contact data from the suspense record into the
Campus Solutions record if the values do not exist in Campus Solutions for the type entered on the run
control page:

• Email

• Address

• Phone Number

For example, let us suppose you have selected phone type as HOME on the run control page and a person
already has a phone number (480) 555–1212 with the phone type of HOME in Campus Solutions. The
test score has a different phone number, (480) 666–6608, for the person. In this case, the process does
not update the phone number in Campus Solutions. The phone number remains (480) 555–1212 in
Campus Solutions. Conversely, let us suppose you have selected phone type as OTHER and a person
has a phone number (480) 555–1212 with the phone type of HOME in Campus Solutions. The test score
has a different phone number, (480) 666–6608, for the person. In this case, the process inserts the phone
number (480) 666–6608 with a phone type of OTHER and also retains the HOME phone number of (480)
555–1212 in Campus Solutions.

Regardless of whether you are posting to CRM or Campus Solutions, if the following biographical fields
do not have a value in Campus Solutions, the process enters the values from the test scores:

• SSN

• Birthdate

• Gender

• Ethnic Group

If the social security number has a value of 999-99-9999  in Campus Solutions, the process overwrites
this value with the social security number provided by the test score. If the biographical fields already
have a value, the process does not update the value. For example, if the prospect's birth date is October
8, 1977 in Campus Solutions and the test score has a birth date of October 9, 1977, the process does not
update the birth date of the prospect. The birth date remains October 8, 1977

For those testing agencies who send last school attended as part of their layout (ACT, AP, EOS, GMAT,
GMASS, SAT and SSS), the process will search against the ACT, ATP, FICE and IPEDS codes in the
External Organization Table for a match. The process then sends the External Org ID value to CRM if a
match is found. Campus Solutions sends all the other related fields for the External Org ID (Descr, City,
State, Postal and Country) to CRM through the External Org EIP.
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Setting Up Search Parameters for Test Score Data
Access the Search Parameters page (Student Recruiting >External Test Score Processing >Search/
Match/Post/Test Scores >Search Parameters or Student Admissions >External Test Score
Processing >Search/Match/Post Test Scores >Search Parameters).

Except for the Ignore option, rest of the page functionality is similar to the Search Parms page (Student
Admissions >Application/Transcript Loads >TS130 >Search/Match/Post Process >Search Parms).

No Matches Found

Field or Control Description

New Ignore: Ignore the unmatched record completely. The process
retains the record in the suspense file with the post status of
awaiting search/match.

Match(es) Found

Field or Control Description

One Match and Multiple Matches Ignore: Ignore the suspense record that matched a record in
your database. The process retains the record in the suspense
file with the post status of awaiting search/match.

Related Links
Setting Up Search/Match Parameters

Researching Duplicate Records

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

In the search dialog page of the External Test Score Suspense component, enter the test ID that you want
to review, Complete in the Edit Process Option field, and Perform in the Search/Match Process Option
field. Then click the Search button. The search process finds only those suspense records that went
through the search/match/post process but did not get posted. The reason the search/match/post process
did not post the records is because it found a possible duplicate record in the database. Upon entering the
component, the Test Score Suspense Data page displays the search/match level involved in the possible
match and the number of individuals in the database that match the criteria in the Search/Match Results
group box.
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For example, let's suppose that the Order Number field in the Search/Match Results group box
displayed 40, and that three matches appear. At PSUNV, Order Number of 40 means that the process
is checking for a matching name and gender. Therefore, you know that there are three people in your
database with the same name and gender as the person in the suspense record. Use the Search/Match
component to look up the name and gender that match the suspense record, and compare the other
information (such as address) to determine whether the person in the database is the same as the person in
the suspense record. Select Student Recruiting, External Test Score Processing, Search/Match or Student
Admissions, External Test Score Processing, Search/Match to access this page.

If the person from the suspense record is not the same as a person in your database, set the Search field to
Complete and the Post field to New ID Add.

If the person from the suspense record is the same as a person in your database, set the Search field to
Complete and the Post field to Update Existing ID. Then go to the Personal Information page and enter
the ID that you want to update. Note, however, that the search/match/post process only updates test score
and candidate data information. The process does not update bio/demo data because some bio/demo data
may have already been verified.

Rerunning the Search/Match/Post Process

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

The process posts the suspense records where you manually changed the Search/Match processing option
to Complete and the Post processing option to New ID Add or Update Existing ID. By this time, all of
your suspense records should be posted to your database. When a record posts a new record to your
database, the post process assigns an ID to the person.

To view a bio/demo record that the post process created, select Student Recruiting > External
Test Score Processing > Add/Update a Person or Student Admissions > External Test Score
Processing > Add/Update a Person.

To view a test score record that the post process created or updated, select Student Recruiting >
External Test Score Processing > Test Results or Student Admissions > External Test Score
Processing > Test Results.

To view the additional data from the testing agency not posted to Test Results or Add/Update a Person,
select Student Recruiting > External Test Score Processing > Test Score Candidate Data or Student
Admissions > External Test Score Processing > Test Score Candidate Data.

If you chose to create a prospect record, select Student Recruiting > Maintain Prospects > Add/
Update a Prospect.

Related Links
Tracking Test Results for Prospects and Applicants
Entering or Updating Applicant Biographical Data
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Purging Suspense Files and Test Score Messages

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

This section discusses how to purge suspense records and test score messages.

Note: If you intend to perform an analysis on your test score processing, do not purge your test score
messages with the External Test Score Purge process. Instead, purge them later when you no longer need
to view them, using the Test Score Messages Purge process.

Pages Used to Purge Suspense Files and Test Score Messages

Page Name Definition Name Navigation Usage

External Test Score Purge SAD_TEST_PURGE • Student Recruiting >
External Test Score
Processing > External
Test Score Purge

• Student Admissions >
External Test Score
Processing > External
Test Score Purge

Purge suspense records and
test score messages for a
specific test ID.

Test Score Messages Purge TST_SCORE_PARMS • Student Recruiting >
External Test Score
Processing > Test Score
Messages Purge

• Student Admissions >
External Test Score
Processing > Test Score
Messages Purge.

Purge all test score messages.
 You can run a process to
purge all test scores remaining
in your suspense files for all
external test scoreloads.

Purging Suspense Records and Test Score Messages
Access the External Test Score Purge page (Student Recruiting > External Test Score Processing >
External Test Score Purge or Student Admissions > External Test Score Processing > External Test
Score Purge).
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This example illustrates the fields and controls on the External Test Score Purge page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Test ID Enter the test ID that you want to delete from the suspense
record. The test ID list that appears in the prompt is based on
the Test ID Security.

All Suspense Rows Select this option to enable the Purge Option for All Rows
group box.

Marked Suspense Rows Select this option to enable the Purge Option for Marked Rows
group box.

Purge Option for All Rows

Field or Control Description

All Suspense Rows Select this option to purge all the suspense records.

750  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 23 Processing External Test Scores

Field or Control Description

Rows Loaded before or on Select this option and enter a date to purge all suspense records
that were loaded on or before the specified date.

Use the Date Loaded field on the Test Score Suspense Data
page to see when you loaded a record.

Suppose you loaded records on May 10, 2009. Subsequently,
 you loaded another set of records on May 15, 2009. If you
select the Rows Loaded before or on option and specify the
date as May 15, 2009, the purge process deletes all suspense
records that were loaded on May 15, 2009 and May 10, 2009.

Purge Option for Marked Rows

Field or Control Description

All Marked Suspense Rows Select this option to purge all the records in your suspense
table that are marked Purge in the Post field of the Test Score
Suspense Data page.

Rows Loaded before or on Select this option and enter a date to purge only those suspense
records that were loaded on or before the specified date and
that are marked Purge in the Post field of the Test Score
Suspense Data page.

Suppose you loaded records on May 10, 2009. Subsequently,
 you loaded another set of records on May 15, 2009. If you
select the Rows Loaded before or on option and specify the
date as May 15, 2009, the purge process deletes the suspense
records marked Purge that were loaded on May 15, 2009 and
May 10, 2009.

Message Purge Parameter

Field or Control Description

Retain Associated Messages Select this option if you want to retain messages that are
associated with the suspense records that you are purging.

Remove Associated Messages Select this option if you want to remove messages that are
associated with the suspense records that you are purging.
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Reviewing Test Score Candidate Data

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

This section provides an overview of test score candidate data and discusses how to review:

• Candidate data personal information.

• Academic information.

• Student profile high school and college activity information.

• Interest information.

Understanding Test Score Candidate Data
The search/match/post process creates test score candidate data only if you are posting to Campus
Solutions. If you are posting to CRM, the process does not create test score candidate data.

The search/match/post process posts candidate data (according to the test) to the Test Score Candidate
Data component. This component is informational only. The data in this component does not affect other
data in your database. For example, if you change a person's name in this component, it does not change
the name anywhere else in the system. If you choose however to create prospects from test scores, some
of this data is used for the process, such as graduation date, intended major, and extracurricular activities.

Many of the values and codes that appear in the Test Score Candidate Data components are based on
values and codes that the testing agency defines. Contact the testing agency that manages the test for full
descriptions of the data that appears in these pages or refer to the test score layout that you received from
the testing agency.

Before entering the Test Score Candidate Data component, you must enter the test ID. The pages in the
component dynamically appear based on the test ID that you entered. The number of pages that appear in
the component depend on the test ID. You must have Test ID Security defined for your user ID in order to
access the component. The pages shown here are examples of the Test Score Candidate Data component.
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Pages Used to Review Test Score Candidate Data

Page Name Definition Name Navigation Usage

Personal Information SAD_ACT_CD

SAD_ADA_CD

SAD_AMC_CD

SAD_LAW_CD

SAD_SAT_CD

SAD_SSS_CD

• Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Personal Information

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Personal Information

This page appears for the
ACT, ADA, AMCAS, LSAT/
LSDAS, SAT, and SSS.
 Review the student's personal
information as it was received
from the testing agency. The
fields vary depending on
the test ID. This page also
indicates if the post process
created an employee ID for
this person.

Test Score Candidate Data SAD_AP_CD

SAD_CRS_CD

SAD_DAT_CD

SAD_EOS_CD

SAD_GMT_CD

SAD_GRE_CD

SAD_GMS_CD

SAD_TFL_CD

• Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data > Test
Score Candidate Data

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data > Test
Score Candidate Data

This page appears for the AP,
 CRS, DAT, EOS, GMAT,
 GRE, GMASS, and TOEFL.
 Review the student's personal
and academic information
as it was received from the
testing agency. The fields vary
depending on the test ID. This
page also indicates if the post
process created an employee
ID for this person.

Academics SAD_ACT_CD_ACAD

SAD_LAW_CD_SCH

• Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Academics

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Academics

This page displays for the
ACT and LSAT/LSDAS.
 Access a student's test and
academic data as reported by
the testing agency. The fields
vary depending on the test ID.

Activities SAD_ACT_CD_ACT • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Activities

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Activities

This page displays for ACT
only. Access student profile
high school and projected
college activity information.
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Page Name Definition Name Navigation Usage

Interests SAD_ACT_CD_INT • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Interests

• Student
Admissions >External
Test Score
Processing >Test
Score Candidate
Data >Interests

This page appears for ACT
only. Access student profile
interest and college preference
information.

Education SAD_ADA_CD_ED • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Education

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Education

This page appears for ADA.
 Review a student's academic
history as reported from
AADSAS.

Applicant Data SAD_ADA_CD_DATA

SAD_AMC_CD_OTH

• Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Applicant Data

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Applicant Data

This page appears for ADA
and AMCAS. Review the
student's data to support their
application for admission
as it was received from the
testing agency. The fields vary
depending on the test ID.

Application SAD_ADA_CD_APP

SAD_AMC_CD_APP

• Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Application

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Application.

This page appears for ADA
and AMCAS. View the results
of the Create Applicants from
Test process for this student.
 You can also select not to
create an application for this
student by selecting Do Not
Use for Create Appl in the
Post Option field.
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Page Name Definition Name Navigation Usage

Courses SAD_ADA_CD_CRS • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Courses

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Courses

This page appears for ADA.
 Review a student's academic
course work and grades as
reported by AADSAS.

Family Information SAD_ADA_CD_FAMILY Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data > Family
Information

Student Admissions >
External Test Score
Processing > Test Score
Candidate Data > Family
Information

This page appears for
ADA. Review the family
information.

Essays SAD_ADA_CD_ESSAY Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data > Essays

Student Admissions >
External Test Score
Processing > Test Score
Candidate Data > Essays

This page appears for ADA.
Review the personal statement
data

Colleges SAD_AMC_CD_COL • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Colleges

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Colleges

This page appears for
AMCAS. Review a student's
prior colleges attended as
well as previous majors and
degrees earned, as provided
by AAMC.
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Page Name Definition Name Navigation Usage

GPA/Hours SAD_AMC_CD_GPA • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
GPA/Hours

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
GPA/Hours

This page appears for
AMCAS. Review a student's
grade point averages and
credit hours, as provided by
AAMC.

Awards SAD_AP_CD_AWRD • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Awards

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Awards

This page appears for AP.
 Review the student's awards
information including award
type and year, as reported
from the Advanced Placement
exam.

Schools SAD_AP_CD_SCHL • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Schools

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Schools

This page appears for
AP. Review a student's
high school and college
information as reported from
the Advanced Placement
exam.

Test Data SAD_AP_CD_TEST

SAD_LAW_CD_SB

SAD_SAT_CD_TEST

• Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data > Test
Data

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data > Test
Data

This page appears for the AP,
 LSAT/LSDAS, and SAT.
 Review additional test data as
reported by the testing agency
that is not posted to the Test
Results page. The fields vary
depending on the test ID.
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Page Name Definition Name Navigation Usage

Additional Data SAD_CRS_CD • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Additional Data

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Additional Data.

This page appears for
CRS. Review the student's
academic, employment,
 and search-related data, as
provided by LSAC.

Prior Schools SAD_LAW_CD_MATR • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Prior Schools

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Prior School.

This page appears for
LSAT/LSDAS. Review
undergraduate academic
data and prior law schools
attended, as provided by
LSAC.

Candidate Data SAD_LAW_CD_CD • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Candidate Data

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Candidate Data

This page appears for LSAT/
LSDAS. Review the student's
additional test and application
information, as provided by
LSAC.

Recommendations SAD_LAW_CD_REC • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Recommendations

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Recommendations

This page appears for LSAT/
LSDAS. Review letter of
recommendation data as
provided by LSAC.
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Page Name Definition Name Navigation Usage

Student Data SAD_SAT_CD_STD

SAD_SSS_CD_SDQ

• Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
Student Data

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
Student Data

This page appears for SAT
and SSS. Review additional
information about the student,
 as provided by ETS. The
fields vary depending on the
test ID.

School Data SAD_SAT_CD_SCH • Student Recruiting >
External Test Score
Processing > Test Score
Candidate Data >
School Data

• Student Admissions >
External Test Score
Processing > Test Score
Candidate Data >
School Data

This page appears for SAT.
 Review college preference
information for a student. If
the test type is college, you
can review the high school
information for the student,
 as provided by ETS. If the
test type is secondary, you
can review the colleges that
the student submitted test
scores to, as provided by ETS.
 The data that appears on
the page depends on the test
type that you selected during
the external test score load
process.

Reviewing Candidate Data Personal Information
Access the Personal Information page (Student Recruiting > External Test Score Processing > Test
Score Candidate Data > Personal Information or  Student Admissions > External Test Score
Processing > Test Score Candidate Data > Personal Information).
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This example illustrates the fields and controls on the Personal Information page (1 of 2). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Personal Information page (2 of 2). You can find
definitions for the fields and controls later on this page.

Personal and academic data posted from the suspense record appears in these fields.

Field or Control Description

Test ID Displays the test you entered on the search page. The pages to
the component vary based on the test ID.

Test Date Displays the day the person took the test.

Personal Data Impacts Indicates whether the process added a new EMPLID to your
database or updated the personal data for an existing EMPLID.

The system displays one of the following values for this field:

• Caused Personal Data Creation

• No Personal Data Impact

• Caused Personal Data Update
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Reviewing Academic Information
Access the Academics page (Student Recruiting > External Test Score Processing > Test Score
Candidate Data > Academics or Student Admissions > External Test Score Processing > Test Score
Candidate Data > Academics).

This example illustrates the fields and controls on the Academics page (1 of 2).
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This example illustrates the fields and controls on the Academics page (2 of 2).

Academic information data posted from the suspense record appears in these fields.

Reviewing Student Profile High School and College Activity Information
Access the Activities page (Student Recruiting > External Test Score Processing > Test Score
Candidate Data > Activities or Student Admissions > External Test Score Processing > Test Score
Candidate Data > Activities).
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This example illustrates the fields and controls on the Activities page.

High school and college activities data posted from the suspense record appears on this page.

Reviewing Interest Information
Access the Interests page (Student Recruiting > External Test Score Processing > Test Score
Candidate Data > Interests or  Student Admissions >External Test Score Processing >Test Score
Candidate Data >Interests).
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This example illustrates the fields and controls on the Interests page (1 of 2).
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This example illustrates the fields and controls on the Interests page (2 of 2).

Interest and college preference data posted from the suspense record appears on this page.

Viewing Test Score Messages Summary Information

Important! Test score load and other processes and components discussed in this Processing External
Test Scores documentation are deprecated. Support will be maintained for these programs, but no new
development will be produced for these programs. It is strongly recommended that you use Prospect/
Admissions Data Load (PDL) instead. For more information on PDL, see the Prospect/Admissions Data
Load documentation.

This section discusses how to use the Test Score Messages page to view a list of all test score messages
stored in your suspense files for any record loaded through an external test score load.
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Page Used to View Test Score Messages Summary Information

Page Name Definition Name Navigation Usage

Test Score Messages TST_SCORE_MSG_TBL • Student Recruiting >
External Test Score
Processing > Test Score
Messages

• Student Admissions >
External Test Score
Processing > Test Score
Messages

View a list of all test score
messages stored in your
suspense files for any record
loaded through an external
test score load.

Viewing Test Score Messages Summary Information
Access the Test Score Messages page (Student Recruiting > External Test Score Processing > Test
Score Messages or Student Admissions > External Test Score Processing > Test Score Messages).

This example illustrates the fields and controls on the Test Score Messages page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Test ID Enter the test ID for which you want to view the test messages.
 The fields that appear in the prompt are based on your Test ID
security.
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Field or Control Description

Record Number Select the record number for which you want to search for test
score messages.

Process Instance Select the process instance for which you want to search for
test score messages.

Date Loaded Select the date loaded for which you want to search for test
score messages.

Last Name Select the last name for which you want to search for test score
messages.

First Name Select the first name for which you want to search for test
score messages.

ID Select the ID for which you want to search for test score
messages.

Search Click to find information matching your search criteria.
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Understanding NCEA Test Score Processing

NCEA is New Zealand's national qualification for senior secondary students. NCEA is part of the
National Qualifications Framework (NQF). Through NCEA, students can record their achieved standards,
thereby acquiring credits on the NQF, as well as a variety of test results. For example, when students have
achieved 80 credits at level 1, they qualify for a NCEA level 1, so long as eight of those credits show
numeracy skills and eight other credits show literacy skills.

See Also

www.nzqa.govt.nz/ncea/index.html

Setting Up NCEA Test Data

Before you can load, review, post, or purge NCEA test data, you must complete some setup requirements.

This section discusses how to:

1. Define NCEA test components.

2. Define NCEA test IDs.

3. Map NCEA subject codes to each NCEA test ID component.

Pages Used to Prepare for NCEA Test Score Processing

Page Name Definition Name Navigation Usage

Test Component Table SA_TEST_COMP_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Test Component
Table

Define test components to
attach to test IDs.

Test Tables SA_TEST_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Test Tables

Define an NCEA test ID and
assign test components.
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Page Name Definition Name Navigation Usage

NCEA Subject Code Map SAD_NCEA_MAPSB_NZL Student Admissions >
Processing Admissions
NZL > NCEA Subject Code
Map

Map subject codes.

Defining NCEA Test Components
Access the Test Component Table page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > Test Component Table).

This example illustrates the fields and controls on the Test Component Table page.

Define NCEA test components.

Related Links
Defining External Test Components

Defining NCEA Test IDs
Access the Test Tables page (Set Up SACR > Product Related > Recruiting and Admissions >
External Test Scores > Test Tables).
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This example illustrates the fields and controls on the Test Tables page.

Add a test ID of NCEA and enter test component details.

Related Links
Defining External Test Components

Mapping NCEA Subject Codes to each NCEA Test ID Component.
Access the NCEA Subject Code Map page (Student Admissions > Processing Admissions NZL >
NCEA Subject Code Map).

This example illustrates the fields and controls on the NCEA Subject Code Map page.

For each NCEA test component, map a subject group code.
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Processing NCEA Test Scores

This section provides an overview of the steps required for NCEA processing, and discusses how to:

• Load NCEA test scores.

• Review NCEA suspense file process options.

• Review basic bio/demo data.

• Review other bio/demo data.

• Review subjects.

• Review standard results.

• Review suspense load messages.

• Post NCEA suspense data.

• Set up search/match parameters for NCEA data.

• Review posted NCEA data.

• Review posted NCEA data details.

• Purge the NCEA suspense files.

Understanding How to Process NCEA Test Scores
To process test scores:

1. Load the test score data from a file in your directory into a suspense table using the NCEA test score
load process.

There are four files: Candidate File, Subject Group File, Result File, and Standard File.

2. Review and edit the data that you loaded in suspense pages.

Correct all load errors before moving on to the next step. In the search dialog page of the suspense
component, enter Error in the Edit Processing Option field and click the Search button. Access each
suspense record and correct the errors until every suspense record has a value of Complete (rather
than Error) in the Edit field on the Process Options page.

3. After you have corrected all of the load errors, run the search/match/post process.

This process looks for data in your database (based on search parameters that you define on the
search/match criteria pages, that can include, for example, name, ID number, and birth date) that
matches the data that you are posting. For a set of parameters that suggest only a possible match
(such as name and gender, for example), the process will not post the record until you can manually
determine which records are actually duplicates.

4. View each suspense record that did not get posted to confirm that it is actually a duplicate.
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On the Search Dialog page of the Suspense component, enter the NCEA test ID, Complete in the Edit
Process Option field and  Perform in the Search/Match Process Option field. Click the Search
button. The search process finds only those suspense records that were not posted in the search/match/
post process. The search/match/post process does not post records if it encounters a possible duplicate
record in the database. After you access the component, find the parameters for which the process
identified a match. Use Search Match to find the bio/demo information that matches the suspense
record and decide whether a person who matches the incoming data already exists in the system.
Specify whether you want the search/match/post process to add the bio/demo and test record to your
database, update an existing record, or ignore the suspense record.

5. Run the search/match/post process again.

The process posts the suspense records that you manually tagged to post. By this time, all of your
suspense records should be posted to your database. To view a test score record that the search/match/
post process created or updated, use the NCEA Test Results page.

6. Purge the suspense tables.

You should purge the suspense tables as soon as all of the suspense records have been posted to the
database. This helps to avoid confusion the next time that you load data into the suspense tables.

7. Review or edit posted test results.

Pages Used to Process NCEA Test Load Data

Page Name Definition Name Navigation Usage

NCEA Load External Data SAD_RCTL_NCEA_LD_N Student Admissions >
Processing Admissions
NZL > NCEA Load
External Data

Run the NCEA Data Load
SQR process (ADUEBNZL),
 in order to load NCEA test
scores in to the suspense
tables.

Process Options SAD_NCEA_SPROC_NZL Student Admissions >
Processing Admissions
NZL > NCEA Suspense >
Process Options

View and correct load process
results.

Bio/Demo Data SAD_NCEA_SPBIO_NZL Student Admissions >
Processing Admissions
NZL > NCEA Suspense >
Bio/Demo Data

Review and edit the student's
personal information in the
suspense record.

Other Bio/Demo Data SAD_NCEA_SPOTR_NZL Student Admissions >
Processing Admissions
NZL > NCEA Suspense >
Other Bio/Demo Data

Review and edit additional
personal information in the
suspense record.
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Page Name Definition Name Navigation Usage

Subjects SAD_NCEA_SPSUB_NZL Student Admissions >
Processing Admissions
NZL > NCEA Suspense >
Subjects

Review and edit the student's
loaded subject data.

Standard Result SAD_NCEA_SPSTD_NZL Student Admissions >
Processing Admissions
NZL > NCEA Suspense >
Standard Result

Review and edit the student's
loaded standard result record.

Messages SAD_NCEA_MSG_NZL Student Admissions >
Processing Admissions
NZL > NCEA Suspense >
Messages

Review message details from
the load process.

Search/Match Parameters SEARCH_PARMS Student Admissions >
Processing Admissions
NZL > NCEA Search/
Match/Post > Search/Match
Parameters

Define your search/match
parameters. These are the
rules that determine what
the post process should do
with the suspense record after
the search/match process is
complete.

NCEA Post Parameters SAD_RCTL_NCEAPST_N Student Admissions >
Processing Admissions
NZL > NCEA Search/
Match/Post > NCEA Post
Parameters

Post NCEA test data from
suspense files. Before you
post the data, however,
 set up the search/match
parameters on the Search/
Match Parameters page. You
can post a single record or all
of the records in the suspense
file.

NCEA Test Results SAD_NCEA_TERES_NZL Student Admissions >
Processing Admissions
NZL > NCEA Test
Results > NCEA Test
Results

View a student's posted
NCEA test data.

Additional Test Score Detail SAD_NCEA_TSTSC_SEC Click the Details button on
the NCEA Test Result page.

Review additional information
about a test component.

NCEA Purge Suspense File SAD_RCTL_NCEAPRG_N Student Admissions >
Processing Admissions
NZL > NCEA Purge
Suspense File

Purge NCEA suspense
records.
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Loading NCEA Test Scores
Access the NCEA Load External Data page (Student Admissions > Processing Admissions NZL >
NCEA Load External Data).

This example illustrates the fields and controls on the NCEA Load External Data page.

The NCEA Data Load process loads four files: A candidate record, a subject group summary record, and
a result record, (each of which is loaded into suspense and then posted to the profile test results tables),
and a standard record, which is loaded each time to provide a temporary look up table. The temporary
standard table is used by the load SQR to obtain the subject group for each standard/version on the result
record. It is also used to obtain more detail about each standard.

Reviewing NCEA Suspense File Process Options
Access the Process Options page (Student Admissions > Processing Admissions NZL > NCEA
Suspense > Process Options).
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This example illustrates the fields and controls on the Process Options page. You can find definitions for
the fields and controls later on this page.

This page provides the status of a suspense record regarding the loading process. Any informational and
error indicators that NCEA data load processes generate appear on this page. You can use this page to
keep current on the status of an individual's NCEA processing.

Processing Options

Field or Control Description

Edit Displays the status of the load process for this suspense record.
 The load process populates this value.

• Complete: The load process loaded the data without a
problem. This record is ready to be posted.

• Error: The load process encountered problems when
loading the data.

The system indicates the values that you must correct
in the Error Indicators group box. Correct all errors
and save the data before running the search/match/post
process on this record. After you correct the errors and
save the component, the system changes the field value to
Complete.

• Perform: You set this value manually.

This is for informational purposes only.
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Field or Control Description

Search Displays the status of the search/match process for this
suspense record. The search/match process populates this
value.

• Complete: The search/match process completed
successfully.

• Error: The search/match process encountered problems.

Refer to the log file for information regarding the error.

• Perform: The search/match process will process this
record the next time you run the process.

Post Displays the status of the record regarding the search/match/
post process. These values can be entered manually; however,
 some are entered by the system after processes are run as
described in the table below. If the process updated an existing
person's record, the process displays the ID that was updated
in the ID field on the Bio/Demo page.

Post Value Meaning How Set

Delete Update ID Not used with NCEA. Not used with NCEA.

Error The posting process encountered a
problem.

Set by the system during the search/
match/post process.

New ID Add Not used with NCEA. Not used with NCEA.

No Action Search/match/post and purge suspense
file processes will ignore the record if
this value is entered.

Set manually.

Purge Indicates that this suspense record will
be removed from the system during the
purge suspense file process.

Set by the system during the search/
match/post process if the record was
successfully processed.
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Post Value Meaning How Set

Update ID The search/match/post process found a
matching ID in the database. The process
will update the matching records with the
data from this suspense record.

When set manually, means that the
process identified a match and the user
determined manually that duplication
exists. The system makes available the
ID field on the Personal Information
page. Select the ID that you want the
search/match/post process to update. You
must save the page and run the search/
match/post process to update the record.

Set by the system during the search/
match process if a match was found
in the database and if your search
parameters define that an update should
occur in this situation (only when you
run search/match and post and different
times).

Set manually.

Wait Srch This record is in the suspense file and is
waiting to be processed by the search/
match/post process.

Set by the system during the load
external data process.

Note: While you can manually edit the values in the Edit, Search and Post fields, keep in mind that
if a field contains Error and you manually change it without correcting an error, you may experience
problems when posting the data.

Error Indicators

Field or Control Description

Last Name,  First Name,  and Birthdate When a load error occurs, the load external data process
displays the required values that were missing or incorrect
in the load. Go to the Bio/Demo Data page or another page
in the NCEA Suspense component where the missing or
incorrect data resides to enter a valid value. When you correct
the error the system clears the check box and the fields will no
longer appear. After all of the check boxes are cleared and the
component is saved, the system enters Complete in the Edit
field.

778  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 24 (NZL) Processing NCEA Test Scores

Search/Match Results

Field or Control Description

Order Nbr (order number) You know that the search/match process found a match and did
not post the suspense record when the Search field contains
Perform and displays the search order number that led to the
match in the Order Nbr field. Use this information to decide
whether or not a possible duplicate exists.

Matches Displays the number of matches that the process found at order
number given.

Reviewing Basic Bio/Demo Data
Access the Bio/Demo Data page (Student Admissions > Processing Admissions NZL > NCEA
Suspense > Bio/Demo Data).

This example illustrates the fields and controls on the Bio/Demo Data page.

Review and edit the student's personal information in the suspense record.

Reviewing Other Bio/Demo Data
Access the Other Bio/Demo Data page (Student Admissions > Processing Admissions NZL > NCEA
Suspense > Other Bio/Demo Data).
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This example illustrates the fields and controls on the Other Bio/Demo Data page.

Review and edit additional personal information in the suspense record.

Reviewing Subjects
Access the Subjects page (Student Admissions > Processing Admissions NZL > NCEA Suspense >
Subjects).

This example illustrates the fields and controls on the Subjects page.

Review and edit NCEA subject information in the suspense record. Each component has its own row and
details.

Reviewing Standard Results
Access the Standard Result page (Student Admissions > Processing Admissions NZL > NCEA
Suspense > Standard Result).
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This example illustrates the fields and controls on the Standard Result page.

Review and edit NCEA standard result file information in the suspense record. Each component has its
own row and corresponding detail rows.

Reviewing Suspense Load Messages
Access the Messages page (Student Admissions > Processing Admissions NZL > NCEA Suspense >
Messages).
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This example illustrates the fields and controls on the Messages page.

Any messages that the NCEA load process generates appear on this page. Use this page to find the
most current information on the status of an individual's NCEA data processing. These messages can
serve historical and analytical purposes, giving you a picture of the kinds of errors encountered in your
processing. Therefore, you should purge your NCEA messages only after you have completed your
analysis.

Posting NCEA Suspense Data
Access the NCEA Post Parameters page (Student Admissions > Processing Admissions NZL > NCEA
Search/Match/Post > NCEA Post Parameters).
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This example illustrates the fields and controls on the NCEA Post Parameters page. You can find
definitions for the fields and controls later on this page.

Search/Match/Post Exec Options

Field or Control Description

Search, Match and Post Select this option if you want the process to search your
database for records that match the suspense record and post
the suspense data to your database. This is the recommended
option.

Post Only Select this option if you only want to post the suspense data to
your database (if you select this option, you must have already
run search/match or manually changed the Search and Post
process options on the External Test Score Suspense page).

Search and Match Only Select this option if you only want to run the search and match
process on the suspense file. You will need to post the data at a
later time.
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Post Processing Parameters

Field or Control Description

Academic Institution Enter the institution for which you want to post NCEA
suspense data.

NCEA Year Enter the year of the NCEA examination.

NCEA File Number Specify the examination file you want to post. Values are:

• First Examination File

• Second Examination File

• Third Examination File

NCEA file number values are delivered with your system as
translate values and you should not modify them.

Process Single Record Select this check box if you want to run the search/match/post
process for a single suspense record. The National Student
Number field becomes available.

National Student Number The national student number for the single record you want
to process. This field applies only if you have selected the
Process Single Record check box.

Setting Up Search Parameters for NCEA Data
Access the Search/Match Parameters page (Student Admissions > Processing Admissions NZL >
NCEA Search/Match/Post > Search/Match Parameters).
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This example illustrates the fields and controls on the Search/Match Parameters page.

Use this page to set up your search/match parameters. These are the rules that determine what the post
process should do with the suspense record after the search/match process is complete.

Related Links
Setting Up Search/Match Parameters

Reviewing Posted NCEA Data
Access the NCEA Test Results page (Student Admissions > Processing Admissions NZL > NCEA
Test Results > NCEA Test Results).
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This example illustrates the fields and controls on the NCEA Test Results page.

Use this page to review a student's loaded NCEA test score data.

Reviewing Posted NCEA Data Details
Access the Additional Test Score Detail page (Click the Details button on the NCEA Test Result page).
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This example illustrates the fields and controls on the Additional Test Score Detail page.

Review additional information about an NCEA test component.

Purging the NCEA Suspense Files
Access the NCEA Purge Suspense File page (Student Admissions > Processing Admissions NZL >
NCEA Purge Suspense File).

Field or Control Description

NCEA Year and NCEA File Number When you purge NCEA suspense files, you do so by year and
file number. Enter a year and file number that correspond to
the suspense records you want to delete.

All Suspense Rows Select this option if you want to purge all of the records in
your suspense table, regardless of the status of the Post field
on the Process Options page.

Marked Suspense Rows Select this option if you only want to purge those records
in your suspense file marked Purge in the Post field on the
Process Options page. Select this option if you suspect that
there are still suspense records that need to be processed. The
purge process will only delete suspense records with Purge in
the Post field on the Process Options page.

Retain Associated Messages Select this option if you want to retain messages that are
associated with the suspense records that you are purging.

Remove Associated Messages Select this option if you want to remove messages that are
associated with the suspense records that you are purging.
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Accessing NCEA Test Data in Display-Only Mode

In some instances, you may want to provide view only or basic summary view access to users. Assign
access to the Student Profile component (SAD_NCEA_SPS_NZL) to do so.

This section lists the pages used to view NCEA summary information.

Pages Used to View NCEA Summary Information

Page Name Definition Name Navigation Usage

Bio/Demo Data SAD_NCEA_S_BIO_NZL Student Admissions >
Processing Admissions
NZL > NCEA Student
Profile > Bio/Demo Data

Review basic biographical
information for an individual.

Other Bio/Demo Data SAD_NCEA_S_OTR_NZL Student Admissions >
Processing Admissions
NZL > NCEA Student
Profile > Other Bio/Demo
Data

Review biographical and
demographic information for
an individual.

Subjects SAD_NCEA_SSUBJ_NZL Student Admissions >
Processing Admissions
NZL > NCEA Student
Profile > Subjects

Review an individual's NCEA
subject record.

Standard Result SAD_NCEA_S_STD_NZL Student Admissions >
Processing Admissions
NZL > NCEA Student
Profile > Standard Result

Review an individual's NCEA
standard result record.
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Understanding TAC Data Load Processing

The TACs are the central offices that receive and process applications for admission to participating
universities. PeopleSoft Campus Solutions supports the following TAC files:

• Queensland Tertiary Admission Center (QTAC)

• South Australia Tertiary Admission Center (SATAC)

• Victoria Tertiary Admission Center (VTAC)

• ACT and New South Wales Universities Admissions Centre (UAC)

As part of the processing of the student applications, the TACs send electronic offer details to the
institutions. PeopleSoft Campus Solutions enables you to upload these offer details.

Preparing for TAC Processing

Before you can process and upload the TAC data loads, you must prepare your system with a variety of
setup data, primarily mapping data rules for your institution that coincide with each TAC load that you
process.

The following table lists the required setup tasks that must be completed before you import TAC files:

Task Required for QTAC Required for UAC Required for SATAC Required for VTAC

1. Set up TAC test IDs. Yes Yes Yes Yes

2. Assign user security
to TAC test IDs.

Yes Yes Yes Yes

3. Map TAC test IDs to
PeopleSoft test codes.

Yes Yes Yes Yes

4. Set up TAC program
codes.

Yes Yes Yes Yes
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Task Required for QTAC Required for UAC Required for SATAC Required for VTAC

5. Set up TAC program
code mapping.

Yes Yes Yes Yes

6. Set up DEST 
(DIISRTE) number
mapping.

Yes Yes No No

7. Set up country code
mapping.

Yes Yes Yes Yes

8. Set up state code
mapping.

Yes Yes Yes Yes

9. Set up external
organizations
associated with the
qualifications that you
want to load.

Yes Yes Yes Yes

10. Define TAC
subjects.

Yes Yes No Yes

11. Map year 12
types to external
organizations.

Yes No No No

12. Map TAC external
institutions to external
organizations.

No No No Yes

13. Map origin of
qualification values to
external organizations.

Yes No No No

14. Map subject
codes to external
organizations.

Yes Yes No Yes

15. Set up qualification
level mapping.

Yes Yes No Yes

16. Set up name prefix
mapping.

Yes Yes Yes Yes

17. Add program action
reason code for basis of
admission mapping.

Yes Yes Yes Yes
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Task Required for QTAC Required for UAC Required for SATAC Required for VTAC

18. Map basis of
admission values.

Yes Yes Yes No

19. Map admit type
values.

No No Yes No

20. Define citizenship
mapping rules.

Yes Yes Yes Yes

21. Set up ethnicity
mapping.

No Yes No Yes

22. Set up DIISRTE
Language Code
Mapping.

Yes Yes No Yes

23. Offer Period
Mapping

Yes No No No

24. Honors Category
Map

Yes No No No

Pages Used to Prepare for TAC Processing

Page Name Definition Name Navigation Usage

Test Tables SA_TEST_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Test Tables

Set up TAC test IDs, such as
QTAC, VTAC, SATAC, and
UAC.

Test ID Security SAD_TEST_SCTY Set Up SACR >
Security > Secure Student
Administration > User
ID > Test ID Security

Assign the TAC test IDs that
a user can access. The system
enforces test ID security
in several components
throughout the system.
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Page Name Definition Name Navigation Usage

External Test Score Mapping SAD_TEST_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > External
Test Scores > External Test
Score Mapping

Map TAC test IDs to suspense
and candidate data records.
 Map the TAC test IDs you
defined on the Test Table page
to the Oracle-delivered test
code. The system needs this
setup to perform a variety of
external test-related functions.
 The PeopleSoft system
delivers the following test
codes for use with TAC: QTC,
 STC, UAC, and VTC.

Program Code Table SSR_PRG_CD_TBL Set Up SACR > Foundation
Tables > Reporting
Codes > Program Code
Table AUS

Define the TAC program
codes to which the applicants
will apply through a TAC or
TACs.

Acad Prog AUS SSR_ACAD_PROG_AUS Set Up SACR > Foundation
Tables > Academic
Structure > Academic
Program Table > Acad
Prog AUS

Map TAC program
information to academic
programs.

DEST Number Map SAD_TAC_MAP_DEST Set Up SACR > Product
Related > Recruiting and
Admissions > TAC > DEST
Number Map

Associate a fact code to a
DEST (DIISRTE) reference
number for the cases where a
fact code relates to DIISRTE
Highest Education Attainment
information.

Country Map SAD_TAC_MAP_CNT Set Up SACR > Product
Related > Recruiting and
Admissions > TAC >
Country Map

Map TAC country codes to
the PeopleSoft equivalent
country field.

State Code Map SAD_TAC_MAP_ST Set Up SACR > Product
Related > Recruiting and
Admissions > TAC > State
Code Map

Map TAC state codes to the
PeopleSoft equivalent state
field.

Organization Table EXT_ORG_TABLE Campus Community >
Organization > Create/
Maintain Organizations >
Organization Table >
Organization Table

Enter external organizations
codes into the system
for posting applicants'
external education data and
the last school attended.
 Education data may include
an applicant's qualifications.
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Page Name Definition Name Navigation Usage

School Subject Maintenance SCHOOL_SUBJECTS Campus Community >
Organization > Create/
Maintain Organizations >
School Subject Maintenance

Define academic subjects for
the external organizations.

External Organization Map SAD_TAC_MAP_EXT Set Up SACR > Product
Related > Recruiting and
Admissions > TAC >
External Organization Map

Map year 12 types, TAC
external institutions, origin
of qualification values, and
subject codes to the external
organizations.

Qualification Level Map SAD_TAC_MAP_QUAL Set Up SACR > Product
Related > Recruiting and
Admissions > TAC >
Qualification Level Map

Map TAC qualification level
codes to PeopleSoft external
academic level codes.

Name Prefix Map SAD_TAC_MAP_PFX Set Up SACR > Product
Related > Recruiting and
Admissions > TAC > Name
Prefix Map

Map TAC prefixes (MR,
 MISS, and MS) to general
system name prefixes.

Program Action Reason Table PROG_RSN_TBL Set Up SACR > Product
Related > Student
Records > Program
Action > Program Action
Reason Table

Add program action reasons
for the program action of
Admit. The TAC Load process
assigns these program action
reasons to applicants based
on the Basis of Admission
mapping.

Basis of Admission Map SAD_TAC_MAP_BOA Set Up SACR > Product
Related > Recruiting and
Admissions > TAC > Basis
of Admission Map

Map Admit program action
reasons to the Basis of
Admission codes provided by
the TAC.

Admit Type Map SAD_TAC_MAP_ADM Set Up SACR > Product
Related > Recruiting and
Admissions > TAC >
Admit Type Map

Associate admit types with
basis of admission values.

Citizenship Map SAD_TAC_MAP_CIT Set Up SACR > Product
Related > Recruiting and
Admissions > TAC >
Citizenship Map

Map TAC citizenship codes
to the citizenship statuses set
up for the country AUS and
residency codes.

Ethnicity Map SAD_ETHNICITY_MAP Set Up SACR > Product
Related > Recruiting and
Admissions > External Test
Scores > Ethnicity Mapping

Map the DIISRTE ethnicity
values (Aboriginal or Torres
Strait Islander codes related to
DIISRTE Element 316) to the
corresponding ethnic groups
set up for regulatory region
AUS.
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Page Name Definition Name Navigation Usage

Language Table SSR_LANG_DEST Set Up SACR > Product
Related > Student
Records > Enrolment
Reporting Codes > AUS
Regulatory Report Setup >
Language Table

Map language codes to
DIISRTE language codes.

Offer Period Mapping SAD_TAC_MAP_OFR Set Up SACR > Product
Related > Recruiting and
Admissions > TAC > Offer
Period Mapping

Map the Offering Month and
Year provided in the TAC File
to an admit term.

Honors Category Map SAD_TAC_MAP_HONOUR Set Up SACR > Product
Related > Recruiting and
Admissions > TAC >
Honors Category Map

Map an honors category to the
TAC Honours value provided
in the qualification file.

Setting Up TAC Test IDs
Access the Test Tables page (Set Up SACR > Product Related > Recruiting and Admissions >
External Test Scores > Test Tables).

This example illustrates the fields and controls on the Test Tables page.

Add a test ID for all applicable TACs.

Assigning TAC Test ID Security
Access the Test ID Security page (Set Up SACR > Security > Secure Student Administration > User
ID > Test ID Security).
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This example illustrates the fields and controls on the Test ID Security page.

Assign the TAC test IDs that a user can access. The system enforces test ID security in several
components throughout the system.

Related Links
"Setting Security for Test IDs" (Campus Solutions Application Fundamentals)

Setting Up TAC Test ID Mapping Rules
Access the External Test Score Mapping page (Set Up SACR > Product Related > Recruiting and
Admissions > External Test Scores > External Test Score Mapping).
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This example illustrates the fields and controls on the External Test Score Mapping page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Test ID Enter a TAC test ID for each PeopleSoft TAC test code. The
PeopleSoft system delivers the following TAC test codes:
QTC, VTC, UAC, and STC

Note: On this page, you only have to enter a TAC test ID that corresponds to a PeopleSoft test code. The
PeopleSoft system delivers the rest of the page complete. It is important that all TAC test IDs you have
defined are mapped to a PeopleSoft test code or you will not be able to load TAC data.

Setting Up TAC Program Codes
Access the Program Code Table page (Set Up SACR > Foundation Tables > Reporting Codes >
Program Code Table AUS).
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This example illustrates the fields and controls on the Program Code Table page.

Set up program codes that map to course codes in the TAC input files.

Mapping TAC Program Codes to Academic Programs
Access the Acad Prog AUS page (Set Up SACR > Foundation Tables > Academic Structure >
Academic Program Table > Acad Prog AUS).

This example illustrates the fields and controls on the Acad Prog AUS (academic program Australia) page
(1 of 2). You can find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Acad Prog AUS (academic program Australia) page
(2 of 2). You can find definitions for the fields and controls later on this page.

Field or Control Description

Program Code Associate a TAC program code with an academic program that
your institution offers. TAC program codes can be mapped to
only one academic program.

TAC Stream Code Applicable to only SATAC and VTAC.

Academic Load Enter the academic load that the TAC Load process assigns to
the admission applications for the program.

Academic Plan Enter the academic plan that the TAC Load process assigns to
the admission applications for the program.

Mode of Attendance Enter the mode of attendance that the TAC Load process
assigns to the admission applications for the program.

Campus Enter the campus that the TAC Load process assigns to the
admission applications for the program.

Associating FACT Codes with DIISRTE Reference Numbers
Access the DEST Number Map page (Set Up SACR > Product Related > Recruiting and
Admissions > TAC > DEST Number Map).
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This example illustrates the fields and controls on the DEST Number Map page. You can find definitions
for the fields and controls later on this page.

DIISRTE - Department of Industry, Innovation, Science, Research and Tertiary - was previously known as
DEEWR and before that, as DEST.

For TACs that provide prior education data as FACT codes, associate a FACT code with the applicable
DEST Reference Number. The system uses the DEST Reference Number and Fact Code mapping to
report highest education attainment so that DIISRTE can track the applicant's prior educational details.
The following table lists the DIISRTE (DEST) reference numbers:

DIISRTE Reference Number Description

1 Post Graduate Program

2 Degree Program

3 Sub Degree Program

4 VET Sub Degree Program

5 VET Award Program

6 VET Secondary Program

7 School Secondary Program

8 Other Program
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You can set up FACT codes that are not associated with the applicant's prior education data. In this case,
the DEST Reference Number for these FACT codes must be set to Not DEST. The Not DEST mapping
setup is optional, and the system uses this setup for its internal processes.

The TAC Load process posts all FACT codes into suspense records. These codes form a part of the
candidate data records after the application is posted, regardless of whether the configuration for these
codes is maintained on the DEST Number Map page. The system posts the prior education data into the
PeopleSoft database only if you have mapped the DEST numbers on the DEST Number Map page.

Note: SATAC provides the prior education data in the applicant file, not the FACT file. Therefore, DEST
number mapping is optional for SATAC.

To view the student DEST information after you import the TAC data, select Campus Community >
Personal Information > Biographical > Personal Attributes > Student Data AUS.

Related Links
"(AUS) Entering Student Data" (Campus Community Fundamentals)

Mapping TAC Country Codes
Access the Country Map page (Set Up SACR > Product Related > Recruiting and Admissions >
TAC > Country Map).

Enter the TAC country code that you want to associate with each PeopleSoft country code. The TAC Load
process uses this mapping to load the data listed in the following table:

Data Supplied by QTAC Supplied by UAC Supplied by SATAC Supplied by VTAC

Country of Address Yes Yes Yes Yes

Country of Birth No Yes Yes Yes

Country of Citizenship No No Yes No

Note that for VTAC you must have a row in which TAC Country Code AUSTRALIA  maps to Country
code AUS. This mapping is required so that the TAC Load process can load the VTAC residential and
postal address data that do not have a country value.

Mapping TAC State Codes
Access the State Code Map page (Set Up SACR > Product Related > Recruiting and Admissions >
TAC > State Code Map).

Enter the TAC state code that you want to associate with each PeopleSoft state code. The TAC Load
process uses this mapping to identify the state values in applicant address data.

800  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 25 (AUS) Managing Tertiary Admissions Centre Data Loads

Adding Organization Values
Access the Organization Table page (Campus Community > Organization > Create/Maintain
Organizations > Organization Table > Organization Table).

This example illustrates the fields and controls on the Organization Table page. You can find definitions
for the fields and controls later on this page.

Add external organization codes that represent the applicants' schools. The TAC Load process uses the
organization codes to post applicant's external education and last school attended data.

You must add the following organization codes if you want to import VTAC files:

Organization Code Description

NON VIC SCH Add this organization code for non-Victorian secondary school
qualification records in the VTAC offer file.

If you add this organization code, the TAC Load process
assumes the external organization code as NON VIC SCH for
qualifications where the School Code is blank.

EXT INSTITN Add this organization code if you do not want to configure an
external organization for each institution that may exist in the
overseas qualifications data.

If the TAC Load process does not find a mapping between the
TAC External Institution Name and an external organization
on the External Organization Map page and you have added
EXT INSTITN as an organization code, the process assumes
EXT INSTITN as the organization code for the post-secondary
level overseas qualifications.
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Related Links
"Understanding Organizations" (Campus Community Fundamentals)

Defining TAC Subjects
Access the School Subject Maintenance page (Campus Community > Organization > Create/
Maintain Organizations > School Subject Maintenance).

This example illustrates the fields and controls on the School Subject Maintenance page (1 of 2).
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This example illustrates the fields and controls on the School Subject Maintenance page (2 of 2).

Enter the TAC subject codes and subject code details that you want to associate with each external
organization.

Mapping External Organization Values
Access the External Organization Map page (Set Up SACR > Product Related > Recruiting and
Admissions > TAC > External Organization Map).
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This example illustrates the fields and controls on the External Organization Map page. You can find
definitions for the fields and controls later on this page.

Year 12 Type

Enter the valid year 12 course codes for this organization. This data corresponds to the year 12 type in the
applicant subject file for QTAC.

External Institution

Use this field for VTAC when you want to map overseas institution names to a specific external
organization ID. VTAC data related to the Overseas Post Secondary Qualifications contain only an
overseas institution name; this field allows you to map an overseas institution to an external organization
ID.

You must set up an organization ID with a value of EXT INSTITN if you do not want to maintain separate
organization IDs for the overseas institutions that may exist in the VTAC overseas qualifications data.
If the external institution and external organization ID mapping does not exist, the TAC Load process
assigns EXT INSTITN as the external organization ID for the overseas qualifications.

Origin of Qualification

Map origin of qualification values to the external organization. The values that you enter here correspond
to the origin of qualification values in the application qualification file for QTAC and UAC.

Subject Code Mapping

Map TAC subject codes to the school subjects of the external organization.
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Mapping TAC Qualification Levels
Access the Qualification Level Map page (Set Up SACR > Product Related > Recruiting and
Admissions > TAC > Qualification Level Map).

Map TAC qualification level codes to PeopleSoft external academic level codes.

Mapping TAC Prefixes
Access the Name Prefix Map page (Set Up SACR > Product Related > Recruiting and Admissions >
TAC > Name Prefix Map).

Enter the TAC name prefix that you want to associate with each PeopleSoft prefix.

VTAC does not provide name prefixes. Therefore, for VTAC, the TAC Run Search/Match Post process
automatically inserts a name prefix of Mr if the applicant gender is Male and Ms if the applicant gender is
female. The TAC Load process does not log any messages related to name prefix mapping because VTAC
does not provide the name prefix in its load file.

Defining a Program Action Reason
Access the Program Action Reason Table page (Set Up SACR > Product Related > Student
Records > Program Action > Program Action Reason Table).

This example illustrates the fields and controls on the Program Action Reason Table page.

Map program action reason codes to the program action of Admit.

VTAC does not provide a basis of admission. For VTAC, define a program action reason OFFR  so that
the TAC Load process can assign the program action reason OFFR to the applications with admission
offers.

Mapping Basis of Admissions Values
Access the Basis of Admission Map page (Set Up SACR > Product Related > Recruiting and
Admissions > TAC > Basis of Admission Map).
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Map the basis of admission values provided by TAC to the action reasons you defined on the Program
Action Reason Table page. The TAC Load process uses this mapping to insert the action reasons into
admission applications. Additionally, the PeopleSoft DIISRTE reporting processes use the action reasons
to report Element 327 - Basis for Admission to Current Courses.

Related Links
"Understanding the DIISRTE File Generation Process" (Student Records)

Mapping TAC Admit Type Values
Access the Admit Type Map page (Set Up SACR > Product Related > Recruiting and Admissions >
TAC > Admit Type Map).

For SATAC, map external basis of admission codes to admit type values.

Mapping TAC Citizenship Codes
Access the Citizenship Map page (Set Up SACR > Product Related > Recruiting and Admissions >
TAC > Citizenship Map).

Define citizenship mapping rules to map TAC citizenship codes to citizenship statuses and PeopleSoft
residency codes.

Mapping Ethnicity
Access the Ethnicity Map page (Set Up SACR > Product Related > Recruiting and Admissions >
External Test Scores > Ethnicity Mapping).

The TAC Load process uses this mapping to associate UAC FACT Codes to applicants. UAC FACT
Codes provide information about an applicant's Aboriginal and Torres Strait Island origin.

The PeopleSoft DIISRTE reporting processes use the ethnicity codes to report DIISRTE Element 316.

The following table shows the required mapping for UAC.

Ethnic Group Ethnicity Code

Aboriginal 3

Torres Strait Islander 4

Aboriginal and Torres Strait Islander 5

The following table shows the required mapping for VTAC.
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Ethnic Group Ethnicity Code

Caucasian 2

Aboriginal 3

Torres Strait Islander 4

Aboriginal and Torres Strait Islander 5

The TAC load process uses this VTAC mapping to load the ethnic code from the VTAC Aboriginal and
Torres Strait Islander offer file element.

Language Mapping
Access the Language Table page (Set Up SACR > Product Related > Student Records > Enrolment
Reporting Codes > AUS Regulatory Report Setup > Language Table).

Map Department of Industry, Innovation, Science, Research and Tertiary Education (DIISRTE) language
codes to the PeopleSoft language codes. The DIISRTE language codes must be the same as the Language
Spoken at Home values in the TAC load file. The TAC Load process uses this mapping to load the
PeopleSoft language code in the TAC suspense component (for example, the TAC load process loads RU
when it finds 3402 for an applicant in a TAC file). The DIISRTE reporting processes use this mapping
to report the DIISRTE language code for element 348 (for example, the DIISRTE reporting processes
include 3402 in the extract file when it finds an applicant with a RU value in your database).

See "Setting Up DIISRTE Reporting Codes" (Student Records)

Mapping Offer Period
Access the Offer Period Mapping page (Set Up SACR > Product Related > Recruiting and
Admissions > TAC > Offer Period Mapping).
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This example illustrates the fields and controls on the Offer Period Mapping page . You can find
definitions for the fields and controls later on this page.

You must have a offer period mapping record for each career and admit term combination.

Field or Control Description

Copy from Career Copy a offer period mapping record of a career. The system
displays the Copy from Career field when you enter the page
on an add mode.

Offer Year and Offer Month You must enter all the possible offering year and month
combinations that may be provided in a TAC file relevant to
the career and admit term.

When a QTAC File is posted, the TAC Search/Match/Post
process will assign the admit term according to the offering
year and month mapping for the career applicable to the
applicant's program. If there is no mapping for the year and
month combination, the admit term on the run control will be
assigned.

Note: This logic is relevant to only QTAC. For UAC, SATAC
and VTAC the system assigns the admit term directly from the
TAC load files.

Mapping Honors Category
Access the Honors Category Map page (Set Up SACR > Product Related > Recruiting and
Admissions > TAC > Honors Category Map).
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Field or Control Description

TAC Honors Code Enter the honors code provided in the TAC Qualifications file.

Honors Category Enter the PeopleSoft honors category applicable to the TAC
honours code.

Note: You should perform this mapping only if you are loading QTAC data.

Processing TAC Loads

This section provides an overview of TAC processing and discusses how to set up load parameters and
load the file.

Understanding TAC Data Load Processing
Recruiting and Admissions supports loading the data files received from the following TACs: QTAC,
SATAC, UAC, and VTAC. The data files contain personal information, previous education data, year 12
results, and details of offer or preferences. For each TAC, you first load data into suspense tables. Then
run the search/match process to verify whether there is an existing record for the applicant in the system.
Finally, post the bio/demo and remaining applicant data to your database. The Search/Match/Post process
posts self-reported academic information to TAC candidate data tables so that the system maintains the
history of data provided with the application. You follow this process for each TAC.

Regardless of the TAC, the same components are used to load, view, post, and purge TAC data. The test
ID of the TAC you are processing must be entered on each component. The entry of the TAC test ID
determines which fields appear on each page. The TAC test IDs shown in the prompt are based on your
TAC test ID security. You must have test ID security defined in order to process TAC data loads.

See "Setting Security for Test IDs" (Campus Solutions Application Fundamentals).

To process TAC data:

1. Use the TAC Load process to load the TAC data from one or more files in your directory into the
suspense tables.

2. Review and edit the data that you loaded in suspense pages.

Correct all load errors before moving on to the next step. In the search page of the TAC Suspense
component, enter the TAC test ID, Error, in the Edit Processing Option field and click the Search
button. Access each suspense record and correct the errors until every suspense record has a value of
Complete (rather than Error) in the Edit field on the Process Options page.

3. After you have corrected all of the load errors, run the search/match/post process.

This process looks for data in your database, based on search parameters that you define on the
search/match criteria pages, that matches the data that you are posting. For a set of parameters that
suggest only a possible match (such as name and gender, for example), the process will not post the
record until you can manually determine which records are actually duplicates.
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4. Access each suspense record that did not get posted to confirm the appropriate post action to assign to
the applicant.

In the search page of the TAC Suspense component, enter the TAC test ID, Complete in the Edit
Processing Option field and Perform in the Search/Match Processing Option field. Then click the
Search button. The search process finds only those suspense records that went through the search/
match/post process but do not have a post processing option of New ID Add or Update ID. The reason
the search/match/post process does not assign a New ID Add or Update ID post processing option
is because of the settings on the Search Parms page. If the system finds multiple or partial matches
for applicants and the setting for these matches are set to suspend, you must manually determine
whether to post or ignore these applicant records. After you access the TAC Suspense component,
find the parameters for which the process identified a match, then use Search/Match to look up the
bio/demo information that matches the suspense record and verify whether a person in the incoming
data already exists in the system. Then, specify whether you want the search/match/post process to
add the bio/demo and TAC record to your database, update an existing record, or ignore the suspense
record altogether.

5. Run the search/match/post process again.

The process posts the suspense records that you manually tagged to post. In addition, the process
posts the suspense records that went through the Search/Match process and are ready to be posted.
By this time, all of your suspense records should be posted to your database. When a record posts to
your database, the search/match/post process assigns an ID to the applicant. To view an applicant's
ID, select Student Admissions > TAC Processing > TAC Suspense > Personal Information or
Student Admissions > TAC Processing > TAC Candidate Data > Personal Information.

6. Purge the suspense tables.

You should purge the suspense tables as soon as all of the suspense records are posted to the database.

7. Review TAC Candidate Data. (optional)

After the system posts the TAC application data, you can view this data on the TAC Candidate Data
component.

Page Used to Load TAC Data

Page Name Definition Name Navigation Usage

TAC Load SAD_TAC_LOAD_RUN Student Admissions > TAC
Processing > TAC Load

Specify a TAC test ID and
designate the directory
location for each of the TAC
files. Run the load process.

Note: You should complete
the full loading, search/match
and posting process before
loading a new set of data. If
you have TAC loads waiting
to be processed, do not load a
new TAC file until you have
processed the data in your
suspense files.
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Setting Up Load Parameters and Loading the File
Access the TAC Load page (Student Admissions > TAC Processing > TAC Load).

This example illustrates the fields and controls on the TAC Load page. You can find definitions for the
fields and controls later on this page.

The number of input files that you can use depends on the TAC test ID that you enter. For example, the
TAC Load page displays five file input fields for UAC and thirteen file input fields for SATAC.

The following table indicates the type of data you must load with the various File Input Path fields.

File Number QTAC UAC SATAC VTAC

File Input Path # 1 Applicant Applicant Applicant Offer File

File Input Path # 2 FACT FACT Academic
Qualifications

File Input Path # 3 Qualifications Qualifications Other Qualifications

File Input Path # 4 Subject Subject Employment
Qualifications

File Input Path # 5 Preferences Year 12 Subjects

File Input Path # 6 Preferences

File Input Path # 7 Preference Course
Rank Set
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File Number QTAC UAC SATAC VTAC

File Input Path # 8 FACT

File Input Path # 9 International
Applicants Personal
Additional Data

File Input Path # 10 Origin Codes

File Input Path # 11 Year 12 School Codes

File Input Path # 12 Employment and
Occupation Codes

File Input Path # 13 HEIMS

Field or Control Description

Test ID Enter the TAC test ID that you want to load. Define TAC test
ID values on the Test Tables page. Once the TAC test ID is
entered, the additional fields specific to the TAC will appear.
 You must have test ID security established in order to select a
value. This field is required.

Academic Institution Enter the institution for which you want to load the data.

Admit Type Applicable to only SATAC and VTAC.

Enter a value only if applicants do not have an admission
offer (basis of admission).

Date Loaded Enter the date of the data load process. The system populates
this field to the current date by default.

Processing Indicator Applicable to only VTAC.

Select a value applicable to the offer file that you want to load.
 You must select Undergrad for an undergraduate offer file and
Graduate for an offer file that contains postgraduate applicant
records.

Initial Course Character Applicable to only SATAC.

Use to filter and load preferences relevant to your institution.
 The TAC Load process selects only those courses from the
preferences file that commence with the character that you
enter in this field.
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Field or Control Description

Offers Applicable to only SATAC.

Select to load only those courses from the preferences file that
TAC has offered to the applicants

If you do not select this check box, the TAC Load process
loads all the preferences depending on the Initial Course
Character value.

File Input Path Enter the path of the directory and file where the TAC data
resides. These fields are required. How you complete the
fields depends on the TAC you are processing. In order for the
upload to work correctly, you must list the input files in the
correct order.

Run Click the run button to run the SAD_TAC_LOAD Application
Engine process at user-defined intervals.

Note: To check for errors during the program run, review the trace file created by the Application Engine
program. Nonfatal errors will appear in the Error Indicators group box in the TAC Suspense component.

Reviewing and Editing Data in the Suspense Record

This section provides an overview of the suspense phase and discusses how to:

• Review process options.

• Review personal information.

• Review and edit data in the suspense record.

Understanding, Correcting, and Editing Suspense Data
Before entering the TAC Suspense component, you must enter the TAC test ID. The pages in the
component dynamically appear based on the TAC test ID you enter. The pages in the component are
very similar in the way they look and work. For example, every suspense component has a Personal
Information page. In addition, they all share the first page – Process Options. Many of the values and
codes that appear in the suspense component are based on values and codes that the TAC defines. Contact
the TAC that manages the application for full descriptions of the data that appears in these pages or refer
to the data layouts you receive from the TAC.

Note: Data in suspense tables does not affect tables in your database until you post the data. In addition,
if you find an error in the suspense component after you post the data, you have to go to the appropriate
page in your database to make any changes. For example, if you find an error on the Personal Information
page in the Suspense component, you have to go to the Add/Update a Person component to correct the
error.
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Pages Used to Review and Edit Suspense Data

Page Name Definition Name Navigation Usage

Process Options SAD_TAC_SUS_PROC Student Admissions >
TAC Processing >
TAC Suspense > TAC
Suspense > Process Options

Review the status of a TAC
record regarding the loading,
 search/match, and posting
processing. For example,
 determine if a record is
waiting to be processed, if a
record instigated a new person
to be added to your database,
 or if any errors or warnings
were encountered during the
load or search/match/post
processes.

Personal Information SAD_TAC_SUS_BIO Student Admissions >TAC
Processing >TAC
Suspense >Personal
Information

Review and edit the student's
personal information in the
suspense record. Refer to the
data layouts from the TAC to
determine the fields that the
load process will populate.
 Each TAC has a Personal
Information page. The data
will vary depending on the
TAC.

Address SAD_TAC_SUS_ADDRC Student Admissions >
TAC Processing > TAC
Suspense > Address

This page appears only
when the TAC applicant
file contains more than one
address. Review and edit the
address information for the
applicant, if necessary. Note
that country and state code
mappings are required for
loading address data.

Qualifications SAD_TAC_SUS_QULSA Student Admissions >
TAC Processing > TAC
Suspense > Qualifications

Review and edit detailed
information about the
student's qualifications. These
details populate the external
education data as part of the
posting process.

Subjects SAD_TAC_SUS_SBJSA Student Admissions >
TAC Processing > TAC
Suspense > Subjects

Review and edit information
about subject courses taken
by the student. This data
populates external education
data as part of the posting
process.
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Page Name Definition Name Navigation Usage

Offers SAD_TAC_SUS_OFFER Student Admissions >
TAC Processing > TAC
Suspense > Offers

Review and edit basic
applicant and offer details.
 The data from this page
is used during the posting
process to populate admission
applicant data and admission
applicant program data.

Fact SAD_TAC_SUS_FACT Student Admissions >
TAC Processing > TAC
Suspense > Fact

Review and edit information
about the Fact codes and
values. These Fact codes
contain data for DIISRTE
statistical reporting and other
items specific to the TAC or
institution or both.

Residency SAD_TAC_SUS_RES Student Admissions >
TAC Processing > TAC
Suspense > Residency

Review and edit residency
details and additional
DIISRTE reporting fields
about the student. Data from
this page is used to populate
residency and DIISRTE
reporting fields as part of the
posting process.

Preferences SAD_TAC_SUS_PRFSA Student Admissions >
TAC Processing > TAC
Suspense > Preferences

Review and edit information
about applicant preferences.
 The data from this page
is used during the posting
process to populate the
applicant program data table.

VIC Data SAD_TAC_SUS_VIC_O2 Student Admissions >
TAC Processing > TAC
Suspense > VIC Data

Review and edit biographical
and demographic information
for this student from the
Victorian TAC.

Common Assessment Tasks SAD_TAC_SUS_CAT Student Admissions >
TAC Processing > TAC
Suspense > Common
Assessment Tasks

Review and edit information
about the Common
Assessment Tasks for
applicants from the Victorian
TAC.

VIC Results SAD_TAC_SUS_VIC_RS Student Admissions >
TAC Processing > TAC
Suspense > VIC Results

Review and edit information
about result summaries for
applicants from the Victorian
TAC.

VCAL Studies SAD_TAC_SUS_VCL Student Admissions >
TAC Processing > TAC
Suspense > VCAL Studies

Review and edit information
about VCAL studies for
applicants from the Victorian
TAC
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Page Name Definition Name Navigation Usage

VCAL Units SAD_TAC_SUS_VCU Student Admissions >
TAC Processing > TAC
Suspense > VCAL Units

Review and edit information
about VCAL units for
applicants from the Victorian
TAC.

Assessment Data SAD_TAC_SUS_VIC_AS Student Admissions >
TAC Processing > TAC
Suspense > Assessment
Data

Review and edit information
about assessment data related
to graduate entry teaching for
applicants from the Victorian
TAC.

PCRS (preference course rank
set)

SAD_TAC_SUS_PCRSA Student Admissions >
TAC Processing > TAC
Suspense > PCRS

The data on this page is
internal to the way students'
eligibility rankings are
determined. South Australian
institutions can refer to this
data.

Reviewing Process Options
Access the Process Options page (Student Admissions > TAC Processing > TAC Suspense > TAC
Suspense > Process Options).

This example illustrates the fields and controls on the Process Options page. You can find definitions for
the fields and controls later on this page.

This page provides the status of a suspense record regarding the loading, search/match and posting
processes. Any informational and error messages that TAC data load and search/match/post processes
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generate appear on this page. You can use this page to keep current on the status of an individual's TAC
processing. These messages can serve historical and analytical purposes, giving you a picture of the kinds
of errors encountered in your TAC processing. To do so, you would need to wait to purge your TAC
messages until you have completed your analysis.

Processing Options

Field or Control Description

Edit Displays the status of the record regarding the Load External
Data process. Values are:

Complete: The program was able to process the record without
a problem.

Error: The program encountered problems when processing
this record.

Perform: This value is only set manually and is for your
informational purposes.

Search Displays the status of the record regarding the Search/Match
process. Values are:

Complete: The Search/Match process was run without errors.

Error: The Search/Match process was run and errors were
detected on this record.

Perform: The Search/Match process has not yet been run for
this record.

Post Displays the status of the record regarding the Post process.
 These values can be entered manually, however, some are
entered by the system after processes are run, as described in
the following table.

Post Value Meaning How Set

Error The posting process encountered a
problem.

Set by the system during the Post
process.

New ID Add The system was unable to find a match in
the database and will add a record with a
new ID to your database when the Post
process is run.

Set by the system during the Search/
Match process if no match was found in
your database.
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Post Value Meaning How Set

Take No Action This value is only added manually. It is
not automatically entered by the system.
 If this value is entered, the Post and
Purge Suspense File processes ignore the
record.

Set manually.

Purge This value indicates that this suspense
record will be removed from the system
during the Purge Suspense File process.

Set by the system during the Post process
if the record was successfully processed
or if the Search/Match process ignored
the suspense record that matched a
record in your database.

Update existing ID The system found a matching ID in the
database. This existing ID record will
be updated with the data from this TAC
record during the process.

Set by the system during the Search/
Match process if a match was found in
the database and if your TAC Search
Parameters define that an update should
occur in this situation.

Awaiting Search This record is in the Suspense File and
is waiting to be processed by the Search/
Match process.

Set by the system during the TAC Load
External Data process.

Warning! While you can manually edit the values in the Edit, Search, and Post fields, keep in mind
that if a field contains Error and you manually change it without correcting an error, you may encounter
problems when posting the data. Edit, Search, and Post values are delivered with your system as
translate values. These translate values should not be modified in any way. Any modification to these
values will require a substantial programming effort.

Error Indicators

If Error appears in any of the Processing Options fields, the Error Indicators group box appears in the
areas an error occurred: Last Name, Birth Date, First Name and Academic Program Error. Correct any
errors on the appropriate pages in this component before running the post process. When you save the
changes, the processing options on the page update appropriately. For example, if the Edit field displays
Error, and you fix the error, the program updates the Edit field to Complete. You can view additional
information about these errors in the Messages group box on the Process Options page.

Search/Match Results

In the Search/Match Results group box, the system displays the order number of the search level
used to find a match for this person. Search order levels are defined on the Search/Match Criteria page.
Additionally, the system displays the number of matches found for this person.
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Messages

Field or Control Description

Message Severity The message severity, such as Message or Error.

Message Text The message on this row of data.

Description The detailed message.

Comments Results or other additional information about the message.

Process Instance The process number of the process that you ran for this record.
 The Process Scheduler generates this number.

Run Date/Time The day and time the process ran for this record.

Process Name The name of the application engine that you ran for this
record.

User ID The user ID of the person who ran the process.

Reviewing Personal Information
Access the Personal Information page (Student Admissions > TAC Processing > TAC Suspense >
Personal Information).
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This example illustrates the fields and controls on the Personal Information page (1 of 2).
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This example illustrates the fields and controls on the Personal Information page (2 of 2).

This page contains all biographical and demographic data loaded into the suspense table when a new
record is posted.

Reviewing Address Information
Access the Address page (Student Admissions > TAC Processing > TAC Suspense > Address).
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This example illustrates the fields and controls on the Address page.

Use this page to view applicant's current and residential addresses, if supplied by TAC. SATAC may
provide both the addresses. VTAC may provide a residential address which appears in this page.

Reviewing Residency Information
Access the Residency page (Student Admissions > TAC Processing > TAC Suspense > Residency).
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This example illustrates the fields and controls on the Residency page.

Use this page to view the applicant's biographical and demographical information if supplied by TAC.

To post the Highest Education Parent/Guardian 1 and Highest Education Parent/Guardian 2 data, you
must ensure that the configuration for DIISRTE Elements 573 and 574 is complete (Set Up SACR,
Product Related, Student Records, Enrolment Reporting Codes, AUS Regulatory Report Setup, Highest
Education).

The TAC Run Search/Match Post process posts the information from these two fields to the Student Data
AUS component (Campus Community, Personal Information (Student), Biographical (Student), Personal
Attributes, Student Data AUS).

Reviewing Qualification Information
Access the Qualifications page (Student Admissions >TAC Processing >TAC
Suspense >Qualifications).
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This example illustrates the fields and controls on the Qualifications page.

The information on the Qualifications page will vary depending on the TAC. For example, the page
displays TAC Origin of Qualification and School Code fields only for QTAC.

Reviewing Subjects Information
Access the Subjects page (Student Admissions >TAC Processing >TAC Suspense >Subjects).
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This example illustrates the fields and controls on the Subjects page.

The information on the Subjects page will vary depending on the TAC.

Reviewing Preferences
Access the Preferences page (Student Admissions >TAC Processing >TAC Suspense >Preferences).
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This example illustrates the fields and controls on the Preferences page.

The information on the Preferences page will vary depending on the TAC. The system does not display
this page for QTAC.

Reviewing VTAC Data
Access the VIC Data page (Student Admissions >TAC Processing >TAC Suspense > VIC Data).
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This example illustrates the fields and controls on the VIC Data page.

The system displays this page for only VTAC. Use this page to view profile and personal information
loaded from the VTAC offer file.

Reviewing Common Assessment Tasks
Access the Common Assessment Tasks page (Student Admissions > TAC Processing > TAC
Suspense > Common Assessment Tasks).
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This example illustrates the fields and controls on the Common Assessment Tasks page.

The system displays this page for only VTAC. Use this page to view Graded Assessment (CAT) results
data loaded from the VTAC offer file.

Reviewing VIC Results
Access the VIC Results page (Student Admissions > TAC Processing > TAC Suspense > VIC
Results).

This example illustrates the fields and controls on the VIC Results page.

The system displays this page for only VTAC. Use this page to view results summary information loaded
from the VTAC offer file.
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Reviewing VCAL Data
Access the VCAL Studies page (Student Admissions > TAC Processing > TAC Suspense > VCAL
Studies).

This example illustrates the fields and controls on the VCAL Studies page.

The system displays this page only for VTAC. Use this page to view information related to Victorian
Certificate of Applied Learning (VCAL) data.

Reviewing VCAL Units
Access the VCAL Units page (Student Admissions > TAC Processing > TAC Suspense > VCAL
Units).

This example illustrates the fields and controls on the VCAL Units page.

The system displays this page only for VTAC. Use this page to view information related to VCAL unit
data.
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Reviewing Assessment Data
Access the Assessment Data page (Student Admissions > TAC Processing > TAC Suspense >
Assessment Data).

This example illustrates the fields and controls on the Assessment Data page.

The system displays this page only for VTAC. Use this page to view information related to assessment
data for graduate entry teaching.

Reviewing Offers
Access the Offers page (Student Admissions > TAC Processing > TAC Suspense > Offers).
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This example illustrates the fields and controls on the Offers page.

The information on the Offers page will vary depending on the TAC. Use this page to view the applicant's
program of offer.

Reviewing FACT Data
Access the Fact page (Student Admissions > TAC Processing > TAC Suspense > Fact).

Copyright © 1988, 2021, Oracle and/or its affiliates. 831



(AUS) Managing Tertiary Admissions Centre Data Loads Chapter 25

This example illustrates the fields and controls on the Fact page.

Use this page to view the data loaded from the FACT file.

The Fact codes mapped to DEST Reference Numbers are posted to DEST Education Participation
Details section of the Student Data AUS page. Select Campus Community > Personal Information
(Student) > Biographical (Student) > Personal Attributes > Student Data AUS to navigate to the
Student Data AUS page.

Reviewing PCRS Data
Access the PCRS page (Student Admissions > TAC Processing > TAC Suspense > PCRS).

This example illustrates the fields and controls on the PCRS page.

The system displays this page only for SATAC. Use this page to confirm that the data has been loaded
from the Preference Course Rank Set file.
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Performing Search/Match and Posting TAC Data

This section provides an overview of how to search/match and post external data, and discusses how to:

• Enter TAC run parameters.

• Enter TAC search/match parameters.

Understanding Performing Search/Match and Posting TAC Data
Once you have loaded the TAC data to the suspense file, you specify on the Search Parms page which
TAC data to load into your database as new records, which TAC data to append to existing records in
your database, and which TAC data to ignore or suspend. After choosing your search/match parameters,
you can also set up the parameters for posting the TAC data, and you can run both processes at once: to
update the suspense file accordingly and to post the TAC external data. Alternatively, you can first run the
search/match process to update the suspense file and then later run the posting process to post the TAC
external data to your database.

Admissions Information that the TAC Bulk Offer Data Load Populates

Examples of the admissions information populated by the TAC Post Process include:

• Personal data.

• Name and address data.

• Personal phone.

• Application Program Data page information.

• If there are multiple preferences, then additional program application data.

• Test results.

• External education data and school loading data including external degrees, courses, and subjects.

• Residency data.

• Government reporting information including education and training data, and Commonwealth Higher
Education Student Support Number (CHESSN) and Student Learning Entitlement (SLE) information.
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Pages Used to Perform Search/Match and Post TAC Data Loads

Page Name Definition Name Navigation Usage

TAC Run Search/Match Post SAD_TAC_POST_RUN Student Admissions > TAC
Processing > Search/Match/
Post TAC > TAC Run
Search/Match Post

Post external TAC data from
suspense files. Before you
post the data, however, set up
the search/match parameters
on the Search Parms page.
 You can post a single record
or all of the records in the
suspense file.

Search Parms SEARCH_PARMS Student Admissions > TAC
Processing > Search/Match/
Post TAC > Search Parms

Define search and match
parameters, which specify
the data that the system will
append to existing records in
your database and the TAC
data that the system will
ignore.

See "Setting Up Search/
Match" (Campus Community
Fundamentals)

Entering TAC Run Parameters
Access the TAC Run Search/Match Post page (Student Admissions > TAC Processing > Search/
Match/Post TAC > TAC Run Search/Match Post).
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This example illustrates the fields and controls on the TAC Run Search/Match Post page. You can find
definitions for the fields and controls later on this page.

Enter the TAC test ID that you want to process. Once the TAC test ID is entered, the additional fields
specific to the TAC will appear. You must have test ID security established to select a value. The prompt
will only display test IDs for which you have security. This field is required.

Execution Option

Field or Control Description

Search, Match and Post Select this option if you want the process to search your
database for records that match the suspense record and post
the suspense data to your database.

Post Only Select this option if you only want to post the suspense data to
your database (if you select this option, you must have already
run search/match).
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Field or Control Description

Search and Match Only Select this option if you only want to run the search and match
process on the suspense file. You will need to post the data
later.

Post Processing Parameters

Field or Control Description

Academic Institution Enter the academic institution to which the applicant data will
be posted.

Date Loaded Enter the date for the data load.

Process Single Record If you prefer to process and post a single record, in the Post
Processing Parameters group box, select the Process Single
Record check box and specify the external applicant number.
 Rather than processing the entire file, you can quickly process
a single record. If you prefer to process the entire suspense
file, do not select Process Single Record.
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Field or Control Description

Address Type If the search/match/post process adds a new record to your
database, the process loads the address information from the
TAC suspense record into the Addresses page. Select the
address type that you want the process to assign to the new
address. Define address types in the Address Type table.

For VTAC data:

• The search/match/post process assigns the address type
that is set on the TAC Run Search/Match Post page to the
postal address referenced on the Personal Information
suspense page.

• The search/match/post process assigns the home address
type set on the Campus Community Installation -
Names / Addresses page to the residential address.

• If the Campus Community home address type field and
the Address Type field have the same value (for example,
 campus), the search/match/post process posts only the
postal address to the database and does not post the
residential address.

Note: Do not select an address type if you want to post a
SATAC file. The TAC Load process, by default, assigns
the MAIL address type to the postal addresses provided by
SATAC. Additionally, the TAC Load process, by default,
 assigns the HOME address type to the current addresses
provided by SATAC.

Phone Type Select the phone type that you want the process to assign.

Email Type Select the email type that you want the process to assign.

Academic Level Select the default academic level for this upload of applicants.

Application Method Select the default application method for this upload of
applicants.

Academic Career Enter the academic career to which applicants will be posted.

Admit Term Enter the admit term for the applicants.

Application Center Enter the default application center for these applicants.
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Field or Control Description

Recruiting Center Enter the default recruiting center for this upload of applicants.

Entering TAC Search/Match Parameters
Access the Search Parms page (Student Admissions > TAC Processing > Search/Match/Post TAC >
Search Parms).

This example illustrates the fields and controls on the Search Parms page. You can find definitions for the
fields and controls later on this page.

Use the Search Parameter field to select the group of predefined search parameters you want to use for
the process.

Note: The words Parameters Refreshed appear if this is the first time that you have entered this page with
this run control ID, or if any of the parameters on this page changed since the last time you accessed this
page with this run control ID.
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No Match Found

Field or Control Description

New Select one of the following options to specify what the search/
match/post process should do when it does not find a matching
record in your database:

Add: Add the unmatched record to your database, including
personal data.

Suspend: Keep the unmatched record in the suspense file to be
looked at manually.

Ignore: Ignore the unmatched record completely. The process
marks the record to be purged.

Match(es) Found

This group box contains one row for each search/match criteria order defined by your institution. Define
search/match orders on the Search/Match Criteria page.

Field or Control Description

Order Nbr (order number) For each order number, select what you want to do with the
record if the search/match/post process discovers one or more
matching records.

One Match and Multiple Matches Select whether you want to add, update, suspend, or ignore
matching records:

Add: Add a new record to your database using the suspense
record.

Update: Update the existing record with the data in the
suspense record.

Suspend: Keep the suspense record back in the suspense table.

You need to determine manually whether or not this record
matches a record in your database.

Ignore: Ignore the suspense record that matched a record in
your database.

The process marks the record to be purged.
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Purging TAC Suspense Files and Messages

This section provides an overview of the purge process and discusses how to purge suspense data.

Understanding the Purge Process
Specify which TAC suspense file records to purge, and do the actual purging on the TAC Purge
Parameters page. You can also purge TAC messages in this process. If you want to perform an analysis
on your processing, perhaps at the end of a year, do not purge your messages with this process. Instead,
purge them later, when you no longer need to view them.

Page Used to Purge TAC Suspense Data

Page Name Definition Name Navigation Usage

TAC Purge SAD_TAC_PURGE Student Admissions > TAC
Processing > TAC Purge

Purge suspense records and
messages for a specific TAC
test ID.

Purging Suspense Data
Access the TAC Purge page (Student Admissions > TAC Processing > TAC Purge).

Field or Control Description

TAC Code Enter the TAC test ID that you want to delete from the
suspense record. The TAC test ID list that appears in the
prompt is based on the test ID security.

Date Loaded Enter the date when the files, which you want to purge, were
loaded.

All Suspense Rows Select this option if you want to purge all of the records in
your suspense table, regardless of the status of the Post field
on the Process Options page.

Marked Suspense Rows Select this option if you only want to purge those records
in your suspense file marked Purge in the Post field on the
Process Options page. Select this option if you want to remove
all suspense records that have been posted or set to purge
and retain the suspense records outstanding for review or
processing. The purge process will only delete suspense
records with Purge in the Post field on the Process Options
page.

Retain Associated Messages Select this option if you want to retain messages that are
associated with the suspense records that you are purging.

840  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 25 (AUS) Managing Tertiary Admissions Centre Data Loads

Field or Control Description

Remove Associated Messages Select this option if you want to remove messages that are
associated with the suspense records that you are purging.

Reviewing TAC Candidate Data

This section provides an overview of TAC student profile data and lists the pages used to review profile
data.

Understanding TAC Candidate Data
After running the TAC Run Search/Match Post process, TAC student profile information, if posted to an
ID, appears in the TAC Candidate Data component. Note that the TAC Load process loads the TAC file
data to the suspense file for all TAC records. Suspense file data, however, is eventually purged, so the
TAC Candidate Data pages have been provided so that you can later view the TAC data for those records
that posted.

The data on these pages is informational only. The Date Loaded field is also a key on the candidate data.
Your institution therefore has a complete audit trail on what has been posted for a student, you can display
the initial creation plus later updates from any additional offer rounds.

Not all data contained in the suspense tables is posted to the Recruiting and Admissions application. The
system populates only minimal personal data; applicant data, external education data, and residency data
in order to create an applicant. The student profile provides a means of inquiring on all data loaded to the
suspense files for a posted student. This means your institution can refer back for a student's total TAC
data but not all of it is used to create the student's admissions record.

The pages and data that appear on the TAC Candidate Data component are similar to the pages and data
that appear on the TAC Suspense component. However, you cannot modify any information on the TAC
Candidate Data component because the data has already been posted. The number of pages on the TAC
Candidate Data component will vary depending on the TAC test ID.

Pages Used to View TAC Student Profile Data

Page Name Definition Name Navigation Usage

Personal Information SAD_TAC_CD_BIO Student Admissions >
TAC Processing > TAC
Candidate Data > Personal
Information

Demographic data appears
on this page from the
TAC Suspense–Personal
Information page. This page
also indicates if a personal
record was created for this
person in your database.
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Page Name Definition Name Navigation Usage

Address SAD_TAC_CD_ADD_CUR Student Admissions >
TAC Processing > TAC
Candidate Data > Address

Review address details about
a student.

Qualifications SAD_TAC_CD_QULSAS Student Admissions >
TAC Processing >
TAC Candidate Data >
Qualifications

Review qualifications details
for a student.

Subjects SAD_TAC_CD_SBJSA Student Admissions >
TAC Processing > TAC
Candidate Data > Subjects

Review subjects taken by a
student.

Offer SAD_TAC_CD_OFFER Student Admissions >
TAC Processing > TAC
Candidate Data > Offer

Review details about the offer
for a student.

Fact SAD_TAC_CD_FACT Student Admissions >
TAC Processing > TAC
Candidate Data > FACT

Review FACT data (including
DIISRTE questions) about a
student.

Residency SAD_TAC_CD_BIO_RES Student Admissions >
TAC Processing >
TAC Candidate Data >
Residency

Review residency and
additional DIISRTE reporting
information about a student.

Preferences SAD_TAC_CD_PRFSA Student Admissions >
TAC Processing >
TAC Candidate Data >
Preferences

Review preference details for
a student.

VIC Data SAD_TAC_CD_VIC_OTR Student Admissions >
TAC Processing > TAC
Candidate Data > VIC Data

Review biographical and
demographic information for
a student from the Victorian
TAC.

Common Assessment Tasks SAD_TAC_CD_CAT Student Admissions >
TAC Processing > TAC
Candidate Data > Common
Assessment Tasks

Review common assessment
task details for a student.

VIC Results SAD_TAC_CD_VIC_RSL Student Admissions >
TAC Processing > TAC
Candidate Data > VIC
Results

Review results details for a
student from the Victorian
TAC.
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Page Name Definition Name Navigation Usage

VCAL Studies SAD_TAC_CD_VCL Student Admissions >
TAC Processing > TAC
Candidate Data > VCAL
Studies

Review information about
VCAL Studies.

VCAL Units SAD_TAC_CD_VCU Student Admissions >
TAC Processing > TAC
Candidate Data > VCAL
Units

Review information about
VCAL units.

Assessment Data SAD_TAC_CD_VIC_AS Student Admissions >
TAC Processing >
TAC Candidate Data >
Assessment Data

Review information about
assessment data for graduate
entry teaching.

PCRS (preference course rank
set)

SAD_TAC_CD_PCRSA Student Admissions >
TAC Processing > TAC
Candidate Data > PCRS

Review a student's preference
course rank set information.
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(CAN) Receiving External Applications from
OUAC

Understanding External Applications from OUAC

Universities in Ontario, Canada use the Ontario Universities Application Center (OUAC) throughout their
undergraduate admissions process. The OUAC collects much of the undergraduate admissions data from
various sources and electronically transmits the data to institutions in Ontario.

PeopleSoft developed the OUAC interface using EDI Manager. This tool enables you to load data that
you receive electronically from OUAC into your PeopleSoft application. The system posts personal data,
application data, academic history, and testing information to core tables in your database.

To process OUAC transactions, you run a pre-load process that prepares the OUAC file for EDI. Then
you load the data from the OUAC file into staging tables in your application. While the data is in the
staging tables you can view and edit the data. When you are ready, you post the data to tables in your
application.

The OUAC defines the fields on these pages. Please refer to the OUAC Systems Manual for explanations
of the individual fields on each page.

Pre-Loading OUAC Data

This section discusses how to pre-load OUAC data.

Page Used to Pre-Load OUAC Data

Page Name Definition Name Navigation Usage

OUAC Pre Load Parms 
(OUAC pre load parameters)

OUAC_PRELOAD_PARMS Student Admissions >
OUAC > Processes > Pre
Load Data Process

Prepare the OUAC file for
EDI. The OUAC pre load
process adds control records
to transaction groups and
sends them to the output file.

Pre-Loading OUAC Data
Access the OUAC Pre Load Parms (OUAC pre load parameters) page (Student Admissions > OUAC >
Processes > Pre Load Data Process).
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This example illustrates the fields and controls on the OUAC Pre Load Parms page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Input File Enter the full path and name of the OUAC file that you want to
process.

Output Des (output description) Enter the full path and name of the output file.

Click the Run button to run the OUAC pre load process at user-defined intervals.

Loading the OUAC Data Through the EDI Manager

Use the Schedule Inbound EC Agent - Run Control Parameters page to load the OUAC data through EDI
Manager. The Inbound EC Agent process (ECIN0001) translates the values in the flat file created by the
OUAC pre-load process and loads them into staging tables. Set the run option parameter to single file and
the force profile parameter to do not force.

See Also

Product documentation for PeopleTools: Supported Integration Technologies

Loading Additional Data Through an SQR Process

This section discusses how to load additional data through an SQR process.
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Page Used to Load Additional Data Through an SQR Process

Page Name Definition Name Navigation Usage

OUAC Load PRCSRUNCNTL_AD_OL Student Admissions >
OUAC > Processes > Load
OUAC Data

Translate OUAC data
that EDI Manager is not
equipped to handle (such
as dates that are in YYMM
format, name fields that
need to be converted to the
PeopleSoft format, and other
character fields that need to be
converted to mixed case).

Reviewing and Editing the OUAC Transaction A/U Staging Tables

This section lists the pages in the OUAC Transactions A/U component used to review and edit OUAC
transaction data.

Pages Used to Review and Edit the OUAC Transaction A/U Staging Tables

Page Name Definition Name Navigation Usage

OUAC A1/U1 OUAC_A1_U1_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U

Review and edit OUAC
transaction data.

OUAC A2/U2 OUAC_A2_U2_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A2/U2

Review and edit OUAC
transaction data.

OUAC A3/U3 OUAC_A3_U3_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A3/U3

Review and edit OUAC
transaction data.

OUAC A4/U4 OUAC_A4_U4_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A4/U4

Review and edit OUAC
transaction data.

OUAC A5/U5 OUAC_A5_U5_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A5/U5

Review and edit OUAC
transaction data.
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Page Name Definition Name Navigation Usage

OUAC A6/U6 OUAC_A6_U6_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A6/U6

Review and edit OUAC
transaction data.

OUAC A7/U7 OUAC_A7_U7_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A7/U7

Review and edit OUAC
transaction data.

OUAC A8/U8 OUAC_A8_U8_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A8/U8

Review and edit OUAC
transaction data.

OUAC A9/U9 OUAC_A9_U9_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
A9/U9

Review and edit OUAC
transaction data.

OUAC AR OUAC_AR_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
AR

Review and edit OUAC
transaction data.

Reviewing and Editing the OUAC Transaction B5 Staging Tables

This section lists the page in the OUAC Transactions B5 component used to review and edit the OUAC
transaction data.

Page Used to Review and Edit the OUAC Transaction B5 Staging Tables

Page Name Definition Name Navigation Usage

OUAC B5 OUAC_B5_PNL Student Admissions >
OUAC > Transactions >
Transactions A/U > OUAC
B5

Review and edit OUAC
transaction data.
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Reviewing and Editing the OUAC Transaction B/V-E Staging
Tables

This section lists the pages used in the UAC Transactions B/V-E component to review and edit OUAC
transaction data.

Pages Used to Review and Edit the OUAC Transaction B/V-E Staging Tables

Page Name Definition Name Navigation Usage

OUAC B1/V1 OUAC_B1_V1_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E

Review and edit OUAC
transaction data.

OUAC B2 OUAC_B2_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC B2

Review and edit OUAC
transaction data.

OUAC B7/V7 OUAC_B7_V7_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC B7/V7

Review and edit OUAC
transaction data.

OUAC B8/V8 OUAC_B8_V8_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC B8/V8

Review and edit OUAC
transaction data.

OUAC B9/V9 OUAC_B9_V9_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC B9/V9

Review and edit OUAC
transaction data.

OUAC C1 OUAC_C1_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC C1

Review and edit OUAC
transaction data.

OUAC C2 OUAC_C2_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC C2

Review and edit OUAC
transaction data.

OUAC D1 OUAC_D1_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC D1

Review and edit OUAC
transaction data.
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Page Name Definition Name Navigation Usage

OUAC E1 OUAC_E1_PNL Student Admissions >
OUAC > Transactions >
Transactions B/V - E >
OUAC E1

Review and edit OUAC
transaction data.

Reviewing and Editing the OUAC Transaction F Staging Tables

This section lists pages used in the OUAC Transactions F component to review and edit OUAC
transaction data.

Pages Used to Review and Edit the OUAC Transaction F Staging Tables

Page Name Definition Name Navigation Usage

OUAC F1 OUAC_F1_PNL Student Admissions >
OUAC > Transactions >
Transactions F

Review and edit OUAC
transaction data.

OUAC F2 OUAC_F2_PNL Student Admissions >
OUAC > Transactions >
Transactions F > OUAC F2

Review and edit OUAC
transaction data.

OUAC F3 OUAC_F3_PNL Student Admissions >
OUAC > Transactions >
Transactions F > OUAC F3

Review and edit OUAC
transaction data.

Reviewing and Editing the OUAC Transaction G/H Staging Tables

This section pages used in the OUAC Transactions G/H component to review and edit OUAC transaction
data.

Pages Used to Review and Edit the OUAC Transaction G/H Staging Tables

Page Name Definition Name Navigation Usage

OUAC G1/H1 OUAC_G1_H1_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H

Review and edit OUAC
transaction data.
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Page Name Definition Name Navigation Usage

OUAC G2/H2 OUAC_G2_H2_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H > OUAC
G2/H2

Review and edit OUAC
transaction data.

OUAC G3/H3 OUAC_G3_H3_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H > OUAC
G3/H3

Review and edit OUAC
transaction data.

OUAC G4/H4 OUAC_G4_H4_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H > OUAC
G4/H4

Review and edit OUAC
transaction data.

OUAC G5/H5 OUAC_G5_H5_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H > OUAC
G5/H5

Review and edit OUAC
transaction data.

OUAC G6/H6 OUAC_G6_H6_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H > OUAC
G6/H6

Review and edit OUAC
transaction data.

OUAC G7/H7 OUAC_G7_H7_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H > OUAC
G7/H7

Review and edit OUAC
transaction data.

OUAC G8/H8 OUAC_G8_H8_PNL Student Admissions >
OUAC > Transactions >
Transactions G/H > OUAC
G8/H8

Review and edit OUAC
transaction data.

Reviewing and Editing the OUAC Transaction J-N Staging Tables

This section lists the pages used in the OUAC Transactions J-N component to review and edit OUAC
transaction data.
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Pages Used to Review and Edit the OUAC Transaction J-N Staging Tables

Page Name Definition Name Navigation Usage

OUAC J/K OUAC_J_K_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
J/K

Review and edit OUAC
transaction data.

OUAC J1/K1 OUAC_J1_K1_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
J1/K1

Review and edit OUAC
transaction data.

OUAC J2/K2 OUAC_J2_K2_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
J2/K2

Review and edit OUAC
transaction data.

OUAC J3/K3 OUAC_J3_K3_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
J3/K3

Review and edit OUAC
transaction data.

OUAC J4/K4 OUAC_J4_K4_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
J4/K4

Review and edit OUAC
transaction data.

OUAC J5/K5 OUAC_J5_K5_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
J5/K5

Review and edit OUAC
transaction data.

OUAC L1/N1 OUAC_L1_N1_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
L1/N1

Review and edit OUAC
transaction data.

OUAC M1 OUAC_M1_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
M1

Review and edit OUAC
transaction data.

OUAC M2 OUAC_M2_PNL Student Admissions >
OUAC > Transactions >
Transaction J - N > OUAC
M2

Review and edit OUAC
transaction data.
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Reviewing and Editing the OUAC Transaction P-R Staging Tables

This section lists pages used in the OUAC Transactions P-R component to review and edit OUAC
transaction data.

Pages Used to Review and Edit the OUAC Transaction P-R Staging Tables

Page Name Definition Name Navigation Usage

OUAC PI OUAC_PI_PNL Student Admissions >
OUAC > Transactions >
Transaction P- R

Review and edit OUAC
transaction data.

OUAC R/S OUAC_R_S_PNL Student Admissions >
OUAC > Transactions >
Transaction P- R > OUAC
R/S

Review and edit OUAC
transaction data.

OUAC R1/S1 OUAC_R1_S1_PNL Student Admissions >
OUAC > Transactions >
Transaction P- R > OUAC
R1/S1

Review and edit OUAC
transaction data.

OUAC R2/S2 OUAC_R2_S2_PNL Student Admissions >
OUAC > Transactions >
Transaction P- R > OUAC
R2/S2

Review and edit OUAC
transaction data.

OUAC R3/S3 OUAC_R3_S3_PNL Student Admissions >
OUAC > Transactions >
Transaction P- R > OUAC
R3/S3

Review and edit OUAC
transaction data.

OUAC R4/S4 OUAC_R4_S4_PNL Student Admissions >
OUAC > Transactions >
Transaction P- R > OUAC
R4/S4

Review and edit OUAC
transaction data.

Reviewing and Editing the OUAC Transaction T Staging Table

This section lists the OUAC T1 page used to review and edit OUAC transaction data.
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Page Used to Review and Edit the OUAC Transaction T Staging Table

Page Name Definition Name Navigation Usage

OUAC T1 OUAC_T1_PNL Student Admissions >
OUAC > Transactions >
Transactions T1

Review and edit OUAC
transaction data.

Viewing Search/Match and OUAC Processing Statuses

You can use the OUAC Suspense page to view the status of an OUAC application record and to view
messages that are generated by the posting process. This section discusses how to use the OUAC
Suspense page.

Page Used to View Search/Match and OUAC Processing Statuses

Page Name Definition Name Navigation Usage

OUAC Suspense OUAC_SUSP_PNL Student Admissions >
OUAC > Processes >
Suspense Data

View the status of an OUAC
application record, and
to view messages when
generated by the posting
process. For example, you
can determine if a record
is waiting to be processed,
 if a record instigated a new
person to be added to your
database, or if any errors
were encountered during
the search/match or loading
processes.

Using the OUAC Suspense Page
Access the OUAC Suspense page (Student Admissions > OUAC > Processes > Suspense Data).
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This example illustrates the fields and controls on the OUAC Suspense page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Search/Match Processing Option Displays the status of the record after the Search/Match
process.

Complete: The process was completed without errors.

Error: The process encountered errors.

Perform: The process has not run yet.

OUAC Process Status Select the status that you want for this record. Field values are
delivered with your system as translate values. Do not modify
these values in any way. Any modifications to these values
require a substantial programming effort. The delivered values
are EDI Loaded, Loaded,  Posted, Reviewed, and  Suspense.
 For example, if you change the status to Loaded, the next
time that you run the post process, this record would post to
the database—because the post process posts any file with a
status of Loaded.  If you do not want the record to remain in
suspense status and do not want to post it to the database at a
later date, select Reviewed.

ID Enter an ID to merge this record with an existing ID type. If
the system suspended the record after it performed the search
and discovered a match for one ID, that ID displays here.

If the system finds more than one match, the search order
number appears and the number of matches appear in the
Matches display-only field.
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Posting OUAC Transaction Data

This process picks up all the transactions in Loaded status and posts the data to the PS Core tables. It
creates separate applications for each OUAC reference number/application number that is not a 101
applicant. For 101 applicants it creates separate program numbers.

To post OUAC transaction data:

• Set search parameters for posting OUAC data.

• Set OUAC post parameters.

• Set defaults for posting OUAC data.

• Set more post parameters.

Pages Used to Post OUAC Transaction Data

Page Name Definition Name Navigation Usage

OUAC Post Parms (OUAC
post parameters)

OUAC_POST_PARMS Student Admissions >
OUAC > Processes > Post
OUAC Data > OUAC Post
Parms

Define default values for
admit type, application center,
 academic career, and campus.

OUAC Post Parms2 (OUAC
post parameters2)

OUAC_POST_PARMS2 Student Admissions >
OUAC > Processes > Post
OUAC Data > OUAC Post
Parms2

Define application and
transcript posting defaults.

OUAC Post Parms BC 
(OUAC post parameters BC)

OUAC_POST_PARMS_BC Student Admissions >
OUAC > Processes > Post
OUAC Data > OUAC Post
Parms BC

Assign transcript status
values.

Setting Search Parameters for Posting OUAC Data
Use the Search Parms (search parameters) page to set up your search/match parameters for processing the
OUAC staging tables.

Related Links
Setting Up Search/Match Parameters

Setting OUAC Post Parameters
Access the OUAC Post Parms (OUAC post parameters) page (Student Admissions > OUAC >
Processes > Post OUAC Data > OUAC Post Parms).
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This example illustrates the fields and controls on the OUAC Post Parms page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Admit Type Select the default admit type for all OUAC transactions
concerning each of the following categories of students:
undergraduates (UAS), part-time (PTIM), teacher's college 
(TEAS), and law (OLSAS). The admit type that you enter here
is the default on the Application Data page (the ADM_APPL
_DATA record). Define admit types on the Admit Types Table
page.

Application Center Select the default application center for all OUAC transactions
concerning each of the following categories of students:
undergraduates (UAS), part-time (PTIM), teacher's college 
(TEAS), and law (OLSAS). The application center that you
enter here is the default on the Application Data page (the
ADM_APPL_DATA record). Define application centers on the
Application Center Table page.

Academic Career Select the default academic career for all OUAC transactions
concerning each of the following categories of students:
undergraduates (UAS), part-time (PTIM), teacher's college 
(TEAS), and law (OLSAS). The academic career that you
enter here is the default in the ADM_APP_CAR_SEQ record.
 Define academic careers on the Academic Career Table page.

Campus Select the default campus for all OUAC transactions
concerning each of the following categories of students:
undergraduates (UAS), part-time (PTIM), teacher's college 
(TEAS), and law (OLSAS). The campus that you enter here is
the default on the Application Program page (the ADM_APPL
_PROG record). If you do not select a campus here, the default
is the default campus attached to the applicant's academic
program. Define campuses on the Campus Table page.

Setting Defaults for Posting OUAC Data
Access the OUAC Post Parms2 (OUAC post parameters2) page (Student Admissions > OUAC >
Processes > Post OUAC Data > OUAC Post Parms2).
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Field or Control Description

Notification Plan Select the notification plan that you want entered for these
applications during the posting process. A notification plan
specifies whether this person should be on a regular or special
notification track. Values for this field are delivered with your
system as translate values. You can modify these translate
values. Values are Early Admt (early admit), Regular, and
Rolling.

Application Method Select the application method that you want entered for these
applications during the posting process. Application methods
indicate how or in what form this application was received.
Values for this field are delivered with your system as translate
values. You can modify these translate values. Values are
Appl Serv (application server), Diskette, EDI (electronic
data interchange), Hard Copy, OUAC (Ontario Universities
Application Center), Web Appl (web application).

Fee Type Select the fee type you want entered for these applications
during the posting process. Fee types enable you to charge
varying user-defined application fees. Values for this field are
delivered with your system as translate values. You can modify
these translate values. Values are Internatnl (international) and
Standard.

Default Admit Term Select a default admit term for OUAC transactions that
transmit term information without a term date. Term Date is a
required field in PeopleSoft applications.

Acad Load (academic load) Select the academic load that you want entered for these
applications during the posting process. Values for this field
are delivered with your system as translate values. You can
modify these translate values.

Acad Level  (academic level) Select the academic level that you want entered for these
applications during the posting process. Values for this field
are delivered with your system as translate values. You can
modify these translate values.

Degree Date Select a default degree date for OUAC transactions that
transmit degree information without a degree date. Degree
Date is a required field in PeopleSoft applications.

Grade Input Enter a default grade for OUAC transactions that transmit
courses without a grade. Grade is a required field in
PeopleSoft applications.

Transcript Status Select a transcript status. The data source and data medium
that you select is the default for the transcript status that you
select here. Insert rows to add subsequent transcript statuses.
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Field or Control Description

Data Source Select a default data source for the transcript status in this row
of data.

Data Medium Select a default data medium for the transcript status in this
row of data.

Setting More Post Parameters
Access the OUAC Post Parms BC (OUAC post parameters BC) page (Student Admissions > OUAC >
Processes > Post OUAC Data > OUAC Post Parms BC).

Field or Control Description

School % Crse Trans Stat  (school % course translate status) Assign a transcript status to the final percentage assigned by
the school.

Prov. Exam % Trans Stat  (province exam % translate status) Assign a transcript status to the exam percentage assigned by
the province.

Prov. Blended % Trans Stat (province blended % translate
status)

Assign a transcript status to the blended percentage.

Prov Interim % Trans Stat  (province interim % translate
status)

Assign a transcript status to the interim percentage assigned by
the school.

BC Honours Category Enter a default for applicants who have earned honors
standing. Values for this field are delivered with your system
as translate values. You can modify these translate values. The
delivered values are Laude, Magna,  None, and Summa.

Note: If you assign the same transcript status to the percentage fields above, the incoming marks data
does not create a new row, but, instead, overwrites the old one. Assigning a different transcript status to
these fields ensures that marks are populated correctly.

Viewing OUAC Messages

This section discusses how to view OUAC messages.
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Page Used to View OUAC Messages

Page Name Definition Name Navigation Usage

OUAC Process Messages
Table

OUAC_PRCS_MSG_TBL Student Admissions >
OUAC > Processes >
OUAC Messages

View errors generated during
the posting process.

Using the OUAC Messages Page
Access the OUAC Process Message Table page (Student Admissions > OUAC > Processes > OUAC
Messages).

This example illustrates the fields and controls on the OUAC Process Message Table page. You can find
definitions for the fields and controls later on this page.

Select the following criteria for which you want to search for OUAC process messages: Instance,
Institution, ID, Appl Nbr (application number), OUAC Ref# (OUAC reference number) OUAC Appl
Nbr (OUAC application number), and  OUAC Identifier.

Reviewing Overflow OUAC Application Information

Use the OUAC Application Data component to view overflow OUAC data. The data that appears in this
component has no natural home in PeopleSoft core tables — it therefore appears here. Thus, for students
posted through OUAC, the OUAC Application Data component is an extension of their application.

This section discusses how to:

• Review general OAUC application data.

• Review OUAC law application information.

860  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 26 (CAN) Receiving External Applications from OUAC

• Review OUAC law categories.

Pages Used to Review Overflow OUAC Application Information

Page Name Definition Name Navigation Usage

OUAC Application Data OUAC_APPL_DATA Student Admissions >
OUAC > OUAC
Application

View overflow OUAC
application data.

OUAC Law Application Data OUAC_APPL_DATA_LAW Student Admissions >
OUAC > OUAC
Application > OUAC Law
Application Data

Review overflow OUAC law
application data.

OUAC Appl Law Cat (OUAC
application law category)

OUAC_APPL_LAW_CAT Student Admissions >
OUAC > OUAC
Application > OUAC Appl
Law Cat

View OUAC law categories.

Reviewing General OUAC Application Data
Access the OUAC Application Data page (Student Admissions > OUAC > OUAC Application).

This example illustrates the fields and controls on the OUAC Application Data page.

Reviewing OUAC Law Application Information
Access the OUAC Law Application Data page (Student Admissions > OUAC > OUAC Application >
OUAC Law Application Data).
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This example illustrates the fields and controls on the OUAC Law Application Data page.

Reviewing OAUC Law Categories
Access the OUAC Appl Law Cat page (Student Admissions > OUAC > OUAC Application > OUAC
Appl Law Cat).

This example illustrates the fields and controls on the OUAC Appl Law Cat page.
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(GBR) Managing UCAS and UTT
Applications

Understanding UCAS and UTT Data Processing

Universities and Colleges Admissions Service (UCAS) is the UK central body that receives and processes
admission applications. Applicants apply to UCAS. UCAS then distributes the applications to the
institutions. Institutions communicate the admission decision to UCAS rather than directly to the
applicant.

UCAS provides an Open Database Connectivity (ODBC) link to which participating institutions
can connect to import applications and send back admission decision details to UCAS. UCAS then
communicates the decision details to the applicants. PeopleSoft Campus Solutions enables you to connect
to the UCAS database to import full-time undergraduate (FTUG) and Teacher Training applications,
process the imported applications, and send back the admission decision details to UCAS.

UCAS provides database views through which institutions import data. For example, the ivStarA
database view contains the applicant's contact details, including address and phone number. Refer to the
ODBC-link Technical Manual for information about the database views, its field descriptions, and the
transactions that are exchanged between UCAS and the academic institution. This manual is available to
UCAS subscribers from the UCAS website.

See www.ucas.ac.uk

To import and process UCAS and Teacher Training applications:

1. Set up options, including the database link to UCAS.

2. Import reference data, such as ethnic codes, country codes, and application statuses, from UCAS.

3. Review the imported reference data.

In some cases, you must map the reference data to the Campus Solutions data, for example, UCAS
country codes to Campus Solutions country codes.

4. Import applications and applicant data from UCAS.

5. Review and correct errors in the imported applications.

6. Enter admission decisions for the imported applications.

7. Communicate the decisions back to UCAS as transactions.

8. Import any changes to the applicant or applications data maintained by UCAS.

Data changes that you import from UCAS could be offer responses.
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Each combination of an institution and a UCAS course is referred to as a choice.

This diagram provides an overview of the process of importing and processing UCAS applications.

When the applicant responds to an offer and when his or her exam results are available, the institution
confirms or rejects the conditional offer by comparing the applicant's exam results with the conditions.
Campus Solutions enables you to import the exam results, match the results with the offer conditions and
process Confirmation decisions.

An applicant who does not have an admission offer becomes eligible for Clearing. Also, an applicant can
register with UCAS for Adjustment if he or she wants to apply for another course. Campus Solutions
supports Confirmation, Clearing, and Adjustment processing for 2009 admissions cycle onwards.

The UCAS Admissions Guide and Decision Processing Manual provide more information about
Confirmation, Clearing, and Extra. This guide and manual are available to subscribers from the UCAS
website.

Common Elements Used to Manage UCAS and Teacher Training
Applications

Field or Control Description

Personal Information Click this link to access the Add/Update a Person component 
(SCC_BIO_DEMO) where you can view and maintain
the person records that the system creates for the imported
applicants.
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Field or Control Description

Applicant Summary Click this link to access the Applicant Summary page where
you can view the imported applicant data.

Maintain Applications Click this link to access the Maintain Applications component 
(ADM_APPL_MAINTNCE) where you can view and
maintain the Campus Solutions admission application records
that the system creates for the imported applications.

Choice Details Click this link to access the Choices page where you view the
applicant's imported application choices and a summary of the
related Campus Solutions application records.

Decision Entry Click this link to access the Initial Decision Entry page
where you can enter an admission decision for an imported
application choice.

Application Notes (<number>) Click this link to access the Application Notes page where you
can view all the key application choice information on a single
page and add notes. The number in parentheses indicates
the number of notes records for the application choice, for
example, Application Notes (2) indicates two notes records for
the application choice.

CAS Details (<number>) Click this link to access the CAS Maintenance component
where you can view the related CAS detail record for the
application choice. The number in parentheses indicates the
number of CAS details records for the application choice, for
example, CAS Details (2) indicates two CAS Details records
for the application choice.

Comments (<number>) Click this link to access the Application Notes page where
you can view and add comments. The number in parentheses
indicates the number of comment records for the application
choice, for example, Comments (2) indicates two comment
records for the application choice.

Further Information Click this link to access the Further Information page for a
subject where you can view the Other Qualification Title,
 Equivalence, National Centre Number and Unit Grades.

Round / Choice This field indicates the round number and choice number of
the Teacher Training application choice. The first digit of
Round / Choice represents the Round Number and the second
digit represents the Choice Number.

Preparing for UCAS and UTT Data Processing

Before you can import and process UCAS, UTT, and Apply data, you must set up your system as follows:
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• Enable the UK fields for all institutions.

• Enable the UK fields for a specific institution.

• Set up script text for UCAS Confirmation and Clearing enquiries.

• Set up phone numbers for UCAS Confirmation and Clearing enquiries.

• Set up UCAS, UTT, and Apply options.

• Set up UCAS, UTT, and Apply application import defaults.

• Set up UCAS and UTT decision approval options.

• Set up UCAS and UTT program action reasons.

• Set up UCAS and UTT program action reasons for Confirmation, Clearing, and Adjustment.

• Map application statuses to program actions and reasons for Apply applications.

• Set up outcomes for enquiries and notes.

• Map UCAS attendance types.

• Map UCAS, UTT, and Apply entry years and months.

• Map UCAS entry points.

• Map UCAS housing interest.

• Define external systems.

• Set up UCAS and Apply user defaults.

• Set up national ID types for country code GBR.

Note: If you implement Campus Solutions and a separate instance of PeopleSoft Human Capital
Management, you should read the additional documentation describing those integrations. Setting up
National ID Types as detailed in this UCAS documentation may vary depending on how you configure
your systems. The following documentation provides information about the setup, functional, and
technical implementation considerations.
See:
"Integrating Person Data" (Campus Solutions Application Fundamentals)
"Integrating Setup Data" (Campus Solutions Application Fundamentals)
"Monitoring Integrations Using the Integrity Utility" (Campus Solutions Application Fundamentals)
See Campus Solutions to Human Capital Management Integration in My Oracle Support (ID 1553319.1).

Pages Used to Prepare for UCAS and UTT Data Processing

Page Name Definition Name Navigation Usage

SA Features SCC_INSTALL_SA2 Set Up SACR >
Install > Student Admin
Installation > SA Features

Enable the UK-specific fields
on the Campus Solutions
pages for all institutions.
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Page Name Definition Name Navigation Usage

Academic Institution 6 SSR_INST_FEATURES Set Up SACR > Foundation
Tables > Academic
Structure > Academic
Institution Table >
Academic Institution 6

Enable the UK-specific
fields on the Campus
Solutions pages for a specific
institution.

Program Action Reason Table PROG_RSN_TBL Set Up SACR > Product
Related > Student
Records > Program
Action > Program Action
Reason Table

Set up program action reasons
for UCAS and UTT.

Also, set up the script text
for UCAS program action
reasons. Your institution's
employees can read aloud this
script text to applicants during
Confirmation and Clearing
enquiries.

Application Center ADM_APPLCTR_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Applicants >
Application Center Table

Set up the application centers
for UCAS, UTT, and Apply
applications.

Enter the phone numbers
that UCAS applicants
can call to enquire about
Confirmation and Clearing in
your institution.

UCAS Configuration SAD_UC_CONFIG Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UCAS Configuration

For an institution, configure
system and interface setup
options.

UCAS Application Import SAD_UC_CONFIG2 Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UCAS Application Import

For an institution, set up the
default values that the import
process uses to create the
Campus Solutions application
records for the ivStarC
application data.

UTT/Apply Import SAD_UC_GT_CONFG Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UTT/Apply Import

For an institution, set up the
default values that the import
process uses to create the
Campus Solutions application
records for the ivgStarG and
Apply application data.

UCAS Decision Approval SAD_UC_DECN_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UCAS Decision Approval

Indicate whether approval
is required for UCAS
application, Confirmation,
 and Release into Clearing
decisions.
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Page Name Definition Name Navigation Usage

UTT Decision Approval SAD_UC_GDEC_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UTT Decision Approval

Indicate whether approval is
required for UTT application
decisions.

UCAS Program Actions SAD_UC_UPRG_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UCAS Program Actions

Define the program actions
and reason values that the
system uses when an update
to a UCAS application
choice requires an update
to the program action and
action reason values of the
corresponding Campus
Solutions application record.

UTT Program Actions SAD_UC_GPRG_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UTT Program Actions

Define the program actions
and reason values that
the system uses when an
update to a UTT application
choice requires an update
to the program action and
action reason values of the
corresponding Campus
Solutions application record.

UCAS Confirmation SAD_UC_CONF_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UCAS Confirmation

Define the program actions
and reason values that the
system uses for UCAS
Confirmation, Clearing, and
Adjustment.

UTT Confirmation SAD_UC_GCNF_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
UTT Confirmation

Define the program actions
and reason values that
the system uses for UTT
Confirmation processing and
for Clearing Elsewhere.

Apply Program Actions SAD_UC_AP_SETUP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
UCAS Configuration >
Apply Program Actions

Map application statuses to
program actions and reasons
for Apply applications.

Outcome Codes SAD_UC_OUTCMCDS Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Outcome Code

Define the outcome codes
that you can use to classify
applicant enquiries and
application notes.
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Page Name Definition Name Navigation Usage

Attendance Type SAD_UC_ATTTYPEM Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Attendance
Type

Map UCAS attendance
types to Campus Solutions
academic levels. The system
uses this mapping when
you import ivEducation and
ivgEducation data to create
Campus Solutions external
education records.

Entry Year SAD_UC_ENTRYYRM Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Entry Year

Map entry year and month
to a Campus Solutions admit
term. You can map multiple
combinations of entry year
and month to a Campus
Solutions admit term.

You define admit terms on
the Term Table page. For
information about defining
term tables, see "Defining
Terms, Sessions, and Session
Time Periods" (Campus
Solutions Application
Fundamentals)

Entry Point SAD_UC_ENT_PT Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Entry Point

Map UCAS entry points to
Campus Solutions academic
levels and careers. The
system uses this mapping
when you import UCAS
applications and when you
create transactions to send to
UCAS.

Home SAD_UC_HOME Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Home

Map UCAS home values to
Campus Solutions housing
interest values. The system
uses this mapping to populate
the Housing Interest values
in the Campus Solutions
application records when you
import UCAS applications.

Title SAD_UC_TITLE_MP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Title

Map UCAS titles values
to Campus Solutions name
prefix values. The system uses
this mapping when creating
name records in Campus
Community when you import
UCAS applicant records.

UCAS, UTT Defaults SAD_UC_USR_DEFAULT Set Up SACR > User
Defaults > UCAS, UTT
Defaults

Set up user defaults that aid in
data entry and search.
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Page Name Definition Name Navigation Usage

External System SCC_EXT_SYS_TBL Setup SACR > Product
Related > Campus
Community > Define
Campus Community >
Set Up > Define External
Systems

Specify the external systems
for UCAS, UTT, and Apply
applicants.

National ID Type Table NID_TYPE_TABLE Set Up Common Objects >
Foundation Tables >
Personal > National ID
Type

Assign UCASID, GTTRID,
 and APPLID national ID
types to the country code
GBR.

Enabling the UK Fields for All Institutions
Access the SA Features page (Set Up SACR > Install > Student Admin Installation > SA Features).

Select the HESA, UCAS check box to enable the HESA and UCAS specific fields in the system for all
academic institutions.

Enabling the UK Fields for a Specific Institution
Access the Academic Institution 6 page (Set Up SACR > Foundation Tables > Academic Structure >
Academic Institution Table > Academic Institution 6).

Select the HESA, UCAS check box to enable the HESA and UCAS specific fields in the system for a
specific institution.

Setting Up Script Text for UCAS Confirmation and Clearing Enquiries
Access the Program Action Reason Table page (Set Up SACR > Product Related > Recruiting and
Admissions >Applicants > Program Action Reason Table).
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This example illustrates the fields and controls on the Program Action Reason Table page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Long Description Enter the description that should appear on the UCAS
Confirmation Enquiries page.

Script Text Enter the description that should appear as script text on the
UCAS Confirmation Enquiries page.

The following is an example of how the script text appears on the Confirmation Enquiries page:

1. Enter the script text and long description for a program action reason of CONF. CONF is mapped to
program action of ADMT (Admit).

2. For Accept Firm decision, select program action of ADMT and action reason of CONF on the UCAS
Confirmation page of the UCAS Configuration component.

3. For an applicant, to whom your institution gave a conditional offer, enter a decision of Accept on the
Confirmation Entry page (and if required, approve it).

4. Because ADMT and CONF are mapped to the Accept Firm decision, the system automatically enters
CONF as the action reason for the corresponding Campus Solutions application record.

5. The CONF script text and long description appear for this applicant on the Confirmation Enquiries
page.

See Also

Setting Up Admissions Program Actions and Program Action Reasons
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Setting Up Phone Numbers for UCAS Confirmation and Clearing Enquiries
Access the Application Center Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Applicants > Application Center Table).

Field or Control Description

Telephone Contact 1 Enter the phone number that should appear as the
Confirmation phone number on the UCAS Confirmation
Enquiries page.

Telephone Contact 2 Enter the phone number that should appear as the Clearing
phone number on the UCAS Confirmation Enquiries page.

These two fields appear on the Application Center Table, regardless of whether you have selected the
UCAS, HESA check box on the Academic Institution 6 and SA Features pages.

See Also

Setting Up Application Processing Centers

Setting Up UCAS and Teacher Training Options
Access the UCAS Configuration page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UCAS Configuration).
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This example illustrates the fields and controls on the UCAS Configuration page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Institution Code Enter the institution code that UCAS supplied to your
institution. The same institution code is used for UTT and
Apply applications.
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Field or Control Description

Cycle Enter the admission cycle for which you want to import data.
 The system uses this value to determine the effective term for
creating new person residency records for applicants.

You must enter the new cycle value when UCAS makes
updated views for the new cycle available through the ODBC-
link. The system uses this value to determine which new fields
must be imported. For example, the system imports the new
ivStarK fields added by UCAS for 2010 only if the UCAS
cycle is 2010 or greater.

Application Import

Field or Control Description

HESA Data Import Select to indicate how the system should update or add the
Instance field values in your database when you import data
from ivStarJ and ivgStarJ.

Select Update all values to overwrite Instance field values
with the imported values.

Select Update only null values to add imported values to
Instance fields that do not have any values.

Add HESA Person Fields Select if you want the system to add new Person HESA Data
field values when you import data from ivStarJ and ivgStarJ.

Process Mismatched Applicants The system uses this check box's setting when you import data
from ivStarJ and ivgStarJ.

Select this check box if you want the system to continue
processing the staging record if there is a mismatch on Name,
 Gender or Date of Birth between the incoming StarJ record
and the existing person record. That is, if the check box
is selected, then the system will log the mismatch and the
processing of the staging record will continue.

If you do not select the check box, then if there is a mismatch
on Name, Gender or Date of Birth between the incoming StarJ
record and the existing person record, then the system sets
the staging record to Error and no further processing is done.
 You will need to resolve the mismatch either by updating the
staging record or by updating the person record before the
staging record can be re-processed.
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Field or Control Description

Update Matriculated Students Select if you want the system to automatically update person
records of matriculated students when you import person
data from ivStarA, ivgStarA, ivStarK, ivgStarK, and Apply
candidate details.

If you do not select this check box, the system does not
update the person record if the student has matriculated with
an application associated with the current combination of
Personal ID and Application Code.  For example, suppose
you import an UTT application choice (personal ID of
10910031010 and Application Code GT02) that has a
corresponding application record with a PROG_ACTION
= MATR. In such a case, if you have selected the Update
Matriculated Students check box, the system will update the
applicant's personal record with the imported UTT data. If you
have not selected the check box, the system will not update
the personal record with the imported UTT data because the
current application has been matriculated.

If the student has matriculated with a previous application
not associated with the current combination of Personal ID
and Application Code, then the system updates the personal
data of the student, regardless of whether you have selected
the Update Matriculated Students check box. For example,
 suppose you import an UTT application choice (personal ID
of 10910031010 and Application Code GT01). The applicant
has a previous UCAS application choice (personal ID of
10910031010 and application code of UC01) that has a
corresponding application record with a PROG_ACTION
= MATR. In such a case, even if you have not selected the
Update Matriculated Students check box, the system will
update the applicant's personal record in Campus Solutions
with the imported UTT data.

Default Marital Status Select the default marital status value that the system should
assign to the imported applicant records.

Default Admin Function Select a value to be the default administrative function when
you add a 3C record using the 3C/Attachments page.

Values are ADMA and ADMP.

If you do not select a value here, the system enters ADMA 
as the default value when you add a 3C record using the 3C/
Attachments page.
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System Setup

Field or Control Description

Database Link Enter the name of the ODBC database link that the system
uses to connect to UCAS.

You can create a database link to UCAS by running the
following command:

CREATE PUBLIC DATABASE LINK link name

CONNECT TO user_name

IDENTIFIED BY password

USING 'service_name'

link name is the value you enter in the Database Link field of
the UCAS Configuration page.

UCAS supplies the link name,  user_name, password, and
service_name values to institutions.

Refer to the ODBC-link Technical Manual for more
information about connecting to the UCAS database.

UCAS Select if you want to import UCAS applicant and application
data.

If you do not select this check box, the import process does not
load the UCAS data into the Campus Solutions tables.

UTT Select if you want to import UTT applicant and application
data.

If you do not select this check box, the import process does
not have the option to load the UTT data into the Campus
Solutions tables.

The UTT-specific pages (such as the UTT Decision Approval
page) appear on the UCAS Configuration component only if
you select this check box.

Import Live Select if you want to import live data from UCAS or UTT into
the Campus Solutions tables through the staging tables. UCAS
data that contains errors will remain in the staging table.

If you do not select this check box, the import process can
only be run to post the data from the staging tables to the
Campus Solutions tables.
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Field or Control Description

Unit Results Select if you want to import unit grade results of your
applicants from ivUnitResults.

Unicode Select if you want to import data from the Unicode version of
applicant views.

Create CAS Records Select if you want the import process to automatically create
a CAS record for a Campus Solutions application when the
applicant's StarK record has a Visa Required value of Y.

See Understanding PBI Data Exchange

Campus Used Select if you have multiple institution campuses for UCAS or
UTT admissions. Otherwise, do not select if you have a single
institution campus for UCAS or UTT admissions.

This check box indicates whether or not the UCAS Campus
field is used by your institution. If the UCAS Campus field
is not used, then when the application choices are imported
with a null value the UCAS Campus field is populated with
an asterisk (*), and this value is used as part of the Course
Mapping to get the Campus Solutions academic program, plan,
 or campus.

Disable Decision Link Select to disable the Decision Entry link on the UCAS
Applicant Summary page (Student Admissions, UCAS
Processing, UCAS Applications, UCAS Applicant Summary),
 the UTT Applicant Summary page (Student Admissions,
 UCAS Processing, UTT Applications, UTT Applicant
Summary), the UCAS Application Notes page (Student
Admissions, UCAS Processing, UCAS Application Notes),
 and the UTT Application Notes page (Student Admissions,
 UCAS Processing, UTT Application Notes).

HRMS Decision Approver Select if you want the Approver and Decision Maker lookups
to display person IDs from PeopleSoft HCM (HRMS) records 
(EMPLEE_NAME_VW).

If you do not select this check box, the Approver and Decision
Maker lookups display person IDs from only the People
records (PEOPLE_SRCH).

Contextual Data Select if you want to import data from the Contextual Data
views (cvRefSchoolContextualData and ivContextual).
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Note: If you implement Campus Solutions and a separate instance of PeopleSoft Human Capital
Management, you should read the additional documentation to understand the setup, functional, and
technical implementation considerations.
See:
"Integrating Person Data" (Campus Solutions Application Fundamentals)
"Integrating Setup Data" (Campus Solutions Application Fundamentals)
"Monitoring Integrations Using the Integrity Utility" (Campus Solutions Application Fundamentals)
See Campus Solutions to Human Capital Management Integration in My Oracle Support (ID 1553319.1).

Apply Setup

Here, you can configure the settings for importing applications through the Apply interface.

Field or Control Description

Use Apply Select to enable the Apply check box on the Import Applicant
Data page.

Selecting this also makes the UTT/Apply Import page appear.

Default Decision Maker If you select this, the Decision Maker field in Apply Decision
defaults to the ID of the person entering the decision.

By default, this check box is not selected. If this isn’t selected
or the person entering the decision doesn’t have an ID, the
Default Maker field defaults to blank.

Attribution Name The value here is used to populate attribution.full_name in the
meta key of POST requests.

Attribution Email The value here is used to populate attribution.email in the meta
key of POST requests.

Attribution User ID The value here is used to populate attribution.user_id in the
meta key of POST requests.

Authentication Token The value here is used to populate the authorization token in
each request header.

Address Usage

The system uses these values when it imports applicant address data from ivStarA and ivgStarA views.
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Field or Control Description

Correspondence Address Type Select the address type that you want the import process
to assign to the imported UCAS and UTT correspondence
addresses and to the Apply candidate address.

Home Address Type Select the address type that you want the import process to
assign to the imported UCAS and UTT home addresses.

The home and correspondence address values must be
different.

Telephone Type Select the phone type that you want the import process to
assign to the imported UCAS, UTT, and Apply telephone
numbers.

Mobile Phone Type Select the phone type that you want the import process
to assign to the imported UCAS and UTT mobile phone
numbers.

Email Type Select the email type that you want the import process
to assign to the imported UCAS, UTT, and Apply email
addresses.

For information about defining address types, see "Defining Address Types" (Campus Community
Fundamentals).

Confirmation Enquiry

After exam results are published, applicants may want to confirm with an institution whether or not
they have been accepted. Also, during this Confirmation processing period, an institution will also
handle enquiries from rejected applicants who may want to be considered through Clearing. Use
the Confirmation Enquiry group box to configure how to handle such applicant enquiries related to
Confirmation and Clearing.

Field or Control Description

Automatic Save Select to have the system automatically save the record
once you have entered the mandatory values on the UCAS
Confirmation Enquiries page.

If you do not select this check box, you will need to click the
Save button on the UCAS Confirmation Enquiries page, after
entering the mandatory values.
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Field or Control Description

Outcome Required Select to make the Action Required and Outcome Codes fields
mandatory to save a Notes record on the UCAS Confirmation
Enquiries page. If you do not select this check box, the Action
Required and Outcome Codes fields become optional fields.

Setting Up UCAS Application Import Defaults
Access the UCAS Application Import page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UCAS Application Import).

When you import ivStarC application data for the first time, the system creates Campus Solutions
application records for the imported data. You can use the Maintain Applications component to access
the Campus Solutions application records. The import process uses the values you set up on the UCAS
Application Import page to create the Campus Solutions application records for the imported ivStarC
application data.

Field or Control Description

Initial Action Reason Enter the default action reason that you want the import
process to assign to the Campus Solutions application records
related to the imported ivStarC application data.

Define the initial action reasons in the Program Action Table
page. Only action reasons mapped with the program action of
APPL appear on the UCAS Application Import page.

For information about setting up action reasons, see Setting Up
Admissions Program Actions and Program Action Reasons

Admit Type Enter the admit type that you want the import process to assign
to the Campus Solutions application records related to the
imported ivStarC application data.

Define the admit types in the Admit Type Table page. If you
have defined an admit type for a career, ensure that the Admit
Type in the UCAS Application Import page matches the career
that is associated with the ivStarC application data.

Academic Level Select the default academic level that you want the import
process to assign to the Campus Solutions application records
related to the imported ivStarC application data. Values for
this field are delivered with your system as translate values.
 The import process assigns this default value only if you do
not map the academic levels to entry points on the Entry Point
Mapping page.
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Field or Control Description

Application Center Select the default application center that you want the import
process to assign to the Campus Solutions application
records related to the imported ivStarC application data. The
import process uses this default value only if you do not map
application centers to UCAS courses and Campus Solutions
careers, programs, and plans on the UCAS Course page.

Define the application processing centers in the Application
Center Table page. If you have defined an application center
for a career, ensure that the application center selected on the
UCAS Application Import page matches the career with which
the ivStarC application data is associated.

See Setting Up Application Processing Centers

See "Setting Security for Application Centers" (Campus
Solutions Application Fundamentals)

Application Fee Type Select the application fee type that you want the import
process to assign to the Campus Solutions application records
related to the imported ivStarC application data. Values for this
field are delivered with your system as translate values.

Application Method Select the application method that you want the import process
to assign to the Campus Solutions application records related
to the imported ivStarC application data. Values for this field
are delivered with your system as translate values.

Housing Interest Set the value to be used when the ivStarC Home value is not
mapped or the application is imported from ivStarZ1.

Campus Enter the default campus that you want the import process to
assign to the Campus Solutions application records related
to the imported ivStarC application data. Values for this field
are delivered with your system as translate values. The import
process assigns the default value only if you do not map a
campus to UCAS courses and Campus Solutions careers,
 programs, and plans on the UCAS Course page.

UCAS Course Code Enter the default course code that you want the import process
to assign to the imported ivStarC application data. The import
process assigns the default value only to imported applications
that do not have a course code.
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Field or Control Description

Earliest Application Year Enter the application year for which you want the process
to import applications. If you leave the field blank, the
import process may import applications from ivStarC for
both previous and current admission cycles depending on
timestamp values.

Suppose, your institution is implementing Campus Solutions
UCAS for the 2010 cycle (the UCAS cycle is 2010 on the
UCAS Configuration page). The institution wants to prevent
the import of 2009 applications. In this case, enter 2010 in the
Earliest Application Year field.

Previous Name Type Select the name type that the import process should use to
create the Previous Name records in Campus Solutions. The
import process creates the previous Name records from the
Forenames and Previous Surname values that it imports from
the StarN views.

The available values for this field does not include Primary
or Preferred because the import process uses these two types
when it creates applicant's current Name records in Campus
Solutions.

To define name types, select Set Up Common Objects >
Foundation Tables > Personal > Name Type.

After running the import process, both the previous names and
primary/preferred names can be viewed on the Names page 
(Campus Community, Personal Information, Biographical,
 Names).

Note: The import process assigns the academic load of Full time and the notification plan of Regular to
the Campus Solutions application records related to the imported ivStarC application data. The values
Full time, Part time, and Regular are delivered with your system as translate values.

Setting Up UTT and Apply Application Import Defaults
Access the UTT/Apply Import page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UTT/Apply Import).

This page appears when you select UTT or Use Apply on the UCAS Configuration page.

When you import application data for the first time, the system creates Campus Solutions application
records for the imported data. You can use the Maintain Applications component to access the Campus
Solutions application records. The import process uses the values you set up on this page to create the
Campus Solutions application records for the imported ivgStarG application data for UTT and Apply
applications.

882  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 27 (GBR) Managing UCAS and UTT Applications

Field or Control Description

Initial Action Reason Enter the default action reason that you want the import
process to assign to the Campus Solutions application records
related to the imported ivgStarG application data. If you do
not enter an initial action reason, the system creates Campus
Solutions application records with an APPL program action
and no action reason for the imported ivgStarG application
data.

Define the initial action reasons in the Program Action Table
page. Only action reasons mapped with the program action of
APPL appear on the UTT/Apply Import page.

Note: This field isn’t considered in Apply applications. For
Apply, the initial action reason is defined in Apply Program
Actions.

Admit Type Enter the admit type that you want the import process to assign
to the Campus Solutions application records related to the
imported application data.

Define the admit types on the Admit Type Table page. If you
have defined an admit type for a career, ensure that the default
Admit Type on the UTT/Apply Import page matches the career
with which the application data is associated.

Academic Level Select the academic level that you want the import process
to assign to the Campus Solutions application records related
to the imported application data. Values for this field are
delivered with your system as translate values.

Application Center Select the default application center that you want the import
process to assign to the Campus Solutions application records
related to the imported application data. The import process
uses this default value only if you do not map application
centers on the UTT Course or Apply Course page.

Define the application processing centers in the Application
Center Table page. If you have defined an application center
for a career, ensure that the application center selected in the
UTT/Apply Import page matches the career with which the
application data is associated.

Application Fee Type Select the application fee type that you want the import
process to assign to the Campus Solutions application records
related to the imported application data. Values for this field
are delivered with your system as translate values.

Application Method Select the application method that you want the import process
to assign to the Campus Solutions application records related
to the imported application data. Values for this field are
delivered with your system as translate values.
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Field or Control Description

Campus Enter the default campus that you want the import process to
assign to the Campus Solutions application records related
to the imported application data. Values for this field are
delivered with your system as translate values. The import
process assigns the default value only if you do not map a
campus on the UTT Course or Apply Course page.

Housing Interest If you define a value here, it’s used as the default for new UTT
and Apply applications. Otherwise, this is set to blank in the
applications.

Notification Plan
If you define a value here, it’s used to override the default
value Regular Admission Decision (REG) for new UTT and
Apply applications.

UTT Course Code Enter the default course code that you want the import process
to assign to the imported ivgStarG application data. The
import process assigns the default value only to imported
applications that do not have a course code.

Note: This field isn’t considered in Apply applications.

Earliest Application Year Enter the application year for which you want the process
to import applications. If you leave the field blank, the
import process may import applications from ivgStarG for
both previous and current admission cycles depending on
timestamp values.

Suppose, your institution is implementing Campus Solutions
UTT for the 2010 cycle (the UCAS cycle is 2010 on the
UCAS Configuration page). The institution wants to prevent
the import of 2009 applications. In this case, enter 2010 in the
Earliest Application Year field.

Note: This field isn’t considered in Apply applications.
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Field or Control Description

Previous Name Type Select the name type that the import process should use to
create the Previous Name records in Campus Solutions. The
import process creates the previous Name records from the
Forenames and Previous Surname values that it imports from
the StarN views.

The available values for this field does not include Primary
or Preferred because the import process uses these two types
when it creates applicant's current Name records in Campus
Solutions.

To define name types, select Set Up Common Objects >
Foundation Tables > Personal > Name Type.

After running the import process, both the previous names and
primary/preferred names can be viewed on the Names page 
(Campus Community, Personal Information, Biographical,
 Names).

Note: This field isn’t considered in Apply applications.

Note: The import process assigns the academic load of Full time or Part Time based on the value of
the PartTime field in the imported ivgStarG record. The values Full time, Part time, and Regular are
delivered with your system as translate values.
For Apply applications, if the academic load is not defined in Apply Course, the import process assigns
the academic load of Full time or Part Time based on the imported Study Mode value.

Setting Up UCAS Decision Approval Options
Access the UCAS Decision Approval page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UCAS Decision Approval).

Select the Interview, Unconditional Offer, Conditional Offer, Rejection, and Withdrawal check boxes
to indicate that a user must use one of the UCAS Decision Approval processing pages to review and
approve the decisions before the institution communicates the decisions to UCAS.

See Approving or Rejecting a UCAS Decision

See Approving or Rejecting Multiple UCAS Decisions

Select the Confirmation Acceptance and Confirmation Rejection check boxes to indicate that a user
must use the UCAS Confirmation Approval page or the Quick Confirmation Approval page to review and
approve the UCAS Confirmation decision before the institution communicates the decisions to UCAS.

See Approving or Rejecting a UCAS Confirmation Decision

See Approving or Rejecting Multiple UCAS Confirmation Decisions

Select the Release to Clearing check box to indicate that a user must use the UCAS Release Approval
page to review and approve the release before the institution communicates the decisions to UCAS.

See Approving or Rejecting the Release into Clearing Decision
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Setting Up UTT Decision Approval Options
Access the UTT Decision Approval page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UTT Decision Approval).

Select the Interview, Unconditional Offer, Conditional Offer, Rejection, and Withdrawal check boxes
to indicate that a user must use the UTT Decision Approval processing page to review and approve the
decisions before the institution communicates the decisions to UTT. To navigate to the UTT Decision
Approval processing page, select Student Admissions, UCAS Processing, UTT Decision Approval,
Decision Approval.

See Approving or Rejecting a UTT Decision

The Confirmation Acceptance and Confirmation Rejection check boxes do not have any impact on the
system.

Setting Up UCAS Program Action Reasons
Access the UCAS Program Actions page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UCAS Program Actions).

This example illustrates the fields and controls on the UCAS Program Actions page (1 of 3). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UCAS Program Actions page (2 of 3). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the UCAS Program Actions page (3 of 3). You can find
definitions for the fields and controls later on this page.

Institution Decisions

When you generate decision transactions to send to UCAS, the system uses the Institution Decisions
group box values to update the Campus Solution application records (related to the imported application
data). The following table describes when the system uses the program action and reason values for the
institution decisions:

Program Action and Action Reason Values For Used by the System When

Conditional Offer You make a conditional offer.

Amended Conditional Offer You amend a decision to conditional offer. This decision is
applicable to an LA transaction.
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Program Action and Action Reason Values For Used by the System When

Unconditional Offer You make an unconditional offer.

Amended Unconditional Offer You amend a decision to unconditional offer. This decision is
applicable to an LA transaction.

Rejection You reject an application.

Amended Rejection You amend a decision to rejection. This decision is applicable
to an LA transaction.

Interview You enter a decision of interview.

Amended Interview You amend a decision to interview. This decision is applicable
to an LA transaction.

Course Full You enter a decision of course full.

Amended Course Full You amend a decision to course full. This decision is
applicable to an LA transaction.

Withdrawal Your institution withdraws an application.

Amended Withdrawal You amend a decision to be withdrawn by the institution. This
decision is applicable to an LA transaction.

UF Withdrawal - Institution Applicant declines the offer. This decision is applicable to an
RW transaction.

UF Amendment You amend a course, entry date, or entry point of an applicant
who has firmly accepted an unconditional offer or who has
accepted a Clearing place. This decision is applicable to an RA
transaction.

Course Correction When you correct a course, the system does not automatically
generate LC transactions for UCAS and as a consequence
the system does not update the Campus Solutions application
record using the program action/reason for Course Correction.
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Applicant Replies

The system uses the Applicant Replies group box values when the Reply values you imported change.
The following table describes when the system uses the program action and reason values for the
applicant reply decisions:

Program Action and Action Reason Values For Used by the System When

Conditional Firm The applicant replies for the first time by accepting a
conditional offer firmly.

Cond Firm – Upgraded The applicant changes his or her reply from Conditional
Insurance to Conditional Firm prior to confirmation.

This can be set to the same values as Conditional Firm if your
institution does not want to distinguish between initial replies
and updated replies.

Conditional Insurance The applicant replies for the first time by accepting a
conditional offer as insurance.

Cond Insurance – Downgraded The applicant changes his or her reply from Conditional Firm
to Conditional Insurance.

This can be set to the same values as Conditional Insurance if
your institution does not want to distinguish between initial
replies and updated replies.

Unconditional Firm The applicant replies for the first time by accepting an
unconditional offer firmly.

Uncond Firm – Upgraded The applicant changes his or her reply from Unconditional
Insurance to Unconditional Firm prior to confirmation.

This can be set to the same values as Unconditional Firm if
your institution does not want to distinguish between initial
replies and updated replies.

Unconditional Insurance The applicant replies for the first time by accepting an
unconditional offer as insurance.

Uncond Insurance – Downgraded The applicant changes his or her reply from Unconditional
Firm to Unconditional Insurance.

This can be set to the same values as Unconditional Insurance
if your institution does not want to distinguish between initial
replies and updated replies.
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Program Action and Action Reason Values For Used by the System When

Conditional Decline The applicant declines a conditional offer.

Unconditional Decline The applicant declines an unconditional offer.

The applicant declines an unconditional offer made by your
institution for an Adjustment choice (Choice Number = 6,
 Decision = U, Reply = D and Adjustment is not D).

UCAS Amendments

The system uses the UCAS Amendments group box values when UCAS initiates changes and you
import these changes from ivStarC and ivStarK. The following table describes when the system uses the
program action and reason values for the UCAS amendments:

Program Action and Action Reason Values For Used by the System When

Changed Course UCAS changes a course.

Changed Campus UCAS changes a campus.

Changed Entry Point UCAS changes an entry point.

Changed Term UCAS changes entry year, entry month, or both, which results
in a change of admit term for the applicant.

Cancelled Choice UCAS cancels an application choice (in ivStarC, the value of
the ChoiceCancelled field is Y).

Withdrawal - UCAS UCAS either notifies that the applicant has withdrawn all
application choices (in ivStarK, the value of the Withdrawn
field is C) or applicant has withdrawn only one choice (in
ivStarC, the value of Decision is W).

UF Withdrawal - UCAS Applicants with an unconditional firm offer for an application
choice notify UCAS that they want to withdraw their
applications (in ivStarK, the value of the Withdrawn field is
U).

890  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 27 (GBR) Managing UCAS and UTT Applications

Program Action and Action Reason Values For Used by the System When

Withdrawal Re-instated UCAS notifies that a previously withdrawn application choice
can be considered by the institution. The system uses the
Withdrawal Re-instated field values when UCAS changes
the ivStarC decision value to blank from W.

Note that the system does not process the R values for the
ivStarK Withdrawn fields. This change is not specific to an
application choice; as a consequence, the system does not
process this change when you import data. To process this type
of change, you must change the decision value to blank from
W for an application choice.

Reject by Default UCAS rejects the application because your institution did not
communicate any decision to UCAS (in ivStarC, the Action
field is R).

Decline by Default UCAS declines an offer because the applicant did not reply (in
ivStarC, the Action field is D).

Note that in ivStarC, if the Action field is U (updated from
insurance to firm, CI to CF, or UI to UF), then the system
picks up the change in the ivStarC Reply value.

The following scenario shows how Campus Solutions uses the values set up on the UCAS Program
Actions page:

1. On the UCAS Program Actions page, for the Rejection decision enter a program action of DENY and
an action reason of R.

2. Enter a decision of Rejection for a UCAS application on the Initial Decision Entry page. If approval is
required, use the UCAS Decision Approval page to approve the Rejection decision.

3. Select the Generate Transaction check box on the Transaction Processing page and run the
Transaction Processing Application Engine (SAD_UC_TRAN) process to generate a transaction for
the Rejection decision.

4. The system sets the program action to DENY and the action reason to R in the Campus Solutions
application record of the corresponding UCAS application number.

Setting Up UTT Program Action Reasons
Access the UTT Program Actions page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UTT Program Actions).
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This example illustrates the fields and controls on the UTT Program Actions page (1 of 2). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UTT Program Actions page (2 of 2). You can find
definitions for the fields and controls later on this page.

Institution Decisions

When you generate UTT decision transactions, the system uses the Institution Decisions group box
values to update the Campus Solution application records (related to the imported UTT application data).
The following table describes when the system uses the program action and the reason values for the
institution decisions:

Program Action and Action Reason Values For Used by the System When

Conditional Offer You make a conditional offer.

Amended Conditional Offer You amend a decision to conditional offer. This decision is
applicable to an LA transaction.

Unconditional Offer You make an unconditional offer.

Amended Unconditional Offer You amend a decision to unconditional offer. This decision is
applicable to an LA transaction.

Rejection You reject an application.
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Program Action and Action Reason Values For Used by the System When

Amended Rejection You amend a decision to rejection. This decision is applicable
to an LA transaction.

Rejection - English You enter a decision of Not qualified in English.

Amended Rejection - English You amend a decision to Not qualified in English. This
decision is applicable to an LA transaction.

Rejection - Maths You enter a decision of Not qualified in Mathematics.

Amended Rejection - Maths You amend a decision to Not qualified in Mathematics. This
decision is applicable to an LA transaction.

Rejection - Science You enter a decision of Not qualified in Science.

Amended Rejection - Science You amend a decision to Not qualified in Science. This
decision is applicable to an LA transaction.

Course Closed You enter a decision of Course Closed.

Amended Course Closed You amend a decision to Course Closed. This decision is
applicable to an LA transaction.

Interview You enter a decision of Interview and specify the interview
date for the transaction.

Amended Interview You amend a decision to Interview and specify the interview
date for the transaction. This decision is applicable to an LA
transaction.

Withdrawal Your enter a decision of Withdrawal.

Amended Withdrawal You amend a decision to Withdrawal. This decision is
applicable to an LA transaction.

UF Amendment You amend an unconditional firm application.
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Applicant Replies

The system uses the Applicant Replies group box values when the Reply values you imported change.
The following table describes when the system uses the program action and the reason values for the
applicant replies:

Program Action and Action Reason Values For Used by the System When

Conditional Firm The applicant accepts a conditional offer firmly.

Unconditional Firm The applicant accepts a unconditional offer firmly.

Conditional Decline The applicant declines a conditional offer.

Unconditional Decline The applicant declines an unconditional offer.

UTT Amendments

The system uses the UTT Amendments group box values when UTT initiates changes and you import
these changes from ivgStarG and ivgStarK. The following table describes when the system uses the
program action and the reason values for the UTT amendments:

Program Action and Action Reason Values For Used by the System When

Changed Course UTT changes a course.

Changed Campus UTT changes a campus.

Changed Term UTT changes entry year, entry month, or both, resulting in a
change of admit term for the applicant.

Withdrawal - UTT UTT notifies that the applicant has withdrawn all application
choices (in ivgStarK, Withdrawn field is C or in ivgStarG,
 Decision field is W).

UF Withdrawal - UTT Applicants with an unconditional firm offer for an application
choice notify UCAS that they want to withdraw their
applications (in ivgStarK, Withdrawn field is U).
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Program Action and Action Reason Values For Used by the System When

Withdrawal Re-instated UTT notifies that a previously withdrawn application choice
can be considered by the institution. The system uses the
Withdrawal Re-instated field values when UTT changes the
ivgStarG decision value to blank from W.

Note that the system does not process the R values for the
ivgStarK Withdrawn fields. This change is not specific to an
application choice and, as a consequence, the system does not
process this change when you import data. To process this type
of change, you must change the decision value to blank from
W for an application choice.

Reject by Default UTT rejects the application because your institution did not
communicate any decision to UCAS (in ivgStarG, Action field
is R).

Decline by Default UTT declines an offer because the applicant did not reply (in
ivgStarG, Action field is D).

Setting Up Apply Program Action Reasons
Access the Apply Program Actions page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > Apply Program Actions).

This example illustrates the fields and controls on the Apply Program Actions page. You can find
definitions for the fields and controls later on this page.

Use this page to create mappings between an application status and program actions and reasons for
Apply applications.

Related Links
Pages Used to Process UCAS and UTT Reference Data
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Setting Up UCAS Program Action Reasons for Confirmation, Clearing, and
Adjustment

Access the UCAS Confirmation page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UCAS Confirmation).

This example illustrates the fields and controls on the UCAS Confirmation page (1 of 2). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the UCAS Confirmation page (2 of 2). You can find
definitions for the fields and controls later on this page.
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UCAS Confirmation Decisions

When the system generates UCAS confirmation transactions (RD transactions), it uses the UCAS
Confirmation Decisions group box values to update the Campus Solutions application records (related
to the imported UCAS application data). The following table describes when the system uses the program
action and reason values for the UCAS Confirmation decisions:

Program Action and Action Reason Values For Used by the System When

Accept Firm The institution confirms acceptance for a conditional firm
application. That is, Decision is A (Accept) and Reply is F 
(Firm).

Also, the system uses this value in ivStarC update processing
when the Reply changes to F, the Decision is U, and the
application was previously CF.

Accept Insurance The institution confirms acceptance for a conditional insurance
application. That is, Decision is A and Reply is I (Insurance).

To prevent an Accept Insurance row being added when the
choice is UF elsewhere, the system uses the following process:
If Decision is A and existing Reply value of the choice is I
and the current action/reason is not UF Elsewhere, the system
gets the new Program Action and Action Reason for Accept
Insurance.

Reject Firm The institution confirms rejection for a conditional firm
application. That is, Decision is R (Reject) and Reply is F.

Reject Insurance The institution confirms rejection of a conditional insurance
application. That is, Decision is R and Reply is I.

Amended Confirmation You change a Confirmation decision and a new RD transaction
is generated.

Confirmation with Change You change Course or Year as part of a Confirmation
decision. That is, Decision is C (Conditional Offer) in an RD
transaction.

Delayed Conditional You delay the conditional offer. That is, Decision is D 
(Delayed Confirmation Decision) in an RD transaction.

For an applicant, you can enter the institution decision and view the applicant reply on the Initial Decision
Entry page and the Decision Processing page.

See Entering an Initial Admission Decision for a UCAS Application Choice
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See Entering or Updating an Admission Decision for a UCAS Application Choice

See Entering a Decision for Multiple UCAS Application Choices

UCAS Confirmation Amendments

When you receive Confirmation amendments from UCAS, the system uses the UCAS Confirmation
Amendments group box values to update the Campus Solution application records (related to the
imported UCAS application data). The following table describes when the system uses the program action
and the reason values for the UCAS Confirmation amendments:

Program Action and Action Reason Values For Used by the System When

UF Elsewhere The applicant is UF (unconditional firm) at another institution
and the local choice is UI (unconditional insurance) or CI 
(conditional insurance).

Clearing Elsewhere Another institution has accepted the applicant through
Clearing.

Adjustment Decline Another institution has accepted the applicant through
Adjustment.

UI to UF at Confirmation An unconditional insurance offer becomes firm as a result
of the applicant's conditional firm choice being rejected at
Confirmation. That is, Decision is U, Reply is F, and the
previous Reply value was I.

CI to CF at Confirmation The applicant's CF choice is rejected during Confirmation and
UCAS updates the applicant's existing CI choice to CF. That
is, Decision is C, Reply is F, and the previous Reply value
was I.

UCAS Enquiry

During the Clearing and Adjustment processes, the system uses the UCAS Enquiry group box values to
create or update the Campus Solutions application records. The following table describes when the system
uses the program action and the reason values for the UCAS Clearing and Adjustment decisions:

Program Action and Action Reason Values For Used by the System When

Adjustment Acceptance You import Adjustment applications (for which the institution
has sent AD transactions) and the system updates the
corresponding Campus Solutions application record.
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Program Action and Action Reason Values For Used by the System When

Clearing Application You import Clearing applications and the system creates the
corresponding Campus Solutions application records for the
imported Clearing applications.

Clearing Acceptance You create a RX transaction (with Decision = A) and
the system updates the corresponding Campus Solutions
application record.

You import an accepted Clearing application and the system
creates a new Campus Solution application record for the
accepted Clearing application (new application).

You import an accepted Clearing decision (Result = A) and the
system updates the Campus Solution application record with
the result (existing application).

Clearing Rejection You create a RX transaction (with Decision = R) and
the system updates the corresponding Campus Solutions
application record.

You import a rejected Clearing decision (Result = R) and the
system updates the Campus Solution application record with
the result (existing application).

Release to Clearing You create a RR transaction to notify UCAS that the
applicant is released into Clearing and the system updates the
corresponding Campus Solutions application record.

RPA Applicant

(record of prior acceptance applicant)

EAS in ivStarK is R, and the system updates the
corresponding Campus Solutions application record.

Scenarios

The following scenarios show how Campus Solutions uses the values set up on the Confirmation page:

Scenario 1: Importing new Clearing applications (that is, application choice number 9 does not exist in the
database)

1. For Clearing Application, enter the program action APPL (Application) and action reason CAP. For
Clearing Acceptance, enter the program action ADMT  and action reason CAC. For Clearing rejection,
enter the program action DENY and action reason CR.

2. The Import Applicant Data Application Engine (SAD_UC_IMPAP) process imports UCAS Clearing
application records from ivStarZ1. The imported UCAS Clearing application records have a choice
number of 9.
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3. If the Result value in ivStarZ1 is null for the Clearing application, the system creates a corresponding
Campus Solutions application record with a program action of APPL and action reason of CAP.

4. If the Result value in ivStarZ1 is A for the Clearing application, the system creates a corresponding
Campus Solutions application record with a program action of ADMT and action reason of CAC.

5. If the Result value in ivStarZ1 is R for the Clearing application, the system creates a corresponding
Campus Solutions application record with a program action of DENY and action reason of CR.

6. For the new Clearing Campus Solutions application record that has a program action of APPL, you
enter a decision A. After entering the decision you generate the RX transaction. In this case, the
system updates the Campus Solutions application record with the program action of ADMT  and
action reason CAC.

Scenario 2: Confirming offers

1. For the Accept Firm decision enter a program action of ADMT and action reason of COF.

2. Click Accept on the UCAS Confirmation page for a UCAS application that has a conditional offer. If
required, approve the acceptance of the admission offer.

3. Select the Generate Transaction check box on the Transaction Processing page and run the
Transaction Processing process to generate a transaction for the Confirmation decision.

4. The system assigns the program action ADMT and action reason COF to the Campus Solutions
application record for the corresponding UCAS application.

Scenario 3: Importing Adjustment Applications

1. For the Adjustment Acceptance decision, enter a program action of ADMT and action reason of ADA.

2. The Import Applicant Data process imports UCAS adjustment (choice number 6 ) records from
ivStarC. For applications, which the institution has already sent AD transactions to UCAS, the
incoming decision value is U and reply value is F.

3. If the incoming decision value is not U, the system creates a corresponding Campus Solutions
application record with a program action of APPL and the action reason that you had set up on the
UCAS Application Import page.

4. If the incoming decision value is U and reply is F, the system updates the corresponding Campus
Solutions application record with a program action of ADMT and action reason of ADA.

5. If the incoming decision value is U, reply is D, and Adjustment is not D, the system updates the
corresponding Campus Solutions application record with the program action and action reason values
that you had set up for Unconditional Decline on the UCAS Program Actions page.

6. For the new Adjustment Campus Solutions application record that has a program action of APPL,
the institution generates an AD transaction. In this case, the system updates the Campus Solutions
application record with the program action of ADMT and action reason of ADA.

Scenario 4: An applicant has been accepted by another institution through Adjustment. Your institution
previously sent an unconditional offer or a confirmation acceptance to UCAS that the applicant has firmly
accepted (the applicant has an application choice with a decision reply value of UF).

1. For the Adjustment Decline decision, enter a program action of DENY and action reason of ADD.
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2. The Import Applicant Data process imports UCAS choice records from ivStarC.

3. If the incoming Adjustment value is D for an application choice that exists in your database, the
process updates the decision-reply value from UF to UD. Also, the system updates the corresponding
Campus Solutions application record with a program action of DENY and action reason of ADD.

Scenario 5: Importing updated Clearing applications.

After a Decision has been made for a choice but before the applicant replies, any changes to course
details, term or entry point made at UCAS can lead to the adding of a new row in the Campus Solutions
application. Consequently, the earlier offer row generated by the LD/LA transaction is no longer the
latest. In this scenario,

• If the incoming Result = A and the Reply is not D, add a new row for Clearing Acceptance.

• If the incoming Result = A and Reply is D and the Campus Solutions application is not already
withdrawn (application status is not Cancelled from WADM or WAPP program action), add a new
row for Unconditional Decline.

• If the incoming Result = R, add a new row for Clearing Rejection.

Setting Up UTT Program Action Reasons for Confirmation and Clearing
Elsewhere

Access the UTT Confirmation page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > UCAS Configuration > UTT Confirmation).

902  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 27 (GBR) Managing UCAS and UTT Applications

This example illustrates the fields and controls on the UTT Confirmation page. You can find definitions
for the fields and controls later on this page.

UTT Confirmation Decisions

When the system generates UTT Confirmation transactions, it uses the UTT Confirmation Decisions
group box values to update the Campus Solution application records (related to the imported UTT
application data). The following table describes when the system uses the program action and the reason
values for the UTT Confirmation decisions:

Program Action and Action Reason Values For Used by the System When

Accept Firm The institution confirms acceptance for a conditional firm
application (Decision is A  and Reply is F). Also, the system
uses this action in ivgStarG update processing when you
change the Reply to F, the Decision is U, and previously the
application was CF.

Reject Firm The institution confirms rejection for a conditional firm
application (Decision is R,  and Reply is F).

Copyright © 1988, 2021, Oracle and/or its affiliates. 903



(GBR) Managing UCAS and UTT Applications Chapter 27

Program Action and Action Reason Values For Used by the System When

Amended Confirmation You change a Confirmation decision and a new RD transaction
is generated.

Confirmation with Change You change Course, Campus, Modular, Part Time, Entry Year,
or Entry Month as part of a Confirmation decision (Decision is
C in an RD transaction).

Delayed Conditional You delay the conditional offer. That is, Decision is D 
(Delayed Confirmation Decision) in an RD transaction.

UTT Confirmation Amendments

When you receive UTT Confirmation amendments, the system uses the UTT Confirmation
Amendments group box values to update the Campus Solution application records (related to the
imported UTT application data). The following table describes when the system uses the program action
and the reason values for the UTT Confirmation amendments:

Program Action and Action Reason Values For Used by the System When

Clearing Elsewhere An applicant was accepted through Clearing at another
institution.

UTT Enquiry

When the system generates UTT Enquiry transactions, it uses the UTT Enquiry group box values to create
or update the Campus Solution application records (related to the imported UTT application data). The
following table describes when the system uses the program action and the reason values for the UTT
Enquiry decisions:

Program Action and Action Reason Values For Used by the System When

Clearing Application You import Clearing applications and the system creates the
corresponding Campus Solutions application records for the
imported Clearing applications.

Clearing Acceptance You import an accepted Clearing application that has Decision
= U (Unconditional Offer) or A and the system creates a new
Campus Solution application record for the accepted Clearing
application.

You create a RX transaction (Decision is U) and the system
updates the corresponding Campus Solutions application
record.
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Program Action and Action Reason Values For Used by the System When

Clearing Offer You import an accepted Clearing application that has Decision
= C (Conditional Offer) and the system creates a new
Campus Solution application record for the accepted Clearing
application.

You create a RX transaction (Decision is C) and the system
updates the corresponding Campus Solutions application
record.

RPA Applicant EAS in ivStarK is R, and the system updates the corresponding
Campus Solutions application record.

Setting Up Outcomes for Enquiries and Notes
Access the Outcome Codes page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Outcome Codes).

This example illustrates the fields and controls on the Outcome Codes page . You can find definitions for
the fields and controls later on this page.

Field or Control Description

Action Required Select a value that allows you to filter the outcome codes on
the UCAS Confirmation Enquiries page, and UCAS and UTT
Application Notes pages.

Values are Applicant, Institution, and None.
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Field or Control Description

UCAS Select to have the outcome code available for selection on the
UCAS Application Notes and UCAS Confirmation Enquiries
pages.

Apply Select to have the outcome code available for selection on the
Apply Application Notes page.

Confirmation Select to have the outcome code available for selection on the
UCAS Confirmation Enquiries page.

Mapping UCAS Attendance Types
Access the Attendance Type page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Mappings > Attendance Type).

This example illustrates the fields and controls on the Attendance Type page. You can find definitions for
the fields and controls later on this page.

Map the UCAS attendance types to Campus Solutions academic load values.

Note: The attendance type mapping is used to set the Approved Academic Load value when External
Education records are created from records imported from ivEducation and ivgEducation.

Mapping UCAS, UTT, and Apply Entry Years and Months
Access the Entry Year page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Mappings > Entry Year).
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This example illustrates the fields and controls on the Entry Year page. You can find definitions for the
fields and controls later on this page.

Use this page to map the admit term for UCAS, UTT, and Apply choices.

Field or Control Description

Entry Year Enter the entry year in the format YYYY.

Entry Month Enter a number between 1 and 12 to indicate the UCAS entry
month. For example, if the month is January, enter 1.

For non-modular UTT applications, enter 0. UTT does
not deliver an entry month value for non-modular UTT
applications. If any incoming application does not have an
entry month, the import process uses the mapping with 0 as the
default.

For Apply applications, this field defaults to zero. If there’s
a value in Entry Month on the Apply Course page, then that
value is used here.

Entry Point (Optional) Set the year of program the applicant can join.
 When you set a value in this field, you can define multiple
records for different Entry Points, and define different Cohort
Tags for each Entry Point. If you leave this field blank, you
can continue to have a single mapping of Entry Year and
Month to Admit Term and a single Cohort Tag that will apply
to all Entry Points.

Note: This field is hidden if System is set to UTT or Apply.

Cohort Tag Use this field if you are using the Program Enrollment
functionality and you want the Import Applicant Data process
to set this cohort value when it creates or updates Campus
Solutions applications as part of the UCAS and UTT or Apply
application import.

For information about Program Enrollment, refer to the
Student Records - Program Enrollment documentation.

See "Understanding Program Enrollment" (Student Records)
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Note: When you import application data, the system uses the mapped admit term to create or update the
related Campus Solutions application records.
It is recommended that you define entry year mappings for a single career for each combination of
institution and system.

Mapping UCAS Entry Points
Access the Entry Point page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Mappings > Entry Point).

This example illustrates the fields and controls on the Entry Point page. You can find definitions for the
fields and controls later on this page.

Note: When you import UCAS application data, the system uses the mapped academic level and year of
program to create the related Campus Solutions application records. If the year of program is not mapped,
then the system sets the value in Application Program Data page to 00 (not set).

UCAS admission entry points range from 0 for foundation year and 1 through 5 for first through fifth year
entry. Entry point is not used in UTT admissions. Therefore, for UTT you need not map entry points with
academic levels and careers. The system uses the default academic level that you defined on the UTT/
Apply Import page for UTT and Apply applications.

Mapping UCAS Housing Interest
Access the Home page (Set Up SACR > Product Related > Recruiting and Admissions > UCAS >
Mappings > Home ).

Values for the Housing Interest field are delivered with your system as translate values. Values are
Commuter, Off Campus Housing, and On Campus Housing.

Note: When you import UCAS application data, the system populates the mapped Campus Solutions
housing interest into the related Campus Solutions application records.
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Mapping UCAS Titles
Access the Title page (Set Up SACR > Product Related > Recruiting and Admissions > UCAS >
Mappings > Title).

This example illustrates the fields and controls on the Title page. You can find definitions for the fields
and controls later on this page.

Name Prefix values are defined here: Set Up Common Objects >Foundation
Tables >Personal >Name Prefix.

Note: When you import UCAS application choices, the system populates the mapped name prefixes into
the related Campus Solutions name records.
If a UCAS Title value is not mapped to a name prefix, then the system uses the UCAS Title value as the
prefix in the name record.

Defining External Systems
Access the External System page (Set Up SACR > Product Related > Campus Community > Define
Campus Community > Set Up > Define External Systems).

Copyright © 1988, 2021, Oracle and/or its affiliates. 909



(GBR) Managing UCAS and UTT Applications Chapter 27

This example illustrates the fields and controls on the External System page. You can find definitions for
the fields and controls later on this page.

Define the following external systems codes listed in the following table.

External System Code Description

GT UTT Personal ID (UTTPERID)

ISA Ind Safeguarding Auth (ISA)

NIN National Insurance No (NIN)

SCN Scottish Candidate Number (SCN)

UC UCAS Personal ID (UCASPERID)

ULN Unique Learner No (ULN)

AP Apply Candidate ID (AP)

You must define the codes as shown in the table but you can modify the description.

The system uses this setup to track applicant IDs imported from UCAS and Apply. To view the imported
IDs for an applicant, use the External System page (Campus Community, Personal Information,
Identification, External System ID).

Setting Up UCAS and Apply User Defaults
Access the UCAS, Apply Defaults page (Set Up SACR > User Defaults > UCAS, UTT Defaults).
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This example illustrates the fields and controls on the UCAS, Apply Defaults page . You can find
definitions for the fields and controls later on this page.

The system uses the defaults that you set up here to populate data in the UCAS, Apply Applications,
and Apply Decisions pages. The default values that you set up here can be overridden on any page in the
system.

Although setting user defaults can save time and minimize data entry errors, doing so is optional.

To set up user defaults for the Academic Institution, Term, Career, and Academic Program fields,
select Set Up SACR > User Defaults > User Defaults 1.

To set up user defaults for the Application Center field, select Set Up SACR > User Defaults > User
Defaults 2.

If your institution does not have PeopleSoft HCM (HRMS) installed, the Decision Maker and Approver
lookups do not have access to the database table that differentiates staff members from the other person
records (such as students). Therefore, if HCM is not installed, the lookups will display all person records.
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The same logic applies to other pages where Decision Maker or Approver lookups exist (for instance, the
UCAS Decision Processing page).

Note: If you implement Campus Solutions and a separate instance of PeopleSoft Human Capital
Management, you should read the additional documentation to understand the setup, functional, and
technical implementation considerations.
See:
"Integrating Person Data" (Campus Solutions Application Fundamentals)
"Integrating Setup Data" (Campus Solutions Application Fundamentals)
"Monitoring Integrations Using the Integrity Utility" (Campus Solutions Application Fundamentals)
See Campus Solutions to Human Capital Management Integration in My Oracle Support (ID 1553319.1).

Setting Up National ID Types for Country Code GBR
Access the National ID Type Table page (Set Up Common Objects > Foundation Tables > Personal >
National ID Type).

This example illustrates the fields and controls on the National ID Type Table page. You can find
definitions for the fields and controls later on this page.

NID Type (maximum
6 characters)

Default Description 
(maximum 30
characters)

Short Desc 
(maximum 10
characters)

National ID Format 
(maximum 20
characters)

UCASID No UCAS Personal ID UCASPERID 9999999999 (10 digits)

GTTRID No UTT Personal ID UTTPERID 9999999999 (10 digits)

APPLID No Apply Candidate ID APPLID XXXXXXXXXX

(10 characters)

The Import Applicant Data process uses the UCASID, GTTRID, and APPLID NID types to import
UCAS, UTT, and Apply applications.
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Setting Up Elements for Teacher Training Applications

This section describes:

• Defining Individual Conditions for Applications

• Defining Condition Groups

• Creating or Reviewing Application Statuses for Apply Applications

• Defining Reasons for Rejection

• Reviewing and Mapping Apply Courses

Note: For teacher training applications, the conditions are relevant only to offers. There’s no requirement
to define conditions or offers for a particular decision code as there are for UTT applications.

Pages Used to Set Up Teacher Training Applications

Page Name Definition Name Navigation Usage

Apply Conditions SAD_UC_APPLY_COND Set Up SACR >Product
Related >Recruiting and
Admissions >UCAS >Apply
Setup >Apply Conditions

Define individual conditions
you can apply to applications.

Apply Offers SAD_UC_APPLY_OFFER Set Up SACR >Product
Related >Recruiting and
Admissions >UCAS >Apply
Setup >Apply Offers

Define groups of conditions
you can apply to applications.

Apply Application Status SAD_U_APPLSTAT_PG Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Apply Setup > Apply
Application Status

Create or review application
statuses that you can apply to
Apply applications.

You can change the
descriptions for the delivered
statuses to reflect your
institution’s admissions
terminology.

Rejection Reasons SAD_UC_APPLY_REJN Set Up SACR >Product
Related >Recruiting and
Admissions >UCAS >Apply
Setup >Rejection Reasons

Define the text for rejecting
applications.
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Page Name Definition Name Navigation Usage

Apply Course SAD_UC_ACOURSE_PG Set Up SACR > Product
Related > Recruiting
and Admissions >
UCAS >Apply Setup >
Apply Course

Manually add Apply course
data to your database. Also,
 map a course with a Campus
Solutions academic career,
 program, plan, application
center, and campus.

Gender Mapping SAD_UC_GENDR_PG Set Up SACR > Product
Related > Recruiting
and Admissions >
UCAS >Apply Setup >
Gender Mapping

Map HESA gender codes to
sex codes in person records.

Residency Mapping SAD_UC_RESID_PG Set Up SACR > Product
Related > Recruiting
and Admissions >
UCAS >Apply Setup >
Residency Mapping

(Optional) Map UK residency
status to residency codes
to create official residency
records for applicants. If
you don’t map the residency
status, then official residency
records aren’t created.

Note: The Residential
Category for UCAS and
UTT isn’t used for Apply
applications.

Defining Individual Conditions for Applications
Access the Apply Conditions page (Set Up SACR >Product Related >Recruiting and
Admissions >UCAS >Apply Setup >Apply Conditions).

This example illustrates the fields and controls on the Apply Conditions page. You can find definitions for
the fields and controls later on this page.
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Use this page to define standard conditions that are applicable to any application and available for all
courses, unless you define course-specific conditions on the Apply Course page. You can also apply
these conditions to the offers you define on the Apply Offers page. See Reviewing and Mapping Apply
Courses.

To create a condition, click Add New Value, then provide values for:

Field or Control Description

Academic Institution Enter your institution. By default, this value is set to the user’s
default institution.

Condition Code Enter a code for the condition. You can enter a maximum of 10
characters.

Details

You can add multiple rows, each row is identified by the effective date. When you add a new row, the
Condition Text is copied from the most-recent row.

Only if a condition is used, you see the list of offers or courses that use the condition. You can delete a
condition only if it isn’t used in any offer or course.

Used in Offers

This region shows the offers that use the condition. If the condition isn’t being used in the most recent
effective-dated row for the offer, the offer doesn’t appear even if the condition was used for an earlier
row.

Used in Courses

This region shows the courses that use the condition.

Field or Control Description

Cycle The value here is the most recent course record that’s being
considered.

If the condition isn’t used in the most recent cycle for the
course, the course isn’t listed on the table even if the condition
was used for an earlier cycle.

Defining Condition Groups
Access the Apply Offers page (Set Up SACR >Product Related >Recruiting and
Admissions >UCAS >Apply Setup >Apply Offers).
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This example illustrates the fields and controls on the Apply Offers page. You can find definitions for the
fields and controls later on this page.

Use this page to create a group of conditions and define them as offers. Offers are applicable to any
application, and are available for all courses unless course-specific offers are defined in Apply Course
mapping.

To create a group of conditions, click Add New Value, then provide values for:

Field or Control Description

Academic Institution Enter your institution. By default, this value is set to the user’s
default institution.

Offer Code Enter a code for the offer. You can enter a maximum of 10
characters.

You can delete an offer and its associated conditions if the offer isn’t used in Apply Course.

Details

You can add multiple rows of conditions, and each row is identified by the effective date. When you add
a new row, the effective date defaults to the current date, the rest of the values are copied from the most
recent row.

Field or Control Description

Description Enter a description for the offer. The maximum length is 30
characters.
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Field or Control Description

Default By default, this is not selected. Only one record can be set as
the default offer.

You can select this check box only if no other offer is set as the
default.

Conditions

Add the conditions you want to use for the offer. You must add at least one condition to save the record.
If you have added these conditions on the Apply Conditions page, you can add them as part of a default
offer:

• Fitness to Teach check

• Disclosure and Barring Service (DBS) check

Used in Courses

Here you see the list of courses that use this offer as the Default Offer or in Available Offers for the most
recent cycle row.

Field or Control Description

Cycle The value here is the most recent course record that’s being
considered.

If the condition isn’t used in the most recent cycle for the
course, the course isn’t listed on the table even if the condition
was used for an earlier cycle.

Default This check box appears as selected if the offer is set as the
default for the course.

Creating or Reviewing Application Statuses for Apply Applications
Access the Apply Application Status page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > Apply Setup > Apply Application Status).

Copyright © 1988, 2021, Oracle and/or its affiliates. 917



(GBR) Managing UCAS and UTT Applications Chapter 27

This example illustrates the fields and controls on the Apply Application Status page. You can find
definitions for the fields and controls later on this page.

Use this page to add or view statuses for Apply applications. You assign these statuses as decisions in
applications.

Available Decisions

Use this region to identify whether a status is valid as a decision for an application.

Field or Control Description

Existing Status These represent the current status an application may have. If
an application has this value as its status, then you can assign
the corresponding application status as a decision on the Apply
Decisions page.

In the example screenshot, you can assign the decision Offer
on the Apply Decisions page for applications whose existing
status is any one of these: New (awaiting_provider_decision),
Offer (offer), or Rejected (rejected).

These records are delivered with the system. You can update these depending on the options that
the Department for Education allows. For example, if an offer can be rescinded after a candidate
accepts the offer, you can add a new row for “Rejected” for applications with an existing status
“pending_conditions.”

Application Status corresponds to a decision that you can assign to an application. Existing Status refers
to an application’s current state in the application process.
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Application Status Existing Status

Offer • New (awaiting_provider_decision)

• Offer (offer)

• Rejected (rejected)

Rejected • New (awaiting_provider_decision)

• Offer (offer)

Conditions met (recruited) Accepted (pending_conditions)

Conditions not met Accepted (pending_conditions)

Related Links
Entering or Updating a Decision for Apply Applications

Defining Reasons for Rejection
Access the Rejection Reasons page (Set Up SACR >Product Related >Recruiting and
Admissions >UCAS >Apply Setup >Rejection Reasons).

Use this page to create the text for rejecting an application. The text you define here is used to populate
the reason rejection field in a decision record.

You can delete rejection reasons because the code is not stored in decision records.

To create a reason for rejection, click Add New Value, then provide values for:

Field or Control Description

Academic Institution Enter your institution. By default, this value is set to the user’s
default institution.

Rejection Code Enter a code for the rejection. You can enter a maximum of 10
characters.

Details

You can add multiple rows of reasons, and each row is identified by the effective date. When you add a
new row, the effective date defaults to the current date, the status defaults to Active, the rejection text is
copied from the most recent row.
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Reviewing and Mapping Apply Courses
Access the Apply Course page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS >Apply Setup > Apply Course).

This example illustrates the fields and controls on the Apply Course page. You can find definitions for the
fields and controls later on this page.

Use this page to add Apply course records with different cycles. Records with the most recent cycle
appear first.

Take note of these fields:
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Field or Control Description

Site Code Enter a short hyphen if the course is offered in only one
location and there’s no site code.

Study Mode Enter full_time or part_time.

Details

You can add multiple records (rows) for different cycles. The records appear in descending order, that is,
the most recent cycle record appears first.

When you add a new record, all the values from the previous record (including the mapping fields) are
copied to the new record except for Cycle and Entry Year, which are blank.

Field or Control Description

Cycle This field requires exactly four digits.

This represents the Recruitment Cycle Year for Apply
applications.

Entry Year (Optional) If you:

• Enter a value, that is used to populate the Entry Year
field on the choice record, which is then used with Entry
Month to map the appropriate Admit Term for the CS
application.

• If you don’t enter a value, the Entry Year for choices is
derived from recruitment_cycle_year.

Entry Month The value defaults to zero and can be set to an alternative
value for use in mapping to Admit Term. For example, for
applications for the 2021 cycle with a start date of February
2022, the Entry Year can be set to 2022 and the Entry Month
to 2 and those values mapped to a different Admit Term
value than the Admit Term used for September 2021 starts if
required.

Default Offer Select a default offer from a list of active Apply Offers.

Mapping

You must map a Campus Solutions academic career, program, and plan for each combination of Apply
course code, entry year and entry month that may exist in an imported application choice. The remaining
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fields are optional. The system uses the mapped values when creating or updating the Campus Solutions
application record related to an Apply application choice.

If you do not map the Application Center and Campus values, the system uses the default values defined
on the UTT/Apply Import page.

Field or Control Description

Academic Load If you don’t enter a value, then it’s derived from the Study
Mode of the choice.

Cohort Tag If you don’t enter a value, then it’s derived from the Entry Year
page if it’s defined there.

Year of Program If you don’t enter a value, then it’s set to 01 – First Year.

Available Offers

If you define offers here, this limits the available offers for applications for the course. Otherwise, all
active offers are available.

When you add a new row for a new cycle, all the existing values are copied to the new record and can be
edited.

Available Conditions

If you define conditions here, this limits the available conditions for applications for the course.
Otherwise, all active conditions are available.

When you add a new row for a new cycle, all the existing values are copied to the new record and can be
edited.

Processing UCAS and UTT Reference Data

This section provides an overview of reference data processing and discusses how to:

• Import reference data.

• Review and map UCAS courses.

• Review and map UTT courses.

• Review and map area of permanent residence.

• Review and map disability data.

• Review and map ethnicity data.

• Review and map residential category data.
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• Review and map country data.

• Review and map nationality data.

• Review exam level data.

Understanding UCAS and UTT Reference Data Processing
You must process reference data before importing applications. To process reference data, first run the
Import Reference Data Application Engine (SAD_UC_IMREF) process to import the reference data.
Then, use the Reference Data pages to view the imported reference data in the Campus Solutions tables.

Note: For Apply applications, reference data isn’t imported.

If you selected the Import Live check box on the UCAS Configuration page, the system loads the data
from UCAS into the staging tables and then into the Campus Solutions tables.

If you did not select the Import Live check box, the system loads the data from the staging tables into the
Campus Solutions tables. The following table lists the staging tables that store the reference data:

Staging Table Stores Data Imported From

PS_SAD_UC_I_SCHCTX cvRefSchoolContextualData

PS_SAD_UC_I_INST cvInstitution

PS_SAD_UC_I_REGION cvnRefRegion

PS_SAD_UC_I_CVCOURSE cvCourse

PS_SAD_UC_I_CVGCOURSE cvgCourse

PS_SAD_UC_I_KEYWORD cvRefKeyword

PS_SAD_UC_I_SCHOOL cvSchool

PS_SAD_UC_I_SCHOOLCONT cvSchoolContact

PS_SAD_UC_I_SCHOOLTYPE cvRefSchoolType

PS_SAD_UC_I_ESTGROUP cvRefEstGroup

PS_SAD_UC_I_APR cvRefAPR

PS_SAD_UC_I_DIS cvRefDis
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Staging Table Stores Data Imported From

PS_SAD_UC_I_ETHNIC cvRefEthnic

PS_SAD_UC_I_RESCAT cvRefResCat

PS_SAD_UC_I_COUNTRY cvRefCountry

PS_SAD_UC_I_NATIONLTY cvRefNationality

PS_SAD_UC_I_POCC cvRefPOCC

PS_SAD_UC_I_SOCCLASS cvRefSocialClass

PS_SAD_UC_I_SOCIOECON cvRefSocioEconomic

PS_SAD_UC_I_CARE cvRefCare

PS_SAD_UC_I_SPONSOR cvRefPrepSponsor

PS_SAD_UC_I_SCHOOLYEAR cvRefSchoolYear

PS_SAD_UC_I_PARENTHE cvRefParentinHE

PS_SAD_UC_I_FEE cvRefFee

PS_SAD_UC_I_EBLSUBJ cvEBLSubject

PS_SAD_UC_I_AWARDBODY cvRefAwardBody

PS_SAD_UC_I_EXAM cvRefExam

PS_SAD_UC_I_SUBJ cvRefSubj

PS_SAD_UC_I_UNITS cvRefUnits

PS_SAD_UC_I_OEQ cvRefOEQ

PS_SAD_UC_I_DEGRSUBJ cvgRefDegreeSubject

PS_SAD_UC_I_GDTYPE cvgRefHighestExpectedQualType
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Staging Table Stores Data Imported From

PS_SAD_UC_I_OFFABBR cvRefOfferAbbrev

PS_SAD_UC_I_UVOFFABBR uvOfferAbbrev

PS_SAD_UC_I_STATUS cvRefStatus

PS_SAD_UC_I_OFFERSUBJ cvRefOfferSubj

PS_SAD_UC_I_ERROR cvRefError

PS_SAD_UC_I_CVAMEND cvRefAmendments

PS_SAD_UC_I_POCC10 cvRefPOCC2010

PS_SAD_UC_I_CVGAMEND cvgRefAmendments

PS_SAD_UC_I_CAREDUR cvRefCareDuration

PS_SAD_UC_I_TARIFF cvRefTariff

PS_SAD_UC_I_LEA cvRefLea

PS_SAD_UC_I_GENIDE cvRefGenIdenDiff

PS_SAD_UC_I_SEXORT cvRefSexOrientation

PS_SAD_UC_I_RELBLF cvRefReligionBelief

If you selected both the UTT and UCAS check boxes on the UCAS Configuration page, the system loads
both the UCAS and UTT reference data.

The system imports cvRefSchoolContextualData data only if you have selected the Contextual Data check
box and the UCAS Cycle is 2012 or greater on the UCAS Configuration page.

After loading the reference data, you need to use the Reference Data pages to map the UCAS values to
the Campus Solutions values. For example, you must map the UCAS courses to the Campus Solutions
careers, programs, and plans. Additionally, you can use the Reference Data pages to review whether the
Import Reference Data process imported all the required data.

For information about the fields on the Reference Data pages that display the imported data, refer to the
ODBC-link Technical Manual.

All the Reference Data pages have Active and Imported check boxes. Clear the Active check box to
deactivate a manually added reference data record.
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The system enables the Active check box for records that you entered manually through the Reference
Data pages. However, the system disables the Active check box for imported records. The exception to
this rule is the Institution Offer Abbreviation page on which the Active check box is enabled for both
imported and non-imported records.

The Imported check box indicates whether you imported or manually added the reference data. If you
manually add the data on a Reference Data page, then the system clears the Imported check box.

For cvName/cvNameU and cvgName/cvgNameU, the system does not import the data into Campus
Solutions. Therefore, staging tables do not exist for these views. The Personal ID look up icon directly
queries these views to display the applicant values on the UCAS and UTT Enquiry Entry pages. If the
Unicode check box is selected on the UCAS Configuration page, then the lookup queries the NameU
version of the view.

If the configured cycle is:

• 2015 or greater on the UCAS Configuration page, the Import Reference Data process imports the
cvRefPOCC2010 view based on the date/time column POCCDate2010 of cvRefAmendments.
POCCDate2010 indicates the date/time of the last changes to the cvRefPOCC2010 view.

• 2022 or greater, the Import Reference Data process imports the cvRefPOCC2020 view based on the
date/time column POCCDate2020 of cvRefAmendments. POCCDate2020 indicates the date/time of
the last changes to the cvRefPOCC2020 view.

From 2015 cycle onwards, the process doesn't import cvRefSocialClass. And from 2022 cycle onwards,
the process doesn't import cvRefPOCC.

The Import Reference Data process imports records for the local institution code (that you define
on the UCAS Configuration page) from cvgCourse. In order to also import the course records of
associated institutions for Schools Direct applications, you must select the Accredited Institution check
box for the institution on the Institution page (Set Up SACR >Product Related >Recruiting and
Admissions >UCAS >Reference Data >Institution) and the Override Timestamp value for the
cvgCourse view must be set back to ensure that all the required records are imported the next time Import
Reference Data process is run. The Override Timestamp value is set on the Internal Timestamp page. For
more information, see Defining a Timestamp for Re-importing Data

Pages Used to Process UCAS and UTT Reference Data

Page Name Definition Name Navigation Usage

Import Reference Data SAD_UC_IMP_REF_PRC Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Import Reference Data

Import UCAS reference data
into your database.

926  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 27 (GBR) Managing UCAS and UTT Applications

Page Name Definition Name Navigation Usage

UCAS Courses SAD_UC_COURSE Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > UCAS Course

View the imported cvCourse
data or manually enter the
UCAS course data into
your database. Also, map a
UCAS course with a Campus
Solutions academic career,
 program, plan, subplan,
 application center, and
campus.

Area of Permanent Residence SAD_UC_APR Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Area of
Permanent Residence

View the imported cvRefAPR
domicile data or manually
enter the APR data into
your database. Also, map
the UCAS domicile to the
Campus Solutions country
code.

Country SAD_UC_CNTRY Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Country

View the imported
cvRefCountry data or
manually enter the UCAS
country data into your
database. Also, map the
UCAS country code to the
Campus Solutions country
code.

Disability SAD_UC_DIS Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Disability

View the imported cvRefDis
data or manually enter the
UCAS disability data into
your database. Also, map the
UCAS disability code to the
Campus Solutions disability
code and type of impairment.

Ethnic SAD_UC_ETHNIC Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Ethnic

View the imported
cvRefEthnic data or manually
enter the UCAS ethnic data
into your database. Also, map
the UCAS ethnicity code to
the Campus Solutions set
ID, regulatory region, and
ethnicity group.

Nationality SAD_UC_NATION Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Nationality

View the imported
cvRefNationality data or
manually enter the UCAS
nationality data into your
database. Also, map the
UCAS nationality code to the
Campus Solutions country
and citizenship codes.
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Page Name Definition Name Navigation Usage

Residential Category SAD_UC_RESCAT Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Residential
Category

View the imported
cvRefResCat data or manually
enter the UCAS residential
category data into your
database. Also, map the
UCAS residential category
code to the Campus Solutions
residency code.

Exam Levels SAD_UC_EXAM Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Mappings > Exam Levels

View the imported
cvRefExam data or manually
enter the UCAS exam level
data into your database. Also,
 map the UCAS exam level
to the Campus Solutions
qualification type.

EBL Subject SAD_UC_EBLSUB Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > EBL
Subject

View the imported
cvEBLSubject data or
manually enter the UCAS
EBL Subject data into your
database.

Institution SAD_UC_INST Set Up SACR > Product
Related > Recruiting
and Admissions >
UCAS > Reference Data >
Institution

View the imported
cvInstitution data or manually
enter the UCAS institution
data into your database.

For UTT and Apply, indicate
schools for which you are the
accredited provider.

NHS Region SAD_UC_REGION Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > NHS
Region

View the imported
cvnRefRegion data or
manually enter the NHS
Region data into your
database.

Awarding Body SAD_UC_AWDBDY Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Awarding
Body

View the imported
cvRefAwardBody data or
manually enter the UCAS
awarding body data into your
database.

In Care SAD_UC_CARE Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > In Care

View the imported cvRefCare
data or manually enter the
UCAS In Care data into your
database.
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Page Name Definition Name Navigation Usage

In Care Duration SAD_UC_CAREDUR Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > In Care
Duration

View the imported
cvRefCareDuration data or
manually enter the UCAS In
Care Duration data into your
database.

Error Code SAD_UC_ERROR Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Error
Code

View the imported cvRefError
data or manually enter the
UCAS Error Code data into
your database.

Establishment Group SAD_UC_ESTGRP Set Up SACR > Product
Related > Recruiting
and Admissions >
UCAS > Reference Data >
Establishment Group

View the imported
cvRefEstGroup data or
manually enter the UCAS
establishment group data into
your database.

Fee Payer SAD_UC_FEE Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Fee Payer

View the imported cvRefFee
data or manually enter the
UCAS fee payer data into
your database.

Keyword SAD_UC_KEY Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Keyword

View the imported
cvRefKeyword data or
manually enter the UCAS
keyword data into your
database.

LEA SAD_UC_LEA Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > LEA

View the imported cvRefLea
data or manually enter
the LEA codes into your
database.

Other Exam Qualifications SAD_UC_OEQ Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Other
Exam Qualifications

View the imported cvRefOEQ
data or manually enter
the UCAS Other Exam
Qualifications data into your
database.

Offer Abbreviation SAD_UC_COFABB Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Offer
Abbreviation

View the imported
cvRefOfferAbbrev data.

Offer Subject SAD_UC_OFFSUB Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Offer
Subject

View the imported
cvRefOfferSubj data or
manually enter the UCAS
Offer Subject data into your
database.
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Page Name Definition Name Navigation Usage

Parent in Higher Education SAD_UC_PARHE Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Parent in
Higher Education

View the imported
cvRefParentinHE data or
manually enter the UCAS
Parent in Higher Education
data into your database.

Parental Occupation SAD_UC_POCC Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Parental
Occupation

View the imported
cvRefPOCC data or manually
enter the UCAS Parental
Occupation data into your
database.

Parental Occupation 2010 SAD_UC_POCC2010 Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Parental
Occupation 2010

View the imported
cvRefPOCC2010 data or
manually enter the UCAS
Parental Occupation 2010
data into your database.

Parental Occupation 2020 SAD_UC_POCC2020 Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Parental
Occupation 2020

View the imported
cvRefPOCC2020 data or
manually enter the UCAS
Parental Occupation 2020
data into your database.

Sponsor SAD_UC_PRESPN Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Sponsor

View the imported
cvRefPrepSponsor data or
manually enter the UCAS
sponsor data into your
database.

School SAD_UC_SCHOOL Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > School

View the imported cvSchool
and cvSchoolContact data.

Click the External Org
Details link to update or view
the details of the External
Organization that is mapped
to the school.

School Contextual Data SAD_UC_SCH_CTXT Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > School
Contextual Data

View the imported
cvRefSchoolContextualData
data or manually enter the
School Contextual data into
your database.

School Type SAD_UC_SCHTYP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > School
Type

View the imported
cvRefSchoolType data or
manually enter the UCAS
school type data into your
database.
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Page Name Definition Name Navigation Usage

School Year SAD_UC_SCHYR Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > School
Year

View the imported
cvRefSchoolYear data or
manually enter the UCAS
school year data into your
database.

Social Class SAD_UC_SOCCLS Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Social
Class

View the imported
cvRefSocialClass data or
manually enter the UCAS
social class data into your
database.

Socio Economic SAD_UC_SOCECO Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Socio
Economic

View the imported
cvRefSocioEconomic data
or manually enter the UCAS
Socio Economic data into
your database.

Status SAD_UC_STATUS Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Status

View the imported
cvRefStatus data or manually
enter the UCAS status data
into your database.

Subject SAD_UC_SUB Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Subject

View the imported cvRefSubj
data or manually enter the
UCAS subject data into your
database.

Units SAD_UC_UNITS Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Units

View the imported cvRefUnits
data or manually enter the
UCAS unit data into your
database.

Institution Course Keyword SAD_UC_CRSKEY Set Up SACR > Product
Related > Recruiting
and Admissions >
UCAS > Reference Data >
Institution Course Keyword

View the imported
uvCourseKeyword data or
manually enter the UCAS
Institution Course Keyword
data into your database.
 If required, update or add
keywords that users can use
to search for the course in
the UCAS course web search
utility.

Institution Offer Abbreviation SAD_UC_UOFABB Set Up SACR > Product
Related > Recruiting
and Admissions >
UCAS > Reference
Data > Institution Offer
Abbreviation

View the imported
uvOfferAbbrev data or
manually enter the UCAS
Institution Offer Abbreviation
data into your database.
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Page Name Definition Name Navigation Usage

Tariff Scores SAD_UC_TARIFF Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Tariff
Scores

View the imported
cvRefTariff data or manually
enter the UCAS tariff data
into your database.

UTT Course SAD_UC_GCOURSE Set Up SACR >Product
Related >Recruiting and
Admissions >UCAS >Mappings >UTT
Course

View the imported cvgCourse
data or manually enter
the UTT course data into
your database. Also, map a
UTT course with a Campus
Solutions academic career,
 program, plan, sub-plan,
 application center, and
campus.

UTT Degree Subject SAD_UC_GDSUB Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > UTT
Degree Subject Table

View the imported
cvgRefDegreeSubject data
or manually enter the UTT
degree subject data into your
database.

UTT Qualification Type SAD_UC_GDTYPE Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > UTT
Qualification Type

View the imported
cvgRefHighest
ExpectedQualType data or
manually enter the UTT
qualification type data into
your database.

Regional EXT_ORG_TBL_REG Campus Community >
Organization > Create/
Maintain Organizations >
Organization Table >
Regional

View the imported cvSchool
data or manually enter the
UCAS school data into your
database.

The system enables the UK
UCAS School Data region
only if you select the HESA,
 UCAS check box on the SA
Features page.

Gender Identity Difference SAD_UC_GENDIDEN Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Gender
Identity Difference

View the imported
cvRefGenIdenDiff data or
manually enter the gender
identity difference data into
your database.

Religion/Belief SAD_UC_RELBLF Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Religion/
Belief

View the imported
cvRefReligionBelief data or
manually enter the religion or
belief data into your database.
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Page Name Definition Name Navigation Usage

Sexual Orientation SAD_UC_SEXORT Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Reference Data > Sexual
Orientation

View the imported
cvRefSexOrientation data
or manually enter the sexual
orientation data into your
database.

Importing Reference Data
Access the Import Reference Data page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > Import Reference Data).

The Import Reference Data process imports reference data based on UCAS timestamps. After the process
runs, you can view the latest timestamp information on the Internal Timestamp page.

For more information about the Internal Timestamp page, see Defining a Timestamp for Re-importing
Data

Field or Control Description

Import Live Indicates how the Import Reference Data process loads data
into the Campus Solutions tables.

You cannot select or clear this check box. The system selects
this check box if you selected the Import Live check box on
the UCAS Configuration page.

If the system selects the check box, the import process loads
the data into the staging tables and then into the Campus
Solutions tables. If the system does not select the check box,
 the import process loads the data from the staging tables into
the Campus Solutions tables.

Academic Institution Enter the academic institution for which you want to import
the data.
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Field or Control Description

Create/Update External Org Rec  (create/update external
organization record)

Select this check box to instruct the process to create or update
an external organization record for the imported school.

If you select this option, and if the process does not find a
corresponding external organization record for the imported
school, it creates an external organization record. You can
view this external organization record using the Organization
Table page (Campus Community, Organization, Create/
Maintain Organizations, Organization Table).

If you select this option, and if the process finds a
corresponding external organization record that needs to
be updated, it creates a new effective dated record in the
Organization Table page. For example, suppose a school's
contact email ID has changed and the school already has an
associated external organization record in Campus Solutions.
When you import the school reference data, the process inserts
a new record with the new email ID of the contact.

If the check box is cleared, the process imports the cvSchool
and cvSchoolContact records into the Campus Solutions tables
but does not create eternal organization records.

Creation of External Org records can cause the process to run
slowly. Therefore, you can first run the Import Reference Data
process without selecting this check box. Then you can run the
process again with the Create/Update External Org Rec check
box selected to create the external organization records.

Reviewing and Mapping UCAS Courses
Access the UCAS Course page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Mappings > UCAS Course).
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This example illustrates the fields and controls on the UCAS Course page . You can find definitions for
the fields and controls later on this page.

Note: If the UCAS Campus value in cvCourse is null (that is, the institution does not have separate UCAS
campus codes), then the Import Reference Data process imports the value as *. If you are adding course
records manually, you need to add either a valid UCAS campus value or *.
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Field or Control Description

UCAS Timestamp Displays the date and time when UCAS updated the cvCourse
view.

This field is read-only and only appears for imported records.
 For manually added records, this field is blank and you do not
need to enter a value.

Mapping

You must map a Campus Solutions academic career, program, and plan for each combination of UCAS
course code, entry year and entry month that may exist in an imported application choice. The remaining
fields in the Mapping group box are optional. The system uses the mapped values when creating or
updating the Campus Solutions application record related to the UCAS application choice.

If you do not map the Application Center and Campus values on this page, then the system uses the
default values defined in the UCAS Application Import page.

Reviewing and Mapping UTT Courses
Access the UTT Course page (Set Up SACR >Product Related >Recruiting and
Admissions >UCAS >Mappings >UTT Course).
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This example illustrates the fields and controls on the UTT Course page. You can find definitions for the
fields and controls later on this page.

Note: If the UTT Campus value in cvgCourse is null (that is, the institution does not have separate UTT
campus codes), then the Import Reference Data process imports the value as *. If you are adding course
records manually, you need to add either a valid UTT campus value or *.
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Field or Control Description

UCAS Timestamp Displays the date and time when UTT updated the cvgCourse
view.

This field is read-only and only appears for imported records.
 For manually added records, this field is blank and you do not
need to enter a value.

Mapping

You must map a Campus Solutions academic career, program, and plan for each combination of UTT
course code, entry year and entry month that may exist in an imported application choice. The remaining
fields in the Mapping group box are optional. The system uses the mapped values when creating or
updating the Campus Solutions application record related to the UTT application choice.

If you do not map the Application Center and Campus values on this page, then the system uses the
default values defined in the UTT/Apply Import page.

Field or Control Description

Academic Load The value you enter here is used in Approved Academic
Load when creating or updating CS applications for UTT
applications. Otherwise, it is derived from the part-time value
from ivgStarG.

Reviewing and Mapping Area of Permanent Residence
Access the Area of Permanent Residence page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > Mappings > Area of Permanent Residence).
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This example illustrates the fields and controls on the Area of Permanent Residence page. You can find
definitions for the fields and controls later on this page.

Mapping

In the Country and the State fields, enter the Campus Solutions country and state codes to map to the
UCAS domicile code.

Reviewing and Mapping Disability Data
Access the Disability page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Mappings > Disability).
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This example illustrates the fields and controls on the Disability page. You can find definitions for the
fields and controls later on this page.

Mapping

In the Disability and Type of Impairment fields, enter the Campus Solutions disability and type of
impairment codes to map to the UCAS disability code.

Reviewing and Mapping Ethnicity Data
Access the Ethnic page (Set Up SACR > Product Related > Recruiting and Admissions > UCAS >
Mappings > Ethnic).

This example illustrates the fields and controls on the Ethnic page. You can find definitions for the fields
and controls later on this page.
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Mapping

In the SetID field, enter the setID of your institution. In the Regulatory Region field, enter the Campus
Solutions regulatory region code. In the Ethnic Group field, enter the Campus Solutions ethnic code to
map to the UCAS ethnic code.

Reviewing and Mapping Residential Category Data
Access the Residential Category page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > Mappings > Residential Category).

Mapping

In the Residency field, enter the Campus Solutions residency code to map to the UCAS residential
category code.

Reviewing and Mapping Country Data
Access the Country page (Set Up SACR > Product Related > Recruiting and Admissions > UCAS >
Mappings > Country).

This example illustrates the fields and controls on the Country page. You can find definitions for the fields
and controls later on this page.

Mapping

In the Country field, enter the Campus Solutions country code to map to the UCAS country code.

Reviewing and Mapping Nationality Data
Access the Nationality page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Mappings > Nationality).
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This example illustrates the fields and controls on the Nationality page. You can find definitions for the
fields and controls later on this page.

Mapping

In the Country and Citizenship Status fields, enter the Campus Solutions country and citizenship status
codes to map to the UCAS nationality code.

Reviewing Exam Level Data
Access the Exam Levels page (Set Up SACR > Product Related > Recruiting and Admissions >
UCAS > Mappings > Exam Levels).

Mapping to Qualification Text is no longer used for ivStarPQR records and is no longer required.

Importing UCAS and UTT Applications and Applicant Data

This section provides an overview of importing applications and applicant data into your database, and
discusses how to:

• View the transaction setup.

• Define the search/match criteria.

• Enter the applicant import parameters.

• Import new applicants.

• Import HESA data.

• Review and edit the suspense data.
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• View, update, and delete application staging data.

• Define a timestamp for re-importing data.

Understanding Importing UCAS and UTT Applications and Applicant Data
When you import applicant data, the system creates new person records in your database or updates
details about existing person records. First, you must ensure that you are not going to create any duplicate
data by setting up the search/match parameters. Then, you run the Import Applicant Data process to load
the application and applicant data into your database. The search/match process determines if the person
might already exist in your database. The purpose of the search/match is to prevent duplicate records. You
can specify what you want the post process to do when search/match finds a match or multiple matches. It
is recommended that you set the status as Suspend when you set up the search/match criteria for multiple
matches. Based on the results of the search/match process, the import process can update the record in
your database that matches the imported data if you are sure that the person in your database is the same
person to whom the imported data relates.

The Import Applicant Data process allows data to be imported from:

• UCAS iv views, if you selected UCAS on the UCAS Configuration page

• UTT iv views, if you selected UTT.

• Apply applications, if you selected Use Apply.

If Import Live is selected, the system imports data into Campus Solutions tables through the staging tables
based on the import options selected for UCAS, UTT, and Apply. You can select Import Live only if you
selected it in UCAS Configuration.

• If Personal ID and Application Code are specified, all application records for the applicant are
imported irrespective of timestamp.

• If Personal ID and Application Code are not selected, records are imported to the staging tables based
on the timestamp records for each system. For UCAS and UTT, internal timestamp records for each
view are considered. For Apply, a single internal timestamp record is considered.

• If there is an internal timestamp record, records with a higher timestamp than the internal
timestamp value (set on the previous run of the import) are imported unless Override Timestamp
is defined, in which case records with a higher timestamp than that value are imported.

• If there is no internal timestamp record, for UCAS and UTT all records are imported for the view.
For Apply, records updated since 2020-01-01T00:00:00Z are imported. At the end of the import,
the internal timestamp records are updated to reflect the highest imported timestamp value.

If Import Live isn’t selected, new records are not imported and existing staging records are re-processed
based on the import options selected for UCAS, UTT, and Apply.

The Import Applicant Data process imports data from the ivContextual view only if the Contextual check
box is selected and Cycle is 2012 or later on the UCAS Configuration page.

Also, the process imports data from the Unicode version of views only if the Unicode check box is
selected on the UCAS Configuration page. For example, if you have selected the Unicode check box, the
process imports data from the Unicode views, such as ivStarAU and ivStarJU. Conversely, if you have not
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selected the Unicode check box, the process imports data from the standard views, such as ivStarA and
ivStarJ.

You can view, update, or delete the suspended UCAS and UTT application data in the staging tables
using the Staging Data pages. You can search for the suspended data based on various search parameters
including import status, application code and personal ID.

The import process creates a corresponding Campus Solutions application record for each imported
application choice. If an applicant has more than one ChoiceNo for an AppCode at your institution, the
import process creates a separate Campus Solutions application record for each AppCode and ChoiceNo
combination. You can use the Maintain Applications component to access the Campus Solutions
application record. Each application record will have an effective date that indicates the date when you
imported the application. If you import updates to the same application on different days, the system
creates new application records with the different effective dates. If you import updates to the same
application multiple times on a particular day, the system updates the Campus Solutions application
record for that particular date. In addition to creating (or updating) the Campus Solutions application for
an imported choice matching the local institution code that you have defined on the UCAS Configuration
page, the process also creates (or updates) the Campus Solutions application for an imported UTT choice
whose Accrediting Provider value matches the local institution code.

The import process also creates (or updates) the Campus Solutions applications for imported Apply
applications where Accredited Institution is selected in the institution reference data record for an
institution code. The process also creates an application choice record in Campus Solutions for the
imported application choice. You can use the UCAS Applications, UTT Applications, Apply Applications
components to view the imported application choice.

If the related application choice record from ivStarC has not been imported, message 14250,176 is logged
for incoming records from ivOffer. Typically this occurs where the ivStarC record remains in staging
because of a missing mapping. In cases where 14250,176 is logged for ivOffer, there is also usually, an
error message logged for the missing mapping as part of the ivStarC import. The ivOffer staging record
status is set to Pending and is reprocessed once the related choice staging record has been successfully
imported.

For more information about these components, see Reviewing Imported UCAS and UTT Applications
and Applicant Data.

Suppose you are importing a UCAS or UTT choice and its decision value already exists in ivStarC or
ivgStarG. For such a choice, when you run the import process for the first time, the process creates the
Campus Solutions application and populates the Program Action and Action Reason of the Application
Program Data record based on the following mappings set up on the program action page of the UCAS
Configuration component:

UCAS processing - ivStarC:

• If Decision = I, use action/reason for Interview

• If Decision = F, use action/reason for Course Full

• If Decision = R, use action/reason for Rejection

• If Decision = W, use action/reason for Withdrawal

• If Decision = C or D and Reply = F, use action/reason for Conditional Firm
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• If Decision = C or D and Reply = I, use action/reason for Conditional Insurance

• If Decision = C or D and Reply = D, use action/reason for Conditional Decline

• If Decision = C or D and Reply = blank, use action/reason for Conditional Offer

• If Decision = U and Reply = F, use action/reason for Unconditional Firm

• If Decision = U and Reply = I, use action/reason for Unconditional Insurance

• If Decision = U and Reply = D, use action/reason for Unconditional Decline

• If Decision = U and Reply = blank, use action/reason for Unconditional Offer

• If Decision and Reply are blank (i.e. most new applications) or any other combination, then set
Program Action = APPL, Action Reason = default value or blank

• Else set program action = APPL and reason = default value (if defined) from the UCAS Application
Import page of the UCAS Configuration component.

Processing updates ensure that for applications where a decision has been made but a reply has not yet
been received, if a new row is added for a change of course/campus, term or entry point, then a second
new row is added to ensure that the most recent row reflects the decision value.

If during import,

• A new row is added for any of the following: Changed Course/Campus, Changed Term, Changed
Entry Point;

• And, the new Decision value is not blank;

• And, both the new and existing Reply values are blank (no subsequent Reply Change row will be
added);

Then, a new row is added based on the Decision value of the choice. For example, if the Decision = C,
then the program action and reason for Conditional Offer are used for the new row.

For applications previously rejected or declined by default and then re-instated, processing updates add a
row to reflect the decision and reply of the choice.

If the new Action value is blank and the existing Action for the choice is D or R, the Campus Solutions
application is updated based on the new decision/reply values. For example, if the Decision = C and
Reply = F, the program action and reason for Conditional Firm are used for the new row.

UTT processing - ivgStarG:

• If ClearingStatus is not ‘2’ or ‘3’ (non-clearing applications), set the program action/reason.

• Set the new Clearing flag in the choice record to N

• If Decision = I, use action/reason for Interview

• If Decision = G, use action/reason for Course Closed

• If Decision = R, E, M, or S, use action/reasons for Rejection, Rejection - English, Rejection - Maths,
Rejection - Science

Copyright © 1988, 2021, Oracle and/or its affiliates. 945



(GBR) Managing UCAS and UTT Applications Chapter 27

• If Decision = W, use action/reason for Withdrawal

• If Decision = C or D and Reply = F, use action/reason for Conditional Firm

• If Decision = C or D and Reply = D, use action/reason for Conditional Decline

• If Decision = C or D and Reply = blank, use action/reason for Conditional Offer

• If Decision = U and Reply = F, use action/reason for Unconditional Firm

• If Decision = U and Reply = D, use action/reason for Unconditional Decline

• If Decision = U and Reply = blank, use action/reason for Unconditional Offer

• If Decision and Reply are blank (i.e. most new applications) or any other combination, then set
Program Action = APPL, Action Reason = default value or blank

• Else set program action = APPL, reason = default value (if defined) from the UTT/Apply Import page
of the UCAS Configuration component.

When choices are initially imported for UCAS (ivStarC or ivStarZ1) and UTT (ivgStarG), if there are
existing values for Decision or Reply, then the program action/reason of the newly created application
is set to the appropriate combination. However, there is a limitation on which program action values can
be used when a Campus Solutions application is initially created. For the first effective-dated record,
only these program actions are valid: ADMT (Admit), DENY (Deny/Reject), RAPP (Re-admit), RECN
(Re-consideration), WAPP (Applicant Withdrawal) or WADM (Administrative Withdrawal). When
these program actions are used to create the initial record, the application is created with that program
action. Otherwise, the application is created using APPL program action and the default action reason
(if available) or blank. If the mapped program action is a value other than ADMT, APPL, DEIN, DENY,
RECN, WADM or WAPP, then a second row is added to the application record to reflect the decision/
reply mapping.

Processing updates ensure that for applications where a decision has been made but a reply has not yet
been received, if a new row is added for a change of course/campus or term, then a second new row is
added to ensure that the most recent row reflects the decision value.

If during import,

• A new row is added for either Changed Course/Campus or Changed Term;

• And, the new Decision value is not blank;

• And, both the new and existing Reply values are blank (no subsequent Reply Change row will be
added);

Then, a new row is added based on the Decision value of the choice. For example, if the Decision = C,
then the program action and reason for Conditional Offer are used for the new row.

For applications previously rejected or declined by default and then re-instated, processing updates add a
row to reflect the decision and reply of the choice.

If the new Action value is blank and the existing Action for the choice is D or R, the Campus Solutions
application is updated based on the new decision/reply values. For example, if the Decision = C and
Reply = F, the program action and reason for Conditional Firm are used for the new row.

946  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 27 (GBR) Managing UCAS and UTT Applications

The Import Applicant Data process uses the Nationality page mapping to import the passport field values
from StarK and create the citizenship and passport records. If the nationality value in an imported record
does not have a corresponding country code mapping, then the process does not create a citizenship and
passport record. The process logs an error message and the record is retained in the staging tables.

Suppose you have mapped a nationality with a country code but did not map the same nationality with a
citizenship status. In this case, if a citizenship record does not exist in Campus Solutions for the imported
record, the process creates a new blank citizenship record. That is, the process enters only the Country
value and leaves the Citizenship Status value as blank on the Citizenship Detail page (Add/Update a
Person component).

Suppose you have mapped a nationality 610 with a country code CHN  and citizenship status 1 (Citizen).
The citizenship record for a person named Eric with the same nationality exists in Campus Solutions with
a different citizenship status 2 (Naturalized). In this case, when the process again imports Eric's record
that has a nationality of 610, it updates Eric's citizenship record in Campus Solutions with the mapped
citizenship status 1.

The Import Applicant Data process processes an incoming passport record if you have mapped the
Nationality and Country values and if UCAS has provided a passport number. The process creates or
updates a passport record for the applicant in the following ways:

• If the applicant's passport record with the Country and Passport Number combination exists in
Campus Solutions, then the process updates that record with the incoming passport issue date, expiry
date and place issued values.

• If the applicant's passport record with the Country and Passport Number combination does not exist in
Campus Solutions, then the process creates a new record using the incoming values.

The import process uses the Forenames and Surname values from StarN to create or update a Primary
and Preferred Name record in Campus Solutions. However, if Preferred First Name value from StarK
exists, then the import process uses this StarK value to create or update the Preferred Name record for the
applicant. A Preferred First Name is not supplied in Apply, so the preferred name record is created using
the same values in Forenames in the primary name record.

If the LastEducation value exists in the ivStarK view and the school code is mapped to a Campus
Solutions External Org in the imported School reference data, the process populates this mapped External
Org value in the Application School/Recruiting page for the Campus Solutions application record. If the
LastEducation value does not exist, but the School value exists in the ivStarK view and the school code is
mapped to a Campus Solutions External Org in the imported School reference data, the process populates
this mapped External Org value in the Application School/Recruiting page.

Pages Used to Import UCAS and UTT Applications and Applicant Data

Page Name Definition Name Navigation Usage

Transaction Setup SCC_TRANSAC_DTLS Student Admissions >
UCAS Processing > Import
Applicants > Transaction
Setup

View the delivered UCAS
and Apply transactions that
you can use in the Transaction
Search/Match Setup page.
 Do not modify any values for
these delivered transactions or
create new ones.
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Page Name Definition Name Navigation Usage

Search/Match Setup SCC_SEARCH_PARMS Student Admissions >
UCAS Processing > Import
Applicants > Transaction
Setup > Search/Match
Setup

Define search and match
parameters for the delivered
UCAS transaction, which
specify what UCAS data the
system will append to existing
records in your database and
which UCAS data the system
will suspend or ignore.

Import Applicant Data SAD_UC_RUN_CNTL Student Admissions >
UCAS Processing > Import
Applicants > Import
Applicant Data

Import the UCAS, UTT, and
Apply applicant data into your
system. Before you import the
data, set up the search/match
parameters on the Search/
Match Processing pages.

Transaction Data SCC_TRANSAC_DATA Student Admissions >
UCAS Processing > Import
Applicants > Transaction
Data

After you run the Import
Applicant Data process,
 use this page to review the
status of a UCAS record
with regard to loading,
 searching/matching, and
posting processing. For
example, determine if a record
is waiting to be processed or if
a record caused a new person
to be added to your database.

UCAS Contextual Staging
Data

SAD_UC_I_IVCONTXT Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivContextual
Staging Data

View, update, or delete the
suspended ivContextual data
stored in the staging tables.

UCAS Education Staging
Data

SAD_UC_I_EDUCAT Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivEducation Staging
Data

View, update, or delete the
suspended ivEducation data
stored in the staging tables.

UCAS Employment Staging
Data

SAD_UC_I_IVEMPL Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivEmployment
Staging Data

View, update, or delete the
suspended ivEmployment data
stored in the staging tables.

UCAS Form Quals Staging
Data

SAD_UC_I_IVFMQ Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivFormQuals
Staging Data

View, update, or delete the
suspended ivFormQuals data
stored in the staging tables.
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UCAS Offer Staging Data SAD_UC_I_OFFER Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivOffer Staging
Data

View, update, or delete the
suspended ivOffer data stored
in the staging tables.

UCAS Prep Activities Staging
Data

SAD_UC_I_IVPREP Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivPrepActivities
Staging Data

View, update, or delete the
suspended ivPrepActivities
data stored in the staging
tables.

UCAS Qualification Staging
Data

SAD_UC_I_IVQUAL Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivQualification
Staging Data

View, update, or delete the
suspended ivQualification
data stored in the staging
tables.

UCAS Reference Staging
Data

SAD_UC_I_IVREF Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivReference Staging
Data

View, update, or delete the
suspended ivReference data
stored in the staging tables.

UCAS StarA Staging Data SAD_UC_I_STARA Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarA Staging
Data

View, update, or delete the
suspended ivStarA data stored
in the staging tables.

UCAS StarC Staging Data SAD_UC_I_IVSTRC Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarC Staging
Data

View, update, or delete the
suspended ivStarC data stored
in the staging tables.

UCAS StarH Staging Data SAD_UC_I_IVSTH Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarH Staging
Data

View, update, or delete the
suspended ivStarH data stored
in the staging tables.

UCAS StarJ Staging Data SAD_UC_I_IVSTJ Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarJ Staging
Data

View, update, or delete the
suspended ivStarJ data stored
in the staging tables.
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Page Name Definition Name Navigation Usage

UCAS StarK Staging Data SAD_UC_I_IVSTK Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarK Staging
Data

View, update, or delete the
suspended ivStarK data stored
in the staging tables.

UCAS StarN Staging Data SAD_UC_I_STARN Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarN Staging
Data

View, update, or delete the
suspended ivStarN data stored
in the staging tables.

UCAS StarPQR Staging Data SAD_UC_I_IVPQR Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarPQR Staging
Data

View, update, or delete the
suspended ivStarPQR data
stored in the staging tables.

UCAS StarW Staging Data SAD_UC_I_STARW Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarW Staging
Data

View, update, or delete the
suspended ivStarW data
stored in the staging tables.

UCAS StarX Staging Data SAD_UC_I_IVSTX Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarX Staging
Data

View, update, or delete the
suspended ivStarX data stored
in the staging tables.

UCAS StarZ1 Staging Data SAD_UC_I_STARZ1 Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStarZ1 Staging
Data

View, update, or delete the
suspended ivStarZ1 data
stored in the staging tables.

UCAS Statement Staging
Data

SAD_UC_I_IVSTAT Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivStatement Staging
Data

View, update, or delete the
suspended ivStatement data
stored in the staging tables.

UCAS Unit Results Staging
Data

SAD_UC_I_IVUNRS Student Admissions >
UCAS Processing > Import
Applicants > UCAS Staging
Data > ivUnitResults
Staging Data

View, update, or delete the
suspended ivUnitResults data
stored in the staging tables.
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UTT Degree Contents Staging
Data

SAD_UC_I_IVGDGC Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgDegreeContents
Staging Data

View, update, or delete the
suspended ivgDegreeContents
data stored in the staging
tables.

UTT Education Staging Data SAD_UC_I_GEDUCAT Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgEducation
Staging Data

View, update, or delete the
suspended ivgEducation data
stored in the staging tables.

UTT First Degree Staging
Data

SAD_UC_I_IVGFDG Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgFirstDegree
Staging Data

View, update, or delete the
suspended ivgFirstDegree
data stored in the staging
tables.

UTT Form Quals Staging
Data

SAD_UC_I_IVGFMQ Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgFormQuals
Staging Data

View, update, or delete the
suspended ivGFormQuals
data stored in the staging
tables.

UTT Offer Staging Data SAD_UC_I_GOFFER Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgOffer Staging
Data

View, update, or delete the
suspended ivgOffer data
stored in the staging tables.

UTT Other Languages
Staging Data

SAD_UC_I_IVGOLN Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgOtherLanguages
Staging Data

View, update, or
delete the suspended
ivgOtherLanguages data
stored in the staging tables.

UTT Reference Staging Data SAD_UC_I_IVGREF Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgReference
Staging Data

View, update, or delete the
suspended ivgReference or
Apply reference data stored in
the staging tables.

UTT StarA Staging Data SAD_UC_I_GSTARA Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarA Staging
Data

View, update, or delete the
suspended ivGStarA or Apply
contact details data stored in
the staging tables.
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UTT StarG Staging Data SAD_UC_I_IVSTRG Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarG Staging
Data

View, update, or delete the
suspended ivgStarG or Apply
application data stored in the
staging tables.

UTT StarH Staging Data SAD_UC_I_IVGSTH Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarH Staging
Data

View, update, or delete the
suspended ivgStarH data
stored in the staging tables.

UTT StarJ Staging Data SAD_UC_I_IVGSTJ Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarJ Staging
Data

View, update, or delete the
suspended ivGStarJ data
stored in the staging tables.

UTT StarK Staging Data SAD_UC_I_IVGSTK Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarK Staging
Data

View, update, or delete the
suspended ivgStarK or Apply
application data stored in the
staging tables.

UTT StarN Staging Data SAD_UC_I_GSTARN Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarN Staging
Data

View, update, or delete the
suspended ivgStarN or Apply
candidate data stored in the
staging tables.

UTT StarW Staging Data SAD_UC_I_GSTARW Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarW Staging
Data

View, update, or delete the
suspended ivgStarW data
stored in the staging tables.

UTT StarX Staging Data SAD_UC_I_GSTARX Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgStarX Staging
Data

View, update, or delete the
suspended ivgStarX data
stored in the staging tables.

UTT Statement Staging Data SAD_UC_I_IVGSTA Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgstatement
Staging Data

View, update, or delete the
suspended ivgStatement or
Apply personal statement data
stored in the staging tables.
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UTT Experience Staging Data SAD_UC_I_IVGEXP Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > ivgExperience
Staging Data

View, update, or delete the
suspended ivgExperience or
Apply work experience data
stored in the staging tables.

Qualifications Staging Data SAD_UC_I_AQUAL_PG Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > Qualifications
Staging Data

View, create, or update Apply
qualifications data stored in
the staging tables.

Offering Conditions Staging
Data

SAD_UC_I_ACOND_PG Student Admissions >
UCAS Processing > Import
Applicants > UTT Staging
Data > Offer Conditions
Staging Data

View, create, update, or delete
data stored in the staging
tables for any conditions
associated with an Apply
offer.

This record allows multiple
conditions per choice.

Internal Timestamps SAD_UC_TIMESTMP Set Up SACR > Product
Related > Recruiting and
Admissions > UCAS >
Timestamps

For an institution, reset a
timestamp to a previous date
if you want to re-import
records. See the highest
timestamp when the view was
last imported. Additionally,
 see the number of records
that were added, deleted, or
amended when the view was
last imported.

Viewing the Transaction Setup
Access the Transaction Setup page (Student Admissions > UCAS Processing > Import Applicants >
Transaction Setup).
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This example illustrates the fields and controls on the Transaction Setup page (1 of 2).

This example illustrates the fields and controls on the Transaction Setup page (2 of 2).
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The system uses the delivered UCAS and Apply transactions to process the incoming UCAS, UTT, and
Apply data. Do not change any values for this transaction.

Defining the Search/Match Criteria
Access the Search/Match Setup page (Student Admissions > UCAS Processing > Import
Applicants > Transaction Setup > Search/Match Setup).

This example illustrates the fields and controls on the Search/Match Setup page. You can find definitions
for the fields and controls later on this page.

The system uses this delivered UCAS  transaction to process the incoming UCAS, UTT, and Apply data.
Therefore, you will need to define search match parameters for the UCAS transaction.

Use the Search Parameter field to select the group of predefined search parameters that you want to use
for the Import Applicant Data process.

Use the Search Result Field field to select a search result value that you defined in the Search Result
page.

It is recommended that you change the Number of Characters of FirstNameSrchRule and
LastNameSrchRule to 7 for PSCS_10, PSCS_30, PSCS_40 and PSCS_50 in the Search/Match Rules
page. Select Set Up SACR > System Administration > Utilities > Search/Match > Search/Match
Rules to navigate to the Search/Match Rules page.
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For information about setting up search/match rules, search parameters and results, see "Understanding
Search/Match" (Campus Community Fundamentals) and "Setting Up Search/Match" (Campus
Community Fundamentals)

Note: You must define at least one Suffix value in the Name Suffix table (Set Up Common
Objects >Foundation Tables >Personal >Name Suffix).

Match(es) Found

This group box contains one row for each search/match criteria order defined by your institution. Define
search/match orders on the Search/Match Criteria page.

Field or Control Description

Search Order Nbr  (search order number) For each order number, select what you want to do with the
record if the search/match/post process discovers one or more
matching records.

One Match and Multiple Matches Select whether you want to add, update, suspend, or ignore
matching records:

Add: Add a new record to your database using the staging
table record.

Update: Update the existing record with the data in the staging
table record.

Suspend: Keep the suspense record back in the staging table.
 Determine manually whether or not this record matches a
record in your database.

Ignore: Ignore the staging table record that matched a record
in your database.

The process marks the record to be purged.

No Match Found

Select one of the following options to specify what the search/match/post process should do when it does
not find a matching record in your database:

Add: Add the unmatched record, including personal data, to your database.

Suspend: Keep the unmatched record in the staging tables to be looked at manually.

Ignore: Ignore the unmatched record completely. The process marks the record to be purged.

Entering the Applicant Import Parameters
Access the Import Applicant Data page (Student Admissions > UCAS Processing > Import
Applicants > Import Applicant Data).
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This example illustrates the fields and controls on the Import Applicant Data page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Academic Institution Enter the academic institution for which you want to import
data.

Import Live Select if you want the import process to load the data into the
staging tables and then into the Campus Solutions tables. If
you do not select this check box, the import process loads the
data from the staging tables into the Campus Solutions tables.

By default, the system selects this check box if the Import
Live check box on the UCAS Configuration page is selected.
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Field or Control Description

Import Applicants Indicates whether the process imports applicant data from
UCAS, UTT, or Apply API.

Either one of these options can be selected, but not both. Or
none needs to be selected.

• The system selects the UCAS or UTT check boxes if
you selected UCAS or UTT on the UCAS Configuration
page.

If the system selects the UTT check box, the process
imports applicant data from UTT ivgStarN, ivgStarA,
 and ivgStarK views. If the system selects the UCAS
check box, the process imports applicant data from UCAS
ivStarN, ivStarA, and ivStarK views.

Note: When importing applications using the odbc-
link, either UCAS or the UTT check box for Import
Applicants must appear selected for the Import Applicant
Data process to run successfully.

• When you’re importing applicant data using the Apply
API, select the Apply check box for Import Applicants.
 When you select this, the UTT Import Applicants check
box is automatically deselected. This prevents the UTT
and Apply processing from running at the same time.

Note: The Apply check box is enabled only when you
select Use Apply on the UCAS Configuration page.

See Preparing for UCAS and UTT Data Processing.
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Field or Control Description

Import Biographical Data Select the UCAS check box if you want to import application
biographical data from the following UCAS views:

• ivStarX

• ivStarH

• ivFormQuals

• ivQualification

• ivEducation

• ivEmployment

• ivPrepActivities

• ivContextual

Select the UTT check box if you want to import application
biographical data from the following UTT views:

• ivgStarX

• ivgStarH

• ivgFormQuals

• ivgEducation

• ivgExperience

• ivgOtherLanguages

• ivgFirstDegree

• ivgDegreeContents

Select both check boxes if you want to import application
biographical data from the UTT and UCAS views.

Import Examination Results Select the UCAS check box if you want to import data from
ivStarPQR and ivUnitResults views.
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Field or Control Description

Import Application Choices Select the UCAS check box if you want to import application
choices from these UCAS views:

• ivStarC

• ivStarW

• ivReference

• ivStatement

• ivOffer

• ivStarZ1

Select the UTT check box if you want to import application
choices from the following UTT views:

• ivgStarG

• ivgStarW

• ivgReference

• ivgStatement

• ivgOffer

Select both check boxes if you want to import application
choices from UTT and UCAS.

Import HESA Data Select the UCAS check box if you want to import ivStarj data.

Select the UTT check box if you want to import ivgStarj data.
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Field or Control Description

Personal ID and Application Code Specify the UCAS or UTT personal ID and application code,
 or the Apply candidate ID and application ID if you want
to re-import all the records of a particular applicant (that has
previously been incorrectly matched and then deleted). If
you specify the personal ID and application code here, then
during the selection from applicant views, the import process
will select only records for that applicant, irrespective of the
Earliest Application Year that you configured and timestamp
values. If you leave these two fields blank, the process selects
records for all applicants based on the timestamp in the
views and updates the internal timestamp with the highest
imported timestamp value. For more information on the
internal timestamp settings:

Defining a Timestamp for Re-importing Data

The Personal ID and Application Code fields are available
only when you select the Import Live check box on this page.

Note: By using the Personal ID and Application Code fields,
 you can specify only one applicant for a single run of the
Import Applicant Data process and you need to ensure that the
correct UCAS, UTT, or Apply import check boxes are selected
on this page.
Also, note that if you specify a personal ID, then the
application code is required. Application code is expanded to a
10–digit value to allow a 10–digit Apply application ID.

If you have installed CRM for Higher Education, you can run an EIP batch replay process following the
main Import Applicant Data process. The following example shows the options available on the Process
Scheduler Request page when CRM for HE is installed.

This example illustrates the fields and controls on the Process Scheduler Request page for the Import
Applicant Data process. You can find definitions for the fields and controls later on this page.

If you select the Batch Replay UCAS option, the Import Applicant Data process (SAD_UC_IMPAP) runs
first and then the EIP Batch Replay (SCC_BAT_RPLY) runs. If you select the SAD_UC_IMPAP option,
only the Import Applicant Data process runs.
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For more information about the EIP Batch Replay process see CRM for Higher Education Developer's
Guide.

Importing New Applicants
To process the ivStarN and ivgStarN staging records, the Import Applicant Data process performs the
following initial processing steps to determine if the applicant already exists in the system. The steps are
followed until an EMPLID is found. If an EMPLID is not found, then the Import Applicant Data process
invokes the search/match processing.

1. Check if there is a matching applicant record for the local institution in SAD_UC_APPLREC. This
check is made by matching the applicant's Institution, Personal ID and App Code.

For Apply, Personal ID is populated with candidate ID and App Code with application ID.

2. Check if there is a matching applicant record for another institution in SAD_UC_APPLREC. This
check is made by matching the applicant's Personal ID and App Code.

3. Check if there is a matching applicant record from previous cycle or other system (UCAS or UTT) in
SAD_UC_APPLREC. This check is made by matching only the Personal ID of either:

a. Applicant record for the same system (that is, UCAS for UCAS applicants, GTTR for UTT
applicants) for a previous cycle with a different App Code.

b. Applicant record for the other system (that is, UTT for UCAS applicants and UCAS for UTT
applicants).

4. Check the External System ID of the same system. This check is made by matching Personal ID to
External System ID of the same system, that is, UC for UCAS applicants, GT for UTT applicants.

5. Check the External System ID of other system. This check is made by matching Personal ID to
External System ID of the other system, that is, GT for UCAS applicants and UC for UTT applicants.

6. Check the Legacy External System ID. This check is made by matching Personal ID to the UP
External System ID. This check is for legacy records that your institution may have imported using a
localisation provided by a vendor.

For Apply applications, the matching is restricted to only existing Apply applications. Matching
on external system ID isn’t relevant to Apply applications. Before records are added to
SAD_UC_APPLREC, the values in the new row are compared to the previous row (if they exist) to
determine whether updates are required. For new applicants that aren’t matched to an existing applicant or
person, constituent staging names, address, phone, email, NID, and citizenship records are created and the
core records are created or updated via CTM.

Mapping Applicant Data

The following tables show the mappings between the UCAS applicant views and the various staging and
base records in Campus Solutions.

• Import Applicants
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odbc-link View Staging Record Record

ivStarN SAD_UC_I_STARN SAD_UC_APPLREC

ivStarA SAD_UC_I_STARA SAD_UC_APPLREC

ivStarK SAD_UC_I_IVSTK SAD_UC_IVSTK

• Import Biographic Data

odbc-link View Staging Record Record

ivContextual SAD_UC_I_IVCNTX SAD_UC_IVCONTXT

ivEducation SAD_UC_I_EDUCAT SAD_UC_EDUCAT

ivEmployment SAD_UC_I_IVEMPL SAD_UC_IVEMPL

ivFormQuals SAD_UC_I_IVFMQ SAD_UC_FRMQUAL

ivQualification SAD_UC_I_IVQUAL SAD_UC_IVQUAL

ivPrepActivities SAD_UC_I_IVPREP SAD_UC_IVPREP

ivStarH SAD_UC_I_IVSTH SAD_UC_IVSTH

ivStarX SAD_UC_I_IVSTX SAD_UC_IVSTX

• Import Choices

odbc-link View Staging Record Record

ivStarZ1 SAD_UC_I_STARZ1 SAD_UC_IVSTARC

ivStarC SAD_UC_I_IVSTRC SAD_UC_IVSTARC

SAD_UC_OTH_CH
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odbc-link View Staging Record Record

ivOffer SAD_UC_I_OFFER SAD_UC_OFFER

SAD_UC_OTH_OFF

ivReference SAD_UC_I_IVREF SAD_UC_REFERENC

ivStatement SAD_UC_I_IVSTAT SAD_UC_STATEMNT

ivStarW SAD_UC_I_STARW SAD_UC_STARW

• Import Exam Results

odbc-link View Staging Record Record

ivStarPQR SAD_UC_I_IVPQR SAD_UC_FRMQUAL

ivUnitResults SAD_UC_I_IVUNRS SAD_UC_IVUNRS

• Import HESA Data

odbc-link View Staging Record Record

ivStarJ SAD_UC_I_IVSTJ SCC_HE_PERSON

SCC_HE_QUAL_ENT

SCC_HE_INST_FLD

SAD_UC_POCC2010

ivStarJ SAD_UC_I_IVSTJQ SCC_HE_QUAL_ENT

Mapping Apply Applicant Data

The following tables show the mappings between the Apply applicant views and the various staging and
base records in Campus Solutions.

The records marked with a single asterisk are shared with UCAS and UTT. The ones marked with two
asterisks are only for Apply. The rest are shared only with UTT.
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Data Staging Record Record

Candidate *SAD_UC_I_STARN *SAD_UC_APPLREC

Contact Details *SAD_UC_I_STARA *SAD_UC_APPLREC

Application SAD_UC_I_IVGSTK SAD_UC_IVGSTK

Course/Offer SAD_UC_I_IVSTRG SAD_UC_IVSTARG

Offer/Conditions **SAD_UC_I_ACOND **SAD_UC_ACOND

Personal Statement SAD_UC_I_IVGSTA SAD_UC_STATEMNT

Qualification **SAD_UC_I_AQUAL **SAD_UC_AQUAL

Jobs, Volunteering SAD_UC_I_IVGEXP SAD_UC_IVGEXP

References SAD_UC_I_IVGREF SAD_UC_REFERENC

Mapping UTT Applicant Data

The following tables show the mappings between the UTT applicant views and the various staging and
base records in Campus Solutions.

• Import Applicants

odbc-link View Staging Record Record

ivgStarN SAD_UC_I_STARN SAD_UC_APPLREC

ivgStarA SAD_UC_I_STARA SAD_UC_APPLREC

ivgStarK SAD_UC_I_IVSTK SAD_UC_IVSTK

• Import Biographic Data

odbc-link View Staging Record Record

ivgDegreeContents SAD_UC_I_IVGDGC SAD_UC_IVGDGC
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odbc-link View Staging Record Record

ivgEducation SAD_UC_I_EDUCAT SAD_UC_EDUCAT

ivgExperience SAD_UC_I_IVGEXP SAD_UC_IVGEXP

ivgFirstDegree SAD_UC_I_IVGFDG SAD_UC_IVGFDG

ivgFormQuals SAD_UC_I_IVGFMQ SAD_UC_FRMQUAL

ivgOtherLanguages SAD_UC_I_IVGOLN SAD_UC_IVGOLN

ivgStarH SAD_UC_I_IVGSTH SAD_UC_IVGSTH

ivgStarX SAD_UC_I_IVGSTX SAD_UC_IVGSTX

• Import Choices

odbc-link View Staging Record Record

ivgStarG SAD_UC_I_IVSTRG SAD_UC_IVSTARG

SAD_UC_OT_CH_GT

ivgOffer SAD_UC_I_GOFFER SAD_UC_OFFER

SAD_UC_OTH_OFF

ivgReference SAD_UC_I_IVGREF SAD_UC_REFERENC

ivgStatement SAD_UC_I_IVGSTA SAD_UC_STATEMNT

ivgStarW SAD_UC_I_STARW SAD_UC_STARW

• Import HESA Data

odbc-link View Staging Record Record

ivgStarJ SAD_UC_I_IVGSTJ SCC_HE_PERSON

SCC_HE_INST_FLD
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Importing HESA Data
A subprocess is called by the Import Applicant Data process that imports StarJ (HESA) data from
UCAS and UTT when the UCAS and UTT check boxes for Import HESA Data is selected on the Import
Applicant Data page.

For more information about the Import Applicant Data page, see Entering the Applicant Import
Parameters.

Business Rules

If you select the UCAS check box for the Import HESA Data sub-process, the UCAS view ivStarJ is
imported to the staging table then processed.

The following tables are loaded if this subprocess is selected for the UCAS view:

UCAS View Staging Table Base Table

IVSTARJ PS_SAD_UC_I_IVSTJ • Person HESA Data (PS_SCC_HE_
PERSON, PS_SCC_HE_PER_FLD)

• HESA Instance Data (PS_SSR_HE
_INSTANCE, PS_SSR_HE_INST_
FLD, PS_SSR_HE_QUAL_ENT)

• External System ID

If you select the UTT check box for the Import HESA Data sub-process, the UTT view ivgStarJ is
imported to the staging table and then processed.

The following tables are loaded if this subprocess is selected for the UTT view:

UCAS View Staging Table Base Table

IVGSTARJ PS_SAD_UC_I_IVGSTJ • Person HESA Data (PS_SCC_HE_
PERSON, PS_SCC_HE_PER_FLD)

• HESA Instance Data (PS_SSR_HE
_INSTANCE, PS_SSR_HE_INST_
FLD, PS_SSR_HE_QUAL_ENT)

• External System ID

General Process Logic

The following is the logic for the Import HESA Data subprocess:

• The subprocess considers the Update Matriculated Students check box setting on the UCAS
Configuration page for processing External System ID records.
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• The subprocess updates HESA-specific records regardless of the Update Matriculated Students check
box setting to ensure that the records are synchronized with the corresponding UCAS view. Updates
to HESA records are controlled by the HESA Data Import field on the UCAS Configuration page.
If the Add HESA Person fields check box is selected on the UCAS Configuration page, then the
subprocess creates new Disability, Nation, Ethnicity and Domicile fields. If the Add HESA Person
fields check box is not selected, then the subprocess updates the existing fields but does not add new
fields.

• The subprocess considers the Process Mismatched Applicants check box setting on the UCAS
Configuration page.

For more information about the UCAS Configuration page, see Setting Up UCAS and Teacher Training
Options

Prerequisites

The following are the prerequisites for a successful run of Import HESA Data sub-process:

• The Person HESA Data and HESA Instance Data records must have been created for each applicant
whose details you want to import.

See "Creating HESA Instance and Person HESA Data Records for Students" (Student Records)

• A UCAS configuration record must be defined on the UCAS Configuration page. Refer to the above
topic General Process Logic

Import Records to Staging Table

If you have selected the Import Live Data from UCAS check box on the UCAS configuration page, then
records are imported from the StarJ views into the relevant staging table based on the timestamp value
of each record. If the timestamp is greater than the internal timestamp for the view, then the record is
imported. At the end of the Import Applicant Data process, the internal timestamp is updated with the
highest timestamp of the records that have been imported.

Processing of Staging Table Records

For each staging table record with status of New, Pending or Error:

1. The record is matched to an existing UCAS applicant record in PS_SAD_UC_APPLREC using
UCAS Personal ID and Application Code to find the EMPLID, or if applicant record is not found,
then the EMPLID is selected from matching External System ID records with ID type UC or GT
(depending on whether UTT or UCAS is selected on the UCAS Configuration page).

2. The imported Surname, Fnames, Birthdate and Gender values are compared with the values in the
Campus Solutions primary person record. If the values are different then a message is logged. If a
Surname, Fnames, Birthdate or Gender value is different and the Process Mismatched Applicants
check box is selected, then the system adds a warning message to the log file (for example, “Warning:
Personal ID: 0035697369, AppCode:UC01, ID:0278 - SURNAME value does not match person
record”) and the subprocess continues to process the staging record. If a Surname, Fnames, Birthdate
or Gender value is different and the Process Mismatched Applicants check box is not selected, the
system sets the staging record status to Error. does not process the record and adds a message to the
log file (for example, “Processing skipped for Personal ID: 0035697369, AppCode:UC01, ID:0278 -
SURNAME value does not match person record”).
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3. Person HESA Data Update: If a Person HESA Data record exists, then fields are added or updated
using the incoming IVSTARJ values (see table below). The inserts/updates are done depending on the
value of the HESA Data Import field on the UCAS configuration page.

4. External System ID (SCN):

• External System ID records are created or updated based on the imported value.

• Default values of 999999999 are skipped

• For matriculated students, updates/inserts are done only if the Update Matriculated Students check
box is selected.

5. HESA Instance – Entry Profile Data Update:

• HESA Instance records are selected by matching from existing UCAS application choice records
via the related Student Program records

• Fields are added/updated using the incoming StarJ values (see table below) and inserts/updates are
done depending on the value of the HESA Data Import field.

• Imported entry qualifications are matched to existing records (in PS_SSR_HE_QUAL_ENR)
based on TYPE, SUBJECT, YEAR and SITTING and if a record already exists, then the GRADE
value is updated, otherwise a new record is created

6. Records with errors (E) and pending records (P) are retained in the staging table and can be
reprocessed once errors are corrected.

Data Mapping for ivStarJ / ivgStarJ

Note that ULN, SBJQA1, SBJPCT1, SBJQA2, SBJPCT2, SBJQA3 and SBJPCT3 are not imported.

The following table shows the Person Data mapping:

StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:

PS_SAD_UC_I_IVSTJ

PS_SAD_UC_I_IVGSTJ

Compared with (Page
name - Field name)

Surname Surname SAD_UC_SURNAME Names - Last Name (for
primary name record)

Fnames Forenames SAD_UC_FORNAME Names - First Name, Middle
Name (for primary name
record)

Birthdte Date of Birth SAD_UC_BIRTHDTE Biographical Details - Date of
Birth
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StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:

PS_SAD_UC_I_IVSTJ

PS_SAD_UC_I_IVGSTJ

Compared with (Page
name - Field name)

Gender Gender (1 = Male or 2 =
Female)

SAD_UC_GENDER Biographical Details – Gender

The following table shows the HESA Person Data mapping:

StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:

PS_SAD_UC_I_IVSTJ

PS_SAD_UC_I_IVGSTJ

PS_SCC_HE_PER_FLD

Disable HESA Disability code 
(cvRefDis). Validated against
imported HESA codes for
DISABLE (To view the codes
that you have imported, select
Records and Enrollment,
 HESA Reporting, Codes and
Mappings, Codes).

Your institution may have
already imported Disability
values from StarK which
the system will have used
to create person Disability/
Impairment records.

SAD_UC_DISABLE DISABLE

Ethnic HESA Ethnicity code 
(cvRefEthnic). Validated
against imported HESA codes
for ETHNIC.

Your institution may have
already imported Ethnic
values from StarH which
the system will have used
to create person Ethnicity
records.

SAD_UC_ETHNIC ETHNIC
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StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:

PS_SAD_UC_I_IVSTJ

PS_SAD_UC_I_IVGSTJ

PS_SCC_HE_PER_FLD

Nation HESA country code 
(cvRefNationality). Validated
against imported HESA codes
for NATION.

Your institution may have
already imported Nationality
values from StarK which
the system will have used
to create person Citizenship
records.

SAD_UC_NATIONALITY NATION

NationD 2-digit code.

Validated against imported
HESA codes for NATIOND.

SAD_UC_NATIONALD NATIOND

The following table shows the External System ID mapping:

StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:

PS_SAD_UC_I_IVSTJ

PS_SAD_UC_I_IVGSTJ

Base Table — Column

SCN Scottish Candidate Number 
(default is 999999999).

Your institution may have
already imported SCN values
from StarK which the system
will have used to create SCN
external system ID records.
 The system does not use the
default value 999999999 for
processing StarK records.

SAD_UC_ SCN External System ID – SCN

ULN Not currently processed – The
system creates ULN external
system ID as part of the initial
STARN import.

SAD_UC_ULN External System ID – ULN

The following table shows the data mapping for HESA Entry Profile:
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StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:

PS_SAD_UC_I_IVSTJ

PS_SAD_UC_I_IVGSTJ

HESA Base Table: PS_
SSR_HE_INST_FLD

Domicile HESA country code 
(cvRefAPR)

Validated against imported
HESA codes for DOMICILE.

Your institution may have
already imported APR from
StarK which the system
will have used to create
person Residency Self-Report
records.

SAD_UC_APR DOMICILE

ParEd 1-character code. Validated
against imported HESA codes
for PARED.

SAD_UC_PARENTINHE PARED

PGCEclss (UTT only) 2-digit code. Validated against
imported HESA codes for
PGCECLSS.

SAD_UC_PGCECLSS PGCECLSS

Postcode Text. No validation applied. SAD_UC_POSTCODE POSTCODE

Previnstz Up to 8-digit code, default
is U00000. No validation
applied.

SAD_UC_PRVINST PREVINST

Qualent3 3-character code - default is
X06.

Validated against imported
HESA codes for QUALENT3.

SAD_UC_QUALENT2 QUALENT3

SEC 1-digit code 
(cvRefSocioEconomic).
 Validated against imported
HESA codes for SEC.

SAD_UC_SOCIOECON

Sec2010 1-digit code. Validate against
HESA codes for SEC.

SAD_UC_SEC2010

SEC

If provided, the value for
Sec2010 should populate
SEC. If not, use the SEC
value.
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StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:

PS_SAD_UC_I_IVSTJ

PS_SAD_UC_I_IVGSTJ

HESA Base Table: PS_
SSR_HE_INST_FLD

SOC2000 4-digit code (cvRefPocc).
 Validated against imported
HESA codes for SOC2000.

SAD_UC_POCC SOC2000

SOC2010 4-digt code. Validated against
HESA codes for SOC2010.

SAD_UC_2010 SOC2010

WelBacc 1-digit code (1, 2, or 3).
 Validated against imported
HESA codes for WELBACC.

SAD_UC_WELBACC WELBACC

Yrllinst Year of leaving school in
YYYY format – default is
9999. No validation applied.

SAD_UC_YRLLINST YRLLINST

The following table shows the data mapping for Entry Qualifications:

StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:
PS_SAD_UC_I_IVSTJ PS
_SAD_UC_I_IVGSTJ

HESA Base Table: PS_
SSR_HE_QUAL_ENT

QualType1 – 30 Text (max 6 characters).
 Validated against imported
HESA codes for QUALTYPE.

SAD_UC_QUALTYPE1 to
30

SSR_HE_QUAL_TYPE

QualSbj1 – 30 ABL Subject Code (EBL
_SUBJ in cvRefSubj).
 Validated against imported
HESA codes for QUALSBJ.

SAD_UC_QUALSBJ1 to 30 SSR_HE_QUAL_SUBJ

QualSit1 – 30 S (Summer) or W (Winter).
 Validated against imported
HESA codes for QUALSIT.

SAD_UC_QUALSIT1 to 30 SSR_HE_QUAL_SIT

QualGrade1 – 30 Text (max 6 characters).
 Validated against
imported HESA codes for
QUALGRADE.

SAD_UC_QUALGRADE1 to
30

SSR_HE_QUAL_GRADE

Copyright © 1988, 2021, Oracle and/or its affiliates. 973



(GBR) Managing UCAS and UTT Applications Chapter 27

StarJ Column:

IVSTARJ

IVGSTARJ

Comment/Format Staging Table Column:
PS_SAD_UC_I_IVSTJ PS
_SAD_UC_I_IVGSTJ

HESA Base Table: PS_
SSR_HE_QUAL_ENT

QualYear1 – 30 4-digit Year value. No
validation applied.

SAD_UC_QUALYEAR1 to
30

SSR_HE_QUAL_YEAR

Reviewing and Editing the Suspense Data
Access the Transaction Data page (Student Admissions > UCAS Processing > Import Applicants >
Transaction Data).

Field or Control Description

Personal ID Displays the value imported from the StarN staging record
for suspended records and from PS_SAD_UC_APPLREC for
updated or added records.

Previous Surname Displays the value from the StarN staging record for
suspended records.

This field does not display a Previous Surname value for
updated or added records.

Possible values for the Status field include:

• New ID Created: The import process added a record with a new ID to your database when the post
process was run. Or the system added a record with a new ID to your database when you clicked the
Add button.

• ID Updated: The import process updated an existing ID record with the data from the UCAS record.
Or the system updated an existing ID record with the data from the UCAS record when you selected
the existing ID in the Results region and then clicked the Update button.

• Suspended: The import process has completed running the search/match process and indicated that the
record should be held for later processing.

• Ignore: The import process has completed running the search/match process and indicated that the
record should be ignored for any processing.

• Error: The import process suspends error records. The Error Messages region indicates which value
is invalid. You must correct the invalid data specified by each error message before selecting the Add
button or the Update button to process the record.

Note: To resolve the “First Name is required” error:

1. Enter dummy values in the First Name field for both the primary and preferred Name Types.
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2. Select Save.

3. Select Add to create a new person or Update to match to an existing person.

Other staging statuses that you can see on the Transaction Data search page are not currently used in
UCAS.

You define the logic to determine the status values in the Search/Match Setup page. For example, to
give the ID Updated status to a record, you may have specified that if the import process does not find a
matching record, then add the imported record to the tables.

The Select a Duplicate region displays the single or multiple matching records. The system disables the
Add and Update buttons and hides the Select a Duplicate region if the data has been posted. Also, all the
fields appear as read-only when the status is New ID Created or ID Updated.

Select a duplicate

Displays a single or multiple matching records for the imported UCAS record where the status is
suspended or error.

Click the Detail link to navigate to the Add/Update a Person component.

Field or Control Description

Add Click to ignore any potential duplicates, manually add a new
ID, and post the imported UCAS record to your database.
 When you click this button, the system posts the record and
assigns an ID to the person.

Update Click to match to an existing record and update the person
record selected in the Select a Duplicate region with data
from the UCAS record.

Additional Information Click to access:

• Person Organization Summary. When you click this
link, the Person Organization Summary component opens
in a new window, similar to Integrated Search Results.

• Relations with Institution

National ID

National ID staging records are created for UCAS, UTT, and Apply applicants. You must select one row
as the primary row.

This region becomes read-only once the system processes the constituent record and the status is updated
to either “New ID Created” or “ID Updated.”
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Citizenship

Citizenship staging records are created only for Apply applicants.

This region becomes read-only once the system processes the constituent record and the status is updated
to either “New ID Created” or “ID Updated.”

Residency Official

Residency Official staging records are created only for Apply applicants.

This region becomes read-only once the system processes the constituent record and the status is updated
to either “New ID Created” or “ID Updated.”

Residency Self Report

Residency Self Report staging records are created only for Apply applicants.

This region becomes read-only once the system processes the constituent record and the status is updated
to either “New ID Created” or “ID Updated.”

Viewing, Updating and Deleting Application Staging Data
Use the Staging Data pages to view, update, or delete the suspense data in the staging tables. The
following is an example of a Staging Data page.
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This example illustrates the fields and controls of a Staging Data page.

The Import Status field displays any one of the following values:

• Error: If the Import Applicant Data process cannot load the record into the Campus Solutions tables.

• Imported: If the Import Applicant Data process has loaded the record into the Campus Solutions
tables.

• New: If the Import Applicant Data process has not loaded the record into the Campus Solutions tables.

• Pending: If the Import Applicant Data process load is waiting for the creation of a new person ID for
the applicant.

In the UCAS and UTT StarA Staging Data search pages, the Country Code search field searches both the
Correspondence Country and the Home Country values loaded from the StarA views. The search results
therefore display records that have a matched search value in either the Correspondence Country field or
Home Country field or both fields. For example, if you enter NLD in the Country Code search field, the
system displays records that have NLD as either the Home Country or Correspondence Country or both. It
is recommended that you use the Contains option when searching using this field.

The staging data pages can display data from either the Unicode views or the standard views. For
example, if you have selected the Unicode check box on the UCAS Configuration page, the StarA Staging
Data page displays the ivStarAU data. Conversely, if you have not selected the Unicode check box on the
UCAS Configuration page, the StarA Staging Data page displays the ivStarA data.
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Defining a Timestamp for Re-importing Data
Access the Internal Timestamp page (Set Up SACR > Product Related > Recruiting and
Admissions > UCAS > Timestamps).

This example illustrates the fields and controls on the Internal Timestamp page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Timestamp Displays the highest UCAS timestamp for the view when it
was last imported.

Override Specify an override date if you want to reload a particular
view. After specifying the override date, run the import
process. The import process then imports the UCAS view
records that have a timestamp of on and after the specified
override date. The default system time for the specified
override date is 00:00:00.

After the import process finishes, the system sets the Override
field value to blank.

Last Run Timestamp Displays the latest timestamp used by the import process when
it was last run.

Records Added Displays the number of records that the import process added
when the process last ran.

Records Amended Displays the number of records that the import process
modified when the process last ran.
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Field or Control Description

Records Deleted Displays the number of records that the import process deleted
when the process last ran.

The following scenario describes how the Internal Timestamp page displays its field values:

1. You have already imported records for a view that has UCAS timestamps up to and including July
31, 2008. Therefore, the Timestamp field on the Internal Timestamp page displays the date July 31,
2008.

2. You now want to re-import data for the view that UCAS has modified and added on or after May 31,
2008, 12 AM.

3. On August 4, 2008 enter an override date of May 31, 2008 in the Internal Timestamp page and run the
Import Applicant Data process.

4. After the Import Applicant Data process completes importing the data, the system sets the Override
date field as blank and sets the Last Run Timestamp field as May 31, 2008 because May 31,2008
was the override timestamp date that the system used when the process was run.

5. The Internal Timestamp page displays the number of records that the import process added, amended,
and deleted on August 4, 2008.

6. The Timestamp field on the Internal Timestamp page still displays the date July 31, 2008 if no
records were found in the UCAS view with timestamps greater than July 31. If the import process
imported records in the UCAS view that had a timestamp of August 1, 2008, then the Timestamp
field displays the date August 1, 2008.

Reviewing Imported UCAS and UTT Applications and Applicant
Data

This section provides an overview of reviewing the imported admissions data and discusses how to
review the imported admissions data.

Understanding Reviewing Imported UCAS and UTT Applications and
Applicant Data

After you load the UCAS applicant data into the Campus Solutions tables, use the UCAS Applications,
UTT Applications, and Apply Applications components to review the imported applications and applicant
data. Refer to the ODBC-link Technical Manual for information about the fields displayed on the UCAS
Applications and UTT Applications components.

These components also enable you to view and maintain the Campus Solutions admission application
record for the imported UCAS, UTT, or Apply application. For example, you can click the admission
application number link on the Choices grid of the UCAS Applicant Summary to navigate to the Maintain
Applications component. Use the Maintain Applications component to maintain the Campus Solutions
admission application record for the imported UCAS application.
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For more information about the Maintain Applications component, see Updating Applications

The UCAS Applications, UTT Applications, and Apply Applications components also enable you to
view and maintain the person records that the import process creates for the applicants. For example, you
can click the Personal Information link on any page of the UCAS Applications component to navigate
to Campus Community's Add/Update a Person component. Note that the import process creates various
other personal information records, such as Citizenship and Passport Data records, Impairment records,
and Residency records, that you can review using the Campus Community menus.

See the product documentation for PeopleSoft Campus Community Fundamentals.

The applicant summary pages of the UCAS and UTT components displays a decision entry link that
enables you to navigate to a decision entry/update page where you can enter or update a decision for the
imported application. When you click this link, the system displays the Initial Decision Entry page if a
decision record does not exist for the UCAS or UTT application. If a decision record does exist for the
UCAS or UTT application, the system displays the Decision Processing page.

For more information about the initial decision entry and decision processing pages for UCAS and UTT,
see Processing Imported UCAS and UTT Applications and Applicant Data

When a service indicator is assigned to a person ID, the corresponding negative or positive service
indicator button appears on all the pages of the UCAS Applications component or UTT Applications
component for that person ID.

See "Understanding Service Indicators" (Campus Community Fundamentals)

Note that UCAS and UTT application search pages enforce application center security. The system
restricts the search results on the UCAS and UTT decision pages based on the application centers defined
for the user (Set Up SACR, Security, Secure Student Administration, User ID, Application Center
Security). You can view the UCAS or UTT application only if your User ID has access to the application
center of the related Campus Solutions application. For example, suppose that user ID SATRN11 does not
have access to the UGRD application center. In such a case, the UCAS Applications page does not allow
SATRN11 to access an application associated with the UGRD application center.

See "Setting Security for Application Centers" (Campus Solutions Application Fundamentals)

The system applies the same application center security to UCAS and UTT application pages and the
Maintain Applications component.

Pages Used to Review Imported UCAS and UTT Applications and Applicant
Data

Page Name Definition Name Navigation Usage

UCAS Applicant Summary SAD_UC_APPL Student Admissions >
UCAS Processing > UCAS
Applications > UCAS
Applicant Summary

View the imported UCAS
applicant record and data
from ivStarC and ivStarK
application and applicant
data. View a summary of the
application choices for your
institution, application status,
 and applicant biographical
details.
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Page Name Definition Name Navigation Usage

Choices SAD_UC_CHOICE_DTL Student Admissions >
UCAS Processing > UCAS
Applications > Choices

View the applicant's imported
application choices (ivStarC
data) and the related Campus
Solutions application records.

Statements SAD_UC_STATEMENTS Student Admissions >
UCAS Processing > UCAS
Applications > Statements

View the applicant's imported
ivStatement data.

References SAD_UC_REFERENCES Student
Admissions >UCAS
Processing >UCAS
Applications >References

View the applicant's imported
ivReference data.

Qualifications SAD_UC_FRMQUAL Student Admissions >
UCAS Processing >
UCAS Applications >
Qualifications

View the applicant's imported
ivFormQuals and ivStarPQR
data.

Unit Results SAD_UC_IVUNRS_SP Student Admissions >
UCAS Processing >
UCAS Applications >
Qualifications > Subject
Detail > Unit Results

View the applicant's imported
ivUnitResults data.

Qualification Summary SAD_UC_QUAL_SUMM Student Admissions >
UCAS Processing >
UCAS Applications >
Qualification Summary

View the applicant's imported
ivQualification and ivStarK
data.

Education SAD_UC_EDUCAT Student Admissions >
UCAS Processing > UCAS
Applications > Education

View the applicant's imported
ivEducation data.

Employment SAD_UC_IVEMPL Student Admissions >
UCAS Processing > UCAS
Applications > Employment

View the applicant's imported
ivEmployment data.

Preparatory Activities SAD_UC_IVPREP Student Admissions >
UCAS Processing > UCAS
Applications > Preparatory
Activities

View the applicant's imported
ivPrepActivities data .

HESA Data SAD_UC_HESA_DTL Student Admissions >
UCAS Processing > UCAS
Applications > HESA Data

View the applicant's imported
ivStarH and ivStarK HESA
details.
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Page Name Definition Name Navigation Usage

UTT Applicant Summary SAD_UC_GTAPPL Student Admissions >
UCAS Processing > UTT
Applications > UTT
Applicant Summary

View the imported UTT
applicant record and the
imported ivgStarG and
ivgStarK application and
applicant details. View a
summary of the application
choices, application status,
 and applicant biographical
details.

Choices SAD_UC_CHOICEGT_DT Student Admissions >
UCAS Processing > UTT
Applications > Choices

View the applicant's imported
application choices (ivgStarG
data) and the related Campus
Solutions application records.

Check whether the Import
Applicant Data process
has marked the application
choice as clearing application.
 The process marks the
application choice as
clearing if ClearingStatus
from ivgStarK is 2 (under
consideration by institution)
or 3 (accepted in clearing) and
the ivgStarG Round Number
is equal to or greater than the
ivgStarK Round Number.

Statements SAD_UC_STATEMENTS Student
Admissions >UCAS
Processing >UTT
Applications >Statements

View the applicant's imported
ivgStatement data.

Qualifications SAD_UC_FRMQUAL Student Admissions >
UCAS Processing >
UTT Applications >
Qualifications

View the applicant's imported
ivgFormQuals data.

References SAD_UC_REFERENCES Student
Admissions >UCAS
Processing >UTT
Applications >References

View the applicant's imported
ivgReference data.

Degree Details SAD_UC_DEG_DTLS Student Admissions >
UCAS Processing > UTT
Applications > Degree
Details

View the applicant's
imported ivgFirstDegree and
ivgDegreeContents data.

Experience SAD_UC_IVGEXP Student Admissions >
UCAS Processing > UTT
Applications >Experience

View the applicant's
imported ivgExperience and
ivgExperienceU data.
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Page Name Definition Name Navigation Usage

Other Languages SAD_UC_IVGOLN Student Admissions >
UCAS Processing > UTT
Applications > Other
Languages

View the applicant's imported
ivgOtherLanguages data.

Education SAD_UC_EDUCAT Student Admissions >
UCAS Processing > UTT
Applications > Education

View the applicant's imported
ivgEducation data.

HESA Details SAD_UC_HESA_GT_DTL Student Admissions >
UCAS Processing > UTT
Applications > HESA
Details

View the applicant's imported
ivgStarH and ivgStarK HESA
details.

Biographical Details SCC_BIO_DEMO_PERS Click the Personal
Information link on any page
of the UCAS Applications
component (SAD_UC_APPL)
or the UTT Applications
component (SAD_UC_
GTAPP).

Campus Community >
Personal Information >
Add/Update a Person >
Biographical Details

View or update the
imported ivStarN, ivStarA,
 ivgStarA, and ivgStarN
applicant biographical data.
 Biographical data includes
details such as applicant
name, birth date, marital
status, and address.

Application Program Data ADM_APPL_PROG_ENT Click the Maintain
Applications link on the
UCAS Applicant Summary
page or the UTT Applicant
Summary page.

Student Admissions >
Application Maintenance >
Maintain Applications >
Application Program Data

View or edit the Campus
Solutions program and
plan data pertaining to the
imported application.

External Education SAD_EXT_EDUCATION Records and Enrollments >
Transfer Credit
Evaluation > External
Education

View the applicant's school
information imported from
ivStarK. The imported school
record includes the attendance
type (academic load).

Apply Application SAD_UC_APPL_PG Student Admissions >
UCAS Processing > Apply
Applications >

View the imported Apply
applicant and application
records.
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Reviewing the Imported UCAS Applications and Applicant Data
Access the UCAS Applicant Summary page (Student Admissions > UCAS Processing > UCAS
Applications > UCAS Applicant Summary).

This example illustrates the fields and controls on the UCAS Applicant Summary page (1 of 3). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UCAS Applicant Summary page (2 of 3). You can
find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the UCAS Applicant Summary page (3 of 3). You can
find definitions for the fields and controls later on this page.

The values in the Application Status and the Biographical Details group boxes come from ivStarK.

The system selects the Criminal Record Declared check box if any of the choice records associated with
the applicant has a declared criminal record.

Reviewing Imported Apply Applications and Applicant Data
Access the Apply Application page (Student Admissions > UCAS Processing > Apply Applications).
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This example illustrates the fields and controls on the Apply Application page (1 of 5). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Apply Application page (2 of 5). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Apply Application page (3 of 5). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Apply Application page (4 of 5). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Apply Application page (5 of 5). You can find
definitions for the fields and controls later on this page.

Field or Control Description

Personal Information This link appears if the user viewing this has security access to
the component.

Academic Institution This doesn’t appear if there’s only one active academic
institution record (Set Up SACR >Foundation
Tables >Academic Structure >Academic Institution
Table).

Unlike UTT pages, Name and Date of Birth references the values in SAD_UC_APPLREC rather than the
person record. This allows you to review any differences between records.

You may see positive or negative service indicator icons on the page. If you select either icon, the Manage
Service Indicators page appears.

Application

This region is similar to the Choice Details region on the UTT Applications >Choices page and displays
details from the most recent effective-dated row for the choice from SAD_UC_IVSTARG and any
associated offer conditions (SAD_UC_ACOND). If Include History is selected, you can scroll through
previous rows to view changes to the application.

Notes

The fields in this region are similar to those on the UCAS Confirmation Enquiries page.

This region displays the most recent notes record for the choice from SAD_UC_APPNOTES. If there
isn’t any existing notes record, then a new record is displayed with Effective Date and Effective Sequence
populated, and the rest of the fields are blank.
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You can add a new notes record or delete an existing one.

Note: Unlike the UCAS Confirmation Enquiries page, Action Required and Outcome Code are always
optional.

Contact

In this region, you see the most recent applicant record (SAD_UC_APPLREC).

Candidate

In this region, you see the most recent applicant (SAD_UC_APPLREC) and biographical
(SAD_UC_IVGSTK) records.

If English Main Language = Yes, then Other Languages appears. Otherwise, English Language
Qualification appears.

Qualifications

In this region, you see the most recent qualification records (SAD_UC_AQUAL).

Personal Statement

In this region, you see the most recent statement record (SAD_UC_STATEMNT).

Work History

In this region, you see the most recent work experience records (SAD_UC_IVGEXP).

References

In this region, you see the most recent reference records (SAD_UC_REFERENC).

Processing Imported UCAS and UTT Applications and Applicant
Data

This section provides an overview of processing the imported admissions data, and discusses how to:

• Define conditions for an offer.

• Review key UCAS application information.

• Add attachments and review 3C information for UCAS application.

• Delete incorrect UCAS applicant records.

• Enter an initial admission decision for a UCAS application choice.

• Enter or update an admission decision for a UCAS application choice.

• Enter a decision for multiple UCAS application choices.
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• Enter or update a decision for Apply applications.

• Approve or reject a UCAS decision.

• Approve or reject multiple UCAS decisions.

• Determine whether applicants satisfy the offer conditions.

• Enter or update a UCAS Confirmation decision.

• Enter multiple UCAS Confirmation decisions.

• Approve or reject a UCAS Confirmation decision.

• Approve or reject multiple UCAS Confirmation decisions.

• Enter a decision to release an applicant into Clearing.

• Approve or reject the Release into Clearing decision.

• Enter UCAS Clearing and Adjustment details.

• Review and update UCAS qualifications.

• Generate, export, and update UCAS and UTT transactions

• Review UCAS transactions.

• Review UCAS Clearing and Adjustment transactions.

• Handle UCAS applicant enquiries.

• Review key UTT application information.

• Add attachments and review 3C information for UTT application.

• Delete incorrect UTT and Apply applicant records.

• Enter an initial admission decision for a UTT application choice.

• Enter or update an admission decision for a UTT application choice.

• Enter a decision for multiple UTT application choices.

• Enter or update a decision for Apply applications.

• Approve or reject a UTT decision.

• Approve or reject multiple UTT decisions.

• Enter or update a UTT Confirmation decision.

• Enter multiple UTT Confirmation decisions.

• Approve or reject a UTT Confirmation decision.

• Approve or reject multiple UTT Confirmation decisions.
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• Enter UTT Clearing details.

• Review and update UTT qualifications.

• Generate, export, and update UCAS and UTT transactions.

• Post decisions for Apply applications.

• Review UTT transactions.

• Review UTT Clearing transactions.

Understanding Processing Imported UCAS and UTT Applications and
Applicant Data

After you import and review the applicants and their applications, delete any applicant records that
UCAS has sent in error or UCAS has cancelled. The UCAS ivStarW view and the UTT ivgStarW view
contain the data related to applicants and application choices that have been sent to UCAS by mistake
or subsequently cancelled at UCAS. When you use the Import Applicant Data process to import the
applications and applicant data, the import process also imports the data from these two views. Use the
Remove Wrong Applicants components to review the ivStarW and ivgStarW data and delete them from
your database. You can also use the Remove Wrong Applicants components to manually un-match an
applicant record which is incorrectly matched to an existing person record.

After reviewing and removing incorrect applicant records, use the Decision Processing or Initial Decision
Entry pages to enter admission decisions for the remaining applications. The UCAS and UTT Initial
Decision Entry pages require less data entry as compared to the Decision Processing pages for making an
admission decision. You can use the Initial Decision Entry pages for the quick entry of standard decisions.
If decision approval is set up, use the Decision Approval pages to approve the decision.

Next, your institution communicates the admission decisions and approvals to UCAS. The following steps
describe how the Campus Solutions system communicates this data to UCAS:

1. After entering or updating a decision, run the Transaction Processing process to generate a
transaction . If decision approval is set up, use the Decision Approval page to approve the decision
before you generate a transaction.

2. Use the Transaction Processing process to export transactions to the TRANIN view at UCAS and
to import error codes once UCAS has processed the transactions. Transactions that the system loads
into TRANIN include the transaction ID generated by UCAS and an error code of -1 to indicate that
UCAS has not yet processed the transaction. Once UCAS fully processes the transaction, the error
code is either 0 (success) or is a code that UCAS defines in the cvRefError reference data view.

UCAS runs a batch process approximately every five minutes to process incoming transactions. As
a result, the Campus Solutions system may delay in reading the error codes and return1 value from
TRANIN and updating its transaction records.

The following (1 and 2) describes how the system processes standards decisions which are not related to
Confirmation or Clearing:

1.) When you run the Transaction Processing process for UCAS applications, the process selects each
UCAS decision record where the system code equals U, transaction flag equals Y, and the approval status
is either Approved or Not Required. For each decision record:
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• If the latest transaction for an application has a transaction type other than LD, LA, LC, RA, or RD,
the process does not generate a transaction. In these cases, you should use the UCAS Transactions
page to manually create a transaction.

• If there is no previous transaction for an application and you had entered C (Conditional Offer), U
(Unconditional Offer), W (Withdrawal) or R (Rejection), the process generates a LD (initial decision)
transaction.

• If the most recent transaction is LD or LA (amended decision):

• If the application is not UF and either the new decision value is different from the decision value
of the existing transaction or the course details have changed, the process generates a new LA
transaction.

• If the application is UF and the new decision is equal to withdrawal, the process generates a RW
transaction.

• If the application is UF and any of the course details of the decision have changed, the process
generates a RA transaction.

• If the most recent transaction is LC and there is no previous transaction, the process generates an LD
transaction. If there is a previous transaction then the process generates a LA transaction.

• When the process completes processing the decisions, it sets the transaction flag for the decision
record to N  to indicate that transaction processing has completed.

2.) When you run the Transaction Processing process for UTT applications, the process selects each UTT
decision record where the system code equals G, transaction flag equals Y, and the approval status is
either Approved or Not Required. For each decision record:

• If the latest transaction for an application has a transaction type other than LD, LA, LC or RA, the
process does not generate a transaction. In these cases, you should use the UTT Transactions page to
manually create a transaction.

• If there is no transaction for an application and you enter I, C, U, W, R, E, M, S, or G decision, the
system generates a LD (initial decision) transaction.

• If the most recent transaction is LD or LA (amended decision), then processing is same as UCAS
applications and the process generates a LA, RW or RA transaction.

• When the system completes processing the decisions, it sets the transaction flag for the decision
record to N to indicate that transaction processing has completed.

When the Transaction Processing process generates a new transaction record, it automatically updates
the Campus Solutions application (linked to the UCAS application choice) with the program action and
action reason values. For example, if transaction type equals LD and decision is I for a UTT application,
the system looks at the program action reason mapping for the decision Interview you have set up in
the UTT Program Actions page. The system then attaches the program action and action reason to
the application. But in Schools Direct applications, that is, when the local institution is identified as
the Accrediting Provider in ivgStarG, the Import Applicant Data process makes direct updates to the
corresponding Campus Solutions applications based on updated decision values in ivgStarG.

Use the Standard Offers page to define conditions for an offer to send to UCAS. For example, you
can define a condition three A Levels at Grade B that can be used for multiple application decisions.
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Subsequently, you can enter this condition in the Decision Processing pages when making a conditional
offer. When you generate transactions for the conditional offers, the system includes this condition in the
transactions to send to UCAS.

The following example is a scenario for UCAS application processing.

Enter a decision and generate a transaction:

1. Use the Initial Decision Entry pages to enter a decision. For example, enter a decision of
unconditional offer.

2. Run the Transaction Processing process to generate the transaction for the unconditional offer
decision. (Select the Generate Transactions check box on the Transaction Processing page.)

3. Use the UCAS Transactions page to review the transaction. For example, because you entered a
decision of Unconditional Offer, the Transaction Details section of the page displays the Transaction
Type LD and Decision of U.

Now you want to export this decision to UCAS and also want to know that UCAS has received this
transaction.

It is recommended that you first generate transactions, review the sent transactions, and then request
UCAS for acknowledgement. Normally, a time delay occurs between Campus Solutions writing the
transaction to UCAS and UCAS updating the transaction with an error code. Therefore, we recommend
that you do not run the transaction processing process with both the Export Transactions and Update
Transactions from UCAS check boxes selected. Run the transaction processing process with the
Generate Transaction check box selected first and review the sent transactions. Then, run the transaction
processing process with the Update Transactions from UCAS check box selected and review the
transaction for acknowledgement.

1. Run the Transaction Processing process to export the applicant's LD transaction to UCAS (select the
Export Transactions check box on the Transaction Processing page.)

2. In the UCAS Transactions page, review the exported transaction (the Sent check box appears as
selected).

3. Run the Transaction Processing process to receive the acknowledgment from UCAS for the exported
transaction (select the Update Transactions from UCAS check box on the Transaction Processing
page).

4. Use the UCAS Transactions page to review the error code for the applicant's LD transaction sent to
UCAS. The error code is 0 (success) in the UCAS Transactions page, which indicates that UCAS
received the institution's decision.

Finally, to know the UCAS applicant's response, complete these steps:

1. Run the Import Applicant Data process. If the applicant has responded to the offer, the offer response
will be in ivStarC.

2. On import, Campus Solutions sets the Reply as F (for a Firm response) or I (for an Insurance
response) on the UCAS Decision Processing page of the applicant if the applicant has accepted the
offer. If the applicant has declined the offer, Campus Solutions sets the Reply as D.

When exam results are available, your institution will confirm conditional offers for UTT and UCAS
applications:
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1. For UCAS applications, make sure you have imported cvRefTariff data (by running the Import
Reference Data process) if you want to use the Results/Offer Matching process to evaluate tariff
offers. This step is not applicable for UTT applications.

2. Run the Import Applicant Data process to import the exam results.

3. Compare the applicant exam results with the offer conditions. You can do the comparison manually or
run the Results/Offer Matching process. This process is not available for UTT applications.

4. Use the Quick Confirmation page or the Confirmation Entry page to accept or reject the conditional
offer.

5. Run the Transaction Processing process to generate and export the RD transaction.

This diagram illustrates the Confirmation process flow.
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The following is an example of processing the Delayed Conditional decisions:

1. Use the Decision Processing page to enter the Delayed Conditional decision for a CF application.

2. If you have selected the Conditional Offer check box on the UCAS Configuration component, use the
Decision Approval page to approve this decision.

3. Run the Transaction Processing process to generate and export the RD transaction with the decision
code of D.

4. A decision code of D is only valid in an RD transaction during September or October for a CF
applicant. Once the results are known, use the Confirmation Entry page to confirm the DF application.

5. If you have selected the Confirmation Acceptance check box on the UCAS Configuration component,
use the Confirmation Approval page to approve this decision.

6. Run the Transaction Processing process to generate and export another RD transaction for the
application.

An applicant who may not have got admission in any institution is eligible for Clearing. To process
Clearing applications for UCAS applicants:

1. Use the Import Applicant Data to import the Clearing application choices.

2. Use the UCAS Initial Decision Entry or the UCAS Decision Processing page to enter an admission
decision for the Clearing application. To search for the Clearing applications, enter 9 in the UCAS
Choice Number field of the decision search page. Note that the decision search pages do not display
accepted Clearing applications (that is UCAS applications with choice number = 9 and the decision
value = A).

3. Use the UCAS Enquiry Entry page to create enquiry records and record RQ Clearing transactions to
request the details of a Clearing applicant. If your institution wants to offer admission to the Clearing
applicant, use the UCAS Enquiry Entry page to record the RX transaction.

4. Run the Transaction Processing process to generate and export the RQ or RX transaction to UCAS.
The RX transaction must have a decision value.

5. Use the Import Applicant Data process to import the application choices for Clearing if you have sent
a RQ transaction.

To process Clearing applications for UTT applicants:

1. Use the UTT Enquiry Entry page to collect student contact address and exam results while the
institution is negotiating with the student. The personal ID and application code values can be looked
up from the cvgName UCAS view.

2. If the institution decides to accept or make a conditional offer to the student, enter the course, campus,
entry year, entry month, transaction type (RX), decision (U or C) and decision maker.

3. Run the Transaction Processing process to generate and export the RX transaction to UCAS. The RX
transaction must have a decision value.

4. Run the Import Applicant Data process to import the applicant data and application choices for the
students you have sent RX transactions for.
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This diagram illustrates an example of the Clearing process flow.

For processing Adjustment records (not applicable for UTT applications):

1. Use the UCAS Enquiry Entry page to create Adjustment records and record RQ or PE transactions.
Use this page to record the AD transaction.

2. Run the Transaction Processing process to generate and export the RQ, PE, AD, LA or RA transaction
to UCAS.

3. Run the Import Applicant Data process. The process imports the Adjustment application choice if
you have sent an AD transaction. If you have sent a RQ or PE transaction, the process imports only
Adjustment applicant data such as biographical data, and ivStarN, ivStarA and ivStarK data.

Use the UCAS Release to Clearing page to release an applicant into Clearing.

After your institution has accepted an applicant through Adjustment (that is, your institution has sent an
AD transaction), the system updates the application choice to UF. If the applicant subsequently withdraws
the applicant, then the institution may either release the application to clearing (RR transaction) or
withdraw the applicant (RW transaction). Use the UCAS Release to Clearing page to record the RR
transaction or use the UCAS Transactions page to record the RW transaction.
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This diagram illustrates an example of the Adjustment initial decision process flow.

When a service indicator is assigned to a person ID, the corresponding negative or positive service
indicator button appears on the UCAS or UTT decision processing pages for that person ID.

See "Understanding Service Indicators" (Campus Community Fundamentals)

Note that the UCAS and UTT processing pages discussed in this section (except the Wrong Applicant,
Standard Offer, and Result/Offer Matching Process pages) enforce application center security. The system
restricts the search results on the UCAS and UTT processing pages based on the application centers
defined for the user (Set Up SACR, Security, Secure Student Administration, User ID, Application Center
Security). You can view the UCAS or UTT application only if your User ID has access to the application
center of the related Campus Solutions application. For example, suppose that user ID SATRN11 does not
have access to the UGRD application center. In such a case, the UCAS Decision Processing page does not
allow SATRN11 to access an application associated with the UGRD application center.

The system applies the same application center security to UCAS and UTT processing pages and the
Maintain Applications component.
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Related Links
"Setting Security for Application Centers" (Campus Solutions Application Fundamentals)

Pages Used to Process the Imported UCAS and UTT Applications and
Applicant Data

Page Name Definition Name Navigation Usage

Standard Offers SAD_UC_STD_OFF Student Admissions >
UCAS Processing >
Standard Offers

Define conditions for an
offer that UCAS sends to the
applicant.

UCAS Application Notes SAD_UC_APPLNOTES Student Admissions >
UCAS Processing > UCAS
Application Notes

View the key information for
a UCAS application choice,
 on a single page. Enter notes
for the application choice.

3C/Attachments SAD_UC_3C_ATTACH Student Admissions >
UCAS Processing > UCAS
Application Notes > 3C/
Attachments

Add or view attachments
for the Campus Solutions
application record. Enter or
view the 3C information for
the person ID.

UCAS Wrong Applicants SAD_UC_STARW Student Admissions >
UCAS Processing >
Remove Wrong
Applicants > UCAS Wrong
Applicants

Review the imported
applicant records from
ivStarW and delete records if
required. You can also use this
page to un-match an applicant
record that is incorrectly
matched to a person record.

UCAS Initial Decision Entry SAD_UC_DECENTRY Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Initial Decision Entry

Enter an admission decision
for a UCAS application
choice.

UCAS Decision Processing SAD_UC_DECISN Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Decision Processing

Enter or update an admission
decision for a UCAS
application choice.

Find out whether your
institution has confirmed the
applicant's admission offer
or released the applicant into
Clearing.

UCAS Quick Decision Entry SAD_UC_QDEC Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Quick Decision Entry

Enter a decision
simultaneously for multiple
UCAS applications.
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Page Name Definition Name Navigation Usage

Apply Decisions SAD_UC_APDECISN_PG Student Admissions >
UCAS Processing > Apply
Decision Processing >Apply
Decisions

Enter or update a decision for
Apply applications.

UCAS Decision Approval SAD_UC_DECAPR Student Admissions >
UCAS Processing > UCAS
Decision Approval >
Decision Approval

Approve or reject the
admission decision for a
UCAS application choice.

UCAS Quick Decision
Approval

SAD_UC_QDAPR Student Admissions >
UCAS Processing > UCAS
Decision Approval > Quick
Decision Approval

Approve or reject
simultaneously the admission
decisions for multiple UCAS
applications.

Results/Offer Matching
Process

SAD_UC_MATCH_PROC Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Result/Offer Matching
Process

Match exam results with
conditional offer details for
Confirmation. The process
determines whether the
applicants have satisfied the
offer conditions.

You can run this process
for all applicants in an
institution, for all applicants
of a particular course, or for
specific applicants.

This process is optional
for confirming conditional
offers. You can use the
Confirmation Entry page to
manually determine whether
an applicant has satisfied the
offer conditions.

UCAS Confirmation Entry SAD_UC_CNFDEC Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Confirmation Entry

Accept or reject the
conditional offer of an
applicant.

If you have not run the
Results/Offer Matching
process for the applicant,
 manually match the
applicant's exam results with
the conditional offer details
and indicate whether the
applicant has satisfied the
conditions for admission.

UCAS Quick Confirmation SAD_UC_QCONF Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Quick Confirmation

Accept or reject the
conditional offer of multiple
applicants.

1000  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 27 (GBR) Managing UCAS and UTT Applications

Page Name Definition Name Navigation Usage

UCAS Confirmation
Approval

SAD_UC_CNFAPR Student Admissions >
UCAS Processing > UCAS
Decision Approval >
Confirmation Approval

Approve or reject the
Confirmation decision for an
applicant.

UCAS Quick Confirmation
Approval

SAD_UC_QAPR Student Admissions >
UCAS Processing > UCAS
Decision Approval > Quick
Confirmation Approval

Approve or reject the
Confirmation decision for
multiple applicants.

UCAS Release To Clearing SAD_UC_RELDEC Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Release to Clearing

Release an applicant into
Clearing.

UCAS Release to Clearing
Approval

SAD_UC_RELAPR Student Admissions >
UCAS Processing > UCAS
Decision Approval >
Release to Clearing
Approval

Approve or reject an
applicant's release into
Clearing.

UCAS Enquiry Entry SAD_UC_CLEARING Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Enquiry Entry

Create or update an applicant's
Clearing or Adjustment
record. Specify whether
you want the Transaction
Processing process to generate
an RX, RQ, PE, or AD
transaction.

UCAS Qualifications SAD_UC_IVFRMQUAL Student Admissions >
UCAS Processing > UCAS
Decision Processing >
Qualifications

Review and edit imported
qualification and exam result
records.

Decision Export SAD_UC_AEXP_RCTL Student Admissions >
UCAS Processing > Apply
Decision Processing >Apply
Decisions Export

Post decisions for Apply
applications.

Transaction Processing SAD_UC_TRN_PROC Student Admissions >
UCAS Processing >
Transaction Processing >
Transaction Processing

Generate, export, and update
UCAS and UTT transactions.

UCAS Transactions SAD_UC_TRANIN Student Admissions >
UCAS Processing >
Transaction Processing >
UCAS Transactions

Review the UCAS
transactions. In addition,
 manually add or delete
transactions and set the hold
flag to prevent the system
from sending the transactions
to UCAS.
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Page Name Definition Name Navigation Usage

UCAS Enquiry Transactions SAD_UC_TRANINCLR Student Admissions >
UCAS Processing >
Transaction Processing >
UCAS Enquiry Transactions

Review the UCAS Clearing
and Adjustment transactions
that the Transaction
Processing process has
generated. Alternatively,
 manually add or delete
Clearing or Adjustment
transactions. Set the hold
flag to prevent the system
from sending the Clearing or
Adjustment transactions to
UCAS.

UCAS Confirmation
Enquiries

SAD_UC_CONF_ENQ Student Admissions >
UCAS Processing > UCAS
Confirmation Enquiries

Review a summary of the
Confirmation or Clearing
application choice. Also, enter
notes and outcome codes for
an application choice while
handling applicant enquiries
related to Confirmation and
Clearing.

UTT Application Notes SAD_UC_GTAPPNOTE Student Admissions >
UCAS Processing > UTT
Application Notes

View the key information for
a UTT application choice, on
a single page. Enter notes for
the application choice.

3C/Attachments SAD_UC_GT3C_ATTACH Student Admissions >
UCAS Processing > UTT
Application Notes > 3C/
Attachments

Add or view attachments
for the Campus Solutions
application record. Enter or
view the 3C information for
the person ID.

Wrong Applicants SAD_UC_GSTARW Student Admissions >
UCAS Processing >
Remove Wrong
Applicants > Wrong
Applicants

Review the imported
applicant records from
ivgStarW and delete records if
required. You can also use this
page to un-match an applicant
record that is incorrectly
matched to a person record.

UTT Initial Decision Entry SAD_UC_GTDECENTRY Student Admissions >
UCAS Processing > UTT
Decision Processing >
Initial Decision Entry

Enter an admission decision
for a UTT application choice

UTT Decision Processing SAD_UC_GTDECISN Student Admissions >
UCAS Processing > UTT
Decision Processing >
Decision Processing

Enter or update an admission
decision for a UTT
application choice.
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Page Name Definition Name Navigation Usage

UTT Quick Decision Entry SAD_UC_QGTDEC Student Admissions >
UCAS Processing > UTT
Decision Processing >
Quick Decision Entry

Enter a decision
simultaneously for multiple
UTT applications.

UTT Qualifications SAD_UC_IVGFRMQUAL Student Admissions >
UCAS Processing > UTT
Decision Processing >
Qualifications

Review and edit imported
qualification records.

UTT Decision Approval SAD_UC_GTDECAPR Student Admissions >
UCAS Processing > UTT
Decision Approval >
Decision Approval

Approve or reject the
admission decision for a UTT
application choice.

UTT Quick Decision
Approval

SAD_UC_QGTDAPR Student Admissions >
UCAS Processing > UTT
Decision Approval > Quick
Decision Approval

Approve or reject
simultaneously the admission
decisions for multiple UTT
applications.

UTT Confirmation Entry SAD_UC_GTCNFDEC Student Admissions >
UCAS Processing > UTT
Decision Processing >
Confirmation Entry

Accept or reject the
conditional offer of a UTT
applicant.

UTT Quick Confirmation SAD_UC_QGTCONF Student Admissions >
UCAS Processing > UTT
Decision Processing >
Quick Confirmation

Accept or reject the
conditional offer of multiple
UTT applicants.

UTT Confirmation Approval SAD_UC_GTAPR Student Admissions >
UCAS Processing > UTT
Decision Approval >
Confirmation Approval

Approve or reject the
Confirmation decision for a
UTT applicant.

UTT Quick Confirmation
Approval

SAD_UC_QGTAPR Student Admissions >
UCAS Processing > UTT
Decision Approval > Quick
Confirmation Approval

Approve or reject the
Confirmation decision for
multiple UTT applicants.

UTT Enquiry Entry SAD_UC_GTCLRING Student Admissions >
UCAS Processing > UTT
Decision Processing >
Enquiry Entry

Create or update an applicant's
Clearing record. Specify
whether you want the
Transaction Processing
process to generate an RX.
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Page Name Definition Name Navigation Usage

UTT Transactions SAD_UC_GTTRANIN Student Admissions >
UCAS Processing >
Transaction Processing >
UTT Transactions

Review UTT transactions
that you have sent or not sent.
 In addition, manually add
or delete transactions and
set the hold flag to prevent
the system from sending the
transactions to UCAS.

UTT Enquiry Transactions SAD_UC_GTTRNCLR Student Admissions >
UCAS Processing >
Transaction Processing >
UTT Enquiry Transactions

Review the UCAS Clearing
transactions that the
Transaction Processing
process has generated.
Alternatively, manually add or
delete Clearing transactions.
 Set the hold flag to prevent
the system from sending the
Clearing transactions to UTT.

ID Delete RUNCTL_ID_CHANGE Campus Community >
Personal Information > ID
Management > ID Delete

Delete an ID from the
database after initiating the
removal process of the ID in
the UCAS Wrong Applicants
or the Wrong Applicants
pages.

Defining Conditions for an Offer
Access the Standard Offers page (Student Admissions > UCAS Processing > Standard Offers).
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This example illustrates the fields and controls on the Standard Offers page. You can find definitions for
the fields and controls later on this page.

For UTT, you should enter only the interview date element in the Free Format field and not the interview
time. For UCAS, you can enter both the interview date and time in the Free Format field.

You can use the Decision Code field in the Decision Processing, Initial Decision and Quick Decision
pages to select a standard offer. On selecting a standard offer, the system populates the decision record
with the values that you defined on the Standard Offers page.

Free Format field and the Interview decision

For Interview decisions, the value you enter in the Free Format field need not start with DDMMYY. You
can define interview standard offers with or without date and time elements. Note that the generated
Transaction Code should not be blank for Interview decisions. You must enter text in either the Comment
field or the Free Format field to generate transaction code.

If the Free Format field on the Standard Offers page starts with a date in the format DDMMYY, then
the system populates the Interview Date field in the UCAS and UTT Decision Processing and Initial
Decision pages with this date. For example, suppose you have an INT01 offer with a free format text that
starts with 010100 on the Standard Offers page. In such a case, when you select INT01 as a decision code
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on the UCAS Decision Processing page, the page automatically populates the Interview Date field as
01/01/2000.

If the Free Format field on the Standard Offers page includes a time in the format HHMM from position
8 to 11 (that is, after a hyphen - as character 7), then the system populates the Interview Time field in the
UCAS Decision Processing and UCAS Initial Decision pages with this time. For example, suppose you
have an INT01 offer with a free format text that starts with 010100-1300. In such a case, when you select
INT01 as a decision code on the UCAS Decision Processing page, the page automatically populates the
Interview Date field as 01/01/2000 and Interview Time as 13:00. UTT does not use Interview Time.

The system populates the Free Format field on the UCAS and UTT Decision Processing pages with the
Free Format value from the Standard Offers page without the interview date and time elements for UCAS
and without the interview date for UTT. For example, suppose you have an INT01 offer with a free format
text 010100-1300 Is your interview date and time. In such a case, when you select INT01 as a decision
code on the UCAS Decision Processing page, the page automatically populates the Interview Date field
with 01/01/2000, Interview Time field with 13:00, and the Free Format field with Is your interview date
and time. The Free Format field does not appear on the Initial Decision pages but the system applies
similar logic in the background to populate the Free Format field of the decision record with the free
format text from the standard offer minus any interview date and time elements.

You can change the interview date and time, comment, and the free format text values on the decision
pages, if required.

Reviewing Key UCAS Application Information
Access the UCAS Application Notes page (Student Admissions > UCAS Processing > UCAS
Application Notes).
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This example illustrates the fields and controls on the UCAS Application Notes page (1 of 4). You can
find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the UCAS Application Notes page (2 of 4). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UCAS Application Notes page (3 of 4). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UCAS Application Notes page (4 of 4). You can
find definitions for the fields and controls later on this page.

The fields on the Notes region are similar to those on the UCAS Confirmation Enquiries page. The
Automatic Save and Outcome Required settings on the UCAS Configuration page affects only the UCAS
Confirmation Enquiries page and does not affect the UCAS Application Notes page.

Field or Control Description

View Printable Page Click to obtain a printable version of the application
information.

Adding Attachments and Reviewing 3C Information for UCAS Application
Access the 3C/Attachments page (Student Admissions > UCAS Processing > UCAS Application
Notes > 3C/Attachments).
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This example illustrates the fields and controls on the 3C/Attachments page (1 of 2). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the 3C/Attachments page (2 of 2). You can find
definitions for the fields and controls later on this page.

File Attachments

Use this group box to add, delete and view attachments for the Campus Solutions application.
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Field or Control Description

Add Attachment Click to access standard PeopleTools functionality to browse
to a file and upload it

View Click the link to open the attachment in a new window.

The Audit tab displays all updates to attachments, including user name and date/time.

Note that you can also use the File Attachments group box on the Application Data page of the Maintain
Applications component to maintain and access the attachment data.

The 3C Group Boxes (Checklists, Comments, and Communications)

The fields on these group boxes are similar to the fields that appear on the Campus Community's
checklist, comment, and communication pages. The group boxes display the records in a similar way to
the Campus Community's checklist, comment, and communication summary pages.

See "Understanding Checklists" (Campus Community Fundamentals)

See "Understanding Comments" (Campus Community Fundamentals)

See "Understanding Communication Management" (Campus Community Fundamentals)

Note that the group boxes display a person ID's 3C records for only the ADMA and ADMP
administrative functions. Also, these group boxes display only those 3C records where the application
number in the variable data of the 3C record matches with the application choice that the Choice Details
region of the page displays or if the application number value in the variable data is blank (3C records
can be created without the application number value in variable data). Records linked to other application
numbers are not displayed.

When you create a checklist, comment, or communication record by clicking the create button on any one
of these group boxes, the system by default:

• Populates the Administrative Function field with the value that you selected for the Default Admin
Function field on the UCAS Configuration page (if the Default Admin Function field is blank, then
the system will enter ADMA in the Administrative Function field).

• Enters the variable data based on the application choice (that is, academic career, student career Nbr,
application number, and application center).

Deleting Incorrect UCAS Applicant Records
Access the UCAS Wrong Applicants page (Student Admissions > UCAS Processing > Remove
Wrong Applicants > UCAS Wrong Applicants).
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This example illustrates the fields and controls on the UCAS Wrong Applicants page . You can find
definitions for the fields and controls later on this page.

In certain circumstances, an incoming UCAS applicant record can be incorrectly matched to an existing
person record during the import process or through the Transaction Data page. In such circumstances:

1. Use the UCAS Remove Wrong Applicants component to manually add the wrong applicant record.

2. Select the Cancelled check box. If needed, edit the Cancelled Date field. Optionally, enter a remark.

3. Save the record.

4. Click the Remove Applicant button to run the Remove Applicant process. This process removes the
incorrectly matched applicant.

The Remove Applicant process does not alter the person-related records (for example, Disability,
Ethnicity, Citizenship, National ID, External System ID and so on) that the Import Applicant Data
process may have created for the incorrect ID. These records should be updated or removed using
the relevant Campus Community pages. In particular, the UCAS Personal ID that the import process
creates as an External System ID for the incorrect ID should be removed to prevent the record being
incorrectly matched again during the re-import.

5. Run the Import Applicant Data process for the single applicant so that all the deleted applicant records
can be re-imported and either matched to the correct person or a new person record created.
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Field or Control Description

Cancelled Date This field is available for edit only when you are manually
adding a record. After you save the manually added record,
 this field becomes unavailable.

Remark This field is available for edit only when you are manually
adding a record.

Remove Applicant Click to run the Remove Applicant process that will delete the
IDs:

• UCAS applicant record.

• UCAS application choice records.

• Non-matriculated Campus Solutions application records.

The system enables this button if the status is Pending,
 Partially Removed, or No Action.. When you click the button,
 the status changes to Removed.

When you click the button for a UCAS applicant for whom
only specific choices are lost, the system removes the specific
lost choices but retains the overall applicant record.

For a manually added record, the system enables the button
only when you save the record.

No Action Click to change the record status from Pending to No Action.
 The No Action status indicates that the record need not be
removed.

For a manually added record, the system enables the button
only when save the record.

After clicking the Remove Applicant button, navigate to Campus Community > Personal
Information > ID Management > ID Delete to remove the person record of the UCAS wrong
applicant.

Entering an Initial Admission Decision for a UCAS Application Choice
Access the UCAS Initial Decision Entry page (Student Admissions > UCAS Processing > UCAS
Decision Processing > Initial Decision Entry).
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This example illustrates the fields and controls on the UCAS Initial Decision Entry page. You can find
definitions for the fields and controls later on this page.

If you didn't select the Interview Applicants option on the UCAS Initial Decision Entry search page, an
application choice is included in the search results only if all the following conditions are satisfied:

• An institution decision does not exist.

• UCAS decision of the choice is blank.

• Choice isn't cancelled.

• Action isn't Declined by Default (D) or Rejected by Default (R).

• The whole application isn't withdrawn.

In such a case, the UCAS Initial Decision Entry page does not allow you to modify an institution
decision. If you want to modify an institution decision, use the UCAS Decision Processing page.

If you select the Interview Applicants option on the UCAS Initial Decision Entry search page, an
application choice is included in the search results only if all the following conditions are satisfied:

• An institution decision record exists with decision = I (interview) and decision is approved or does not
require approval.
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• UCAS decision value of the choice (imported from StarC/StarG) is not W (withdrawn) or R (rejected).

• Choice is not cancelled.

• Action isn't Declined by Default (D) or Rejected by Default (R).

• The whole application is not withdrawn.

In such a case, you can then use the UCAS Initial Decision Entry to modify the Interview decision to a
post-interview decision (that is, Offer, Conditional offer, or Reject).

Decision Details

Field or Control Description

Institution Decision Select an admission decision. After you enter a decision, run
the Transaction Processing process to generate the transaction
to send to UCAS.

If the choice number is 9 (Clearing), the valid decisions
are A (Accept) or R (Rejection). If the choice number is 6 
(Adjustment), the valid decision is U (Unconditional Offer).
 If the choice number is not 9 or 6 (standard application), the
valid decisions are C (Conditional Offer), U (Unconditional
Offer), R (Rejection), F (Course Full), and I (Interview).

The Interview Date and Interview Time fields appear only if
you select the Interview decision.

You cannot enter the Delayed Conditional decision code (D) in
this page or the UTT Initial Decision Entry page. This decision
can be entered only in the Decision Processing page.

Decision Code Optionally, add a standard offer to the decision.

Interview Date Select the date on which the interview is to take place.

Interview Time Enter the time the interview is scheduled to begin. The time
format uses a 24-hour clock. Therefore, for example, if the
interview time is 2:30 PM, enter 14:30.

Comment For all decisions you can add a comment, unless a standard
offer is entered.

You can enter the reason for a Clearing Rejection in the
Comment field. When you generate a RX transaction for the
rejection, the system includes the comment text in the Free
Format column of the RX transaction.
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Notes

This region is similar to the Apply Application and UCAS Confirmation Enquiries pages.

Related Links
Reviewing Imported Apply Applications and Applicant Data

Entering or Updating an Admission Decision for a UCAS Application
Choice

Access the UCAS Decision Processing page (Student Admissions > UCAS Processing > UCAS
Decision Processing > Decision Processing).

This example illustrates the fields and controls on the UCAS Decision Processing page (1 of 3). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UCAS Decision Processing page (2 of 3). You can
find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the UCAS Decision Processing page (3 of 3). You can
find definitions for the fields and controls later on this page.
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Field or Control Description

Institution Decision Select an admission decision. After you enter or update a
decision, if required, use the UCAS Decision Approval page
to approve the decision. Then use the Transaction Processing
process to generate the decision transaction to send to UCAS.

The validations of this field are similar to that of the Institution
Decision field on the UCAS Initial Decision Entry page.
 However, you can enter the Delayed Conditional (D) decision
only from this page. Decision D is valid only for non-clearing
CF application choices (CF means decision is Conditional
Offer and reply is Firm).

Confirmation Decision The system automatically selects this check box when you
enter a Confirmation decision in the UCAS Confirmation
Entry page or the UCAS Quick Confirmation page.

Release to Clearing The system automatically selects this check box when you
enter a Release into Clearing decision in the UCAS Release to
Clearing page.

Decision Code Optionally, add a standard offer to the decision.

Comment The usage of this field is similar to that of the Comment field
on the UCAS Initial Decision Entry page. The only difference
is that on this page you can use this field for transaction code.
 For example, if Interview Date is May 26, 2009 and Interview
Time is 9:15 and Comment is Bring your portfolio and you
click Letter Text, then the following transaction code appears
260509-0915,'Bring your portfolio'

The offer details fields are similar to the fields on the Standard Offers page.

Notes

This region is similar to the Apply Application and UCAS Confirmation Enquiries pages.

Related Links
Reviewing Imported Apply Applications and Applicant Data

Entering a Decision for Multiple UCAS Application Choices
Access the UCAS Quick Decision Entry page (Student Admissions > UCAS Processing > UCAS
Decision Processing > Quick Decision Entry ).
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This example illustrates the fields and controls on the UCAS Quick Decision Entry page. You can find
definitions for the fields and controls later on this page.

If you do not select the Interview Applicants check box on the UCAS Quick Decision Entry page, a
choice is included in the search results only if all the following conditions are satisfied:

• An institution decision does not exist.

• UCAS decision of the choice is blank.

• Choice is not cancelled.

• The whole application is not withdrawn.

In such a case, the page does not allow you to modify an admission decision. If you want to modify an
admission decision, use the UCAS Decision Processing page.

If you select the Interview Applicants check box on this page, a choice is included in the search results
only if all the following conditions are satisfied:

• An institution decision record exists with decision = I (interview) and decision is approved or does not
require approval.

• UCAS decision value of the choice (imported from StarC/StarG) is not W.

• Choice is not cancelled.

• The whole application is not withdrawn.

In such a case, you can use this page to modify the Interview decision to a post-interview decision (that is,
Offer, Conditional offer, or Reject).

The system enables the Interview Date - From and Interview Date - To search fields and displays the
interview date column in the search results, if you select the Interview Applicants check box. And the
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system enables the Created Date - From and Created Date - To search fields, if you deselect the Interview
Applicants check box.

You can search for records of a particular institution, course, campus, entry year and application center or
combination of those. The decision, decision code, decision maker and comment field values are used for
all the records that have a decision applied and are saved.

You cannot enter the Delayed Conditional decision code (D) in this page or the UTT Quick Decision
Entry page. This decision can be entered only in the Decision Processing page.

Entering or Updating a Decision for Apply Applications
Access the Apply Decisions page (Student Admissions > UCAS Processing > Apply Decision
Processing >Apply Decisions).

This example illustrates the fields and controls on the Apply Decisions page (1 of 2). You can find
definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Apply Decisions page (2 of 2). You can find
definitions for the fields and controls later on this page.

The regions Application, Contact, Candidate, Qualifications, Personal Statement, Work History, and
References are similar to the ones on the Apply Application page.

Note: You may see positive or negative service indicator icons on the page. If you select either icon, the
Manage Service Indicators page appears.

Decision

In this region, you can view current and older effective-dated records as well as delete them.

Field or Control Description

Effective Date This defaults to the current date when you add a new row.

Note: You can select a future effective date, but future records
aren’t included in the export process.

Decision Select your decision for this application.

The values you can select are derived from the most recent
effective-dated row on the Apply Application Status page.
 For information about the decisions and application status
mapping, see Creating or Reviewing Application Statuses for
Apply Applications.
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Field or Control Description

Decision Maker When a decision has been made, this field is populated with a
default value from any one of these:

• If the user has defined a Decision Maker on the UCAS,
 Apply Defaults page.

• If the Default Decision Maker check box is selected on
the UCAS Configuration page, and the user who makes
the decision is associated with an EMPLID, then this
value is the default.

• Blank by default.

Rejection Reason This field appears only when your Decision =
Rejected, and can be populated with predefined text that
you select by clicking Select Reason.

You can still edit the predefined text once this field is
populated.

Select Reason Click to select pre-defined text for rejected applications. The
text populates the Rejection Reason field.

Course Change

This region appears only when Decision = Offer.

Field or Control Description

Select Course Click to select an Apply Course. When you select a course, the
fields in this region are populated and the existing conditions
in the Conditions region are removed.

If there’s a default offer on the Apply Course page for the new
course, the Conditions grid is populated with the conditions
defined for the most recent row of that offer.

The list includes all Apply Course records for the cycle of the
application for all provider codes.

Clear Course Select to clear all the fields in this region as well as any default
conditions in the Conditions region for the change of course.

Conditions

This region appears only when Decision = Offer. You can do any one of these actions:
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• Edit or delete the text even when the text is populated from an offer.

• Click + to add ad hoc conditions that are specific to an application.

The Conditions region is populated based on these scenarios:

• If there’s a default offer on the Apply Course page for the existing course or cycle of the choice, then
this region is populated with the conditions associated with the most recent effective row of the offer.

• If there isn’t a default offer and an Apply Offer is set as the default in the most recent effective-dated
row for the offer, then the conditions associated with the most recent effective-dated row for the offer
populates this region.

• If a default offer isn’t defined on the Apply Course page nor is there a default offer on the Apply
Offers page, the Conditions region is blank.

Field or Control Description

Select Offer Optional. Click to select an Apply Offer record. Only active
offers are available to choose from. But the system may limit
the choices to Available Offers that are defined on the Apply
Course page.

When you select an offer record, existing rows in this region
are removed. The conditions from the most recent effective-
dated row for the offer populate this region.

Select Condition Optional. Click to select an Apply Condition record. Only
active conditions are available to choose from. But the system
may limit the choices to Available Conditions that are defined
on the Apply Course page.

When you select a condition record, a new row is added with
the condition from the condition record you selected.

Export Details

Field or Control Description

Export Status For new records, this field defaults to New. The decision
export process updates this value to either Completed or
Error.

You can manually set the status to Resend to re-export an
existing decision record after you correct an error.

3C/Attachments

This region has the same functionality as UTT Application Notes.
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Approving or Rejecting a UCAS Decision
Access the UCAS Decision Approval page (Student Admissions > UCAS Processing > UCAS
Decision Approval > Decision Approval).

This example illustrates the fields and controls on the UCAS Decision Approval page . You can find
definitions for the fields and controls later on this page.

Click Approve or Deny button to indicate whether the admission decision entered in the UCAS Decision
Processing or UCAS Initial Decision Entry page is approved or denied.

Approving or Rejecting Multiple UCAS Decisions
Access the UCAS Quick Decision Approval page (Student Admissions > UCAS Processing > UCAS
Decision Approval > Quick Decision Approval).
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This example illustrates the fields and controls on the UCAS Quick Decision Approval page. You can
find definitions for the fields and controls later on this page.

You can search for records of a particular institution, course, campus, entry year and application center or
combination of those. The Approver value is used for all the records that are approved and saved.

Determining Whether Applicants Satisfy the Offer Conditions
Access the Result/Offer Matching Process page (Student Admissions > UCAS Processing > UCAS
Decision Processing > Result/Offer Matching Process).

This example illustrates the fields and controls on the Result/Offer Matching Process page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Student Override Select if you want to run the process for one or more IDs
selected in the EmplID field.

If you select the Student Override check box, the process
ignores any values entered in the UCAS Course Code field.

For a student, the process can compare the conditions you generated (Transaction Code) on the UCAS
Decision Processing page with the exam results, and determine whether the student has satisfied the
conditions. The process considers the following abbreviations when comparing conditional offer details
with exam results:

• TO - Tariff offers

• GC - GCE A Level

• AS - GCE AS Level

• IH - Irish Leaving Certificate (Higher Level)

• SH - SQA Highers

• AH - SQA Advanced Highers

• EG - Excluding General Studies

• AC - Alternate conditions

Any other abbreviations need to be manually reviewed before the offer is confirmed.

After running this process, navigate to the UCAS Confirmation Entry page to check whether the applicant
has satisfied the conditions. If the process determines that the applicant has satisfied all the conditions,
the Results Matching  field displays Satisfied  on the UCAS Confirmation Entry page. If the process
determines that at least one condition has not been met, the Results Matching field displays Not Satisfied.
If the process determines that at least one condition has not been evaluated, the Results Matching field
displays Partially Evaluated. If the process determines that none of the conditions have been evaluated,
the Results Matching field displays Not Evaluated.

The following example shows how the Result/Offer Matching process works for a tariff offer:

1. Use the UCAS Decision Processing page to enter a conditional offer for a student.

Enter abbreviation = TO (Tariff Score) and Grade Mark = 200. This condition is generated: The
student must obtain a minimum of 200 UCAS tariff points.

2. Import the exam results from ivStarPQR.

The student has grade C for GCE A Levels in Maths, General Studies, and English.

3. Run the Results/Offer Matching process for the student.

The system uses the imported cvRefTariff data to translate the total tariff score to 240 (grade C is
equivalent to 80 tariff points).
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4. The UCAS Confirmation Entry page for the student shows that the condition is satisfied.

Note: The Result/Offer Matching process considers only records that have a current decision of C or D,
for which the Manual Matching Required check box is cleared on the UCAS Decision Processing page.

Entering or Updating a UCAS Confirmation Decision
Access the UCAS Confirmation Entry page (Student Admissions > UCAS Processing > UCAS
Decision Processing > Confirmation Entry).

This example illustrates the fields and controls on the UCAS Confirmation Entry page (1 of 3). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UCAS Confirmation Entry page (2 of 3). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the UCAS Confirmation Entry page (3 of 3). You can
find definitions for the fields and controls later on this page.

Click the Accept or Reject button to indicate the Confirmation decision.

To add any changes to the course details, first enter the changes, then click the Accept button, and finally
save the record. For example, enter a Campus Change value, click the Accept button, and then save the
record.

Note that if you decide to save the record without clicking either the Accept button or Reject button, then
the system removes any course change details in the existing non-confirmation decision record.

All application records that are CF or CI (decision is conditional offer, and reply is firm or insurance)
appear on the UCAS Confirmation Entry page regardless of whether a confirmation decision is pending
or has been entered. Additionally, any application records that are DF (decision is delayed conditional
and reply is firm) appear on the UCAS Confirmation Entry page regardless of whether a confirmation
decision is pending or has been entered. You can enter or amend a confirmation decision using this page.

The system automatically selects the Confirmation Decision check box on the UCAS Decision
Processing page when you click Accept or Reject.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1029



(GBR) Managing UCAS and UTT Applications Chapter 27

After you enter a Confirmation decision, if required, use the Confirmation Approval page to approve the
decision. Then run the Transaction Processing process to generate the RD transaction to send to UCAS.

If you amend an existing confirmation decision using this page, in most cases, the Transaction Processing
process generates another RD transaction with the new Accept or Reject decision. However, in cases
where you have already sent an accept decision and a course change is being made, then the process
generates a RA transaction.

If the Entry Point is being changed to a foundation year with Entry Point of zero, you must enter 9 in
the Entry Point Change field of this page. The system will send this value to UCAS in the confirmation
transaction as zero when you run the Transaction Processing process.

Entering Multiple UCAS Confirmation Decisions
Access the UCAS Quick Confirmation page (Student Admissions > UCAS Processing > UCAS
Decision Processing > Quick Confirmation).

This example illustrates the fields and controls on the UCAS Quick Confirmation page. You can find
definitions for the fields and controls later on this page.

The same rules discussed in the “Entering a Confirmation Decision” topic apply to the UCAS Quick
Confirmation page. However, there are two exceptions:

• The Quick Confirmation page does not display a DF application choice.

• The Quick Confirmation page does not display an application choice for which you already have
entered a confirmation decision.

You can search for records of a particular course. Also, you can use the same Decision Maker value for all
the records that appear in the search results.

A choice is included in the search results of this page only if all the following conditions are satisfied:

• Institution decision is C (conditional offer)

• Reply of the choice (from ivStarC) is F or I.

• Choice is not cancelled.
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• The whole application is not withdrawn.

When you click Accept or Reject, the system automatically updates the Decision value to A or R,
respectively.

Approving or Rejecting a UCAS Confirmation Decision
Access the UCAS Confirmation Approval page (Student Admissions > UCAS Processing > UCAS
Decision Approval > Confirmation Approval).

This example illustrates the fields and controls on the UCAS Confirmation Approval page (1 of 2).
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This example illustrates the fields and controls on the UCAS Confirmation Approval page (2 of 2).

Approving or Rejecting Multiple UCAS Confirmation Decisions
Access the UCAS Quick Confirmation Approval page (Student Admissions > UCAS Processing >
UCAS Decision Approval > Quick Confirmation Approval).

This example illustrates the fields and controls on the UCAS Quick Confirmation Approval page. You can
find definitions for the fields and controls later on this page.

You can search for records of a particular institution, course, campus, entry year and application center or
combination of those. The Approver value is used for all the records that are approved and saved.

Entering a Decision to Release an Applicant into Clearing
Access the UCAS Release to Clearing page (Student Admissions > UCAS Processing > UCAS
Decision Processing > Release to Clearing).
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This example illustrates the fields and controls on the UCAS Release to Clearing page. You can find
definitions for the fields and controls later on this page.

The page displays:

• Application choices that have a Institution Decision of U (Unconditional), Reply of F (Firm), and the
Release to Clearing check box cleared on the Decision Processing page.

• All accepted Clearing and Adjustment application choices (that is, application choice number is 6 or
9, decision is A or U, and Reply is not equal to D (declined).

The system automatically selects the Released to Clearing check box on the UCAS Decision Processing
page when you click Release to Clearing.

After you enter a decision to release an applicant into Clearing, if required, use the Release to Clearing
Approval page to approve the decision. Then run the Transaction Processing process to generate the RR
transaction to send to UCAS.

Note: The system displays a warning message if the applicant is not eligible for release to Clearing. That
is, when you click the Release to Clearing button, a warning message appears if the application is for
deferred entry, if the application is for a future or previous cycle, if the application is RPA (Record of
Prior Acceptance), or if the application Fee Level is single fee.

Approving or Rejecting the Release into Clearing Decision
Access the UCAS Release Approval page (Student Admissions > UCAS Processing > UCAS Decision
Approval > Release to Clearing Approval).
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This example illustrates the fields and controls on the UCAS Release Approval page.

Entering UCAS Clearing or Adjustment Details
To search for only adjustment records, select the Adjustment check box on the search page. To search for
only Clearing records, clear the Adjustment check box on the search page.

Access the UCAS Enquiry Entry page (Student Admissions > UCAS Processing > UCAS Decision
Processing > Enquiry Entry).
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This example illustrates the fields and controls on the UCAS Enquiry Entry page (1 of 2). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the UCAS Enquiry Entry page (2 of 2). You can find
definitions for the fields and controls later on this page.

Use the Transaction Type field to record an RQ, PE, or RX transaction for a Clearing enquiry or the
RQ, PE, or AD transaction for an Adjustment enquiry. Use the Decision field to enter A (Accept) or R
(Reject). After you record the Clearing or Adjustment details, run the Transaction Processing process to
generate the Adjustment or Clearing transactions to send to UCAS.

If you want to record a PE transaction, the UCAS Personal ID and UCAS Application Code fields are
required (UCAS Course Code is optional).

If you want to record a AD transaction, the UCAS Personal ID, UCAS Application Code, UCAS Course
Code, Entry Year, and Entry Month fields are required.

The UCAS Course Code field is required for RQ and RX transactions. Also, the Decision field is required
for RX transaction.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1035



(GBR) Managing UCAS and UTT Applications Chapter 27

Reviewing and Updating UCAS Qualifications
Access the UCAS Qualifications page (Student Admissions > UCAS Processing > UCAS Decision
Processing > Qualifications)

This example illustrates the fields and controls on the UCAS Qualifications page.

Generating, Exporting, and Updating UCAS and UTT Transactions
Access the Transaction Processing page (Student Admissions > UCAS Processing > Transaction
Processing > Transaction Processing).
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This example illustrates the fields and controls on the Transaction Processing page. You can find
definitions for the fields and controls later on this page.

Use the check boxes in the UCAS and UTT regions to generate, export, and update UCAS and UTT
transactions.

Field or Control Description

Generate Transactions Select to generate transactions and update the corresponding
Campus Solutions application choice records.

Export Transactions to UCAS Select to write the transactions to the TRANIN table at UCAS.

Update Transactions from UCAS Select to enable the Campus Solutions system to read back
error codes from TRANIN at UCAS.

The system disables the UTT check boxes on the Transaction Processing page if you clear the UTT check
box on the UCAS Configuration page.

Posting Decisions for Apply Applications
Access the Decision Export page (Student Admissions > UCAS Processing > Apply Decision
Processing >Apply Decisions Export).

Use this page to run the process that posts your decisions using the Apply API. Once successfully posted,
the error codes and updated applications are imported back into Campus Solutions to update the local
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record. This confirms that your decision was exported. If there are any errors, they’re stored in the local
record, which allows you to correct the record and resend your decision.

When you initiate this process, it first checks that the Import Applicant Data process isn’t running to
prevent locking issues with the choice and staging records. If the import process is running, the export
process stops and the system logs a message.

If the process continues, it then checks the configuration record for your institution to ensure that you
have defined all the required values. For each decision record, if the most recent effective-dated row’s
Export Status is Either New or Resend and:

• Decision = Offer, the record is posted with this information:

• The conditions are populated from the decision condition records.

• Course object elements are included only if Course Change is selected, and each value is
populated from the decision record.

• Decision = Rejected, the record is posted with this information:

• The Rejection Reason is populated from the decision record.

• The rejection date is populated with the effective date and time of the decision record.

• Decision = Recruited, the record is posted.

• Decision = Conditions not met, the record is posted.

• Decision = any other value, the decision is not exported and the record is updated with Export Status
= Error and an error message.

When the record successfully posts, Export Status is set to Complete and the time stamp is included in the
POST request. Otherwise, Export Status is set to Error and a message is logged.

For successful posts, the updated application choice and any conditions are imported, and the local choice
record as well as the corresponding CS application (if required) are updated. This processing is the same
as the processing performed for choice updates as part of the Import Applicant Data process.

Reviewing UCAS Transactions
Access the UCAS Transactions page (Student Admissions > UCAS Processing > Transaction
Processing > UCAS Transactions).
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This example illustrates the fields and controls on the UCAS Transactions page. You can find definitions
for the fields and controls later on this page.

You cannot update transactions that the system has already sent to UCAS. The transaction appears in
read-only mode if the system has already sent the transaction to UCAS. If the system has not sent the
transaction, you can use this page to update, delete, or hold the transaction.
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Field or Control Description

Error Code Displays the status of a transaction that UCAS sends back to
the institution. You import the error codes, descriptions, and
error positions from cvRefError view when you import the
reference data.

An error code of:

• -1 indicates that UCAS has not yet processed the
transaction.

• 0 indicates that UCAS has successfully processed the
transaction.

Error Position Indicates where the error appears in the transaction code.

Decision Select a decision for the transaction of an application choice.

Transaction Code Enter the transaction code that you want to send to UCAS.

Auto Indicates that the system has automatically generated the
transaction.

Sent Indicates that the system has sent the transaction to UCAS.

Hold Select to indicate that you do not want the system to export the
transaction to UCAS.

Obsolete Select if you do not want the transaction to appear in the
search results when you search for error, hold, or unsent
transactions. Note that you can select the Transactions in
Error check box, Transaction on Hold check box, or Unsent
Transaction check box on the UCAS Transactions search page
to search for error, hold, or unsent transactions.

Also, if you select the Obsolete check box, the system does not
export the transaction to UCAS. Hold or obsolete transactions
cannot be sent to UCAS.

The following table lists the field values that are mandatory when you create a transaction manually.
If you create a transaction manually, you will need to manually update the related Campus Solutions
application record.

Transaction Type Mandatory Field Value

LD (decision)

LA (amended decision)

RD (confirmation decision)

Decision
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Transaction Type Mandatory Field Value

LC (course correction) At least one of the following values must be provided:

• Course

• Campus

• Entry Year

• Entry Month

• Entry Point

RR (release into clearing) Transaction Code must contain a value ranging from .R1 to
.R8.

PE, RA, or RW None

RA, RR, and RW Application must be UF. That is, Decision must be U
(Unconditional Offer) and Reply must be F (Firm).

Use the UCAS Enquiry Transactions page to manually create an RX or RQ transaction.

Reviewing UCAS Clearing and Adjustment Transactions
To search for only adjustment transactions, select the Adjustment check box on the search page. To search
for only Clearing transactions, clear the Adjustment check box on the search page.

Access the UCAS Enquiry Transactions page (Student Admissions > UCAS Processing > Transaction
Processing > UCAS Enquiry Transactions).
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This example illustrates the fields and controls on the UCAS Enquiry Transactions page.

Most of the fields on the UCAS Enquiry Transactions page are similar to those on the UCAS Transactions
page.

Handling UCAS Applicant Enquiries
Access the UCAS Confirmation Enquiries page (Student Admissions > UCAS Processing > UCAS
Confirmation Enquiries).
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This example illustrates the fields and controls on the UCAS Confirmation Enquiries page (1 of 2). You
can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the UCAS Confirmation Enquiries page (2 of 2). You
can find definitions for the fields and controls later on this page.

The page displays all UCAS application choices (similar to the UCAS Applications component). There is
no restriction to just Confirmation and Clearing application choices. You can add multiple notes records
for an effective date.
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Field or Control Description

Notes Enter the details of the interaction with the applicant.

Action Required Select a value to filter the codes available on the Outcome
Code field.

Outcome Code Select a code to categorize the interaction with the applicant.

Note: If you have configured Automatic Save, the system automatically saves a new record when you
enter the mandatory values. The Notes field is always mandatory. The Action Required and Outcome
Code fields become mandatory, if Outcome Required is configured as mandatory.
You configure Automatic Save and Outcome Required on the UCAS Configuration page.

Reviewing Key UTT Application Information
Access the UTT Application Notes page (Student Admissions > UCAS Processing > UTT
Application Notes).
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This example illustrates the fields and controls on the UTT Application Notes page (1 of 3).
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This example illustrates the fields and controls on the UTT Application Notes page (2 of 3).

This example illustrates the fields and controls on the UTT Application Notes page (3 of 3).
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Most of the fields on this page are similar to those on the UCAS Application Notes page. The UTT
Application Notes page has the Degree Details region and the Work Experience region that are not
applicable to UCAS.

Adding Attachments and Reviewing 3C Information for UTT Application
Access the 3C/Attachments page (Student Admissions > UCAS Processing > UTT Application
Notes > 3C/Attachments).

This example illustrates the fields and controls on the 3C/Attachments page.

The fields on this page are similar to those on the 3C/Attachments page for UCAS.
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Deleting Incorrect UTT and Apply Applicant Records
Access the Wrong Applicants page (Student Admissions > UCAS Processing > Remove Wrong
Applicants > Wrong Applicants).

This example illustrates the fields and controls on the Wrong Applicants page for UTT (Universities and
Colleges Admissions Service Teacher Training) Applicant Records.

This example illustrates the fields and controls on the Wrong Applicants page for Apply Applicant
Records.

For UTT applications, the fields on this page are similar to those on the UCAS Wrong Applicants page.

For Apply records:

• When you click Applicant Summary , you’re accessing Apply Applications.

1048  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 27 (GBR) Managing UCAS and UTT Applications

• In Wrong Applicant Details, all options, except Cancelled, is hidden.

See also Deleting Incorrect UCAS Applicant Records

Entering an Initial Admission Decision for a UTT Application Choice
Access the UTT Initial Decision Entry page (Student Admissions > UCAS Processing > UTT Decision
Processing > Initial Decision Entry).

This example illustrates the fields and controls on the UTT Initial Decision Entry page.

The fields on this page are similar to those on the UCAS Initial Decision Entry page. Note that the UTT
Initial Decision Entry page does not display Accepted clearing choices that have a Choice Number of 99
and Decision of U.

The search results logic of the UTT Initial Decision Entry search page is similar to UCAS Initial Decision
Entry search page except that the UTT search logic does not check whether the UTT choice is cancelled.

Entering or Updating an Admission Decision for a UTT Application Choice
Access the UTT Decision Processing page (Student Admissions > UCAS Processing > UTT Decision
Processing > Decision Processing).
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This example illustrates the fields and controls on the UTT Decision Processing page (1 of 3).

This example illustrates the fields and controls on the UTT Decision Processing page (2 of 3).
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This example illustrates the fields and controls on the UTT Decision Processing page (3 of 3).

Most of the fields on this page are similar to the UCAS Decision Processing page. However, this page has
a Clearing check box that does not appear on the UCAS Decision Processing page. The system selects
the Clearing check box if ClearingStatus from ivgStarK is 2 (under consideration by institution) or 3
(accepted in clearing) and the ivgStarG Round Number is equal to or greater than the ivgStarK Round
Number.

Entering a Decision for Multiple UTT Application Choices
Access the UTT Quick Decision Entry page (Student Admissions > UCAS Processing > UTT
Decision Processing > Quick Decision Entry).
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This example illustrates the fields and controls on the UTT Quick Decision Entry page.

The fields on this page are similar to those on the UCAS Quick Decision Entry page.

The search results logic of the UTT Quick Decision Entry page is similar to UCAS Quick Decision Entry
page except that the UTT search logic does not check whether the UTT choice is cancelled.

Approving or Rejecting a UTT Decision
Access the UTT Decision Approval page (Student Admissions > UCAS Processing > UTT Decision
Approval > Decision Approval).
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This example illustrates the fields and controls on the UTT Decision Approval page. You can find
definitions for the fields and controls later on this page.

Click Approve or Deny button to indicate whether the admission decision entered in the UTT Decision
Processing or UTT Initial Decision Entry page is approved or denied.

Approving or Rejecting Multiple UTT Decisions
Access the UTT Quick Decision Approval page (Student Admissions > UCAS Processing > UTT
Decision Approval > Quick Decision Approval).
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This example illustrates the fields and controls on the UTT Quick Decision Approval page.

Entering or Updating a UTT Confirmation Decision
Access the UTT Confirmation Entry page (Student Admissions > UCAS Processing > UTT Decision
Processing > Confirmation Entry).

This example illustrates the fields and controls on the UTT Confirmation Entry page (1 of 3).
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This example illustrates the fields and controls on the UTT Confirmation Entry page (2 of 3).

This example illustrates the fields and controls on the UTT Confirmation Entry page (3 of 3).

The fields on this page are similar to those on the UCAS Confirmation Entry page. Note that only
application records that are CF (decision is conditional offer, and reply is firm) or DF appear on the UTT
Confirmation Entry page regardless of whether a confirmation decision is pending or has been entered.
Also, application records for which a conditional offer has been made during Clearing appear on this
page.

Entering Multiple UTT Confirmation Decisions
Access the UTT Quick Confirmation page (Student Admissions > UCAS Processing > UTT Decision
Processing > Quick Confirmation).
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This example illustrates the fields and controls on the UTT Quick Confirmation page.

The fields on this page are similar to those on the UCAS Quick Confirmation page.

The search results logic of the UTT Quick Confirmation page is similar to UCAS Quick Confirmation
page except that the UTT search logic does not check whether the UTT choice is cancelled.

Approving or Rejecting a UTT Confirmation Decision
Access the UTT Confirmation Approval page (Student Admissions > UCAS Processing > UTT
Decision Approval > Confirmation Approval ).
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This example illustrates the fields and controls on the UTT Confirmation Approval page.

Approving or Rejecting Multiple UTT Confirmation Decisions
Access the UTT Quick Confirmation Approval page (Student Admissions > UCAS Processing > UTT
Decision Approval > Quick Confirmation Approval ).
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This example illustrates the fields and controls on the UTT Quick Confirmation Approval page.

Entering UTT Clearing Details
Access the UTT Enquiry Entry page (Student Admissions > UCAS Processing > UTT Decision
Processing > Enquiry Entry).
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This example illustrates the fields and controls on the UTT Enquiry Entry page . You can find definitions
for the fields and controls later on this page.

The Personal ID and Application Code fields look up values directly from the UCAS cvgName view.

Use the Transaction Type field to create a RX transaction for a Clearing enquiry. Use the Decision field
to enter U (Unconditional) or C (Conditional). After you record the Clearing details, run the Transaction
Processing process to generate the Clearing transactions to send to UCAS.

If you want to record a RX transaction, the UCAS Personal ID, UCAS Application Code, UTT Course
Code, Entry Year, Entry Month, Modular, Part Time, and Decision fields are required.
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Reviewing and Updating UTT Qualifications
Access the UTT Qualifications page (Student Admissions > UCAS Processing > UTT Decision
Processing > Qualifications)

This example illustrates the fields and controls on the UTT Qualifications page.

Reviewing UTT Transactions
Access the UTT Transactions page (Student Admissions > UCAS Processing > Transaction
Processing > UTT Transactions).
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This example illustrates the fields and controls on the UTT Transactions page.

The functionality of the UTT transactions page is similar to that of the UCAS Transactions page.
Additionally, most of the fields on the UTT Transactions page are similar to those on the UCAS
Transactions page.

When the decision is Interview, ensure that the interview date entered in the Transaction Code area
contains only the date without the time element.

Reviewing UTT Clearing Transactions
Access the UTT Enquiry Transactions page (Student Admissions > UCAS Processing > Transaction
Processing > UTT Enquiry Transactions).
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This example illustrates the fields and controls on the UTT Enquiry Transactions page.

Most of the fields on the UTT Enquiry Transactions page are similar to those on the UTT Transactions
page.

Connecting to the Apply API

This section describes additional procedures to connect to the Apply API as well as troubleshooting
information.

Configuring the Integration Broker
You need to set up these elements to ensure that you can connect to the Apply API.

Updating the REST Base URL

1. Go to PeopleTools >Integration Broker >Integration Setup >Service Operations.

2. In Service Operation, search for SAD_UC_DFE_APPL_GET.

3. Click Search.

4. In the results, click the service operation name.

5. In REST Base URL, provide the new URL.

6. Click Save.

7. Repeat steps 2 to 6 for SAD_UC_DFE_APPL_POST.
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Configuring the Routing Definition

You must set up the routing to connect to the API.

1. Go to PeopleTools >Integration Broker >Integration Setup >Routings.

2. Click Add New Value.

3. In Routing Name, enter SAD_UC_DFE_GET_APPL.

4. Click Add.

5. From the Routing Definitions page, provide these values:

• Service Operation: SAD_UC_DFE_APPL_GET

• Version: This field is automatically populated when you select the service operation.

• Description: DFE Get Applications

• Sender Node: Select the local node for the environment.

• Receiver Node: WADL_NODE

• Owner ID: Admissions — UK

6. Click Parameters.

a. In Outbound Request, Message.Ver into Transform 1, remove any value (if there’s any).

b. In Inbound Response, Message.Ver out of Transforms, remove any value (if there’s any).

7. Click Connector Properties.

a. In Gateway ID, enter LOCAL.

b. In Connector ID, enter HTTPTARGET.

c. In Delivery Mode, select Guaranteed Delivery.

d. In Connector Properties, delete any rows with values.

8. Click Save.

9. Repeat steps 3 to 7 for:

• Routing Name: SAD_UC_DFE_GET_POST

• Service Operation: SAD_UC_DFE_APPL_POST

• Description: DFE Post Applications

Configuring the Gateway

1. Go to PeopleTools >Integration Broker >Configuration >Gateways.
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2. In Integration Gateway ID begins with, enter LOCAL.

3. Click Search.

4. From the Gateways page, click Gateway Setup Properties.

5. Enter your user ID and password.

6. Click Advanced Properties Page.

7. In Gateway Properties, scroll to the end of the box and look for
UseDomainName.ExternalOperationNames.

The line looks similar to this:
#ig.UseDomainName.ExternalOperationNames=MYSOP1.v1,MYSOP2.v1.

8. When you locate the line:

• Remove the hashtag.

• Replace MYSOP1.v1,MYSOP2.v1 with SAD_UC_DFE_APPL_GET.v1,
SAD_UC_DFE_APPL_POST.v1.

It should look like this:
ig.UseDomainName.ExternalOperationNames=SAD_UC_DFE_APPL_GET.v1,SAD_UC_DFE_APPL_POST.v1

9. Click OK.

10. On the PeopleSoft Node Configuration page, click Save.

11. On the Gateways page, click Save.

Testing Your Connection

1. Go to PeopleTools >Integration Broker >Service Utilities >Service Operation Tester.

2. In Service, enter SAD_UC_DFE_API.

3. Click Search.

4. From the results, click the service operation name.

5. From the Service Operation page, click Populate Document Template.

6. From the URI Template Builder page, click since.

7. From the Set Value page, in Long, enter 2020-01-01T10:00:00Z.

8. Click OK, then click Return.

9. Click Invoke Operation.

You may get a 401 unauthorized error message. This is okay; it means that a connection to the Apply
API was successfully established.
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Troubleshooting
Here’s what you can do when you see these errors.

HTTPS Hostname Wrong

To resolve the error logged as Integration Gateway - External System Contact Error (158,10721), update
your gateway configuration. See Configuring the Integration Broker, “Configuring the Gateway.”

Untrusted Server Certificate Chain

To resolve this issue, you must upload the DFE API root certificate to your web server keystore.

Note: These steps assume you’re using Firefox as your browser. If you use another browser, you may
have to determine the corresponding steps.

1. On your browser, enter the REST base URL in the address field, then press Enter.

This is the same URL you used in “Updating the REST Base URL.”

2. In the URL field where you entered the REST base URL, click the lock icon. This icon is located on
the left of the URL.

3. In Connection, click the arrow to show connection details.

4. Click More Information.

5. From the window that appears, click View Certificate.

The Certificate Viewer appears.

6. Click Details.

7. In Certificate Hierarchy, select the topmost certificate: GlobalSign Root CA - R3.

8. Click Export, then save the certificate to a place in your hard drive.

If necessary, save the certificate as GlobalSign Root CA - R3.crt.

9. Using an FTP client, upload the certificate to your web server keystore folder. This is the path: /opt/
oracle/psft/pt/cfghome/webserv/peoplesoft/piaconfig/keystore.

10. Using PuTTY, import the certificate to your keystore folder. Enter this on the command line:

keytool -import -v -alias "GlobalSignRootCA-R3" -keystore /opt/oracle/psft/pt/cfghome/
webserv/peoplesoft/piaconfig/keystore/pskey -storepass Passw0rd -file /opt/oracle/psft/pt/
cfghome/webserv/peoplesoft/piaconfig/keystore/GlobalSignRootCA-R3.crt -trustcacerts

11. If the certificate already exists and you’re asked if you still want to add it or whether you trust this
certificate, answer Yes.

You should see this message: Certificate was added to keystore.

12. Bounce the web server, application server, and process server.

13. Log in to PIA, then go to PeopleTools >Security >Security Objects >Digital Certificats.
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14. Add a new row:

• Type: RootCA

• Alias: GlobalSignRootCA-R3

This is the alias you used when you imported the certificate to your keystore folder.

15. Click Add Root.

16. Using a text editor, open the certificate you saved (step 8) and copy the entire content of the file.

17. On the Add Root Certificate page, paste the certificate content in the text box.

18. Click OK.

19. Bounce the web server, application server, and process server.

20. Test your connection to the API. See Configuring the Integration Broker, “Testing Your Connection.”
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Understanding PBI Data Exchange

Campus Solutions provides the following processing capabilities to support institutions with the Tier 4
student visa requirements of the United Kingdom Visas and Immigration (UKVI):

• The collection of the data from overseas applicants and continuing students to allow Confirmation
of Acceptance for Studies (CAS) requests to be submitted in bulk to the UKVI via the Sponsor
Management System (SMS).

• The creation of XML files to transfer to SMS using Bulk Upload to request one or more CAS
numbers.

• The import of CAS details from XML files created by SMS using Bulk Export after the UKVI has
assigned CAS numbers.

• The generation of communications to notify an applicant or student of their assigned CAS number.

• The creation of XML files to transfer to SMS using Bulk Update in cases where the amount of fees
paid by the applicant or student has changed after the CAS number has been assigned.

• The generation of communications to notify an applicant or student of the changed fee details.

• The creation of XML files to transfer to SMS using Bulk Report to report on applicants or students
who have not enrolled or are not in attendance at your institution.

The following is an overview of how CAS requests are processed:

1. The institution creates CAS Details records in Campus Solutions for overseas applicants that require a
student visa or for continuing students that require an extension to an existing visa. The CAS Details
record can be created at the point the application is received or the institution may wish to wait until
the applicant has accepted an offer of admission before creating the record.

2. The institution requests the CAS number for the applicant or student either by submitting a bulk
upload XML file created from Campus Solutions to SMS or by submitting an individual request for
an applicant or student directly to the UKVI portal.

3. SMS processes each record and, if the processing is successful, assigns a CAS number and status
(Assigned) to each record. The institution can use Campus Solutions to import these updates, which
contain the CAS number, from a bulk export XML file generated from SMS.

4. The institution is responsible for passing the CAS number on to the applicant or student.

5. The applicant or student can then use the CAS number to apply for his or her student visa.

6. The institution can modify existing CAS records in SMS (for example, when students pay the tuition
fees and you want to modify the CAS records for these students in SMS). To update the CAS records

Copyright © 1988, 2021, Oracle and/or its affiliates. 1067



(GBR) Managing PBI Data Exchange Chapter 28

the institution can use Campus Solutions to create a Bulk Update XML file and submit the file to
SMS.

7. When the applicant or student submits the visa application, UKVI updates the CAS status in SMS
to Used. The institution can view the updated CAS record by signing into SMS or by using Campus
Solutions to import the updated records from a bulk export XML file generated from SMS.

8. The institution can use Campus Solutions to fulfill their reporting duties for applicant or student who
have failed to enroll or are not in attendance. The institution can use Campus Solutions to create a
Bulk Report XML file that contains data of students who have used a CAS number supplied by the
institution but have not registered or enrolled.

Note: The academic institution and SMS exchanges the applicant and student data in XML format.
Review the Bulk Data Transfer Toolkit available from the UKVI website. This toolkit provides details on
the XML files such as the XML schema, examples of export and import XML files, and validation rules.

See the UK Visas and Immigration website

The CAS Maintenance component and the CAS Record Update process are used to create and manage
CAS Details records and prepare records for inclusion a Bulk Upload file to request CAS numbers from
the UKVI. An optional verification step can be built into the process to allow the request details to be
reviewed before the request is sent.
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This diagram illustrates the process for creating and maintaining CAS Details records.

Once records are ready to be sent to the UKVI the Create Extract process, the Upload Extract Data
component and the Create and Validate XML processes are used to create and review upload records and
to generate the XML file for transfer to SMS.
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This diagram illustrates the process for creating and sending the Bulk Upload XML file to SMS.

After you submit the CAS number requests to SMS, the UKVI assigns a CAS number to the applicant
or student. You can generate a Bulk Export XML file from SMS and import the details using the Import
CAS Details process.

Download the XML file and load the XML data into Campus Solutions using the import process. The
process will update the CAS Number and CAS Status details for matched. Unmatched records can be
reviewed using the CAS Staging Data component, match details added and the records re-processed.

You can also import subsequent CAS status changes from SMS when the UKVI updates the status to
one of the post-assigned values: Used (when the applicant has used the CAS number to apply for a visa),
Cancelled, Expired, Obsolete and Withdrawn.
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This diagram illustrates the process for importing CAS Details.

Once the CAS number has been assigned any changes to the fees paid fields need to be reported to the
UKVI via the Bulk Update file. When any of the fees paid fields is updated for CAS records that have a
CAS number, the system automatically sets the Update Status to the status defined for Update Required.
The Create Extract process can then be run to select these records for inclusion in the Bulk Update XML
file. You can choose to follow an optional verification step before setting the Update Status to Update
Ready.

While the CAS status is Assigned a CAS record can be included in multiple Bulk Updates as the fees paid
values change over time. Once the CAS Status is updated to one of the post-assigned values then further
updates for the fees paid fields are not required.
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This diagram illustrates the process for preparing CAS records for inclusion in the Bulk Update XML file.
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This diagram illustrates the process for creating the Bulk Update XML file.

CAS records need to be submitted to SMS in the Bulk Report file if the applicant or student has used the
CAS number in their visa application but is not attending your institution. You can set the Report Status
to indicate the applicant or student is not attending. Once you have set this status, the Create Extract Data
process can be used to select record for inclusion in the Bulk Report XML file.
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This diagram illustrates the process for preparing records for inclusion in the Bulk Report XML file.
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This diagram illustrates the process for creating the Bulk Report XML file.

See Understanding PBI Field Derivation

Preparing for PBI Data Exchange

Before you start importing and exporting SMS data, you must set up Campus Solutions as follows:

• Enable the PBI functionality for all institutions or for a specific institution.

• Set up a PBI configuration record.

• Set up CAS statuses.
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• Define the UKVI Sponsor License Number for partner institutions.

• Enter the PBI data for academic programs.

• Enter the PBI data for academic plans.

• Set up PBI communications.

• Configuring common attributes for PBI.

Defining field values at the configuration level

You can define default values for fields in the Upload extract on the PBI Configuration page if you do
not want to specify field values separately at the program and plan levels or at the individual CAS record
level.

Defining field values at the academic program and plan levels

For a particular academic program or plan, the value that your institution wants to include in the Upload
or Update extract for one or more fields may be the same for all the applicants or students for that
academic program or plan. Use the Academic Program and Academic Plan PBI Data pages to define field
values at program and plan level respectively, rather than using the CAS Maintenance component to enter
field values for each individual applicant or student.

If the same value applies to all academic plans associated with an academic program the value can
be defined at academic program level only. The defined values are used to default the values for the
corresponding fields when a new CAS Details record is created.

Defining field values at the CAS record level

You can choose to enter or update field values at the applicant or student level using the CAS
Maintenance component.

See Creating and Maintaining CAS Details

Note

For most fields the extract process will first look at the CAS Details record to derive a field value. In
most cases if a default value has been defined at Academic Plan, Academic Program or Configuration
level then the field will be automatically populated in the CAS Details record when it is created. For some
fields if a value has not been defined at that CAS Details level, then the process will look at the Academic
Plan level. If a value has not been defined at the Academic Plan level, then it looks at the Academic
Program level. If a value has not been defined at Academic Program level, finally it derives the field
value from the Configuration level.

Refer to the PBI Field Derivation documentation for information about derivation of the individual fields.
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Pages Used to Prepare for PBI Data Exchange

Page Name Definition Name Navigation Usage

SA Features SCC_INSTALL_SA2 Set Up SACR >
Install > Student Admin
Installation > SA Features

Enable the PBI pages and
links in Campus Solutions.

Academic Institution 6 SSR_INST_FEATURES Set Up SACR > Foundation
Tables > Academic
Structure > Academic
Institution Table >
Academic Institution 6

Enable the PBI pages and
links in Campus Solutions for
a specific institution.

PBI Configuration SAD_PB_CONFIG Student Admissions >
PBI Processing > PBI
Configuration

Create a PBI configuration
record. Enter the sponsor
license numbers of your
institution and campuses.
 Also, specify field and course
date defaults, and applicant
and student communication
details.

Statuses SAD_PB_CONFIG1 Student Admissions >
PBI Processing > PBI
Configuration > Statuses

Define the various processing
statuses for CAS records.

Regional SAD_UC_SCHOOL_SBP Campus Community >
Organization > Create/
Maintain Organizations >
Organization Table >
Regional

Define the UKVI Sponsor
License Number for an
external organization being
reported to UKVI as a Partner
Institution.

Academic Program PBI Data SAD_PB_PROG Set Up SACR > Foundation
Tables > Academic
Structure > Academic
Program Table > PBI Data

Specify field values at
program level.

Academic Plan PBI Data SAD_PB_PLAN Set Up SACR > Foundation
Tables > Academic
Structure > Academic Plan
Table > PBI Data

Specify field values at plan
level.

Enabling the UK Fields for All Institutions
Access the SA Features page (Set Up SACR > Install > Student Admin Installation > SA Features).

Select the PBI check box to enable PBI pages, fields, and links fields in Campus Solutions.
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Enabling the UK Fields for a Specific Institution
Access the Academic Institution 6 page (Set Up SACR > Foundation Tables > Academic Structure >
Academic Institution Table > Academic Institution 6).

Select the PBI check box to enable PBI pages, fields, and links in Campus Solutions for a specific
institution.

Setting Up a PBI Configuration Record
Access the PBI Configuration page (Student Admissions > PBI Processing > PBI Configuration).

This example illustrates the fields and controls on the PBI Configuration page . You can find definitions
for the fields and controls later on this page.

Field or Control Description

Enable Sub-Plan Reporting Select the check box for Sub-Plans to be considered in the
derivation of Course Title in the Upload extract.

Sponsor License Number Enter your institution's license number. The value is used to
derive the corresponding field in the Upload extract.

Use the Tier ID, Category and Schema ID fields to specify the values that are used to derive the
corresponding fields in the Upload extract.
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Field or Control Description

Main Site of Study Enter the Location if the same Main Site details are reported
in the Upload extract for all CAS records for your institution.
 The value is displayed as the default Main Site on the CAS
Details page. The value is used in the derivation of the Main
Site address fields in the Upload extract if no Reported Site is
defined in the individual CAS Details record.

Field Defaults

Use this region to specify default field values for new CAS records. The system uses a Field Defaults
value as a default value in a new CAS Details record only if the value is not defined at the program or
plan level.

Admit Term Defaults

For each term, define the values that are used to populate the fees and course date fields in new CAS
records if no values are defined at plan or program level. The Latest Acceptance Date should be on or
after the Course Start Date.

Field or Control Description

Cohort Tag (Optional) Select the appropriate cohort tag as set up for your
institution.

Use this field to allow different dates and fees to be defined
for different cohorts within the same Admit Term. The value
you set in this field is used by the CAS Details component as
well as the processes that are used to add new CAS records to
evaluate the default dates and fees for an applicant or student.

Communication Details

Use this region to set up the event IDs that are used in the communication generation process to notify
applicants or students about their CAS number or fee updates.

Field or Control Description

Notification Type Indicate whether you want to notify CAS Number or Fee
Update.

Record Type Indicate whether you want to notify the applicant or student.
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Field or Control Description

Event ID Select the event ID that you want the system to assign the
applicant or student.

You can select only event IDs defined for the CASN
administrative function in Campus Community. The CASN
function captures Academic Career, Career Number and
CAS Number as variable data. Refer to "Setting Up PBI
Communications" in this section for information about the
event ID setups.

The system assigns an event ID for CAS Number notification type to a person when the Import CAS
Details process loads the CAS number from the inbound XML file for the first time.

For more information about how the process assigns event IDs for CAS Number notification, see
Importing CAS Details.

The system assigns an event ID for Fee Update notification type when the Create Extract process creates
the update extract data.

You can create one or more communication records using the Communication Generation process to
notify applicants or students about their CAS number or fee updates.

Campus Details

Use this region to specify Sponsor Licence Numbers for individual Campuses if your institution has a
different licence number for a particular campus. The value is used to derive the corresponding field in
the Upload extract based on the Campus value of the applicant or student in place of the value defined for
your institution. If no value is defined the value defined for the institution is used.

Setting up CAS Statuses
Access the Statuses page (Student Admissions > PBI Processing > PBI Configuration > Statuses).

This example illustrates the fields and controls on the Statuses page. You can find definitions for the fields
and controls later on this page.
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Field or Control Description

Apply Academic Org Security (apply academic organization
security)

Select to have the Create Extract process choose only that
CAS record for which the user ID has access to at least one
academic organization.

Clear this check box if you want the process to choose a CAS
record regardless of whether the user ID has access to the
related academic organization.

Refer to the following "Applying Academic Organization
Security to the Create Extract Process" topic for more
information about this setup.

New CAS Record Choose an Upload status value that the system assigns to new
CAS records. If you do not choose a value, the system assigns
a blank Upload status.

Upload Ready Choose an Upload status value. The Create Extract Data
process uses this value to select CAS records for inclusion in
the Upload extract.

Upload Complete Choose an Upload status value. The Create Extract Data
process uses this value to create a new effective dated record
to indicate that a CAS record has been included in the Upload
extract.

Update Required Choose an Update status value that the system assigns to
CAS records where the CAS number has been imported and a
subsequent change is made to one of the fees paid fields.

Update Ready Choose an Update status value. The Create Extract Data
process uses this value to select records for inclusion in the
Update extract.

Update Complete Choose an Update status value. The Create Extract Data
process uses this value to create a new effective dated record
to indicate that a CAS record has been included in the Update
extract.

Report Ready Choose a Report status value. The user uses this value to
indicate that a record is ready to be included in the Report
extract. The Create Extract Data process uses this value to
select records for inclusion in the Report extract.

Report Complete Choose a Report status value. The Create Extract Data process
uses this value to create a new effective dated record to
indicate that a CAS record has been included in the Report
extract.

Statuses are delivered as translate values for Upload (SAD_PB_UPLOAD), Update (SAD_PB_UPDATE)
and Report (SAD_PB_REPORT). You can amend or add to the translate values as required.
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If additional verification steps are required before a CAS record is ready for inclusion in the Upload
extract, additional interim statuses can be defined and used to manage individual CAS records. Additional
statuses can be defined and used to prevent CAS records from being included in the Upload extract if
required.

If a verification step is required between one of the fees paid values being updated and the record being
included in the Update extract, different status values can be defined for Update Required and Update
Ready. If no verification step is required the same status value for Update Ready can be used for both
fields.

Note: To allow records to be retrieved using the single Processing Status search field in the CAS
Maintenance component it is recommended that distinct status values are defined for Upload, Update and
Extract.

The following is a scenario on how the statuses work where there are verification steps before a CAS
record is included in an extract:

1. Use PeopleTools to create additional status values required. For example: new Upload Statuses of
Upload Exclude and Upload Pending and a new Update Status of Update Pending.

2. Use the Statuses page to define the required values.

3. Use the CAS Maintenance component to create CAS records. The Upload Status is automatically set
to New when you create the records.

4. Use the CAS Record Update process or CAS Details page to set the Upload Status to Upload Exclude
for records that should be excluded from the Upload extract. For example, for a second CAS record
for an applicant where the previous CAS record has already been sent and a CAS number requested.

5. Use the CAS Record Update process or CAS Details page to set the Upload Status to Upload Pending
for records where all the details have been entered and the record needs to be verified before it is
included in an Upload extract.

6. Use the CAS Record Update process or CAS Details page to change the Upload Status from Upload
Pending to Upload Ready for records that have been verified and are ready to be included in an
Upload extract.

7. Run the Create Extract Data process with the Create Upload option selected. The process picks up
only those records that have an Upload Status of Upload Ready.

8. After including the record data in the extract, the Create Extract Data process sets the Upload Status to
Upload Complete and saves the Upload File ID to each CAS record included.

9. After importing the CAS number, when you update the fees paid details on the CAS Details page, the
system automatically sets the Update Status to Update Required.

10. Use the CAS Record Update process or CAS Details page to set the Update Status to Update Pending
for records where the fees paid changes need to be verified before the record is included in an Update
extract.

11. Use the CAS Record Update process or CAS Details page to change the Update Status from Update
Pending to Update Ready for records that have been verified and are ready to be included in an
Update extract.
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12. Run the Create Extract Data process with the Create Update option selected. The process picks up
records that have an Update Status of Update Ready.

13. After including the record data in the extract, the Create Extract Data process sets the update status to
Update Complete.

14. Use the CAS Record Update process or CAS Details page to set the Report Status to Report Ready for
the CAS records where the CAS number has been used and the applicant or student has not enrolled at
your institution.

15. Run the Create Extract Data process with the Create Report option selected. The process picks up
only those records that have a Report Status of Report Ready.

16. After including the record data in the extract, the Create Extract Data process sets the status to Report
Complete.

Applying Academic Organization Security to the Create Extract Process

These are the high-level steps to set up academic organization security for the Create Extract process:

1. Select the Apply Academic Org Security on the Statuses page.

2. Use the Academic Org Security page to grant or restrict access to academic organizations (Set Up
SACR, Security, Secure Student Administration, User ID, Academic Org Security, Academic Org
Security). Only those academic organizations defined using the Tree Manager are available for
selection on the Academic Org Security page.

See "Defining Academic Organizations" (Campus Solutions Application Fundamentals)

See "Securing Academic Organizations" (Campus Solutions Application Fundamentals)

3. Use the Taxonomy/Campus page to link academic programs to academic organizations (Set Up
SACR, Foundation Tables, Academic Structure, Academic Program Table, Taxonomy/Campus).

If you are not linking programs, link plans as described in the next step.

4. Use the Owner page to link academic plans to academic organizations (Set Up SACR, Foundation
Tables, Academic Structure, Academic Plan Table, Owner).

If you are not linking plans, link programs as described in the previous step.

The Create Extract process performs the following steps if you select the Applying Academic
Organization Security check box on the Statuses page:

Step 1: Select the program and plan for the CAS record

For a CAS record with type = applicant:

• Select the academic program from the latest effective dated Campus Solutions admission application
record (the CAS Details page displays this record).

• Select the reported plan from the CAS Details record or if the reported plan does not exist, then
select the plan that starts with the lowest alphabet from the latest effective dated Campus Solutions
admission application record. For example, suppose if the reported plan does not exist and there are
two plans: Biology and Zoology. Then, select Biology.
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For a CAS record with type = student:

• Select the academic program from the latest effective dated Campus Solutions student program record
(the CAS Details page displays this record).

• Select the reported plan from the CAS Details record or if the reported plan does not exist, then select
the plan that starts with the lowest alphabet from the latest effective dated Campus Solutions student
program record.

Step 2: Use the Taxonomy/Campus and Owner pages to find out the academic organizations that are
linked with the selected academic program and academic plan.

Step 3: Use the Academic Org Security page to find out whether the user ID that you are using to run the
Create Extract process has access to the academic organizations.

Step 4: If the user ID has access to the academic organization, include the CAS record in the extract.

Entering the PBI Data for an Academic Program
Access the Academic Program PBI Data page (Set Up SACR > Foundation Tables > Academic
Structure > Academic Program Table > PBI Data).

This example illustrates the fields and controls on the Academic Program PBI Data page. You can find
definitions for the fields and controls later on this page.

This page appears only if you have selected the PBI check box on the Academic Institution 6 or SA
Features page. The values defined are used to populate the corresponding fields in new CAS records if no
value is defined for the field at plan level. Values are also used during field derivation.
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Field or Control Description

Cohort Tag (Optional) Select the appropriate cohort tag as set up for your
institution.

Use this field to allow different dates and fees to be defined
for different cohorts within the same Admit Term. The value
you set in this field is used by the CAS Details component as
well as the processes that are used to add new CAS records to
evaluate the default dates and fees for an applicant or student.

The Placement Percentage, Placement Justification, and Placement Organisation fields become available
for entry if you select Yes in the Work Placement field. The Reason SELT Not Required field becomes
available for entry if you select No  in the SELT Required field.

Refer to the PBI Field Derivation documentation for information about derivation of the individual fields.

Entering the PBI Data for an Academic Plan
Access the Academic Plan PBI Data page (Set Up SACR > Foundation Tables > Academic
Structure > Academic Plan Table > PBI Data).

This example illustrates the fields and controls on the Academic Plan PBI Data page.

This page appears only if you have selected the PBI check box on the Academic Institution 6 or SA
Features page. The values defined are used to populate the corresponding fields in new CAS records.
Values are also used during field derivation.
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Field or Control Description

Cohort Tag (Optional) Select the appropriate cohort tag as set up for your
institution.

Use this field to allow different dates and fees to be defined
for different cohorts within the same Admit Term. The value
you set in this field is used by the CAS Details component as
well as the processes that are used to add new CAS records to
evaluate the default dates and fees for an applicant or student.

Refer to the PBI Field Derivation documentation for information about derivation of the individual fields.

Setting Up PBI Communications
You must set up Campus Community communications to notify applicants and students about their
assigned CAS numbers or fee update details. This section discusses the steps required to define the Event
ID values that are used in the PBI Configuration page, the Import CAS Details process (for CAS Number
notification), the Create Extract - update process (for Fee Update notification), the 3C Engine process and
the Communications Generation process to create communications to notify applicants and students.

For more information on setting up communications, see:

• "Understanding Communication Management" (Campus Community Fundamentals)

• "Understanding the 3C Engine" (Campus Community Fundamentals)

This section provides communications setup examples for sending CAS number notifications to
applicants and students. Similar setups are required for Fee Update notification. The Fee Update
notification should contain the relevant update data: First Year Course Fees, Course Fees Paid,
Accommodation Fees Paid, and Boarding Fees Paid.

The PeopleSoft system provides a CASN administrative function that captures the variable data
required to identify the CAS record that has been updated. The variable data can be used to generate
communications, checklists or comments associated with an Event ID. No further setup is required for
this function.

The following variable data is automatically populated from the incoming CAS record:

• Academic Career

• Student Career Number

• CAS Number
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This example shows the CASN administrative function.

To access the Administrative Function table, select Set Up SACR >Common
Definitions >Administrative Function Table.

Creating Queries

Access the Query Manager page (Reporting Tools >Query >Query Manager).

The PeopleSoft system delivers example queries, one for CAS Number notifications to
applicants (QA_SAD_PB_CASA) and one for CAS Number notifications to continuing students
(QA_SAD_PB_CASB).

Create your own queries to select all the data you require for your communications. Refer to "Defining
Communication Data Sources" in this section for information about data sources.

Each query requires the following:

• The core record must be included in the query associated with the administrative function. For the
CASN function, the CAS Details record (SAD_PB_CAS) must be included.

• A prompt must be created for the applicant/student ID. The Unique Prompt Name must be changed to
Person_ID.

• Prompts must also be created for the variable data fields relating to the administrative function,
ACAD_CAREER, STDNT_CAR_NBR and SAD_PB_CAS_NUMBER.
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This example shows the selected fields for the QA_SAD_PB_CASA query.

This example shows the selected records for the QA_SAD_PB_CASA query.

This example shows the selected fields for the QA_SAD_PB_CASB query.
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This example shows the selected records for the QA_SAD_PB_CASB query.

Defining Communication Data Sources

Access the Communication Data Source page (Campus Community >Communications >Set up
Communications >Communication Data Source).

Define Communication Data Sources for each query.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1089



(GBR) Managing PBI Data Exchange Chapter 28

This example shows the CASA data source map ID.
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This example shows the CASB data source map ID.

Defining Report Definitions

Access the Definition page (Reporting Tools >BI Publisher >Report Definition).

Example templates are delivered that can be used in Report Definitions for CAS Number notifications
to applicants (CASA_1) and CAS Number notifications to students (CASB_1). The templates have been
created from the XML file downloaded from each Data Source using Oracle BI Publisher.

Create your own template files. There are several possible methods including installing BI Publisher for
Word which creates a new menu option in Word. A template can then be created from the XML document
downloaded from the Data Source page.
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This example shows the Definition page for CASA.

This example shows the Template page for CASA.
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This example shows the Definition page for CASB.

This example shows the Template page for CASB.

Defining Standard Letters

Access the Standard Letters page (Campus Community >Communications >Set up
Communications >Standard Letter Table).

Create standard letters for applicants and students. Select Report Name to add the details.
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This example shows the Standard Letters page for CSA.
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This example shows the Standard Letters page for CSB.

Defining Communication Contexts

Access the Communications Context page (Campus Community >Communications >Set up
Communications >Communications Context Table).

Create communication contexts for applicants and students.
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This example shows Communications Context page for CASA.

This example shows Communications Context page for CASB.

Defining Communication Categories

Access the Communications Category page (Campus Community >Communications >Set up
Communications >Communications Category Table).

Create communication categories for applicants and students using the CASN administrative function and
the communication contexts created in the previous step.
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This example shows the Communications Categories page for CASA.

This example shows the Communications Categories page for CASB.

Defining Communication Speed Keys

Access the Speed Key Table page (Campus Community >Communications >Set up
Communications >Speed Key Table).

Create speed keys for applicants and students using the CASN administrative function and the
communication contexts and categories created in the previous steps.
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This example shows the Communications Speed Keys page for CASA and CASB.

Defining Communication 3C Groups

Access the Communication 3C Groups page (Campus Community >Communications >Set up
Communications >Communication 3C Groups).

Define the new categories for the appropriate Communication 3C Groups for the user depending on your
institution's group setup (Set Up SACR, User Defaults, User 3C Group Summary).
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This example shows the Communication 3C Groups page for CASA.

This example shows the Communication 3C Groups page for CASB.

Creating Event Definitions

Access the Event Definition page (Campus Community >3C Engine >Set Up 3C Engine >Event
Definition).

Define events using the CASN administrative function and communication keys defined in previous
steps. Additional communications, comments or checklists can be added to the events if required.
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This example shows the Event Definition page for CASA.

This example shows the Event Definition page for CASB.
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Defining Event 3C Groups

Access the Event 3C Groups page (Campus Community >3C Engine >Set Up 3C Engine >Event 3C
Groups).

Define the new event IDs for the appropriate Communication 3C Groups for the user depending on your
institutions group setup (Set Up SACR, User Defaults, User 3C Group Summary).

This example shows the Event 3C Groups page for CASA.

This example shows the Event 3C Groups page for CASB.

Related Links
Generating PBI Communications
"Understanding Communications Setup" (Campus Community Fundamentals)

Configuring Common Attributes for PBI
Common Attribute Framework is enabled for the CAS Details page (SAD_PB_CAS) with a delivered
record context. You can use this framework to add an additional fields link and secondary page to the
CAS Details page. For more information on the CAS Details page, see the next section:
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Creating and Maintaining CAS Details

For information on using Common Attribute Framework, refer to the Campus Community — Common
Attribute Framework documentation.

See "Understanding Common Attribute Framework" (Campus Community Fundamentals)

This example shows the delivered record context for SAD_PB_CAS.
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This example shows the delivered record context for SAD_PB_CAS.

When you add a minimum of one attribute to this record context, the Additional Details link will appear
on the CAS Details page. Click that link to capture additional data. If no attribute is added to this record
context, the CAS Details page will not display the link.

Creating and Maintaining CAS Details

You can use the CAS Maintenance component to create and update CAS records.

The CAS Maintenance component has a CAS Details page and a Report Details page. Use the pages to
enter upload, update and report extract field values at the application or student career level.

This section discusses how to:

• Create new CAS records for individuals

• Create new CAS records for groups of students

• Review existing CAS records.

• Enter or update PBI upload/update data.

• Enter or update PBI report data.
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Pages Used to Create and Maintain CAS Details

Page Name Definition Name Navigation Usage

CAS Details SAD_PB_CAS • Student Admissions >
PBI Processing > CAS
Maintenance > CAS
Details

• Student Admissions >
Application Entry >
CAS Maintenance

• Student Admissions >
Application
Maintenance >
Maintain
Applications >
Application Program
Data > CAS Details

• Records and
Enrollments >
Career and Program
Information > Student
Program/Plan >
Student Program >
CAS Details

Enter or update upload
and update field values for
a CAS Details record at
the application or student
program level

Create CAS Records SAD_PB_CAS_CRT Recruiting and
Admissions >PBI
Processing >Create CAS
Records

Create CAS Details records
using Population Selection.
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Page Name Definition Name Navigation Usage

Report Details SAD_PB_CASREPDTLS • Student Admissions >
PBI Processing > CAS
Maintenance > Report
Details

• Student Admissions >
Application Entry >
CAS Maintenance

• Student Admissions >
Application
Maintenance >
Maintain
Applications >
Application Program
Data > CAS Details >
Report Details

• Records and
Enrollments >
Career and Program
Information > Student
Program/Plan >
Student Program >
CAS Details > Report
Details

Enter or update report field
values for a CAS Details
record at the application or
student career level.

Creating New CAS Records for Individuals
You can use the CAS Maintenance component to add new CAS Details records.

Applicants

New CAS records can be added for applicants that require a student visa using the CAS Maintenance
component. You can access this component from the Applicant Entry or PBI Processing menus or by
clicking the CAS Details link on the Application Program Data page in the Maintain Applications
component. Select a record type of Applicant to add a new record.

Continuing Students

New CAS records can be added for continuing students that require an extension to an existing visa. To
add new CAS records for continuing students use the CAS Maintenance component from the menus or
click the CAS Details link on the Student Program page. Select a record type of Student to add a new
record.

Adding CAS Records

Add a CAS record for each CAS request. You can add multiple CAS records for an application or student
program record. In such a case, the system defaults the record number to 1 for the first CAS record and
increments the record number as you add new records for the application or student program record.
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Note that the Import CAS Details and the Import Applicant Data processes can also create new CAS
records.

See Importing CAS Details

See Setting Up UCAS and Teacher Training Options

Creating New CAS Records for Groups of Students
Access the Create CAS Records page (Recruiting and Admissions >PBI Processing >Create CAS
Records).

Field or Control Description

Academic Institution Select the institution. Only records that have a matching value
from Population Selection are created.

Record Type Select a value to create CAS records for either an applicant or
student.

Population Selection

Population selection is a method for selecting the IDs to process for a specific transaction. The Population
Selection group box is a standard group box that appears on run control pages when the Population
Selection process is available or required for the transaction. Selection tools are available based on the
selection tools that your institution selected in the setup of the Population Selection process for the
application process and on your user security. Fields in the group box appear based on the selection tool
that you select. The fields act the same from within the group box no matter what run control page you are
on or what transaction you are processing.

See "Using the Population Selection Process" (Campus Community Fundamentals).

Field or Control Description

Query Name These sample queries are provided:

• SAD_PB_CAS_CREATE_APPLICANT: This query
picks up admitted applications for a particular term where
the Official Residency record is “Overseas” (OVS). The
admit term of the application is matched to the effective
term of the Residency record. The Admit Term is selected
using Edit Prompts.

• SAD_PB_CAS_CREATE_STUDENT: This query picks
up active student program records where the student has
a T4S (tier 4 student) visa record with an expiration date
prior to the end date of the Expected Graduation Term.

If you create your own queries, make sure you include the following fields for:
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• Record Type of Applicant: EMPLID, INSTITUTION, ACAD_CAREER, ADM_APPL_NBR, and
APPL_PROG_NBR

• Record Type of Student: EMPLID, INSTITUTION, ACAD_CAREER and STDNT_CAR_NBR

Parameters

Field or Control Description

Effective Date (Optional) Enter the date to be used for creating new records.
 The date you enter replaces the current date.

Upload Status By default, this value is set to New.

Course Start Date, Latest Acceptance Date, Expected End
Date, First Year Course Fees, First Year Boarding Fees

(Optional) If you do not enter values, the values default in the
same way as new records that are added via the CAS Details
page.

Reviewing Existing CAS records
You can use the CAS Maintenance component to search for existing CAS Details records.

Search for existing records by entering criteria on the search page. The search values for Academic
Institution, Academic Career and Admit Term are defaulted from the values defined on the User Defaults
pages.

Records with a particular Upload, Update or Report Status can be selected by adding a value in the
Processing Status field. For example, select Update Complete in the Processing Status field of the search
page to search for records that the Create Extract process has included in an Update extract.

Note: To allow records to be searched for using the Processing Status field it is recommended that distinct
status values are defined for Upload, Update and Extract. Refer to "Setting up CAS Statuses" for more
information.

See Setting up CAS Statuses

For users to have access to CAS records for applications of particular application centers using the
Application Entry menu, you must grant the users access to these application centers via the Application
Center Security page.

See "Setting Security for Application Centers" (Campus Solutions Application Fundamentals)

Security is not applied when the record type is student or when records are accessed using the PBI
Processing menu.

Entering PBI Data for Applicants or Students
Access the CAS Details page (Student Admissions >PBI Processing >CAS Maintenance >CAS
Details).
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This example illustrates the fields and controls on the CAS Details page. You can find definitions for the
fields and controls later on this page.

You can use the CAS Details page to view a CAS record's history of changes throughout its processing
cycle. Each history change record has a unique Effective Date and Sequence Number combination.

Field or Control Description

First Name, Middle Name, and Last Name Displays the values from the most recent effective-dated
primary name record for the person.

Personal Information Click to navigate to the Biographical Details page of the Add/
Update a Person component.

View Long Name Click to access the Manage Long Name page.

This link appears only when there is a long names record
associated with the primary name record

Upload Status Identifies whether the record has been identified as:

• Newly added (New or blank)

• To be included in the Upload extract (Upload Ready)

• Included in the Upload extract (Upload Complete)

Once the CAS Number and Status have been imported the
system makes this field non-editable.

Upload File ID Displays the File ID generated when the record is included in
the Upload extract.
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Field or Control Description

CAS Number, Export File ID, CAS Status, andCAS Status
Date

Displays the values imported using the Import CAS Details
process.

The CAS Number field is used to derive the corresponding
field in the Update and Report extracts.

Update Status Identifies whether the record has been identified as:

• Requiring inclusion in the Update extract (Update
Required)

• To be included in the Update extract (Update Ready)

• Included in the Update extract (Update Complete)

The system enables this field once the CAS Number and
Status has been imported and the CAS Status is Assigned.
 Once the CAS Status is updated to one of the post-assigned
values, for example, Used, the field becomes non-editable.

Once the CAS Status is Assigned, the system will
automatically update the Update Status to Update
Required when changes are made to the Course Fees Paid,
 Accommodation Fees Paid or Boarding Fees paid values.

Update File ID Displays the File ID generated when the record is included in
the Update extract. If the record is included in multiple Update
extracts the most recent Update File ID is displayed in the
current effective date/sequence record.

User ID Indicates the User ID and name of the user who last updated
the record.

If the Create Extract Data or Import CAS Details process
updated the record, the User ID field indicates the user who
ran the process.

Applicant Details

The following is an example of the Applicant Details region on the CAS Details page.
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This example illustrates the fields and controls on the Applicant Details region – CAS Details page. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Report Month/Year Only Select to include the date of birth in CCYY-MM format in the
Upload extract

Report Year Only Select to include the date of birth in CCYY format in the
Upload extract.

UCAS Personal ID Displays the value imported from UCAS.

The system selects this value from External System ID records
with ID type UC or UP. The most recent effective dated record
is displayed. The same value is derived for the corresponding
field in the Upload extract when the record type is Applicant.

Click the link to navigate to the UCAS Applicant Summary
page.

Note: The UTT Personal ID is not included in the CAS Details
page. Therefore, the UCAS Personal ID link is not functional
for UTT applicants. To access a UTT application, select the
Maintain Applications link on the header region of the CAS
Details page, and then select the Personal ID link on the
Application Program Data page.

Nationality Displays the country value of the non-EU Citizenship record
for the applicant or student.
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Field or Control Description

Select Nationality Click if you want to change the default value or select a new
value for the Nationality field.

If multiple non-EU Citizenship records exist on the Campus
Community Citizenship/Passport page, then the record
with the lowest country code is displayed by default in
the Nationality field and the link is displayed to allow an
alternative record to be selected.

Passport Number Displays the passport number of the record associated with the
Citizenship record displayed in the Nationality field.

Select Passport Click if you want to change the default value or select a new
value for the Passport field.

If multiple Passport records exist on the Campus Community
Citizenship/Passport page for the selected Nationality ,
 then the passport record with the most recent Issue Date is
displayed by default in the Passport Number field and the
link is displayed to allow an alternative record to be selected.
 Passport records with an Expiration Date in the past are not
considered.

Partner Institution and Overseas Institution The system automatically populates this field when a new
CAS record is created. The value is populated from the
Academic Plan PBI data page if a value is defined for the
Academic Plan of the application or student career. If a value
is not defined for the Academic Plan, the value is populated
from the Academic Program PBI data page if a value is
defined for the Academic Program of the application or
student career.

Enter an external ID value if the value has not been set up on
the Academic Program or Plan PBI data pages or if you want
to enter a different value for the applicant or student.

The Overseas Institution prompt is restricted to organizations
where the primary location has a country other than GBR.

SELT Required The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page, (b) Academic Program PBI
Data page, or (c) PBI Configuration page. If default value does
not exist at these three levels, then the system sets the field as
blank.
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Field or Control Description

Reason SELT Not Required This field becomes available when the value is No in the SELT
Required field.

The value is populated from (a) Academic Plan PBI Data page
or (b) Academic Program PBI Data page. If default value does
not exist at these two levels, then the system sets the field as
blank.

English Level Attained, Test Provider, English Reading Level,
English Speaking Level, English Listening Level, and English
Writing Level

These fields become available when the value is Yes in the
SELT Required field.

Note: Fields related to personal details, such as Date of Birth, Gender, Birth Country and Birth Location,
display values from the core person record. This is different from the Nationality and Passport Number
fields whose values the system stores in the CAS Details record rather than just display the values from
the core person record.

Course Details

The following is an example of the Course Details region on the CAS Details page.

This example illustrates the fields and controls on the Course Details region – CAS Details page. You can
find definitions for the fields and controls later on this page.
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Field or Control Description

Academic Plan For record type Applicant, if multiple plans exist in the
Application Plan Data record, the field displays the plan code
which is alphabetically lowest.

For record type Student, if multiple plans exist in the Student
Program/Plan record, the field displays the plan code which
has lowest sequence number

Reported Plan Select an alternative plan if the required value is different to
the default value displayed in the Academic Plan field. This
value will be used in place of the Academic Plan in deriving
values in the Upload extract.

Course Title Override Enter the course title that the system uses in the Upload
extract. The system uses this value in place of the subplan
level values or plan level values in the Upload extract.

Main Site of Study Displays the value defined for your institution from the PBI
Configuration page. If no value is defined in the configuration
record the field displays the primary Location of the Campus
displayed for the applicant or student.

Displays the value defined for your institution from the PBI
Configuration page. If no value is defined in the configuration
record the field displays the primary Location of the Campus
displayed for the applicant or student.

Reported Site Select an alternative Location if the required value is different
to the default value displayed in the Main Site of Study field.
 This value will be used in place of the Main Site of Study
value in deriving the Main Site address fields in the Upload
extract.
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Field or Control Description

Academic Level The system automatically populates this field when a new
CAS record is created. The value is populated from HESA
Plan Data page if a COURSEAIM value is defined for the
Academic Plan of the application or student career.

If a value is not defined for the Academic Plan, the value
is populated from the HESA Program Data page if a
COURSEAIM value is defined for the Academic Program of
the application or student career.

The first letter of the COURSEAIM value is translated to an
NQF level as follows: D (doctoral) = 8, M (masters) = 7, H 
(honours) = 6, I (intermediate) = 5, C (certificate) = 4.

Enter a value if a COURSEAIM value has not been set up on
the HESA data pages or if you want to enter a different value
for the applicant or student.

Secondary Academic Level Select a secondary NQF level if required.

NQF values for this field and Academic Level are delivered as
translate values with the system (SAD_PB_ACAD_LEVEL).
 You can define additional translate values for qualification
types if required.

Course Start Date The system automatically populates this field when a new
CAS record is created. The value is populated based on the
value defined for the Admit Term and Cohort Tag (if defined)
from:

• Academic Plan PBI Data page

• Academic Program PBI Data page

• PBI Configuration page

• For applicants, the term begin date of the Admit Term
on the Application Program Data page; for students, the
earliest effective date on the Student Program page.

You can override the default value.

Course Start Date must be equal to or greater than the current
system date when the Upload Status is set to Upload Ready.
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Field or Control Description

Expected End Date The system automatically populates this field when a new
CAS record is created. The value is populated based on
the value defined for the Admit Term and Cohort Tag (if
defined) from (a) Academic Plan PBI Data page, (b) Academic
Program PBI Data page, (c) PBI Configuration page or (d) the
end date of the Expected Graduation Term.

You can override the default value.

Latest Acceptance Date The system automatically populates this field when a new
CAS record is created. The value is populated based on
the value defined for the Admit Term and Cohort Tag (if
defined) from (a) Academic Plan PBI Data page, (b) Academic
Program PBI Data page or (c) PBI Configuration page. If
default value does not exist at these three levels, then the
system sets the field as blank.

You can override the default value. The value must be on or
after the Course Start Date and on or before the Expected End
Date.

Months Duration The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page or (b) Academic Program PBI
Data page. If default value does not exist at these two levels,
 then the system sets the field as blank.

You can override the default value by entering a number in the
range of 0 and 99.

This field is informational only and is not included in the
Upload, Update or Report extract.

Full-Time Course If the Academic Load field displays Full-Time, the system
automatically populates the value Yes when a new CAS record
is created.

Course Hours The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page or (b) Academic Program PBI
Data page. If default value does not exist at these two levels,
 then the system sets the field as blank.

You can override the default value by entering a decimal value
in the range of 0.0 and 168.0.
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Field or Control Description

Previous UK Study The system automatically populates this field when a new
CAS record is created. The value is populated from the PBI
Configuration page. If default value does not exist at the
configuration level, then the system sets the field as blank.

You can select a different value if required.

Previous Academic Level, Current Level Comparison, and
Progression Justification

These three fields become available when the value is Yes in
the Previous UK Study field.

Work Placement The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page, (b) Academic Program PBI
Data page or (c) PBI Configuration page. If default value does
not exist at these three levels, then the system sets the field as
blank.

You can select a different value if required.

Placement Organization Enter an external ID value if required.

This field becomes available when the value is Yes in the Work
Placement field.

The value is populated from (a) Academic Plan PBI Data page
or (b) Academic Program PBI Data page. If default value does
not exist at these two levels, then the system sets the field as
blank.

Placement Justification This field becomes available when the value is Yes in the Work
Placement field.

The value is populated from (a) Academic Plan PBI Data page
or (b) Academic Program PBI Data page. If default value does
not exist at these two levels, then the system sets the field as
blank.

Placement Percentage This field becomes available when the value is Yes in the Work
Placement field.

The value is populated from (a) Academic Plan PBI Data page
or (b) Academic Program PBI Data page. If default value does
not exist at these two levels, then the system sets the field as
blank.
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Note: For Placement Percentage, Placement Justification and Placement Organisation: If Work Placement
defaults to No from the academic plan, then the system skips step (b) for these three fields and values
for these fields are not derived from the academic program. In such a case, the value for each of these
three fields will either default from (a) academic plan or will be blank to ensure that the default Work
Placement details are consistent.

Financial Details

The following is an example of the Financial Details region on the CAS Details page.

This example illustrates the fields and controls on the Financial Details region – CAS Details page. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Accommodation Provided The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page, (b) Academic Program PBI
Data page or (c) PBI Configuration page. If default value does
not exist at these three levels, then the system sets the field as
blank.

You can select a different value if required.

First Year Course Fees The system automatically populates this field when a new
CAS record is created. The value is populated based on
the value defined for the admit term and Cohort Tag (if
defined) from (a) Academic Plan PBI Data page, (b) Academic
Program PBI Data page or (c) PBI Configuration page.

If no value is defined for the admit term, then the field value
defaults to zero.

You can override the value by entering a number in the range
of 0.00 to 1,000,000.
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Field or Control Description

Course Fees Paid Enter a number in the range of 0.00 to 1,000,000.

You cannot enter a value greater than the First Year Course
Fees, if the First Year Course Fees field has a value greater
than zero.

If the CAS Status is Assigned the Update Status value is
updated to Update Required when the value for this field is
updated.

If you leave the field blank, the Create Extract process derives
zero for the field in the Upload extract.

Accommodation Fees Included The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page, (b) Academic Program PBI
Data page or (c) PBI Configuration page. If default value does
not exist at these three levels, then the system sets the field as
blank.

You can select a different value if required.

Accommodation Fees Paid Enter a number in the range of 0.00 to 1,000,000.

You cannot enter a value greater than the First Year Course
Fees, if the First Year Course Fees field has a value greater
than zero.

If the CAS Status is Assigned the Update Status value is
updated to Update Required when the value for this field is
updated.

If you leave the field blank, the Create Extract process derives
zero for the field in the Upload extract.

First Year Boarding Fees The system automatically populates this field when a new
CAS record is created. The value is populated based on
the value defined for the admit term and Cohort Tag (if
defined) from (a) Academic Plan PBI Data page, (b) Academic
Program PBI Data page or (c) PBI Configuration page. If
default value does not exist at these three levels, then the
system sets the field as blank.

If no value is defined for the admit term, then the field value
defaults to zero.

You can override the value by entering a number in the range
of 0.00 to 1,000,000.
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Field or Control Description

Boarding Fees Paid Enter a number in the range of 0.00 to 1,000,000.

You cannot enter a value greater than the First Year Boarding
Fees, if the First Year Boarding Fees field has a value greater
than zero.

If the CAS Status is Assigned the Update Status value is
updated to Update Required when the value for this field is
updated.

If you leave the field blank, the Create Extract process derives
zero for the field in the Upload extract.

Documentation

The following is an example of the Documentation region on the CAS Details page.

This example illustrates the fields and controls on the Documentation region – CAS Details page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Offer Documents Enter a value up to a maximum of 2000 characters.

The value is used to derive the DocumentsUsedToObtainOffer
field in the Upload extract.

ATAS Certificate Required The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page, (b) Academic Program PBI
Data page or (c) PBI Configuration page. If default value does
not exist at these three levels, then the system sets the field as
blank.

You can select a different value if required.
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Field or Control Description

Dean's Certificate Required The system automatically populates this field when a new
CAS record is created. The value is populated from (a)
Academic Plan PBI Data page, (b) Academic Program PBI
Data page or (c) PBI Configuration page. If default value does
not exist at these three levels, then the system sets the field as
blank.

You can select a different value if required. 

Sponsor Notes

The following is an example of the Sponsor Notes region on the CAS Details page.

This example illustrates the fields and controls on the Sponsor Notes region – CAS Details page. You can
find definitions for the fields and controls later on this page.

To notify UKVI of corrections to the applicant data, an institution adds Sponsor Notes to a CAS record
through SMS. You can use Notes field to enter the same notes to a CAS record in the system. This enables
you to maintain the Sponsor Notes locally. The system does not include the Notes field value in the
Upload extract data.

Entering PBI Report Data for Applicants or Students
Access the Report Details page (Student Admissions >PBI Processing >CAS Maintenance >Report
Details).
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This example illustrates the fields and controls on the Report Details page . You can find definitions for
the fields and controls later on this page.

Field or Control Description

Report Status Identifies whether the record has been identified as:

• To be included in the Report extract (Report Ready).

• Included in the Report extract (Report Complete).

You can set report status to Report Ready, only if the CAS
Number is populated and the CAS Status of the record is Used.

Report File ID Displays the File ID generated when the record is included in
the Report extract.

Expected Enrollment The system automatically populates this field when a new
CAS record is created. The value is populated based on
the value defined for the Admit Term and Cohort Tag (if
defined) from (a) Academic Plan PBI Data page, (b) Academic
Program PBI Data page or (c) PBI Configuration page. If
default value does not exist at these three levels, then the
system sets the field as blank.

You can override the default value. The value must be on
or before the Latest Acceptance Date defined on the Course
Details region of the CAS Details page.

Notes Enter a value up to a maximum of 2000 characters.

The value is used to derive the Notes field for the Report
extract.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1121



(GBR) Managing PBI Data Exchange Chapter 28

Updating Multiple CAS Records

Use the CAS Record Update process if you want to update a group of CAS records in Campus Solutions
at the same time. You can select the group of CAS records based on selection criteria, including:

• Academic career, program or plan.

• Students or applicants.

• Admit term.

• Upload, Update or Report status.

This section discusses how to update multiple CAS Records.

Note: This process can only be used to update multiple CAS records with a single value per field.
Updates that require a different value for each CAS record, for example updates to Course Fees Paid that
may vary by applicant or student, should be made using the CAS Details page.

Page Used to Update Multiple CAS Records

Page Name Definition Name Navigation Usage

CAS Record Update SAD_PB_CAS_UPD Student Admissions > PBI
Processing > CAS Record
Update

Update multiple CAS records.

Updating Multiple CAS Records
Access the CAS Record Update page (Student Admissions > PBI Processing > CAS Record Update).
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This example illustrates the fields and controls on the CAS Record Update page (1 of 2). You can find
definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the CAS Record Update page (2 of 2). You can find
definitions for the fields and controls later on this page.

Use the Selection Criteria region to specify the group of CAS records that you want to update.

Use the Population Selection region to further filter the records that are selected for update by selected a
PS Query value.
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Use the New Value Details region to specify the values that are updated by the process.

Population Selection

Population selection is a method of selecting the IDs to process a specific transaction. The Population
Selection group box appears on the run control pages when the Population Selection process is available
or required for the transaction.

The system writes the CAS records returned from any query specified under Population Selection to
SAD_PB_CAS_RES. The query must return the following values to uniquely identify the CAS records
that need to be updated:

• EMPLID

• INSTITUTION

• SAD_PB_REC_TYPE

• ACAD_CAREER

• STDNT_CAR_NBR

• SAD_PB_REC_NUMBER

• ADM_APPL_NBR (blank for record type = student)

• APPL_PROG_NBR (blank for record type = student)

For each distinct CAS record, the query automatically selects the most recent effective dated/sequenced
row for further filtering before the process creates a new row.

A sample query, SAD_PB_CAS_RECORD_UPDATE, has been delivered. This query selects the most
recent effective dated rows for all the CAS records of an institution.

See "Understanding the Population Selection Group Box" (Campus Community Fundamentals)

After specifying the changes on the New Value Details region, when you run the process:

1. The process selects the CAS records based on the specified criteria.

2. In each CAS record, it inserts a new row with an effective date equal to the Effective Date parameter
value or, if the most recent row has the same effective date as the Effective Date parameter value, the
sequence number is incremented.

3. In the new row, the process makes the changes based on the parameters you specified on the New
Value Details region. The rest of the fields in the new row contain the values from the previous row.

The following table describes how the CAS Record Update process determines whether or not to update a
CAS record value:
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Process Parameter Conditions

Effective Date If the most recent existing CAS record row has an effective
date later than the parameter value, the process logs a message
and skips the update for that record.

Upload Status Only updated if the Upload Status field is enabled in the CAS
record, that is the CAS Number is not populated.

Update Status Only updated if the Update Status field is enabled in the CAS
record, that is the CAS Number is populated and the CAS
Status is blank or Assigned.

Report Status No conditions.

Course Start Date No conditions.

Expected End Date Only updated if the date is after the new/existing Course Start
Date.

Latest Acceptance Date Only updated if the date is after the new/existing Course Start
Date and is before the new/existing Expected End Date.

Expected Enrollment Date Only updated if the date is not after the new/existing Latest
Acceptance Date.

First Year Course Fees Only updated if the value is greater than zero.

First Year Boarding Fees Only updated if the value is greater than zero.

Course Fees Paid Only updated if the value is greater than zero and is not greater
than the new/existing First Year Course Fees value.

Accommodation Fees Paid Only updated if the value is greater than zero and is not greater
than the new/existing First Year Course Fees value.

Boarding Fees Paid Only updated if the value is greater than zero and is not greater
than the new/existing First Year Boarding Fees value.

If any of Course Fees Paid, Accommodation Fees Paid or Boarding Fees Paid is updated and the Update
Status field is currently enabled then the Update Status is updated to the value defined for 'Update
Required' in the PBI configuration record, unless a new Update Status is specified in the Statuses region
in which case that value is used for the update.
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There is no validation applied to updates to Course Fees Paid, Accommodation Fees Paid or Boarding
Fees Paid to check that the Update Status field is enabled. Values for the fields will be updated even if
the Update Status in the CAS Details record is disabled following the update of the CAS Status to one of
the post-assigned values. You should ensure that updates to the three Fees Paid fields are only made for
records where the Update Status field is enabled.

Generating an XML File to Send to SMS

This section discusses how to:

• Generate an extract.

• Review an extract.

• Create an XML file from an extract.

• Validate an XML file.

Pages Used to Generate an XML file to send to SMS

Page Name Definition Name Navigation Usage

Create Extract Data SAD_PB_CRT_EXT Student Admissions >
PBI Processing > Create
Extract

Generate the Upload, Update,
 or Report extract data.

Upload Extract Data SAD_PB_UPL_EXT Student Admissions >
PBI Processing > Upload
Extract Data

Review and edit the upload
extract data.

Update Extract Data SAD_PB_UPD_EXT Student Admissions >
PBI Processing > Update
Extract Data

Review and edit the update
extract data.

Report Extract Data SAD_PB_REP_EXT Student Admissions >
PBI Processing > Report
Extract Data

Review and edit the report
extract data.

Create XML SAD_PB_GXML Student Admissions > PBI
Processing > Create XML

Generate the XML file from
the extract data.

Validate XML SAD_PB_VALX_PRC Student Admissions > PBI
Processing > Validate XML

Validate the XML file.

Generating an Extract
Access the Create Extract Data page (Student Admissions > PBI Processing > Create Extract).
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This example illustrates the fields and controls on the Create Extract Data page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Create Upload Select to create Upload extract data. If you select this check
box, the process selects CAS Details records with an Upload
status of Upload Ready.

Create Update Select to create the Update extract data. If you select this
check box, the process selects CAS Details records with an
Update status of Update Ready.

Create Report Select to create the Report extract data. If you select this check
box, the process selects CAS Details records with a Report
status of Report Ready.

Include Applicants Select to create extract data for only applicants. If you select
this check box, the process selects CAS Details records with
record type Applicant.

Include Students Select to create extract data for only students. If you select this
check box, the process selects CAS Details records with record
type Student.

Note: You should not clear both the Include Applicants and
the Include Students check boxes. You must select one of the
check boxes to run the process. Also, you can select both the
check boxes to include both applicant and student records.
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Field or Control Description

Upload File ID Override If you do not enter an override value, the process automatically
generates a value in the format INST_UPLOAD_YYYY_
MM_DD_nn where INST is your institution code and nn is a
sequence number that begins 01 and is incremented for new
runs of the extract process on that date. For example, a File ID
of PSUNV_UPLOAD_2010_06_26_01 will be generated for
the first upload extract for institution PSUNV on the 26th June
2010.

Enter a File ID value to be used in place of the automatically
generated value if required. The value must not have already
been used for an Update or Report extract. If an extract for the
File ID entered has already been run any existing extract data
records will be deleted before the process is re-run.

Update File ID Override If you do not enter an override value, the process automatically
generates a value in the format INST_UPDATE_YYYY_
MM_DD_nn where INST is your institution code and nn is a
sequence number that begins 01 and is incremented for new
runs of the extract process on that date.

Enter a File ID value to be used in place of the automatically
generated value if required. The value must not have already
been used for an Upload or Report extract. If an extract for the
File ID entered has already been run any existing extract data
records will be deleted before the process is re-run.

Report File ID Override If you do not enter an override value, the process automatically
generates a value in the format INST_REPORT_YYYY_
MM_DD_nn where INST is your institution code and nn is a
sequence number that begins 01 and is incremented for new
runs of the extract process on that date.

Enter a File ID value to be used in place of the automatically
generated value if required. The value must not have already
been used for an Upload or Update extract. If an extract for the
File ID entered has already been run any existing extract data
records will be deleted before the process is re-run.

Create Upload check box

If the Create Upload check box is selected, CAS Details records with an Upload Status of Upload Ready
are selected. The process selects applicant records, if the Include Applicants check box is selected. The
process selects student records, if the Include Students check box is selected. If you have selected both
the Include Students and Include Applicants check boxes, the process selects both applicant and student
records.

If an Upload File ID Override value is selected, any existing extract records are deleted before new
records are selected.

If you have selected both Include Applicants and Include Students check boxes, the process includes one
record for each applicant or student. If there is more than one CAS Details record with an Upload Status
of Upload Ready, the first record selected is included and a message is logged for any subsequent records
selected by the process. The additional records can be included in a future extract or the Upload Status
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can be set to the appropriate status to prevent the record from being included if a second CAS request is
not required.

After a CAS Details record is included by the process, a new effective dated record is created to set the
Upload Status to Upload Complete and to populate the Upload File ID.

Create Update check box

If the Create Update check box is selected, CAS Details records with an Update Status of Update Ready
and the CAS Number populated are selected. The process selects applicant records, if the Include
Applicants check box is selected. The process selects student records, if the Include Students check box is
selected. If you have selected both the Include Students and Include Applicants check boxes, the process
selects both applicant and student records.

If an Update File ID Override value is selected any existing extract records are deleted before new records
are selected.

The same value is derived for each record in the Upload extract for the Update File ID field.

After a CAS Details record is included by the process, a new effective dated record is created to set the
Update Status to Update Complete and to populate the Update File ID.

If an Event ID is set up on the PBI Configuration page for Record Type = Applicant or Student and
Notification Type = Fee Update, the process creates the 3C Engine Trigger result for the Event ID and
person.

For steps that you should perform after the process creates the 3C Engine Trigger result, see Generating
PBI Communications

Create Report check box

If the Create Report check box is selected, CAS Details records with a Report Status of Report Ready and
the CAS Number populated are selected. The process selects applicant records, if the Include Applicants
check box is selected. The process selects student records, if the Include Students check box is selected. If
you have selected both the Include Students and Include Applicants check boxes, the process selects both
applicant and student records.

If a Report File ID Override value is selected any existing extract records are deleted before new records
are selected.

The same value is derived for each record in the Upload extract for the Report File ID field.

After a CAS Details record is included by the process, a new effective dated record is created to set the
Report Status to Report Complete and to populate the Report File ID.

Refer to the PBI Field Derivation documentation for information about derivation of each field in the
extract.

Reviewing an Extract
Use the Upload Extract Data, Update Extract Data, and Report Extract Data pages to review the extract
data that the Create Extract process has generated prior to creating the XML file.
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This example illustrates the fields and controls on the Upload Extract Data page (part). You can find
definitions for the fields and controls later on this page.

Field or Control Description

Exclude from XML Select to prevent an individual record from being included in
the XML file when the Create XML process is run for the File
ID.
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Field or Control Description

Reported Value Displays the derived value for the field. You can change this
value if a different value is required in the XML file to be sent
to SMS.

If the derived value is overwritten in the extract data you
should ensure that the corresponding data in the CAS Details
record is also updated.

In cases where both General and Child category records
are included in the upload extract data the Schema ID and
Category values can be overridden for the Child records in the
Reported Value field.

Derived Value Overridden The system automatically selects the check box if you use the
Reported Value field to change the derived value.

Creating an XML File from an Extract
Access the Create XML page (Student Admissions > PBI Processing > Create XML).

This example illustrates the fields and controls on the Create XML page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Extract Type Select an extract type to filter the prompt values for the File ID
field.

Extract Date Select an extract date to filter the prompt values for the File ID
field.

File ID Select the extract that you want to process.
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Field or Control Description

XML Path/File Name Enter the file path and file name that you want the system to
use to save the XML file. You must enter a valid directory path
that maps to a folder with appropriate Read/Write permissions.
 If you cannot locate such a folder, consult your system
administrator.

If defined the file name element must include the lower case .
xml extension:

• Windows format - \\server\folder\filename.xml

• Unix format - //server/folder/filename.xml

If you enter the file path and do not specify the file name,
 the process uses the File ID value to name the XML file. The
format without the file is as follows:

• Windows format - \\server\folder

• Unix format - //server/folder

Upload Extract XML

For the upload extract the process creates a separate XML file for each combination of the header fields
found in the extract data for the File ID:

<BulkUploadFileId>

<SchemaID>

<TierID>

<Category>

<SponsorLicenceNumber>

In cases where there are multiple Sponsor Licence Numbers in the upload extract data multiple XML
files are created. If there are both General and Child category records multiple XML files are created. If
multiple XML files are required a sequence letter (A, B, C etc) is added to the file name to distinguish
between the files.

For cases where the process is being re-run, if there is an existing file for the specified path/file name then
that file is overwritten.

Update and Report Extract XML

A single XML file is created for each File ID for update and report extract data.

For cases where the process is being re-run, if there is an existing file for the specified path/file name then
that file is overwritten.
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Validating a XML File
Access the Validate XML page (Student Admissions > PBI Processing > Validate XML).

This example illustrates the fields and controls on the Validate XML page . You can find definitions for
the fields and controls later on this page.

Field or Control Description

XML Path/File Name Enter the path and file name of the XML file that you want to
validate.

XSD Path/File Name Enter the complete path and file name of the primary XSD file.
 The process uses all of the XSD files to validate your XML
file.

The XSD files are available from the UKVI website.

The process validates the XML and checks that it is well formed in the context of the defined schema.

If any errors are reported by the Validate XML process, correct the errors by amending the Reported
Value in the Extract Data pages or by amending the CAS Details or related records.

If you have corrected the errors using the Extract Data pages, re-run the Create XML process and validate
the file. If you have corrected the errors in the CAS Details or related records, re-run the Create Extract
process, re-run the Create XML process and validate the file.

Once the XML file passes schema validation, submit the XML file to SMS via the UKVI portal.

Importing CAS Details

After you send one or more CAS number requests to SMS, use the Import CAS Details process to import
the CAS details from the Bulk Export XML file retrieved from SMS.

When you run the process:

1. Initially it processes the XML file and creates CAS records in the staging tables.
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2. Then it processes the staging table records to either update an existing CAS record with the CAS
number and status details or create a new CAS record where you have submitted the CAS request
directly via the UKVI portal.

Each CAS record in the staging table has an import status. The following table describes how the process
determines which import status to assign to a CAS staging record.

Condition Status Set By the Import Process

The status is initially set to this value for each new record
imported to the staging table from the XML file.

New (N)

The import process did not find a matching CAS Details
record.

Pending (P)

The import process encountered a problem when identifying
a CAS Details record (for example, there is an existing CAS
Details record but it is future dated).

Error (E)

The status is set to this value for each staging record where the
corresponding CAS record has been created or updated with
the imported CAS details.

Imported (I)

Use the CAS Staging Data pages to review the staging records that have Pending or Error status. For
records with Pending status, you can use the CAS Staging Data page to match the record with an existing
application or student program record and create a new CAS record. For records with Error status, you
can use the CAS Details page to correct or update the existing records to allow the staging record to be re-
processed.

This section discusses how to:

• Import and create CAS records in bulk.

• Review and edit the CAS staging data.

Pages Used to Import CAS Records

Page Name Definition Name Navigation Usage

Import CAS Details SAD_PB_IMPC_PRC Student Admissions > PBI
Processing > Import CAS
Details

Import the CAS details from
the Bulk Export XML file
provided by SMS.

CAS Staging Data SAD_PB_I_CAS Student Admissions > PBI
Processing > CAS Staging
Data

Review the records that the
Import CAS Details has
loaded into the staging tables.
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Importing CAS Details
Access the Import CAS Details page (Student Admissions > PBI Processing > Import CAS Details).

This example illustrates the fields and controls on the Import CAS Details page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Add Attachment Click to browse to the XML file that you want to import, and
click Upload.

You can browse your local drive and select a file. When
you click Upload, the system automatically copies the file
to the application server and the XML Path/File Name field
automatically displays the server path and file name.

Note: The upload process creates a files subdirectory to
store and process the XML files. This subdirectory is created
in the server directory location that is specified in the PS_
SERVDIR system parameter in the Application Server/Process
Scheduler configuration file psappsrv.cfg/psprcs.cfg. Ensure
that PS_SERVDIR is set up with an appropriate value in the
configuration file and that users have the correct permission to
access the files subdirectory.

XML Path/File Name Enter the path and file name of the XML file that you want to
import. You must store this XML file on an application server
that the import process can access.

If you want to reprocess the staging records, leave the field
blank.

Processing steps

The process performs the following steps to create new staging table records if the XML Path/File Name
parameter has been provided:

1. Deletes any existing staging records with a status of Obsolete.

2. Deletes any existing staging records with a status of Imported
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3. Opens the XML file. If the XML file cannot be found a message is logged and the re-processing of
any existing staging records continues.

4. Creates staging records with a status of New for each record found in the XML file.

The process then performs the following steps to process staging records that have an import status of
Pending from a previous run of the process:

1. Create: If the application or student program details have been added via the CAS Staging Data
page and there is no existing CAS Details record, a new record is created using the application or
student program details added and the CAS Number, CAS Status, CAS Status Date and Export File
ID from the staging record. The Upload Status is set to Upload Complete and the Nationality value is
populated if a country value exists in the staging record.

2. Update: If the application or student program details have been added via the CAS Staging Data page
and there is an existing CAS Details record without the CAS Number populated, a new effective dated
record is created for the current date with the CAS Number, CAS Status, CAS Status Date and Export
File ID from the staging record.

3. Pending: If the full application or student program details have not been added via the CAS Staging
Data page a message is logged and the record remains with a status of Pending.

4. Error: If the applicant or student details have been added via the CAS Staging Data page and there is
an existing CAS Details record with a different CAS Number already populated then an error message
is logged and the status is set to Error.

The process performs the following step to process New staging records and Error records from a
previous run of the import process:

1. Update CAS Status: If the staging record can be matched to an existing CAS Details record using
Applicant ID (EMPLID) and CAS Number, a new effective dated record is created with the CAS
Status, CAS Status Date and Export File ID from the staging record.

This processing will occur when the CAS Number has already been imported and the CAS Status is
being updated from, for example, Assigned to Used.

Note: If the most recent existing effective dated record is in the future or there are multiple matching
records, a message is logged and the import status is set to Error.

2. Update Applicant: If Application ID is populated and the staging record can be matched to an existing
applicant CAS Details record using Applicant ID (EMPLID) and Application ID (the combination
of Admission Application Number and Application Program Number), a new effective dated record
is created with the CAS Status, CAS Status Date and Export File ID from the staging record. This
processing will occur when the CAS Number is being imported for the first time and the CAS request
has been generated from an existing CAS Details record.

Note: If the most recent existing effective dated record is in the future or there are multiple matching
records, a message is logged and the import status is set to Error.

3. Update Student: If the Application ID is not populated and the staging record can be matched to an
existing student CAS Details record using Applicant ID (EMPLID) and Course ID (either Academic
Plan or Academic Sub-Plan if sub-plan reporting is enabled on the PBI Configuration page), a new
effective dated record is created with the CAS Status, CAS Status Date and Export File ID from the
staging record.
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Note: If the most recent existing effective dated record is in the future or there are multiple matching
records, a message is logged and the import status is set to Error.

4. No Match: If no match is made to an existing CAS Details record the status is set to Pending. The
staging record can be reviewed via CAS Staging Data page and the application or student program
details can be added to allow the record to be re-processed.

Assigning Event IDs to the Applicant or Student for CAS Number Notification

If you have defined an event ID for a notification type of CAS Number on the PBI Configuration page, the
import process assigns the event ID when it creates a new CAS record or when it creates a new effective
dated row for an existing CAS record and the CAS Number is being populated for the first time. If the
process is updating an existing CAS record where the CAS number is already populated the Event ID is
not created.

To assign the event details to the applicant or student, the process creates a results record in the 3C
Engine Trigger Results table for Institution, Event ID and Function (CASN) for the applicant or student
EMPLID. The variable data associated with the CASN administrative function (Academic Career, Student
Career Number and CAS Number) are also populated.

See Generating PBI Communications

Reviewing and Editing the CAS Staging Data
Access the CAS Staging Data page (Student Admissions > PBI Processing > CAS Staging Data).

This example illustrates the fields and controls on the CAS Staging Data page. You can find definitions
for the fields and controls later on this page.
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Use the search page to retrieve Pending or Error status records for review and update.

Use the Maintain Applications or Student Program/Plan links to search for and review existing
application or student program records.

Use the CAS Details link to search for and review any existing CAS Details records.

For a record with an import status of Error, you can correct the existing CAS Details record to allow
the staging record to be re-processed when the Import CAS Details process is next run (Use the CAS
Record Details region and CAS Details link for the correction). You can also match an error record with a
different ID and then have the system re-process the record when the Import CAS Details process is next
run. The ID field is available for entry only if the record has an import status of Error.

The system enables the CAS Record Details region if the import status is either Pending or Error. If you
want to match the staging record with an existing application or student program record for re-processing:

1. Specify whether the new CAS Details record is for an applicant or student by selecting a value in the
Record Type field.

2. Select the Academic Career for the applicant or student from the prompt.

3. Select the Student Career Number for the applicant from the prompt.

4. If the record type is applicant, select the Application Number from the prompt.

5. If the record type is applicant, select the Program Number from the prompt.

6. Save the record.

Deleting CAS Staging Records

You can delete records that are no longer required for processing. To delete a record:

1. Change the import status to Obsolete.

2. Save the record.

3. When you run the Import CAS Details process, the system deletes the records with the Obsolete
status.

Note: Imported staging records cannot be deleted.

Generating PBI Communications

After the system assigns event IDs, use the following process to notify applicants or students about CAS
Number or fee update details:

1. Use the 3C Engine Trigger Results page to view the result records that have been added (Campus
Community >3C Engine >3C Engine Trigger Results).

2. Run the 3C Engine process for each event ID.

3. Use the Person Communication page to view the assigned communication.
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4. Run the Communication Generation process to create the communication that you can send to
applicants and students.

This section describes the steps to assign and generate communications for CAS Number and fee update
notifications.

Related Links
"Understanding Communication Management" (Campus Community Fundamentals)
"Understanding the 3C Engine" (Campus Community Fundamentals)
Setting Up PBI Communications

Reviewing 3C Engine Trigger Results
Access the 3C Engine Trigger Results page (Campus Community >3C Engine >3C Engine Trigger
Results).

Use the 3C Engine Trigger Results page to review records that the Import CAS Details process or the
Create Extract - update process creates.

Use the page to add any additional records required. Select Variable Data to add the required values for
any additional records added.

This example shows the 3C Engine Trigger Results page for CAS Number notification.

Running the 3C Engine Process
Access the 3C Engine Parameters page (Campus Community >3C Engine >Run 3C Engine).
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This example illustrates the fields and controls on the 3C Engine Parameters page.

Run the 3C Engine process for each of the Event IDs defined on the PBI Configuration page. The process
assigns communications, comments and checklists associated with the Event ID to the ID of the applicant
or student.

Assigned communications can be reviewed on the Person Communication page. To navigate to
the Person Communication page, select Campus Community >Communications >Person
Communications >Communication Management >Person Communication.

Running the Communication Generation Process
Access the Selection Parameters page (Campus Community >Communications >Communication
Generation).

Run the Communication Generation process for each standard letter code to generate the communications
for the assigned communications.
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The following example shows that the Communication Method is set to E-Mail. Note that the ID
Selection value should be set to All Person IDs rather than All IDs as shown on the example.

Define the Person Communication Usage values on the Process Parameters page.
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This example illustrates the fields and controls on the Process Parameters page (1 of 2).

This example illustrates the fields and controls on the Process Parameters page (2 of 2).

Define the From and Subject values on the Email Parameters page.
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This example illustrates the fields and controls on the Email Parameters page.

Review the communications generated by the process on the Communications Management page
(Campus Community >Communications >Person Communications >Communications
Management).
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Understanding PBI Field Derivation

We recommend that you review the field specification, sample XML files, schemas and validation
documents available on UKVI web site. The field specification provides information, such as, each field's
format, description, whether a field value is required for SMS to issue the CAS number, whether the
academic institution must validate a field value using the schema, and whether SMS performs additional
validation on the field value when you upload the file.

You can capture the field values at three levels in Campus Solutions:

1. Configuration level.

2. Academic program or plan level.

3. CAS Details level.

For more information about the data capture levels, see Preparing for PBI Data Exchange

The following table lists the navigation paths for the pages mentioned throughout this PBI field derivation
documentation:

Page Navigation

PBI Configuration Student Admissions >PBI Processing >PBI Configuration

Academic Plan PBI Data Set Up SACR >Foundation Tables >Academic
Structure >Academic Plan Table >PBI Data

Academic Program PBI Data Set Up SACR >Foundation Tables >Academic
Structure >Academic Program Table >PBI Data

CAS Details Student Admissions >PBI Processing >CAS
Maintenance >CAS Details

See Understanding PBI Data Exchange

Upload Extract Fields

This section discusses how the Create Extract process derives the field values for the Upload extract. To
derive specific fields the following values are determined for each CAS Details record:
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• Campus and Academic Program

• Selected from the current Application Program Data record for applicants.

• Selected from the current Student Program record for students.

• Academic Plan

• Selected from the Reported Plan value from the CAS Details page.

• If no Reported Plan is defined:

- Selected from the current Application Plan Data record for applicants. If more than one record
exists the first plan code alphabetically is selected.

- Selected from the Student Plan record for students. If more than one record exists the plan with
the lowest sequence number is selected.-

• Academic Subplan

• Selected if Enable Sub-Plan Reporting is checked on the PBI Configuration page.

• Selected from the current Application Sub-Plan Data record for applicants.

• Selected from the current Student Sub-Plan record for students.

• If more than one record exists the first subplan code alphabetically is selected.

Upload File ID
Upload Extract Data page: Header

XML Tag: <BulkUploadFileId>

Mandatory: Yes

Pages Used:

Page Page Element

Create Extract Data (Student Admissions, PBI Processing ,
 Create Extract Data)

Upload File ID Override

Derivation Steps:

1. Derive from the Upload File ID Override parameter of the Create Extract process.

2. Derive in the format INST_UPLOAD_YYYY_MM_DD_nn (for example,
PSUNV_UPLOAD_2009_09_27_01), where INST is the institution code and nn is an automatically
generated sequence number for the day.
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Schema ID
Upload Extract Data page: File Details

XML Tag: <SchemaID>

Mandatory: Yes

Pages Used:

Page Page Element

PBI Configuration Schema ID

Derivation Steps:

1. Derive the long description value of the translate value defined on the PBI Configuration page.

Tier ID
Upload Extract Data page: File Details

XML Tag: <TierID>

Mandatory: Yes

Pages Used:

Page Page Element

PBI Configuration Tier ID

Derivation Steps:

1. Derive the long description value of the translate value defined on the PBI Configuration page.

Category
Upload Extract Data page: File Details

XML Tag: <Category>

Mandatory: Yes

Pages Used:

Page Page Element

PBI Configuration Category
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Derivation Steps:

1. Derive the long description value of the translate value defined on the PBI Configuration page.

Sponsor Licence Number
Upload Extract Data page: File Details

XML Tag: <SponsorLicenceNumber>

Mandatory: Yes

Pages Used:

Page Page Element

PBI Configuration Sponsor Licence Number

Campus Sponsor Licence Number

Derivation Steps:

1. Derive the value defined for the Campus of the applicant or student defined on the PBI Configuration
page.

2. Derive the value defined for the institution on the PBI Configuration page.

Applicant ID
Upload Extract Data page: Header

XML Tag: <ApplicantID>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details ID

Derivation Steps:

1. Derive from the CAS Details record.

UCAS Personal ID
Upload Extract Data page: Applicant Details

XML Tag: <UCAS_UKPASS_Id>
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Mandatory: No

Pages Used:

Page Page Element

CAS Details UCAS Personal ID

External System ID (Campus Community, Personal
Information, Identification, External System ID)

External System ID

Derivation Steps:

1. Derive from External System ID records with type UC or UP.

2. Derive as null.

Application ID
Upload Extract Data page: Applicant Details

XML Tag: <ApplicationID>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Application Number

Program Number

Derivation Steps:

1. Derive as a concatenation of Application Number and Program Number from the CAS Details page.

2. Derive as null for Student record type.

Family Name
Upload Extract Data page: Applicant Details

XML Tag: <FamilyName>

Mandatory: Yes

Pages Used:
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Page Page Element

Names (Campus Community, Personal Information,
 Biographical , Names)

Last Name: The last name for the current primary name
record.

Long Names (Campus Community Personal Information,
 Biographical, Names, Manage Long Names)

Long Last Name: The long last name for the current primary
name record.

Derivation Steps:

1. If any of the long name fields (Long First Name, Long Middle Name or Long Last Name) are defined,
and the Long Last Name is populated and is 35 characters or fewer, derive Long Last Name from the
current primary name record

2. If either Long First Name or Long Middle Name are defined but Long Last Name is blank, derive as
NULL ERROR.

3. If any of the long name fields are defined, and the last unbroken text element of Long Last Name
exceeds 35 characters, derive as NULL ERROR.

4. If any of the long name fields are defined and Long Last Name exceeds 35 characters, but can be
extracted as distinct elements (names are separated by spaces), then derive as distinct elements
working backwards from the long last name provided.

5. Derive Last Name from the current primary name record.

Given Name
Upload Extract Data page: Applicant Details

XML Tag: <GivenName>

Mandatory: No

Pages Used:

Page Page Element

Names (Campus Community, Personal Information,
 Biographical , Names)

First Name. The first name for the current primary name
record.

Long Names (Campus Community Personal Information,
 Biographical, Names, Manage Long Names)

Long First Name. The long first name for the current primary
name record.

Derivation Steps:

1. If any of the long name fields (Long First Name, Long Middle Name or Long Last Name) are defined,
and the Long First Name is populated and is 35 characters or fewer, derive Long First Name from the
current primary name record

2. If any of the long name fields are defined, and Long First Name is blank, derive as null.
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3. If any of the long name fields are defined and Long First Name exceeds 35 characters, derive as
NULL ERROR.

4. Derive First Name from the current primary name record.

Note: UKVI have indicated that this field can be blank where the applicant or student only has one name
although a first name value is required in Campus Solutions. If required the Reported Value for Given
Name can be set to blank on the Upload Extract Data page prior to creating the XML.

Other Names
Upload Extract Data page: Applicant Details

XML Tag: <OtherNames>

Mandatory: No

Pages Used:

Page Page Element

Names (Campus Community, Personal Information,
 Biographical , Names)

Middle Name. The middle name for the current primary name
record.

Long Names (Campus Community Personal Information,
 Biographical, Names, Manage Long Names)

Long Middle Name. The long middle name for the current
primary name record.

Derivation Steps:

1. If any of the long name fields (Long First Name, Long Middle Name or Long Last Name) are defined
and derivation of Family name is not step 4 (i.e. elements of Long Last Name are not included); and
Long Middle Name is not blank, derive from the current primary name record.

2. If any of the long name fields are defined and derivation of Family name does not follow step 4 (i.e.,
elements of Long Last Name are not included); and Long Middle Name is blank, derive as null.

3. If any of the long name fields are defined and derivation of Family name follows step 4 (i.e., elements
of Long Last Name are included); and Long Middle Name is not blank, derive as Long Middle Name
followed by a <space>, then the elements of Long Last Name that were not derived for Family Name.

4. If any of the long name fields are defined and derivation of Family name follows step 4 (i.e., elements
of Long Last Name are included); and Long Middle Name is blank, derive the elements of Long Last
Name that were not derived for Family Name.

5. Derive Middle Name from the current primary name record.

6. Derive as null.

See Family Name for its derivation.
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Nationality
Upload Extract Data page: Applicant Details

XML Tag: <Nationality>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Nationality

Derivation Steps:

1. Derive from the CAS Details record.

Note: If required the Reported Value can be set to STATELESS on the Upload Extract Data page prior to
creating the XML. The text must be contained within to pass schema validation.

Gender
Upload Extract Data page: Applicant Details

XML Tag: <Gender>

Mandatory: Yes

Pages Used:

Page Page Element

Names (Campus Community, Personal Information, Add/
Update a Person, Biographical History)

Gender

Derivation Steps:

1. Derive from the current Biographical History record where Male is derived as 1 and Female is derived
as 2.

2. Derive as NULL ERROR.

Country of Birth
Upload Extract Data page: Applicant Details

XML Tag: <CountryOfBirth>

Mandatory: Yes
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Pages Used:

Page Page Element

Names (Campus Community, Personal Information, Add/
Update a Person, Biographical History)

Birth Country

Derivation Steps:

1. Derive from the Birth Information record.

2. Derive as NULL ERROR.

Place of Birth
Upload Extract Data page: Applicant Details

XML Tag: <PlaceOfBirth>

Mandatory: No

Pages Used:

Page Page Element

Names (Campus Community, Personal Information, Add/
Update a Person, Biographical History)

Birth Location

Derivation Steps:

1. Derive from the Birth Information record.

2. Derive as NULL ERROR.

Date of Birth
Upload Extract Data page: Applicant Details

XML Tag: <DateOfBirth>

Mandatory: Yes

Pages Used:

Page Page Element

Names (Campus Community, Personal Information, Add/
Update a Person, Biographical History)

Date of Birth
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Page Page Element

CAS Details Report Month/Year Only

Report Year Only

Derivation Steps:

1. Derive from the person record. If Report Year Only check box is selected, derived as YYYY. If
the Report Month/Year Only check box is selected, derived as YYYY-MM. If neither check box is
selected derived as YYYY-MM-DD.

2. Derive as NULL ERROR.

Passport Number
Upload Extract Data page: Applicant Details

XML Tag: <ApplicantPassportOrTravelDocumentNumber>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Passport Number

Derivation Steps:

1. Derive from the CAS Details record.

Partner Institution
Upload Extract Data page: Other Institution Details

XML Tag: <Name>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution
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Page Page Element

Academic Program PBI Data Partner Institution

Organization Table (Campus Community, Organization,
 Create/Maintain Organizations, Organization Table)

Description

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Partner Institution Sponsor Licence Number
Upload Extract Data page: Other Institution Details

XML Tag: <SponsorLicenceNumber>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Regional (Campus Community, Organization, Create/Maintain
Organizations, Organization Table, Regional)

Sponsor Licence Number

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.
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Partner Institution Address 1
Upload Extract Data page: Other Institution Details

XML Tag: <AddressLine>

Mandatory: If any partner institution details are supplied

Pages Used:

Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 1

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Partner Institution has a value, derive as NULL ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: The delivered address formats for Belgium and the Netherlands do not include use of the Address 1
field. As this is a mandatory value if the country is either Belgium or the Netherlands the value is derived
as a combination of Street (Address Line 3) and Number.

Partner Institution Address 2
Upload Extract Data page: Other Institution Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:
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Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 2

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Partner Institution Address 3
Upload Extract Data page: Other Institution Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 3

Derivation Steps:
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1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: If the country is either Belgium or the Netherlands the field is derived as null as the Street (Address
Line 3) value is used to derive Partner Institution Address 1.

Partner Institution City
Upload Extract Data page: Other Institution Details

XML Tag: <City>

Mandatory: If any partner institution details are supplied

Pages Used:

Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

City

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Partner Institution has a value, derive as NULL ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.
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Note: The delivered address format for Singapore does not include use of the City field. If the country
value is Singapore the City value will also be derived as Singapore.

Partner Institution County/Area/District
Upload Extract Data page: Other Institution Details

XML Tag: <CountyAreaDistrict>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

County (UK addresses)

State

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Partner Institution Country
Upload Extract Data page: Other Institution Details

XML Tag: <Country>

Mandatory: If any partner institution details are supplied

Pages Used:
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Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Country

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Partner Institution has a value, derive as NULL ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Partner Institution Postcode
Upload Extract Data page: Other Institution Details

XML Tag: <PostCode>

Mandatory: If any partner institution details are supplied and country is GBR

Pages Used:

Page Page Element

CAS Details Partner Institution

Academic Plan PBI Data Partner Institution

Academic Program PBI Data Partner Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Post Code

Derivation Steps:
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1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Partner Institution has a value and Partner Institution Country is GBR, derive as NULL ERROR,
otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Overseas Institution
Upload Extract Data page: Other Institution Details

XML Tag: <Name>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution

Organization Table (Campus Community, Organization,
 Create/Maintain Organizations, Organization Table)

Description

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Overseas Institution Address 1
Upload Extract Data page: Other Institution Details

XML Tag: <AddressLine>

Mandatory: If any overseas institution details are supplied
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Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 1

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Overseas Institution has a value, derive as NULL ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: The delivered address formats for Belgium and the Netherlands do not include use of the Address
1 field. As this is a mandatory value, if the country is either Belgium or the Netherlands, the value is
derived as a combination of Street (Address Line 3) and Number.

Overseas Institution Address 2
Upload Extract Data page: Other Institution Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution
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Page Page Element

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 2

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Overseas Institution Address 3
Upload Extract Data page: Other Institution Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 3

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.
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4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: If the country is either Belgium or the Netherlands the field is derived as null as the Street (Address
Line 3) value is used to derive Overseas Institution Address 1.

Overseas Institution City
Upload Extract Data page: Other Institution Details

XML Tag: <City>

Mandatory: If any overseas institution details are supplied

Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

City

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Overseas Institution has a value, derive as NULL ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: The delivered address format for Singapore does not include use of the City field. If the country
value is Singapore the City value will also be derived as Singapore.

Overseas Institution County/Area/District
Upload Extract Data page: Other Institution Details
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XML Tag: <CountyAreaDistrict>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

County (UK addresses)

State

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Overseas Institution Country
Upload Extract Data page: Other Institution Details

XML Tag: <Country>

Mandatory: If any overseas institution details are supplied

Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution
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Page Page Element

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Country

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Overseas Institution has a value, derive as NULL ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Overseas Institution Postcode
Upload Extract Data page: Other Institution Details

XML Tag: <PostCode>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Overseas Institution

Academic Plan PBI Data Overseas Institution

Academic Program PBI Data Overseas Institution

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Post Code

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.
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4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Course Title
Upload Extract Data page: Course Details

XML Tag: <CourseCurriculumTitle>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Course Title Override

PBI Configuration Enable Sub-Plan Reporting

Sub-Plan HESA (Set Up SACR, Foundation
Tables >Academic Structure >Academic SubPlan
Table >Sub-Plan HESA)

Course Title

Academic Sub-Plan Table (Set Up SACR, Foundation
Tables >Academic Structure >Academic SubPlan Table)

Description

Plan HESA Data (Set Up SACR, Foundation
Tables >Academic Structure >Academic Plan
Table >Plan HESA Data)

Course Title

Academic Plan Table (Set Up SACR, Foundation
Tables >Academic Structure >Academic Plan Table)

Description

Derivation Steps:

1. Derive from the CAS Details record.

2. If Enable Sub-Plan Reporting is checked and a sub-plan record is found for the applicant or student,
derive the Course Title from the Sub-Plan HESA record.

3. If Enable Sub-Plan Reporting is checked and a sub-plan record is found for the applicant or student,
derive a concatenation of plan description + space + sub-plan description.

4. Derive the Course Title from the Plan HESA Data record.

5. Derive the plan description.
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Course ID
Upload Extract Data page: Course Details

XML Tag: <CourseID>

Mandatory: No

Pages Used:

Page Page Element

PBI Configuration Enable Sub-Plan Reporting

Derivation Steps:

1. If Enable Sub-Plan Reporting is checked and a sub-plan record is found for the applicant or student,
derive the sub-plan code.

2. Derive the plan code.

Academic Level
Upload Extract Data page: Course Details

XML Tag: <AcademicLevel>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Academic Level

Derivation Steps:

1. Derive from the CAS Details record. Derive as the short name (XLATSHORTNAME) from the
Translate Values table (PSXLATITEM), for SAD_PB_ACAD_LEVEL.

There are page elements that have translate values. For example, translate values Presessional B1 and
Presessional B2 for the Academic Level page element on the CAS Details page. The Create Extract
process derives the field value as short name (XLATSHORTNAME) from these page elements. For
example, suppose you have defined an academic level translate value on the CAS Details page as
Presessional B1 which has a short name of B1. In such a case, the Create Extract Data process derives the
Academic Level field value as B1.

If a Message Number is found for the short name, derive as the message text. If the message is not in the
Message Catalog (set number 14260), derive the field as MESSAGE NOT FOUND.
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Note: The system sets the default Academic Level value on the CAS Details page based on the
COURSEAIM defined on the Plan HESA Data, Program HESA Data, or Sub-Plan HESA page. The
order in which COURSEAIM is checked: Plan HESA Data page first, then Program HESA Data
page and finally Sub-Plan HESA page. The system defaults the NQF level using the first letter of the
COURSEAIM value as follows:
D — Doctoral — NQF Level 8
M — Masters — NQF Level 7
H — Honours —NQF Level 6
I — Intermediate — NQF Level 5
C — Certificate — NQF Level 4

You can change this default value on the CAS Details page.

Secondary Academic Level
Upload Extract Data page: Course Details

XML Tag: <SecondaryAcademicLevel>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Secondary Academic Level

Derivation Steps:

1. Derive from the CAS Details record. Derive as the short name (XLATSHORTNAME) from the
Translate Values table (PSXLATITEM), for SAD_PB_ACAD_LEVEL.

If a Message Number is found for the short name, derive as the message text. If the message is not in
the message catalog (set number 14260), derive the field as MESSAGE NOT FOUND.

2. Derive as null.

Related Links
Academic Level

Course Start Date
Upload Extract Data page: Course Details

XML Tag: <CourseStartDate>

Mandatory: Yes

Pages Used:
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Page Page Element

CAS Details CourseStartDate

Derivation Steps:

1. Derive from the CAS Details record.

Note: If the derived date is not in the future an error message is logged.

Latest Acceptance Date
Upload Extract Data page: Course Details

XML Tag: <LatestDateForAcceptanceOnCourse>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Latest Acceptance Date

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as null.

Note: If the derived date is not in the future, or is before the derived Course Start Date, or is after the
derived Expected Course End Date, an error message is logged.

Expected End Date
Upload Extract Data page: Course Details

XML Tag: <ExpectedCourseEndDate>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Expected End Date

Derivation Steps:
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1. Derive from the CAS Details record.

Note: If the derived date is not in the future, or is before the derived Course Start Date, an error message
is logged.

Full-Time Course
Upload Extract Data page: Course Details

XML Tag: <CourseIsFullTime>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Full-Time Course

Derivation Steps:

1. If the value in the CAS Details record is Yes, derive as true

2. Derive as false.

Course Hours
Upload Extract Data page: Course Details

XML Tag: <CourseHoursPerWeek>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Course Hours

Academic Plan PBI Data Course Hours

Academic Program PBI Data Course Hours

Note: The Course Hours field is mandatory on the CAS Details page if Full-Time Course is No. The
system performs steps 2, 3, or 4 only if Full-Time Course is Yes on the CAS Details page.

Derivation Steps:

1. Derive from the CAS Details record.
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2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Full-Time Course is derived as true, derive as 0.0

Main Site Address 1
Upload Extract Data page: Course Details

XML Tag: <AddressLine>

Mandatory: Yes

Pages Used:

Page Page Element

PBI Configuration Main Site

CAS Details Reported Site

Campus Table (Set Up SACR >Foundation
Tables >Academic Structure >Campus Table)

Location Code

Location Address (Set Up Common Objects, >Foundation
Tables >Organization >Location)

Address Line 1

Derivation Steps:

1. Derive from location defined as Reported Site in the CAS Details record.

2. Derive from the location defined as the Main Site in the PBI Configuration record.

3. Derive from the primary location for the Campus of the applicant or student.

4. Derive as NULL ERROR.

Main Site Address 2
Upload Extract Data page: Course Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:
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Page Page Element

PBI Configuration Main Site

CAS Details Reported Site

Campus Table (Set Up SACR >Foundation
Tables >Academic Structure >Campus Table)

Location Code

Location Address (Set Up Common Objects, >Foundation
Tables >Organization >Location)

Address Line 1

Derivation Steps:

1. Derive from location defined as Reported Site in the CAS Details record.

2. Derive from the location defined as the Main Site in the PBI Configuration record.

3. Derive from the primary location for the Campus of the applicant or student.

4. Derive as null.

Main Site Address 3
Upload Extract Data page: Course Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:

Page Page Element

PBI Configuration Main Site

CAS Details Reported Site

Campus Table (Set Up SACR >Foundation
Tables >Academic Structure >Campus Table)

Location Code

Location Address (Set Up Common Objects, >Foundation
Tables >Organization >Location)

Address Line 3

Derivation Steps:

1. Derive from location defined as Reported Site in the CAS Details record.

2. Derive from the location defined as the Main Site in the PBI Configuration record.
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3. Derive from the primary location for the Campus of the applicant or student.

4. Derive as null.

Main Site City
Upload Extract Data page: Course Details

XML Tag: <City>

Mandatory: Yes

Pages Used:

Page Page Element

PBI Configuration Main Site

CAS Details Reported Site

Campus Table (Set Up SACR >Foundation
Tables >Academic Structure >Campus Table)

Location Code

Location Address (Set Up Common Objects, >Foundation
Tables >Organization >Location)

City

Derivation Steps:

1. Derive from location defined as Reported Site in the CAS Details record.

2. Derive from the location defined as the Main Site in the PBI Configuration record.

3. Derive from the primary location for the Campus of the applicant or student.

4. Derive as NULL ERROR.

Main Site County/Area/District
Upload Extract Data page: Course Details

XML Tag: <CountyAreaDistrict>

Mandatory: No

Pages Used:

Page Page Element

PBI Configuration Main Site
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Page Page Element

CAS Details Reported Site

Campus Table (Set Up SACR >Foundation
Tables >Academic Structure >Campus Table)

Location Code

Location Address (Set Up Common Objects, >Foundation
Tables >Organization >Location)

County (UK addresses)

State

Derivation Steps:

1. Derive from location defined as Reported Site in the CAS Details record.

2. Derive from the location defined as the Main Site in the PBI Configuration record.

3. Derive from the primary location for the Campus of the applicant or student.

4. Derive as null.

Main Site Postcode
Upload Extract Data page: Course Details

XML Tag: <PostCode>

Mandatory: Yes

Pages Used:

Page Page Element

PBI Configuration Main Site

CAS Details Reported Site

Campus Table (Set Up SACR >Foundation
Tables >Academic Structure >Campus Table)

Location Code

Location Address (Set Up Common Objects, >Foundation
Tables >Organization >Location)

Post Code

Derivation Steps:

1. Derive from location defined as Reported Site in the CAS Details record.

2. Derive from the location defined as the Main Site in the PBI Configuration record.

3. Derive from the primary location for the Campus of the applicant or student.
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4. Derive as NULL ERROR.

Work Placement
Upload Extract Data page: Course Details

XML Tag: <ApplicantHasWorkPlacement>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Work Placement

Derivation Steps:

1. Derive from the CAS Details record.

Note: Yes is derived as true, No is derived as false.

Work Placement Percentage
Upload Extract Data page: Work Placement Details

XML Tag: <WorkPlacementPercentage>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Placement Percentage

Derivation Steps:

1. Derive as the short translate value from the CAS Details record.

2. Derive as null.

Note: On the CAS Details page, a Placement Percentage value is mandatory for Upload Ready status if
Work Placement is Yes.

Work Placement Justification
Upload Extract Data page: Work Placement Details
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XML Tag: <WorkPlacementJustificationText>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Placement Justification

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as null.

Note: On the CAS Details page, a Placement Justification value is mandatory for Upload Ready status if
Placement Percentage is greater than 033.

Work Placement Address 1
Upload Extract Data page: Work Placement Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Placement Organisation

Academic Plan PBI Data Placement Organisation

Academic Program PBI Data Placement Organisation

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 1

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.
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4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: The delivered address formats for Belgium and the Netherlands do not include use of the Address 1
field. As this is a mandatory value if the country is either Belgium or the Netherlands the value is derived
as a combination of Street (Address Line 3) and Number.

Work Placement Address 2
Upload Extract Data page: Work Placement Details

XML Tag: <AddressLine>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Placement Organisation

Academic Plan PBI Data Placement Organisation

Academic Program PBI Data Placement Organisation

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 2

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Work Placement Address 3
Upload Extract Data page: Work Placement Details

XML Tag: <AddressLine>
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Mandatory: No

Pages Used:

Page Page Element

CAS Details Placement Organisation

Academic Plan PBI Data Placement Organisation

Academic Program PBI Data Placement Organisation

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Address Line 3

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: If the country is either Belgium or the Netherlands the field is derived as null as the Street (Address
Line 3) value is used to derive Work Placement Address 1.

Work Placement City
Upload Extract Data page: Work Placement Details

XML Tag: <City>

Mandatory: If any work placement details are supplied

Pages Used:

Page Page Element

CAS Details Placement Organisation

Academic Plan PBI Data Placement Organisation
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Page Page Element

Academic Program PBI Data Placement Organisation

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

City

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Work Placement Address 1 has a value, derive as NULL ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Note: The delivered address format for Singapore does not include use of the City field. If the country
value is Singapore the City value will also be derived as Singapore.

Work Placement County/Area/District
Upload Extract Data page: Work Placement Details

XML Tag: <CountyAreaDistrict>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Placement Organisation

Academic Plan PBI Data Placement Organisation

Academic Program PBI Data Placement Organisation

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

County (UK addresses)

State

Derivation Steps:

1. Derive from the CAS Details record.
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2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Work Placement Country
Upload Extract Data page: Work Placement Details

XML Tag: <Country>

Mandatory: If any work placement details are supplied

Pages Used:

Page Page Element

CAS Details Placement Organisation

Academic Plan PBI Data Placement Organisation

Academic Program PBI Data Placement Organisation

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Country

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. Derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Work Placement Postcode
Upload Extract Data page: Work Placement Details

XML Tag: <PostCode>

Mandatory: If any work placement details are supplied and country is GBR
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Pages Used:

Page Page Element

CAS Details Placement Organisation

Academic Plan PBI Data Placement Organisation

Academic Program PBI Data Placement Organisation

Location Details (Campus Community, Organization, Create/
Maintain Organizations, Organization Locations, Location
Details)

Post Code

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive from the Academic Plan record.

3. Derive from the Academic Program record.

4. If Work Placement Address 1 has a value and Work Placement Country is GBR, derive as NULL
ERROR, otherwise derive as null.

Note: The address fields are derived from the current active primary location for the selected
organization.

Secure English Language Test (SELT) Required
Upload Extract Data page: Evidence Details

XML Tag: <SELTRequired>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details SELT Required

Derivation Steps:

1. Derive from the CAS Details record. Yes is derived as true, No is derived as false.

Reason SELT Not Required
Upload Extract Data page: Evidence Details
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XML Tag: <ReasonSELTNotRequired>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Reason SELT Not Required

Derivation Steps:

1. Derive as the short translate value from the CAS Details record. If a message number is found in the
short translate value, then derive the message text. Else derive the short translate value. *

2. Derive as null.

* One of the valid values - ENG_COUNTRY  - is too long to be held as short translate name (maximum is
10 characters) in the system. For ENG_COUNTRY, the short translate value is set to a message number
(93).

Note: On the CAS Details page, a Reason SELT Not Required value is mandatory for Upload Ready
status if SELT Required is No.

English Language Level Attained
Upload Extract Data page: Evidence Details

XML Tag: <EnglishLanguageLevelAttained>

Mandatory: No

Pages Used:

Page Page Element

CAS Details English Level Attained

Derivation Steps:

1. Derive as the short translate value from the CAS Details record.

If a Message Number is found for the short translate value, derive as the message text. If the message
is not in the message catalog (set number 14260), derive the field as MESSAGE NOT FOUND.

2. Derive as null.

Note: On the CAS Details page, a English Level Attained value is mandatory for Upload Ready status if
SELT Required is Yes.
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SELT Listening Level
Upload Extract Data page: Evidence Details

XML Tag: <SELTListeningLevel>

Mandatory: No

Pages Used:

Page Page Element

CAS Details English Listening Level

Derivation Steps:

1. Derive short translate name of the value from the CAS Details record.

2. Derive as null.

SELT Reading Level
Upload Extract Data page: Evidence Details

XML Tag: <SELTReadingLevel>

Mandatory: No

Pages Used:

Page Page Element

CAS Details English Reading Level

Derivation Steps:

1. Derive short translate name of the value from the CAS Details record.

2. Derive as null.

SELT Speaking Level
Upload Extract Data page: Evidence Details

XML Tag: <SELTSpeakingLevel>

Mandatory: No

Pages Used:

1184  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 29 (GBR) PBI Field Derivation

Page Page Element

CAS Details English Speaking Level

Derivation Steps:

1. Derive short translate name of the value from the CAS Details record.

2. Derive as null.

SELT Writing Level
Upload Extract Data page: Evidence Details

XML Tag: <SELTWritingLevel>

Mandatory: No

Pages Used:

Page Page Element

CAS Details English Writing Level

Derivation Steps:

1. Derive short translate name of the value from the CAS Details record.

2. Derive as null.

SELT Test Provider
Upload Extract Data page: Evidence Details

XML Tag: <TestProvider>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Training Provider

Derivation Steps:

1. Derive as the short translate value from the CAS Details record.
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If a Message Number is found for the short translate value, derive as the message text. If the message
is not in the message catalog (set number 14260), derive the field as MESSAGE NOT FOUND.

2. Derive as null.

Note: On the CAS Details page, a Training Provider value is mandatory for Upload Ready status if SELT
Required is Yes.

Previous UK Study
Upload Extract Data page: Evidence Details

XML Tag: <PreviousUKStudy>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Previous UK Study

Derivation Steps:

1. Derive from the CAS Details record. Yes is derived as true, No is derived as false.

Previous Academic Level
Upload Extract Data page: Evidence Details

XML Tag: <PreviousAcademicLevel>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Previous Academic Level

Derivation Steps:

1. Derive as the short translate value from the CAS Details record.

If a Message Number is found for the short translate value, derive as the message text. If the message
is not in the Message Catalog (set number 14260), derive the field as MESSAGE NOT FOUND.

2. Derive as null.
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Note: On the CAS Details page, a Previous Academic Level value is mandatory for Upload Ready status
if Previous UK Study is Yes.

Current Level Comparison
Upload Extract Data page: Evidence Details

XML Tag: <CurrentPreviousCourseLevelComparison>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Current Level Comparison

Derivation Steps:

1. Derive as the short translate value (upper case) from the CAS Details record.

If a Message Number is found for the short name, derive as the message text. If the message is not in
the Message Catalog (set number 14260), derive the field as MESSAGE NOT FOUND.

2. Derive as null.

Note: On the CAS Details page, a Current Level Comparison value is mandatory for Upload Ready status
if Previous UK Study is Yes.

Progression Justification
Upload Extract Data page: Evidence Details

XML Tag: <ProgressionJustification>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Progression Justification

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as null.
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Note: On the CAS Details page, a Progression Justification value is mandatory for Upload Ready status if
Current Level Comparison is L or S.

Accommodation Provided
Upload Extract Data page: Financial Details

XML Tag: <AccommodationProvided>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Accommodation Provided

Derivation Steps:

1. Derive from the CAS Details record.

Note: Yes is derived as true, No is derived as false.

Accommodation Fees Included
Upload Extract Data page: Financial Details

XML Tag: <CourseFeeIncludesAccomodationCosts>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Accommodation Fee Included

Derivation Steps:

1. Derive from the CAS Details record.

Note: Yes is derived as true, No is derived as false.

First Year Course Fees
Upload Extract Data page: Financial Details

XML Tag: <CourseFeesForFirstYearOnly>
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Mandatory: Yes

Pages Used:

Page Page Element

CAS Details First Year Course Fees

Derivation Steps:

1. Derive from the CAS Details record. Derive as 0, if the First Year Course Fees is 0 on the CAS Details
page.

Course Fees Paid
Upload Extract Data page: Financial Details

XML Tag: <CourseFeesPaidToDate>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Course Fees Paid

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as null.

Accommodation Fees Paid
Upload Extract Data page: Financial Details

XML Tag: <AccommodationFeesPaidToDate>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Accommodation Fees Paid

Derivation Steps:
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1. Derive from the CAS Details record.

2. Derive as null.

First Year Boarding Fees
Upload Extract Data page: Financial Details

XML Tag: <BoardingFeesForFirstYearOnly>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details First Year Boarding Fees

Derivation Steps:

1. Derive from the CAS Details record. Derive as 0, if the First Year Boarding Fees is 0 on the CAS
Details page.

Boarding Fees Paid
Upload Extract Data page: Financial Details

XML Tag: <BoardingFeesPaidToDate>

Mandatory: No

Pages Used:

Page Page Element

CAS Details Boarding Fees Paid

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as null.

ATAS Certificate Required
Upload Extract Data page: Certification

XML Tag: <CourseRequiresATAS>

Mandatory: Yes
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Pages Used:

Page Page Element

CAS Details ATAS Certificate Required

Derivation Steps:

1. Derive from the CAS Details record.

Note: Yes is derived as true, No is derived as false.

Dean's Certificate Required
Upload Extract Data page: Certification

XML Tag: <PostgraduateDeanCertificateRequired>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Dean's Certificate Required

Derivation Steps:

1. Derive from the CAS Details record.

Note: Yes is derived as true, No is derived as false.

Offer Documents
Upload Extract Data page: Documentation

XML Tag: <DocumentsUsedToObtainOffer>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details Offer Documents

Derivation Steps:
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1. Derive from the CAS Details record.

Update Extract Fields

This section discusses how the Create Extract process derives the field values for the Update extract.

Update File ID
Update Extract Data page: Header

XML Tag: <BulkUpdateFileId>

Mandatory: Yes

Pages Used:

Page Page Element

Create Extract Data (Student Admissions, PBI Processing ,
 Create Extract Data)

Update File ID Override

Derivation Steps:

1. Derive from the Update File ID Override parameter of the Create Extract process.

2. Derive in the format INST_UPDATE_YYYY_MM_DD_nn (for example,
PSUNV_UPDATE_2009_09_27_01), where INST is the institution code and nn is an automatically
generated sequence number for the day.

CAS Number
Update Extract Data page: Header

XML Tag: <CASNumber>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details CAS Number

Derivation Steps:

1. Derive from the CAS Details page.
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First Year Course Fees
Update Extract Data page: Financial Details

XML Tag: <CourseFeesForFirstYearOnly>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details First Year Course Fees

Derivation Steps:

1. Derive from the CAS Details record. Derive as 0, if the First Year Course Fees is 0 on the CAS Details
page.

Course Fees Paid
Update Extract Data page: Financial Details

XML Tag: <CourseFeesPaidToDate>

Mandatory: One of the Fees Paid fields must be present.

Pages Used:

Page Page Element

CAS Details Course Fees Paid

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as zero.

Note: An error message is logged if none of the Fees Paid fields contains a value greater than zero.

Accommodation Fees Paid
Update Extract Data page: Financial Details

XML Tag: <AccommodationFeesPaidToDate>

Mandatory: One of the Fees Paid fields must be present.

Pages Used:
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Page Page Element

CAS Details Accommodation Fees Paid

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as zero.

Note: An error message is logged if none of the Fees Paid fields contains a value greater than zero.

Boarding Fees Paid
Update Extract Data page: Financial Details

XML Tag: <BoardingFeesPaidToDate>

Mandatory: One of the Fees Paid fields must be present.

Pages Used:

Page Page Element

CAS Details Boarding Fees Paid

Derivation Steps:

1. Derive from the CAS Details record.

2. Derive as zero.

Note: An error message is logged if none of the Fees Paid fields contains a value greater than zero.

Report File Fields

This section discusses how the Create Extract process derives the field values for the Report extract.

Report File ID
Report Extract Data page: Header

XML Tag: <BulkReportingID>

Mandatory: Yes

Pages Used:
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Page Page Element

Create Extract Data (Student Admissions, PBI Processing ,
 Create Extract Data)

Report File ID Override

Derivation Steps:

1. Derive from the Report File ID Override parameter of the Create Extract process.

2. Derive in the format INST_REPORT_YYYY_MM_DD_nn (for example,
PSUNV_REPORT_2009_09_27_01), where INST is the institution code and nn is an automatically
generated sequence number for the day.

CAS Number
Report Extract Data page: Header

XML Tag: <CASNumber>

Mandatory: Yes

Pages Used:

Page Page Element

CAS Details CAS Number

Derivation Steps:

1. Derive from the CAS Details record.

Expected Enrollment Date
Report Extract Data page: Report Details

XML Tag: <ExpectedEnrollmentDate>

Mandatory: Yes

Pages Used:

Page Page Element

Report Details (Student Admissions, PBI Processing, CAS
Maintenance, Report Details)

Expected Enrollment

Derivation Steps:

1. Derive from the CAS Details record
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Notes
Report Extract Data page: Report Details

XML Tag: <Notes>

Mandatory: No

Pages Used:

Page Page Element

Report Details (Student Admissions, PBI Processing, CAS
Maintenance, Report Details)

Notes

Derivation Steps:

1. Derive from the CAS Details record

2. Derive as NULL ERROR.
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(NLD) Managing Studielink

Understanding Studielink

Documentation for setting up and managing Studielink is not available in Online Help. For Studielink
documentation, see PeopleSoft Campus Solutions Selected PeopleBook Chapters for the Netherlands
(NLD) in My Oracle Support (ID 2052493.1).

The documentation in My Oracle Support includes these topics:

• Setting up Studielink

• Receiving messages from Studielink

• Posting Studielink messages to application tables

• Reviewing and updating Studielink information

• Managing outbound messages

• Changing student status using Studielink
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(NLD) Managing the BRON Interface

Understanding BRON

Documentation for setting up and managing BRON is not available in Online Help. For BRON
documentation, see PeopleSoft Campus Solutions Selected PeopleBook Chapters for the Netherlands
(NLD) in My Oracle Support (ID 2052493.1).

The documentation in My Oracle Support includes these topics:

• Setting up the BRON interface

• Setting up BO for BRON

• Setting up ED for BRON

• Setting up VAVO for BRON

• Setting up NT2 for BRON

• Setting up BRON prior education

• Setting up BRON enrollment end reason

• Setting up BRON funding reason

• Setting up BRON BO error messages

• Creating and sending the BRON file

• Reviewing the BRON file before sending

• Viewing BRON history by student

• Managing BRON return file processing

• Managing GBA data

• Managing BRON snapshot files
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Evaluating Applicants

Understanding the Evaluating Applicants Business Process

This section lists prerequisites and discusses the evaluating applicants business process.

Prerequisites
Before you begin evaluating applicants, applications must be fully entered into your system. Depending
on your office procedures, you will add evaluations at different times during the year. Although not all of
the following information is required to run evaluations, the following list can serve as an overview of the
relevant data that can be entered, and thus considered, for an application:

• Applicant demographics.

• Applicant address.

• Application program data.

• Application data.

• Application recruiting data.

• External education data.

• Test results.

• General materials.

• Application materials.

• Early financial aid offer information.

Evaluating Applicants Business Process
There are many ways you can use your system to evaluate applicants. Recruiting and Admissions
provides SQR processes that enable you to automate much of your business process. You can also use
Recruiting and Admissions to evaluate applicants manually. In fact, many combinations of manual and
automated processes can work. Therefore, before evaluating applicants, decide how you want to use your
system to evaluate applicants.

Regardless of whether you choose to evaluate applicants manually, through SQR processes, or through
a combination of manual and automated processing, you must define rating schemes and the rating
components that make up rating schemes. You must also define:

• Evaluation codes.
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• Evaluation committees (if applicable to your evaluation business process).

• Evaluation status codes.

After you have set up the process for evaluating applicants, you are ready to perform the evaluations. This
is where you have the most options regarding manual processing versus automatic processing. Performing
applicant evaluations involves:

• Assigning evaluation codes to applicants.

• Linking materials (such as recommendations, essays, and portfolios) to applications.

• Assigning committees (which consist of the evaluators who physically evaluate the applicants).

• Entering evaluator ratings.

• Retrieving and evaluating objective ratings (such as test scores and GPA) from the applications.

After you have defined rating schemes, evaluation codes, committees, and evaluation statuses, you are
ready to evaluate the applicants. Depending on the evaluation code/rating scheme structure that your
institution uses, there are many ways to evaluate applicants. This book limits the discussion to the tools
that you can use to fulfill your specific needs. These tools include:

• General evaluations and general evaluator ratings.

• Application evaluations and application evaluation ratings.

• An automated method for assigning evaluation components.

• An SQR process for linking application materials to applications.

• An SQR process for entering rating values.

• An SQR process for evaluating applicants based on rating values, and for updating application
evaluation statuses.

• A COBOL process for calculating enrollment deposits.

• A COBOL process for activating applicants as students.

Use these tools to assign evaluation codes to applications, to enter and retrieve rating component values,
to enter or have the system calculate overall rating values, to evaluate the applicant based on those overall
rating values, and to update the applicant's program status.

Automatic Versus Manual Processing

The following table presents the steps that can be performed manually or automatically:

Task To execute automatically To execute manually

Assign evaluation codes. Evaluation Code Assignment process

ADEVALCD.SQR

General Evaluations component or
Application Evaluations component.
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Task To execute automatically To execute manually

Link application materials. Application Materials Extract process
ADMTEXT.SQR

Application Materials page.

Enter rating values for rating schemes
and rating components.

For objective rating components:

Evaluation Calculation process

ADMTLRTG.SQR

For subjective rating components:

General Evaluator Ratings component
or Application Evaluator Ratings
component.

Evaluate applicants based on rating
values, and update application evaluation
statuses.

Application Status Update

ADMTLPGS.SQR

General Evaluations component or
Application Evaluations component.

Calculate enrollment deposits. When you update application evaluation
statuses in batch:

SFPBADEP (COBOL SQL)

Calculate Deposit Fees link on the
Application Program Data page.

Activate applicants as students. When you update application evaluation
statuses in batch:

ADPCPPRC (COBOL SQL)

Application Program Data page in the
Application Maintenance component.

Your institution can rename the processes listed in the above table. You can also add to or edit the SQCs
for the SQRs listed above. Check with your system administrator for more information about the specific
SQRs and SQCs used by your institution.

General Versus Application Evaluations

To assign evaluation codes manually, you must create an evaluation for each applicant. There are two sets
of components that you can use to create evaluations for an applicant.

• Use the General Evaluations and General Evaluator Ratings components to create general
evaluations.

General evaluations are not tied to a career, program, or application number. Therefore, use general
evaluations to evaluate applicants on general criteria that are not required by a particular career or
program (such as a statement of purpose that the institution requires, regardless of the career or
program the person is applying to). In addition, because general evaluations are not tied to application
numbers, you can use general evaluations to evaluate individuals (such as prospects) without having
to enter an application.

• Use the Application Evaluations and Application Evaluator Ratings components to create application
evaluations.
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Application evaluations are tied to a career, program, and application number. Therefore, use
application evaluations to evaluate applicants on specific criteria for the career and program to which
they are applying.

You can evaluate an applicant using both of these sets of components if you desire. You also use
these components to enter ratings. You can enter the ratings manually, or you can use the Application
Evaluation process to retrieve and evaluate objective scores, and then enter rating values. If you enter
ratings manually, you use the Application Evaluator Ratings or the General Evaluator Ratings page. If
the Application Evaluation process retrieves the ratings, they appear on the Overall Ratings page in the
Application Evaluation component.

Understanding Automatic Overall Rating Calculation

Your Recruiting and Admissions application is equipped with a background process that averages
evaluator ratings and overall ratings. Therefore, you only have to manually enter rating values at the
rating component level. The system averages those ratings and populates overall ratings at the next higher
level. The system continues to average overall ratings until you have an overall rating for the application.

This chart illustrates the hierarchical structure of the background process that averages evaluator ratings
and overall ratings.

You must first enter rating component rating values. The system then calculates the overall rating value
for the scheme. After all of the overall rating values for the scheme have been calculated, the system
calculates the overall rating value for the evaluator, and the process continues hierarchically.
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For example, suppose you assigned two committees to evaluate an applicant. One committee is to
evaluate essays and interviews, and the second committee is to evaluate other materials (for simplicity
we will not look at the details of the second committee). The first committee consists of two committee
members (or evaluators). Each evaluator evaluates two schemes: the undergraduate essay and the
undergraduate interview. The evaluators evaluate the style and grammar components of the undergraduate
essay scheme, and they evaluate the delivery and preparation components of the undergraduate interview
scheme.

1. First, the evaluator enters ratings for each component in each scheme.

In the example in the diagram above, the first evaluator entered 10 for style and 8 for grammar for the
essay, and 6 for delivery and 8 for preparation for the interview. The second evaluator entered 4 for
style and 6 for grammar for the essay, and 6 for delivery and 8 for preparation for the interview. For
the system to calculate the averages, you must enter values at this level first.

2. When the evaluators saved the pages, the system calculates the averages for each scheme and
populates the Overall Rating fields on the General Evaluator Rating page or the Application Evaluator
Rating page, depending on the type of evaluation.

In our example, the overall rating for the first scheme for Evaluator1 is 9 (the average of 10 and 8),
and the overall rating for the second scheme for Evaluator1 is 7 (the average of 6 and 8). The overall
rating for the first scheme for Evaluator2 is 5 (the average of 4 and 6), and the overall rating for the
second scheme for Evaluator2 is 7 (the average of 6 and 8).

3. After each scheme has an overall rating value, the system populates the overall rating for the
evaluator (after you save the page) and populates the Overall Rating field on the Evaluator Ratings
page in the General Evaluation or Application Evaluation components, depending on the type of
evaluation.

In our example, the overall rating for Evaluator1 is 8 (the average of 9 and 7), and the overall rating
for Evaluator2 is 6 (the average of 5 and 7).

4. After each evaluator has an overall rating value, the system populates the overall rating for the
committee (after you save the page) and populates the Overall Rating field on the Evaluation
Committee page in the General Evaluation or Application Evaluation components, depending on the
type of evaluation.

In our example, the overall rating for Committee1 is 7 (the average of 8 and 6), and suppose that the
overall rating for Committee2 is 9.

5. After each committee has an overall rating value, the system populates the overall rating for the
application (after you save the page) and populates the Overall Rating field on the General Evaluation
or Application Evaluation page, depending on the type of evaluation.

In our example, the overall rating for the application is 8 (the average of 7 and 9).

Remember that you must start at the first step. If you manually enter overall ratings for a scheme,
for instance, without entering components, you will break the chain and the system will not calculate
averages at any level. In other words, the system only calculates overall ratings at any given level if it had
calculated the overall ratings at every level below that one.
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Creating General Evaluations

This section discusses how to:

• Assign an evaluation code to a general evaluation.

• Link general materials to a general evaluation.

• Assign a committee to a general evaluation.

• Assign evaluators to a general evaluation.

Pages Used to Create General Evaluations

Page Name Definition Name Navigation Usage

General Evaluation GENL_EVAL1 • Student Recruiting >
Evaluate Prospects >
General Evaluations

• Student Recruiting >
Evaluate Prospects >
Student Admissions >
Application
Evaluation > General
Evaluations

Assign evaluation codes
and to enter high level,
 general information about a
person. The evaluation code
populates various fields in
this component with default
information (such as rating
schemes and committees).
 You can also link general
materials to an evaluation
from this page.

Select General Materials GENL_MATL_POPUP Click the  Link Materials
link on the General Evaluation
page.

Link general materials to a
general evaluation.

View Assigned Materials MATL_EVAL_POPUP Click the appropriate Detail
button on the Select General
Materials page.

View details about a Material
Type.

General Evaluation
Committee

GENL_EVAL2 • Student Recruiting >
Evaluate Prospects >
General Evaluations >
General Evaluation
Committee

• Student Admissions >
Application
Evaluation > General
Evaluations > General
Evaluation Committee

Assign general evaluation
committees to a general
evaluation. The overall ratings
of the committees you assign
are also stored on this page.

1206  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 32 Evaluating Applicants

Page Name Definition Name Navigation Usage

General Evaluators GENL_EVAL3 • Student Recruiting >
Evaluate Prospects >
General Evaluations >
General Evaluators

• Student Admissions >
Application
Evaluation > General
Evaluations > General
Evaluators

Assign evaluators to a general
evaluation, and to record
overall ratings for each
evaluator. The evaluators
can be from a committee or
you can choose any person in
your database. The individual
evaluators' overall ratings also
appear on this page.

Assigning an Evaluation Code to a General Evaluation
Access the General Evaluation page (Student Recruiting > Evaluate Prospects > General
Evaluations).

This example illustrates the fields and controls on the General Evaluation page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Eval Code (evaluation code) Select the evaluation code to be used to evaluate this person.
Other fields on this page (such as Scheme) populate according
to the evaluation code you select. This is where you assign
evaluation codes to evaluations manually. Define evaluation
codes on the Evaluation Table page.
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Field or Control Description

Eval Nbr (evaluation number) The evaluation number default is 1 for the first general
evaluation you enter, 2 for the second, and continues
incrementally.

Eval Stat (evaluation status) Select the current evaluation status of this general evaluation.
 Define evaluation status codes on the Evaluation Status Table
page.

Eval Dt (evaluation date) The default for the evaluation date is your system date.

Scheme Select the rating scheme you want to use for this general
evaluation. If the evaluation code entered on this page is
linked to a committee rating ID scheme, that scheme appears
automatically. Define rating schemes on the Rating Scheme
Table page.

Overall Rating If you are using rating schemes, and if you entered all the
evaluator ratings for every committee linked to this person,
 this value appears automatically. However, you must enter
ratings at the lowest level first for this functionality to work.
 Overall ratings for each committee are stored on the General
Evaluation Committee page. You can override this calculation.
 Additionally, if you choose not to use rating schemes to
evaluate prospects and applicants, you can enter an overall
rating manually.

See Evaluating Applicants Business Process.

Note: This value does not include rating values that were
retrieved and calculated by the Evaluation Calculation process.

Link Materials Click this link to link general materials to this general
evaluation. This link is available only after you save the page,
provided there are general materials stored for this person. You
can only choose from the general materials that are linked to
this person. The Select General Materials Page appears.

View Materials Click this link to view the general materials that are linked to
this general evaluation. This link is available after you save the
page, provided that you have linked materials to this general
evaluation on the Select General Materials page. The View
Assigned Materials Page appears.

Go Click to go to another component.

Linking General Materials to a General Evaluation
Access the Select General Materials page (Click the Link Materials link on the General Evaluation page).
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This example illustrates the fields and controls on the Select General Materials page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Material Type Select the material type that you want to link to this
evaluation.

Assigning a Committee to a General Evaluation
Access the General Evaluation Committee page (Student Recruiting > Evaluate Prospects > General
Evaluations > General Evaluation Committee or Student Admissions > Application Evaluation >
General Evaluations > General Evaluation Committee).

This example illustrates the fields and controls on the General Evaluation Committee page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Committee The system populates the committee if the evaluation code for
this general evaluation has an evaluation committee assigned
to it. You can add committees.

Note: To create general evaluations, you must assign an
evaluation committee. However, an evaluation committee can
be made up of only one person.

Evaluation Status Select the evaluation status reflecting the current status of this
committee's evaluation. Define evaluation status codes on the
Evaluation Status Table page.

Evaluation Date The default for the evaluation date is the system date.

Overall Rating The system automatically calculates the overall rating for the
entire committee by averaging the overall ratings entered for
each evaluator in this committee assigned to this evaluation
and scheme. However, you must enter ratings at the lowest
level first for this functionality to work. Overall ratings for
each evaluator are stored on the General Evaluators page. You
can override this calculation. Additionally, if you choose not
to use rating schemes to evaluate applicants, you can enter an
overall rating manually.

Related Links
Understanding the Evaluating Applicants Business Process

Assigning Evaluators to a General Evaluation
Access the General Evaluators page (Student Recruiting > Evaluate Prospects > General
Evaluations > General Evaluators  or Student Admissions > Application Evaluation > General
Evaluations > General Evaluators).
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This example illustrates the fields and controls on the General Evaluators page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Evaluator ID Enter an evaluator ID number. An evaluator can be any person
in your database. If you entered a committee on the General
Evaluation Committee page, the evaluators on that committee
will appear here. You can add and delete evaluators from those
that appear.

Note: You cannot enter evaluators under an evaluation code
unless you have first entered a committee on the General
Evaluation Committee page.

Committee Role Enter the role that this evaluator plays on the committee. The
person's role automatically appears if the committee member is
already assigned a role.

Evaluation Status Select the evaluation status reflecting the current status of this
evaluator's evaluation. You set up evaluation status codes on
the Evaluation Status Table page.

Evaluation Date The default for the evaluation date is your system date.
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Field or Control Description

Overall Rating The system automatically calculates the overall rating for the
evaluator by averaging the overall ratings for each scheme that
the evaluator evaluated. However, you must enter ratings at the
lowest level first for this functionality to work. Overall ratings
for each scheme (by evaluator) are stored on the General
Evaluator Rating page. You can override this calculation.
 Additionally, if you choose not to use rating schemes to
evaluate applicants or prospects, you can enter an overall
rating manually.

Related Links
Evaluating Applicants Business Process

Entering and Updating General Evaluator Ratings

Use the General Evaluator Ratings component to enter rating component values and overall ratings for
evaluators. Only use this component if you are evaluating applicants based on rating schemes.

This section discusses how to:

• Enter and update general evaluator overall ratings.

• Enter and update general evaluator ratings of rating components.

Pages Used to Enter and Update General Evaluator Ratings

Page Name Definition Name Navigation Usage

General Evaluator Rating GENL_RATING1 • Student Recruiting >
Evaluate Prospects >
General Evaluator
Rating

• Student Admissions >
Application
Evaluation > General
Evaluator Rating

Enter general evaluator rating
information (such as the rating
scheme, evaluation status, and
the evaluator's overall rating.)

You have to first set up an
applicant evaluation based
on an evaluation code in
the General Evaluations
component.
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Page Name Definition Name Navigation Usage

General Evaluator Detail GENL_RATING2 • Student Recruiting >
Evaluate Prospects >
General Evaluator
Rating > General
Evaluator Detail

• Student Admissions >
Application
Evaluation > General
Evaluator Rating >
General Evaluator
Detail

Enter an evaluator's ratings of
the components for a rating
scheme. The system averages
and displays the ratings
entered here on the General
Evaluator Rating page.

You must first complete the
General Evaluator Rating
page.

Entering and Updating General Evaluator Overall Ratings
Access the General Evaluator Rating page (Student Recruiting > Evaluate Prospects > General
Evaluator Rating or Student Admissions > Application Evaluation > General Evaluator Rating).

This example illustrates the fields and controls on the General Evaluator Rating page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Scheme The system populates the rating scheme according to the
rating scheme entered on the General Evaluation page for this
evaluation code and for this person. You can add more than
one rating scheme for an evaluator.
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Field or Control Description

Evaluation Status Select the evaluation status reflecting the current status of
this evaluator's evaluation (for this scheme). Evaluation status
codes are set up on the Evaluation Status Table page.

Evaluation Date The default for the evaluation date is your system date.

Overall Rating The system automatically calculates the overall rating based
on the ratings for each rating component entered for this
evaluator (and for this scheme). Ratings for each component 
(by evaluator) are stored on the General Evaluator Detail page.
 You can override this calculation.

Entering and Updating General Evaluator Ratings of Rating Components
Access the General Evaluator Detail page (Student Recruiting > Evaluate Prospects > General
Evaluator Rating > General Evaluator Detail or Student Admissions > Application Evaluation >
General Evaluator Rating > General Evaluator Detail).

This example illustrates the fields and controls on the General Evaluator Detail page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Component  and Type The rating components and types linked to this rating scheme
automatically appear. Edit or add new components and
corresponding types.

Rating Value Enter a rating value for each component in this rating scheme.
 If you set up rating values for the rating components for this
rating scheme, you can prompt for those values. Define rating
values on the Rating Components Table page.

When you save this page, the system averages the rating
values for each component and populates the overall rating for
the rating scheme (for this evaluator) on the General Evaluator
Rating page. You must enter ratings on this page first in order
for the system to calculate overall ratings. This is the lowest
level of the calculation.

Creating Application Evaluations

Use the Application Evaluations component to create application evaluations. Application evaluations
are tied to an academic career, academic program, and application number. Therefore, use application
evaluations to evaluate applicants on specific criteria for the academic career and program that they are
applying to.

Use this component to record subjective rating values (such as a rating given by a committee) and
objective rating values (such as a test score). If you are using the Automatic Evaluation process to retrieve
objective rating values from applications, those rating values appear on the Overall Rating page in this
component.

After creating the application evaluation, use the Application Evaluator Ratings component to enter actual
evaluator rating values. However, if you are not using rating schemes, you can manually enter overall
ratings in the General Evaluations component.

This section discusses how to:

• Assign an evaluation code to an application.

• Enter overall component ratings for an application.

• Assign a committee to an application evaluation.

• Assign evaluators to an application evaluation.
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Pages Used to Create Application Evaluations

Page Name Definition Name Navigation Usage

Application Evaluation ADM_EVAL1 Student Admissions >
Application Evaluation >
Application Evaluation

Assign evaluation codes
and to enter high level,
 general information about
an applicant. The evaluation
code populates various fields
in this component with default
information (such as rating
schemes and committees).

Overall Rating ADM_OVERALL_RATING Student Admissions >
Application Evaluation >
Application Evaluation >
Overall Rating

Manually enter or edit overall
rating information for an
application evaluation. The
Overall Rating page stores
objective overall rating
information for an application
evaluation. Rating values for
a rating scheme's components
are stored on this page for
an application evaluation.
 Because it is unnecessary
for each committee member
to evaluate objective
information (such as a
test score), you can store
objective rating values for
each application in one place.
 You can enter the rating
values manually, or you can
use the Evaluation Calculation
process to determine the
values.

Committee Rating ADM_EVAL2 Student Admissions >
Application Evaluation >
Application Evaluation >
Committee Rating

Assign application evaluation
committees to an application
evaluation. The overall ratings
of the committees you assign
are also stored on this page.

Evaluator Rating ADM_EVAL3 Student Admissions >
Application Evaluation >
Application Evaluation >
Evaluator Rating

Assign evaluators to an
application evaluation, and
record overall ratings for each
evaluator. The evaluators
can be from a committee or
you can choose any person in
your database. The individual
evaluators' overall ratings also
appear on this page.
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Assigning an Evaluation Code to an Application
Access the Application Evaluation page (Student Admissions > Application Evaluation > Application
Evaluation).

This example illustrates the fields and controls on the Application Evaluation page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Evaluation Code Enter an evaluation code to be used to evaluate this applicant.
Evaluation codes are set up on the Evaluation Table page. This
is where you assign evaluation codes to evaluations manually.
 Evaluation codes can also be assigned automatically using the
evaluation code assignment process.

See Assigning Evaluation Codes to Applications in Batch.

Evaluation Nbr  (number) The evaluation number automatically populates as 1 for the
first application evaluation you enter, 2 for the second, and
continues incrementally.

Eval Stat (evaluation status) Select the evaluation status reflecting the current status of this
application evaluation. Define evaluation status codes on the
Evaluation Status Table page.

Eval Dt  (evaluation date) The default evaluation date is your system date. Edit the date.
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Field or Control Description

Committee Rating ID The committee rating ID automatically appears if the
evaluation code was defined with a committee rating ID. A
committee rating ID is a rating scheme with a type equal to
Committee. Such schemes evaluate subjective information
about an application. If you only want to evaluate objective
data, select an overall rating ID only. You can change the
committee rating ID.

Overall Rating ID The overall rating ID automatically appears if the evaluation
code was defined with an overall rating ID. An overall rating
ID is a rating scheme with a type equal to Overall. Such rating
schemes evaluate objective information about an application.
If you only want to evaluate subjective data, enter a committee
rating ID only. You can change the overall rating ID.

Recalculation Evaluation The system selects this check box if application materials
were linked to this application—either manually or through
the application materials extract process (ADMTEXT.SQR)
—after the application status update process processed
this application. This tells the system that even though this
application has already gone through the application status
update process, it needs to go through it again.

Go Click to go to another component.

Entering Overall Component Ratings for an Application
Access the Overall Rating page (Student Admissions > Application Evaluation > Application
Evaluation > Overall Rating).
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This example illustrates the fields and controls on the Overall Rating page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

New Course, New Subject, New Summary, New Test Score,
 and New General Material

If a new course, subject, academic summary, test score, or
general material is added to this person's record, the system
automatically selects their respective check boxes. These
check boxes cannot be manually selected.

Automatic Update Process The system selects this check box if one of the other choices
in this group box is selected. When this check box is
selected, it lets the automatic update process know that this
application needs to be considered for processing when you
run the application materials extract process. The system
automatically sets these flags if a new transcript, test score, or
general material is added for the employee ID.

Rating Component The rating components of the rating scheme that you entered
in the Overall Rating ID field on the Application Evaluation
page appear. You can add new rating components.

Rating Value If you are manually rating these components, enter the rating
values for each component that you want to award this
application. The Evaluation Calculation process will calculate
these values if you are automatically rating these components.

Final Value The system selects this check box if the rating component was
defined as a final value component. Final value components
are those that are required to be filled before the Evaluation
Calculation process processes this application.
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Field or Control Description

Evaluated The system selects this check box if a rating component was
evaluated through the Evaluation Calculation process. If you
are manually evaluating this component, select this check box
after evaluating the component.

Go Click to go to another component.

Assigning a Committee to an Application Evaluation
Access the Committee Rating page (Student Admissions > Application Evaluation > Application
Evaluation > Committee Rating).

This example illustrates the fields and controls on the Committee Rating page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Committee The system populates the committee if the evaluation code
for this application evaluation has an evaluation committee
assigned to it. You can add committees.

Committee Type The type of the committee that you select appears.
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Field or Control Description

Evaluation Status Select the evaluation status reflecting the current status of
this committee's evaluation. The evaluation code assignment
process enters the evaluation status when you assign
evaluation codes automatically. Define evaluation status codes
on the Evaluation Status Table page.

Evaluation Date The default for the evaluation date is the system date. The
evaluation code assignment process enters the evaluation date
when you assign evaluation codes automatically.

Overall Rating The system automatically calculates the overall rating for
the entire committee by averaging the overall ratings entered
for each evaluator assigned to this evaluation and scheme.
 However, you must enter ratings at the lowest level first for
this functionality to work. Overall ratings for each evaluator
are stored on the General Evaluators page. You can override
this calculation. Additionally, if you choose not to use rating
schemes to evaluate applications, you can enter an overall
rating manually.

Go Click to go to another component.

Assigning Evaluators to an Application Evaluation
Access the Evaluator Rating page (Student Admissions > Application Evaluation > Application
Evaluation > Evaluator Rating).
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This example illustrates the fields and controls on the Evaluator Rating page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Evaluator ID Enter an evaluator ID number. An evaluator can be any
person in your database. If you entered a committee on the
Application Evaluation Committee page, the evaluators on that
committee will appear here. You can add and delete evaluators
from those that appear.

Note: You cannot enter evaluators under an evaluation code
unless you have first entered a committee on the Committee
Rating page.

Committee Role Enter the role that this evaluator plays on the committee. The
person's role automatically appears if the committee member is
already assigned a role.

Evaluation Status Select the evaluation status reflecting the current status of this
evaluator's evaluation. Evaluation status codes are set up on
the Evaluation Status Table page.

Evaluation Date The default for the evaluation date is your system date.
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Field or Control Description

Overall Rating The system automatically calculates the overall rating for the
evaluator by averaging the overall ratings for each scheme that
the evaluator evaluated. However, you must enter ratings at the
lowest level first for this functionality to work. Overall ratings
for each scheme (by evaluator) are stored on the Application
Evaluator Rating page. You can override this calculation.
 Additionally, if you choose not to use rating schemes to
evaluate applications, you can enter an overall rating manually.

Entering and Updating Evaluator Ratings for an Application

Use the Application Evaluator Rating component to enter rating component values and overall ratings for
evaluators. Only use this component if you are evaluating applications based on rating schemes.

This section discusses how to:

• Enter and update evaluator overall ratings for an application evaluation.

• Enter and update evaluator ratings of individual rating components.

Pages Used to Enter and Update Evaluator Ratings for an Application

Page Name Definition Name Navigation Usage

Application Evaluator Rating ADM_RATING1 Student Admissions >
Application Evaluation >
Evaluate Application
Materials > Application
Evaluator Ratings

Enter evaluator rating
information (such as the rating
scheme, evaluation status, and
the evaluator's overall rating.)

Application Evaluator Detail ADM_RATING2 Student Admissions >
Application Evaluation >
Evaluate Application
Materials > Application
Evaluator Ratings >
Application Evaluator
Detail

Enter an evaluator's ratings
of the components of a rating
scheme. The system then
averages and displays these
ratings on the Application
Evaluator Rating page.

Entering and Updating Evaluator Overall Ratings for an Application
Evaluation

Access the Application Evaluator Rating page (Student Admissions > Application Evaluation >
Evaluate Application Materials > Application Evaluator Ratings).
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This example illustrates the fields and controls on the Application Evaluator Rating page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Scheme The system populates the rating scheme according to the rating
scheme entered on the Application Evaluation page for this
evaluation code (for this person). You can add more than one
rating scheme for an evaluator.

Evaluation Status Select the evaluation status reflecting the current status of
this evaluator's evaluation (for this scheme). Evaluation status
codes are set up on the Evaluation Status Table page.

Evaluation Date The default for the evaluation date is your system date.

Overall Rating The system automatically calculates the overall rating by
averaging the ratings for each rating component entered
for this evaluator (and for this scheme). Ratings for each
component (by evaluator) are stored on the Application
Evaluator Detail page. You can override this calculation.
 Additionally, if you choose not to use rating schemes to
evaluate applications, you can enter an overall rating manually.

Entering and Updating Evaluator Ratings of Individual Rating Components
Access the Application Evaluator Detail page (Student Admissions > Application Evaluation >
Evaluate Application Materials > Application Evaluator Ratings > Application Evaluator Detail).
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This example illustrates the fields and controls on the Application Evaluator Detail page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Component and Type The rating components and types linked to this rating scheme
automatically appear. Edit or add new components and
corresponding types.

Rating Value Enter a rating value for each component in this rating scheme.
 If you set up rating values for the rating components for this
rating scheme, you can prompt for those values. Define rating
values on the Rating Components Table page.

When you save this page, the system averages the rating
values for each component and populates the overall rating
for the rating scheme (for this evaluator) on the Application
Evaluator Rating page. You must enter ratings on this page
first in order for the system to calculate overall ratings. This is
the lowest level of the calculation.
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Evaluating Applicants Using Automatic
Processing

Understanding How to Evaluate Applicants Using Automatic
Processing

Important! Mass Change is a deprecated product. Support will be maintained for this product, but
no new development will be produced for Mass Change. It is strongly recommended that you use
Application Engine instead. For more information on PeopleSoft Application Engine, see PeopleTools:
Application Engine.

Recruiting and Admissions provides the following automatic processes to aid in evaluating applicants:

• Mass Change and the Assign Evaluation Codes process (ADEVALCD.SQR).

Assigns evaluation codes to applications in batch. Evaluation codes contain default data required for
evaluating applicants (such as the rating scheme and evaluation status).

• Extract data for Adm Appl Matl (extract data for admissions application materials) process
(ADMTLEXT.SQR).

Assigns application materials to applications in batch. Application materials are used to evaluate
applications.

• Assign Adm Applicant Rating (assign admissions applicant rating) process (ADMTLRTG.SQR).

Retrieves objective scores (such as test scores) and evaluates them based on rules that you define
in your own SQCs. Then, the process populates rating values on the Overall Rating page in the
Application Evaluation component. Rating values are used to evaluate applicants.

• Program Stack Update process (ADMTLPGS.SQR).

Checks to see that all of the rating components have been entered, then sums all of the final value
components on the Overall Rating page for an application. An SQC defined by your institution
determines the status of the application according to the sum of the final values. Finally, updates the
application evaluation status based on the rules in your SQCs.

• Deposit Fees Calc (Batch) [deposit fees calculation (batch)] process (SFPBADEP).

Calculates enrollment deposits in batch on applications on which you've run the Program Stack
Update process.

• Activate Applications process (ADPCPPRC).

Matriculates applicants in batch who were evaluated using the Program Stack Update process.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1227



Evaluating Applicants Using Automatic Processing Chapter 33

Note: PeopleSoft delivers sample SQRs to help you with a variety of tasks. However, your institution can
modify these SQRs to fit their specific needs. For this reason, your SQRs might be named differently, and
they might behave slightly differently than described.

Related Links
Understanding the Evaluating Applicants Business Process

Assigning Evaluation Codes to Applications in Batch

Important! Mass Change is a deprecated product. Support will be maintained for this product, but
no new development will be produced for Mass Change. It is strongly recommended that you use
Application Engine instead. For more information on PeopleSoft Application Engine, see PeopleTools:
Application Engine.

Before you can run the application materials extract process or an evaluation calculation for a group
of applications, you must assign them an evaluation code. Evaluation codes contain important default
information and helps with selecting the appropriate group for extract and evaluation processing.

First you must select the applications that you want to assign the evaluation codes to. Use the Mass
Change feature to do this. Then run the Assign Evaluation Codes process to assign the evaluation codes to
the applications that the mass change process selected.

To access the Mass Change Definition component, select Student Admissions > Processing
Applications > Mass Change > Mass Change Definition.

See product documentation for PeopleTools: Data Management

To assign evaluation codes with mass change:

1. Select the appropriate mass change definition to define which applications need to be assigned which
evaluation code.

Use the Mass Change Definition - Description page to enter the mass change definition that defines
the criteria by which you select applications. The delivered mass change definition for assigning
evaluation codes is Evaluation Assignment Select. However, your institution can define its own mass
change definition for assigning evaluation codes, but use the delivered mass change definition as a
template.

2. Enter criteria for determining which applications to assign the evaluation code, and enter the
evaluation code you want assigned to those applications.

Use the Criteria and Defaults page to enter criteria for determining which applications to assign the
evaluation code, and to enter the evaluation code you want assigned to those applications.

The first execution sequence of the SQL statement in the delivered mass change definition is Delete
Tmp5 Table. This program clears the temporary table that stores the records of those applications
selected the last time you ran this process.
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The second execution sequence of the SQL statement in the delivered mass change definition is Select
Applicant Criteria. The following page shot shows an example of the criteria that can be used in the
selection process.

This example illustrates the fields and controls on the Criteria and Defaults page. You can find definitions
for the fields and controls later on this page.

Use the Criteria group box to enter the criteria by which the mass change process will select applications
to assign the evaluation code you select. In the delivered Evaluation Assignment Select mass change
definition, there are 27 fields you can use to select applicants (such as academic level, academic career,
program status, recruiter ID, and many others). In our example in the previous page shot, the applicant
must have an academic level of 10 and must be an undergraduate. However, there could be many more
fields selected as search criteria in subsequent rows.

Use the Defaults group box to select the evaluation code that you want the mass change process to assign
to the applications that you selected. In the example in the previous page shot, the evaluation code the
mass change process will assign is UGAPPLFYR (first year undergraduate applicants).

1. Generate the SQL for this mass change definition.

Use the Mass Change Definition - Generate SQL page to generate the SQL statement for this mass
change definition.

Remember to click the Clear SQL button if an SQL statement already exists in the text box.

2. Set up a mass change group to define in what order you want the mass change definitions to run.

Use the Mass Change Group component to set up mass change groups. To access the Mass Change
Group component select Student Admissions >Processing Applications >Mass Change >Mass
Change Group. Create a mass change group to group the steps that it takes to process the
applications you selected. Create a group by entering related mass change definitions that you must
run to complete a particular task (such as assigning evaluation codes), and the order in which they
should be run.
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On the Mass Change Group page, select SA (student administration) in the PS Owner field.

Next, select the mass change definitions. In the previous example, you would run the Evaluation
Assignment Select mass change definition first. This definition selects all the records chosen by the
SQL statement that you generated earlier. Second, you would run the Evaluation Duplicate Check
mass change definition, which removes any applicants who matched your selection criteria, but were
already assigned the evaluation code.

3. Process the mass change group to select the applications to be assigned the evaluation code.

Use the Run Mass Change page to execute the mass change definitions in the mass change group. The
mass change definitions in this group choose your final list of applications that should be assigned a
code during the evaluation code assignment process. To access this page select Student Admissions,
Processing Applications, Mass Change, Run Mass Change.

On the Run Mass Change page, select the Execute Mass Change Group option. Then select the mass
change group ID that you defined on the Mass Change Group page.

4. Run the Evaluation Code Assignment process (discussed in the following section).

Page Used to Assign Evaluation Codes to Applications in Batch

Page Name Definition Name Navigation Usage

Evaluation Code Assignment RUNCTL_EVALCODE Student Admissions >
Processing Applications >
Evaluations > Assign
Evaluation Codes

Assign the evaluation code
to the applications that you
selected through the mass
change process.

Note: PeopleSoft delivers
a sample SQR for
assigning evaluation codes,
 ADEVALCD.SQR. Your
institution can modify this
SQR to fit its specific needs.

Running the Evaluation Code Assignment Process
Access the Evaluation Code Assignment page (Student Admissions > Processing Applications >
Evaluations > Assign Evaluation Codes).
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This example illustrates the fields and controls on the Assign Evaluation Codes page. You can find
definitions for the fields and controls later on this page.

Program Evaluation Status

Field or Control Description

Evaluation Status and Evaluation Date Enter the evaluation status and date that you want entered on
the Evaluation subpage of the Application Program Data page.
 Define evaluation statuses on the Evaluation Status Table
page.

Evaluation Code Status

Field or Control Description

Evaluation Status and Evaluation Date Enter the evaluation status and date that you want entered on
the Application Evaluation page. Define evaluation statuses on
the Evaluation Status Table page.
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Committee Evaluation Status

Field or Control Description

Evaluation Status and Evaluation Date Enter the evaluation status and date that you want entered on
the Committee Rating and Evaluator Rating pages. Define
evaluation statuses on the Evaluation Status Table page.

Click the Run button to run the Assign Evaluation Codes process at user-defined intervals.

Linking Application Materials to Applications in Batch

This section discusses how to link application materials to applications in batch.

Page Used to Link Application Materials to Applications in Batch

Page Name Definition Name Navigation Usage

Application Materials Extract RUNCTL_APPEVAL1 Student Admissions >
Processing Applications >
Evaluations > Application
Materials Extract

Assign application materials
to applications in batch.
Application materials are used
to evaluate applicants.

Note: PeopleSoft delivers a
sample SQR for extracting
application materials,
ADMTLEXT. Your institution
can add to or edit the SQCs
for this SQR.

Linking Application Materials to Applications in Batch
For an application to be considered during the application materials extract process, the application
must have an evaluation code assigned on the Application Evaluation page, and the Automatic Update
Process check box must be selected on the Overall Rating page. In addition, the evaluation code you are
using must include a rating scheme that has a type of Overall, which must have material extract SQCs
defined for it. The Application Materials Extract process uses those SQCs to assign the appropriate
materials to the selected applications. Define rating schemes and their material extracts on the Rating
Scheme Table page.

Field or Control Description

Evaluation Code Select an evaluation code. The process only extracts
application materials for applications that have been assigned
the evaluation code you select. Define evaluation codes on the
Evaluation Table page.
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Field or Control Description

Admit Term Select an admit term. The process only extracts application
materials for applications with the admit term that you select.
 Define admit terms on the Term Values Table page.

Evaluation Status Select an evaluation status. The process only extracts
application materials for applications with the evaluation status
that you select. The process looks at the Evaluation Status
field on the Application Program Data page.

Institution Select an Academic Institution. The process only extracts
application materials for applications for the institution you
select.

Click the Run button to run the Extract data for Adm Appl Matl (extract data for admissions application
materials) process at user-defined intervals.

To view the results of this extract process, use the Application Materials Summary pages under Student
Admissions, Applicant Summaries.

Calculating Rating Values Through an Automatic Process

The section discusses how to calculate rating values through an automatic process.

Page Used to Calculate Rating Values Through an Automatic Process

Page Name Definition Name Navigation Usage

Evaluation Calculation RUNCTL_APPEVAL2 Student Admissions >
Processing Applications >
Evaluations > Evaluation
Calculation

Run the evaluation
calculation.

Calculating Rating Values Through an Automatic Process
Access the Evaluation Calculation page (Student Admissions > Processing Applications >
Evaluations > Evaluation Calculation).
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This example illustrates the fields and controls on the Evaluation Calculation page. You can find
definitions for the fields and controls later on this page.

The application must first be assigned an evaluation code on the Application Evaluation page. In addition,
the evaluation code you are using must include a rating scheme that has a type of Overall, and the rating
scheme must have rating components assigned to it. Each rating component in the rating scheme has
a defined sequence and formula ID. The formula ID defines which SQC should be run for the rating
component. The evaluation calculation looks to those components to come up with rating values that will
be inserted on the Overall Rating page for the application. Application materials must have been assigned
manually or automatically.

The Evaluation Calculation process looks for applications that meet the criteria you enter here which
have never been calculated or which were previously calculated, but have had materials linked to the
application after the last calculation was run. If new materials have been added since the last calculation,
the system selects the Recalculate Evaluation check box on the Application Evaluation page.

When the Evaluation Calculation process finds an application that meets its criteria, it retrieves the values
that your SQCs tell it to retrieve, evaluates the values based on the rules in your SQC, and populates the
result on the Overall Rating page in the Application Evaluation component. For example, suppose you
determine that an SAT score of over 1450 is worth a rating value of 10. Suppose further that you run
the process and it retrieves an SAT score of 1462. The process would evaluate based on your rules and
populate the rating value 10 in the Rating Value field for the test score component.

Note: PeopleSoft delivers a sample SQR for evaluating applications, ADMTLRTG. Your institution must
define its own SQCs for this SQR, which define the rules by which applications should be evaluated.

Field or Control Description

Evaluation Code Select an evaluation code. The process only evaluates
applications that have been assigned the evaluation code you
select. Define evaluation codes on the Evaluation Table page.
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Field or Control Description

Admit Term Enter an admit term. The process only evaluates applications
that have the admit term you select. Define admit terms on the
Term Values Table page.

Institution Enter an institution. The process only evaluates applications
for this institution.

From The process only evaluates applications that have the
evaluation status you select. This is the evaluation status listed
on the Application Evaluation page.

To Enter the evaluation status that you want the process to add to
the application evaluations.

Click the Run button to run the Assign Adm Applicant Rating (assign admissions applicant rating)
process at user-defined intervals.

Automatically Updating Application Program Evaluation Statuses

Use the Application Status Update process to automatically update the program evaluation status of
multiple applications.

This process looks to the parameters you define to choose the applications to be considered for the status
update. The program looks to the Overall Rating page to verify that all rating components designated as
final value have been evaluated. The program then determines if any of these applications have a future
dated row on the Application Program Data page. Any records with a future dated row are not included in
this process.

The next step in the process is to sum all of the final value components on the Overall Rating page for an
application. An SQC defined by your institution determines the status of the application according to the
sum of the final values.

For each application evaluated, the Application Program Data page is updated as follows:

• The process updates the program evaluation status.

• The process inserts a new program data row with an effective date equal to your system date, or, if the
most recent row has the same effective date as the current date, the sequence number is incremented.

The new row contains the same data as the previous row, with the following exceptions: program
action, action date and program status, which the process updates. The action reason is also updated if
you have defined for it to do so in your SQC.

The values the process inserts are determined by the rules of the SQCs that your institution defines.

When you update application program data via the Application Status Update process, you're unable to
manually calculate enrollment deposits or activate applicants as students. Therefore, you must calculate
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enrollment deposits and activate applicants as students via two COBOL processes: the Calculate Deposits
process and the Activating Applications process.

This section discusses how to:

• Updating application program evaluation status using the Program Stack Update process.

• Calculating enrollment deposits using the Deposit Fees Calc (Batch) process.

• Activating applicants as students using the Activate Applications process.

Pages Used to Automatically Update Application Program Evaluation
Statuses

Page Name Definition Name Navigation Usage

Application Status Update RUNCTL_EVALSTATUS Student Admissions >
Processing Applications >
Update Applications >
Application Status Update

Perform a background
process to update the program
evaluation status and program
actions of applications that
have been evaluated.

See Understanding How to
Evaluate Applicants Using
Automatic Processing

Note: PeopleSoft delivers a
sample SQR, ADMTLPGS.
SQR. Your institution can add
to or edit the SQCs for this
SQR.

Calculate Deposits RUNCTL_SFPBADEP Student Admissions >
Application Fees and
Deposits > App Deposit
Fees Process

Calculate enrollment deposits
for applicants who were
admitted via the Application
Status Update process. You
must calculate an enrollment
deposit before activating
the applicant as a student if
you have a deposit fee code
assigned to your application
center (on the Application
Center Table page).

You must first admit
applicants through the
Program Stack Update
process.
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Page Name Definition Name Navigation Usage

Activate Application RUNCTL_AD_SR Student Admissions >
Processing Applications >
Update Applications >
Activate Applicants

Activate applicants as
students. This process
inserts a program action of
Matriculate (MATR) on the
Application Program Data
page and creates the student
program and plan records.
 Use the Activate Applications
process if you admitted an
applicant through the Program
Stack Update process, and
therefore could not manually
matriculate the applicant.

If your institution requires
an enrollment deposit prior
to matriculation, you must
calculate a deposit prior to
running this process.

Updating Application Program Evaluation Status Using the Program Stack
Update Process

Access the Application Status Update page (Student Admissions > Processing Applications > Update
Applications > Application Status Update).

This example illustrates the fields and controls on the Application Status Update page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Evaluation Code Enter an evaluation code. The process only processes the
applications that have the evaluation code that you select.
 Define evaluation codes on the Evaluation Table page.

Academic Career Enter an academic career. The process only processes the
applications that have the academic career that you select. This
is the academic career to which that the applicant is applying.

Academic Program Enter an academic program. The process only processes the
applications that have the academic program that you select.

Admit Type Enter an admit type. The process only processes applications
that have the admit type that you select. Define admit types on
the Admit Type Table.

Admit Term Enter an admit term. The process only processes the
applications that have the admit term that you select. Define
admit terms on the Term Values Table page.

Action Date The default for the action date is your system date. Edit this
date to reflect the date you want to appear as the action date on
the Application Program Data page.

From The process only process applications that have the evaluation
status you select.

To Enter the program evaluation status that you want the process
to add to the applications on the Application Program Data
page.

Click the Run button to run the Program Stack Update process at user-defined intervals.

To view the results of this application program evaluation status update process, you can use the
Applicant Progression page, or you can go to an individual's Application Program Data page in the
Application Maintenance component.

Calculating Enrollment Deposits Using the Deposit Fees Calc (Batch)
Process

Access the Calculate Deposits page (Student Admissions > Application Fees and Deposits > App
Deposit Fees Process).
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This example illustrates the fields and controls on the Calculate Deposits page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Academic Career Enter an academic career. The process only calculates
enrollment deposits for applications that have the academic
career that you select.

Admit Term Enter an admit term. The process only calculates enrollment
deposits for applications that have the admit term that you
select. Define admit terms on the Term Values Table page.

Admit Type Enter an admit type. The process only calculates enrollment
deposits for applications that have the admit type that you
select. Define admit types on the Admit Type Table page.

You can add additional rows as needed for selecting additional careers, admit terms etc. to calculate
deposits for multiple groups of applicants. Click the Run button to run the Deposit Fees Calc (Batch)
[deposit fees calculation (batch)] process at user-defined intervals.

To view the results of the Deposit Fees Calc (Batch) process for applicants, use the Display Deposit Fees
link on the Run Control page or the Review Batch Deposit Fees page.

Activating Applicants as Students Using the Activate Applications Process
Access the Activate Application page (Student Admissions > Processing Applications > Update
Applications > Activate Applicants).
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This example illustrates the fields and controls on the Activate Applicants page. You can find definitions
for the fields and controls later on this page.

Note: Admissions application records use the Last Admit Term to determine if the program, plan, or
subplan should appear in the prompt. If the Last Admit Term is populated on the Academic Program
Table (ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic SubPlan Table
(ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID, the system does
not display the value in the prompt.

Field or Control Description

Career Enter an academic career. The process only matriculates
applicants who have the academic career that you select.

Acad Program (academic program) Enter an academic program. The process only matriculates
applicants who have the academic program that you select.

Admit Term Enter an admit term. The process only matriculates applicants
who have the admit term that you select. Define admit terms
on the Term Values Table page.

Admit Type Enter an admit type. The process only matriculates applicants
who have the admit type that you select. Define admit types on
the Admit Type Table page.

As of Date The default for the as of date is your system date. This is the
date you ran this process.

Add additional rows as needed to define additional selection criteria. Click the Run button to run the
Activate Applications process at user-defined intervals.
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Viewing Application Evaluation Summaries
and Progression

Viewing Application Evaluation Summaries

Use the Application Evaluation Summary pages to view the status of application evaluations.

This section discusses how to:

• View overall results of an application evaluation.

• View committee results of an application evaluation.

• View evaluator results of an application evaluation.

• View evaluator detail summary information for an application evaluation.

Pages Used to View Application Evaluation Summaries

Page Name Definition Name Navigation Usage

Overall Results ADM_EVAL_SUMM Student Admissions >
Applicant Summaries >
Application Evaluation
Summary > Overall Results

Look up overall results of an
application evaluation for an
applicant.

You must first complete the
application evaluation for this
person.

Committee Results ADM_EVAL_COMM_
SUMM

Student Admissions >
Applicant Summaries >
Application Evaluation
Summary > Committee
Results

Look up results of committee
application evaluations for an
applicant.

Evaluator Results ADM_EVALUATOR_SUMM Student Admissions >
Applicant Summaries >
Application Evaluation
Summary > Evaluator
Results

Look up results of evaluators'
evaluations of an application.
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Page Name Definition Name Navigation Usage

Evaluator Detail ADM_EVAL_DTL_SUM Student Admissions >
Applicant Summaries >
Application Evaluation
Summary > Evaluator
Detail

Look up results of the details
of evaluators' evaluations of
an application.

You must first complete the
application evaluation for this
person.

Viewing Overall Results of an Application Evaluation
Access the Overall Results page (Student Admissions > Applicant Summaries > Application
Evaluation Summary > Overall Results).

This example illustrates the fields and controls on the Overall Results page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Component Enter a rating component If you want to view summary
information by this criterion. When you click the Search
button the system retrieves only those components assigned to
this application.

Final Value Select Yes if you want to view summary information for final
value components only. Select No if you do not want to view
only final value components.
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Field or Control Description

Evaluation Code Enter an evaluation code if you want to view summary
information based on this criterion. When you click the
Search button the system retrieves only those evaluation codes
assigned to this application.

Eval Stat (evaluation status) Select an evaluation status if you want to view summary
information by this criterion. When you click the Search
button the system retrieves overall result information for those
evaluations that have matching evaluation statuses that on the
Application Evaluation page.

Sort By Select whether you want to view the results by Component, 
Final Value, Evaluation Method, or Rating Value.

Search Click this button to bring up the summary information
matching your search criteria. If information is found, it
displays in the bottom portion of the page.

Viewing Committee Results of an Application Evaluation
Access the Committee Results page (Student Admissions > Applicant Summaries > Application
Evaluation Summary > Committee Results).

This example illustrates the fields and controls on the Committee Results page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Committee Enter an evaluation committee If you want to view committee
information by this criterion. When you click the Search
button the system retrieves only those committees assigned to
this application.
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Field or Control Description

Evaluation Code Enter an evaluation code if you want to view committee
information based on this criterion. When you click the
Search button the system retrieves only those evaluation codes
assigned to this application.

Eval Stat (evaluation status) Select an evaluation status if you want to view committee
information by this criterion. When you click the Search
button the system retrieves overall result information for those
evaluations that have matching evaluation statuses that on the
Committee Evaluation page.

Committee,  Rating, and Eval Stat (evaluation status) Select whether you want to view the results of your summary
information by committee, rating, or evaluation status.

Search Click this button to bring up the summary information
matching your search criteria. If information is found, it
displays in the bottom portion of the page.

Viewing Evaluator Results of an Application Evaluation
Access the Evaluator Results page (Student Admissions > Applicant Summaries > Application
Evaluation Summary > Evaluator Results).

This example illustrates the fields and controls on the Evaluator Results page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Committee Enter an evaluation committee If you want to view evaluator
result information by this criterion. When you click the Search
button the system retrieves only those committees assigned to
this application.
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Field or Control Description

Evaluation Code Enter an evaluation code if you want to view evaluator result
information based on this criterion. When you click the
Search button the system retrieves only those evaluation codes
assigned to this application.

Evaluator Enter an evaluator if you want to view evaluator result
information for a specific evaluator.

Eval Stat (evaluation status) Select an evaluation status if you want to view evaluator result
information by this criterion. When you click the Search
button the system retrieves evaluator result information for
those evaluations that have matching evaluation statuses on the
Evaluator Rating page.

Committee,  EvaluatorRating, and Eval Stat (evaluation
status)

Select whether you want to view the results of your summary
information by committee, evaluator, rating, or evaluation
status.

Search Click this button to bring up the summary information
matching your search criteria. If information is found, it
displays in the bottom portion of the page.

Viewing Evaluator Detail Summary Information for an Application
Evaluation

Access the Evaluator Detail page (Student Admissions > Applicant Summaries > Application
Evaluation Summary > Evaluator Detail).

This example illustrates the fields and controls on the Evaluator Detail page. You can find definitions for
the fields and controls later on this page.
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Field or Control Description

Committee Enter an evaluation committee If you want to view evaluator
detail information by this criterion. When you click the Search
button the system retrieves only those committees assigned to
this application.

Evaluation Code Enter an evaluation code if you want to view evaluator detail
information based on this criterion. When you click the
Search button the system retrieves only those evaluation codes
assigned to this application.

Component Enter a rating component If you want to view evaluator detail
information by this criterion. When you click the Search
button the system retrieves only those components assigned to
this application.

Eval Stat (evaluation status) Enter an evaluation status if you want to view evaluator detail
information by this criterion. When you click the Search
button the system retrieves evaluator detail information for
those evaluations that have matching evaluation statuses on the
Application Evaluator Detail page.

Committee,  Component,  Evaluator,  and Rating Value Select whether you want to view the results of your summary
information by committee, component, evaluator or rating
value.

Search Click this button to bring up the evaluator detail information
matching your search criteria. If information is found, it
displays in the bottom portion of the page.

Viewing a Summary of an Applicant's Progression

This section discusses how to view a summary of an applicant's progression.
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Page Used to View a Summary of an Applicant's Progression

Page Name Definition Name Navigation Usage

Applicant Progression APPL_PROGRESS_SUMM Student Admissions >
Applicant Summaries >
Applicant Progression

View a summary of an
applicant's progression
through the recruiting and
admissions business process.
 Summary data (such as status
and program action) can be
viewed for the person as
a prospect, applicant, and
student. You can also view
any file attachments submitted
by the applicant.

Individuals must have an
application in your database
for you to be able to view
their progression.
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Chapter 35

(NLD) Managing BPV Internship
Agreements

Understanding BPV Internship Agreements

Students pursuing vocational education receive theoretical as well as practical education. As part of their
practical training students participate in internships at external organizations. These internships are known
as vocational training, or BPV (Beroepspraktijkvorming). The BPV agreement between the student, the
external organization, and the institution is laid out in a contract which must be printed and signed by
various persons.

Setting Up BPV Internship Agreements

To set up BPV internship agreements, use the Organization Type component (SAD_BPV_OTP_NLD),
Address Types component (SAD_ADDRESS_TP_NLD), Campus Telephone component
(SAD_CAMPUS_TEL_NLD), BPV Appendix component (SAD_BPV_NBL_NLD), and the BPV User
Settings component (SAD_BPV_OID_NLD).

This section discusses how to:

• Set up BPV user security.

• Define role user with BPV administrator rights.

Pages Used to Set Up BPV Internship Agreements

Page Name Definition Name Navigation Usage

BPV Organization Type SAD_BPV_OTP_NLD Student Admissions >
Internship Contracts
NLD > Organization
Types > BPV Organization
Type

Define organization types
by academic organization.
 You can only enter types for
organizations for which you
have access. Organization
types are used to classify
organization locations on the
BPV Organization Locations
page.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1249



(NLD) Managing BPV Internship Agreements Chapter 35

Page Name Definition Name Navigation Usage

Address Types SAD_ADDRESS_TP_NLD Student Admissions >
Internship Contracts
NLD > Address Types >
Address Types

Define address and phone
types for organizations.
 Specify address types for
organizations on the Location
Detail page and specify
phone types on the BPV
Organization Phones page.

BPV Campus Telephone SAD_CAMPUS_TEL_NLD Student Admissions >
Internship Contracts
NLD > Campus Telephone
Numbers > BPV Campus
Telephone

Define campus telephone
numbers. Campus telephone
numbers are printed on top of
the BPV contract.

BPV Appendix SAD_BPV_NBL_NLD Student Admissions >
Internship Contracts
NLD > BPV Appendix >
BPV Appendix

Create standard appendix
texts that can be linked to
BPVOs. The standard texts
must be secured by academic
organization security and
must be set up per CREBO
code. Link appendix text
to contracts on the BPV
Appendix page.

BPV User Settings SAD_BPV_OID_NLD Student Admissions >
Internship Contracts
NLD > BPV User
Settings > BPV User
Settings

Set up BPV user security to
allow users to work with BPV
contract functionality.

BPV Set-up SAD_BPV_INST_NLD Student Admissions >
Internship Contracts
NLD > BPV Set-up > BPV
Set-up

Define a role user with BPV
administrator rights and set up
last contract number assigned

Setting Up BPV User Security
Access the BPV User Settings page (Student Admissions > Internship Contracts NLD > BPV User
Settings > BPV User Settings).
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This example illustrates the fields and controls on the BPV User Settings page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

BBL Match Select this check box if this user can link students in the BBL
career only to a contract with the same CREBO. Clear this
check box if the user can link students in the BBL career to
contracts regardless of CREBO.

BOL Match Select this check box if this user can link students in the BOL
career only to a contract with the same CREBO. Clear this
check box if the user can link students in the BOL career to
contracts regardless of CREBO.

Defining Role User with BPV Administrator Rights
Access the BPV Set-up page (Student Admissions > Internship Contracts NLD > BPV Set-up >
BPV Set-up).

This example illustrates the fields and controls on the BPV Set-up page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Role User Select a role user that should have BPV Administrator rights.
 The BPV Administrator can change the student career number
value and BPV creation date on BPV Contracts.
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Field or Control Description

Last Contract Number Assigned Use this field to maintain the last BPV contract number
assigned.

Defining BPV Organization Locations

This section discusses how to:

• Define BPV organization locations.

• Review or update BPV organization locations.

• Define accreditation information for BPV organizations.

Pages Used to Define BPV Organization Locations

Page Name Definition Name Navigation Usage

Location Detail ORG_LOCATIONS • Student
Admissions >Internship
Contracts
NLD >Organization
Locations >Location
Detail

• Campus
Community >Organization >Create/
Maintain
Organization >Organization
Locations >Location
Detail

Add a BPV organization
location.

BPV Organization Locations SAD_BPV_OLC_NLD • Student Admissions >
Internship Contracts
NLD > BPV
Locations > BPV
Organization Locations

• Click the Edit BPV
Location Address link
on the Location Detail
Page.

Review or update the
locations for BPV
organizations that you added
on the Location Details page.

BPV Accreditation SAD_BPV_ACC_NLD Student Admissions >
Internship Contracts
NLD > BPV Locations >
BPV Accreditation

Define accreditation
information for BPV
organization locations.
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Page Name Definition Name Navigation Usage

BPV Location Notes SAD_BPV_LNT_NLD Student Admissions >
Internship Contracts
NLD > BPV Locations >
BPV Location Notes

Enter notes for BPV
organization locations.

Defining BPV Organization Locations
Access the Location Detail page (Student Admissions >Internship Contracts NLD >Organization
Locations >Location Detail).

This example illustrates the fields and controls on the Location Detail page. You can find definitions for
the fields and controls later on this page.
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Click the Edit BPV Location Address link to access the BPV Organization Locations page and review or
update the locations for BPV organizations that you add on this page. The Edit BPV Location Address
link appears only if you select the Use Dutch Functionality option on the SA Features page.

Reviewing or Updating BPV Organization Locations
Access the BPV Organization Locations page (Student Admissions > Internship Contracts NLD >
BPV Locations > BPV Organization Locations).

This example illustrates the fields and controls on the BPV Organization Locations page . You can find
definitions for the fields and controls later on this page.

Note: You cannot use this page to add a BPV organization location. To add a BPV organization location,
use the Location Detail page (discussed in the previous section).

Field or Control Description

Organization type Select an organization type for this location. Organization
types are defined on the BPV Organization Type page.
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Field or Control Description

AR number (account receivable number) Enter the account receivable number of the location.

Address Type Enter the address type for this location. Define address types
on the Address Types page.

Main address Select the primary address for this location.

Copy Default Location Address Click to copy the address from the Location Detail page. When
you click the button, the address appears on the address type
row.

The button appears only if you select an address type.

To administer phone numbers, access the Location Detail page (Student Admissions >Internship
Contracts NLD >Organization Locations >Location Detail). To add or update BPV contacts,
access the Contact Detail page (Student Admissions >Internship Contracts NLD >Organization
Contacts >Contact Detail).

Defining Accreditation Information for BPV Organizations
Access the BPV Accreditation page (Student Admissions > Internship Contracts NLD > BPV
Locations > BPV Accreditation).

This example illustrates the fields and controls on the BPV Accreditation page . You can find definitions
for the fields and controls later on this page.

Field or Control Description

Knowledge centre id Enter the knowledge center or external organization at this
location for which to select accreditation.
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Field or Control Description

External contract Enter the number of the external contract that has been
generated and distributed by the knowledge center to the BPV
organization. This is for information only.

HEGIS Code Enter the CREBO code for which the accreditation applies.
 Only the HEGIS codes that belong to the knowledge center
and are secured through the link between HEGIS code and
academic program appear in the prompt.

Appr by nat org Enter the accreditation status of this organization for this
CREBO code. Your options are Accredited, In Cons (in
consideration), and Not Accr (not accredited). When you select
the Accredited check box when creating a contract on the
BPV Contract page, only CREBO codes that are identified as
accredited here are available.

Start Date  and End Date Enter the start and end dates of the accreditation.

Setting Up BPV Contacts

This section discusses how to:

• Define BPV organization contacts.

• Define BPV contact persons.

• Define BPV contact person locations.

Pages Used to Set Up BPV Contacts

Page Name Definition Name Navigation Usage

Contact Detail ORG_CONTACTS Student Admissions >
Internship Contracts
NLD > Organization
Contacts > Contact Detail

Add contact information for
BPV usage.

BPV Contact Person SAD_BPV_OCN_NLD Student Admissions >
Internship Contracts
NLD > BPV Contact
Persons > BPV Contact
Person

Define BPV contact persons.
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Page Name Definition Name Navigation Usage

Contact Person Locations SAD_BPV_OCL_NLD Student Admissions >
Internship Contracts
NLD > BPV Contact
Persons > Contact Person
Locations

Define locations for the
contact person.

Contact Person Notes SAD_BPV_OCN_NT_NLD Student Admissions >
Internship Contracts
NLD > BPV Contact
Persons > Contact Person
Notes

Enter comments about the
contact person.

Defining BPV Organization Contacts
Access the Contact Detail page (Student Admissions > Internship Contracts NLD > Organization
Contacts > Contact Detail).
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This example illustrates the fields and controls on the Contact Detail page.

Defining BPV Contact Persons
Access the BPV Contact Person page (Student Admissions > Internship Contracts NLD > BPV
Contact Persons > BPV Contact Person).
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This example illustrates the fields and controls on the BPV Contact Person page. You can find definitions
for the fields and controls later on this page.

Note: You cannot use the BPV Contact Persons component to add contacts. Use the component to add
BPV specific details for contacts that you added using the Organization Contacts, Contact Detail page.

Field or Control Description

Contact Nbr Contacts that appear on this page are active organization
contacts. Contact Nbr, ID, Contact Name, Job Title,
 Contact Type, and Email Address values appear by default
from the Organization Contacts, Contact Detail page.

Assign contacts to specific BPV locations on the Contact
Person Locations page.

Defining BPV Contact Person Locations
Access the Contact Person Locations page (Student Admissions > Internship Contracts NLD > BPV
Contact Persons > Contact Person Locations).
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This example illustrates the fields and controls on the Contact Person Locations page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Location Nbr  (location number) You must assign at least one location to contacts.

Creating Internship Contracts

This section discusses how to:

• Create BPV contracts.

• Attach appendixes to BPV contracts.

Pages Used to Create Internship Contracts

Page Name Definition Name Navigation Usage

BPV Contract SAD_BPV_CTR_NLD Student Admissions >
Internship Contracts
NLD > BPV Contracts >
BPV Contract

Create a BPV contract.

BPV Location Detail SAD_BPV_OLC_SP_NLD Click the Location Nbr
button on the BPV Contract
page.

View remarks about the BPV
location.

BPV Appendix SAD_BPV_C_BIJL_NLD Student Admissions >
Internship Contracts
NLD > BPV Contracts >
BPV Appendix

Attach appendixes to the BPV
contract, or manually enter
appendix text.
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Creating BPV Contracts
Access the BPV Contract page (Student Admissions > Internship Contracts NLD > BPV
Contracts > BPV Contract).

This example illustrates the fields and controls on the BPV Contract page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Accredited Select to limit the values in the HEGIS Code field to
CREBO codes for which this location is accredited. Select
Accreditation on the BPV Accreditation page.

Location Nbr  (location number) Select a BPV organization location. Define organization
locations on the BPV Organization Locations page.

Location Nbr  (location number) Click this button to view location notes for this location.
 Define location notes on the BPV Location Notes page.

HEGIS Code Select a CREBO code for this contract. Only those CREBO
codes for which you are authorized to create contracts is
available.
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Field or Control Description

Outsourcing company Select the outsourcing company for this contract. Define
outsourcing companies on the External Organization Table
page. If you enter an outsourcing company you must enter a
location for it.

Outsourcing loc  (outsourcing location) Enter a location number for the outsourcing company.

Internal contract When you save the page, the system assigns a number for
this contract by adding 1 to the highest number found in the
Contract table.

External contract Enter the external contract number, if applicable.

Start Date  and End Date Enter the start and end dates of this contract. The start and end
dates of the contract must fall within the start and end date of
the OWO, if the OWO exists.

Mailing location Enter the location number that will be used for
correspondence. Locations are defined on the BPV
Organization Location page.

Instructor ID Select the practicum tutor of the institution. Define instructors
on the Instructor/Advisor Table page.

Contact Nbr  (contact number) Select the contact number for the contact at the internship
provider. Define contacts for this location on the BPV Contact
Person page. Only contacts for this location appear as options.

Contact nbr 2 Select a second contact. Only contacts for this location appear
as options.

Contract length in weeks Enter the number of weeks the contract will last.

If you enter values in the Start Date and End Date fields, the
system automatically calculates and displays a value in the
Contract length in weeks field. Alternatively, you can enter a
value directly in the Contract length in weeks field.

When you enter values in the Start Date and End Date fields,
the system uses the following formula to calculate the Contract
length in weeks value:

N (number of weeks) ) = (end date - start date) / 7

X (number of weeks after deduction of full years) = max (40,
 N mod 52)

Y (number of full years) = Int (N / 52) * 40

Contract length in weeks = X + Y
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Field or Control Description

Number of hours per week Enter the number of hours per week of this contract.

Maximum Nbr of Students  (maximum number of students) Enter the maximum number of students that can be linked to
this contract.

Total nbr of BPV Hours  (total number of BPV hours) If values are entered in the Contract length in weeks and
Number of hours per week fields, the system automatically
calculates and displays a value in the Total nbr of BPV
Hours field and the Total nbr of BPV Hours field becomes
unavailable for edit.

Alternatively, you can enter a value directly in the Total nbr of
BPV Hours field. If you enter a value in the Total nbr of BPV
Hours field, the system disables the Contract length in weeks
and Number of Hours per week fields.

Plan Indicate whether this contract is valid for BOL, BBL, or Both.

Delete Click this button to delete this contract. You can only delete
contracts that have no students linked to them.

Attaching Appendixes to BPV Contracts
Access the BPV Appendix page (Student Admissions > Internship Contracts NLD > BPV
Contracts > BPV Appendix).

This example illustrates the fields and controls on the BPV Appendix page. You can find definitions for
the fields and controls later on this page.
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Field or Control Description

Appendix document Select the appendix document that you want attached to this
contract. Create appendixes on the BPV Appendix page. This
field becomes unavailable when the contract is printed.

Add Appendix Click to add the selected appendix to the contract. You can
manually add text to the appendix in the text box. The text box
becomes unavailable when the contract is printed.

Adding Students to Contracts

This section discusses how to:

• Match students to contracts.

• Add students to contracts.

• Update a student's contract details.

• Update a student's appendix information.

Pages Used to Add Students to Contracts

Page Name Definition Name Navigation Usage

Match Contracts SAD_BPV_MATCH_NLD Student Admissions >
Internship Contracts
NLD > BPV Match
Contracts > Match
Contracts

After you have created
contracts on the BPV
Contracts page, search for
and select contracts to match
students to the contracts.

Match Contracts - Vacancy SAD_BPV_CTR_DL_NLD Click the Detail Panel button
on the Match Contracts page.

Select students to add to the
contract.

Match Contracts - BPV
Vacancy Detail

SAD_BPV_CTR_D3_NLD Click the Detail Panel button
on the Match Contracts -
Vacancy page or the Match
Students page.

Update contract details for the
student.

Match Contracts - BPV
Appendix Detail

SAD_BPV_CTR_D2_NLD Click the Appendix button on
the Match Contracts - BPV
Vacancy Detail page.

Update BPV appendix
information for the student´.
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Matching Students to Contracts
Access the Match Contracts page (Student Admissions > Internship Contracts NLD > BPV Match
Contracts > Match Contracts).

This example illustrates the fields and controls on the Match Contracts page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

HEGIS Code Select a CREBO code (stored in the HEGIS table) to select
contracts for the CREBO code you select.

Org ID  (organization ID) Select an organization ID to limit contracts by organization.

Organization type Select an organization type to limit contracts by organization
type.

Open Only Select this check box to retrieve only contracts that have
vacancies.

Select Click this button to search for contracts based on the criteria
you enter.

Deselect Click this button to clear the page.

Detail Panel Click this button to select a contract to which to add students.
 The Match Contracts - Vacancy page appears, with which you
can add students.

Adding Students to Contracts
Access the Match Contracts - Vacancy page (click the Detail Panel button on the Match Contracts page).
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This example illustrates the fields and controls on the Match Contracts - Vacancy page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

EmplID (employee ID) Select students to add to this contract. The values that appear
in the prompt differs depending on the BPV user settings 
(BOL/BBL match) and the Plan field (BOL/BBL/Both) on the
BPV contract.

Detail Panel Click the Detail Panel button to enter contract details for this
student.

Updating a Student's Contract Details
Access the Match Contracts - BPV Vacancy Detail page (click the Detail Panel button on the Match
Contracts - Vacancy page or the Match Students page).
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This example illustrates the fields and controls on the Match Contracts - BPV Vacancy Detail page.

Update the student's contract information.

Related Links
Creating Internship Contracts

Updating a Student's Appendix Information
Access the Match Contracts - BPV Appendix Detail page (click the Appendix button on the Match
Contracts - BPV Vacancy Detail page).
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This example illustrates the fields and controls on the Match Contracts - BPV Appendix Detail page.

Adding Contracts to Students

This section discusses how to:

• Match contracts to students.

• Link contracts to a student.

Pages Used to Add Contracts to Students

Page Name Definition Name Navigation Usage

Match Students SAD_BPV_MATCH2_NLD Student Admissions >
Internship Contracts
NLD > BPV Match
Students > Match Students

Search for and select students
to which to link contracts.

BPV Student Detail SAD_BPV_STD1_NLD Click the Detail Panel button
on the Match Students page.

Link contracts to students.
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Matching Contracts to Students
Access the Match Students page (Student Admissions > Internship Contracts NLD > BPV Match
Students > Match Students).

This example illustrates the fields and controls on the Match Students page. You can find definitions for
the fields and controls later on this page.

Enter search criteria to retrieve students to which you want to link to contracts. Click the Detail Panel
button to link contracts to students.

Linking Contracts to a Student
Access the BPV Student Detail page (click the Detail Panel button on the Match Students page).

This example illustrates the fields and controls on the BPV Student Detail page. You can find definitions
for the fields and controls later on this page.
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Field or Control Description

External Org ID  (external organization ID) Select the external organization that manages hosts the
internship.

Internal contract Select the contract that you want to link to this student.

Detail Panel Click this button to access the Match Contracts - BPV Vacancy
Detail page to view and update contract details.

Printing BPV Contracts

Run the Print BPV Contract (SABPVNL) PSJob, which runs three processes:

• Fill Contracts with Print Data (SAD_BPV_FILL) application engine process.

This process adds additional information from your system to PS_SAD_BPV_STC_NLD, which
holds the contract.

• SABPVNL1 (SABPVNL1).

This process prints the contract.

• SABPVPNL (SABPVNL.sqr).

This process updates the print flag in the contract table.

You cannot change contract data once the contract has been printed.

Page Used to Print BPV Contracts

Page Name Definition Name Navigation Usage

Print BPV Contracts SAD_BPV_RUN_NLD Student Admissions >
Internship Contracts
NLD > Print BPV
Contracts > Print BPV
Contracts

Print contract agreements.

Entering Contract Details and Signature Dates

This section discusses how to:

• Enter contract details.

• Update contract information for a student.
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Pages Used to Enter Contract Details

Page Name Definition Name Navigation Usage

Select BPV Contracts SAD_BPV_CT_SUM_NLD Student Admissions >
Internship Contracts
NLD > Select BPV
Contracts

Select contracts by the
available criteria and enter
contract details, including
signature dates.

Maintain BPV contracts SAD_BPV_CTR_D1_NLD Click the Detail Panel  button
on the Select BPV Contracts
page.

View or update details about
the contract.

Entering Contract Details
Access the Select BPV Contracts page (Student Admissions > Internship Contracts NLD > Select
BPV Contracts).

This example illustrates the fields and controls on the Select BPV Contracts page: Contracts Detail tab.
You can find definitions for the fields and controls later on this page.

Enter search criteria to retrieve students to which you want to update contract information. Click the
Detail Panel button to update contract information, if the contract has not yet been printed. Enter
signature dates on the Signatures tab.
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Updating Contract Information for a Student
Access the Maintain BPV contracts page (click the Detail Panel  button on the Select BPV Contracts
page).

This example illustrates the fields and controls on the Maintain BPV contracts page. You can find
definitions for the fields and controls later on this page.

Enter contract details if the contract has not already been printed.

Field or Control Description

Change Click to replace the contract entered for the student by another
contract. This can only be done when the contract is not
printed. When you click the Change button the system
retrieves the correct prompt table views for the External Org
ID and Internal Contract fields—based on BPV user settings
in combination with the academic load—and these fields are
made available for entry so you can update them with the new
contract.
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Common Elements Used to Create Educational Agreements

Field or Control Description

Appendix Document The reference code of the appendix document.

Maintaining Coursework and Agreement Information

This section discusses how to maintain coursework and agreement information.

Page Used to Maintain Coursework and Agreement Information

Page Name Definition Name Navigation Usage

OWO Course and Support
Agreements

SAD_AOHS_NLD Student Admissions >
Educational Contracts
NLD > Course and Support
Agreements

This page is used to
describe the contents of
an appendix (with course
and support issues) that
is printed on the OWO 
(Onderwijsovereenkomst)
contract. During the creation
process of the OWO (SQR
process), the appendix that
is flagged as the default
appendix is added to the
OWO contract appendix
table. Before printing, this
appendix can be replaced
for an individual student by
another non default appendix
from the OWO course and
support appendix table. If
required, the text can then
be modified to the needs
for this individual student.
 In the OWO course and
support appendix section of
the report, the text from the
OWO contract appendix table
is inserted during the print
process.
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Maintaining Coursework and Agreement Information
Access the OWO Course and Support Agreements page (Student Admissions > Educational Contracts
NLD > Course and Support Agreements).

This example illustrates the fields and controls on the OWO Course and Support Agreements page. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Default Select this option to make the appended document the default
agreement.

Long Description This region contains the default course and support agreements
which can be set up according to the academic organization.
 The text is effective-dated. Individually this text can be
replaced by other agreements in the AOHS appendix table.

Maintaining Financial Contribution Information

This section discusses how to maintain financial contribution information.
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Page Used to Maintain Financial Contribution Information

Page Name Definition Name Navigation Usage

OWO Voluntary
Contributions

SAD_AVB_NLD Student Admissions >
Educational Contracts
NLD > Voluntary
Contributions

Maintain information
regarding a student's
course work requirement
and institutional support
agreement. During the
print process the voluntary
contributions text will be
inserted on the OWO report
in the Voluntary contributions
appendix section.

Maintaining Financial Contribution Information
Access the OWO Voluntary Contributions page (Student Admissions > Educational Contracts NLD >
Voluntary Contributions).

This example illustrates the fields and controls on the OWO Voluntary Contribution page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Item Amount The entered amount is placed on a fixed position in the
voluntary contribution appendix during the print process. The
currency is placed by the report (it can be any currency). The
voluntary contribution appendix usually contains a text (that
explains for example the reason for the voluntary contribution)
and the agreed amount. This amount is derived from this field.

Description A short description of the appendix text. It is only
informational. This can be used to find a specific appendix
more easily in search records/prompts.

Reviewing and Updating Educational Agreements

This section discusses how to:

• Review and updating educational contract agreements.

• Review details of the OWO contract.

• Add general text appendixes.

Pages Used to Review and Update Educational Agreements

Page Name Definition Name Navigation Usage

OWO Summary SAD_OWO_CTRSUM_NLD Student Admissions >
Educational Contracts
NLD > OWO Summary

Review and update
educational contract
agreements for individual
students. Updating contract
information is only possible
when the OWO is not printed.
 After printing the OWO, only
the print flag, return flag/date,
 and status (active/inactive)
can be changed.

OWO Contract Summary SAD_OWO_CNTRCT_SEC Click the Detail button on the
OWO Summary page to view
the OWO Contract Summary
page.

Review details of the OWO
contract.

Other Text Appendixes SAD_OWO_APP4_SEC Click the Detail button on
the OWO Contract Summary
page to view the Other Text
Appendixes page.

Add general text appendixes.
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Reviewing and Updating Educational Contract Agreements
Access the OWO Summary page (Student Admissions > Educational Contracts NLD > OWO
Summary).

This example illustrates the fields and controls on the OWO Summary page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Select OWO Contracts When you click this button, the entered values in the selection
area are used to select the OWO contracts from the contract
table. When the employee ID is entered, the selection is based
only for this employee. If no employee is selected, the other
selection fields are used.

Refresh OWO Selection Click this button to initiate the selection fields.

EmplID Enter the employee identification code for the student.

Institution Enter the academic institution attended by the student.

Acad Prog (academic program) Enter the academic program of the student.

Campus Enter the campus with which the student is affiliated.

Career Select the career with which the student is affiliated.

Term Select the admit term.
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Field or Control Description

Status Select Active or Inactive.

Group Select If a group selection is required, define the source of the group 
(when one is selected, then this field becomes available) and
enter the group name. The source of the group can be the Class
table, Student Group table or Student Block Header table.

OWO Details

Field or Control Description

Print Select if you want to print the OWO to start automatically after
the generation process.

Received When an OWO contract has been printed, this flag can
be checked after all signatures needed for the contract are
received. On the detail page for this contract, the return date
will be set to the system date. This date can be changed by the
user.

Details Click the detail button to view additional data on the OWO
contract. When not printed yet, some data can be maintained
by the user. After printing the contract, only status and return
date for the signatures can be changed.

Contract Number The contract number which is automatically assigned to this
contract by the OWO creation process.

Date Signed This is the date on which the contract has been created.

EmplID The student ID for which the OWO contract is created.

More OWO details

Field or Control Description

Career The career with which the student is affiliated.

Program The program with which the student is affiliated.
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Field or Control Description

Student Career Nbr (student career number) The student career number with which the student is affiliated.

Campus The campus with which the student is affiliated.

User ID The ID of the user who is responsible for creating the OWO
contract.

Reviewing Details of the OWO Contract
Access the OWO contract summary subpage (Click the Detail button on the OWO Summary page).

Field or Control Description

Status The status can be changed from Active to Inactive. The
Reason field will appear.

Start Date The matriculation date of the student.

End Date The matriculation date of the student plus the duration.

Duration (Hours) The total duration of the OWO agreement in hours.

Old contract nbr (old contact number) If the OWO contract replaces another OWO contract, the old
contract number can be maintained here.

Complete education If this option is not selected, then all the plans linked to the
student will display.

Agreements AOHS (agreements appendix educational help
structure)

If this option is not selected, then you are able to link to
another appendix. The description also becomes available for
text entries related to the student. Only appendixes that are not
the default appendix will appear in the available options.

Agreements AVB (agreements voluntary contributions) If this option is not selected, then you are able to link to
another voluntary financial contribution appendix. Enter the
amount and description for the student. Only appendixes
that are not the default appendix will appear in the available
options.

Note: After the contract is printed no additional data can be entered. If you need to correct data, then the
contract must be set to inactive, a reason entered, and then a new contract must be generated. You may
reprint the contract.
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Adding General Text Appendixes
Access the Other Text Appendixes page (Click the Detail button on the OWO Contract Summary page).

Enter additional text which can be added to the OWO contract. The information can be used for
institutions that need to add extra data to the OWO contract. The report can be customized to put this text
on any place on the OWO contract.

Determining a Selection Method for an Institution

This section discusses how to determine a selection method for an institution.

Page Used to Determine a Selection Method for an Institution

Page Name Definition Name Navigation Usage

OWO Setup Table SAD_OWO_INS_NLD Student Admissions >
Educational Contracts
NLD > OWO Setup

Determine selection method
for an institution.

Determining a Selection Method for an Institution
Access the OWO Setup Table page (Student Admissions > Educational Contracts NLD > OWO
Setup).

Use this page to control the way the OWO creation process should select the students, for which a
contract is created. Choose one of the three options.

Field or Control Description

Applicant Only students for whom at least an application entry has
been made can be selected during the OWO contract creation
process.

Matriculation Matriculation of a student enrollment is the basis for OWO
creation. Only students with a matriculation record can be
selected.

Activated for Term Students need to be activated for a specific term first before
they can be selected for the OWO creation process.

Creating OWO Contracts

This section discusses how to create OWO contracts.
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Page Used to Create OWO Contracts

Page Name Definition Name Navigation Usage

Create OWO Contracts SAD_RUN_OWO_NLD Student Admissions >
Educational Contracts
NLD > Create OWO
Contracts

Generate educational contract
agreements for groups of
students or for individuals.

Creating OWO Contracts
Access the Create OWO Contracts page (Student Admissions > Educational Contracts NLD > Create
OWO Contracts).

This example illustrates the fields and controls on the Create OWO Contracts page. You can find
definitions for the fields and controls later on this page.

The actual process that generates the OWO is a batch process.

Field or Control Description

Institution Enter the institution for which you want to create the OWO.

Academic Career Enter the career for which you want to create the OWO.
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Field or Control Description

Selection Criteria Select this option if you want to create a contract for just one
student. The Student ID and Career Nbr fields display.

Student ID Select the student ID of the student for whom you want to
create the OWO. This field displays only if the Selection
Criteria check box is selected.

Career Nbr (career number) Select the career number of the student for whom you want
to create the OWO. This field displays only if the Selection
Criteria check box is selected.

Academic Program Enter the program for which you want to create the OWO.

Term Enter the admit term for which you want to create the OWO.

Campus Enter the campus for which you want to create the OWO.

Group selection If a group selection is required, define the source of the group
and (when one is selected this field becomes visible), enter the
group name. The source of the group can be the Class table,
 Student group table or Student block header table.

Group Select the group, block, or class section the student is in.

Address Type Enter the address type that must be used for the student's
address on the OWO.

Type of Name Enter the name type that must be used for the student's name
on the OWO.

Replace contracts Use to set the old contract to inactive, allowing for a new
OWO contract to be created.

Current Effective Date Available when the Replace contracts check box is selected.
 Only contracts with an end date that is earlier than the entered
current effective date are part of the selection

Start Date When a start date is entered, it will be put on the OWO
contract as start date and the end date must be entered . When
not entered, the start date is determined by the OWO creation
process.

End Date End date must be entered if a start date is given. This date will
be recorded on the OWO contract as the end date during the
OWO creation process. If it is not entered, the creation process
will automatically calculate the end date of the contract.
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Printing OWO Contracts

This section discusses how to print OWO contracts.

Page Used to Print OWO Contracts

Page Name Definition Name Navigation Usage

Print OWO Contracts SAD_RUN_OWO_NLD Student Admissions >
Educational Contracts
NLD > Print OWO
Contracts

Print educational contract
agreements for groups of
students or for an individual.

Printing OWO Contracts
Access the Print OWO Contracts page (Student Admissions > Educational Contracts NLD > Print
OWO Contracts).

This example illustrates the fields and controls on the Print OWO Contracts. You can find definitions for
the fields and controls later on this page.

If you want to print a contract for just one student, select the Selection Criteria option. The EmplID and
Career Nbr fields appear on the page.
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See Creating OWO Contracts.
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Calculating Admissions Averages

Understanding Admissions Averages Calculation

When you evaluate an applicant for admission to your organization, you can evaluate that applicant by
the grade point average he or she earned in a specific set of classes. For example, an institution with a
nursing program can evaluate applicants based on the grade point averages applicants earned in nursing
prerequisites.

You can calculate the grade point average, evaluate the applicant based on that grade point average—an
SQC defined by your institution determines the status of the application—and then update the applicant's
application status.

To evaluate applicants based on admissions averages:

1. Set up the rules for the delivered admissions averages SQC (ADEVLAVG.sqc).

2. Assign the admissions evaluation code to the applicant and run the Materials Extract process
(ADMTLEXT.sqr).

3. Run the Evaluating Applicants process (ADMTLRTG.sqr) to calculate the average.

4. Update the application status (ADMTLPGS.sqr).

5. You can also update financial aid and student records and generate an admissions average report.

Prerequisites for Calculating Admissions Averages

To calculate admissions averages, you use rating components, rating schemes, and evaluation codes.
You set up one rating component for averages (AVDAVG), but you can set up many rating schemes that
use the averages rating component. You can name your rating schemes whatever you like, but you must
link the average rating component to each scheme that calculates admissions averages. For example,
suppose that you calculate averages for your nursing program using the rating scheme UAVGNUR, for
your computer engineering program using the rating scheme UAVGCEN, and for your honors English
program using the rating scheme UAVGHEN. You would need to assign each of these rating schemes the
ACDACG rating component.

You enter an SQC on the rating scheme, and you link the rating scheme to the evaluation code. You enter
this code when you run the Evaluation Calculation process (ADMTLRTG.sqr) to calculate the averages.
The evaluation code is linked to the rating scheme, which tells the process to execute the SQC.

Steps to take before you calculate admissions averages:

• Define an admissions averages rating component.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1285



Calculating Admissions Averages Chapter 37

Use the Rating Comp Def Table (rating component definition table) page to define an admission
average rating component. Each rating scheme can have many rating components. For example, you
can evaluate applicants based on an interview, SAT/ACT scores, overall GPA, and a grade average of
a group of prerequisites. Each of these parameters would be defined as a rating component. You can
also define a rating component for an overall score that the system uses to determine the application
status. However, you need a rating component set up specifically for averages because the admissions
averages SQC has to be associated with a specific rating component to calculate the desired averages.

Important! When you enter the Rating Comp Def Table page for the first time, the system asks you
to enter an institution and a rating component. Enter ADAVG in the Rating Component field.

• Define an admissions averages rating scheme.

Use the Rating Scheme Table page to define the admissions average rating scheme that the system
uses in the admissions evaluation process. You can name the rating scheme whatever you like, and
you can define many rating schemes to calculate various admissions averages.

Use the Rating Components Table page to assign the admissions averages rating component
(ADAVG) to the rating scheme, and to enter the SQC that the process uses to calculate averages.

When setting up the rating scheme for calculating admissions averages, be sure to select the
Final Value check box on the Rating Components Table page. You must select this check box for
the Evaluation Calculation process (ADMTLRTG.sqr) to consider this rating component in the
admissions decision. Selecting this check box also enables you to post the results of the calculation
to the application, and to update the Averages for Fin. Aid and Recs (averages for financial aid and
records) page.

The Method field must be set to Automatic to call the averages calculation SQC.

Important! You must enter ADEVLAVG in the Formula ID field. This is the delivered SQC that the
system must run to calculate admissions averages.

• Define an admissions averages evaluation code.

Use the Evaluation Table page to define your evaluation code for admissions averages. Select the
rating scheme that you want to use to calculate admissions averages—the averages rating component
(ADAVG) must be tied to this rating scheme—in the Overall Rating ID field. This is the hook that
ties the evaluation code to the average calculation SQC. In addition, when you prepare to run the
Evaluation Calculation process, you enter an evaluation code. The process runs the Evaluation
Calculation process on applications that are assigned the same evaluation code.

Important! In order for an application to be considered during the Evaluation Calculation process,
the application must have an evaluation code assigned on the Application Evaluation page.

Setting Up Rules for the Admissions Averages SQC

To set up rules for admissions averages SQC, use the Alternate Average Calculations component
(PROG_AVG_CALC_DEFN).
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This section discusses how to set up rules for the admissions averages SQC, and provides examples of
average program calculation and external courses and admissions averages.

Page Used to Set Up Rules for the Admissions Averages SQC

Page Name Definition Name Navigation Usage

Program Average Calculation PROG_AVG_CALC Set Up SACR > Product
Related > Recruiting and
Admissions > Alternate
Evaluations > Alternate
Average Calculations

Set up rules for the delivered
admissions averages SQC 
(ADEVLAVG). Using the
criteria that you select in
this page, the SQC searches
the applicant's external
course history to find courses
that match the criteria that
you set up here. After the
process finds a match it
takes the official grade from
the external course history,
 converts it to a numerical
value if it is not in this format
already, and averages it with
the other course grades it
finds.

Setting Up Admissions Averages SQC Rules
Access the Program Average Calculation page (Set Up SACR > Product Related > Recruiting and
Admissions > Alternate Evaluations > Alternate Average Calculations ).

This example illustrates the fields and controls on the Program Average Calculation page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Course Credit Count Enter the minimum number of total course credits that the
applicant must have taken in order for the process to calculate
an admissions average. The average calculation process looks
at each course listed in the Courses and Degrees page for this
applicant to find matches based on the criteria you select. The
process counts the number of course credits for each course.
 If the process—using the criteria that you set up—cannot find
enough matches to add up to your course credit criteria, the
process does not generate an average. The process instead
produces the following error message: "An average was not
calculated because the student has not met the minimum
course credit count."

See Viewing Admissions Calculation Errors.

Crse Level  (course level) Select the course level required for this average calculation.
 The process only looks at external courses that have the value
that you select in the Course Level field on the Courses and
Degrees page.

External Academic Level Select the external academic level required for this average
calculation. The process only looks at external courses that
have this external academic level in the Acad Level  field on
the Courses and Degrees page.

Minimum Score Enter a minimum score if you want the process to only include
in the calculation average those external courses that contain
a score of at least the value that you enter in the Grade In/
Official field on the Courses and Degrees page. For example,
 A minimum score of 50 is entered. Thus, an external course
that meets all of the other criteria that are set up on this page
but contains a grade of less than 50 is not used in the average
calculation.

Repeated Grade Processing Select how you want the process to choose between two or
more repeated courses. Values for this field are delivered with
your system as translate values. You can modify these translate
values. Values are:

First: If the process finds a repeated course, it uses the grade
of the first course it finds in the calculation process.

Highest: If the process finds a repeated course, it uses the
highest grade of the repeated courses in the calculation
process.

Last: If the process finds a repeated course, it uses the grade of
the last course it finds in the calculation process.

Transcript Status Select the transcript status to be used in this average
calculation. The system only uses those applications with this
transcript status in the calculation process. You can insert a
row to specify more than one transcript statuses.
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Field or Control Description

External Org ID  (external organization ID) Enter the external organization ID that is associated with the
course that is to be used in this average calculation.

Req#  (requirement number) Requirement number enables the average calculation SQC 
(ADEVLAVG) to determine which group of courses should
be evaluated together when more than one course can satisfy a
program prerequisite.

See Viewing an Average Program Calculation Example.

Wildcard Select this option if you want to calculate all courses that begin
with the value in the School Course Nbr field.

For example, if you entered SCNC in the School Course Nbr
field, and selected the Wildcard option, the process would
look for any course beginning with SCNC, such as SCNC10,
 SCNC100, and SCNC15.

School Course Nbr  (school course number) Enter the school course number to be used for this average
calculation.

Min Grade (minimum grade) Enter a minimum grade if you want to override the Minimum
Score field for this external course.

Viewing an Average Program Calculation Example
Suppose that one of the criteria with which you evaluate applicants is a grade point average of a select
number of classes. You calculate the average and use the average calculation functionality to evaluate
applicants and update the application status.

For example, suppose that you evaluate applicants on the grade point average of the following courses:

1. ENGL70

2. MATH104

3. One of the following: ENGL100, ENGL92, or SCNC25

Therefore, use an average based on the grades of only three courses in our Evaluation Calculation
process. To calculate the average, enter the first course in the Program Average Calculation page just as in
the previous page shot. Then, insert a row in the bottom portion of the page and do as follows:
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This is an example of Program Average Calculation page (1 of 4).

Select your second prerequisite in the School Course Nbr field and change the Req# value to 2. This tells
the system to treat this course as a separate course, and to use the grades that the applicant earned in both
of these courses in the calculation. Then insert a row as follows:

This is an example of Program Average Calculation page (2 of 4).

Enter a third course in the School Course Nbr field and change the Req# to 3. Then, insert two more
rows and select the remaining two courses, but keep the Req# value the same.
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This is an example of Program Average Calculation page (3 of 4).

Note in page shot 3 of 4 that Req# is still 3, but you selected a second course.

This is an example of Program Average Calculation page (4 of 4).

Note in page shot 4 of 4 that Req# is still 3, but you selected a third course. Because there are three
courses with the Req# of 3, the process only uses one of the courses in the calculation. If the applicant
took only one of the courses, the system would use that course. If the applicant took more than one of
these courses, the system treats the courses as repeated and selects a class to use in the calculation process
based on the option selected in the Repeated Grade Processing  field.

The system averages the scores of ENGL70 and MATH104, and the Highest of ENGL100, ENGL92, and
SCNC25. From here, go to the Evaluation Calculation page to run the process and then to the Overall
Rating page to view the result in the Rating Value field.
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Viewing an External Courses and Admissions Averages Example
The courses that you select on the Program Average Calculation page are assigned to the student on
the Courses and Degrees page. The calculation process looks at the Courses and Degrees page for each
student to determine which courses to use in the calculation.

The following example represents an external course for an applicant.

Student Recruiting > Maintain Prospects > Academic Information > Education > Courses and
Degrees or Student Admissions > Application Entry > Academic Information > Education >
Courses and Degrees

This image illustrates an example of Courses and Degrees page.

For this course to be included in the average calculation, the Course Nbr (course number) field on the
Courses and Degrees page: Course tab must correspond with the School Course Nbr (school course
number) field on the Program Average Calculation page. If you choose a course level and external
academic level on the Program Average Calculation page, the process compares that to the Course Level
field and Acad Level  (academic level) field on Courses and Degrees page: Details tab. If there is a
match, then this course is included in the average calculation. The SQL goes down each course on the
applicant's record to look for a match based on the criteria that you set up.

The system uses the translated value in the field to the right of the Grd In/Official (grade in/official) field
for the average calculation. The average calculation only runs for numeric grades. The average calculation
converts non-numeric grades into numeric grades to be used in the average.
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Running the Application Materials Extract Process

Before you can run the Evaluation Calculation process you must run a process to link all or a portion
of a person's application materials to an application, or you must link the materials manually through
the Application Materials page. These materials can then be used for evaluating the application. The
Application Materials Extract process extracts the materials associated with the rating scheme that is
assigned to the evaluation code. Evaluation codes must be assigned to the applicant on the Application
Evaluation page so the Application Materials Extract process knows which records to extract. Ensure that
the admissions evaluation code is assigned to the applicants before running the extract process or before
linking the materials manually.

Related Links
Linking Application Materials to Applications in Batch
Entering General Materials for Prospects and Applicants

Evaluating Applicants Based on Admissions Averages

After you have properly flagged the external course grades to include in the average calculation—by
setting up the rules for the SQC—you can run the Evaluation Calculation process (ADMTLRTG). To run
this process, select an evaluation code. By selecting an evaluation code you call the rating scheme (which
is tied to the evaluation code). When you defined the rating scheme in an earlier step, you entered the
averages SQC. Thus, running the Evaluation Calculation process performs the average calculation.

After the process calculates the average, you can view the result. But if the process encountered an error,
you can view the error messages online, correct the error, and re-run the process.

This section discusses how to:

• Run the Evaluation Calculation process.

• View the newly calculated average.

• Correct admissions calculation errors.

• View admissions calculation errors.

Page Used to Evaluate Applicants Based on Admissions Averages

Page Name Definition Name Navigation Usage

Alternate Avg Calc Messages 
(alternate average calculation
messages table)

AVG_PRCS_MSG_TBL Student Admissions >
Application Evaluation >
Alternate Avg Calc
Messages

View admissions calculation
errors.
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Running the Evaluation Calculation Process
Use the Evaluation Calculation page to calculate the admissions average. This process updates the Rating
Value field on the Overall Rating page with the newly calculated average.

Enter the evaluation code that calls the appropriate admissions average rating scheme. The rating
scheme that you select here must contain the admissions average rating component (ADAVG) and SQC
(ADEVLAVG) to calculate the admissions average.

Related Links
Calculating Rating Values Through an Automatic Process

Viewing the Newly Calculated Average
Use the Overall Rating page to view the newly calculated average. After you run the Evaluation
Calculation process with the delivered averages SQC (ADEVLAVG), the resulting average appears on
this page in the Rating Value field. However, the average only appears on this page when the system
successfully calculates the average. If the Evaluated check box is selected but there is no value in the
Rating Value field, an error was encountered during the process. The next section describes how to view
admissions calculation errors.

Related Links
Creating Application Evaluations

Correcting Admissions Calculation Errors
The Evaluation Calculation process runs for every applicant who has been assigned the evaluation code
for which you are running the process. Sometimes an applicant who has been assigned the evaluation
code does not meet all of the criteria for calculating an average that you select. For example, if you
specify that applicants must have taken the course SCNC100 to be given an average, and an applicant
who has been assigned the evaluation code for which you run the Evaluation Calculation process has not
taken this course, the process does not generate an average. Instead, the Evaluation Calculation process
generates an error message that tells you why it did not generate an average.

You know that an error occurred when the Evaluated check box is selected but there is no value in the
Rating Value field on the Overall Rating page. View Admissions Calculation Errors on the Alternate Avg
Calc Messages (alternate average calculation messages) page.

Related Links
Creating Application Evaluations

Viewing Admissions Calculation Errors
Access the Alternate Avg Calc Messages page (Student Admissions >Application
Evaluation >Alternate Avg Calc Messages).
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This example illustrates the fields and controls on the Alternate Avg Calc Messages page. You can find
definitions for the fields and controls later on this page.

Note: You must enter at least one search parameter in addition to institution.

Field or Control Description

Instance Enter a process instance. Each time the evaluation process
runs, the system assign a number to that specific instance.
 Enter a process instance number to search for error messages
generated during that instance of the process.

ID Enter a student's identification number. The system looks for
any error messages that the system generated when calculating
averages for this ID.

Appl Nbr  (application number) Enter an application number. The system looks for any error
messages that the Evaluation Calculation process generated
when calculating averages for this application number.

Eval Code (evaluation code) Enter an evaluation code. The system looks for error messages
that the Evaluation Calculation process generated for this
evaluation code.

Component Enter a rating component. The system looks for error messages
that the Evaluation Calculation process generated for this
rating component.

Search Click this button to search for messages using the criteria you
select.
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Error Messages

There are three error messages delivered with the application. The process generates error messages when
an applicant who has been assigned the evaluation code does not meet the criteria you specified for the
admissions SQC on the Avg Prog Calc page.

• Minimum course credit count not met.

Description: "An average was not calculated because the student has not met the minimum course
credit count."

Example: You enter 60 in the Course Credit Count field on the AVG Prog Calc page but the
applicant's total course credit count only equals 58.

Description: "An average was not calculated because the student has not met the minimum grade
requirement."

Example: You select 2.0 in the Minimum Score field. The applicant took the prerequisites you
specified but did not achieve a grade of 2.0 in that course.

• Program prerequisites have not been met.

Description: "An average was not calculated because the student does not have the necessary courses
to meet the program prerequisites."

Example: You entered the prerequisite SCNC10 in the School Course Nbr field on the Avg Prog Calc
page but this course is not listed on this applicant's external course record.

Running the Application Status Update Process

Use the Application Status Update page to update the application statuses of those applicants for whom
the Evaluation Calculation generated an admissions average. These are applicants who were assigned
the admissions average evaluation code and who met all of the SQC criteria that you specified on the
Program Average Calculation page. This process also updates the Averages for Fin. Aid and Recs page.

Select the evaluation code that contains the admissions average rating scheme. This is the same evaluation
code that you used to run the Evaluation Calculation process. The application status update process uses
the result from the Evaluation Calculation process to update the applicant's application status.

Note: An SQC defined by your institution determines the status of the application based on the sum of the
final evaluation calculation values.

The application status update process also updates the Program Action field on the Application Program
Data page.

Related Links
Understanding How to Evaluate Applicants Using Automatic Processing
Entering Application Program Data
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Updating Admissions Averages for Financial Aid and Student
Records

The section discusses how to update admissions averages for financial aid and student records.

Page Used to Update Admissions Averages for Financial Aid and Student
Records

Page Name Definition Name Navigation Usage

Avgs for Fin Aid and Records 
(averages for financial aid and
student records)

ADM_EVAL_FA_SR_PNL Student Admissions >
Application Evaluation >
Avgs for Fin Aid and
Records

Update admissions averages
in PeopleSoft Financial Aid
and PeopleSoft Student
Records.

Using the Averages for Fin Aid and Records Page
Access the Avgs for Fin Aid and Records page (Student Admissions > Application Evaluation > Avgs
for Fin Aid and Records).

This example illustrates the fields and controls on the Avgs for Fin Aid and Records page.

There are two ways financial aid and student records personnel can use admissions averages. The first
way is to access this page and view the averages for specific applicants.

However, if you want to update PeopleSoft Financial Aid and PeopleSoft Student Records automatically,
you can write SQRs that extract the information from Recruiting and Admissions. First, write an SQR
to select or clear the FA (financial aid) and SR (student records) check boxes. This SQR tells the system
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which application numbers you want to make available to Financial Aid and Student Records. Second,
write an SQR to extract the admissions average data. The SQR(s) that you write should extract the
averages and send them to Financial Aid to be used in determining awards, and to Student Records so that
the averages travel with the applicant throughout his or her career at your organization.

1298  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 38

Using Admissions Average Cutoff Reports

Understanding the Admissions Averages Cutoff Report

Recruiting and Admissions enables you to assess an evaluated applicant pool to determine the admissions
average that drive certain program actions. For example, you might need to know how many applicants
within an evaluation code, who have admissions averages between 85 and 100, have the program action
of ADMT.

To generate an admissions average cutoff report:

1. Set up the criteria that determine the content of the report.

The report tallies the number of applicants who:

• Are assigned the specified evaluation code, have an admissions average that falls within the range,
and have the appropriate program action based on the range you define.

• Are assigned the specified evaluation code, have an admissions average that falls within a defined
range, but do not have the appropriate program action based on the range you define.

• Are assigned the specified evaluation code (the total number of applicants assigned this evaluation
code).

2. Run the average cutoff report process (ADAVGCUT.sqr).

The process retrieves the rating component that is attached to the admissions average SQC
(ADEVLAVG.sqc). Next, the process tallies applicants based on the program actions and value
ranges that you specified on the Average Cutoff Report page. Finally, the process generates a report
according to your Process Scheduler settings and calls it adavagcut.lis.

Generating Admissions Average Cutoff Reports

To set up the average cutoff table, use the Average Cutoff component (AVERAGE_CUTOFF_TBL).

This section discusses how to set up the average cutoff table.
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Pages Used to Generate Admissions Average Cutoff Reports

Page Name Definition Name Navigation Usage

Average Cutoff Table AVG_CUTOFF_TBL Set Up SACR > Product
Related > Recruiting and
Admissions > Alternate
Evaluations > Average
Cutoff Table > Avg Cutoff
Table

Set up the criteria that you
want the system to report.

Average Cutoff Report RUNCTL_ADAVGCUT Student Admissions >
Reports > Average Cutoff
Report

Run the average cutoff report.

Setting Up the Average Cutoff Table
Access the Average Cutoff Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Alternate Evaluations > Average Cutoff Table > Avg Cutoff Table).

This example illustrates the fields and controls on the Average Cutoff Table page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Program Action Enter the program action that an applicant should be assigned
if his or her average falls within the range that you enter. The
report displays the number of applicants whose average falls
within this range but are not assigned this program action, as
well as those who fall within the range and who are assigned
this program action.
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Field or Control Description

Evaluation Code Enter the evaluation code for which you want to generate
a cutoff report. The system only queries applications that
are assigned the evaluation code that you enter here for the
program action and average range.

Cutoff Average from Range Enter the minimum value an average can be for the system
to consider the program action effective for the group of
applicants that are assigned the evaluation code that you enter.

Cutoff Average to Range Enter the maximum value an average can be for the system
to consider the program action effective for the group of
applicants that are assigned the evaluation code that you enter.

In the previous page shot, all applications to the undergraduate liberal arts program for admit term Fall
2001 with the first year admit type, that are assigned the evaluation code ADMAVG and that have an
average between 3.6 and 4.0 inclusive appears on the report under the program action of Admit. Those
applications with an average between 1.0 and 3.0 inclusive appears on the report under the program action
of Deny. Those applications with an average between 3.1 and 3.5 inclusive appears on the report under the
program action of Wait.

Related Links
Recruiting and Admissions Reports: Selected Reports
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Creating Alternate Program Offers

Understanding Alternate Program Offers

When applicants do not meet the requirements for their requested program, you can evaluate them in
alternate programs, thereby giving them a second chance to attend your organization. For example, an
applicant might be denied entry to your highly competitive engineering program, but when re-evaluated
for a less competitive program the same applicant might be accepted.

To create alternate program offers you must first assign an alternate academic program and an alternate
evaluation code. You select the primary academic program to which the person is applying (such as FAU),
and then specify the alternate program (such as LAU). Thus, all applicants who get denied or waitlisted
for FAU, in this example, get evaluated in the LAU program.

After you have assigned alternate program evaluation codes, you run the Assign Alternate Eval Codes
process (ADALTEVL.sqr) that assigns alternate evaluation codes to applicants. You will select applicants
based on academic institution, the academic program that they requested, and the admit term. For
example, if you select the program LAU and admit term 0450, the process will assign an alternate
evaluation code to applicants who applied to but were denied or waitlisted to LAU in Fall 2001.

After you have assigned alternate evaluation codes to applicants, you must either run the materials extract
process, or assign the materials manually. Then you must run the Evaluation Calculation process to
evaluate them in the new program using the new evaluation code that you just assigned to them.

After the Evaluation Calculation process calculates the overall rating score, you run the Alternate
Programs process (ADALTPRG.sqr). The Alternate Programs process compares the minimum rating
score that you define to the overall rating score that the Evaluation Calculation process calculates. If the
applicant meets the criteria, the Alternate Programs process inserts a new row in the person's application
(adm_appl_prog) for the existing application number and assigns a new program number. Thus, you still
have access to the application in which the person was denied or waitlisted.

Assigning Alternate Evaluation Codes

To set up alternate evaluation codes, use the Alternate Offer component (ALT_OFFER_TABLE).

This section discusses how to assign alternate evaluation codes.
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Page Used to Assign Alternate Evaluation Codes

Page Name Definition Name Navigation Usage

Alternate Offer Table ALT_OFFER_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Alternate
Evaluations > Alternate
Offer Table

Assign alternate offer program
evaluation codes to academic
programs.

Assigning Alternate Evaluation Codes
Access the Alternate Offer Table page (Set Up SACR > Product Related > Recruiting and
Admissions > Alternate Evaluations > Alternate Offer Table).

Field or Control Description

Alternate Academic Program Enter the alternate program. Any person who applies and is
either denied or waitlisted to the academic program that you
specified upon entering this page will be evaluated in the
alternate program that you enter here. For example, you can
set it up so that any person applying to LAU, who is denied or
waitlisted in that program, will be evaluated in FAU using the
ACT evaluation code.

Alternate Evaluation Code Enter the evaluation code the system will use to evaluate the
applicant in the alternate program. For example, an applicant
who was denied or waitlisted in the undergraduate engineering
program using the UGENG  evaluation code may be accepted
into the Liberal Arts program using the ACT evaluation code.
 Define alternate evaluation codes on the Evaluation Table
page.

Selecting Applicants for Alternate Offers

This section discusses how to select applicants for alternate offers.
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Page Used to Select Applicants for Alternate Offers

Page Name Definition Name Navigation Usage

Assign Alternate Eval Codes 
(assign alternate evaluation
codes)

RUNCTL_ADALTEVL Student Admissions >
Processing Applications >
Assign Alternate Eval Codes

Run the Alternate Averages
process. The process assigns
the alternate evaluation
code that you set up on the
Alternate Offer Table page to
any applicants who applied
to the academic institution
and academic program for the
admit term that you select.

Selecting Applicants for Alternate Offers.
Access the Assign Alternate Eval Codes page (Student Admissions > Processing Applications >
Assign Alternate Eval Codes).

Note: Admissions application records use the Last Admit Term value to determine if the program, plan,
or subplan should appear in the prompt. If the Last Admit Term field is populated on the Academic
Program Table (ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic
SubPlan Table (ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID,
the system does not display the value in the prompt.

Field or Control Description

Institution Enter the academic institution to which the academic program
belongs.

Academic Program Enter the academic program. This is the original academic
program to which the applicants applied but into which they
were not admitted. The process assigns the alternate evaluation
code to any applicant who applied to this academic program
—in the admit term you specify—and has a program action of
Deny,  Waitlist,, or Waitlist Offer Accepted.

If a student meets the above criteria but already has an
application to the alternate program, the Alternate Averages
process does not assign the alternate program code.

Admit Term The process only assigns the alternate evaluation code to
applicants who were denied or waitlisted in this term.

Click Run to run the Alternate Averages process at user-defined intervals.
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Assigning Alternate Programs

This section discusses how to run the Alternate Programs process to assign alternate programs, and
provides an example of how alternate programs are assigned to students.

Page Used to Assigning Alternate Programs

Page Name Definition Name Navigation Usage

Alternate Program Addition RUNCTL_ADALTPRG Student Admissions >
Processing Applications >
Alternate Program Addition

Run the Alternate Programs
process. The Alternate
Programs process updates
applications by comparing
the minimum score that
you enter on this page to
the overall rating that the
Evaluation Calculation
process calculates. The
Alternate Programs process
uses the information that
you define on this page to
update information in the new
application row.

Running the Alternate Programs Process
Access the Alternate Program Addition page (Student Admissions > Processing Applications >
Alternate Program Addition).
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This example illustrates the fields and controls on the Alternate Program Addition page. You can find
definitions for the fields and controls later on this page.

Note: Admissions application records use the Last Admit Term value to determine if the program, plan,
or subplan should appear in the prompt. If the Last Admit Term field is populated on the Academic
Program Table (ACAD_PROG_TBL), Academic Plan Table, (ACAD_PLAN_TBL), or Academic
SubPlan Table (ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID,
the system does not display the value in the prompt.

Field or Control Description

Institution Enter the academic institution for which you want to run the
process.

Academic Career Enter the academic career for the alternate academic program.

Alternate Evaluation Code Enter the alternate evaluation code that is assigned to the
applicants to be evaluated. The Alternate Programs process
updates the applications of only those applicants who have
been assigned this alternate evaluation code. Therefore, you
must have already run the Alternate Eval Code process to
assign applicants an alternate evaluation code. Define alternate
evaluation codes on the Evaluation Table page.

Rating Component Enter the rating component that you want to use to evaluate
applicants. The rating component defines the format and
meaning of the rating value. For example, in the preceding
page shot, you selected the ACT rating component. The rating
value therefore represents the minimum ACT score that can be
admitted into the alternate program.
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Field or Control Description

Rating Value Enter the minimum score for consideration in the alternate
program. The Alternate Programs process compares this score
to the overall rating value that the Evaluation Calculation
process calculates. If the overall rating value is equal to or
more than the value you enter in this field, then the applicant is
accepted into the alternate program. In the above example, the
applicant must score at least 27 on the ACT to be accepted into
the alternate program.

See Assigning Alternate Programs.

Note: After an applicant is accepted into the alternate
program, the Alternate Programs process creates a new row
in the person's application (adm_appl_prog) for the existing
application number. The system assigns a new program
number for the new program and plan into which the person
was accepted.

Approved Academic Load Select the academic load that you want the process to assign to
anyone who meets the criteria defined on this page.

Academic Plan Enter the academic plan that you want the process to assign to
anyone who meets the criteria defined on this page.

Campus Enter the campus that you want the process assign to anyone
who meets the criteria defined on this page.

Program Action Enter the program action that you want the process assign to
anyone who meets the criteria defined on this page.

Update Eval Status (update evaluation status) Enter the evaluation status that you want the process to assign
to anyone who meets the criteria defined on this page.

Action Reason Enter the action reason that you want the process to assign to
anyone who meets the criteria defined on this page.

Admit Term Enter the admit term that you want the system to assign to
anyone who meets the criteria defined on this page.

In the above example, applicants to the undergraduate career at PSUNV with an alternate evaluation code
of ACT and an ACT score of at least 27 will receive a program action of Admit.

Click Run to run the Alternate Programs process at user-defined intervals.

Viewing an Example of How Alternate Programs are Assigned to Students
The following person applied and was denied to the FAU program. Note that the program number is 0, the
academic program is LAU, and the program action is DENY.
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This is an example of Application Program Data page (1 of 2).

• First, you set up the Alternate Offer Table page, which enables applicants who were denied or
waitlisted in LAU to be evaluated in FAU.

See Assigning Alternate Evaluation Codes.

• Then you run the Alternate Averages process (ADALTEVL.sqr).

See Selecting Applicants for Alternate Offers.

The Alternate Averages process assigns an alternate evaluation code (ACT) to the person's application, as
illustrated in the following example. Access the Application Evaluation component by selecting Student
Admissions > Application Evaluation > Application Evaluation.
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This example is an example of Application Evaluation page.

Note in the page above that the evaluation code now reads ACT.

• This new evaluation code has not been evaluated through the Evaluation Calculation process.

Therefore, you ran the Materials Extract process to extract the application data, and then you ran the
Evaluation Calculation process to calculate the overall rating score based on the rating components
for the ACT evaluation code.

See Linking Application Materials to Applications in Batch.

See Calculating Rating Values Through an Automatic Process.

• Next you run the Alternate Program process (ADALTPRG.sqr), which compares the minimum score
that you enter on the Alternate Program Addition - Parameters page to the overall rating score that the
Evaluation Calculation process calculates.

The applicant in our example was denied in his requested program (LAU), but was accepted into the
alternate program (FAU), as illustrated in the following page shot. Maintain Applications is found by
selecting Student Admissions > Application Maintenance > Maintain Applications.
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This is an example of Application Program Data page (2 of 2).

Note that the program number is now 1. The Alternate Programs process inserted a new row and
incremented the program number by one. Thus, the program action of DENY for LAU still exists in
the student's record. This new row contains the new academic program FAU (the alternate program)
and note that the program action is ADMT. The Alternate Programs process also updated the remaining
parameters that you selected on the Alternate Program Addition page, such as the action reason, campus,
and academic load.

By evaluating this applicant in an alternate program, you were able to admit a person whom you would
have otherwise denied.

Copyright © 1988, 2021, Oracle and/or its affiliates. 1311



Creating Alternate Program Offers Chapter 39

1312  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 40

Updating Application Program Actions and
Statuses

Understanding Admissions Program Actions and Statuses

Important! Mass Change is a deprecated product. Support will be maintained for this product, but
no new development will be produced for Mass Change. It is strongly recommended that you use
Application Engine instead. For more information on PeopleSoft Application Engine, see PeopleTools:
Application Engine.

As applicants move through the admissions process, you must take action on their academic program
and update their program status. You can update a single application, a group of applications, or you can
use Population Selection or a mass change definition to update a large number of applications. When
you enter new program actions, you will enter new effective dates. Thus, you can maintain a history of
previous actions.

Note: For institutions who are new to this functionality, Oracle recommends the use of the Update
Program Action/Reason process with Population Selection for batch processing. See the “Updating
Program Actions and Action Reasons Using Population Selection” section.
Updating Program Actions and Action Reasons Using Population Selection

As you begin using program actions and statuses provided with Recruiting and Admissions, start with the
most straightforward cases to become accustomed to the process. Then begin to work on the special cases,
such as deferrals and reconsiderations.

Program status is the high level relationship a person has with an academic program. When you select
a program action to change an applicant's program data, the program status often changes. Thus, the
Program Action field on the Application Program Data page contains different rows of program data for
a student. For example, a student goes from being an applicant to being admitted.

A program action is a change to a person's program data. An action reason indicates why a particular
program action was taken, or offers a further description of the program action. For example, you can
record that an applicant has withdrawn an application for an academic program. The reason you enter
could be After Decision or Before Decision.

For your reference, the program actions and program statuses relevant to admissions are explained in the
following table:
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If you Select this Program Action: The System Updates the Program Status to:

Application

Readmit Application

Reconsideration

Applicant

Waitlist

Waitlist Offer

Waitlisted

Admit

Conditional Admit

Admitted

Admission Revocation

Deny

Administrative Withdrawal

Applicant Withdrawal

Cancelled

Intention to Matriculate Prematriculant

Matriculation Active

Data Change

Defer Decision

Defer Enrollment

Plan Change

Program Change

The same Program Status as the previous row.

Program Status values are delivered with your system as translate values. Do not modify these values in
any way. Any modification to these values require a substantial programming effort. You can, however,
modify the descriptions of these values. Remember, however, that the altered description needs to retain
its original meaning to avoid confusion.

The Program Status values delivered with your system that are relevant to admissions, along with their
original descriptions, are:

• AC - Active in Program

• AD - Admitted

• AP - Applicant

• CN - Cancelled
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• DE - Deceased

• PM - Prematriculant

• WT - Waitlisted

Reviewing Admissions Program Action Definitions

The previous section details which admissions program actions set which program statuses. The chart
below lists Program Action definitions and provides additional information about what happens
when you choose a Program Action. Also, if any action triggers or requires an additional step, those
requirements are described here.

Admissions Program Action Explanation Additional Steps or Requirements
Caused by this Action

Application A person has an application that is under
consideration by an academic program.

None.

Readmit Application A person has applied to reenter a student
career and academic program for which
he or she already has a student record.

When you choose this action, the Career
Number field becomes available for
input. You must select which student
record should be populated with the
readmit information if the student ends
up enrolling again. Additionally, if you
enter this action, the admit type you enter
on the Application Data page must be
one associated with readmit processing.

Reconsideration A person who has a cancelled status
for the academic program, but is being
reconsidered for admission in the same
applicant pool.

After an action of reconsideration is
taken, you can admit the applicant. You
cannot take an action of Admit if the
program status is Cancelled. You must
first select a Reconsideration action.

Waitlist A person has been evaluated and may
be eligible for admission, but you do
not want to offer them admission at this
time. For example, there may not be
enough space in the class. The candidate
is currently active on the waitlist.

None.

Waitlist Offer A person has been evaluated and may
be eligible for admission, but you do
not want to offer them admission at this
time. The candidate has been offered a
place on a waitlist, but has not accepted
that offer.

None.
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Admissions Program Action Explanation Additional Steps or Requirements
Caused by this Action

Admit A person has been evaluated and
admitted into an academic program.

When a person has a status of admitted
or higher, depending on your application
center setup, the Deposits link becomes
available for input. If, in your application
center, you use a deposit fee code that
requires you to calculate a deposit, you
must calculate an enrollment deposit
before you can save the page. If your
application's deposit fee code does not
require you to calculate a deposit, or
if you do not have a deposit fee code
associated with your application center,
 you are not required to calculate a
deposit. If an application was given a
status of admit through the Application
Status Update process, you can run
the Calculate Deposits process to
calculate an enrollment deposit for those
applications.

Conditional Admit A person has been evaluated and
accepted into an academic program
on a conditional basis. Along with
a Conditional Admit action you can
assign a checklist code to help track
the outstanding requirements for the
conditions of admission.

Same as for Admit.

Admission Revocation A person was admitted into an academic
program, but it was later determined that
the person did not qualify for admission.
 The individual was assigned a Cancelled
status from an Admitted or Active status.

When revoking admission for a
person who has a current action of
Matriculation, and therefore an Active
status, you must go to Records and
Enrollment to take this action on the
Student Program/Plan component.
 When you revoke admission from
Records and Enrollment, the Student
program information is deleted and your
application information is updated as
Cancelled Due to Admission Revocation.
 If the person never had an action of
matriculation, you can add an Admission
Revocation action directly in PeopleSoft
Recruiting and Admissions.
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Admissions Program Action Explanation Additional Steps or Requirements
Caused by this Action

Deny A person has been denied admission to
an academic program.

None.

Administrative Withdrawal A person's application to an academic
program has been withdrawn from
consideration for admission or from
enrollment in a class. This can be done
before or after an action of admit has
been taken or after the applicant has
achieved active status. In addition,
 reasons can be created to clarify when or
why the application was withdrawn.

None.

Applicant Withdrawal A person has withdrawn from
consideration for admission or from the
entering class. Reasons can be created
to clarify when or why the withdrawal
occurred. For example, an action of
applicant withdrawal with Before
Decision as the reason indicates the
individual withdrew early enough in the
process that no admission decision had
been made. A Waitlist Withdrawal reason
indicates someone who did not want to
accept a place on the waitlist.

None.

Intention to Matriculate A person has indicated intent to
matriculate, but has not completed all
the steps to become an active student.
 Reasons can be defined to clarify
why the candidate is changed from an
admitted status to a Prematriculant
status. For example, if you require that
an admitted student submit multiple
deposits to secure a place in the class,
 after the first deposit is received, you
might indicate an intention to matriculate
action with a reason of First Deposit.

None.
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Admissions Program Action Explanation Additional Steps or Requirements
Caused by this Action

Matriculation A person has completed all necessary
steps to become an active student in an
academic program.

When you enter an action of
Matriculation, you must click the
Create Program button that creates a
record for this person in PeopleSoft
Student Records. You can not save
the page until you click this button.
 After you matriculate the applicant,
 the component is saved. Also, all fields
become unavailable for input because
this person now belongs to PeopleSoft
Student Records.

Data Change Data relative to an applicant's academic
program was changed. This action
records the fact that a change was made.

None.

Defer Decision An evaluation was performed on an
application, but a decision was not
made. This action records the fact that
an application has been evaluated. For
example, a person applies under an early
notification plan. The person is evaluated
but does not meet the early decision
criteria. The final decision is deferred
until the regular decision deadline.

None.

Defer Enrollment A person has been admitted and may
be active for one admit term but will
actually enroll in a later admit term. This
action enables you to change the admit
term for the applicant and record that he
or she is deferring enrollment.

None.

Plan Change The academic plan to which an applicant
is applying was changed.

None.

Program Change The academic program to which an
applicant is applying was changed.

None.
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Updating the Program Action and Status of One Application

Use the Application Program Data page to update the program action and status of one application. If you
only have one application to update, do so through the Maintain Applications component.

Related Links
Entering Application Program Data

Updating Program Actions and Statuses of Multiple Applications

This section discusses how to update program actions and statuses of multiple applications.

Page Used to Update Program Actions and Statuses of Multiple
Applications

Page Name Definition Name Navigation Usage

Action/Reason Entry ADM_ACT_ENTRY • Student Admissions >
Application
Evaluation >
Application Decisions >
Action/Reason Entry

• Student Admissions >
Application
Maintenance > Action/
Reason Entry

Update multiple applications
to an identical program action
and status. If you must update
a group of applications which
are for the same academic
program and admit term with
the same program action,
 it is faster to do so through
this page, as opposed to one
at a time on the Application
Program Data page.

Updating Program Action and Status of Multiple Applications
Access the Action/Reason Entry page (Student Admissions > Application Evaluation > Application
Decisions > Action/Reason Entry  or Student Admissions > Application Maintenance > Action/
Reason Entry).
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This example illustrates the fields and controls on the Action/Reason Entry page. You can find definitions
for the fields and controls later on this page.

Note: Admissions application records use the Last Admit Term value to determine if the program
should appear in the prompt. If the Last Admit Term field is populated on the Academic Program Table
(ACAD_PROG_TBL), and the term is less than or equal to the term selected for the ID, the system does
not display the value in the prompt.

Field or Control Description

Admit Term Enter an admit term. Admit terms are defined on the Term
Values Table page.

Program Action Enter the program action to be entered on the applications
you are updating. Field values are delivered with your system
as translate values. Do not modify these values in any way.
 Any modifications to these values require a substantial
programming effort.

Action Reason Enter an action reason to be entered on the applications if you
have defined any reasons for this program action. Values for
this field are defined in the Action Reason Table page.

Action Date The default for the action date is your system date.

Seq  (sequence) If the action you are taking has the same date as the current
action, enter a 1. Enter a 2 for another action on the same date.
 The default sequence is 0.
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Field or Control Description

Application Number  and  ID Enter the first application number to be processed. The ID
displays. If you do not know the application number, prompt
on the ID field.

Program Number Enter the program number if the application has multiple
program numbers. When you navigate out of this page or click
the Refresh button, you can verify that you have the correct
person and application by reviewing the information displayed
in the Program Data and Program Status group boxes.

Create Program After entering an application number, click this button to
update the program data for the application number that you
enter. This button is only available to click if you entered a
program action of MATR.

Calculate Deposits Click this link to calculate deposits. The Calculate Deposits
page appears. This link appears if you have entered a
program action of ADMT and you have set up deposits for the
application center.

Updating Program Actions and Action Reasons Using Population
Selection

This section discusses how to run the Update Program Action/Reason process.

Page Used to Run the Update Program Action/Reason Process

Page Name Definition Name Navigation Usage

Update Program Action/
Reason

SAD_APL_PRG_RUN Student Admissions >
Processing Applications >
Update Applications >
Update Program Action/
Reason

Run the Update Program
Action/Reason process for a
group of applicants.

Updating Program Actions and Action Reasons Using Population Selection
Access the Update Program Action/Reason page (Student Admissions > Processing Applications >
Update Applications > Update Program Action/Reason).
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This example illustrates the fields and controls on the Update Program Action/Reason page. You can find
definitions for the fields and controls later on this page.

This page enables you to update program actions and action reasons for multiple applications, using
Population Selection.

Population Selection

Use this group box to select the applicants whose applications are to be updated via the Update Program
Action/Reason process.

Population selection is a method for selecting the IDs to process for a specific transaction. The Population
Selection group box is a standard group box that appears on run control pages when the Population
Selection process is available or required for the transaction.

Selection tools are available based on the selection tools that your institution selected in the setup of the
Population Selection process for the application process and on your user security. Fields in the group box
appear based on the selection tool that you select. The fields behave the same way from within the group
box on all run control pages and application processes. If your institution uses a specific selection tool (PS
Query, Equation Engine, or external file) to identify IDs for a specific transaction, you must use it.

See "Understanding the Population Selection Group Box" (Campus Community Fundamentals)

Field or Control Description

Selection Tool Select a tool to create the group of applicants whose records
you want to update. The fields in this group box change
depending on your selection. The Population Selection context
definition, Update Program Action/Reason, delivered to
support the use of population selection with this process, is
configured for use with Equation Engine, External File, and
PS Query.

In creating either a query or equation for use with the Update Program Action/Reason process, the
bind record SAD_APL_PRG_BND must be included in the query or equation. If the bind record is not
included, then the query or equation will not appear as prompt value for the Query Name or Equation
Name field. The bind record contains the required fields for the update process: Emplid, Institution,

1322  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 40 Updating Application Program Actions and Statuses

Academic Career, Application Number, and Application Program Number. Whether you use PS Query or
Equation Engine, values for these fields for the selected applicants must be passed through in the selection
tool in order for the process to know which records to update. You may extend the selection criteria
beyond the required data fields by including other fields or by joining to other records. For example, you
may want to include program action or admit term as part of the selection criteria and specify a value
either in the query or equation or as a run time prompt. If External File is used as the selection tool, then
the inbound file must also contain those data required fields.

The system delivers sample queries and equation. The sample queries are:
QA_CS_AD_PS_APPL_PRGUPD_01 and QA_CS_AD_PS_APPL_PRGUPD_02. The sample equation
is: ADADPSAPPUPD.

Program Action - Action Reason

Use this group box to specify the program action and action reason to be entered on the applications you
are updating.

Field or Control Description

Effective Date Enter a date equal to or greater than the System Date. The
default value is the System Date.

Use System Date Select this check box to always use the System Date and
ignore the value in the Effective Date field.

The Update Program Action/Reason process first selects the applications according to the criteria defined
in the Population Selection group box. Then, for each application, the process will add a new row to the
Application Program Data page with the program action, action reason, and effective date that you have
specified on the Program Action - Action Reason group box.

Updating Program Actions and Statuses Using Mass Change

Important! Mass Change is a deprecated product. Support will be maintained for this product, but
no new development will be produced for Mass Change. It is strongly recommended that you use
Application Engine instead. For more information on PeopleSoft Application Engine, see PeopleTools:
Application Engine.

This section provides an overview of how to update program actions and statuses using mass change and
discusses how to run the Application Program Update process.

Understanding Multiple Application Program Action and Status Updates
If you have a large number of applications you want to update with the same program action, action
reason, and academic program status, you can use a background process.

To update program actions and statuses of multiple applications:

1. Set up your Mass Change Definition.
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Use the Mass Change Definition - Description page to enter your mass change definition. The mass
change definition defines the criteria for selecting which applications should be updated. PeopleSoft
provides a sample mass change definition called Application Program Update Select.  However, your
institution might have defined its own mass change definition for updating program information, or
your institution might have changed the shipped sample.

See PeopleTools: Data Management, “Mass Change”

2. Specify your Mass Change Criteria and Defaults.

Use the Mass Change Definition - Criteria and Defaults page to set up your mass change criteria.
You also choose the program action and action reason codes to be added to the selected application
records. The system automatically updates the program status according to the action taken.

There is one SQL statement execution sequence for this Mass Change Definition: Select Applicant
Criteria.

In the Defaults  group box, select the codes you want added to the new program row for the selected
applications. You may select values for program action and action reason. For example, you might be
updating these applications with a program action of DENY, and an action reason of AUTO. These two
fields are stored on the Application Program Data page.

3. Generate your SQL Statement to select the applications to be updated.

Use the Mass Change Definition - Generate SQL page to generate the SQL statement for this mass
change definition. Click the Clear Sw button then the Generate SQL button so do this. After
generating the SQL, select Save. After setting up your mass change definition and generating your
SQL statement, you are ready to process your mass change.

4. Run a Mass Change Group to select the applications to be updated.

Use the Run Mass Change page to process your mass change and select the actual applications to be
updated during the Application Program Update process. This process selects the actual applications
to be updated.

Because you want to delete any data in the temp file before running this process, you can use a mass
change group that PeopleSoft provides, which deletes the temp using the delivered Communication
- Delete Temp mass change definition and runs your Application Prog Update Select mass change
definition.

Select Application Prog Update Base in the Mass Change Group ID field. If you want to create a
different Mass Change Group or modify Application Prog Update Base, use the Mass Change Group
component before running the mass change group on Run Mass Change. On Run Mass Change, click
the Execute Mass Change Group radio button to make the Mass Change Group ID field available
for selection.

5. Run the Application Program Update process to do the actual updating of applications.

Use the Application Program Update page to update the program data of the selected applications. A
new row of program data is added to the selected applications on the Application Program Data page.
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Pages Used to Run the Application Program Update Process

Page Name Definition Name Navigation Usage

Application Program Update RUNCTL_PROGUPDT Student Admissions >
Processing Applications >
Update Applications >
Application Program
Update

Update the program data of
the selected applications.

This process uses the
applicants selected when
running the mass change
group to insert the program
action and program reason
defined on the Criteria
and Defaults page of the
Mass Change Definition
component. You must first
process your mass change
group before running the
application program update
process.

Mass Change Definition MC_DEFN_00 Student Admissions >
Processing Applications >
Mass Change > Mass
Change Definition

Define criteria for
applications to be updated.

Mass Change Group MC_DEFN_00 Student Admissions >
Processing Applications >
Mass Change > Mass
Change Group

Define the execution
sequence for the mass change
definitions.

Run Mass Change MC_DEFN_00 Student Admissions >
Processing Applications >
Mass Change > Run Mass
Change

Run the mass change group
to select the application to be
updated via the application
program update process.
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Managing Enrollment

Understanding Enrollment Management Targets

This section discusses:

• Enrollment management targets.

• Cohort, population, and division.

• Examples of enrollment management targets.

Learning About Enrollment Management Targets
Enrollment Management is an extremely flexible feature. Although there are many ways in which your
institution can use Enrollment Management, you must first think about how you want to set up and use
this tool. By spending time now thinking about the design, you will save time later.

Because this feature is so flexible, we can only show you examples of how you might want to use it.
There are virtually no rules, only possibilities. How you set up and design your enrollment management
targets can be as simple or as complex as you want.

With Recruiting and Admissions, you can store the following types of enrollment management
information:

• Target enrollment numbers.

• Actual enrollment numbers.

You can also group target enrollment numbers and actual enrollment numbers into levels that you define.

Learning About Cohort, Population, and Division
Enrollment management targets are set up using a three-level structure that consists of the following
elements: cohort, population, and division. These terms can mean whatever you need them to mean.
Cohort, population, and division are different levels, from highest to lowest, that you set up, define, link
to one another and for which you set targets. They are conceptually similar to the three-level structure
found in communications.
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This diagram illustrates the enrollment management level structure.

Cohort is the highest of the three levels. The cohort is the starting point for your target development. An
example of a cohort level that you can define is the entire group of students in an academic year. You
can define a cohort level of 2005 and set an enrollment target of 500 students for that academic year.
Alternatively, you can break this up into a cohort level for academic terms of Fall 2005 and Spring 2006.

Population is the next level down the hierarchy. You can define a population level by academic career.
Alternatively, you can define a population level by school or college. It is entirely up to you how you
define each level.

Division is the final bottom level in the enrollment management target setup. You can define a division
level, for example, by gender, ethnicity, academic program, admit type, or program status. There are
numerous options for how to break down and define enrollment management levels.

Viewing Examples of Enrollment Management Targets
The following examples illustrate how enrollment management targets can be set up.

Example 1 - One Detail

Suppose that the PeopleSoft University College of Engineering is concerned about enrolling more
women. You want to conduct a recruiting effort to target women for the 2005 academic year. You might
consider setting up the following enrollment management target to track your efforts. The following table
shows a detail enrollment management target.

Field Detail Target

Cohort 2005 Academic Year

Population College of Engineering

Division Female

Target 200
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Example 2 - Two or More Details (a Group)

Now, suppose that you want to break this down from the 2005 Academic Year into targets for each term,
Fall and Spring. This is the place to introduce the idea of a group enrollment management target. In this
case, you set up two detail enrollment management targets and join them as a group to form one group
enrollment management target. Instead of one detail with a cohort for the entire academic year of 2005
(Example #1), now you have two detail targets defined; one with a cohort for each term and a target of
100 (Example #2). You can combine two or more details into one group enrollment target.

Field Detail Target 1 Detail Target 2

Cohort Fall 2005 Spring 2006

Population College of Engineering College of Engineering

Division Female Female

Target 100 100

Example 3 - More Details

The College of Engineering consists of four different academic programs: Mechanical Engineering,
Chemical Engineering, Electrical Engineering, and Civil Engineering. In this example, you want each
program to set its own targets, not just one overall target for the entire College of Engineering. Assume
that you are setting the target for the entire 2005 Academic Year, and not by term this time. You can set up
a group of four detail enrollment management targets, one for each program as follows:

Field Detail Target 1 Detail Target 2 Detail Target 3 Detail Target 4

Cohort 2005 2005 2005 2005

Population Mech. Eng. Chem. Eng. Elect. Eng. Civil Eng.

Division Female Female Female Female

Target 100 100 100 100

Example 4 - Complex Details

To add more complexity, suppose that the College of Engineering is concerned not only with enrolling
more women, but also with enrolling other underrepresented minorities as well: African Americans,
Native Americans, and Latinos. You want to set up enrollment management targets for all women and
underrepresented minorities for the 2005 Academic Year for each of the four academic programs within
the College of Engineering. That is 16 different enrollment management target details. Here is one way
that you could set this up:
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Field Detail Target 1 Detail Target 2 Detail Target 3 Detail Target 4

Cohort 2005 2005 2005 2005

Population Mech. Eng. Mech. Eng. Mech. Eng. Mech. Eng.

Division Female African American Latino Native American

Target 100 100 100 100

 Detail 5 Detail 6 Detail 7 Detail 8

Cohort 2005 2005 2005 2005

Population Chem. Eng. Chem. Eng. Chem. Eng. Chem. Eng.

Division Female African American Latino Native American

Target 50 50 50 50

 Detail 9 Detail 10 Detail 11 Detail 12

Cohort 2005 2005 2005 2005

Population Elect. Eng. Elect. Eng. Elect. Eng. Elect. Eng.

Division Female African American Latino Native American

Target 25 25 25 25

 Detail 13 Detail 14 Detail 15 Detail 16

Cohort 2005 2005 2005 2005

Population Civil Eng. Civil Eng. Civil Eng. Civil Eng.

Division Female African American Latino Native American

Target 20 20 20 20
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In the preceding example, a group enrollment target that you define might consist of all 16 of the detail
targets, but it does not have to. You can, for example, set up a group of the horizontal detail targets in
the above table, or a group of the vertical detail targets. It all depends on what you want to do with the
information, and how you want to access it and report on it. There are several possible ways to use the
enrollment management targets as tools in your recruiting efforts.

Setting Up Enrollment Management Targets

To set up enrollment management targets, use Enrollment Target Division component
(TARGET_DIV_TABLE), Enrollment Target Population (TARGET_POP_TABLE), and the Enrollment
Target Cohort component (TARGET_COH_TABLE).

This section explains how to define for enrollment management the following items:

• Divisions

• Populations

• Cohorts

Start by defining divisions and then define populations and cohorts, because you attach divisions and
populations to cohorts.

Pages Used to Define Divisions, Populations, and Cohorts

Page Name Definition Name Navigation Usage

Target Division Table TARGET_DIV_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Enrollment
Targets > Enrollment
Target Division > Target
Division Table

Define a division.

Target Population Table TARGET_POP_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Enrollment
Targets > Enrollment
Target Population > Target
Population Table

Define a population
enrollment management
target.

Enrollment Target Cohort TARGET_COH_TABLE Set Up SACR > Product
Related > Recruiting and
Admissions > Enrollment
Targets > Enrollment
Target Cohort

Define a cohort enrollment
management target.
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Defining a Cohort
Access the Enrollment Target Cohort page (Set Up SACR > Product Related > Recruiting and
Admissions > Enrollment Targets > Enrollment Target Cohort).

This example illustrates the fields and controls on the Enrollment Target Cohort page. You can find
definitions for the fields and controls later on this page.

After you set up your divisions and populations, you set up the cohort. As an example, set up an
enrollment target level that tracks the enrollment of women, in all university programs, for the Fall 2002.

Field or Control Description

Population Enter the populations that you want to attach to this cohort. In
this example, you attached the population of All Programs to
the Fall 2002 cohort. You can attach multiple populations to
a cohort. Define populations on the Target Population Table
page.

Division Enter the divisions that you want to attach to this cohort. In
our example, you attached the African American, Female, and
All Program divisions to the Fall 2002 cohort. You can attach
multiple divisions to a cohort. Define divisions on the Target
Division Table page.

Performing Enrollment Management

This section discusses how to:

• Define enrollment management targets.

• Set additional target details.
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• Process enrollment management targets.

• Display enrollment management target results.

• Display target results with the Enrollment Management Summary page.

Pages Used to Perform Enrollment Management

Page Name Definition Name Navigation Usage

Enrollment Target ENRL_MGMT_TARGET Student Admissions >
Enrollment Targets >
Define Enrollment
Targets > Enrollment
Target

Set enrollment targets for each
level that you defined.

Target Detail ENRL_MGMT_DETAIL Student Admissions >
Enrollment Targets >
Define Enrollment
Targets > Target Detail

Specify additional details
about a target.

Target Applicants ENROLL_MGMT_ID Student Admissions >
Enrollment Targets >
Define Enrollment
Targets > Target Applicants

Display a list of all the people
that meet the target selection
criteria.

The Enrollment Target
process populates the
values in this page. A list of
people who meet your target
selection criteria appears
on the bottom section of
the page. For each person,
 it displays the ID, name,
 application number, program
number, and the number of
times that person is counted
for this detail or group. If you
are displaying a detail target,
 then this field is always 1.
 If you are displaying a group
target, then this number could
be anything depending on the
number of times the person
met the criteria for each detail
target within the group.
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Page Name Definition Name Navigation Usage

Calculate Enrollment Targets RUNCTL_ENRL_TARGET Student Admissions >
Enrollment Targets >
Calculate Enrollment
Targets

Process the enrollment
management target and obtain
current results. After you
have set up and defined your
enrollment management
target levels, you can run the
Enrollment Target process at
any time to obtain the results
and see how your institution is
doing with its efforts towards
these targets.

Enrollment Target Summary ENROLL_TARGET_SUMM Student Admissions >
Enrollment Targets >
Enrollment Target
Summary > Enrollment
Target Summary

View enrollment management
target results.

Defining Enrollment Management Targets
Access the Enrollment Target page (Student Admissions > Enrollment Targets > Define Enrollment
Targets > Enrollment Target). You must have already defined cohorts, populations, and divisions.

This example illustrates the fields and controls on the Enrollment Target page. You can find definitions
for the fields and controls later on this page.

1334  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 41 Managing Enrollment

Group/Detail Information

Field or Control Description

Group Select this option to set up a group enrollment management
target consisting of multiple detail targets.

Detail Select this option to set up a detail enrollment management
target. This is the default setting.

Cohort Select the cohort for this enrollment management target.

Population Enter the population for this enrollment management target.

Division Enter the division for this enrollment management target.

Target Enter the target number for this enrollment management target.

Result After you run the Enrollment Target process, this field displays
the total number of application rows meeting the target
selection criteria.

Actual After you run the Enrollment Target process, this field displays
the total number of people meeting the target selection criteria.
 If it is a detail row, the Actual field contains the same number
as the Result field.

Real After you run the Enrollment Target process, this field displays
the same value as the Result field. For group targets, you can
change this field to any number between (and including) the
result and actual number.

For example, suppose that for a group target of Fall 2005
undergraduate enrollment, the Result field displays 100.
 However, suppose that some of these people applied for two
or more programs. Therefore, the Actual field displays 80. The
Real field defaults to 80 but you can change it to any number
within that range that is appropriate, for example, 90. You
can use the Target Applicants page to view a list of the people
who meet your target selection criteria and verify the correct
real number. You can also use the Enrollment Management
Summary page to view results.
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Field or Control Description

Result Date/Time After you run the Enrollment Target process, the date and time
the most recent results were calculated for this enrollment
target appear.

Select Prog

Choose an application program setting:

Field or Control Description

Current Select this option to have the Enrollment Target process check
only the most current application row. If a student is in this
application program, and matches the target selection criteria,
 he or she is included in the count.

All Select this option to have the Enrollment Target process
check all the application rows. If a student has any application
program row that matches the target selection criteria, he or
she is included in the count.

For example, suppose that a person has applied to the LAU
academic program as illustrated in the following table:

Program Effective Date Status

LAU 03/01/05 Admitted

LAU 01/01/05 Applied

Field or Control Description

 You create an enrollment target detail in which the program is
LAU and the status is Applied, then:

If you select the All option, the student is included in the
enrollment target count on 3/01/05.

If you select the Current option, the student is not included
in the enrollment target count on 3/01/05. The student's most
current application program status (highest effective date) is
Admitted.
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Group Detail Selection

Field or Control Description

Detail Sequence Use this field only if you are creating a group enrollment
management target that consists of a series of detail targets.
 You would select all the detail targets here.

Detail

Field or Control Description

Career Enter the academic career for this enrollment management
target.

Term Enter the term for this enrollment management target.

Setting Additional Target Details
Access the Target Detail page (Student Admissions > Enrollment Targets > Define Enrollment
Targets > Target Detail).
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This example illustrates the fields and controls on the Target Detail page. You can find definitions for the
fields and controls later on this page.

In the Selection Criteria group box, select any additional criteria that you want to use to define your
target. These are selection criteria beyond the academic institution, academic career, and academic term
that you defined on the Enrollment Target page. The specific cohort, population, and division should drive
the selection of any of these fields.

Note: Admissions application records use the Last Admit Term  value to determine if the program, plan,
or subplan should appear in the prompt. If the Last Admit Term  field is populated on the Academic
Program Table (ACAD_PROG_TBL), Academic Plan Table (ACAD_PLAN_TBL), or Academic
SubPlan Table (ACAD_SBPLN_TBL) and the term is less than or equal to the term selected for the ID,
the system does not display the value in the prompt.

Field or Control Description

Admit Type Select this check box if you want to define your target by
admit type. After you select this check box, the Admit Type
field becomes available for input.

Program Status Select this check box if you want to define your target by
program status. After you select this check box, the Status
field becomes available for input.
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Field or Control Description

Academic Program Select this check box if you want to define your target by
academic program. After you select this check box, the Acad
Prog (academic program) field becomes available for input.

Gender Select this check box if you want to define your target by
gender. After you select this check box, the Gender field
becomes available for input.

Ethnic Group Select this check box if you want to define your target by
ethnic group. After you select this check box, the Ethnic
Group field becomes available for input.

If this detail comprised your entire enrollment management target, then you have completed all the
necessary data entry. Remember to save the page. If you are creating a group enrollment management
target and this was just one detail target, display the Enrollment Target page again and specify your
additional detail targets. Use the Group - Detail Selection field to find all the detail targets that you must
specify (roll up into) the group enrollment management target.

Note: The Target Applicants page displays only the list of students meeting the selection criteria after you
have run the Enrollment Target process.

Processing Enrollment Management Targets
Access the Calculate Enrollment Targets page (Student Admissions > Enrollment Targets > Calculate
Enrollment Targets). You must first set up the target detail on the Enrollment Target and Target Detail
pages.

Field or Control Description

Cohort Select the cohorts for which you want to process enrollment
management targets.

Click Run to run the Enrollment Target process at user-defined intervals.

Displaying Enrollment Management Target Results
After you have run the Enrollment Target process, you can display the results to see how your institution
is progressing with its recruiting efforts towards the target. There are two ways that you can obtain
enrollment management target information:

• Through the Enrollment Target page.

After you have run the enrollment management target process for a specific enrollment management
target, you can use the Enrollment Target page to display the calculated enrollment figures.

• Through the Enrollment Management Summary page.
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Related Links
Setting Up Enrollment Management Targets

Displaying Target Results with the Enrollment Management Summary Page
Access the Enrollment Target Summary page (Student Admissions > Enrollment Targets >
Enrollment Target Summary > Enrollment Target Summary). You must first run the Enrollment
Target process.

This example illustrates the fields and controls on the Enrollment Target Summary page. You can find
definitions for the fields and controls later on this page.

Entering Selection Criteria

Field or Control Description

Cohort,  Population, and Division Select the cohort, population, and division for which you want
to display targets.

Search Click to display the specified target results.

Viewing Results

The bottom section of the page displays the target results in the following columns:

Field or Control Description

Seq Nbr (sequence number) The target sequence number.
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Field or Control Description

Cohort The defined cohort.

Population The defined population.

Division The defined division.

Target The target number you originally set for this enrollment
management target.

Result The current result count for this target.

Real The current real count for this target.

Result Calculated Date/Time The most recent date and time these results were last
calculated.

Using Enrollment Management Target Templates

Use the Enrollment Management Template feature to easily create new targets by copying the details that
you want from existing targets. Using templates makes the process of creating enrollment management
targets much simpler. For example, you might have to set up a target detail enrollment for the next term
that is identical in all other respects as a target detail for this term. Alternatively, you might want to have
the same detail and group targets as last academic year but you must have a different target number.
The target template feature can manage this, so that you do not have to set up the target details from the
beginning.

Use the Target Detail Template component to define and use enrollment management templates.

To create enrollment targets using a template:

1. Enter new target details.

2. Specify the detail from which you are copying.

This section discusses how to select the target information from the old detail.
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Pages Used to Use Enrollment Management Target Templates

Page Name Definition Name Navigation Usage

New Target Detail TARGET_DETAIL_NEW Student Admissions >
Enrollment Targets >
Target Detail Template >
New Target Detail

Create new enrollment
management targets using the
target template feature.

Copy Target Detail TARGET_DETAIL_COPY Student Admissions >
Enrollment Targets >
Target Detail Template >
Copy Target Detail

Specify the target information
you are copying from for the
new detail target.

Selecting the Target Information from the Old Detail
Access the Copy Target Detail page (Student Admissions > Enrollment Targets > Target Detail
Template > Copy Target Detail).

This example illustrates the fields and controls on the Copy Target Detail page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Detail Sequence Select the detail sequence number of the detail from which you
are copying. The system displays the corresponding cohort,
 population, and division, if applicable.

Term Select the term for the new detail you are creating.
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Field or Control Description

Copy Click to copy the detail template from the old to the new
target.

After you save the page, you can display the new detail template and change only the items you have to
for the new target, rather than recreating everything from scratch.

Generating Enrollment Management Reports

This section discusses how to generate three different enrollment management reports:

• Enrollment Target Cohort Table.

• Target Population Table.

• Target Division Table.

Pages Used to Generate Enrollment Management Reports

Page Name Definition Name Navigation Usage

Enrollment Target Cohort PRCSRUNCTL Set Up SACR > Product
Related > Recruiting and
Admissions > Reports >
Enrollment Target >
Enrollment Target Cohort

Create a report listing the
enrollment target cohort levels
you have defined.

Enrollment Target Population PRCSRUNCTL Set Up SACR > Product
Related > Recruiting and
Admissions > Reports >
Enrollment Target >
Enrollment Target
Population

Create a report listing the
enrollment target population
levels you have defined.

Enrollment Target Division PRCSRUNCTL Set Up SACR > Product
Related > Recruiting and
Admissions > Reports >
Enrollment Target >
Enrollment Target Division

Create a report listing the
enrollment target division
levels you have defined.
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Loading and Assigning EPS Market Codes

Understanding EPS Market Codes

EPS™ (Enrollment Planning Service) is a geographic and demographic data service offered annually
by the College Board to Colleges and Universities. EPS provides information to subscribing institutions
about competitors, feeder schools, and demographic strengths and weaknesses. EPS market codes are
proprietary market codes owned by the College Board and are used to categorize external organizations
and people into geographical areas, mostly in the United States. Some admissions offices use EPS market
codes to focus their recruiting efforts in geographic areas in which they believe they will be the most
successful. Note that there is a license agreement that you must sign with the College Board to use the
EPS geomarket data. However, an institution is not required to purchase EPS to use the PeopleSoft EPS
market code functionality.

PeopleSoft Campus Solutions does not provide EPS data; however, it does provide an EPS market code
load process and lets you automatically assign the market codes to external organizations.

Setting Up Code Types for EPS Organizations

This section discusses how to set up external organization code types.

Page Used to Set Up Code Types for EPS Organizations

Page Name Definition Name Navigation Usage

External Organization Code
Type

EXTORGCDTYPE_TABLE Campus Community >
Organization > Define
Organization Data > Ext
Org Code Type Table >
External Organization Code
Type

Define an EPS market code
organization code type. When
you load EPS data, the EPS
External Load process links
the EPS data to the external
organization code types that
you define. Thus, you identify
EPS data by the external
organization code type to
which you link the data.

Setting Up External Organization Code Types
Access the External Organization Code Type page (Campus Community > Organization > Define
Organization Data > Ext Org Code Type Table > External Organization Code Type).
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Field or Control Description

Code Type Option Select EPS if the external organization code type that you are
adding is an EPS market code type. If the code you are adding
is not an EPS market code, select None.

Loading EPS Market Codes

You can load EPS market codes via the EPS External Load Parms (EPS external load parameters) page.
You can then view the load results and correct any errors. This section discusses how to run the EPS
External Load process.

Page Used to Load the EPS Market Codes

Page Name Definition Name Navigation Usage

EPS Load External Data EPS_LOAD_PARMS Campus Community >
Organization >
Organizations Data Load >
EPS Load External Data

Run the process to load the
EPS market codes for the
external organization code
type that you defined.

Running the EPS External Load Process
Access the EPS Load External Data page (Campus Community > Organization > Organizations Data
Load > EPS Load External Data).

This example illustrates the fields and controls on the EPS Load External Data page. You can find
definitions for the fields and controls later on this page.
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EPS Data Load Options

Field or Control Description

Load EPS Data Select to add EPS data to your system. You must select either
the Load EPS Data check box or the Delete EPS Data check
box.

EPS Code Type Select the EPS code type that you want to load. Only EPS
code types that you defined on the Ext Org Code Type Table
page are available for selection.

Input File Enter the drive, directory, and filename path where the EPS
market code external data resides.

EPS Data Delete Options

Field or Control Description

Delete EPS Data Select if you want to delete EPS data. You might perform this
action, for example, if you want to remove the previous year's
version of the EPS data.

All Select to remove all EPS data.

Specific Type and  EPS Code Type Select Specific Type to delete a specific EPS data type. Then
choose an EPS Code Type.

Click the Run button to run the EPS External Load process at user-defined intervals. The process name is
CCEPSLOD and the process type is SQR Report.

Viewing EPS Load Results

This section discusses how to view the following data related to the EPS load process:

• Zip codes

• Market codes

• Error messages

• Suspense messages

• All messages
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Pages Used to View EPS Load Results

Page Name Definition Name Navigation Usage

EPS Zip to Market Code EPS_ZIP_MRKT_TABLE Campus Community >
Organization > Define
Organization Data > EPS
Zip to Market Code

View the zip code that is
related to the market code.
 After running the EPS Load
External Data process, the
EPS data is populated into
the EPS Zip to Market Code
table.

EPS Market Code Table EPS_MRKT_CD_TABLE Campus Community >
Organization > Define
Organization Data > EPS
Market Code Table

View or update the EPS
market codes that you loaded
through the load process.

EPS Suspense Data EPS_SUSP_DATA Campus Community >
Organization >
Organization Data Load >
EPS Suspense > EPS
Suspense Data

View any error messages that
may result from the EPS load
process.

EPS Suspense Message EPS_SUSP_MESSAGE Campus Community >
Organization >
Organization Data Load >
EPS Suspense > EPS
Suspense Message

View the EPS suspense error
messages.

EPS Messages EPS_MESSAGE_TABLE Campus Community >
Organization >
Organization Data Load >
EPS Messages

View all of the messages
generated by the EPS External
Load process.

Viewing EPS Zip Codes Loaded Through the Load Process
Access the EPS Zip to Market Code page (Campus Community > Organization > Define
Organization Data > EPS Zip to Market Code).

This example illustrates the fields and controls on the EPS Zip to Market Code page.

1348  Copyright © 1988, 2021, Oracle and/or its affiliates.



Chapter 42 Loading and Assigning EPS Market Codes

Market codes can be linked to many external organization code types. You can view market code
descriptions on the EPS Market Code Table page.

Viewing EPS Market Codes Loaded Through the Load Process
Access the EPS Market Code Table page (Campus Community > Organization > Define
Organization Data > EPS Market Code Table).

Viewing EPS Load Process Error Messages
Access the EPS Suspense Data page (Campus Community > Organization > Organization Data
Load > EPS Suspense > EPS Suspense Data).

This example illustrates the fields and controls on the EPS Suspense Data page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Delete Select to mark this suspense record for deletion. The system
deletes the record when you run the EPS Purge Suspense File
process.

Duplicate Ind  (duplicate indicator) The load process selects this check box when it finds a
duplicate postal code, market name, and market code within
the code type.

Status

Field or Control Description

OK to Purge Select to mark the record for purge. When you run the EPS
Purge Suspense File process, this record is purged.
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Field or Control Description

Completed The load process selects this option when the record has been
successfully updated.

Error The load process selects this option when it encounters an
error, such as a duplicate. The system indicates duplicates
by selecting the Duplicate Ind check box. You can decide
whether to delete a duplicate record by selecting the Delete
check box, or to ignore the duplication by clearing the
Duplicate Ind check box.

Viewing EPS Suspense Messages
Access the EPS Suspense Message page (Campus Community > Organization > Organization Data
Load > EPS Suspense > EPS Suspense Message).

This example illustrates the fields and controls on the EPS Suspense Message page.

Viewing All Messages Generated from Loading EPS Market Codes
Access the EPS Messages page (Campus Community > Organization > Organization Data Load >
EPS Messages).
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This example illustrates the fields and controls on the EPS Messages page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Code Type,  Postal, Process Instance, Postal Place, and
Record Nbr (record number)

Use these fields to narrow the selection of messages that you
want to display.

Search Click to display the messages based on your search.

Assigning EPS Market Codes to an Organization

This section discusses how to:

• Assign market codes.

• View and maintain the organization external codes.

Pages Used to Assign EPS Market Codes to an Organization

Page Name Definition Name Navigation Usage

EPS Assign Organization EPS_ASGN_ORG_PARMS Campus Community >
Organization >
Organization Data Load >
EPS Assign Organization

Assign EPS market codes to
external organizations.
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Page Name Definition Name Navigation Usage

External Organization Codes EXT_ORG_CODES Campus Community >
Create/Maintain
Organizations > External
Organization Codes >
External Organization
Codes

Display the results of the
automated EPS assignment
process for a specific external
organization. You can also
use this page to maintain the
EPS market code data for the
institution.

Assigning Market Codes
Access the EPS Assign Organization page (Campus Community > Organization > Organization Data
Load > EPS Assign Organization).

This example illustrates the fields and controls on the EPS Assign Organization page. You can find
definitions for the fields and controls later on this page.

EPS Delete Option

Field or Control Description

Delete EPS Data Type and EPS Code Type Select to delete EPS data. Select the EPS code type to delete.
 Use this action, for example, to remove a prior year's version
of the EPS data.
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EPS Assign Options

Field or Control Description

Assign EPS Data Type and  EPS Code Type Select to assign EPS data to organizations. Select the EPS code
type to assign.

Skip Select if you do not want to assign an EPS market code to this
organization if this organization already has this EPS market
code assigned.

Replace Select if you do want to assign an EPS market code to this
organization if this organization already has this EPS market
code assigned.

Org Selection Criteria

Field or Control Description

Assign EPS Code to All Org  (assign enrollment planning
service code to all organizations)

Select to assign EPS market codes to all external
organizations. If you select this check box, the School Type
field and the fields in the Address Selection group box
become unavailable for input.

School Type Select the school type to which you want to assign EPS market
codes. If you want to select organizations by using the address
fields below, do not select the Assign EPS Code to All Org
check box. Instead, select a school type (such as Secondary).

Address Selection

Use this group box to assign EPS market codes to organizations based on address criteria.

Field or Control Description

Country  and State Enter the country and state to select external organizations.

Postal Code

Use this group box if you want to select external organizations from a certain postal code or postal code
range. Select the appropriate option depending on how you want to select by postal code. Select one
option only.
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Field or Control Description

Begins With Select to choose an organization by a beginning postal code.
 Enter the beginning postal code in the From field.

For example, suppose that one organization has had a 5-
digit postal code entered (90068) and one organization has
a 9-digit version of the postal code entered (90068-6328).
 Using a postal code that begins with 90068 will find both
organizations.

Equals Select to choose an organization by a specific postal code.
 Enter the postal code in the From field.

Range Select to choose an organization by a postal code range. Enter
the beginning postal code in the From field and the ending
postal code in the To field.

N/A Select if you do not want to use postal codes in your selection
criteria for the organization. This is the default setting.

Click the Run button to run the EPS Assign Organization process at user-defined intervals.

Viewing and Maintaining the Organization External Codes
Access the External Organization Codes page (Campus Community > Create/Maintain
Organizations > External Organization Codes > External Organization Codes).

This example illustrates the fields and controls on the External Organization Codes page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Ext Org Code Type  (external organization code type) Enter the external organization code type. If this external
organization code type is an EPS code type, then the EPS
Postal Code field becomes available for selection (if the
external organization code type is not an EPS code type, then
the EPS Postal Code field displays but you cannot edit or
change this field).

EPS Postal Code Enter the EPS postal code. You can change this field no matter
what the assignment process did.

EPS Market Code  and  EPS Market Name After you enter an EPS postal code, the system displays the
EPS Market Code and EPS Market Name from the setup
tables. This data cannot be changed on this page.

Purging EPS Market Codes

This section discusses how to purge EPS suspense files.

Page Used to Purge EPS Market Codes

Page Name Definition Name Navigation Usage

EPS Purge Suspense File EPS_PURGE_PARMS Campus Community >
Organization > EPS Purge
Suspense File

Purge EPS code records from
the suspense file. You can
purge all EPS codes or a
specific type.

Purging EPS Suspense Files
Access the EPS Purge Suspense File page (Campus Community > Organization > EPS Purge
Suspense File).
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This example illustrates the fields and controls on the EPS Purge Suspense File page. You can find
definitions for the fields and controls later on this page.

EPS Code Type

Use this group box to select the EPS market code records that you want to purge from the suspense file.

Field or Control Description

All Type Select to purge all EPS market code type records from the
suspense file.

Specific Type and Purge Code Type Select to purge only a specific EPS market code type record
from the suspense file. Use Purge Code Type to choose an
EPS market type.

Purge Suspense Record Status

Use this group box to select the type of messages that you want to remove. You must choose at least one.

Field or Control Description

All Select to remove all suspense records, regardless of their
status.

OK to Purge Select to remove all suspense records with a status of OK to
Purge.
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Field or Control Description

Completed Select to remove all suspense records with a status of
Completed.

Error Select to remove all suspense records with a status of Error.

Click the Run button to run the EPS Purge Program process at user-defined intervals.
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Deleting Prospect and Applicant
Information

Understanding the Prospect Delete and Application Delete
Processes

You can only delete prospect records and applications for which you have appropriate recruiting center
and application center security.

See "Understanding Recruiting and Admissions Security" (Campus Solutions Application Fundamentals).

You can delete prospect records and applications:

• Individually

• In a group

Use the group delete process to delete groups of prospect records or applications that you no longer want
to keep in your database—for example, once a semester, you might delete all prospect records that are
five years old and for which no application exists. You might use the individual delete process at the end
of each day, to delete prospect records or applications entered in error.

You can delete all academic career information for prospects or applicants or only information for a
specific academic career, when multiple careers exist. In either case, the processes delete prospect or
applicant data from all tables in which the data resides.

You also have the option to delete the communications, checklists, and comments (3Cs) associated with
the prospect record or application.

Before running the delete process, you can access the holding table to remove records that you no longer
want to delete or to change the 3Cs that you want to delete.

Important! The Prospect Delete and Application Delete processes are designed strictly as cleanup tools.
They are not to be used to delete an ID from the database. PeopleSoft Campus Community has the ID
Delete function for that task.

How Prospect Delete and Application Delete Relate to ID Delete

Although the Prospect Delete and Application Delete processes remove prospect records and applications
from database tables, the identification number and personal data still remain in the system. If you need to
delete this information, use the ID Delete functionality.

The ID Delete process, because of its primary objective to maintain referential integrity, searches for
the presence of critical data in high-level tables before it deletes individual identification numbers. If it
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finds no data for the identification number, it proceeds with the deletion. However, if it does find data, it
cancels the deletion and displays a message of explanation.

The Prospect Delete and Application Delete processes prepare records for ID Delete when:

• No other prospect record or application exists.

• No student record exists for a matriculated applicant or active student.

• No student financial record exists.

When you create prospect records and applications, the system writes a corresponding row to the
STDNT_CAREER table for each career of the prospect or applicant. The STDNT_CAREER table is one
of the control tables that the ID Delete process searches before it deletes an identification number. To
ensure that you can delete an identification number after a corresponding prospect record or application
is deleted, the Prospect Delete and Application Delete processes check for critical data elements to
determine if the identification number for the prospect or applicant meets certain conditions. If the
identification number meets those conditions and if it meets all the requirements of the ID Delete
feature, then the processes delete the identification number from the STDNT_CAREER table and the
identification number becomes eligible for ID delete.

Likewise, when your institution processes application fees and enrollment deposits, the system writes a
corresponding row to the ITEM_SF table, and this data flows up to the ACCOUNT_SF table (one of the
four control tables in the ID Delete feature). In the ITEM_SF table, the Applicant Delete process changes
the Application Number Deleted field from No, the default, to Yes.

The Prospect Delete and Application Delete processes remove data from the ID Delete control tables only
if the data came from Recruiting and Admissions processes. They do not remove data that originated from
other applications in PeopleSoft Campus Solutions.

Related Links
"Deleting Individual IDs" (Campus Community Fundamentals)

Common Elements Used to Delete Prospect and Applicant Information
This section lists common elements.

3Cs

You can delete the 3C information that is associated with prospect and application records.

Field or Control Description

Delete Communications, Delete Checklists, and Delete
Comments

Select the appropriate check boxes to delete any associated
3Cs that are assigned to prospect or application records.

Only 3Cs with the administrative functions PSSV, PROS,
 or PROP for prospect records and ADMA or ADMP for
applications, where the variable data matches the prospect or
application record, will be deleted.
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By Population

The By Population group box appears when the Population Selection process is selected. The population
selection process is a method for selecting the IDs to process for a specific transaction. The By
Population group box functions in the same way as the Population Selection group box, which is a
standard group box that appears on run control pages when the Population Selection process is available
or required for the transaction.

Selection tools are available based on the selection tools that your institution selected in the setup of the
Population Selection process for the application process, and on your user security. Fields in the group
box appear based on the selection tool that you select. The fields behave the same way from within the
group box on all run control pages and application processes.

If your institution uses a specific delivered selection tool (PS Query, Equation Engine equation, or
external file) to identify IDs for a specific transaction, you must use it.

See "Understanding the Population Selection Group Box" (Campus Community Fundamentals).

Field or Control Description

Selection Tool Select a tool to create the group of prospect records that you
want to delete. Values are: Equation Engine, External File, and
PS Query. The fields in this group box change depending on
your selection.

Query Name A number of queries are delivered with the PS Query tool. If
you run queries other than those that are delivered, you must
include the appropriate bind record in your query or it will
not appear when you select the prompt to view the available
queries.

The bind record for prospect delete is SAD_PRS_DEL_BND.
 Your query must also contain the following values: EMPLID,
 INSTITUTION and ACAD_CAREER.

The bind record for application delete is SAD_APP_DEL
_BND. Your query must also contain the following values:
EMPLID and ADM_APPL_NBR.

Click the Preview Selection Results link to verify that the
records that you selected are the ones that you want to delete.
 Click the Run button to insert the records into the Prospect
Delete Holding table or into the Application Delete Holding
table.

Adding Multiple Rows

Save data entry time by adding multiple rows.
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Field or Control Description

Click to add multiple rows. Unused rows are deleted when you
save.

Deleting Prospect Records

This section discusses how to:

• Select individual prospect records to delete.

• Select a group of prospect records to delete.

• View the Prospect Delete Holding (ADM_PRS_DEL_SUSP) table.

• Run the Prospect Delete SQR (ADPRSDEL) process.

Pages Used to Delete Prospect Records

Page Name Definition Name Navigation Usage

Delete Prospect Record SAD_PRS_DELETE Student Recruiting > Delete
Prospects > Delete Prospect
Record

Select individual prospect
records for deletion.

Prospect Delete by Batch SAD_PRS_DEL_BATCH Student Recruiting > Delete
Prospects > Prospect Delete
by Batch

Select a group of prospect
records for deletion.

Prospect Delete Holding ADM_PRS_DEL_SUSP Student Recruiting > Delete
Prospects > Prospect Delete
Holding

Review the prospect records
that you selected for deletion
and remove any that you no
longer want to delete.

Prospect Delete Process ADM_PRSP_DEL_PARMS Student Recruiting > Delete
Prospects > Prospect Delete
Process

Run the Prospect Delete
process.

Selecting Individual Prospect Records to Delete
Access the Delete Prospect Record page (Student Recruiting > Delete Prospects > Delete Prospect
Record).
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This example illustrates the fields and controls on the Delete Prospect Record page: Prospect tab. You can
find definitions for the fields and controls later on this page.

Enter a value in the  ID field. If only one prospect record exists, the institution and career will appear
automatically. If a prospect has multiple institution or career records, you must enter a row for each record
that you want to delete.

For each prospect record, select the 3Cs, if any, that you want to delete.

Prospect Details

Select the Prospect Details tab.

This example illustrates the fields and controls on the Delete Prospect Record page: Prospect Details tab.
You can find definitions for the fields and controls later on this page.

View additional information about the records that you have selected on this page.

When you save this page, the selected records are inserted into the Prospect Delete Holding table, where
they are stored until you run the Prospect Delete process. If you enter an ID for a prospect for which a
record already exists in the holding table, you will receive an error message and will not be able to add the
prospect.

Selecting a Group of Prospect Records to Delete
Access the Prospect Delete by Batch page (Student Recruiting > Delete Prospects > Prospect Delete
by Batch).
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This example illustrates the fields and controls on the Prospect Delete by Batch page. You can find
definitions for the fields and controls later on this page.

3C PROS/PROP/PSSV Delete Optns (3C PROS/PROP/PSSV delete options)

Select the 3Cs, if any, that you want to delete. Your selection will apply to all prospect records in the
group. You can update the 3C information for individual records in the group by accessing the Prospect
Delete Holding table after you run the process.

Running the Process

Click Run to run the Prospect Delete by Batch Application Engine (SAD_PRS_DEL) process using
the PeopleSoft Process Scheduler. This process inserts all the selected records into the Prospect Delete
Holding table if they do not already exist there.

Once the process runs successfully, view the message log to confirm how many records were selected
(SAD_PRS_DEL_TGT) and how many records were inserted into the holding table (ADM_PRS_DELC).

Viewing the Prospect Delete Holding Table
Access the Prospect Delete Holding page (Student Recruiting > Delete Prospects > Prospect Delete
Holding).

This example illustrates the fields and controls on the Prospect Delete Holding page. You can find
definitions for the fields and controls later on this page.
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The Prospect Delete Holding table contains all the records that you have selected for deletion, whether
individually or in a group. Review these records before you run the Prospect Delete process.

You can:

• Use the check boxes to select different 3C options for a prospect.

• Click the Remove From Holding Table button to remove a record from the holding table if you no
longer want to delete that record.

Click the Prospect Data link to access the Create/Update Prospects component, where you can view
additional prospect information and determine whether to remove a record from the holding table.

Running the Prospect Delete Process
Access the Prospect Delete Process page (Student Recruiting > Delete Prospects > Prospect Delete
Process).

Click Run to run the Prospect Delete process using the PeopleSoft Process Scheduler. This process
deletes all the records in the Prospect Delete Holding table.

Technical Information

To prepare records for the optional ID Delete process, the Prospect Delete process analyzes whether data
should be deleted from the STDNT_CAREER table as follows:

• The process evaluates the ADM_APPL_DATA table for each prospect, searching for an application
record in the academic career corresponding to the prospect record.

• If the process finds an application, then it does not delete the row containing the prospect's
identification number from the STDNT_CAREER table because the prospect has another
relationship, as an applicant, with the academic institution.

The prospect does not qualify for ID Delete.

• If the process does not find an application, then it evaluates the ACAD_PROG table.

• The process evaluates the ACAD_PROG table for each prospect, searching for a student record in the
academic career and academic program corresponding to the prospect record.

• If the process finds a student record, it does not delete the row containing the prospect's
identification number from the STDNT_CAREER table because the prospect has another
relationship, as a student, with the academic institution.

The prospect does not qualify for ID delete.

• If the process does not find a student record, it deletes the row containing the prospect's EMPLID
and ACAD_CAREER from the STDNT_CAREER table.

The prospect meets both conditions and might qualify for ID deletion.
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Deleting Applications

This section lists prerequisites and discusses how to:

• Select individual applications to delete.

• Select a group of applications to delete.

• View the Application Delete Holding (ADM_APP_DEL_SUSP) table.

• Run the Application Delete SQR (ADAPPDEL ) process.

Prerequisites
Before you can delete an application:

1. Select Records and Enrollment > Career and Program Information > Student Program/Plan.

2. On the Student Program page, make sure that the applicant is not an active student in the academic
career corresponding to the application.

If the applicant has matriculated, delete the student records for the academic career and academic
program corresponding to the application. Scroll to find and delete only the rows that correspond to
the same academic career and academic program as the current application.

If the applicant matriculated in multiple academic programs in the same academic career and one
of them is valid, you can still run the Application Delete process. However, the applicant does not
qualify for subsequent ID deletion because the applicant still has a relationship, as a student, in
another academic program within the institution.

3. Select Student Admissions > Application Maintenance > Maintain Applications > Application
Program Data.

4. On the Application Program Data page, determine whether the applicant has another application in the
same academic career corresponding to this application but in a different academic program.

If the applicant has another application in the academic career, you can still run the Application Delete
process. However, the applicant does not qualify for subsequent ID deletion because the applicant still
has a relationship, as an applicant, in another academic program within the institution.

Note: If a prospect record exists for the applicant, the applicant does not qualify for subsequent ID
deletion because the applicant has a relationship, as a prospect, with the institution.

Pages Used to Delete Applications

Page Name Definition Name Navigation Usage

Delete an Application SAD_APP_DELETE Student Admissions >
Application Delete > Delete
an Application

Select individual applications
for deletion.
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Page Name Definition Name Navigation Usage

Application Delete by Batch SAD_APP_DEL_BATCH Student Admissions >
Application Delete >
Application Delete by Batch

Select a group of applications
for deletion.

Application Delete Holding ADM_APP_DEL_SUSP Student Admissions >
Application Delete >
Application Delete Holding

Review the application
records that you selected for
deletion and remove any that
you no longer want to delete.

Application Delete Process ADM_APPL_DEL_PARMS Student Admissions >
Application Delete >
Application Delete Process

Run the Application Delete
process.

Selecting Individual Applications to Delete
Access the Delete an Application page (Student Admissions > Application Delete > Delete an
Application).

This example illustrates the fields and controls on the Delete an Application page: Application tab. You
can find definitions for the fields and controls later on this page.

Field or Control Description

ID Enter the ID of the person for whom you want to delete an
application.

Application Number After you enter the ID, select the application that you want to
delete.

Application Data Click this link to access the Maintain Applications component
in a new window.

Delete Communications Delete Checklists and Delete
Comments

For each application, select the 3Cs, if any, that you want to
delete.

Application Details

Select the Application Details tab.
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This example illustrates the fields and controls on the Delete an Application page: Application Details
tab. You can find definitions for the fields and controls later on this page.

View further information about the records that you have selected.

When you save the page, the selected records are inserted into the Application Delete Holding table,
where they are stored until you run the Application Delete process. If you enter an ID and Application
Number for an application for which a record already exists in the holding table, you will receive an error
message and you will not be able to add the application.

Selecting a Group of Applications to Delete
Access the Application Delete by Batch page (Student Admissions > Application Delete >
Application Delete by Batch).

This example illustrates the fields and controls on the Application Delete by Batch page. You can find
definitions for the fields and controls later on this page.

3C ADMA/ADMP Delete Options

Select the 3Cs, if any, that you want to delete. Your selection will apply to all application records in the
group. You can update 3C information for individual records in the group by accessing the Application
Delete Holding table after you run the process.

Running the Process

Click Run to run the Application Delete by Batch Application Engine (SAD_APP_DEL) process using
the PeopleSoft Process Scheduler. This process inserts all the selected records into the Application Delete
Holding table if they do not already exist there.
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Once the process runs successfully, view the message log to confirm how many records were
selected (SAD_APP_DEL_TGT ) and how many records were inserted into the holding table
(ADM_APP_DELC).

Viewing the Application Delete Holding Table
Access the Application Delete Holding page (Student Admissions > Application Delete > Application
Delete Holding).

This example illustrates the fields and controls on the Application Delete Holding page. You can find
definitions for the fields and controls later on this page.

The Application Delete Holding table contains all the records that you have selected for deletion, whether
individually or in a group. Review these records before you run the Application Delete process.

You can:

• Use the check boxes to select different 3C options for an application.

• Click the Remove From Holding Table button to remove a record from the holding table if you no
longer want to delete that record.

Click the Application Data link to access the Maintain Applications component, where you can view
additional applicant information and determine whether to remove a record from the holding table.

Running the Application Delete Process
Access the Application Delete Process page (Student Admissions > Application Delete > Application
Delete Process).

Click Run to run the Application Delete process using the PeopleSoft Process Scheduler. All application
records will be deleted from the holding table.
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Technical Information

To prepare records for the optional ID Delete process, the Application Delete process analyzes whether
data should be deleted from the ID Delete control tables:

• The process evaluates the ACAD_PROG table for each applicant, searching for a student record in the
academic career corresponding to the application.

• If the process finds a student record, it does not delete the row containing the applicant's
identification number from the STDNT_CAREER table because the applicant has another
relationship, as a student, with the academic institution. Therefore, the applicant does not qualify
for ID deletion.

• If the process does not find a student record, then it evaluates the ADM_APPL_PROG table.

• The process evaluates the ADM_APPL_PROG table for each applicant, searching for another
application in the academic career corresponding to the application record.

• If the process finds another application, it does not delete the row containing the applicant's
identification number from the STDNT_CAREER table because the applicant still has a
relationship, as an applicant, with the academic institution. Therefore, the applicant does not
qualify for ID deletion.

• If the process does not find an application, then it evaluates the ADM_PRSPCT_CAR table.

• The process evaluates the ADM_PRSPCT_CAR table for each applicant, searching for a prospect
record in the academic career corresponding to the application record.

• If the process finds a prospect record, it does not delete the row containing the applicant's
identification number from the STDNT_CAREER table because the applicant has another
relationship, as a prospect, with the academic institution. Therefore, the applicant does not qualify
for ID deletion.

• If the process does not find a prospect record, it deletes the row containing the applicant's
EMPLID, ACAD_CAREER, and CAR_REQ_TERM from the STDNT_CAREER table.

• The process updates the Application Number Deleted field in the ITEM_SF table from N, the
default, to Y.

• Data in the ITEM_SF table flows up to the ACCOUNT_SF table.
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Producing a Year to Year Comparison
Report

Running the Admissions Funnel Report Process

PeopleSoft delivers an Admissions Funnel report that you can use to report on your prospect and
applicant numbers across one or multiple terms. Using this process, you can produce a year-to-year
demographic comparison report. You can run the Admissions Funnel report in multiple formats showing
varied data, depending on your criteria. The report lists the numbers of individuals by applicant type and
status as well as other various conditions that you choose, such as ethnicity, gender, region, and academic
program. You can also include a comparison of terms on this report. The report calculates numeric and
percentile representations of these comparisons.

This section discusses how to run Admissions Funnel reports.

Page Used to Run the Admissions Funnel Report Process

Page Name Definition Name Navigation Usage

Admissions Funnel Report -
Parameters

RUNCTL_ADFUNNEL Student Admissions >
Reports > Admissions
Funnel Report >
Parameters

Run a demographic funnel
report.

Related Links
Recruiting and Admissions Reports: A-Z

Running Admissions Funnel Reports
Access the Admissions Funnel Report - Parameters page (Student Admissions > Reports > Admissions
Funnel Report > Parameters).
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This example illustrates the fields and controls on the Admissions Funnel Report - Parameters page. You
can find definitions for the fields and controls later on this page.

Define the data that you want to appear in your report in the Report Request Parameters section.

Field or Control Description

Report Grouping Group the data on your report. The default is to group the
report by at least the application type and status (Only by
Application Type, Status). However, you can select a different
option to group the report by other criteria in addition to
application type and status. For example, if you select Also
by Application Method, then the report will be grouped by
application type, status, and application method. Values for
this field are delivered with your system as translate values.
 You can modify these translate values but you may also
need to modify the report according to the translate values
added. Values are Only by Application Type, Status, Also by
Application Method, Also by Ethnicity, Also by Event Type,
 Also by Gender, Also by Program,Also by Region, and Also by
State.

Create Compare Report Select if you want to compare terms on this report. When this
check box is selected, additional fields appear on the screen
enabling you to select additional terms. If you want to report
on only one term, clear this check box.

Regulatory Region Select the Regulatory Region to determine which Ethnic
Groups to display in the report. The field will display when the
Report Grouping of Also by Ethnicity is selected.

Show Term Detail Select if you want to view the set of terms and details
regarding those terms. You can view details of up to five
terms. If you have selected more than five terms and you select
this check box, you will receive an error message. Clear this
check box if you want to view your data in one group.
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Field or Control Description

Address Type for Country/State This field appears when you select Also By Country/State in
the Report Grouping field. Select the address type that you
want the system to use when grouping the report data.

All Terms for Academic Year Select the year for which you want to run the report. When
you select an academic year, the admit terms defined for that
year automatically appear. You can remove any of these terms.
 You must select a year for the Admissions Funnel Report
process to run successfully.

All Terms in Comparison Year If you are running a comparison report, select the year to
which you are comparing.

Admit Term The system populates the admit terms based on the year you
selected in the All Terms for Academic Year.  You can add
and delete the admit terms. However, you must select at least
one admit term for the Admissions Funnel Report process to
run successfully.

Comparison Admit Term After you select a comparison year, the admit terms defined
for that year automatically appear. You can remove any of
these terms.
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Recruiting and Admissions Reports

Recruiting and Admissions Reports: A-Z

This table lists the Recruiting and Admissions reports, sorted by report ID.

See the product documentation for PeopleTools: Process Scheduler

Report ID and Report
Name

Description Navigation Run Control Page

ADAVGCUT

Average Cutoff Report

Enables you to assess an
evaluated applicant pool to
determine the admissions
averages that drive certain
program actions. (SQR)

Student Admissions >
Reports > Average Cutoff
Report

RUNCTL_ADAVGCUT

ADFUNNEL

Admissions Funnel

Lists prospect and applicant
numbers across one
or multiple terms. The
report lists the numbers of
individuals by applicant type
and status as well as other
various conditions that you
choose, such as ethnicity,
 gender, region, and academic
program (SQR).

Student Admissions >
Reports > Admissions
Funnel Report

RUNCTL_ADFUNNEL

Recruiting and Admissions Reports: Selected Reports

This section provides detailed information about individual reports including important fields and tables
accessed.

ADAVGCUT

Field or Control Description

Institution Enter the institution name.

Academic Program Enter the academic program for which you want to generate an
average cutoff report.
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Field or Control Description

Admit Term Enter the admit term for which you want to generate an
average cutoff report.

Running the process creates a file called adavgcut.lis. Use this file to view the output.

Note: If you enter an academic program and admit term combination that is not set up in the Average
Cutoff Table page, you receive a blank report.

ADFUNNEL
Define the data that you want to appear in your report in the Report Request Parameters section.

Field or Control Description

Report Grouping Group the data on your report. The default is to have the report
grouped by at least the application type and status (Only by
Application Type, Status). However, you can select a different
option to group the report by other criteria in addition to
application type and status. For example, if you select Also
by Application Method, then the report will be grouped by
application type, status, and application method. Values for
this field are delivered with your system as translate values.
 You can modify these translate values but you may also need
to modify the report according to the translate values added.
 The delivered values are Only by Application Type, Status,
 Also by Application Method, Also by Ethnicity, Also by Event
Type, Also by Gender, Also by Program, Also by Region, and
Also by Country/State.

Create Compare Report Select if you want to compare terms on this report. After this
check box is selected, additional fields appear on the screen
enabling you to select additional terms. If you want to report
on only one term, clear this check box.

Regulatory Region Select the Regulatory Region to determine which Ethnic
Groups to display in the report. The field will display when the
Report Grouping of 'Also by Ethnicity' is selected.

Show Term Detail Select if you want to see the set of terms and details regarding
those terms. You can view details of up to five terms. If you
have selected more than five terms and you select this check
box, you will receive an error message. Clear this check box if
you prefer to see your data in one group.

Address Type for Country/State This field appears when you select Also By Country/State in
the Report Grouping field. Select the address type that you
want the system to use when grouping the report data.
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Field or Control Description

All Terms for Academic Year Select the year for which you want to run the report. After
you select an academic year, the admit terms defined for that
year automatically appear. You can remove any of the terms
that you do not want to see. You must select a year for the
Admissions Funnel Report process to run successfully.

All Terms in Comparison Year If you are running a comparison report, select the year to
which you are comparing.

Admit Term The system populates the admit terms based on the year you
selected in the All Terms for Academic Year.  You can add
and delete the admit terms if you want. However, you must
select at least one admit term for the Admissions Funnel
Report process to run successfully.

Comparison Admit Term After you select a comparison year, the admit terms defined
for that year automatically populate these fields. You can
remove any of the terms you do not want to see.
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